
Documentation

OTRS 7 - Admin Manual

Build Date:

2018-04-20



OTRS 7 - Admin Manual
製作著作 © 2003-2018 OTRS AG

この著作はOTRS AGによって著作権で保護されています。

コピーがこの著作権宣言文を保持する限り、全体あるいは一部分をコピーしても良いです。

All trade names are used without the guarantee for their free use and are possibly registered trade marks. All
products mentioned in this manual may be trade marks of the respective manufacturer.

このドキュメントの原本はgithubのリポジトリdoc-adminで見つけることができます。寄付は大歓迎です。Transifexであな
たの言語へ翻訳して貢献することもできます。

https://otrs.github.io
https://github.com/OTRS/doc-admin
https://www.transifex.com/otrs/OTRS/


目次
序文 .............................................................................................................................. xvii
1. 導入 ............................................................................................................................. 1

1. トラブルチケット・システム - 基礎 ......................................................................... 1
1.1. トラブルチケット・システムとは？それが必要な理由は？ ............................... 1
1.2. トラブルチケットとは？ .............................................................................. 2

2. OTRS ヘルプデスク ............................................................................................... 2
2.1. 基礎 ........................................................................................................... 2
2.2. 機能 ........................................................................................................... 2
2.3. ハードウェアとソフトウェアの必要条件 ........................................................ 9
2.4. コミュニティー ......................................................................................... 10
2.5. OTRSのためのプロフェッショナル・サービス .............................................. 10

2. インストール .............................................................................................................. 11
1. Installation From Source (Linux, Unix) .............................................................. 11
2. Updating OTRS ................................................................................................. 16

3. ファースト・ステップ .................................................................................................. 20
1. Agent Web Interface ........................................................................................ 20
2. Customer Web Interface ................................................................................... 21
3. Public Web Interface ........................................................................................ 21
4. First Login ......................................................................................................... 22
5. The Web Interface - an Overview .................................................................... 23
6. ダッシュボード ................................................................................................... 25
7. キューとは何か？ ................................................................................................ 31
8. キュー概要とは何か？ .......................................................................................... 32
9. ユーザー設定 ....................................................................................................... 33

4. 管理 ........................................................................................................................... 35
1. The Administration Area of OTRS ..................................................................... 35

1.1. 基礎 ......................................................................................................... 35
1.2. 担当者、グループおよび役割 ...................................................................... 35
1.3. Customer Users and Customers ............................................................ 42
1.4. キュー ..................................................................................................... 52
1.5. Salutations, Signatures, Attachments and Templates ............................ 53
1.6. 自動応答 .................................................................................................. 59
1.7. システム・メール・アドレス ...................................................................... 61
1.8. チケット通知 ............................................................................................ 62
1.9. S/MIME ................................................................................................... 65
1.10. PGP鍵 ................................................................................................... 65
1.11. 状態 ....................................................................................................... 65
1.12. システム構成 .......................................................................................... 66
1.13. Eメールアカウントの使用 ........................................................................ 67
1.14. 受信Eメール・メッセージのフィルタリング ............................................... 67
1.15. GenericAgent（一般担当者）による自動処理の実行 .................................... 70
1.16. Administrative Messages ..................................................................... 72
1.17. セッション管理 ....................................................................................... 72
1.18. システムメンテナンス ............................................................................. 73
1.19. システムログ .......................................................................................... 74
1.20. コミュニケーション・ログ ....................................................................... 75
1.21. SQL Queries via the SQL Box .............................................................. 78
1.22. パッケージ・マネージャー ....................................................................... 78
1.23. ウェブサービス ....................................................................................... 80
1.24. 動的フィールド ....................................................................................... 80
1.25. カレンダー ............................................................................................. 81

2. システム構成 ....................................................................................................... 82
2.1. OTRS構成ファイル ................................................................................... 82
2.2. Configuring the System Through the Web Interface .............................. 82

3. Backing Up the System .................................................................................... 83

iii



3.1. バックアップ ............................................................................................ 84
3.2. リストア .................................................................................................. 84

4. Eメール設定 ........................................................................................................ 85
4.1. Sending/Receiving Emails ...................................................................... 85
4.2. Secure Email with PGP .......................................................................... 91
4.3. Secure Email with S/MIME ..................................................................... 94

5. Using External backends .................................................................................. 98
5.1. Customer Data ....................................................................................... 98
5.2. Customer User Backend ........................................................................ 99
5.3. Backends to Authenticate Agents and Customers ............................... 106
5.4. Customizing the Customer Self-Registration ........................................ 110

6. チケット設定 ..................................................................................................... 112
6.1. チケットの状態 ....................................................................................... 112
6.2. Ticket Priorities .................................................................................... 116
6.3. チケット責任者とチケットの監視 .............................................................. 116

7. Date and Time Related Functions .................................................................. 118
7.1. 業務時間、祝祭日とタイムゾーンの設定 .................................................... 118
7.2. 自動アンロック ....................................................................................... 119

8. Customizing the PDF Output .......................................................................... 120
9. Reporting ........................................................................................................ 120

9.1. 統計 ....................................................................................................... 120
9.2. The Report Generator .......................................................................... 127

10. 動的フィールド ............................................................................................... 131
10.1. 導入 ..................................................................................................... 131
10.2. 構成 ..................................................................................................... 132

11. 一般インターフェイス ...................................................................................... 148
11.1. 一般インターフェース・レイヤー ............................................................ 148
11.2. ウェブサービス・コマンドライン・インタフェース ................................... 150
11.3. ウェブサービス ..................................................................................... 153
11.4. ウェブサービス・グラフィカル・インターフェース ................................... 153
11.5. ウェブサービス・コマンドライン・インターフェイス ............................... 171
11.6. ウェブサービス構成 ............................................................................... 172
11.7. コネクタ .............................................................................................. 179

12. The OTRS Daemon ....................................................................................... 200
12.1. OTRS Daemon Graphical Interface .................................................... 202
12.2. OTRS Daemon Command Line Interface ............................................ 203

5. カスタマイズ ............................................................................................................ 204
1. アクセス・コントロール・リスト(ACL) ................................................................ 204

1.1. 導入 ....................................................................................................... 204
1.2. 記述 ....................................................................................................... 204
1.3. サンプル ................................................................................................ 205
1.4. 参照 ....................................................................................................... 210

2. 工程管理 ........................................................................................................... 214
2.1. 導入 ....................................................................................................... 214
2.2. サンプル・プロセス ................................................................................. 214
2.3. 例の実行 ................................................................................................ 214
2.4. プロセス構成リファレンス ....................................................................... 239
2.5. Import Ready2Adopt process ............................................................... 261

3. Localization of the OTRS Front End ................................................................ 262
6. 機能 ......................................................................................................................... 263

1. The Appointment Calendar ............................................................................ 263
1.1. 導入 ....................................................................................................... 263
1.2. Usage ................................................................................................... 264

2. The Ticket Timeline View ............................................................................... 287
2.1. 摘要 ....................................................................................................... 287
2.2. 構成 ....................................................................................................... 287
2.3. Usage ................................................................................................... 288

3. The Article Attachment Overview .................................................................. 289

iv



3.1. 摘要 ....................................................................................................... 289
3.2. 構成 ....................................................................................................... 289
3.3. Usage ................................................................................................... 289

4. System Configuration User Specific Settings ................................................. 290
4.1. 摘要 ....................................................................................................... 290
4.2. 構成 ....................................................................................................... 290
4.3. Usage ................................................................................................... 290

5. Notification Methods ....................................................................................... 292
5.1. 摘要 ....................................................................................................... 292
5.2. Notification Web View .......................................................................... 292
5.3. SMS Notifications ................................................................................. 293

6. The SLA Field Selection Dialog ....................................................................... 294
6.1. 摘要 ....................................................................................................... 294
6.2. 構成 ....................................................................................................... 294
6.3. Usage ................................................................................................... 295

7. SMS Communication Channel ........................................................................ 295
7.1. 摘要 ....................................................................................................... 295
7.2. Activating SMS Cloud Service .............................................................. 295
7.3. Configuring SMS Templates ................................................................. 297
7.4. Creating SMS Tickets ........................................................................... 297
7.5. Creating SMS Articles .......................................................................... 298
7.6. Displaying SMS Articles ....................................................................... 299

8. The Dynamic Field Contact with Data ............................................................ 300
8.1. 摘要 ....................................................................................................... 300
8.2. 構成 ....................................................................................................... 301
8.3. Usage ................................................................................................... 301

9. The Chat ......................................................................................................... 302
9.1. 摘要 ....................................................................................................... 302
9.2. 構成 ....................................................................................................... 302
9.3. Setup .................................................................................................... 304
9.4. General Usage ..................................................................................... 306
9.5. Advanced Usage .................................................................................. 311

10. Video and Audio Calls .................................................................................. 315
10.1. 摘要 ..................................................................................................... 315
10.2. 構成 ..................................................................................................... 315
10.3. Setup .................................................................................................. 315
10.4. Usage ................................................................................................. 316
10.5. Connection ......................................................................................... 323

11. FAQ（よくある質問） ....................................................................................... 323
11.1. 摘要 ..................................................................................................... 323
11.2. 構成 ..................................................................................................... 323
11.3. Included Features ............................................................................... 338
11.4. Usage ................................................................................................. 340

12. Share Search Templates ............................................................................... 344
12.1. 摘要 ..................................................................................................... 344
12.2. 構成 ..................................................................................................... 344
12.3. Usage ................................................................................................. 345

7. パフォーマンス・チューニング ................................................................................... 346
1. OTRS ............................................................................................................... 346

1.1. TicketIndexModule ............................................................................... 346
1.2. Ticket Search Index ............................................................................. 346
1.3. Article Storage (Email, Phone and Internal Articles) ............................ 347
1.4. チケットのアーカイブに保管 .................................................................... 348
1.5. キャッシュ ............................................................................................. 349

2. データベース ..................................................................................................... 349
2.1. MySQL .................................................................................................. 349
2.2. PostgreSQL ........................................................................................... 349

3. Web Server ..................................................................................................... 350

v



A. 追加の資料 ............................................................................................................... 351
B. 構成オプションリファレンス ...................................................................................... 353

1. CloudService ................................................................................................... 353
2. CloudService → Admin → ModuleRegistration ................................................ 353
3. Core ................................................................................................................ 353
4. Core → AppointmentCalendar ........................................................................ 354
5. Core → AppointmentCalendar → Plugin .......................................................... 356
6. Core → AppointmentCalendar → TicketAppointments ..................................... 356
7. Core → Auth → Agent → TwoFactor ................................................................. 357
8. Core → Auth → Customer ............................................................................... 358
9. Core → Auth → Customer → TwoFactor ........................................................... 363
10. Core → Autoload ........................................................................................... 363
11. Core → Cache ............................................................................................... 364
12. Core → Chat ................................................................................................. 364
13. Core → CommunicationChannel ................................................................... 368
14. Core → CommunicationChannel → MIMEBase ............................................... 369
15. Core → CommunicationLog ........................................................................... 370
16. Core → Crypt → PGP ..................................................................................... 371
17. Core → Crypt → SMIME ................................................................................. 372
18. Core → Customer ......................................................................................... 373
19. Core → DB → Mirror ...................................................................................... 375
20. Core → DocumentSearch → Driver ............................................................... 376
21. Core → Draft ................................................................................................. 378
22. Core → DynamicFields → DriverRegistration ................................................. 378
23. Core → DynamicFields → ObjectTypeRegistration ......................................... 380
24. Core → Email ................................................................................................ 381
25. Core → Email → PostMaster .......................................................................... 384
26. Core → Event → AppointmentCalendar ........................................................ 394
27. Core → Event → CustomPage ....................................................................... 394
28. Core → Event → CustomerCompany ............................................................. 394
29. Core → Event → CustomerUser .................................................................... 395
30. Core → Event → DynamicField ...................................................................... 396
31. Core → Event → FAQ .................................................................................... 396
32. Core → Event → LinkObject .......................................................................... 396
33. Core → Event → Package .............................................................................. 396
34. Core → Event → Queue ................................................................................ 397
35. Core → Event → ServiceCatalogueItem ........................................................ 398
36. Core → Event → Ticket ................................................................................. 398
37. Core → FAQ ................................................................................................... 402
38. Core → FAQ → Approval ................................................................................ 404
39. Core → FAQ → Explorer ................................................................................ 405
40. Core → FAQ → Item ...................................................................................... 407
41. Core → FAQ → Item → Voting ....................................................................... 408
42. Core → FAQ → RelatedArticles ...................................................................... 408
43. Core → FAQ → TicketCompose ...................................................................... 409
44. Core → GoogleChrome ................................................................................. 410
45. Core → LinkObject ........................................................................................ 410
46. Core → Log ................................................................................................... 412
47. Core → MailQueue ........................................................................................ 414
48. Core → PDF ................................................................................................... 414
49. Core → Package ............................................................................................ 416
50. Core → PerformanceLog ............................................................................... 417
51. Core → Permission ........................................................................................ 418
52. Core → ProcessManagement ........................................................................ 419
53. Core → Queue .............................................................................................. 421
54. Core → ReferenceData ................................................................................. 422
55. Core → SLA ................................................................................................... 422
56. Core → SMS .................................................................................................. 422

vi



57. Core → SOAP ................................................................................................ 423
58. Core → Service ............................................................................................. 423
59. Core → Session ............................................................................................. 423
60. Core → Stats ................................................................................................. 426
61. Core → Stats → Reports ................................................................................ 427
62. Core → SystemMaintenance ......................................................................... 427
63. Core → Ticket ............................................................................................... 428
64. Core → Ticket → ACL .................................................................................... 438
65. Core → Ticket → DynamicFieldDefault .......................................................... 441
66. Core → Ticket → FulltextSearch .................................................................... 445
67. Core → Ticket → Permission ......................................................................... 459
68. Core → Time ................................................................................................. 462
69. Core → Time → Calendar1 ............................................................................ 465
70. Core → Time → Calendar2 ............................................................................ 467
71. Core → Time → Calendar3 ............................................................................ 469
72. Core → Time → Calendar4 ............................................................................ 471
73. Core → Time → Calendar5 ............................................................................ 473
74. Core → Time → Calendar6 ............................................................................ 475
75. Core → Time → Calendar7 ............................................................................ 477
76. Core → Time → Calendar8 ............................................................................ 480
77. Core → Time → Calendar9 ............................................................................ 482
78. Core → Web .................................................................................................. 484
79. Core → WebUserAgent .................................................................................. 484
80. Daemon ........................................................................................................ 485
81. Daemon → Log ............................................................................................. 485
82. Daemon → ModuleRegistration ..................................................................... 485
83. Daemon → SchedulerCronTaskManager → Task ............................................ 486
84. Daemon → SchedulerGenericAgentTaskManager ......................................... 497
85. Daemon → SchedulerGenericInterfaceTaskManager ..................................... 497
86. Daemon → SchedulerTaskWorker ................................................................. 498
87. Frontend → Admin ........................................................................................ 498
88. Frontend → Admin → ModuleRegistration ..................................................... 501
89. Frontend → Admin → ModuleRegistration → AdminOverview ........................ 519
90. Frontend → Admin → ModuleRegistration → Loader ...................................... 534
91. Frontend → Admin → ModuleRegistration → MainMenu ................................ 549
92. Frontend → Admin → View → ContactWithData ............................................ 560
93. Frontend → Admin → View → CustomPage ................................................... 560
94. Frontend → Admin → View → CustomerCompany ......................................... 561
95. Frontend → Admin → View → CustomerUser ................................................. 561
96. Frontend → Admin → View → NotificationEvent ............................................ 561
97. Frontend → Admin → View → SelectBox ....................................................... 564
98. Frontend → Admin → View → SysConfig ....................................................... 564
99. Frontend → Agent ......................................................................................... 564
100. Frontend → Agent → ArticleComposeModule .............................................. 578
101. Frontend → Agent → FAQJournalOverview .................................................. 578
102. Frontend → Agent → FAQOverview ............................................................. 579
103. Frontend → Agent → FAQRelatedArticles .................................................... 579
104. Frontend → Agent → FrontendNotification .................................................. 580
105. Frontend → Agent → LinkObject ................................................................. 583
106. Frontend → Agent → MIMEViewer ............................................................... 586
107. Frontend → Agent → ModuleRegistration .................................................... 586
108. Frontend → Agent → ModuleRegistration → Loader .................................... 604
109. Frontend → Agent → ModuleRegistration → MainMenu ............................... 617
110. Frontend → Agent → TicketOverview .......................................................... 626
111. Frontend → Agent → TicketOverview → MenuModule ................................. 628
112. Frontend → Agent → ToolBar ...................................................................... 630
113. Frontend → Agent → View → CustomerInformationCenter .......................... 635
114. Frontend → Agent → View → CustomerUserAddressBook ............................ 639

vii



115. Frontend → Agent → View → CustomerUserInformationCenter ................... 639
116. Frontend → Agent → View → CustomerUserSearch ..................................... 642
117. Frontend → Agent → View → Dashboard ..................................................... 644
118. Frontend → Agent → View → Dashboard → EventsTicketCalendar ............... 654
119. Frontend → Agent → View → Dashboard → TicketFilters .............................. 655
120. Frontend → Agent → View → FAQAdd ......................................................... 656
121. Frontend → Agent → View → FAQEdit ......................................................... 656
122. Frontend → Agent → View → FAQExplorer ................................................... 657
123. Frontend → Agent → View → FAQJournal ..................................................... 658
124. Frontend → Agent → View → FAQPrint ........................................................ 658
125. Frontend → Agent → View → FAQSearch ..................................................... 659
126. Frontend → Agent → View → FAQZoom ...................................................... 662
127. Frontend → Agent → View → FAQZoom → MenuModule .............................. 663
128. Frontend → Agent → View → LinkObject ..................................................... 664
129. Frontend → Agent → View → NotificationView ............................................ 664
130. Frontend → Agent → View → Preferences ................................................... 666
131. Frontend → Agent → View → Stats ............................................................. 677
132. Frontend → Agent → View → TicketBounce ................................................. 679
133. Frontend → Agent → View → TicketBulk ..................................................... 680
134. Frontend → Agent → View → TicketClose .................................................... 682
135. Frontend → Agent → View → TicketCompose .............................................. 687
136. Frontend → Agent → View → TicketCustomer ............................................. 690
137. Frontend → Agent → View → TicketEmailNew ............................................. 690
138. Frontend → Agent → View → TicketEmailOutbound .................................... 693
139. Frontend → Agent → View → TicketEmailResend ........................................ 694
140. Frontend → Agent → View → TicketEscalation ............................................ 695
141. Frontend → Agent → View → TicketForward ................................................ 696
142. Frontend → Agent → View → TicketFreeText ............................................... 698
143. Frontend → Agent → View → TicketHistory ................................................. 703
144. Frontend → Agent → View → TicketLocked ................................................. 704
145. Frontend → Agent → View → TicketMerge ................................................... 705
146. Frontend → Agent → View → TicketMove .................................................... 706
147. Frontend → Agent → View → TicketNote ..................................................... 709
148. Frontend → Agent → View → TicketOwner .................................................. 714
149. Frontend → Agent → View → TicketPending ................................................ 718
150. Frontend → Agent → View → TicketPhoneInbound ...................................... 723
151. Frontend → Agent → View → TicketPhoneNew ............................................ 725
152. Frontend → Agent → View → TicketPhoneOutbound ................................... 728
153. Frontend → Agent → View → TicketPrint ..................................................... 730
154. Frontend → Agent → View → TicketPriority ................................................. 730
155. Frontend → Agent → View → TicketProcess ................................................. 735
156. Frontend → Agent → View → TicketQueue .................................................. 735
157. Frontend → Agent → View → TicketResponsible .......................................... 738
158. Frontend → Agent → View → TicketSMSNew ............................................... 743
159. Frontend → Agent → View → TicketSMSOutbound ...................................... 745
160. Frontend → Agent → View → TicketSearch .................................................. 746
161. Frontend → Agent → View → TicketService ................................................. 753
162. Frontend → Agent → View → TicketStatus .................................................. 754
163. Frontend → Agent → View → TicketWatch ................................................... 755
164. Frontend → Agent → View → TicketZoom ................................................... 756
165. Frontend → Agent → View → TicketZoom → ArticleAction ........................... 761
166. Frontend → Agent → View → TicketZoom → MenuModule ........................... 765
167. Frontend → Base ......................................................................................... 773
168. Frontend → Base → Loader ......................................................................... 779
169. Frontend → Base → NavBarModule ............................................................. 783
170. Frontend → Base → OutputFilter ................................................................. 784
171. Frontend → External ................................................................................... 787
172. Frontend → External → Auth ....................................................................... 788

viii



173. Frontend → External → Menu ...................................................................... 789
174. Frontend → External → PrivacyNotice ......................................................... 791
175. Frontend → External → Route ..................................................................... 792
176. Frontend → External → View → KnowledgeBaseDetail ................................ 794
177. Frontend → External → View → Preferences ................................................ 794
178. Frontend → External → View → TicketCreate .............................................. 796
179. Frontend → External → View → TicketDetail ............................................... 799
180. Frontend → External → View → TicketOverview .......................................... 801
181. GenericInterface ......................................................................................... 802
182. GenericInterface → ErrorHandling → ModuleRegistration ........................... 802
183. GenericInterface → Invoker → ModuleRegistration ..................................... 803
184. GenericInterface → Mapping → ModuleRegistration .................................... 803
185. GenericInterface → Operation .................................................................... 804
186. GenericInterface → Operation → Generic → RPC ........................................ 804
187. GenericInterface → Operation → ModuleRegistration ................................. 805
188. GenericInterface → Operation → TicketCreate ............................................ 807
189. GenericInterface → Operation → TicketSearch ............................................ 808
190. GenericInterface → Operation → TicketUpdate ........................................... 808
191. GenericInterface → Transport → ModuleRegistration .................................. 809
192. WebApp ...................................................................................................... 810
193. WebApp → API → Customer → Account ...................................................... 810
194. WebApp → APIClient ................................................................................... 812

C. GNUフリー文書許諾契約書 ........................................................................................ 814
0. はじめに ........................................................................................................... 814
1. この利用許諾契約書の適用範囲と用語の定義 ......................................................... 814
2. 逐語的に忠実な複製 ........................................................................................... 815
3. 大量の複製 ........................................................................................................ 815
4. 改変 ................................................................................................................. 816
5. 文書の結合 ........................................................................................................ 817
6. 文書の収集 ........................................................................................................ 817
7. 独立した著作物の集積 ........................................................................................ 818
8. 翻訳 ................................................................................................................. 818
9. 契約の終了 ........................................................................................................ 818
10. 将来における本利用許諾契約書の改訂 ................................................................ 818
この利用許諾契約書をあなたの文書に適用するには ................................................... 818

ix



図の一覧
3.1. Login screen of the agent interface ..................................................................... 20
3.2. Login screen of the customer interface ................................................................ 21
3.3. 公開ウェブインターフェイス ..................................................................................... 22
3.4. 新規パスワードを申請 ............................................................................................... 23
3.5. Dashboard of the agent interface ......................................................................... 24
3.6. フッター ................................................................................................................. 25
3.7. ダッシュボード・ウィジェット .................................................................................. 26
3.8. イベント・チケット・カレンダー・ウィジェット ......................................................... 28
3.9. Dashboard Settings ............................................................................................... 30
3.10. 担当者用キュー・ビュー（デフォルト） ................................................................... 32
3.11. Agent Queue View visual alarms ........................................................................ 33
3.12. Agent's personal preferences ............................................................................. 33
3.13. Customer's personal preferences ....................................................................... 34
4.1. OTRS Administration Overview Screen ................................................................. 35
4.2. 担当者管理 .............................................................................................................. 36
4.3. 新しい担当者を追加 .................................................................................................. 36
4.4. グループ管理 ........................................................................................................... 37
4.5. 担当者 <-> グループ管理 ......................................................................................... 37
4.6. Change the groups an agent belongs to .............................................................. 38
4.7. Change the agents that belong to a specific group .............................................. 38
4.8. 役割管理 ................................................................................................................. 40
4.9. 新しい担当者の追加 .................................................................................................. 41
4.10. Change the roles associated with an agent ........................................................ 41
4.11. Change the agents associated with a specific role ............................................. 41
4.12. Manage roles-groups relations ............................................................................ 41
4.13. Change group relations for a role ....................................................................... 42
4.14. Change role relations for a group ....................................................................... 42
4.15. Customer User management .............................................................................. 43
4.16. Adding a customer user ..................................................................................... 43
4.17. Customer Users-Customers relations management ............................................ 44
4.18. Customer Users-Group relations management ................................................... 44
4.19. Change Group relations for a Customer User ..................................................... 45
4.20. Change Customer user relations for a Group ..................................................... 45
4.21. Customers-Group relations management ........................................................... 46
4.22. Change Group relations for a Customer User ..................................................... 46
4.23. Change Customer user relations for a Group ..................................................... 47
4.24. キュー管理 ............................................................................................................ 52
4.25. Adding a new queue ........................................................................................... 52
4.26. 挨拶文管理 ............................................................................................................ 53
4.27. 新規挨拶文の追加 ................................................................................................... 54
4.28. 署名管理 ............................................................................................................... 54
4.29. 新規署名の追加 ...................................................................................................... 55
4.30. 添付ファイル管理 ................................................................................................... 55
4.31. 新規添付ファイルの追加 ......................................................................................... 56
4.32. 添付のテンプレートへのリンク ................................................................................ 56
4.33. テンプレート用添付関連の変更 ................................................................................ 56
4.34. 添付用テンプレート関連の変更 ................................................................................ 56
4.35. テンプレート管理 ................................................................................................... 57
4.36. 新規テンプレートの追加 ......................................................................................... 58
4.37. Template-Queue relations management ............................................................. 58
4.38. テンプレートのためのキュー関係の変更 ................................................................... 58
4.39. キューのためのテンプレート関係の変更 ................................................................... 59
4.40. 自動応答管理 ......................................................................................................... 59
4.41. 自動応答の追加 ...................................................................................................... 60
4.42. Queue <-> auto response relations management ............................................. 61

x



4.43. Change auto response relations for a queue ...................................................... 61
4.44. システムメールアドレスの管理 ................................................................................ 61
4.45. システム・メール・アドレスの追加 .......................................................................... 62
4.46. チケット通知管理 ................................................................................................... 62
4.47. Customizing a notification .................................................................................. 63
4.48. 通知のカスタマイズ ................................................................................................ 64
4.49. Customizing notification methods ....................................................................... 64
4.50. S/MIME管理 .......................................................................................................... 65
4.51. PGP管理 ............................................................................................................... 65
4.52. 状態管理 ............................................................................................................... 66
4.53. Graphical user interface of the system configuration. ........................................ 67
4.54. Eメールアカウント管理 ........................................................................................... 67
4.55. ポストマスター・フィルタ管理 ................................................................................ 68
4.56. ポストマスター・フィルタを追加 ............................................................................. 70
4.57. GenericAgent（一般担当者）のためのジョブ・リスト ................................................ 71
4.58. GenericAgent（一般担当者）のためのジョブ作成 ....................................................... 71
4.59. Admin notification screen ................................................................................... 72
4.60. セッション管理 ...................................................................................................... 73
4.61. セッション詳細 ...................................................................................................... 73
4.62. The system maintenance overview screen with some scheduled periods .......... 74
4.63. The system maintenance edit screen ................................................................. 74
4.64. システムログ ......................................................................................................... 75
4.65. Communication Log Overview ............................................................................ 75
4.66. Communication Log Time Range Selection ......................................................... 76
4.67. Communication Log Account Status ................................................................... 76
4.68. Communication Log Account Status ................................................................... 76
4.69. Communication Log Detail View ......................................................................... 77
4.70. Communication Log Priority Filter ....................................................................... 77
4.71. SQLボックス ......................................................................................................... 78
4.72. パッケージ・マネージャー ...................................................................................... 78
4.73. Package Manager Update All Installed Packages Button ..................................... 79
4.74. Package Manager Update All Installed Packages In Progress Notification ........... 79
4.75. Package Manager Update All Installed Packages Summary ................................ 80
4.76. ウェブサービスのためのグラフィカル・インターフェース .......................................... 80
4.77. The dynamic fields overview screen with some dynamic fields .......................... 81
4.78. The calendar management screen with some calendars .................................... 81
4.79. システム構成用のグラフィカル・インターフェース .................................................... 82
4.80. System configuration deployment ...................................................................... 83
4.81. メールアカウントの追加。 ...................................................................................... 86
4.82. Changing the Responsibility of a ticket in its zoomed view .............................. 117
4.83. Pop-up dialog to change a ticket's responsibility .............................................. 117
4.84. Subscribing to watching a ticket in its zoomed view ........................................ 118
4.85. Unsubscribing from watching a ticket in its zoomed view ................................ 118
4.86. Watched tickets view ........................................................................................ 118
4.87. Overview of the standard statistics. ................................................................. 121
4.88. Viewing a specific statistic. ............................................................................... 121
4.89. Adding a new statistic, first step. ..................................................................... 122
4.90. Adding a new statistic, second step. ................................................................ 123
4.91. Configuring the x-axis of a statistic. ................................................................. 124
4.92. Configuring the y-axis of a statistic. ................................................................. 124
4.93. Configuring the data filter of a statistic. ........................................................... 124
4.94. Configuring the data filter of a statistic. ........................................................... 125
4.95. Statistics import ................................................................................................ 125
4.96. Overview of the defined reports. ...................................................................... 127
4.97. Automatic generation settings .......................................................................... 127
4.98. Automatic generation settings .......................................................................... 128
4.99. Output settings ................................................................................................. 128
4.100. Report: Front page .......................................................................................... 129

xi



4.101. Report: Table of contents ................................................................................ 129
4.102. Report: Preamble ............................................................................................ 130
4.103. Report: Statistics ............................................................................................. 130
4.104. Dynamic fields overview screen. .................................................................... 133
4.105. 動的フィールド・テキストの構成ダイアログ。 ...................................................... 135
4.106. 動的フィールドテキストエリアの構成ダイアログ。 ................................................ 136
4.107. 動的フィールド・チェックボックスの構成ダイアログ ............................................. 136
4.108. 動的フィールド・ドロップダウンの構成ダイアログ ................................................ 138
4.109. 動的フィールド 複数選択の構成ダイアログ ........................................................... 139
4.110. 動的フィールド 日付/時刻の構成ダイアログ .......................................................... 140
4.111. 動的フィールド 日付 の構成ダイアログ ................................................................ 141
4.112. サンプルデータで埋められた動的フィールドの概要画面 ......................................... 142
4.113. Field1 in New Phone Ticket Screen ................................................................. 143
4.114. Field1 in New Phone Ticket Screen as mandatory .......................................... 143
4.115. Several fields in New Phone Ticket Screen as mandatory ............................... 144
4.116. Some deactivated fields in New Phone Ticket Screen as mandatory .............. 145
4.117. Field1 in Ticket Zoom Screen .......................................................................... 145
4.118. Field1 in Ticket Overview Small Screen .......................................................... 146
4.119. Field1 in User preferences screen ................................................................... 147
4.120. The graphical interface layers ........................................................................ 149
4.121. Web services overview ................................................................................... 154
4.122. Web services add ............................................................................................ 155
4.123. ウェブサービス・クローン .................................................................................. 156
4.124. Web services export ....................................................................................... 157
4.125. Web services import ....................................................................................... 157
4.126. Web service history ........................................................................................ 158
4.127. ウェブサービスの削除 ......................................................................................... 159
4.128. Web service debugger .................................................................................... 160
4.129. Web services change ...................................................................................... 161
4.130. Web service provider network transport (HTTP::SOAP) ................................... 162
4.131. Web service provider network transport (HTTP::REST) ................................... 164
4.132. Web service operation .................................................................................... 165
4.133. Web service requester network transport (HTTP::SOAP) ................................. 166
4.134. Web service requester network transport (HTTP::REST) ................................. 167
4.135. Web service invoker ........................................................................................ 169
4.136. Web service invoker event ............................................................................. 170
4.137. Web service mapping ..................................................................................... 171
4.138. Daemon notification ........................................................................................ 202
4.139. Start Daemon .................................................................................................. 202
5.1. ACL 100-Example-ACL ......................................................................................... 206
5.2. ACL 102-Example-ACL ......................................................................................... 207
5.3. ACL 102-Second-Example-ACL ............................................................................ 208
5.4. ACL 103-Third-ACL-Example ................................................................................ 209
5.5. ACL 104-Only-Hardware-Services-for-HW-Queues-ACL ........................................ 209
5.6. ACL 105-Disallow-Process-For-CustomerID .......................................................... 210
5.7. OTRS管理者画面 - システム管理 ............................................................................. 217
5.8. 新しいプロセス・ボタンの作成 ................................................................................ 217
5.9. 新しいプロセスの追加 ............................................................................................. 218
5.10. Create New User Task Activity Dialog button ................................................... 218
5.11. Add new User Task Activity Dialog ................................................................... 219
5.12. フィールド詳細(記事)の編集 .................................................................................. 219
5.13. Create New Sequence Flow button ................................................................... 222
5.14. Add new Sequence Flow ................................................................................... 222
5.15. Create New Sequence Flow Action button ........................................................ 223
5.16. Add new Sequence Flow Action ........................................................................ 224
5.17. Configure Sequence Flow Action ...................................................................... 224
5.18. 新規アクティビティボタンの作成 ........................................................................... 226
5.19. キャンバスに第1のアクティビティをドラッグしてください。 ................................... 227

xii



5.20. 第二のアクティビティをキャンバスにドラッグします。 ........................................... 227
5.21. Drag a Sequence Flow into the canvas ............................................................ 228
5.22. Connect Activities using Sequence Flows ......................................................... 228
5.23. Assign Sequence Flow Actions .......................................................................... 229
5.24. 本の注文の完全なプロセス・パス ........................................................................... 231
5.25. Import Ready2Adopt Processes widget ............................................................. 262
6.1. Calendar management overview ........................................................................ 265
6.2. Calendar edit screen ........................................................................................... 265
6.3. Color picker in calendar edit screen ................................................................... 265
6.4. Appointment import in calendar management overview .................................... 267
6.5. Calendar overview screen ................................................................................... 267
6.6. Sidebar in calendar overview screen .................................................................. 268
6.7. View modes in calendar overview screen ........................................................... 269
6.8. Weekly view in calendar overview screen .......................................................... 269
6.9. Monthly view in calendar overview screen ......................................................... 270
6.10. Navigation controls in calendar overview screen ............................................. 270
6.11. Today and Jump buttons in calendar overview screen ...................................... 270
6.12. User preferences for calendar overview screen ................................................ 271
6.13. Agenda overview screen ................................................................................... 271
6.14. Appointment edit screen .................................................................................. 272
6.15. Appointment display in calendar overview screen ........................................... 273
6.16. Appointment tooltip .......................................................................................... 274
6.17. Edit screen of a repeating appointment ........................................................... 274
6.18. Repeating appointments in calendar overview screen ..................................... 275
6.19. Edit screen of a repeating child appointment ................................................... 275
6.20. Repeating settings of a child appointment ....................................................... 275
6.21. Notification settings in appointment edit screen .............................................. 276
6.22. Calendar/Appointment notification management link ....................................... 277
6.23. Calendar/Appointment notification management overview .............................. 277
6.24. Sidebar in calendar/appointment notification overview .................................... 277
6.25. Table in calendar/appointment notification overview ........................................ 278
6.26. Event definition for calendar/appointment notifications ................................... 278
6.27. Filter settings in calendar/appointment notifications ........................................ 279
6.28. Recipient settings in calendar/appointment notifications ................................. 279
6.29. Notification methods in calendar/appointment notifications ............................. 279
6.30. Notification body in calendar/appointment notifications ................................... 280
6.31. Show in agent preferences option in calendar/appointment notifications ......... 280
6.32. Ticket link option in appointment edit screen ................................................... 281
6.33. Linked appointments table in ticket zoom screen ............................................ 281
6.34. Appointment linking from ticket zoom screen .................................................. 281
6.35. New appointment link in ticket zoom screen .................................................... 282
6.36. Ticket appointments configuration in calendar edit screen .............................. 282
6.37. Ticket appointment rule in calendar edit screen .............................................. 283
6.38. Ticket appointment in calendar overview screen ............................................. 284
6.39. Edit screen of a ticket appointment ................................................................. 285
6.40. Today filter in upcoming appointments dashboard widget ................................ 286
6.41. Soon filter in upcoming appointments dashboard widget ................................. 287
6.42. Switching to the Ticket Timeline View .............................................................. 288
6.43. Using the Ticket Timeline View ......................................................................... 288
6.44. Switching to the article attachment overview .................................................. 289
6.45. Using the article attachment overview ............................................................. 289
6.46. Accessing the user specific settings ................................................................. 290
6.47. Reverting a setting to default value ................................................................. 290
6.48. Access to user values of a particular setting .................................................... 291
6.49. Usage of the user specific values screen ......................................................... 291
6.50. Access to the setting reset dialog .................................................................... 291
6.51. Choosing the reset scope ................................................................................. 292
6.52. Enabling the Notification Web View .................................................................. 292

xiii



6.53. Notification Web View Icon on the Tool-bar ...................................................... 293
6.54. Notification Web View Overview ....................................................................... 293
6.55. Notification Web View Detail ............................................................................. 293
6.56. Enabling SMS Notifications ............................................................................... 294
6.57. Agent Preferences SMS Notification Settings .................................................... 294
6.58. SMS Notification Text Fields .............................................................................. 294
6.59. SLA configuration .............................................................................................. 295
6.60. SLA message .................................................................................................... 295
6.61. Cloud Services Screen in Admin Interface ........................................................ 295
6.62. Activating SMS Cloud Service ........................................................................... 296
6.63. Manage SMS Templates .................................................................................... 297
6.64. Manage SMS Templates .................................................................................... 297
6.65. New SMS Ticket Screen .................................................................................... 298
6.66. New SMS Ticket Screen .................................................................................... 299
6.67. New SMS Ticket Screen .................................................................................... 299
6.68. SMS Article Display ........................................................................................... 300
6.69. SMS Ticket History Entries ................................................................................ 300
6.70. Setting up preferred chat channels .................................................................. 305
6.71. Setting up Chat Availability .............................................................................. 305
6.72. The Chat Managing Screen ............................................................................... 306
6.73. Starting an A2C chat from ticket zoom ............................................................ 307
6.74. Starting an A2C chat from dashboard .............................................................. 307
6.75. Starting a C2A chat .......................................................................................... 307
6.76. An Open Chat Request ..................................................................................... 308
6.77. Open Chat Request Details ............................................................................... 308
6.78. The chat widget ................................................................................................ 309
6.79. Monitor a chat .................................................................................................. 309
6.80. Advanced chat actions ...................................................................................... 309
6.81. The chat widget ................................................................................................ 310
6.82. Configure Chat Integration Button .................................................................... 311
6.83. Configuration Tab .............................................................................................. 312
6.84. Integration Code Tab ......................................................................................... 313
6.85. Preview Tab ....................................................................................................... 314
6.86. Setting up the On-line widget on Dashboard .................................................... 316
6.87. Making a call inside the chat ............................................................................ 317
6.88. Media Permission Request ................................................................................ 317
6.89. Waiting for the other party ............................................................................... 318
6.90. Established Connection ..................................................................................... 318
6.91. Mute Buttons ..................................................................................................... 319
6.92. Audio Only ........................................................................................................ 319
6.93. Call Invitation .................................................................................................... 320
6.94. Notification Permission Request ........................................................................ 320
6.95. Online widget on the Dashboard ...................................................................... 321
6.96. Calling other agents from Ticket Zoom ............................................................ 321
6.97. Making a call from Customer Information Center ............................................. 322
6.98. Making a call from Ticket Zoom ....................................................................... 322
6.99. Starting a Video Call from Customer interface ................................................. 322
6.100. Deploy template for each agent ..................................................................... 345
A.1. バグ・トラッキング・ツール ................................................................................... 352

xiv



表の一覧
4.1. デフォルト・グループは新規のOTRSインストールで利用可能です ................................. 36
4.2. OTRSグループに関連付けられる権限 ......................................................................... 38
4.3. 追加の許可グループ .................................................................................................. 39
4.4. 自動応答用イベント .................................................................................................. 60
4.5. 異なるX-OTRSヘッダーの機能 ................................................................................... 68
4.6. 次のフィールドがシステムへ追加されます。: ............................................................ 134
A.1. メーリングリスト ................................................................................................... 351

xv



例の一覧
4.1. 特定のキューの中へのスパム・メールのソート ............................................................ 70
4.2. Routing via Procmail Using otrs.Console.pl ...................................................... 87
4.3. .fetchmailrc ....................................................................................................... 88
4.4. Example jobs for the filter module
Kernel::System::PostMaster::Filter::Match ........................................................ 89
4.5. フィルタ・モジュールのためのサンプル・ジョブ
　Kernel::System::PostMaster::Filter::CMD .................................................................... 89
4.6. Example job for the filter module
Kernel::System::PostMaster::Filter::ExternalTicketNumberRecognition ...... 90
4.7. DB顧客バックエンドの構成 ....................................................................................... 99
4.8. Using Company Tickets with a DB Backend ....................................................... 101
4.9. LDAP顧客バックエンドの構成 ................................................................................. 102
4.10. LDAPバックエンドを備えた会社チケットの使用 ...................................................... 103
4.11. OTRSでひとつ以上の顧客バックエンドを使用する ................................................... 104
4.12. DBバックエンドに対する認証エージェント ............................................................. 106
4.13. LDAPバックエンドに対する認証エージェント ......................................................... 106
4.14. HTTPBasicを使用して、担当者を認証します。 ....................................................... 108
4.15. Radiusバックエンドに対する担当者を認証します。 ................................................. 108
4.16. DBバックエンドに対する顧客ユーザ認証 ................................................................ 109
4.17. LDAPバックエンドに対する顧客ユーザ認証 ............................................................ 109
4.18. HTTPBasicを備えた顧客ユーザ認証 ....................................................................... 110
4.19. Radiasのバックエンドに対する顧客ユーザ認証 ....................................................... 110
4.20. デフォルトの統計許可グループ .............................................................................. 123
4.21. カスタマイズされた統計許可グループ ..................................................................... 123
4.22. 新規電話チケット画面にあるフィールド１を活性化します。 ..................................... 143
4.23. 新規電話チケット画面中の必須フィールド1を活性化 ................................................ 143
4.24. 必須として新規電話チケット画面中のフィールド1を活性化 ...................................... 144
4.25. 新規電話チケット画面中の複数の必須フィールドを非活性化 ..................................... 144
4.26. チケットズーム画面でフィールド１を活性化 ........................................................... 145
4.27. チケット概要小画面の中のField1を活性化 .............................................................. 145
4.28. チケット作成イベントのフィールド１を活性化 ........................................................ 146
4.29. ユーザー選択でのField1を活性化 ........................................................................... 147
4.30. Example to start the OTRS Daemon ................................................................. 203
4.31. Example to list all configured daemons ............................................................ 203
4.32. Example to a summary of all daemon tasks .................................................... 203
5.1. ACLはチケット優先度5のチケットのみをキューへの移動を許可します。 ...................... 205
5.2. データベースに格納された優先度5のチケットだけのキューへ移動を許可するACL ......... 206
5.3. 未対応のキュー中のチケットの完了を不能にし、閉じるボタンを隠すACL .................... 207
5.4. 状態：「閉鎖成功」を常に削除するACL .................................................................... 208
5.5. "HW"で始まるキューが作成されるハードウェア・サービス・チケットのみを表示する
ACL ............................................................................................................................. 209
5.6. ACL to restrict a Process in the customer frontend using the CustomerID. ......... 210
5.7. 全ての可能かつ重要なACL設定を示すリファレンス（参照） ....................................... 211

xvi



序文
OTRS 管理者向けの冊子です。OTRS 初心者のための参考書としても提供しています。

次の章では、インストール、構成、および OTRS ソフトウェアの管理について説明します。テキス
トの最初の 3行で、ソフトウェアの主要な機能について説明しています。一方残りの部分は、構成
可能なパラメタの完全なセットへの参照として提供されています。

この本は新製品中の移動標的を与えられて、引き続き進行中の仕事です。私達はこれを使いやすく
正確かつ完璧な高品質な参考文献にするためにあなたのフィードバックを必要としています。この
本で内容の欠落、説明が不十分な点、スペルミス、文法のエラーあるいは誤植を見つけた場合は私
達にお知らせ下さい。どのような種類のフィールドバックも正しく評価され、 http://
bugs.otrs.orgにある 私達の追跡システムによって反映されます。あなたの貢献に感謝申し上げま
す。
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第1章 導入
1. トラブルチケット・システム - 基礎
この章ではトラブル・チケットの主要概念の説明とともにトラブル・チケット・システムの手短な紹
介を提供します。例示により手っ取り早くこのようなシステムを使うメリットについて説明します。

1.1. トラブルチケット・システムとは？それが必要な理
由は？
次の例ではトラブル・チケット・システムとは何か、そしてどのようにあなたが会社でそのような
システムが役立つかを述べています。

マックス氏はビデオレコーダーの製造業者だと想像して下さい。マックス氏は製品サポートを必要
とするお客様から多くのメッセージを受け取っています。ある日、彼は速やかに返答することも
メッセージを受け入れることもできなくなりました。一部の顧客は対応の遅さに我慢ができず同じ
質問をするために 2 度めのメッセージを送ります。サポート依頼を含むすべてのメッセージは、単
一の受信トレイ フォルダーに格納されます。サポート依頼はソートされておらず、マックス氏は、
通常のEメール プログラムを使用してメッセージに応答します。

マックス氏はすべてのメッセージに対して十分に速やかに返信できないため、彼は開発者のジョー
氏とジョン氏に助けてもらっています。ジョー氏とジョン氏は同じメールシステムを使い、同じ
メールボックスにアクセスします。彼らはマックス氏がしばしば一人の不満を持った顧客から２件
の全く同じ要求を受けていることに気づいていません。ときどき彼ら二人は全く同じサポート依頼
に対して別々に返答をし、顧客は二つの異なる返答を受信してしまうはめになります。その上、
マックス氏は彼らの返信の詳細について知りさえしないのです。また彼は、どの問題がより頻繁に
起こっているいるのかといった顧客の問題やそれらの解決の詳細についても、あるいは、顧客サ
ポートにどれほどの時間やお金が使われているかについても気づいてはいません。

会議にて同僚はマックス氏に対して、トラブル・チケット・システムが、如何にマックスが顧客サ
ポートで抱えている問題を解決可能であるかを伝えました。インターネットで情報を調査したの
ち、マックス氏は、コンピュータにOTRSをインストールすることに決めました。それは彼の顧客
と彼の従業員の両者がウェブからアクセスできるものです。現在では顧客のサポート要求はもう
マックス氏の個人メールボックスに送られることはなくOTRS用に使用されるメールアカウントに
送信されます。チケットシステムはこのメールボックスに接続しすべての顧客の要求をデータベー
スに保存します。新しい要求毎に、システムは自動的に解答を生成し、それを顧客に送ります。そ
のため顧客は要求が受信されて速やかに要求に対し解答されるだろうとわかります。OTRSは明確な
参照番号、すなわち、チケット番号を生成し、要求毎に対して与えます。現在では顧客は喜んでい
ます。なぜなら顧客の要求は認識され、同じ内容の２度目の要求メッセージを送らなくても良く
なったからです。マックス氏、ジョン氏そしてジョー氏は現在では、シンプルにウェブからOTRS
にログインして顧客の要求に回答しています。システムは回答中のチケットをロックするので、そ
のメッセージを同時に他の誰かに編集されることはありません。

スミス氏がマックス・カンパニーにサポート要求をして、彼のメッセージがOTRSで処理されたと
想像してみましょう。ジョン氏は彼の要求に短い解答をします。しかしスミス氏は彼の質問に対す
るジョンの解答に対して引き続き質問をしたいと思っています。ジョン氏は多忙のためマックスが
スミス氏のメッセージに解答します。マックス氏は、OTRSの履歴機能によってこの要求に関するコ
ミュニケーションの全ての流れを把握することができます。スミス氏は複数のサービス担当者が
　彼の要求を解決するためにかかわっていることを知らないのですが、彼はマックス氏の最後の解
答が到着しその詳細について大変満足しています。

むろん、これはトラブル・チケット・システムのほんのわずかの可能性と特徴を垣間見たに過ぎま
せん。しかし、もしあなたの会社がEメールと電話を通して大量の顧客要求を処理しなければなら
ないならば、そして、もし異なるサービス担当者が異なる時間に対応する必要があるならば、チ
ケット・システムは大変役立つことができます。むろん、これはトラブル・チケット・システムの
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ほんのわずかの可能性と特徴を垣間見たに過ぎません。しかし、あなたの会社がEメールと電話を
使って大量の顧客要求を処理しなければならないならば、そして、もし異なるサービス担当者が異
なる時間に対応する必要があるならば、チケット・システムは大変役立ちます。またチケット・シ
ステムは、ワークフロー・プロセスを合理化する助けとなり、効率化を促進し、全体的に生産性を
改善します。チケットシステムは柔軟にサポートやヘルプデスク環境を構築することができます。
顧客と2人のサービススタッフ間のコミュニケーションはよりわかりやすくなります。最終的な成
果は、サービスの効率性が向上することです。そしてきっとその顧客の満足度は、会社により良い
財務実績をもたらすことでしょう。

1.2. トラブルチケットとは？
トラブル チケットは、病院の患者のために作成した医療レポートに似ています。患者が病院を訪れ
るとまず、すべての必要な個人と医療情報を保持するために医療レポートが作成されます。何度も
通院すると、患者は前回と同じあるいは他の医師に診察され、診察医は、患者の健康及び治療中の
処置に関する情報を追加しレポートを更新します。こうすることで他のどの医師や看護スタッフが
すぐに患者の状態を完全に把握することができます。患者が回復し退院するとき、医療レポートか
ら得られるすべての情報は保存されレポートは閉じられます。

OTRSのようなトラブル・チケット・システムはトラブル・チケットを通常のEメールのように取
り扱います。メッセージはシステムに保存されます。顧客が依頼を送信すると、システムは新しい
チケットを生成します。そのようなシステムは新しく作成される医療レポートに相当します。新し
いチケットへの応答は、医者が医療レポートへの記入することに似ています。チケットは、回答が
顧客へ返送された場合あるいは、チケットがシステムによって個別に閉じられた場合に、完了とな
ります。もし顧客がすでに完了したチケットに再度応答すると、そのチケットは、新しい情報を追
加された上で、再対応中となります。全てのチケットは格納され、完全な情報でアーカイブされま
す。チケットは通常のEメールのように取り扱われ、添付ファイルや文脈上の注釈もまた各Eメール
に格納されます。さらに、基準日、従業員関係、チケットの解決に要した作業時間などの情報が保
存されます。その後いつでも、チケットはソートされ、検索可能であり、さまざまなフィルタリン
グ・メカニズムを使いすべての情報を分析することができます。

2. OTRS ヘルプデスク
この章では、OTRS ヘルプデスク (OTRS) の機能について説明します。OTRSのハードウェアとソフト
ウェアの要件に関する情報を提供します。さらにこの章では、コミュニティとの連絡方法、そしても
し必要ならOTRSに関する商用サポートを取得する方法を知ることができます。

2.1. 基礎
OTRS ヘルプデスク (OTRS) は、 ウェブ サーバーにインストールされるウェブアプリケーション
です。したがって　ウェブ ブラウザーで使用することができます。

OTRS ヘルプデスク (OTRS) は、 ウェブ サーバーにインストールされるウェブアプリケーション
です。したがって　ウェブ ブラウザーで使用することができます。OTRS はいくつかのコンポーネ
ントに分かれています。主なコンポーネントは、アプリケーションとチケット システムのすべての
主要機能を含んでいる OTRS フレームワークです。以下のような追加のアプリケーションをインス
トールすることが可能です。OTRS::ITSM モジュール、ネットワーク監視ソリューションとの統合、
知識ベース（サポート技術情報 ）(FAQ) など。

2.2. 機能
OTRSには多くの機能があります。OTRS フレームワークに含まれる主な機能の概要を以下に示しま
す。

2.2.1. ユーザ・インターフェイス
• OTRS には、担当者と顧客用に別々の最新のウェブ インターフェイスが付属します。
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• Retinaディスプレイをはじめとするモバイルプラットフォームに対応し、どのモダンブラウザで
も利用可能です

• ウェブインターフェイスは、独自のテーマとスキンでカスタマイズできます。

• 強力でカスタマイズ可能な担当者用ダッシュボードは、個人チケット概要とグラフィカルな統計
情報のサポートを実装しています。

• 拡張可能なレポート作成エンジンは、様々な統計とレポートのスケジュール・オプションを提供
します。

• プロセス管理でチケット・ベースの独自の画面とプロセス (チケット・ワークフロー) を定義する
ことが可能です。

• OTRS は、権限管理システムを内蔵しており、きめ細かいアクセス制御リスト (ACLs) で拡張す
ることができます。

• 30 以上の言語と異なるタイムゾーンをサポートします。

2.2.2. メール・インターフェース
• MIME メール添付ファイル付きのメールをサポートします。

• HTML形式メールをテキスト形式に自動変換します(機密性の高いコンテンツのセキュリティを強
化し検索をより高速にします)。

• 受信メールはフィルタリングされ、複雑な規則のある、例えばスパムメッセージまたはキュー配
布に対するなどの前処理が可能です。

• PGP ならびに S/MIME 準拠の鍵や証明書の管理とメール処理機能をサポート。

• 全てのキューに設定可能な自動応答。

• 新規、フォローアップあるいはロック解除されたチケットに関する担当者へのEメール通知。

• フォローアップ（たとえばコール＃、チケット＃、あるいはリクエスト＃など）を認識するため
に独自のチケットの識別子を定義することが可能です。さまざまなチケット番号生成器（日付
ベース、ランダムなど）があり、あなたがあなた自身をもそれに統合することができます。フォ
ローアップもまたIn-Reference-To headers（メール参照ヘッダー）または外部チケット番号で
認識できます。

2.2.3. チケット
• OTRSは、外部、内部に所属している全てのコミュニケーションを収集するためにチケットを用
います。これらのチケットは、キューで整理されます。

• 異なる詳細なレベル(小/中/プレビュー)においてシステム内のチケット（キュー、状態、エスカ
レーションなど）を閲覧するための多くそして異なる方法が用意されています。

• チケットの履歴は、チケットのあらゆる変更を記録します。

• チケットは、さまざまな方法で変更されます。返信、転送、bouncing、別のキューへの移動、属
性（状態、優先度など）の更新、ロック、稼働時間の計算という方法です。チケットの一括変更
も可能です。 （bulk action)

• 保留中時間とエスカレーション時間 /SLA 管理は、チケットに関する時間ベースのスケジュール
設定と制限を許可します。

• チケットは他のチケットまたは FAQ エントリなどの他のオブジェクトにリンクできます。
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• 自動およびタイムアクションのチケットが 「GenericAgent」で利用可能です。

• OTRSは、チケットに関する複雑でフルテキストの検索が可能な強力なサーチエンジンとなりま
す。

2.2.4. システム
• OTRSは、多くのオペレーティング・システム(Linux、Solaris、AIX、FreeBSD、OpenBSD、Mac

OS 10.x)上で走り、主要なOTRSバックエンド用のいくつかのデータベース・システム
(MySQL、PostgreSQL、オラクル、MSSQL)をサポートします。

• コア・システムは、OTRSパッケージのインストールにより拡張することができます。OTRSグルー
プのサービス契約顧客が利用可能な機能追加パッケージと同様に、多くの無料のパッケージも
(FAQ、OTRS::ITSM他のような)あります。

• 顧客情報用の外部バックエンドの統合（例えば AD、eDirectoryあるいはOpenLDAP経由）。顧
客は、データベース、LDAP、HTTPAuth あるいは Radius によって認証されます。

• 一般インターフェイス（GenericInterface）で、他のウェブサービスにOTRSを接続するのは簡単
です。シンプルなウェブサービスによって、プログラムやカスタム拡張による複雑なシナリオな
ど必要とせずに、統合することができます。OTRSチケット・コネクターは、サードパーティー・
アプリケーションのウェブサービスによって、チケットの更新、検索および作成を許可します。

では、次にOTRSの最近のバージョンの変化を見ましょう。

2.2.5. New Features of OTRS 7

2.2.6. New Features of OTRS 6
2.2.6.1. 生産性

• Implemented proper time zone support. Time zones can be configured system wide and
also on a per-user basis.

• Improvements to ticket handling

• Added possibility to store unfinished ticket forms as drafts for later reuse.

• Completely revamped ticket zoom screen, with a fresh new design with accent on
content. User avatars have been introduced as a visual aid for easier identification of
the article sender. Article display settings are now displayed in a settings dialog.

• Dropped dubious and somewhat confusing article types, and introduced the concept
of communication channels as source for ticket articles (e.g. Email, Phone, Chat, etc).
Customer visibility of articles can now be determined by a simple check-box.

• Improved AgentTicketHistory screen usability.

• Merged the add-on module OTRSAdvancedTicketSplit. Now it's possible to select to
which kind of ticket an article should be split: phone (default), email or process ticket.
For process tickets, additional selection of specific process will be provided. However,
only those fields which are configured in the first activity dialog will be adopted from
original ticket.

• Added support for ticket number and title search in ticket merge and bulk screens.
Auto-complete list can be used to populate the ticket number field with a single click,
therefore speeding up the process and limiting room for error. In the ticket merge
screen, there is also a CustomeriD search filter option, which will limit the results to
tickets belonging to the same customer company as the source ticket.
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• Split last sender and ticket title columns in ticket overviews.

• It's now possible to access all supported article actions directly from large ticket
overview screen.

• It is now possible to delete linked objects directly from the zoom view.

• Ticket search and statistic can now filter for pending until time.

• Added possibility to restrict zoom and print screens in the customer interface by using
ACLs.

• The used search template is now shown on the ticket search result screen.

• Added possibility to automatically lock new tickets to the agent who creates them.

• Added possibility to send notifications to the agent who created a ticket, thanks to
Dian Tong Software.

• Added new recipient notification groups 'AllRecipientsFirstArticle' and
'AllRecipientsLastArticle'.

• Make it possible to configure which ticket state types to show striked through in the
linked objects table, thanks to Renée Bäcker.

• Made possible to define ServiceIDs and SLAIDs as default shown ticket search
attributes, thanks to Paweł Bogusławski.

• Merged the add-on module OTRSTicketCloseRedirect. It is now possible by a new
SysConfig setting to stay in Ticket Zoom after an action that closes the ticket instead
of been redirected to the last overview screen or dashboard. This is now controlled
by the new SysConfig setting "Ticket::Frontend::RedirectAfterCloseDisabled".

• Merged the add-on module OTRSUserDefaultQueue, With a new SysConfig setting
now it is possible to pre-select a queue to create a ticket in the New Phone, Email
and Process ticket screens.

• Merged the add-on module OTRSAppointmentCalendar. Now OTRS provides a calendar
implementation that allows agents to manage and display multiple calendars and their
appointments.

• Improvements for working with customers

• Added dynamic field support for customer users and customers. This makes it possible
to attach additional data fields to customer users and customers (companies) without
making manual changes to the database.

• Modernized the OTRS address book. It is now possible to search for all configured
custom user and customer fields.

• Added the Customer User Information Center frontend. This works like the existing
Customer Information Center, but focuses on all data of one particular customer user,
rather than a complete customer (company).

• Improved the selection of customers in various screens by adding autocomplete
fields.

• Added support for proper Chinese name formatting, thanks to Dian Tong Software.

• Removed custom spell-checker in favor of using the built-in spell checker features of
the different browsers.
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• Email articles now support display of their transmission status in the agent zoom
screen. Messages with errors will be flagged as such, and automatic notifications will be
triggered for relevant agents. Useful email resend screen can be used to resend failed
messages.

• Added option for dashboard widgets to mark them as mandatory. With this feature
administrators have the ability to configure dashboard widgets that can't be disabled
by the agents individually.

• Added the possibility to filter content of the CCI Dashboard Widget.

2.2.6.2. Usability & Accessibility

• Added beautiful drag & drop multi file upload for agent and customer interface.

• Added a high contrast skin for visually impaired agents.

2.2.6.3. スケーラビリティー & パフォーマンス

• Improved session storage to no longer include permission information. This should result
in significant performance gains for large systems with many agents and groups.

• Moved ticket number counter from the TicketCounter.log file to the database. This allows
OTRS to process incoming e-mails much faster and in parallel.

• Improved web upload cache performance, thanks to Paweł Bogusławski.

• Improved Generic Agent performance at deleting old execution times. Thanks to Moritz
Lenz @ noris networks!

2.2.6.4. セキュリティ

• Made bcrypt cost configurable for agent and customer password hashing, thanks to
Paweł Bogusławski.

2.2.6.5. 外部システムとの作業

• Web service improvements

• Added support for additional response headers in REST and SOAP provider
configuration.

• Added possibility to filter for events before calling Invokers.

• Added the possibility to include the ticket data in web service response data.

• Added automatic cleanup of old web service debug log information.

• Added new operations TicketHistoryGet and SessionGet.

• Updated default web service configurations.

• Improved Authentication, Proxy and SSL handling in SOAP and REST transport.

• Improved usability of debugger.

• Added SOAPAction naming flexibility.

• Improved SOAP output generation.

• Prevent usage of invalid web services in provider.
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• Globally changed wording from 'webservice' to 'web service'.

• Added error handling to the Generic Interface.

• Improved XSLT mapping functionality.

• Email improvements

• Added possibility to configure default headers for outgoing emails
(Sendmail::DefaultHeaders), thanks to Renée Bäcker.

• Added possibility to use multiple named captures in Postmaster filters, thanks to
Renée Bäcker.

• Added possibility to set the ticket title in Postmaster filters, thanks to Renée Bäcker.

• Add support for setting owner and responsible via filter also for follow-ups, thanks to
Renée Bäcker.

• Make it possible to re-enable auto responses from Postmaster filters by setting X-
OTRS-Loop to no/false, thanks to Paweł Bogusławski.

• All email communication is now being queued for sending and handled by dedicated
scheduled daemon task. In case of errors, multiple retries will be scheduled, in order
to alleviate temporary problems.

• Added possibility to add an external link to the action menu in AgentTicketZoom,
thanks to Paweł Bogusławski.

2.2.6.6. インストールとアドミニストレーション（管理）

• Renewed system configuration mechanism including a totally new graphical user
interface.

• Added possibility to review changes before they are effective.

• Exclusively edit settings, so other administrators can not change the same setting
at the same time.

• Added possibility to define favorite settings for quick access.

• Added new console commands to display and update setting values
(Maint::Config::Dump and Maint::Config::Rebuild).

• Added possibility to distribute configuration states to all nodes in a cluster
environment.

• Added new command Admin::Package::UpgradeAll, which allows updating all installed
packages at once. This can also be triggered from the package manager screen.

• Renewed main administration screen.

• Renewed user preferences screen.

• Added SHA-512 as new password digest method to agent and customer authentication.

• Added support for multi-tiered customer and customer user relationships.

• Added the possibility to use the auto complete search for the customer ID selection in
the user management frontend.

7



• Improved command Maint::Ticket::InvalidUserCleanup. It can now now both unlock
tickets of invalid users and also (optionally) change their state to make sure they will
not be overlooked. Thanks to Moritz Lenz @ noris networks!

• Added per-address email loop protection configuration
(PostmasterMaxEmailsPerAddress), thanks to Moritz Lenz.

• Added console command to list configured queues, thanks to Martin Burggraf.

• Added completely new log mechanism for email communications. The dashboard-like
display allows administrators to quickly see what might be wrong in their system
regarding receiving and sending emails. Account overview can be used to determine
which mail accounts might be having issues and why. Detailed logging should help
figuring out how an email was processed by the system before ending up in a specific
ticket.

2.2.7. OTRS 5 での新機能
2.2.7.1. 生産性

• OTRSは、さまざまな大きさ・種類のモバイルデバイスで利用できるように最適化されていま
す。

• 単一ないし複数選択可能な入力フィールドは、近代化と高度な検索とフィルタリング機能を備え
ています(MühlbauerのDusan Vuckovic氏に感謝)。

• WYSIWYG エディタを介してコピー&ペーストやドラッグ&ドロップすることにより、アプリ
ケーションの外からでも画像ファイルを追加・アップロードすることができます(ブラウザ問わ
ず、アドオンも不要です)。

• チケット通知システムが改善されました。お好みのトリガーや受信者の定義をもとにチケット通
知を設定することが可能です。OTRS Business Solution™ を利用される場合は、SMS や
Notification Web View を通じて通知を受け取ることもできます。 Notification Web
View は、一般的な電子メールクライアントを使わなくてもすべてのエージェント通知を把握で
きる、OTRS 独自のスクリーン機能です。

• Statistics received a new graphical user interface which is much better accessible and
helps to create great statistics quickly and easily.

• これに加えて、統計機能は新たに四半期ならびに半期をサポートしました。

• It is now possible to group action menu items in the ticket zoom screen. Less often used
items can be grouped in a submenu, improving screen usage and clarity.

• チケット・オーバービューで顧客企業データを表示できるようになりました。（ Renée Bäcker
に感謝！）

• チケットプロセスの遷移アクション「チケット作成」で、記事を含まないチケットを作成可能に
なりました。

2.2.7.2. スケーラビリティー & パフォーマンス

• 新しいOTRSデーモンは、非同期かつ定期的にタスクを処理する、これまでのcronジョブに代わ
る機能です。クラスタ構成でもノード間で自動的に調整を行います。

• 複数の読込み専用ミラー(スレーブ)データベースを指定可能になったことにより、統計情報や全
文検索などの複数のデータベースに亙って行う高度な計算に対応しました。

2.2.7.3. セキュリティ

• 新たにログインセキュリティを向上させる2要素認証レイヤが追加されました。
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• 固定ユーザー名とパスワードに加えて、時刻ベースのオープンスタンダードなワンタイムパス
ワードを入力する必要があります(RfC 6238、通称 Google Authenticator)。

• After having enabled the two-factor authentication, agents and customers can add a
shared secret to their preferences and immediately start logging in using one-time
passwords created by a compatible method of their choice (e.g. the Android Google
Authenticator app).

2.2.7.4. 外部システムとの作業

• A new XSLT based GenericInterface mapping module allows for arbitrarily complex user-
defined data mapping.

2.2.7.5. インストールとアドミニストレーション（管理）

• The new OTRS console makes working on the commandline easy and fun. All commands
have a consistent interface, useful documentation and provide helpful colored output.

• Administrators can now specify a minimum log level to reduce logging volume, thanks
to Renée Bäcker.

• Overview screens in the admin area now show invalid entities in gray, making it easy
to focus on active elements.

2.3. ハードウェアとソフトウェアの必要条件
OTRS can be installed on many different operating systems. OTRS can run on linux and on
other unix derivates (e.g. OpenBSD or FreeBSD). OTRS does not have excessive hardware
requirements. We recommend using a machine with at least a 3 GHz Xeon or comparable
CPU, 8 GB RAM, and a 256 GB hard drive.

さらに、OTRSを実行するために、ウェブサーバとデータベース・サーバを使用する必要があるで
しょう。それとは別に、perlをインストールし、かつ、またはいくつかの追加のperlモジュールを
OTRSマシンにインストールするべきです。OTRSと同じマシンにウェブサーバとパールをインス
トールしなければいけません。データベース・バックエンドは、ローカルにあるいは別のホスト上
でインストールしても結構です。

ウェブサーバについては、Apache HTTP Serverの利用をお勧めします。そのモジュールmod_perl
がOTRSの性能を非常に改善するためです。それとは別に、OTRSは、Perlスクリプトを実行するこ
とができるウェブサーバ上で走らせるべきです。

異なるデータベース上のOTRSを展開させることができます。MySQL、PostgreSQLあるいはOracle
のいずれかを選択可能です。MySQLあるいはPostgreSQLを使用すれば、ウェブ・フロントエンド
によって、インストール中にデータベースおよびいくつかのシステム設定を行うことができるとい
う長所があります。

Perlには、Perl ShellとCPANモジュールもしくはご利用のオペレーティング・システム向けのパッ
ケージ・マネージャー（rpm, yast, apt-get）を介して追加モジュールを導入する必要になること
があります。

ソフトウェア必要条件

2.3.1. Perlサポート
• Perl 5.16 or higher

2.3.2. ウェブサーバ・サポート
• Apache2, nginx or any other web server that can be used as a reverse proxy
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2.3.3. データベース・サポート
• MySQL 5.0以上

• MariaDB

• PostgreSQL 9.2 or higher

• Oracle 10g以上

2.3.4. Other Dependencies
• Elasticsearch 6.0 or or higher

• Node.js 8.9 or higher

Perl・モジュールのインストールに関するマニュアル中のセクションは、OTRSに必要とされるもの
をどのようにセット・アップすることができるかをより詳細に説明しています。

2.3.5. ウェブブラウザー・サポート
To use OTRS, you'll be OK if you use a modern browser with JavaScript support enabled.
Supported Browsers are:

• Google Chrome

• Firefox version 31 and higher

• Safari version 6 and higher

• Internet Explorer version 11 and higher, Microsoft Edge

We recommend keeping your browser up-to-date. JavaScript and rendering performance
in newer versions is always improved. Dramatic performance issues can be seen in larger
systems when using older versions. We are happy to consult you on that matter.

2.4. コミュニティー
OTRS has a large user community. Users and developers discuss OTRS and exchange
information on related issues through the mailing-lists. You can use the mailing lists to
discuss installation, configuration, usage, localization and development of OTRS. You can
report software bugs in our bug tracking system.

OTRSコミュニティーのホームページは次のとおりです:http://www.otrs.com/open-source/ .

2.5. OTRSのためのプロフェッショナル・サービス
We offer best professional support from the OTRS team, reliable OTRS security and regular
free updates as well as an exclusive set of additional Business Features that you can
flexibly activate or deactivate according to different deployment scenarios.

The OTRS Group offers specific training programs in different countries. You can either
participate in one of our public OTRS Administrator trainings which take place regularly,
or benefit from an inhouse training that covers all the specific needs of your company.
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第2章 インストール
This chapter describes the installation and basic configuration of the central OTRS
framework.

本章の詳細なステップに従ってOTRSをサーバにインストールしましょう。インストールが完了した
らウェブ・インターフェースを使用してシステムにログインし管理することができます。

1. Installation From Source (Linux,
Unix)
1.1. Preparation: Disable SELinux
注記
If your system uses SELinux, you should disable it, otherwise OTRS will not work
correctly.

Here's how to disable SELinux for RHEL/CentOS/Fedora:

• Configure SELINUX=disabled in the /etc/selinux/config file:

# This file controls the state of SELinux on the system.
# SELINUX= can take one of these three values:
#       enforcing - SELinux security policy is enforced.
#       permissive - SELinux prints warnings instead of enforcing.
#       disabled - No SELinux policy is loaded.
SELINUX=disabled
# SELINUXTYPE= can take one of these two values:
#       targeted - Targeted processes are protected,
#       mls - Multi Level Security protection.
SELINUXTYPE=targeted
                        

• Reboot your system. After reboot, confirm that the getenforce command returns
Disabled:

root> getenforce
Disabled
                        

1.2. Step 1: Unpack and Install the
Application

Unpack the source archive (for example, using tar) into the directory /opt, and rename
the directory from otrs-x.x.x to otrs (see Script below).

root> tar xzf /tmp/otrs-x.x.x.tar.gz
root> mv otrs-x.x.x /opt/otrs
        

1.3. Step 2: Install Additional Programs and
Perl Modules

Use the following script to get an overview of all installed and required CPAN modules
and other external dependencies.
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root> perl /opt/otrs/bin/otrs.CheckEnvironment.pl
Checking for Perl Modules:
  o Archive::Tar.....................ok (v1.90)
  o Archive::Zip.....................ok (v1.37)
  o Crypt::Eksblowfish::Bcrypt.......ok (v0.009)
...
            

注記
Please note that OTRS requires a working Perl installation with all "core" modules
such as the module version. These modules are not explicitly checked by the
script. You may need to install a perl-core package on some systems like RHEL
that do not install the Perl core packages by default.

OTRS requires a supported stable version of Node.js to be installed. Please refer to the
Node.js installation instructions.

1.4. Step 3: Create the OTRS User
Create a dedicated user for OTRS:

root> useradd -d /opt/otrs -c 'OTRS user' otrs
            

1.5. Step 4: Activate the Default Config File
There is one OTRS config file bundled in $OTRS_HOME/Kernel/Config.pm.dist. You must
activate it by copying it without the ".dist" filename extension.

root> cp /opt/otrs/Kernel/Config.pm.dist /opt/otrs/Kernel/Config.pm
    

1.6. Step 5: Configure the Apache Web Server
OTRS comes with an own built-in web server that is used behind apache as a reverse
proxy (or any other reverse proxy server). A few apache modules are needed for correct
operation: proxy_module, proxy_http_module and proxy_wstunnel_module.

# On some systems like Debian and SuSE, these modules need to be specifically enabled:

root> a2enmod proxy
root> a2enmod proxy_http
root> a2enmod proxy_wstunnel
        

Most Apache installations have a conf.d directory included. On Linux systems you can
usually find this directory under /etc/apache or /etc/apache2. Log in as root, change to
the conf.d directory and link the appropriate template in /opt/otrs/scripts/apache2-
httpd.include.conf to a file called zzz_otrs.conf in the Apache configuration directory
(to make sure it is loaded after the other configurations).

# Debian/Ubuntu:
root> ln -s /opt/otrs/scripts/apache2-httpd.include.conf /etc/apache2/sites-enabled/
zzz_otrs.conf
        

Now you can restart your web server to load the new configuration settings. On most
systems you can do that with the command systemctl restart apache2.service.
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1.7. Step 6: Set File Permissions
Please execute the following command as root user to set the file and directory
permissions for OTRS. It will try to detect the correct user and group settings needed for
your setup.

root> cd /opt/otrs/
root> bin/otrs.SetPermissions.pl
        

1.8. Step 7: Setup the Database
The following steps need to be taken to setup the database for OTRS properly:

• Create a dedicated database user and database.

• Create the database structure.

• Insert the initial data.

• Configure the database connection in Kernel/Config.pm.

注記
Please note that OTRS requires utf8 as database storage encoding.

1.8.1. MySQL

#
# Run the following commands in mysql as admin user:
#

mysql -uroot -p

    # Create database
    CREATE DATABASE otrs CHARACTER SET utf8;

    # Create database user
    # Special handling for MySQL 8, as the default caching_sha2_password can only be used
 over secure connections.
    CREATE USER 'otrs'@'localhost' IDENTIFIED WITH mysql_native_password BY 'choose-your-
password';
    # Older mysql versions:
    CREATE USER 'otrs'@'localhost' IDENTIFIED BY 'choose-your-password';

    # Assign user privileges to the new database.
    GRANT ALL PRIVILEGES ON otrs.* TO 'otrs'@'localhost';
    FLUSH PRIVILEGES;

#
# Run the following commands on the shell:
#

# Create schema and insert data.
mysql -uroot -p otrs < /opt/otrs/scripts/database/otrs-schema.mysql.sql
mysql -uroot -p otrs < /opt/otrs/scripts/database/otrs-initial_insert.mysql.sql
mysql -uroot -p otrs < /opt/otrs/scripts/database/otrs-schema-post.mysql.sql

# Configure database settings in Kernel/Config.pm
$Self->{DatabaseHost} = '127.0.0.1';
$Self->{Database}     = 'otrs';
$Self->{DatabaseUser} = 'otrs';
$Self->{DatabasePw}   = 'choose-your-password';
$Self->{DatabaseDSN}  = "DBI:mysql:database=$Self->{Database};host=$Self->{DatabaseHost};";
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注記

The following configuration settings are recommended for MySQL setups. Please
add the following lines to /etc/my.cnf under the [mysqld] section:

max_allowed_packet   = 64M
query_cache_size     = 32M
innodb_log_file_size = 256M
                

1.8.2. PostgreSQL

#
# Run these commands as "postgres" user:
#
sudo su - postgres

    # Create database
    createdb --encoding=utf8 --owner=otrs otrs

    # Create database user
    echo "create user otrs password 'choose-your-password';" | psql

#
# Run these commands on the shell as 'otrs' user.
#

    # Create schema and insert data.
    export PGPASSWORD=some-pass
    psql otrs otrs -h localhost < /opt/otrs/scripts/database/otrs-schema.postgresql.sql
    psql otrs otrs -h localhost < /opt/otrs/scripts/database/otrs-
initial_insert.postgresql.sql
    psql otrs otrs -h localhost < /opt/otrs/scripts/database/otrs-schema-post.postgresql.sql

# Configure database settings in Kernel/Config.pm
$Self->{DatabaseHost} = '127.0.0.1';
$Self->{Database}     = 'otrs';
$Self->{DatabaseUser} = 'otrs';
$Self->{DatabasePw}   = 'choose-your-password';
$Self->{DatabaseDSN}  = "DBI:Pg:dbname=$Self->{Database};host=$Self->{DatabaseHost};";
                

1.8.3. Finishing the Database Setup
To verify your database setup, run the following command (as otrs user):

otrs> /opt/otrs/bin/otrs.Console.pl Maint::Database::Check
Trying to connect to database 'DBI:Pg:dbname=otrs;host=localhost' with user 'otrs'...
Connection successful.
                

Once the database is configured correctly, please initialize the system configuration with
the following command:

otrs> /opt/otrs/bin/otrs.Console.pl Maint::Config::Rebuild
Rebuilding the system configuration...
Done.
            

注記

For security reasons, please change the default password root of the admin user
root@localhost.
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otrs> /opt/otrs/bin/otrs.Console.pl Admin::User::SetPassword root@localhost
Generated password 'rtB98S55kuc9'.
Successfully set password for user 'root@localhost'.
                    

1.9. Step 8: Setup Elasticsearch Cluster
OTRS requires an active cluster of Elasticsearch 6.0 or higher. The easiest way is to setup
Elasticsearch on the same host as OTRS and binding it to its default port. With that, no
further configuration in OTRS is needed.

Additionally, OTRS requires plugins to be installed into Elasticsearch:

# Install required plugins for elasticsearch.
root> /usr/share/elasticsearch/bin/elasticsearch-plugin install --batch ingest-attachment
root> /usr/share/elasticsearch/bin/elasticsearch-plugin install --batch analysis-icu
            

To verify the Elasticsearch installation, you can use the following command:

otrs> /opt/otrs/bin/otrs.Console.pl Maint::DocumentSearch::Check
Trying to connect to cluster...
  Connection successful.
            

1.10. Step 9: Start the OTRS Daemon and
Web Server

The new OTRS daemon is responsible for handling any asynchronous and recurring tasks
in OTRS. The built-in OTRS web server process handles the web requests handed over
from Apache. Both processes must be started from the otrs user.

otrs> /opt/otrs/bin/otrs.Daemon.pl start
otrs> /opt/otrs/bin/otrs.WebServer.pl
            

1.11. Step 10: First Login
Now you are ready to login to your system at http://localhost/otrs/index.pl as user
root@localhost with the password that was generated (see above).

1.12. Step 11: Setup Cron Jobs
There are two default OTRS cron files in /opt/otrs/var/cron/*.dist, and their purpose
is to make sure that the OTRS Daemon is running. They need to be be activated by copying
them without the ".dist" filename extension.

otrs> cd /opt/otrs/var/cron
otrs> for foo in *.dist; do cp $foo `basename $foo .dist`; done
            

To schedule these cron jobs on your system, you can use the script Cron.sh with the
otrs user.

otrs> /opt/otrs/bin/Cron.sh start

# Stopping the cron jobs is also possible (useful for maintenance):
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otrs> /opt/otrs/bin/Cron.sh stop
            

With this step, the basic system setup is finished.

1.13. Step 12: Setup Bash Autocompletion
(optional)

All regular OTRS commandline operations happen via the otrs Console interface bin/
otrs.Console.pl. This provides an auto completion for the bash shell which makes
finding the right command and options much easier.

You can activate the bash autocompletion by installing the package bash-completion.
It will automatically detect and load the file /opt/otrs/.bash_completion for the otrs
user.

After restarting your shell, you can just type bin/otrs.Console.pl followed by TAB, and
it will list all available commands. If you type a few characters of the command name, TAB
will show all matching commands. After typing a complete command, all possible options
and arguments will be shown by pressing TAB.

1.14. Step 13: Further Information
We advise you to read the OTRS performance tuning chapter.

Please have a look at the list of additional resources for information about OTRS Group,
the creator of and service provider for OTRS, and futher resources.

2. Updating OTRS
注記

最初に独立した試験機でのテスト·アップデートを実行することを強くお勧めします。

Updating from an earlier version of OTRS 7

You can update directly from any previous to the latest available patch level release.

Updating from OTRS 6

You can update from any OTRS 6 patch level to the latest available OTRS 7 patch level
release.

Updating from OTRS 5 or earlier

警告

You cannot update from OTRS 5 or earlier directly to OTRS 7. Full updates to all
available minor versions have to be made sequentially instead. For example,
if you come from OTRS 4.0, you first have to perform a full update to OTRS 5,
then to 6 and finally to OTRS 7.

2.1. Step 1: Stop all relevant services and the
OTRS Daemon

Please make sure there are no more running services or cron jobs that try to access OTRS.
This will depend on your service configuration, here is an example:
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root> /etc/init.d/cron stop
root> /etc/init.d/postfix stop
root> /etc/init.d/apache stop
            

Stop OTRS cron jobs and the daemon (in this order):

otrs> cd /opt/otrs/
otrs> bin/Cron.sh stop
otrs> bin/otrs.Daemon.pl stop
            

If you perform a patch level update of OTRS 7, you need to also stop the built-in OTRS
web server:

otrs> cd /opt/otrs/
otrs> bin/otrs.WebServer.pl --stop
            

2.2. Step 2: Backup files and database
• Kernel/Config.pm

• Kernel/WebApp.conf (only in case of a patch level update of OTRS 7, and only if the
file was modified)

• var/*

• データベースも同様に行います。

警告

Don't proceed without a complete backup of your system.

2.3. Step 3: Install the new release
注記

With OTRS 7 RPMs are no longer provided. RPM based installations need to switch
by uninstalling the RPM (this will not drop your database) and using the source
archives instead.

root> cd /opt
root> mv otrs otrs-old
root> tar -xzf otrs-x.x.x.tar.gz
root> mv otrs-x.x.x otrs
        

2.3.1. 旧構成ファイルをリストア
• Kernel/Config.pm

• Kernel/WebApp.conf (only in case of a patch level update of OTRS 7, and only if the
file was modified)

2.3.2. 記事データのリストア
If you configured OTRS to store article data in the file system you have to restore the
article folder to /opt/otrs/var/ or the folder specified in the System Configuration.
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2.3.3. Restore already installed default statistics
If you have additional packages with default statistics you have to restore the stats xml
files with the suffix *.installed to /opt/otrs/var/stats.

root> cd OTRS-BACKUP/var/stats
root> cp *.installed /opt/otrs/var/stats
            

2.3.4. Set file permissions
Please execute the following command as root user to set the file and directory
permissions for OTRS. It will try to detect the correct user and group settings needed for
your setup.

root> cd /opt/otrs/
root> bin/otrs.SetPermissions.pl
            

2.3.5. Install Required Programs and Perl Modules
Please refer to the section in the installation guide that explains how to verify external
dependencies such as Perl modules and Node.js.

In addition to that, OTRS 7 also requires an active cluster of Elasticsearch 6.0 or higher.
Please refer to the Setup Elasticsearch Cluster section in the installation guide.

2.4. Step 4: Run the migration script
注記

If you have any custom Perl or XML configuration files in Kernel/Config/Files,
these need to be converted to the new formats supported by OTRS 7 before
running the migration script.

The migration script will perform many checks on your system and give you advice on
how to install missing Perl modules etc., if that is required. If all checks succeeded, the
necessary migration steps will be performed. Please also run this script in case of patch
level updates.

Run the migration script (as user otrs, NOT as root):

otrs> cd /opt/otrs/
otrs> scripts/DBUpdate-to-7.pl
        

警告

Do not continue the upgrading process if this script did not work properly for you.
Otherwise malfunction or data loss may occur.

2.5. Step 5: Update installed packages
注記

Packages for OTRS 6 are not compatible with OTRS 7 and have to be updated.
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You can use the command below to update all installed packages. This works for all
packages that are available from online repositories. You can update other packages later
via the package manager (this requires a running OTRS Daemon).

otrs> cd /opt/otrs/
otrs> bin/otrs.Console.pl Admin::Package::UpgradeAll
        

2.6. Step 6: Restart your services
OTRS 7 comes with an own built-in web server that is used behind apache as a reverse
proxy (or any other reverse proxy server). For major updates from OTRS 6, the apache
configuration must be updated with the new version in /opt/otrs/scripts/apache2-
httpd.include.conf, if it was copied and not just linked. Please also note that while
mod_perl is no longer needed, other Apache modules are required now: proxy_module,
proxy_http_module and proxy_wstunnel_module.

After that, the services can be restarted. This will depend on your service configuration,
here is an example:

root> /etc/init.d/apache start
root> /etc/init.d/postfix start
root> /etc/init.d/cron start
        

注記

The OTRS Daemon is required for correct operation of OTRS such as sending
emails. Please activate it as described in the next step.

2.7. Step 7: Start the OTRS Daemon, web
server and cron job

The OTRS Daemon is responsible for handling any asynchronous and recurring tasks in
OTRS. The daemon and its keepalive cron job must be started as the otrs user. The built-
in OTRS web server process handles the web requests handed over from Apache.

otrs> cd /opt/otrs/
otrs> bin/otrs.Daemon.pl start
otrs> bin/Cron.sh start
otrs> bin/otrs.WebServer.pl
            

Now you can log into your system.
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第3章 ファースト・ステップ
The goal of this chapter is to provide a brief overview of OTRS and the structure of its
web interface. The terms 'agents', 'customers', and 'administrators' are introduced. We also
login as the OTRS administrator and take a closer look at the user preferences available
on every account.

1. Agent Web Interface
注記

Before logging on for the first time, please consider activating the HTTPS on your
web server in order for OTRS to be served as a secure app over SSL/TLS protocol.
For detailed instructions on how to do this, please consult the documentation of
your web server (e.g. Apache2).

After you activate HTTPS, please set the configuration option HttpType to https
in SysConfig. This will make sure that all internal links in OTRS are indeed using
HTTPS.

Good practice is to also redirect all HTTP traffic to HTTPS, in case someone tries
to access the OTRS via an insecure link. This should be done on web server
configuration level for maximum effect. However, in case this is not possible, you
can set HTTPSForceRedirect to Yes in SysConfig to do it on application level.

担当者は、担当者ウェブインターフェイスで顧客のリクエストに答えることができます。顧客のた
めあるいは他の担当者のために新規チケットを作成し、顧客との通話に関することをチケットに書
き、FAQを記入し、顧客データを編集します。

あなたのOTRSホストをhttp://www.example.comと仮定した場合、WebブラウザでURLhttp://
www.example.com/otrs/index.pl でOTRSログイン画面にアクセスすることができます(下図参
照)。

図3.1 Login screen of the agent interface
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2. Customer Web Interface
顧客は、OTRSの別々のウェブインターフェイスを持ち、それを通じて、新規アカウントを作成し、
アカウント設定を変更し、チケットを作成、編集し、作成したチケットに関する概要を取得するこ
とができます。

Continuing the above example, the customer login screen can be reached by using the
URL http://www.example.com/otrs/customer.pl with a web browser (see figure below).

図3.2 Login screen of the customer interface

3. Public Web Interface
担当者と顧客のためのウェブインターフェイスに加えて、OTRSにはさらにFAQモジュールによって
利用可能な公開ウェブ・インターフェースがあります。このモジュールを別々にインストールして
いる必要があります。それはFAQシステムに公衆アクセスを提供し、特別の認可のないFAQエント
リーをビジターに捜させます。

私達のサンプルでは, 公開ウェブインターフェイスは次のいずれかのURL : http://
www.example.com/otrs/faq.pl , http://www.example.com/otrs/public.plに到達できます。
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図3.3 公開ウェブインターフェイス

4. First Login
Access the login screen as described in the section Agent web interface . Enter a user
name and password. Since the system has just been installed and no users have yet been
created, login as OTRS administrator first, using 'root@localhost' for username and the
generated password in the last step of the installer.

警告

このアカウントデータは
　どの新規にインストールされたOTRSシステムでも有効です。OTRS管理者パスワードは
できるだけ早く変更すべきです。OTRS管理者用画面preferencesから実行できます。

If you don't want to login as OTRS administrator, just enter the username and password
for your normal agent account.

In case you have forgotten your password, you can request the system for a new
password. Simply press the link below the Login button, enter the username that is
registered for your OTRS account into the input field, and press the Request New Password
button (see figure).
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図3.4 新規パスワードを申請

5. The Web Interface - an Overview
Upon successfully logging into the system, you are presented with the Dashboard page
(see figure below). It shows your locked tickets, allows direct access through menus to
the queue, status and escalation views, and also holds options for creation of new phone
and e-mail tickets. It also presents a quick summary of the tickets using different criteria.
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図3.5 Dashboard of the agent interface

To improve clarity, the general web interface is separated into different areas. The top
row of each page shows some general information such as the logout button, icons listing
the number of locked tickets with direct access to them, links to create a new phone/e-
mail ticket, etc. There are also icons to go to the queue, status, and escalation views.

アイコンの下の行はナビゲーション・バーです。システムのモジュールや異なるエリアへナビゲー
トしてくれるメニューを表示し、いくつかの全体的アクションを実行させてくれます。ダッシュ
ボード・ボタンをクリックすることでダッシュボード行けます。チケット・ボタンをクリックすれ
ば、チケット・ビューを変更したり、新しいチケット(電話/Eメール)を作成したり、あるいは特定
のチケットを探索したりするオプションを備えたサブメニューを使えます。統計ボタンは、新しい
ものを作成し、既存のものを輸入して、登記済みの統計の概観からあなたが選ぶことを可能にする
メニューを表示します。顧客ボタンはあなたを顧客管理スクリーンヘ導きます。管理者ボタンのク
リックによって、管理者モジュールすべてにアクセスすることができます、それは新しい代理人、
キューなどを作ることを可能にします。さらにチケット探索をするサーチ・ボタンもあります。

関連するアプリケーションがインストールされている場合、例えばFAQ、サーベイ、これらのアプ
リケーションを起動するボタンも表示されます。

In the area below the navigation bar, different system messages can be shown. If you are
logged in as the default OTRS administrator user, you get a red message warning you not
to work using this system account.

現在表示しているセクションのタイトルの下に、いくつかのサブセクションがあります。別々の
ボックスに各１つづつ、作業中の画面に関する関連情報を含んでいます。

これらのボックスは各スクリーンの主要部分を含んでいます。それらは常に1つあるいはいくつか
のカラムで表示されます。ボックスはそれぞれ、現在のスクリーンに関する関連情報（例えば指
示、アドバイス、概観など）を格納することができます。さらに、各画面に関連するアクションを
実行するために必要なフォームあるいはツールも表示されます。例えば、レコードの追加、更新、
削除、ログのチェック、構成設定の変更等のアクションです。
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Finally at the bottom of the page, the site footer is displayed (see figure below). It contains
a link to directly access the OTRS official web site, or switch to mobile mode.

通常は、アイコン列、ナビゲーション・バーおよびフッタはウェブ・インターフェース上のすべて
の画面の中で同じに存在します。

図3.6 フッター

6. ダッシュボード
ダッシュボードはシステムのメインページです。ここでチケット・アクティビティに関連する他の
スタッフやチケットに関する概要を得ることができます。それは担当者にとっての日常業務のため
の出発点であると言えます。それはデフォルトでチケットの即時サマリーを表示します。サマリー
には他の情報の中で保留、エスカレーション、新規および対応中の情報があります。

ダッシュボードの最も重要な機能のひとつは完璧なカスタマイズ機能です。要素を表示あるいは非
表示にすることで思い通りに各パートを構成することができることを意味します。要素のヘッダを
クリックしながらドラッグし要素をどこにでもドロップすることで同じ列の中でこの要素を再配置
することさえ可能です。システムは、ボックスから使用する準備ができているいくつかのウィ
ジェットを持っています。しかし、ダッシュボード画面のモジュール設計は、カスタム・ウィ
ジェットを簡単に統合する準備ができています。

The content of this screen is arranged in two main columns, on the left column you
normally can see information about tickets classified by their states like: reminder,
escalated, new, and open. On each of this widgets you can filter the results to see all
of the tickets that you are allowed to access, tickets you have locked, the ones that are
located in agent defined queues, among other filters. There are also other kind of widgets
in this column and they are all described below.
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図3.7 ダッシュボード・ウィジェット

左列 ダッシュボード・ウィジェット

• チケット・リスト・ウィジェット

このカテゴリーの下のウィジェットは全体的な同じ挙動、ルック・アンド・フィールを共有しま
す。このウィジェットは決定した状態のチケットのリストを表示します。チケット数は各リス
ト・ページに表示します。リスト・ページは、ウィジェット・オプション(あなたがウィジェット
の右上部上にマウスポインタを置くとそれらが現われます)で構成することができます。このウィ
ジェットは次のフィルタを支援します:

• 自身のロック・チケット

ログインした担当者がロックされたチケット

• 自身の監視チケット

The tickets that the logged agent has in his/her watched list, requires
Ticket::Watcher setting to be turned on to be displayed.

• 自身の責任者

The tickets that the logged agent is set as responsible, Ticket::Responsible setting
is required to be turned on in order to make this filter visible.

• 自身のキューにあるチケット

The tickets that are on queues where the agent define as My Queues.

• 担当サービス内チケット

26



The tickets that are assigned to services where the agent define as My Services and
are on queues with at least read-only permissions.

• 全てのチケット

担当者がアクセス権を持つ全てのチケット

このウィジェットは：

• リマインダ・チケット

保留として設定され、かつ、リマインダ日を経過したチケット。

• エスカレーションされたチケット

エスカレーション済のチケット

• 新規チケット

Tickets that have state New.

• 対応中チケット / 返答必要

Tickets that have state Open and are ready for work with them.

• イベント・チケット・カレンダー

カレンダ・イベントは新規チケットが作成された時、イベント・チケット・カレンダ機能が有効
になります。それはチケット作成画面に表示する２つの新規フィールドを必要とし、ひとつはイ
ベント開始時刻、他方は終了時刻用です。この２つの時刻がイベント期間を決定します。定義さ
れます。

このウィジェットは次のビューを含みます：月、週、日。担当者は左右の矢印を使用することで
ページからスクロールできます。

直前にウィジェットは十分に有効になっていないと述べたようにチケット用の「Date/Time」の
動的フィールドのいくつかはシステムに追加し、（管理者パネルにある動的フィールドリンク経
由で）それらをこのウィジェットのためにSysConfigで設定すべきです。両方の動的フィールド
はチケット生成画面に表示されるように構成されるべきです。それらは、カレンダのイベント
（開始及び終了時間）用の時間枠について記述するために、チケット生成あるいは他のチケッ
ト・アクション画面(例えば自由フィールド)中に満たされるべきです。チケット・ズーム画面
は、それが必要であると考えた場合、動的フィールドも示すように構成されるかもしれません。
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図3.8 イベント・チケット・カレンダー・ウィジェット

Further configurations for this widget could be found under the
Frontend::Agent::Dashboard::EventsTicketCalendar SubGroup in the SysConfig:

• カレンダー幅

カレンダの幅をパーセントで定義します。デフォルトは95%です。

• DynamicFieldStartTime

開始時間の動的フィールド名を定義します。

• DynamicFieldEndTime

終了時間の動的フィールド名を定義します。

• キュー

この設定で明記されたキュー上のチケットのみが、カレンダ・ビューで検討されます。

• DynamicFieldsForEvents

カレンダ・イベント・オーバーレイ画面に表示する動的フィールドを定義します。

• TicketFieldsForEvents

カレンダ・イベント・オーバーレイ画面に表示するチケット属性を定義します。

• チケット・キュー・外観
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このウィジェットは行がキューを表し列がチケット状態を表しているチケット・カウント・マト
リックスの中で表示します。各セルには、特定のキュー上に属する定義された状態上のチケット
数が表示されます。

ウィジェットは、集計行および集計列も表示します。集計行は、すべての示されたキュー上の各
状態のチケットの合計を表します。一方、集計列はすべての示された状態上で各キューのチケッ
トの合計を表します。

表示されるキューと状態はSysConfigで変更することができます

チケット・カウント数のどれかをクリックすると検索結果ページが開き、担当者にそれらのより
詳細な概要を得させます。

In the right column is located a special widget that allow you to control the widgets you
want to show or hide. This is the Settings widget. Click on it's header to expand the section
and see all available widgets, as shown in Figure. Each widget name has a checkbox.
Use this checkboxes to define the visibility of the widgets in the dashboard (unchecked
widgets will not be shown) after you define the visibility options and click on Save for
storing your changes. This section is fixed on the screen, this means you can't drag and
drop it, or close it.
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図3.9 Dashboard Settings
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右列ダッシュボード・ウィジェット

• 7日統計

それは、2行のラインを含んでいる過去7日にわたるチケット活動のグラフを示します。通常青い
色である第１行は、日次作成チケット数を表示し、通常オレンジ色の第２行は日次完了チケット
を表示します。

• 次回のイベント

エスカレーションするためあるいは既にエスカレーションされた至急のチケットはここにリスト
されます。このウィジェットからの情報は大変役立ちます。なぜなら、注意喚起する必要のある
チケットを知る機会を持つからです。そうしてどのチケットに労力を傾注したいのか、優先度を
置きたいのか、単に次の予定をチェックするのか、を決定することができます。

• OTRSニュース

OTRSアクティビティの完全なリストと新製品のリリースやパッチに関する大変重要な情報

• オンライン

ここで、現在システムにログインしている担当者に関する要約が示されます。さらにそれは、オ
ンラインの顧客用セクションを含んでいます。このウィジェットは通常非表示であることに注目
してください。それは前述の設定ウィジェットを使用して表示することができます。

7. キューとは何か？
多くのメールシステムでは、全てのメッセージが格納される受信ファイルに流し込むのが普通で
す。新しいメッセージはその受信ファイルの最後に追加されます。メール・クライアント・プログ
ラムはメールの読み書きに使用され、この受信ファイルを読み、ユーザにコンテンツを表示しま
す。

多くのメッセージを格納することもできるので、OTRSでのキューは多少受信ボックスと比較できま
す。キューにはさらに受信ボックスのメール・ファイル以上の特徴があります。OTRS担当者あるい
はユーザとして、チケットがどのキューに格納されているかを記憶しておく必要があります。担当
者は、キューにあるチケットを開き編集することができ、あるキューから別のキューに移動するこ
ともできます。しかし、なぜチケットを移動させるのでしょうか。

それについてより実践的な説明するために、example of a ticket systemで述べたマックスの会社
の例を思い出しましょう。マックスは彼のチームがビデオテープレコーダーを買う会社取引先のサ
ポートをよりよく管理することを可能にするためにOTRSをインストールしました。

全てのリクエストを持つ1つのキューは、この状況にとって十分です。しかし、マックスがさらに
いつかDVDレコーダーを売ることを決定後は、顧客は、ビデオテープレコーダーだけでなく新製品
に関する質問をします。より多くのEメールがマックスのOTRSの単一のキューに入り、起こって
いることの明瞭な事態を把握することは難しくなります。

マックスは、サポート・システムを再構成することを決定し、2つの新しいキューを追加します。
したがって、これで3つのキューが使用されていることになります。チケットシステムに到着する
新しいメッセージは、古いキュー「未対応(raw)」へ格納されます。2つの新しいキューのうち、1
つ「ビデオテープレコーダー」はもっぱらビデオテープレコーダーのリクエスト用、もう一方の
「dvdレコーダー」はもっぱらdvdレコーダーのリクエスト用です。

マックスはサンドラに未対応キューを注視し、顧客の要求に応じてメッセージを「ビデオレコー
ダ」キューまたは「dvdレコーダ」キューにソート（送る）します。

OTRSは、ユーザ、グループおよび役割のためのアクセス管理をサポートします。いくつかのユー
ザアカウントにのみアクセス可能なキューを設定することも簡単です。マックスは、さらにフィル
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タ・ルールで、リクエストを異なるキューに入れる別の方法を使用することができました。そうで
なければ、2つの異なるメールアドレスが使用される場合、サンドラは単に自動的に送信できない2
つの他のキューへそれらの電子メールを送信しなければなりません。

異なるキューへの受信メッセージをソートすることは、サポート・システムを組み立てて、かつ整
然としていておくのを助けます。担当者はキュー上の異なるアクセス権を持つ異なるグループへ配
置されるので、システムはさらに最適化することができます。キューは、ワークフロー・プロセス
を定義するかあるいは会社の構造を作るために使用することができます。マックスは例えば、「要
求、オファー、注文、請求」等を含む「販売」と呼ばれる別のキューを実行することができまし
た。マックスにとってそのようなキュー構造は、注文処理を最適化するのを助けることができまし
た。

キューの適切なデザインを通してのような改善されたシステム構造により、重要な時間および原価
の削減につなげることができます。キューは、会社の中のプロセスを最適化するのを支援すること
ができる。

8. キュー概要とは何か？
キュー概要は（チケットが表示され、読み書き権限を持つユーザに対する）全てのキューの一覧を
提供します。

図3.10 担当者用キュー・ビュー（デフォルト）

The queue overview offers a variety of options for daily work with OTRS. The first of these
is the My Queue. In the Agent Preferences, or when administering agents, a set of queues
can be defined for which the agent has been assigned to work within. All the tickets will
appear in this default view, when accessing the Tickets -> Queue View menu.

キュー・ビューによって提供される２番目のオプションは、個別のキューと作業すべきチケット含
むサブ・キューにドリルダウンするナビゲーションです。

In both of the view types, the user also has the added ability to see either all unlocked
tickets (this is the default filter), or the user can then choose to view all available tickets.
Tickets must be in one of the viewable state types to be shown in the queue view. Per
default, these are open, new, pending reminder, pending auto.

ユーザ補助のための視覚アラームがあります。
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図3.11 Agent Queue View visual alarms

視覚アラーム

• Highlight Age 1: Sets the age in minutes (first level) for highlighting queues that contain
untouched tickets. Seen in above in the Raw queue.

• Highlight Age 2: Sets the age in minutes (second level) for highlighting queues that
contain untouched tickets. Seen in above in the Postmaster queue.

• Blink: A blinking mechanism of the queue that contains the oldest ticket can be activated
using Ticket::Frontend::AgentTicketQueue###Blink. Not supported in all browsers.
In that case, the queue name will just appear in red color, as seen in above on the
queue Junk.

• Bold: The current queue will be bolded, as seen above in the My Queues.

9. ユーザー設定
OTRS users such as customers, agents and the OTRS administrator can configure their
account preferences as per their needs. Agent can access the configuration screen by
clicking on the gear icon at the top of the web interface (see figure below), and customers
must click on the "Preferences" link (see figure below).

図3.12 Agent's personal preferences

An agent can configure 4 different categories of preferences: User Profile, Notification
Settings, Miscellaneous, and Advanced. The default possibilities are:

ユーザ・プロファイル

• 現在のパスワードを変更

• Change your avatar image.

• インターフェイス言語を変更

• Select your personal time zone.
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• 業務外時間を活性化し構成

通知設定

• 「マイキュー」でモニターしたいキューを選択

• Select the services you want to monitor in "My Services".

• Configure which ticket notifications you want to receive (per transport method).

• Choose for which kind of appointment changes you want to receive notifications.

Miscellaneous

• フロントエンド・スキンを変更

• Set the refresh period for the overviews (Dashboard, Queue View, etc.).

• チケット作成後表示する画面を設定

• Define limits per page for different overview screens (Ticket, Dynamic Fields and
Communication Log).

Advanced

• Define their own values for some system configuration settings.

図3.13 Customer's personal preferences

顧客はウェブ・インターフェース言語を選択し、チケット概要用の更新間隔をセットし、表示する
チケット最大数を選択できます。また新しいパスワードをセットすることも可能です。
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第4章 管理
1. The Administration Area of OTRS
1.1. 基礎
次のシステム構成セッティングは、OTRS管理者が、OTRSウェブインターフェースの管理者ページへ
のアクセスをすることで利用可能です。それにより可能なことは、担当者、顧客、そしてキューの
追加。チケットとEメールの構成、FAQやITSMなどさらに多くの追加のパッケージをインストール
することです。

Agents who are members of the admin group can access the Admin area by clicking the
Admin link in the navigation bar (see figure below). Agents without sufficiently elevated
access rights will not be able to access this link.

図4.1 OTRS Administration Overview Screen

1.2. 担当者、グループおよび役割
1.2.1. 担当者

By clicking the link Agents, you get access to the agent management screen of OTRS (see
figure below). Administrators can add, change or deactivate agent accounts. Furthermore
they can also manage agent preferences, including the language and notification settings
for the individual agent's interface.

注記

OTRSの担当者アカウントは非活性化されますが、ここでは削除はされません。非活性化
は無効または無効-暫定のフラグを有効にセットするで実施されます。
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図4.2 担当者管理

To register an agent, click on the Add agent button, enter the required data and press
the Submit button at the bottom of the screen, as shown in Figure.

図4.3 新しい担当者を追加

新規担当者アカウントが作成された後、担当者に1つ以上のグループあるいは役割のメンバーを作
るべきです。グループと役割に関する情報は本章のグループ と役割のセクションにおいて利用可能
です。

1.2.2. グループ
Every agent's account should belong to at least one group or role. In a brand new
installation, there are three pre-defined groups available, as shown in Table 4-1.

表4.1 デフォルト・グループは新規のOTRSインストールで利用可能です

グループ 摘要

admin システムで管理業務を実行することができま
す。

stats OTRSのstatsモジュールにアクセスし、統計を
生成する資格があります。

users 担当者は読み書きの権限を持って、このグルー
プに属し、チケットシステムのすべての機能に
アクセスすることができます

注記

In a brand new OTRS installation, the agent 'root@localhost' belongs by default to
the admin, stats and users groups.
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You can access the group management page (see figure below) by clicking the Groups
link in the admin area.

図4.4 グループ管理

注記

担当者でそうであるように、OTRSグループは非活性化することができますが削除はできま
せん。非活性化は無効または無効-暫定のフラグを有効にセットするで実施されます。

グループにエージェントを追加する、またはグループに属するエージェントを変更するには、管理
画面からリンク「エージェント <-> グループ」を使用することができます。（下図参照）。

図4.5 担当者 <-> グループ管理

システムですべての役割および担当者の概要を得るためには、管理者ページの役割リンク<-> 担当
者をクリックして下さい。さらに、特定の要素を見つけるためにフィルタを使用することができま
す。担当者に関連付けられた役割を変更したい場合は、担当者の名前をクリックしてください(下記
の図を参照)。役割に関連付けられた担当者を変更するためには、あなたが編集したい役割をクリッ
クしてください(下記の図を参照)。
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図4.6 Change the groups an agent belongs to

図4.7 Change the agents that belong to a specific group

Each group has a set of rights associated with it, and each group member (agent) may
have some combination of these rights for themselves. A list of the permissions / rights
is shown in Table 4-2.

表4.2 OTRSグループに関連付けられる権限

権限 摘要

chat_observer Agents may take part silently in a chat
(available in OTRS Business Solution™).
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権限 摘要

chat_participant Agents may normally participate in a chat
(available in OTRS Business Solution™).

チャット所有者 Agents have full rights for a chat and can
accept chat requests (available in OTRS
Business Solution™).

読取り このグループのチケット、エントリー、キュー
へのRead onlyのアクセス

移動 このグループのエリア、キュー間におけるエン
トリーあるいはチケットの移動権限

作成 このグループのエリアまたはキュー間における
エントリーあるいはチケットの作成権限

メモ Right to add notes to tickets or entries in the
queues or areas of this group.

所有者 このグループのエリアまたはキュー間における
エントリーあるいはチケットのオーナーの更新
権限

優先度（priority） このグループのエリアまたはキュー間における
エントリーあるいはチケットの優先度の変更権
限

読書き このグループのエリアまたはキュー間における
エントリーあるいはチケットのフルのRead/
Write権限

注記

By default, the QueueView only lists tickets in queues that an
agent has rw access to, i.e., the tickets the agent needs to
work on. If you want to change this behaviour, you can set
Ticket::Frontend::AgentTicketQueue###ViewAllPossibleTickets  to Yes.

すべての利用可能なパーミションはデフォルトで表示されるとは限りません。これらの追加のパー
ミションは加えることができます。

表4.3 追加の許可グループ

権限 摘要

stats stats(統計)ページにアクセス権を与えます。

bounce（返送） Eメールメッセージを送り返す権限（チケット
ズームの返送ボタンで）。

compose（作成） チケットに対する回答を作成する権限。

customer（顧客） チケットの顧客を変更する権限。

転送 メッセージを転送する権限(転送ボタンで)。

pending （保留） チケットを保留にする権限。

phone （電話） チケットに通話を追加する権限。

responsible （責任者） チケットに対する責任担当者を変更する権限。

注記

These permissions can be added by changing the System::Permission
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1.2.3. 役割
Roles:"役割"は、強力な機能で、それにより非常にシンプルかつ迅速に多くの担当者のアクセス権
を管理できます。それらは、多くの担当者、グループおよびキューを抱える大きく複雑なサポー
ト・システムで特に役立ちます。下記の例でどのようなケースでご利用いただけば良いかを説明し
ます。

あなたのシステムが100人の担当者を持つと仮定します。単一のキューにアクセスを持つ100人中
90人は、全てのサポート依頼を取り扱う「サポート」と呼ばれるます。「サポート」キューは複数
の副キューを含みます。残りの10人の担当者は、システムの全てのキューへアクセスする許可を
持っています。この10人の担当者は、チケットを発行し、未対応のキューを見て対応し、「ジャン
ク」キューへスパム・メッセージを移動させます。

その会社は、何らかの製品を販売する新規部署を開設します。注文依頼、受注、注文確認あるいは
支払などの処理が必要となるでしょう。そして、会社の担当者のうちの数人は、OTRSを使用して、
これをすることになります。異なる担当者は、生成される新規のキューへのアクセスを得なければ
いけません。

個々の担当者のためにアクセス権を手動で変更するのに長い時間がかかるので、異なるアクセスレ
ベルを定義する”役割”を作成することができます。その後、担当者は、自動的に修正済のアクセス
権を持つことにより、1つ以上の役割に加えることができます。新規担当者アカウントが作成され
る場合、さらに、このアカウントを1つ以上の役割に加えることは可能です。

注記
Roles are really useful when dealing with complex organizations and when
maintaining larger OTRS installations. Proper care is advised though. Mixing Agent
to Group with Agent to Role mappings can make for a complex access control
scheme, that is difficult to understand and maintain. If you wish to use only roles
and disable the Agents <-> Groups option in the Admin area, you can do so by
modifying the Frontend::Module###AdminUserGroup in the SysConfig. Be aware
that this won't remove already existing Agents to Group assignments!

管理ページにある 役割 リンクをクリックすることで、役割管理セクション(下図参照)にアクセスで
きます。

図4.8 役割管理

注記
担当者とグループでそうであったように、いったん作成された役割は、非活性化すること
ができるが削除することができません。非活性化するためには、有効オプションで「無
効」あるいは「無効-暫定」にセットするします。

An overview of all roles in the system is displayed. To edit a role's settings, click on the
role's name. In a fresh new OTRS installation, there are no roles defined by default. To
register one, click on the Add role button, provide the needed data and submit it (see
figure below).
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図4.9 新しい担当者の追加

システムですべての役割および担当者の概要を得るためには、管理者ページのリンク「役割<-> 担
当者」をクリックして下さい。さらに、特定の要素を見つけるためにフィルタを使用することがで
きます。担当者に関連付けられた役割を変更したい場合は、担当者の名前をクリックしてください
(下図参照)。役割に関連付けられた担当者を変更するためには、あなたが編集したい役割をクリッ
クしてください(下図参照)。

図4.10 Change the roles associated with an agent

図4.11 Change the agents associated with a specific role

システムでのすべての役割およびグループの概要を得るためには、管理者ページのリンク・役割<-
>グループをクリックしてください。図で表示されたと同様の画面が見えることでしょう。さら
に、特定のエンティティ（実体）を見つけるためにフィルタを使用することができます。

図4.12 Manage roles-groups relations
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To define the different access rights for a role, click on the name of a role or a group (see
below the Figures 4.13 and 4.14, respectively).

図4.13 Change group relations for a role

図4.14 Change role relations for a group

1.3. Customer Users and Customers
1.3.1. 顧客ユーザー

OTRS supports different types of users. Using the link Customer Users (via the navigation
bar, or the Admin page), you can manage the accounts of your customer users (see figure
below), who can log into the system via the Customer Users interface (customer.pl).
Through this interface, your customers can not only create tickets but also review their
past tickets for new updates. It is important to know that a customer user is needed for
the ticket history in the system.
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図4.15 Customer User management

You can search for a registered customer user, or edit their settings by clicking on
their name. You also have the possibility to change the customer back-end, for further
information please refer to the chapter about external back-ends.

To create a new customer user account, click on the Add customer user button (see figure
below). Some of the fields are mandatory, i.e., they have to contain values, so if you leave
one of those empty, it will be highlighted in red.

図4.16 Adding a customer user

Customer Users can access the system by providing their username and password. The
CustomerID is needed by the system to identify the user and associated tickets. Since the
email address is a unique value, it can be used as the ID.

With the configuration parameter AdminCustomerUser::UseAutoComplete in the Admin
SysConfig the autocomplete field can be activated for the customer ID selection in the
customer user add or edit screen.
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注記

As with agents, groups and roles, customer users can not be deleted from
the system, only deactivated by setting the Valid option to invalid or invalid-
temporarily.

1.3.2. Customer Users ↔ Customers Relations
Customer users can be assigned to multiple customers (and vice-versa) using the link
Customer Users ↔ Customers on the admin page. In addition to their own (primary)
customer, they will be linked to any other customer for which there is a defined relation.

This gives them access to tickets of customer users from these customers.

図4.17 Customer Users-Customers relations management

1.3.3. 顧客ユーザー ↔ グループ
Customer users can also be added to a group, which can be useful if you want to add
customer users of the same company with access to one or a few queues. First create
the group to which your customer users will belong, via the Group management module.
Then add the queues and select the new group for the queues.

The next step is to activate the customer group support. This can be done with the
configuration parameter CustomerGroupSupport, from the Admin SysConfig option. Using
the parameter CustomerGroupAlwaysGroups, you can specify the default groups for a
newly added customer user, so that every new account will be automatically added to
these groups.

Through the link Customer Users ↔ Groups you can manage which customer shall belong
to the different groups (see figure below).

図4.18 Customer Users-Group relations management

To define the different groups a customer should be part of and vice versa, click on
the corresponding customer username or group (see below the Figures 4.18 and 4.19,
respectively).
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図4.19 Change Group relations for a Customer User

図4.20 Change Customer user relations for a Group

1.3.4. 顧客 ↔ グループ
Customers can also be added to a group, which can be useful if you don't want to
add group relations to every single customer user. First create the group to which your
customers will belong, via the Group management module. Then add the queues and
select the new group for the queues.

The next step is to activate the customer group support. This can be done with the
configuration parameter CustomerGroupSupport, from the Admin SysConfig option. Using
the parameter CustomerGroupAlwaysGroups, you can specify the default groups for a
newly added customers, so that every new customer will be automatically added to these
groups. Available permission levels can be changed via configuration.

Assigned permissions will be shared among all customer users of this customer, so
permissions don't have to be given individually to every customer user (although this is
still possible if required).

Different contexts of permission assignment are available, which will determine how the
permissions are inherited by customer users.

The following contexts are available:

• 同じ顧客
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Group permissions will be inherited by all customer users of this customer. This provides
them with access to tickets of all customer users from the this customer if they are
located in a queue that's assigned to this group.

• Other Customers

Group permissions will be inherited by all customer users of this customer. This provides
them with access to tickets of all customer users from other customers if they are
located in a queue that's assigned to this group and if the other customer also has
permissions to this group.

Access is limited to the level the customer user of a ticket has.

Through the link Customers ↔ Groups you can manage which customer shall belong to
the different groups (see figure below).

図4.21 Customers-Group relations management

To define the different groups a customer should be part of and vice versa, click on
the corresponding customer username or group (see below the Figures 4.18 and 4.19,
respectively).

図4.22 Change Group relations for a Customer User
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図4.23 Change Customer user relations for a Group

1.3.5. Customer permission functionality explained
Access to tickets on the customer interface with enabled group support is mostly
evaluated by a combination of group and individual (customer/customer user based)
permission. Only if both criteria are met, specific access is granted.

If the resulting access is rw, a customer user can view and modify a ticket, if the access
is ro only viewing is possible.

For ticket creation only the group permissions are used and a customer user can create
tickets for all queues with rw permissions (unless restricted otherwise, e.g. ACL or
CustomerPanelOwnSelection).

Group permissions are additive (meaning that only one method needs to grant
permissions) and the following possibilities are taken into account:

• Customer user default groups via SysConfig setting

• Groups assigned to the customer user via Customer Users ↔ Customers admin frontend

• Customer default groups via SysConfig setting

• Groups assigned to the customer via Customers ↔ Groups admin frontend

For the methods above, all customers related to a customer user are used. This includes
the 'primary' customer (selected in Customer User admin frontend), additional customers
(added in Customer Users ↔ Customers admin frontend) and other customer that might
exist in the backend.

Individual permission checks require one of the following conditions to be met:

• Ticket is assigned to the customer user

• Ticket is assigned to a customer that the customer user is related to (as explained
above)

• Ticket is assigned to a customer with group permissions for the ticket queue while a
customer related to the customer user has Other Customers permission to the same
group

An example for the last item to clarify the functionality:

• Ticket is assigned to customer user 'Arvid Karlsson' with related customer 'Ericsson AB'

• Ticket is located in queue 'Support Sweden'
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• Queue 'Support Sweden' is in group 'support-se'

• Customer 'Ericsson AB' has 'Same Customer' context 'rw' permission to group 'support-
se'

• Logged in customer user is 'Barry Smith' which is related to customer 'Farmers Inc.'

• Customer 'Farmers Inc.' has 'Same Customer' context 'ro' permission to group 'support-
se'

• Now, if Customer 'Farmers Inc.' is given 'Other Customers' context 'ro' permission to
group 'support-se', Barry Smith will be able to view the ticket

• In order for Barry to modify the ticket, 'rw' permission is required for both 'Same
Customer' and 'Other Customers' context

1.3.6. Multi-Tier Customer Relationship Usage/Setup
Example

In this example we will create a multi-tier customer structure with resulting ticket
permissions. To get the same results you will need a relatively clean system without many
customizations.

First, create following customers through 'Admin → Customers' frontend:

• CustomerID: de, Customer: Graubrot AG

• CustomerID: mx, Customer: Hernandez SA

• CustomerID: se, Customer: Ericsson AB

• CustomerID: us, Customer: Farmers Inc.

Next, create the following customer users through Admin → Customer Users frontend and
assign them to the already created customers. Use any valid email addresses for Email
field.

• Firstname: Arvid, Lastname: Karlsson, Username: ak, CustomerID: Ericsson AB

• Firstname: Barry, Lastname: Smith, Username: bs, CustomerID: Farmers Inc.

• Firstname: Christian, Lastname: Müller, Username: cm, CustomerID: Graubrot AG

• Firstname: Diego, Lastname: Garcia, Username: dg, CustomerID: Hernandez SA

Then, go to 'Admin → Groups' frontend and add the following as new groups:

• faq-amer

• faq-emea

• support-de

• support-mx

• support-se

• support-us

Then, go to Admin → Queues and add corresponding queues which will use previously
created groups. For the System address you can use any available.

• Name: FAQ Germany, Group: faq-emea

• Name: FAQ Mexico, Group: faq-amer
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• Name: FAQ Sweden, Group: faq-emea

• Name: FAQ USA, Group: faq-amer

• Name: Support Germany, Group: support-de

• Name: Support Mexico, Group: support-mx

• Name: Support Sweden, Group: support-se

• Name: Support USA, Group: support-us

Go to Admin → Customer Users ↔ Customers frontend and assign customer users to other
customers.

• Arvid Karlsson

de Graubrot AG → active {1}

• Diego Garcia

se Ericsson AB, us Farmers Inc. → active {2}

Additionally, go to Admin → Customer Users ↔ Groups frontend and assign a single
customer user direct access to a group.

• Diego Garcia

faq-emea → rw {3}

Now, go to Admin → Customers ↔ Groups frontend and assign customers to groups
according to the matrix below. Be sure to select proper permission level for each group
and company.

• de Graubrot AG

• Same Customer {4}

faq-amer → ro

faq-emea → ro

support-de → rw

support-mx → ro

• mx Hernandex SA

• Same Customer {5}

faq-amer → ro

faq-emea → ro

support-de → ro

support-mx → rw

• Other Customers {6}

support-de → rw (this is intentional to demonstrate limitation to base permissions)

support-mx → rw
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• se Ericsson AB

• Same Customer {7}

faq-amer → ro

faq-emea → ro

support-se → rw

• us Farmers Inc.

• Same Customer {8}

faq-amer → ro

faq-emea → ro

support-us → rw

• Other Customers {9}

faq-amer → ro

For reference, please consult image below where all relationships are drawn as lines:

Finally, let's create some tickets. Go to New phone ticket frontend and create tickets, one
each per customer user and queue (32 in total). By the way, this is possible in the agent
frontend as the customer group restrictions are only active on the customer frontend.

For checking resulting access to the tickets, you can easily switch between the customer
users by activating SwitchToCustomer option in SysConfig. Then just go to Admin →
Customer Users and click on corresponding Switch to customer link next to the user's
name.
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You will be immediately logged in as that customer user and you can visit Tickets →
Company Tickets screen for checking the ticket access. It should conform to the matrix
below. Click on a ticket to check if corresponding permission level is honored: for ro
permission level you should not see the Reply button.

This is the expected result for each customer user. The marker '{0}' refers to the location
above where the corresponding setting was taken (this shows why the access is granted).

Resulting access for customer user Arvid Karlsson

• Queue FAQ Germany: ro (via {7}) + Christian's Tickets ro (via {1})

• Queue FAQ Mexico: ro (via {7}) + Christian's Tickets ro (via {1})

• Queue FAQ Sweden: ro (via {7}) + Christian's Tickets ro (via {1})

• Queue FAQ USA: ro (via {7}) + Christian's Tickets ro (via {1})

• Queue Support Germany: rw (via {1→6}) + Christian's Tickets rw (via {1})

• Queue Support Mexico: -

• Queue Support Sweden: rw (via {7}) + Christian's Tickets rw (via {1})

• Queue Support USA: -

Resulting access for customer user Barry Smith

• Queue FAQ Germany: ro (via {8})

• Queue FAQ Mexico: ro (via {8}) + Arvid's, Christian's, Diego's Tickets ro (via {9})

• Queue FAQ Sweden: ro (via {8})

• Queue FAQ USA: ro (via {8}) + Arvid's, Christian's, Diego's Tickets ro (via {9})

• Queue Support Germany: -

• Queue Support Mexico: -

• Queue Support Sweden: -

• Queue Support USA: rw (via {8})

Resulting access for customer user Christian Müller

• Queue FAQ Germany: ro (via {4})

• Queue FAQ Mexico: ro (via {4})

• Queue FAQ Sweden: ro (via {4})

• Queue FAQ USA: ro (via {4})

• Queue Support Germany: rw (via {4})

• Queue Support Mexico: ro (via {4})

• Queue Support Sweden: -

• Queue Support USA: -

Resulting access for customer user Diego Garcia

• Queue FAQ Germany: rw (via {3}) + Arvid's, Barry's Tickets rw (via {2})
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• Queue FAQ Mexico: ro (via {5}) + Arvid's, Barry's Tickets ro (via {2}) + Christian's
Tickets ro (via {2→9})

• Queue FAQ Sweden: rw (via {3}) + Arvid's, Barry's Tickets rw (via {2})

• Queue FAQ USA: ro (via {5}) + Arvid's, Barry's Tickets ro (via {2}) + Christian's Tickets
ro (via {2→9})

• Queue Support Germany: ro (via {5}) + Arvid's, Barry's Tickets ro (via {2}) + Christian's
Tickets ro (via {6})

• Queue Support Mexico: rw (via {5}) + Arvid's, Barry's Tickets rw (via {2}) + Christian's
Tickets rw (via {6})

• Queue Support Sweden: rw (via {2→4}) + Arvid's, Barry's Tickets rw (via {2})

• Queue Support USA: rw (via {2→5}) + Arvid's, Barry's Tickets rw (via {2})

1.4. キュー
管理者ページをリンク「キュー」をクリックすると、システムのキューを管理することができます
(下記の図を参照)。新規OTRSインストレーションでは、4つのデフォルト・キューがあります:「未
対応(Raw)」、「ジャンク(Junk)」、「その他(Misc)」と「ポストマスター(Postmaster)」。フィル
タ規則が定義されなければ、受信メッセージはすべて「未対応の」キューに格納されるでしょう。
「ジャンク」キューはスパム・メッセージを格納するために使用することができます。

図4.24 キュー管理

Here you can add queues (see figure below) and modify them. You can specify the group
that should use the queue. You can also set the queue as a sub-queue of an existing queue.

図4.25 Adding a new queue
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キュー用のアンロック・タイムアウトを定義することができます。担当者がチケットをロックし、
アンロックタイムアウトが過ぎる前に、それを完了しなければ、チケットが自動的にアンロックさ
れ、他の担当者が継続して利用可能にされます。

キュー・レベルに関連可能な3つのエスカレーション時間設定があります:

エスカレーション - 第1の応答時間
• チケットの生成の後、顧客といかなるコミュニケーションも無く、定義された時間が失効した場
合、Eメールであれ電話であれエスカレーションされます。

エスカレーション - 更新期限
• Eメールあるいは顧客ポータル(それはチケットに記録される)のいずれかによって顧客フォロー
アップがある場合、エスカレーション更新時間はリセットされます。ここで定義された時間が失
効するまでに顧客へのコンタクトがない場合、チケットはエスカレーションされます。

エスカレーション - 解決時間
• ここで定義された時間が失効する前にチケットが完了（成功）しなかったら、チケットはエスカ
レーションされます。

「フォローアップの後のチケット・ロック」により、以下を定義できます。１．旧チケット・オー
ナーに対して「ロック」状態にセットすべきチケット。２．一旦完了してて、再度対応中となった
チケットこれにより以前にそのチケットを扱った担当者が確実にフォローアップ・チケットが処理
することができます。

システム・アドレス用のパラメタは、このキューの送信チケットに使用されるメール・アドレスを
特定します。Eメール返信のために、挨拶文と署名にキューを関連させることもできます。より多
くの詳細情報に関しては、Eメール・アドレス、挨拶文および 署名のセクションを参照してくださ
い。

注記
担当者でそうであるように、グループ、顧客、キューは削除できません。単に有効オプ
ションを無効にあるいは無効-暫定にする設定によって非活性化するだけです。

1.5. Salutations, Signatures, Attachments
and Templates
1.5.1. 挨拶文
挨拶文はテンプレート用のテキスト・モジュールです。キューに関するセクションに述べられてい
るように、挨拶文は1つ以上のキューにリンクすることができます。挨拶文は、挨拶文がリンクさ
れて、返信されているキューからのチケットのみに使用されます。システムの異なる挨拶文を管理
するためにには、管理者エリアの「挨拶文」リンクを使用してください(下図参照)。

図4.26 挨拶文管理

デフォルト・インストレーションの後、利用可能な1つの挨拶文が既にあります、「システム標準
挨拶文(en)」
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To create a new salutation, press the button Add salutation, provide the required data
and submit it (see figure below).

図4.27 新規挨拶文の追加

挨拶文の中で変数を使用することは可能です。チケットに応答する時、変数名はそれらの値に置換
されます。

テンプレートの中で使用することができる異なる変数は、挨拶文画面の下方部分にリストされま
す。例えばこれを使えば、チケット送信者の姓が変数<OTRS_LAST_NAME> が返信に含まれるで
しょう。

注記
他のOTRSの実体のように、挨拶文は削除できません。有効オプションを無効または無効-
暫定にすることで不活性化されるだけです。

1.5.2. 署名
テンプレート用の別のテキスト・モジュールは署名です。キューに関するセクションに述べられて
いるように、署名はキューにリンクすることができます。署名が以前にキューにリンクされていれ
ば、署名は単にテンプレート・テキストに追加されるだろうということに注意してください。管理
者ページの「署名」リンクへのアクセスにより、システムでの署名を管理することができます(下図
参照)。

図4.28 署名管理

OTRSの新規インストール後、システムにはあらかじめ定義された署名：「システム標準署名
(en)」が存在します。
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To create a new signature, press the button Add signature, provide the needed data and
submit it (see figure below).

図4.29 新規署名の追加

挨拶文のように、署名は、チケットに答える担当者の姓、名のような動的内容を含むことができま
す。またここで変数は、すべてのチケットに対して署名テキストのコンテンツを代替するために使
用することができます。使う変数に関しては署名画面の下部をご覧ください。あなたが署名に例え
ば可変<OTRS_LAST_NAME>を含めば、チケットに答える担当者の姓は変数を代替します。

注記

挨拶文でもそうであるように、署名も削除できません。有効オプションを無効または無効-
一時的に設定してのみ非活性化することができます。

1.5.3. 添付
You can also optionally add one or more attachments to a template. If the template is
selected, the attachments will be attached to the message in the compose screen. If
necessary, the agent can remove the attachment from an individual template before
sending it to the customer.

管理者ページの「添付」リンクによって、システムのデータベースに添付を読み込むことができま
す(下図参照)。

図4.30 添付ファイル管理
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To create a new attachment, press the button Add attachment, provide the required data
and submit it (see figure below).

図4.31 新規添付ファイルの追加

If an attachment is stored it can be linked to one or more templates. Click on the
Attachment <-> Templates link of the Admin page (see figure below).

図4.32 添付のテンプレートへのリンク

To associate different attachments with a specific template and vice versa, click on
the corresponding template name or attachment (see below the Figures 4.29 and 4.30,
respectively).

図4.33 テンプレート用添付関連の変更

図4.34 添付用テンプレート関連の変更

1.5.4. テンプレート
チケット処理を促進し、かつ返答の外観を標準化するために、OTRSにテンプレートを定義すること
ができます。テンプレートは1つ以上のキューにリンク、および逆リンクも可能です。
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OTRSの異なる部分で使用される、異なる種類およびそれらのテンプレートがありますそれらはそ
れ自身の目的を持っていて、下記は可能なテンプレート・タイプのリストです。:

• 返答：Answer: チケット・応答として使用されるか返答します。

• 作成：Create: 新規電話かEメール・チケットの中で使用されます。

• 転送：Forward: 誰か他の人へ記事を転送するために使用されます。

• 電話：PhoneCall: 電話の着信および発信画面で使用されます。

• ProcessDialog: To be used in the Process activity dialogs (field "Article" contains the
template selection)

Answer templates can be accessed in two ways, from the ticket zoom screen in the article
menu, or in a quicker fashion: from any ticket overview large screen such as Status View
or Ticket View. For a fresh OTRS installation, the "empty answer" template (Answer) is set
as the default for every queue.

As soon as Forward templates are added and assigned to the queues, the "Forward"
button in ticket zoom (that normally leads to an empty text forward screen) will change
into a selection control. This selection is filled with the added Forward templates, and
by choosing one of the templates, the forward screen will be shown pre-filled with
the template text and attachments (similar to the reply selection box with the Answer
templates).

Creating templates of type Create and PhoneCall will make visible the "Text Template"
selection box in their respective screens, and choosing a template for the list will populate
the "Text" and "Attachment" fields (if available in the template). Notice that any previous
change in the text or attachments will be overwritten by selecting a template.

管理者ページの「テンプレート」をクリックすれば、テンプレート管理画面が開きます。(下図参
照)。

図4.35 テンプレート管理

To create a new template, click on the Add template button, provide the required data
(make sure to select the appropriate template type) and submit it (see figure below).
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図4.36 新規テンプレートの追加

テンプレートを1つ以上のキューに追加/削除するためには、管理者ページの「テンプレート<->
キュー」リンクをクリックしてください(下図参照)。さらに、特定の実体に関する情報を得るため
にフィルタを使用することができます。

図4.37 Template-Queue relations management

To define the different templates that will be available for a queue and vice versa, click
on the corresponding template or queue (see figures below).

図4.38 テンプレートのためのキュー関係の変更
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図4.39 キューのためのテンプレート関係の変更

When choosing a template, additional information could be added to the template text,
this depends on the template type.

PhoneCall and Create templates do not add any content to the template text. However,
New Email Ticket screen adds the queue assigned signature to the resulting email body
(this screen has a separated box to visualize the signature).

Answer templates text when selected also include the salutation associated with the
queue, followed by the text of the template, then the quoted ticket text, and finally the
signature associated with the queue.

Forward templates are similar to Answer templates, but they do not include the salutation
part.

1.6. 自動応答
OTRSは、特定のイベントの発生に応じて顧客へ自動応答を送信することを可能にします。それら
のイベントとは、特定のキュー中のチケットの生成、チケットに関するフォローアップメッセージ
の受取り、チケットの完了か拒否、等です。そのような応答を管理するためには、管理者ページ上
でリンク「自動応答」をクリックしてください(下図参照)。

図4.40 自動応答管理

To create an automatic response, click on the button Add auto response, provide the
needed data and submit it (see figure below).
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図4.41 自動応答の追加

署名と挨拶文でそうであったように、自動応答の件名およびテキストは、変数によって生成するこ
とができます。例えば、自動応答の本文に可変<OTRS_CUSTOMER_EMAIL[5]>を挿入すれば、
顧客メール・テキストの最初の5行が自動応答に挿入されるでしょう。図示された画面の一番下に
て使用することができる有効な変数に関するより多くの詳細を見つけるでしょう。

すべての自動返答ではそれをきっかけとすべきイベントを指定することができます。デフォルトの
インストレーションの後で利用可能なシステム・イベントは表4.4に説明されています。

表4.4 自動応答用イベント

Name 摘要

自動応答 あるキュー中のチケットの自動返答生成

自動応答/新規チケット 既に完了チケットへの返信。例えば顧客がその
チケットへ返信した場合

自動フォローアップ チケットに対するフォローアップの受付

自動拒否 システムによって行われたチケットの自動拒否

自動削除 システムによって行われたチケットの削除

注記

他のOTRSの実体と同様に、自動応答も単に非活性化されるだけであり、削除はできませ
ん。（有効オプションを無効または無効-暫定に設定することによって）

キューに対する自動応答を加えるためには、管理者ページ上で「自動応答<-> キュー」リンクを使
用してください(下図参照)。全てのシステム・イベントは全てのキューのためにリストされます。
また、同じイベントを備えた自動応答はリストボックスによって選択するか、削除することができ
ます。
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図4.42 Queue <-> auto response relations management

キューに利用可能になる異なる自動応答を定義するためには、対応するキュー名をクリックしてく
ださい(下図参照)。さらに、既存の自動応答を編集することは可能です。それには「応答」をク
リックして、「新規自動応答を編集」として同じやり方で編集してください。

図4.43 Change auto response relations for a queue

1.7. システム・メール・アドレス
To enable OTRS to send emails, you need a valid email address to be used by the
system. OTRS is capable of working with multiple email addresses, since many support
installations need to use more than one. A queue can be linked to many email addresses,
and vice versa. The address used for outgoing messages from a queue can be set when
the queue is created. Use the "Email Addresses" link from the Admin page to manage all
email addresses of the system (see figure below).

図4.44 システムメールアドレスの管理

If you create a new mail address (see figure below),you can select the queue or sub
queue to be linked with it. This link enables the system to sort incoming messages via
the address in the To: field of the mail into the right queue.
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図4.45 システム・メール・アドレスの追加

注記

他のOTRSの実体と同様に、Eメール・アドレスも単に非活性化されるだけであり、削除は
できません。（有効オプションを無効または無効-暫定に設定することによって）

1.8. チケット通知
OTRSは、あるイベントの発生に基づいて担当者や顧客へ通知することが可能です。担当者は、個
人設定の編集 のリンク経由で自身への通知用のシステム・イベントを設定できます。

管理者ページの「チケット通知管理」リンクによって、システムの通知を管理することができます
(下図参照)。ある通知だけをリストするためにフィルタを使用することができます。

図4.46 チケット通知管理

件名および通知テキストをカスタマイズすることができます。リストから変更したい通知をクリッ
クしてください(下図参照)。そうすれば、内容が編集用にロードされます。利用可能な言語の各々
の同じ名前を持った通知があることをご留意ください。
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図4.47 Customizing a notification

エージェントは、名前、コメントを編集できます。そしてこの通知を受け取ることを選択すること
ができる場合は（送信方法ごとに）コントロールできます。すべての言語において、件名と本文を
追加または編集された通知内容として実際に送信されるかを設定することができます。

署名と挨拶文でそうであるように、特殊変数の使用により、通知の内容を動的に作成することは可
能です。図の中で示される画面最下部の変数のリストを見つけることができます。

あなたはイベントがこの通知をトリガすべきかを選択し、一定の基準（チケットおよび/または記
事のフィルタ）と一致したチケットにそれを制限することができます。これは、お使いのシステム
に関連するかもしれない別のキュー、優先順位やその他の基準のためのさまざまな通知を作成する
ことが可能になります

通知の受信者は、別の基準（グループ、ロール、個々の担当など）に応じて設定することができま
す。すべての設定された受信者は、通知を受信します。
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図4.48 通知のカスタマイズ

さらに通知は、オフィスの外にいるエージェントに送信するかどうかを指定し、一日あたり、及び
チケットあたりの送信を制限することができます。（例 リマインダ通知保留中）

通知は、異なる通知方法で送信することができます。メール通知方法は、「OTRS無料」で提供され
ます。また、OTRSビジネスソリューション™では、（電子メールクライアントがOTRSを使用する
ために必要とされないように）データベースから通知を表示するだけでなく、SMS経由でそれらを
送信することができます。（例えば非常に重要な通知のために）

図4.49 Customizing notification methods

The field 'Additional recipient email addresses' provides the possibility to use OTRS-
tags like <OTRS_TICKET_DynamicField_...> to insert values from the current ticket. The
according SMS field (only available in OTRS Business Solution™) also has this feature.
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Since OTRS 5s Email transport contains security options for each notification, that includes
signing and encrypting possibilities with PGP and S/MIME and the opportunity to decide
what to do in case of missing key or certificate.

1.9. S/MIME
OTRS can process incoming S/MIME encoded messages and sign outgoing mails. Before
this feature can be used, you need to activate it and change some configuration
parameters in the SysConfig.

管理者ページの「S/MIME証明書」リンクによってS/MIME証明書を管理することができます(下図
参照)。証明書の追加及び削除、またSMIMEデータの検索もできます。

図4.50 S/MIME管理

1.10. PGP鍵
OTRS handles PGP keys, which allows you to encrypt/decrypt messages and to sign
outgoing messages. Before this feature can be used, you need to activate it and change
some  configuration parameters  in the SysConfig.

管理者ページの「PGP鍵」リンクによって、例えば地方のOTRSユーザやOTRSのウェブサーバ・
ユーザがOTRSに設定されたPGP鍵に使用されるユーザのkey ringを管理することは可能です(下図
参照)。キーと署名を加えること、及び削除することは可能です。また、key ring中のすべてのデー
タを捜すことができます。

図4.51 PGP管理

1.11. 状態
管理者ページのリンク「状態」によって、システムの中で使用したい異なるチケット状態を管理す
ることができます(下図参照)。
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図4.52 状態管理

デフォルトの開始後、定義される「状態」がいくつかあります。

• 完了（成功）

• 完了（不成功）

• 結合済

• 「新規」（new）

• 対応中（open）

• 保留（自動完了＋）

• 保留（自動完了-）

• 保留（期限付）

• 削除済

全ての状態はタイプにリンクされます。新たな状態が作成されたならばタイプが指定されねばなり
ません。デフォルトの状態タイプは次の通りです。

• 完了済

• 結合済

• 「新規」（new）

• 対応中（open）

• 保留（自動）

• 保留（期限付）

• 削除済

1.12. システム構成
The System Configuration link leads to the section where many OTRS configuration
options are maintained.

The system configuration link on the admin page loads the graphical user interface
for the system configuration (see figure below). You can upload your own configuration
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files for the system, as well as backup all current settings into a file. Almost all
configuration parameters of the OTRS framework and any installed extensions can be
viewed and changed using this interface. All configuration parameters are part of a certain
group, which makes it possible to navigate quickly through the vast number of existing
parameters. It is also possible to perform a full-text search over all parameters.

図4.53 Graphical user interface of the system configuration.

The graphical user interface of the system configuration is described in detail in the
chapter  "Configuring the system through the web interface".

1.13. Eメールアカウントの使用
There are several possibilities to transport new emails into the ticket system. One way
is to use a local MTA and the otrs.PostMaster.pl script that pipes the mails directly into
the system. Another possibility is the use of mail accounts which can be administrated
through the web interface. The "PostMaster Mail Accounts" link on the Admin page loads
the management console for the mail accounts (see figure below). OTRS supports the
mail protocols: POP3, POP3S, IMAP and IMAPS.

図4.54 Eメールアカウント管理

より詳細については、PostMasterメールアカウント に関するセクションを参照してください。

1.14. 受信Eメール・メッセージのフィルタリング
OTRS has the capability to filter incoming email messages. For example, it is possible to
put certain emails automatically into specified queues, or to set a specific state or ticket
type for some mails. The filters apply to all incoming mails. Several filter conditions can
be defined per each mail header. You can manage your filters via the link "PostMaster
Filter" on the Admin page (see figure below).
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図4.55 ポストマスター・フィルタ管理

A filter consists of one or more criteria that must be met in order for the defined actions
to be executed on the email. Filter criteria may be defined for the headers or the body of
an email, e.g. search for specific header entries, such as a sender address, or on strings
in the body. Even regular expressions can be used for extended pattern matching. If your
filter matches, you can set fields using the X-OTRS headers in the GUI. These values will
be applied when creating the ticket or follow-up message in OTRS. The table below lists
the different X-OTRS headers and their meaning.

注記
You also can use X-OTRS-FollowUp-* headers to set values for follow up emails.

表4.5 異なるX-OTRSヘッダーの機能
Name 可能な値 摘要

X-OTRS-優先度: 1 極低い, 2 低い, 3 普通, 4 高い,
5 極高い

チケットの優先度を設定しま
す。

X-OTRS-キュー: システム内でのキュー名 Sets the queue where the
ticket shall be sorted. If
set in X-OTRS header, all
other filter rules that try to
sort a ticket into a specific
queue are ignored. If you use
a sub-queue, specify it as
Parent::Sub.

X-OTRS-ロック: ロック、アンロック チケットのロック状態を設定し
ます

X-OTRS-無視: 「はい」 あるいは 「真」 このX-OTRSヘッダーが「は
い」にセットされれば、受信
メッセージは完全に無視され、
システムに配達されないでしょ
う。

X-OTRS-状態: 新規、対応中、完了（成功）、
完了（不成功）...

チケットの次の状態を設定しま
す

X-OTRS-状態-保留時間: 例えば 2010-11-20 00:00:00 Sets the pending time
of a ticket (you also
should sent a pending state
via X-OTRS-State). You can
specify absolute dates like
"2010-11-20 00:00:00" or
relative dates, based on the
arrival time of the email.
Use the form "+ $Number
$Unit", where $Unit can be
's' (seconds), 'm' (minutes),
'h' (hours) or 'd' (days).
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Name 可能な値 摘要
Only one unit can be
specified. Examples of valid
settings: "+50s" (pending in
50 seconds), "+30m" (30
minutes), "+12d" (12 days).
Note that settings like "+1d
12h" are not possible. You
can specify "+36h" instead.

X-OTRS-タイプ: デフォルト (あなたの実施した
セットアップに依存します)

Sets the type of a ticket (if
Ticket::Type is activated).

X-OTRS-サービス: （セットアップにもよります
が）

Sets the service of a ticket (if
Ticket::Service is active).
If you want to set a sub-
service you should specify it
as Parent::Sub.

X-OTRS-SLA: （セットアップにもよります
が）

Sets the SLA of a ticket (if
Ticket::Service support is
active).

X-OTRS-顧客ユーザ: CustomerUser（顧客ユーザ） チケット用顧客ユーザーを設定
します。

X-OTRS-顧客番号: CustomerNo（顧客番号） このチケットの顧客IDを設定し
ます。

X-OTRS-送信者タイプ： 担当者、システム、顧客 このチケット送信者のタイプを
設定します。

X-OTRS-
IsVisibleForCustomer:

0, 1 Controls if the article is
shown in the customer
interface.

X-OTRS-DynamicField-
<DynamicFieldName>:

動的フィールドの構成に依存し
ます（テキスト：ノートブッ
ク、日付：2010-11-20
00:00:00, Integer: 1)

Saves an additional info
value for the ticket
on <DynamicFieldName>
Dynamic Field.

X-OTRS-ループ: 真 このX-OTRSヘッダーが設定さ
れたら、メッセージ送信者へ自
動返信は配信されません。
（メール・ループ保護のため）

X-OTRS-FollowUp-State-
Keep:

0, 1 If this X-OTRS header is
set, the incoming follow-
up message will not
change the ticket state. For
this purpose the header
can be customized in
the SysConfig using option
KeepStateHeader.

X-OTRS-AttachmentExists: no, yes Depending on whether
attachments are included
in the email this X-OTRS
header is set to 'yes', or
it has a 'no' value if no
attachments are included.

X-OTRS-AttachmentCount: (number of attachments) This X-OTRS header contains
as value the number
of attachments which are
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Name 可能な値 摘要
contained in the email
(i.e. '0' for mails without
attachments).

You should specify a name for every filter rule. Filter criteria can be specified in the section
"Filter Condition". Choose via the list boxes for "Header 1", "Header 2" and so on for the
parts of the messages where you would like to search, and specify on the right side the
values you wish to filter on. In the section "Set Email Headers", you can choose the actions
that are triggered if the filter rules match. You can select for "Header 1", "Header 2" and
so on to select the X-OTRS-Header and set the associated values (see figure below).

Filter rules are evaluated in alphabetical order, and are all executed except if the "Stop
after match" setting has been set to "Yes" in one of the rules (in this case evaluation of
the remaining filters is canceled).

図4.56 ポストマスター・フィルタを追加

例4.1 特定のキューの中へのスパム・メールのソート
A useful filter rule would be to let OTRS automatically move mails marked for spam, by
using a spam detection tool such as SpamAssassin, into the "Junk" queue. SpamAssassin
adds the "X-Spam-Flag" header to every checked mail. When the mail is marked as spam,
the Header is set to "Yes". So the filter criteria would be "X-Spam-Flag: Yes". To create a
filter rule with this criteria you can insert the name as, for example, "spam-mails". In the
section for "Filter Condition", choose "X-Spam-Flag:" for "Header 1" from the listbox. Insert
"Yes" as value for this header. Now the filter criteria is specified. To make sure that all spam
mails are placed into the "Junk" queue, choose in the section for "Set Email Headers", the
"X-OTRS-Queue:" entry for "Header 1". Specify "Junk" as value for this header. Finally add
the new filter rule to activate it for new messages in the system.

There are additional modules that can be used to filter incoming messages more
specifically. These modules might be useful when dealing with larger, more complex
systems.

1.15. GenericAgent（一般担当者）による自動処理の実
行
GenericAgent（一般担当者）はタスクを自動的に実行するツールです。「一般担当者」は例えば、
チケットを完了したり、移動したり、エスカレートされたチケットに対して通知を送信したりでき
ます。
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管理者ページ上でリンクGenericAgen（一般担当者）をクリックしてください(下図参照)。システム
でのすべての自動ジョブを備えたテーブルが表示されます。その後、これらのジョブは編集、手動
で動作、または完全に削除することができます。

図4.57 GenericAgent（一般担当者）のためのジョブ・リスト

新規ジョブを作成するために「ジョブ追加」ボタンをクリックしてください。最初に名前を提供す
る必要があります。その後、ジョブがどのように実行されるか特定することができます:指定時刻で
自動（cronjobのようにこのモードはチケット・フィルターによってすべてのチケットで作動しま
す。）あるいは、チケット・イベンで自動（チケット・フィルターにマッチしていれば単一のチ
ケットが変更された直後に）。

図4.58 GenericAgent（一般担当者）のためのジョブ作成

すべてのジョブについては、チケット・フィルタを指定することができるが、例えば、ある特定の
キュー中ではチケット上でのみ作動します。フィルター条件はすべて、チケット上で実行される
ジョブのために満たされなければならない。

すべてのジョブについては、チケット・フィルタを指定することができるが、例えば、ある特定の
キュー中ではチケット上でのみ作動します。フィルター条件はすべて、チケット上で実行される
ジョブのために満たされなければなりません。最後に、チケットは新規キューか状態のような様々
なチケット・フィールドの設定により修正することができます。チケットにノートを付けるか、カ
スタマイズされたモジュールを実行することは可能です。さらに、データベースからチケットを削
除するオプションがあります。これはシステムからの時代遅れのデータあるいは無効のデータを除
去するのに有用になりえます。
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警告

チケットを削除する機能を使う場合、すべての影響を受けるチケットやそれらの添付ファ
イルはデータベースから取り除かれ復元することはできません。

ジョブを編集した後に、OTRSは概要画面に戻ります。そこで、どんなジョブも手動で実行できる可
能性があります。ジョブを実行することを選ぶならば、ジョブが実際に走っている時に全てのチ
ケットが影響を受けることをまず最初に見ることでしょう。このリストは、あなたが意図通りに
ジョブが働いていることを確認するのに役立ちます。このポイントでは、これらのチケットにまだ
変更は行なわれていません。あなたが画面を確認する場合のみ、ジョブが実行されます。

1.16. Administrative Messages
OTRS administrators can send messages to specific users or groups. The "Admin
Notification" link on the Admin page opens the screen where the agents and groups that
should be notified can be selected (see figure below).

図4.59 Admin notification screen

通知文の送信者、件名、本文は指定可能です。担当者、グループ、およびメッセージを受け取るべ
き役割を選ぶこともできます。

1.17. セッション管理
You can see all logged in users and their session details by clicking the "Session
Management" link in the admin area (see figure below).
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図4.60 セッション管理

Some statistics about all active sessions are displayed, e.g. how many agents and
customer users are logged in and the number of active sessions. Any individual session
can be removed by clicking on the Kill this session link on the right-hand side of the list.
You also have the option to Kill all sessions, which can be useful if you want to take the
system offline. Detailed information for every session is available, too (see figure below).

図4.61 セッション詳細

1.18. システムメンテナンス
System Maintenance give the option to schedule one or more maintenance periods for the
system. During this period no agents or customers can login into the system (except for
Agents in the "admin" group). Current logged users and customers receive a notification
about the maintenance (before and during the maintenance period). Administrators have
the option to kill the sessions for logged agents and customers, all this in preparation to
be able to make changes in the system (e.g. a system update) in a "safe" environment.
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図4.62 The system maintenance overview screen with some
scheduled periods

The Start Date and the Stop Date are required fields, and the only rule for this combination
is that Start Date can not be a date after the Stop Date.

図4.63 The system maintenance edit screen

After a new maintenance period is defined an overview and details about the current
active sessions is shown, from there administrators can kill this sessions one by one or
all of them (except current) if it is needed.

1.19. システムログ
管理者ページの「システムログ」リンクは、システムのログ・エントリーを表示します。最新を先
頭にして時系列の逆順でソートされます(下図参照)。
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図4.64 システムログ

ログの各ラインは、以下を含みます。タイム・スタンプ、ログ優先度、システム・コンポーネント
及びログ・エントリー自体です。

注記

System logs are available via the web interface only on Linux / Unix systems.

1.20. コミュニケーション・ログ
The Communication Log frontend in the Admin area allows you to inspect the internal logs
about communication handling in OTRS, i.e. sending/receiving emails.

図4.65 Communication Log Overview

Overview page is a dashboard-like screen with several metrics indicating the overall
health of the system, depending on filtered communications.

• Account status will signal if you have any issues with configured accounts used for
fetching or sending messages.

• Communication status will notify you if there are any errors with either account
connections or message processing.

• Communication state widget will display if there are any active communications
currently in the system.

• Average processing time is a cumulative time statistic that is needed to complete a
communication.

You can select the time range in the left sidebar in order to filter communications
depending on their creation time. In addition to this, you can also dynamically filter for
any keywords, state of the communication, and you can sort the overview table by all
columns.
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図4.66 Communication Log Time Range Selection

図4.67 Communication Log Account Status

Clicking on account widget will take you to the account status screen, where you can
further filter for communications that are related to specific accounts.

図4.68 Communication Log Account Status
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If you click on a communication row in any table, you will be presented with a detailed
view screen.

図4.69 Communication Log Detail View

Every communication can contain one or more logs, which can be of Connection or
Message type.

• Connection logs will contain any log messages coming from the modules responsible
for connecting to your accounts and fetching/receiving messages.

• Message logs will contain any log messages related to specific message processing.
Any module working on message themselves can log their actions in this log, giving
you a clear overview of what's going on.

You can filter log entries based on their priority, by choosing desired priority in the left
sidebar.

図4.70 Communication Log Priority Filter

Log level rules apply: by selecting a specific priority, you will get log entries that have
that priority set and higher, with Error being the highest.
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1.21. SQL Queries via the SQL Box
The "SQL Box" link on the Admin page opens a screen that lets you query the content
of the tables in the OTRS database (see figure below). It is not possible to change the
content of the tables, only 'select' queries are allowed.

図4.71 SQLボックス

1.22. パッケージ・マネージャー
Using the Package Manager link on the Admin page, you can install and manage packages
that extend the functionality of OTRS (see figure below).

図4.72 パッケージ・マネージャー

パッケージ・マネージャは、それらのバージョン番号と一緒に、サーバに現在インストールした
OTRS addonパッケージを示します。

オンライン・レポジトリセクションにあるレポジトリを選択し、リポジトリ情報の更新ボタンをク
リックすることによって、リモート・ホストからパッケージをインストールすることができます。
利用可能なパッケージが対応するテーブルに表示されます。 画面右側には利用可能なパッケージを
表示します。パッケージをインストールするためにインストールをクリックします。インストレー
ション後、パッケージはローカル・レポジトリセクションを表示します。

To update an installed package, the list of available packages in the online repository will
show Update in the Action column for any package that has a higher version than the
one that is installed locally. Just click Update and it will install the new package version
on your system.

OTRSシステムがインターネットに接続されないような場合、ローカル・ディスクにダウンロード
したそれらのパッケージもインストールすることもできます。アクション・サイドバー上のブラウ

78



ズをクリックし、あなたのディスク内の.opmファイルを選択します。開くを、それからパッケージ
をインストールをクリックします。インストレーションの完了後、パッケージはレポジトリセク
ションに表示されます。設置が終わった後、パッケージはのローカルのリポジトリセクションに表
示されます。既にインストールされているパッケージの更新のために同じステップを使用すること
ができます。

In special cases, you might want to configure the Package Manager, e.g., to use a proxy
or to use a local repository. Just take a look at the available options in SysConfig under
Core::Package.

1.22.1. インストールされているパッケージを全て更新する
Since OTRS 6, a new button labeled Update all installed packages has been added to the
sidebar of the package manager screen. When this button is pressed, an OTRS Daemon
task will be scheduled to update all packages. Alternatively, this action can be also issued
from the command line interface by using the Admin::Package::UpgradeAll console
command.

図4.73 Package Manager Update All Installed Packages Button

This feature reads the information of all defined package repositories and determines if
there is a new version for every installed package in the system and calculates the correct
order to update the packages respecting all other package dependencies, even if new
versions of existing packages require new packages not yet installed in the system.

注記

If there are packages installed that do not have a corresponding repository defined
in the system, they can not be updated by this feature and will be marked as failed
(due to the missing on-line repository).

When the process to update all packages is running, a notification bar is added to the
package manager screen for easier identification. When notification link is clicked, a
progress summary is displayed with the current progress. Also, when the process is
running package actions such as "Install", "Update", "Uninstall" and "ReInstall" some
actions on the screen might be temporarily disabled in order to avoid conflicts.

図4.74 Package Manager Update All Installed Packages In Progress
Notification
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When the process finishes (only if it was started in the graphical user interface) the
progress notification will change to indicate the new state: it becomes green if all
packages was correctly updated or red if there where any failures. Clicking on this
notification will show the final summary. In the summary table, a tooltip for the status
column of every package can indicate more details about the state. After closing this
window, the package manager screen will refresh to show the new version of the installed
packages.

図4.75 Package Manager Update All Installed Packages Summary

1.23. ウェブサービス
The Web Services link leads to the graphical interface where web services (for the OTRS
Generic Interface) are created and maintained (see figure below).

図4.76 ウェブサービスのためのグラフィカル・インターフェース

ウェブサービス構成用のグラフィカル・インターフェースは、セクション"Webサービス・グラ
フィカル・インターフェース"に、より詳細に述べられています。

1.24. 動的フィールド
動的フィールドは、チケットと記事用のカスタムフィールドをセットアップし管理する場所です。
（下記参照）
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図4.77 The dynamic fields overview screen with some dynamic
fields

動的フィールド構成は、セクション"動的フィールド構成"に、より詳細に述べられています。

動的フィールドタイプにはそれぞれそれ自身の構成セッティングおよびしたがってそれ自身の構成
画面があります。

注記

OTRSフレームワークでは、動的フィールドはデフォルトでチケットと記事にリンクのみす
ることができます。しかし、それらは、他のオブジェクトまで同様に延長することができ
ます。

1.25. カレンダー
Via calendar management interface it is possible to add and edit multiple calendars.

図4.78 The calendar management screen with some calendars

The calendar management is described in more detail in the section Calendar
Management.
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2. システム構成
2.1. OTRS構成ファイル

All OTRS configuration files are stored in the directory Kernel and in its subdirectories.
There is no need to manually change any other file than Kernel/Config.pm, because the
rest of the files will be changed when the system gets updated. Just copy the configuration
parameters from other files into Kernel/Config.pm and change them as per your needs.
This file will never be touched during the update process, so your manual changes are
safe.

The configuration can be rebuilt either manually by executing perl bin/
otrs.Console.pl Maint::Config::Rebuild or automatically by the installer, package
operations (install, update, reinstall and uninstall), etc. All .xml files located in Kernel/
Config/Files/XML/ are parsed and their content is transferred to the OTRS database.
Most of the .xml files which are part of this directory by default belong to OTRS Free, but
OTRS Free Features such as FAQ or Survey (or any other OTRS extension) will add their
own configuration files to this directory as well.

To apply any sort of changes to the configuration, it is necessary to deploy them. The
deployment process will extract all settings and the according values from the OTRS
database, convert them to a format that OTRS can understand naturally and put them
into Kernel/Config/Files/ZZZAAuto.pm.

If the OTRS web interface is accessed, the settings contained in the files Kernel/Config/
Files/ZZZAAuto.pm, Kernel/Config/Files/ZZZACL.pm (if existing), Kernel/Config/
Files/ZZZProcessManagement.pm (if existing) and any other custom .pm file will be
evaluated alphabetically. These files are used by the graphical user interface for caching
purposes and should never be changed manually. Lastly, the file Kernel/Config.pm that
contains your individual settings and manually changed configuration parameters will
be parsed. Reading the configuration files in this order makes sure that your specific
configuration settings are considered correctly by the system.

2.2. Configuring the System Through the Web
Interface
図4.79 システム構成用のグラフィカル・インターフェース

OTRS Free currently brings more than 1700 configuration settings, and there are different
ways to quickly access a specific one. With the full text search, all configuration settings
can be scanned for one or more keywords. The full text search not only searches through
the names of the configuration settings, but also the descriptions and values. This allows
an element to be found easily even if its name is unknown.
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Furthermore, each configuration setting is classified by a category and a navigation group.
Navigation groups are individual elements in the main navigation tree. By selecting one
of these navigation entries, all settings assigned to the selected group will be shown. As
long as no extensions are installed, the category selection is automatically hidden, but as
soon as a package is installed which brings its own configuration settings (such as FAQ
or Survey), the category selection will be revealed. Selecting a category makes the main
navigation tree show only the navigation groups belonging to the selected category.

All configuration settings are shown as read only by default. To edit a setting, click the Edit
this setting button that appears on hovering your mouse cursor over a setting. Once edit
mode has been entered, changes made to the fields from within the setting can be saved
by clicking the Save button on the right (or by hitting the Enter key on your keyboard).
If a setting is currently edited by another administrator, it is not possible to get access
to the edit mode for that setting until the other administrator finished their work. Editing
can be cancelled by clicking the Cancel button on the right or hitting the Escape key on
your keyboard. When editing is cancelled, all changes made during the current editing
session are discarded.

Clicking the setting name or the menu icon on the top right of each setting will reveal
a menu with some more options (e.g. enable/disable a setting, reset a setting values to
their defaults, copy a direct link to a setting or add a setting to a list of favorites for quick
access).

To bring changes into effect, a deployment has to be started. The system configuration
deployment screen shows a list of the settings which are to be deployed. Clicking the
arrow icon on the top left of each setting or in the outer Changes Overview box will show a
one to one comparison between the settings current state (which is about to be deployed)
and the previous (or default) state.

図4.80 System configuration deployment

If you would like to save all the changes you made to your system configuration (for
example to quickly set up a new instance) you can use the Export settings button, which
will provide a .yml file for downloading. To restore your own settings, use Import settings
and select the .yml file you have created before.

注記

For security reasons, the configuration settings for the database connection cannot
be changed in the graphical user interface of the system configuration. These have
to be set manually in Kernel/Config.pm.

3. Backing Up the System
本章はバックアップとOTRSデータのリストアについて記述します。
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3.1. バックアップ
バックアップする2つのタイプのデータがあります:ひとつはアプリケーションファイル(例えば /
opt/otrs の中のファイル)、もうひとつはデータベースに格納されたデータです。

バックアップを単純化するために、スクリプト scripts/backup.pl はOTRSのインストレー
ションで含まれています。それは全てのインポートデータをバックアップするように走らせること
ができます。(下記のスクリプトを参照)。

linux:/opt/otrs# cd scripts/
linux:/opt/otrs/scripts# ./backup.pl --help
backup.pl - backup script
Copyright (C) 2001-2018 OTRS AG, https://otrs.com/
usage: backup.pl -d /data_backup_dir/ [-c gzip|bzip2] [-r 30] [-t fullbackup|nofullbackup|
dbonly]
linux:/opt/otrs/scripts#

スクリプト：OTRSバックアップメカニズムに関するヘルプ

バックアップを作成するために以下のスクリプトで指定したコマンドを実行します：

linux:/opt/otrs/scripts# ./backup.pl -d /backup/
Backup /backup//2010-09-07_14-28/Config.tar.gz ... done
Backup /backup//2010-09-07_14-28/Application.tar.gz ... done
Dump MySQL rdbms ... done
Compress SQL-file... done
linux:/opt/otrs/scripts#

スクリプト:バックアップの作成

全てのデータはディレクトリ /backup/2010-09-07_14-28/　に格納されます。（下図参照）そ
れに加えてデータはa .tar.gz fileに保存されます。

linux:/opt/otrs/scripts# ls /backup/2010-09-07_14-28/
Application.tar.gz  Config.tar.gz  DatabaseBackup.sql.gz
linux:/opt/otrs/scripts#

スクリプト:バックアップ・ファイルのチェック。

3.2. リストア
バックアップをリストアするために、保存されたアプリケーション・データはインストレーショ
ン・ディレクトリ（例えば、/opt/otrs　）に書き戻されなければいけません。さらに、データ
ベースをリストアしなければなりません。

リストア・プロセスを簡素化するスクリプト scripts/restore.pl (下記のスクリプトを参照)
は、OTRSの全ての出荷時に同梱され、MySQLとPostgreSQLをサポートします。

linux:/opt/otrs/scripts# ./restore.pl --help
restore.pl - restore script
Copyright (C) 2001-2018 OTRS AG, https://otrs.com/
usage: restore.pl -b /data_backup/<TIME>/ -d /opt/otrs/
linux:/opt/otrs/scripts#

スクリプト:リストア・メカニズムに関するヘルプ

例えば保存されるデータ（例えば、ディレクトリー/backup/2010-09-07_14-28/の中にある）
は、以下のスクリプトで指定されたコマンドでリストアすることができます。（OTRSは/opt/
otrsにインストールされていると仮定します。）

linux:/opt/otrs/scripts# ./restore.pl -b /backup/2010-09-07_14-28 -d /opt/otrs/
Restore /backup/2010-09-07_14-28//Config.tar.gz ...
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Restore /backup/2010-09-07_14-28//Application.tar.gz ...
create MySQL
decompresses SQL-file ...
cat SQL-file into MySQL database
compress SQL-file...
linux:/opt/otrs/scripts#

スクリプト:　OTRSデータのリストア

4. Eメール設定
4.1. Sending/Receiving Emails
4.1.1. Sending Emails
4.1.1.1. Via Sendmail (Default)

OTRS can send out emails via Sendmail, Postfix, Qmail or Exim. The default configuration
is to use Sendmail and should work out-of-the-box.

You can configure the sendmail settings via the graphical configuration frontend
(Framework::Core::Sendmail).

4.1.1.2. Via SMTP Server or Smarthost
OTRS can send emails via SMTP (Simple Mail Transfer Protocol / RFC 821) or Secure SMTP.

The SMTP server settings can be configured via the SysConfig
(Framework::Core::Sendmail). If you don't see SMTPS available as an option, the
required Perl modules are missing. In that case, please refer to "Installation of Perl
modules required for OTRS" for instructions.

4.1.1.3. Mail Queue
Before sending, OTRS will queue all emails and let a Daemon task asynchronously handle
them in due time. On a normal installation, the emails will be sent out every minute by
the OTRS Daemon.

To check the status of email sending, you can use the bin/otrs.Console.pl
Maint::Email::MailQueue console command with --list switch.

shell> cd /opt/otrs/
shell> bin/otrs.Console.pl Maint::Email::MailQueue --list
  +----+-----------+----------+----------------+--------------------+----------
+----------------+-------------------+
  | ID | ArticleID | Attempts | Sender         | Recipient          | Due Time | Last SMTP
 Code | Last SMTP Message |
  +----+-----------+----------+----------------+--------------------+----------
+----------------+-------------------+
  | 28 | 284       | 0        | otrs@localhost | marketing@otrs.com | -        | -          
    | -                 |
  | 29 | 285       | 0        | otrs@localhost | feedbac@otrs.com   | -        | -          
    | -                 |
  +----+-----------+----------+----------------+--------------------+----------
+----------------+-------------------+

  Mail queue contains 2 message(s)
                

In order to filter the table, you can use --filter argument, for example with ID of the
send job.

shell> bin/otrs.Console.pl Maint::Email::MailQueue --list --filter ID::28
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  +----+-----------+----------+----------------+--------------------+----------
+----------------+-------------------+
  | ID | ArticleID | Attempts | Sender         | Recipient          | Due Time | Last SMTP
 Code | Last SMTP Message |
  +----+-----------+----------+----------------+--------------------+----------
+----------------+-------------------+
  | 28 | 284       | 0        | otrs@localhost | marketing@otrs.com | -        | -          
    | -                 |
  +----+-----------+----------+----------------+--------------------+----------
+----------------+-------------------+

  Mail queue contains 1 message(s)

Done.
                

To delete emails queued for sending, specify either --delete-all switch, or --delete
with some filter active.

shell> bin/otrs.Console.pl Maint::Email::MailQueue --delete --filter ID::28
Deleted messages from mail queue.
Done.
                

You can also manually send email without waiting for OTRS Daemon task to kick in. Simply
specify the --send switch.

shell> bin/otrs.Console.pl Maint::Email::MailQueue --send
1 message(s) successfully sent!
Done.
                

4.1.2. Receiving Emails
4.1.2.1. Mail Accounts Configured via the OTRS GUI

OTRS is able to receive emails from POP3, POP3S, IMAP and IMAPS mail accounts.

Configure your mail accounts via the PostMaster Mail Accounts link on the Admin page.

If a new mail account is to be created (see figure below), then its mail server name, login
name and password must be specified. Also, you need to select the mail server type,
which can be POP3, POP3S, IMAP or IMAPS. If you don't see your server type available
as an option, the required Perl modules are missing on your system. In that case, please
refer to  Installation of Perl modules required for OTRS for instructions.

図4.81 メールアカウントの追加。

86



If you select Yes for the value of the Trusted option, any X-OTRS headers attached to an
incoming message are evaluated and executed. Because the X-OTRS header can execute
some actions in the ticket system, you should set the Trusted option to Yes only for known
senders. X-OTRS-Headers are used by the filter module in OTRS. The X-OTRS headers are
explained in this table in more detail. Any postmaster filter rules created are executed,
irrespective of the Trusted option's setting.

The distribution of incoming messages can be controlled if they need to be sorted by
queue or by the content of the To: field. For the Dispatching field, if Dispatching by
selected queue is selected, all incoming messages will be sorted into the specified queue.
The address where the mail was sent to is disregarded in this case. If Dispatching by
email To: field is selected, the system checks if a queue is linked with the address in the
To: field of the incoming mail. You can link an address to a queue in the E-mail address
management section of the Admin page. If the address in the To: field is linked with a
queue, the new message will be sorted into the linked queue. If no link is found between
the address in the To: field and any queue, then the message flows into the Raw queue
in the system, which is the PostmasterDefaultQueue after a default installation.

All data for the mail accounts are saved in the OTRS database. The bin/otrs.Console.pl
Maint::PostMaster::MailAccountFetch command uses the settings in the database
and fetches the mail. You can execute it manually to check if all your mail settings are
working properly.

On a normal installation, the mail will be fetched every 10 minutes by the OTRS Daemon.

注記

メールを取って来る場合、OTRSはPOPかIMAPサーバーからメールを削除します。さらに
サーバ上でコピーを保存するオプションはありません。サーバのコピーを保持したけれ
ば、メールサーバで転送規則を作成するとよいでしょう。詳細のためにメールサーバ・ド
キュメンテーションを調べてください。

4.1.2.2. Via Command Line Program and Procmail
(otrs.Console.pl Maint::PostMaster::Read)

If you cannot use mail accounts to get the email into OTRS, the command line program
bin/otrs.Console.pl Maint::PostMaster::Read might be a way around the problem.
It takes the mails via STDIN and pipes them directly into OTRS. That means email will be
available in your OTRS system if the MDA (mail delivery agent, e.g. procmail) executes
this program.

To test bin/otrs.Console.pl Maint::PostMaster::Read without an MDA, execute the
command of the following script.

linux:/opt/otrs# cd bin
linux:/opt/otrs/bin# cat ../doc/sample_mails/test-email-1.box | ./otrs.Console.pl
 Maint::PostMaster::Read
linux:/opt/otrs/bin#
                

スクリプト:MDAのないポストマスターのテスト

EメールがQueueViewの中で表示される場合、あなたの設定は正しく動作しています。

例4.2 Routing via Procmail Using otrs.Console.pl

In order to route mails in a specific queue using otrs.Console.pl use the following
example.

87



| $SYS_HOME/bin/otrs.Console.pl Maint::PostMaster::Read --target-queue=QUEUENAME
                    

When sorting to a subqueue, you must separate the parent and child queue with a ::.

| $SYS_HOME/bin/otrs.Console.pl Maint::PostMaster::Read --target-queue=QUEUENAME::SUBQUEUE
                    

ProcmailはLinux環境中でとても普及しているEメール・フィルタです。ほとんどのシステムにそ
れがインストールされます。そうでなければ、procmailホームページを見てください。

OTRS用にprocmailを構成するためには(sendmail、postfix、eximあるいはqmailといった
procmail構成のMTAに基づいた）、~otrs/.procmailrc.distファイルを使用し
て、.procmailrcにそれをコピーして、スクリプトのラインを下に加えてください。

SYS_HOME=$HOME
PATH=/bin:/usr/bin:/usr/local/bin
# --
# Pipe all email into the PostMaster process.
# --
:0 :
| $SYS_HOME/bin/otrs.Console.pl Maint::PostMaster::Read
                

スクリプト:OTRSのためのprocmailの構成。

All email sent to the local OTRS user will be piped into bin/otrs.Console.pl
Maint::PostMaster::Read and then shown in your QueueView.

4.1.2.3. Fetching emails via POP3 or IMAP and fetchmail for
otrs.Console.pl Maint::PostMaster::Read

In order to get email from your mail server, via a POP3 or IMAP mailbox, to the OTRS
machine/local OTRS account and to procmail, use fetchmail.

注記
OTRSマシン上で作動してるSMTP構成が必要です。

You can use the .fetchmailrc.dist in the home directory of OTRS and copy it to
.fetchmailrc. Modfiy/change it for your needs (see the Example below).

例4.3 .fetchmailrc

#poll (mailserver) protocol POP3 user (user) password (password) is (localuser)
poll mail.example.com protocol POP3 user joe password mama is otrs
                    

.fetchmailrc のパーミッションを 710 にする(chmod 710 .fetchmailrcを実行する)のを忘
れないでください！

With the .fetchmailrc from the Example above, all email will be forwarded to the local
OTRS account, if the command fetchmail -a is executed. Set up a cronjob with this
command if you want to fetch the mails regularly.

4.1.2.4. Filtering/Dispatching by OTRS/PostMaster Modules (for
More Complex Dispatching)

If you use the bin/otrs.Console.pl Maint::PostMaster::Read or bin/
otrs.Console.pl Maint::PostMaster::MailAccountFetch method, you can insert or
modify X-OTRS header entries with the PostMaster filter modules. With the X-OTRS
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headers, the ticket system can execute some actions on incoming mails, sort them into
a specific queue, change the priority or change the customer ID, for example. More
information about the X-OTRS headers are available in the section about adding mail
accounts from the OTRS Admin page.

いくつかのデフォルト・フィルタ・モジュールがあります:

注記
ジョブ名 (e.g. $Self->{'PostMaster::PreFilterModule'}->{'JobName'}) はユニークで
ある必要があります。

Kernel::System::PostMaster::Filter::Match is a default module to match on some
email header (e.g. From, To, Subject, ...). It can set new email headers (e.g. X-OTRS-Ignore:
yes or X-OTRS-Queue: spam) if a filter rule matches. The jobs of the Example below can
be inserted in Kernel/Config.pm

例4.4 Example jobs for the filter module
Kernel::System::PostMaster::Filter::Match

# Job Name: 1-Match
# (block/ignore all spam email with From: noreply@)
$Self->{'PostMaster::PreFilterModule'}->{'1-Match'} = {
    Module => 'Kernel::System::PostMaster::Filter::Match',
    Match => {
        From => 'noreply@',
    },
    Set => {
        'X-OTRS-Ignore' => 'yes',
    },
};
# Job Name: 2-Match
# (sort emails with From: sales@example.com and Subject: **ORDER**
# into queue 'Order')
$Self->{'PostMaster::PreFilterModule'}->{'2-Match'} = {
    Module => 'Kernel::System::PostMaster::Filter::Match',
    Match => {
        To => 'sales@example.com',
        Subject => '**ORDER**',
    },
    Set => {
        'X-OTRS-Queue' => 'Order',
    },
};
                    

Kernel::System::PostMaster::Filter::CMD is a default module to pipe the email into
an external command. The output is given to STDOUT and if the result is true, then set
new email header (e.g. X-OTRS-Ignore: yes or X-OTRS-Queue: spam). The Example below
can be used in Kernel/Config.pm

例4.5 フィルタ・モジュールのためのサンプル・ジョブ
　Kernel::System::PostMaster::Filter::CMD

# Job Name: 5-SpamAssassin
# (SpamAssassin example setup, ignore spam emails)
$Self->{'PostMaster::PreFilterModule'}->{'5-SpamAssassin'} = {
    Module => 'Kernel::System::PostMaster::Filter::CMD',
    CMD => '/usr/bin/spamassassin | grep -i "X-Spam-Status: yes"',
    Set => {
        'X-OTRS-Ignore' => 'yes',
    },
};
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Kernel::System::PostMaster::Filter::ExternalTicketNumberRecognition is a
default module that adds the possibility to parse external identifiers, in the email subject,
the body or both using regular expressions. It then stores this value in a defined dynamic
field. When an email comes in, OTRS will first search for an external identifier and when
it finds one, query OTRS on the pre-defined dynamic field. If it finds an existing ticket,
it will update this ticket, otherwise it will create a new ticket with the external reference
number in the separate field.

OTRS SysConfig already provide 4 different settings to setup different external ticket
numbers. If more settings are needed they need to be added manually. The following
example can be used in Kernel/Config.pm to extend SysConfig settings.

例4.6 Example job for the filter module
Kernel::System::PostMaster::Filter::ExternalTicketNumberRecognition

# Job Name: ExternalTicketNumberRecognition
# External Ticket Number Reconition, check for Incident-<number> in incoming mails subject
 and
# body from the addeesses <sender>@externalticket.com, if number is found it will be stored
 in
# the dynamic field 'ExternalNumber' (that need to be setup in the Admin Panel).
$Self->{'PostMaster::PreFilterModule'}->{'000-ExternalTicketNumberRecognition'} = {
    'FromAddressRegExp' => '\\s*@externalticket.com',
    'NumberRegExp'      => 'Incident-(\\d.*)',
    'SearchInSubject'   => '1',
    'SearchInBody'      => '1',
    'TicketStateTypes'  => 'new;open'
    'DynamicFieldName'  => 'ExternalNumber',
    'Module'            =>
 'Kernel::System::PostMaster::Filter::ExternalTicketNumberRecognition',
    'Name'              => 'Test External Ticket Number',
    'SenderType'        => 'system',
};
                

構成オプション

• FromAddressRegExp

This is an optional setting. Only mails matching this From: address will be considered
for this filter. You can adjust this setting to the sender address your external system
uses for outgoing mails. In case this address can differ, you can set this option to empty.
OTRS will in that case not check the sender address.

• NumberRegExp

これは必須設定項目です。この設定は
　件名またはチケットの本文からチケット番号を抽出するためにOTRSが使う正規表現を含みま
す。デフォルトの正規表現は
　以下のような例の発生と一致するでしょう。例えば「Incident-12354」そしてその部分を動的
フィールド中に括弧で挟む部分を置きます（ここでは「12354」）

• SearchInSubject

これが「1」にセットされる場合、Eメール件名はチケット番号を求めて検索されます。

• SearchInBody

これが「1」にセットされる場合、Eメール本文はチケット番号を求めて検索されます。

• TicketStateTypes（チケット・状態・タイプ）

これはオプションの設定です。もし与えられれば、それは与えられた状態タイプの開いた外部チ
ケットのみOTRSを検索するでしょう。状態タイプはセミコロンで分離されます。
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• DynamicField

これは必須の設定で、外部番号を保存するために使われている動的フィールドを定義します。
(フィールド名はシステムに存在しなければいけないしかつ有効でなければなりません)

• SenderType

これは、OTRSで記事作成に使用される送信者タイプを定義します。

Kernel::System::PostMaster::Filter::Decrypt is a default module that is capable to
decrypt an encrypted incoming email message (S/MIME or PGP) placing the unencrypted
message body in the email header X-OTRS-BodyDecrypted to be processed later.
Additionally it can also update the email body to the unencrypted version.

In order to decrypt the emails the system needs to be properly configured for S/MIME and/
or PGP and have the needed private keys to decrypt the information.

This module is disabled by default and it can be configured directly in the System
Configuration in the Admin Panel.

構成オプション

• StoreDecryptedBody

Set this option to "1" to update the email body to the unencrypted version if
the decryption was successful. Be aware that using this the emails will be stored
unencrypted and there is no possible way to revert this action.

もちろん、自分のPostMasterフィルタ・モジュールを開発することも可能です。

4.1.2.5. Troubleshooting Email Filtering

This section shows some common issues and things to consider when troubleshooting
Postmaster filters.

• The filters are worked in order of their alphabetically sorted filter names. The last filter
wins for a certain field to be set, when the criteria match twice.

• Stop After Match can prevent a second match.

• Make sure the regular expression is valid.

• Headers can be set as to control OTRS, but are not written in the mail itself.

• When matching one From, CC, TO, use EMAILADDRESS: <your@address>

• The Mailbox must be trusted.

• The match criteria are AND conditions.

• Ticket properties can not be matched by the postmaster filter.

注記
Details about Postmaster filter processing are also present in communication logs.
Make sure to check Communication Log in the Admin area.

4.2. Secure Email with PGP
OTRSは、PGP鍵を備えた送信メッセージに署名するか暗号化する能力を持っています。更に、暗
号化された受信メッセージは解読することができます。暗号化と解読はGPLツールGnuPGで実施
されます。OTRSのためのセットアップGnuPGに、次のステップを行なわなければなりません。
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1.オペレーティング・システムのパッケージ・マネージャーによるGnuPGのインストール

2. OTRSで使うGnuPGを構成してください。GnuPGと秘密鍵のための必要なディレクトリを作成
しなければなりません。シェルからユーザ「otrs」としてスクリプト中で下に示されるコマンド
を実行しなければなりません。

    linux:~# su otrs
    linux:/root$ cd
    linux:~$ pwd
    /opt/otrs
    linux:~$ gpg --gen-key
    gpg (GnuPG) 1.4.2; Copyright (C) 2005 Free Software Foundation, Inc.
    This program comes with ABSOLUTELY NO WARRANTY.
    This is free software, and you are welcome to redistribute it
    under certain conditions. See the file COPYING for details.

    gpg: directory `/opt/otrs/.gnupg' created
    gpg: new configuration file `/opt/otrs/.gnupg/gpg.conf' created
    gpg: WARNING: options in `/opt/otrs/.gnupg/gpg.conf' are not yet active during t
    his run
    gpg: keyring `/opt/otrs/.gnupg/secring.gpg' created
    gpg: keyring `/opt/otrs/.gnupg/pubring.gpg' created
    Please select what kind of key you want:
       (1) DSA and Elgamal (default)
       (2) DSA (sign only)
       (5) RSA (sign only)
    Your selection? 1
    DSA keypair will have 1024 bits.
    ELG-E keys may be between 1024 and 4096 bits long.
    What keysize do you want? (2048)
    Requested keysize is 2048 bits
    Please specify how long the key should be valid.
         0 = key does not expire
      <n>  = key expires in n days
      <n>w = key expires in n weeks
      <n>m = key expires in n months
      <n>y = key expires in n years
    Key is valid for? (0)
    Key does not expire at all
    Is this correct? (y/N) y

    You need a user ID to identify your key; the software constructs the user ID
    from the Real Name, Comment and Email Address in this form:
        "Heinrich Heine (Der Dichter) <heinrichh@duesseldorf.de>"

    Real name: Ticket System
    Email address: support@example.com
    Comment: Private PGP Key for the ticket system with address support@example.com
    You selected this USER-ID:
    "Ticket System (Private PGP Key for the ticket system with address support@examp
    le.com) <support@example.com>"

    Change (N)ame, (C)omment, (E)mail or (O)kay/(Q)uit? O
    You need a Passphrase to protect your secret key.

    Passphrase: secret
    Repeat passphrase: secret

    We need to generate a lot of random bytes. It is a good idea to perform
    some other action (type on the keyboard, move the mouse, utilize the
    disks) during the prime generation; this gives the random number
    generator a better chance to gain enough entropy.
    ++++++++++.+++++++++++++++++++++++++....+++++.+++++...+++++++++++++++++++++++++.
    +++++++++++++++++++++++++.+++++.+++++.+++++++++++++++++++++++++>++++++++++>+++++
    .......>+++++<+++++................................+++++

    Not enough random bytes available.  Please do some other work to give
    the OS a chance to collect more entropy! (Need 280 more bytes)

    ++++++++++.+++++..++++++++++..+++++....++++++++++++++++++++.+++++++++++++++.++++
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    ++++++++++++++++++++++++++.++++++++++.+++++++++++++++.++++++++++.+++++++++++++++
    ..+++++>.+++++....>+++++........................................................
    ...........................................................>+++++<+++++.........
    .............+++++^^^
    gpg: /opt/otrs/.gnupg/trustdb.gpg: trustdb created
    gpg: key 7245A970 marked as ultimately trusted
    public and secret key created and signed.

    gpg: checking the trustdb
    gpg: 3 marginal(s) needed, 1 complete(s) needed, PGP trust model
    gpg: depth: 0  valid:   1  signed:   0  trust: 0-, 0q, 0n, 0m, 0f, 1u
    pub   1024D/7245A970 2006-02-03
          Key fingerprint = 2ED5 BC36 D2B6 B055 7EE1  5833 1D7B F967 7245 A970
     uid                  Ticket System (Private pgp key for ticket system with addre
    ss support@example.com) <support@example.com>
    sub   2048g/52B97069 2006-02-03

    linux:~$
    

スクリプト: GnuPGの構成

スクリプトの中で下に示されるように、デフォルト構成は、ほとんどの要求されるパラメタのた
めに適用することができます。キーに指定された適切なパスワードで、key所有者に対する値だ
けを正確に入力しなければなりません。

3. In the screen for the PGP settings, PGP should be activated for OTRS (first option). Also,
the path to the gpg program should be set and checked.

次の構成設定(PGP::Options)はさらに変わることを要求するかもしれません。このコンフィ
グ・セッティングによって、「otrs」ユーザによってgpgのすべての実行に使用されるパラメタ
は指定することができます。特に「otrs」ユーザのGnuPGのための構成ファイルのディレクト
リは重要です。例/opt/otrs/.gnupgの中で、使用されます。このディレクトリは、PGP鍵構
成以前に作成されました。

次の構成オプション(PGP::Key::Password)によって、キーIDのペアおよび自身の秘密鍵のパス
ワードを指定することは可能です、なぜなら、外部からのコミュニケーションパートナーチケッ
トシステムに彼らのメッセージを暗号化と秘密鍵で書き込み、OTRSはそれらのメッセージをID
とパスワードをここで指定して解読するからです。

どのようにしてあなた自身の秘密鍵のIDを得ることができますか？あなた自身の秘密鍵のIDは
すでにキー生成時に表示されています。（上記ステップ１をご覧ください）さらに、次のスクリ
プト中で指定されたコマンドがユーザ「otrs」として実行される場合、IDを得ることが可能です:

    linux:~# su otrs
    linux:/root$ cd
    linux:~$ pwd
    /opt/otrs
    linux:~$ gpg --list-keys
    /opt/otrs/.gnupg/pubring.gpg
    ----------------------------
    pub   1024D/7245A970 2006-02-03
    uid                  Ticket System (Private pgp key for ticket system with
    address support@example.com) <support@example.com>
    sub   2048g/52B97069 2006-02-03

    linux:~$
    

スクリプト:自分の秘密鍵のIDを得ること。

秘密鍵のIDは、「サブ」で始まるラインで見つけることができます。それは長さ8文字で16進法
の文字列で上の例では「52B97069」です。チケットシステムでこのキー用に指定しなければな
らないパスワードは、キー生成中に与えられたのと同じです。
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このデータが挿入された後、「アップデート」ボタンはセッティングを保存するために使用する
ことができます。これでOTRSは暗号化されたメッセージを受け取り解読する準備ができていま
す。

4.このデータが挿入された後、「アップデート」ボタンはセッティングを保存するために使用する
ことができます。これでOTRSは暗号化されたメッセージを受け取り解読する準備ができていま
す。

最初の方法は、顧客管理インターフェースで顧客の公開鍵を指定することです。

第2の方法は、PGP鍵設定(管理者ページから到達可能)によってキーを指定することです。この画
面の右側のセクションにおいては、すでにインポート済の顧客の公開鍵が全て表示されま
す。PGP鍵がOTRSのために活性化され構成されたら、自分の公開鍵もそこにリストされるべき
です。PGP鍵設定画面の左のエリアでキーを探せます。さらに、新規公開鍵はファイルからシス
テムへアップロードすることができます。

OTRSへインポートされる必要のある公開鍵を備えたファイルはGnuPGP互換性をもつキー・
ファイルでなければなりません。ほとんどの場合、ファイルに格納されたキーは「ASCII
armored key」です。OTRSはこのフォーマットを取り扱えます。

4.3. Secure Email with S/MIME
一見、S/MIMEを備えた暗号化はPGP鍵を備えた暗号化より少し複雑に見えます。最初に、OTRSシ
ステムのために認証局(CA)を設立しなければなりません。後のステップは、PGP鍵で必要とされる
ものに非常に似ています:OTRSの構成、自身の証明書のインストール、必要な他の証明書のイン
ポート等。

S/MIME構成は、大部分はOTRSウェブインターフェースの外部で行われ、「otrs」ユーザによって
シェルの中で実行されるべきです。Linux下のMIME構成SSL(OpenSSL)に基づきます。したがっ
て、あなたのシステムにOpenSSLパッケージがインストールされるかどうかを第一にチェックし
てください。OpenSSLパッケージは、CA.pl(証明書生成の最も重要なステップはそれで行なうこと
ができます)と呼ばれるスクリプトを含んでいます。手続きを単純化するために、ファイルシステム
でCA.plスクリプトが保存され、シェルのパス変数に一時的に位置を入力する場所を見つけます。
(下記のスクリプトを参照)

otrs@linux:~> rpm -ql openssl | grep CA
/usr/share/ssl/misc/CA.pl
otrs@linux:~> export PATH=$PATH:/usr/share/ssl/misc
otrs@linux:~> which CA.pl
/usr/share/ssl/misc/CA.pl
otrs@linux:~> mkdir tmp; cd tmp
otrs@linux:~/tmp>

スクリプト:S/MIMEの構成

上記のスクリプトは、新規一時ディレクトリ~/tmpが作成されたことを表示しています。証明書は
その中で生成されることになっています。

証明書を作成するためには、コマンドライン中から次のオペレーションを行なってください:(我々
は、OTRS管理者がテスト用のSSL証明書および学習する目的を作成しなければならないと考えま
す。暗号化用の保証されたSSL証明書を既に持った場合それを使用して、これらのステップをス
キップしてください。)

1. SSLのために自分の認証局を開設してください。自分のSSL証明書の要請を証明するためにそれ
を必要とする(下記のスクリプトを参照)。

otrs@linux:~/tmp> CA.pl -newca
CA certificate filename (or enter to create)
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Making CA certificate ...
Generating a 1024 bit RSA private key
...++++++
......++++++
writing new private key to './demoCA/private/cakey.pem'
Enter PEM pass phrase:
Verifying - Enter PEM pass phrase:
-----
You are about to be asked to enter information that will be incorporated
into your certificate request.
What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank
For some fields there will be a default value,
If you enter '.', the field will be left blank.
-----
Country Name (2 letter code) [AU]:DE
State or Province Name (full name) [Some-State]:OTRS-state
Locality Name (eg, city) []:OTRS-town
Organization Name (eg, company) [Internet Widgits Pty Ltd]:Your company
Organizational Unit Name (eg, section) []:
Common Name (eg, YOUR name) []:OTRS Admin
Email Address []:otrs@your-domain.tld
otrs@linux:~/tmp> ls -la demoCA/
total 8
-rw-r--r--  1 otrs otrs 1330 2006-01-08 17:54 cacert.pem
drwxr-xr-x  2 otrs otrs   48 2006-01-08 17:53 certs
drwxr-xr-x  2 otrs otrs   48 2006-01-08 17:53 crl
-rw-r--r--  1 otrs otrs    0 2006-01-08 17:53 index.txt
drwxr-xr-x  2 otrs otrs   48 2006-01-08 17:53 newcerts
drwxr-xr-x  2 otrs otrs   80 2006-01-08 17:54 private
-rw-r--r--  1 otrs otrs   17 2006-01-08 17:54 serial
otrs@linux:~/tmp>
    

スクリプト:　SSLのために認証局を設立

2.証明書リクエストを生成してください(下記のスクリプトを参照)

otrs@linux:~/tmp> CA.pl -newreq
Generating a 1024 bit RSA private key
..........................................++++++
....++++++
writing new private key to 'newreq.pem'
Enter PEM pass phrase:
Verifying - Enter PEM pass phrase:
-----
You are about to be asked to enter information that will be incorporated
into your certificate request.
What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank
For some fields there will be a default value,
If you enter '.', the field will be left blank.
-----
Country Name (2 letter code) [AU]:DE\keyreturn
State or Province Name (full name) [Some-State]:OTRS-state
Locality Name (eg, city) []:OTRS-town
Organization Name (eg, company) [Internet Widgits Pty Ltd]:Your company
Organizational Unit Name (eg, section) []:
Common Name (eg, YOUR name) []:OTRS admin
Email Address []:otrs@your-domain.tld

Please enter the following 'extra' attributes
to be sent with your certificate request
A challenge password []:
An optional company name []:
Request (and private key) is in newreq.pem
otrs@linux:~/tmp> ls -la
total 4
drwxr-xr-x  6 otrs otrs  232 2006-01-08 17:54 demoCA
-rw-r--r--  1 otrs otrs 1708 2006-01-08 18:04 newreq.pem
otrs@linux:~/tmp>
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スクリプト:　証明書リクエストの作成

3.証明書リクエストは署名され、それによってあなた自身のCAに証明されます。あるいは別の外
部の保証されたCAによって署名されることによりさらに信頼性を高められます。（下記スクリ
プト参照）

otrs@linux:~/tmp> CA.pl -signreq
Using configuration from /etc/ssl/openssl.cnf
Enter pass phrase for ./demoCA/private/cakey.pem:
Check that the request matches the signature
Signature ok
Certificate Details:
        Serial Number:
            fd:85:f6:9f:14:07:16:c8
        Validity
            Not Before: Jan  8 17:04:37 2006 GMT
            Not After : Jan  8 17:04:37 2007 GMT
        Subject:
            countryName               = DE
            stateOrProvinceName       = OTRS-state
            localityName              = OTRS-town
            organizationName          = Your Company
            commonName                = OTRS administrator
            emailAddress              = otrs@your-domain.tld
        X509v3 extensions:
            X509v3 Basic Constraints:
                CA:FALSE
            Netscape Comment:
                OpenSSL Generated Certificate
            X509v3 Subject Key Identifier:
                01:D9:1E:58:C0:6D:BF:27:ED:37:34:14:D6:04:AC:C4:64:98:7A:22
            X509v3 Authority Key Identifier:
                keyid:10:4D:8D:4C:93:FD:2C:AA:9A:B3:26:80:6B:F5:D5:31:E2:8E:DB:A8
                DirName:/C=DE/ST=OTRS-state/L=OTRS-town/O=Your Company/
                CN=OTRS admin/emailAddress=otrs@your-domain.tld
                serial:FD:85:F6:9F:14:07:16:C7

Certificate is to be certified until Jan  8 17:04:37 2007 GMT (365 days)
Sign the certificate? [y/n]:y

1 out of 1 certificate requests certified, commit? [y/n]y
Write out database with 1 new entries
Data Base Updated
Signed certificate is in newcert.pem
otrs@linux:~/tmp>
    

スクリプト:証明書リクエストの署名

4.あなた自身の証明書を生成して下さい。そしてそれに伴い、署名された証明書を使う、すべての
データを生成して下さい。（下記スクリプト参照）

otrs@linux:~/tmp> CA.pl -pkcs12 "OTRS Certificate"
Enter pass phrase for newreq.pem:
Enter Export Password:
Verifying - Enter Export Password:
otrs@linux:~/tmp> ls -la
total 12
drwxr-xr-x  6 otrs otrs  328 2006-01-08 18:04 demoCA
-rw-r--r--  1 otrs otrs 3090 2006-01-08 18:13 newcert.p12
-rw-r--r--  1 otrs otrs 3791 2006-01-08 18:04 newcert.pem
-rw-r--r--  1 otrs otrs 1708 2006-01-08 18:04 newreq.pem
otrs@linux:~/tmp>
    

スクリプト:新規証明書の生成
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今、これらのオペレーションが実行され、S/MIMEセットアップはOTRSの中で完成したはずです。

セットアップのこの部分はリンク"SMIME"を選んで、管理者ページで実行されます。OTRSで一般的
なS/MIMEサポートがまだ可能にされてない場合、マスク(mask)は管理者にこれを指摘し、それを
可能にするために適切なリンクを提供します。

With the SysConfig group "Crypt::SMIME", you can also enable and configure the general
S/MIME support.

ここで、S/MIME支援を活性化し、OpenSSLコマンド用のパスおよび証明書用のディレクトリーを
定義することができます。上に作成されたキー・ファイルは、ここで示されたディレクトリーに格
納されなければいけません。そうでなければ、OpenSSLは使用できません。

次のステップはOTRS管理ページ上のS/MIME構成で行われます。ここで、OTRSシステムの秘密鍵
および他のコミュニケーション・パートナーの公開鍵(複数)をインポートすることができます。こ
のセクションの最初に作成し、OTRSに追加した公開鍵を入力してください。

Obviously, all public S/MIME keys of communication partners can be imported using the
customer user administration tool as well.

4.3.1. Fetch S/MIME Certificates from Customer User
Backends

It is possible to use a Customer User Backed (such as LDAP) as the source of public S/
MIME certificates. This certificates could be imported into the system and be displayed in
S/MIME configuration on the OTRS Admin page and they can be used from OTRS to send
encrypted emails to the customers.

In order to enable this feature is needed to:

1. Enable SMIME in SysConfig

2. Enable SMIME::FetchFromCustomer in SysConfig

3. Configure a customer user backend to provide the attribute UserSMIMECertificate
with the customer user S/MIME certificate (there is an example for LDAP customer user
mapping in $OTRS_HOME/Kernel/Config/Defaults.pm).

This feature can be used in three different ways:

1. Incoming Emails:

A dedicated Postmaster filter (PostMaster::PreFilterModule###000-
SMIMEFetchFromCustomer in SysConfig) will extract the email address of each incoming
email and will try to find the email address is the list of customers. If found it will try
get the S/MIME certificate from customer user attributes. If a certificate is found it will
try to import it (unless it was already imported).

2. Specific email address or all customers:

The console command Maint::SMIME::CustomerCertificate::Fetch can be used to
import the S/MIME certificate of one customer email address as:

shell> perl /opt/otrs/bin/otrs.Console.pl Maint::SMIME::CustomerCertificate::Fetch --
email customer@example.com
                    

In this case the console command will try to match the supplied email address with one
of the customer users. If found it will try add to the system the S/MIME certificate found
in customer user properties (if the certificate is not already added).
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The same console command can be used to import the S/MIME certificates of
all customer users (limited to CustomerUserSearchListLimit property from the
customer user backend). This option is discouraged specially for systems with a large
number of customer users as it might require too much time to execute and depending
on the limit it might be possible that not all customer certificates will be fetch. Execute
the console command in this mode as:

shell> perl /opt/otrs/bin/otrs.Console.pl Maint::SMIME::CustomerCertificate::Fetch --add-
all
                    

For this option the console command will query the customer user backends to get
all possible customers and for each it will check if there is a S/MIME certificate. If a
certificate is found, it will try to add it to the system (if the certificate is not already
added).

3. Renew existing certificates:

Another console command Maint::SMIME::CustomerCertificate::Renew can be
used to check for all existing certificates in the system. This verifies that the existing
certificates from customer users matches the ones that are retrieved by the customer
user properties. Any new certificate in the customer user backend will be added into
the system (no certificates are deleted in this process).

This console command is executed once a day
by the OTRS daemon automatically with the task
Daemon::SchedulerCronTaskManager::Task###RenewCustomerSMIMECertificates
(as seen in SysConfig), but it can be also executed manually on demand as:

shell> perl /opt/otrs/bin/otrs.Console.pl Maint::SMIME::CustomerCertificate::Renew
                    

5. Using External backends
5.1. Customer Data

OTRSは、ユーザー名、メール・アドレス、電話番号などのような多くの顧客情報属性で動作して
います。これらの属性は担当者および顧客フロント・エンドの両方に表示され、顧客の認証に使用
されます。

OTRSの内に使用されるか表示された顧客情報は高度にカスタマイズ可能です。しかし次の情報
は、顧客認証に常に必要とされます:

• User login（ユーザーログイン）

• Email address（Eメールアドレス）

• Customer ID（顧客ID）

担当者インターフェースの顧客情報を表示したければ、次のSysConfigパラメタを使用して下さ
い。

    # Ticket::Frontend::CustomerInfo*
    # （作成（電話とEメール）、ズーム、キュービュー時に顧客情報を表示）
    $Self->{'Ticket::Frontend::CustomerInfoCompose'} = 1;
    $Self->{'Ticket::Frontend::CustomerInfoZoom'} = 1;
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スクリプト：SysConfig構成パラメタ

5.2. Customer User Backend
2つのタイプの顧客バックエンド、DBおよびLDAPを使用することができます。あなたが別の顧客
バックエンド(例えばSAP)を既に持っていれば、それを使用するモジュールを書くことはもちろん
可能です。

5.2.1. データベース(デフォルト)
下記の例は、DB顧客バックエンドの構成を示します。それは、OTRSデータベースに保存された顧
客情報を使用します。

例4.7 DB顧客バックエンドの構成

# CustomerUser (customer database backend and settings)
$Self->{CustomerUser} = {
    Name => 'Database Datasource',
    Module => 'Kernel::System::CustomerUser::DB',
    Params => {
        # if you want to use an external database, add the required settings
#            DSN => 'DBI:odbc:yourdsn',
#            Type => 'mssql', # only for ODBC connections
#            DSN => 'DBI:mysql:database=customerdb;host=customerdbhost',
#            User => '',
#            Password => '',
            Table => 'customer_user',

            # CaseSensitive will control if the SQL statements need LOWER()
            #   function calls to work case insensitively. Setting this to
            #   1 will improve performance dramatically on large databases.
            CaseSensitive => 0,
        },
# customer unique id
CustomerKey => 'login',

# customer #
CustomerID => 'customer_id',
CustomerValid => 'valid_id',
    CustomerUserListFields => ['first_name', 'last_name', 'email'],
    CustomerUserSearchFields => ['login', 'last_name', 'customer_id'],
    CustomerUserSearchPrefix => '',
    CustomerUserSearchSuffix => '*',
    CustomerUserSearchListLimit => 250,
    CustomerUserPostMasterSearchFields => ['email'],
    CustomerUserNameFields => ['title','first_name','last_name'],
    CustomerUserEmailUniqCheck => 1,
#    # show not own tickets in customer panel, CompanyTickets
#    CustomerUserExcludePrimaryCustomerID => 0,
#    # generate auto logins
#    AutoLoginCreation => 0,
#    AutoLoginCreationPrefix => 'auto',
#    # admin can change customer preferences
#    AdminSetPreferences => 1,
#    # cache time to live in sec. - cache any database queries
#    CacheTTL => 0,
#    # just a read only source
#    ReadOnly => 1,
    Map => [
        # note: Login, Email and CustomerID needed!
        # var, frontend, storage, shown (1=always,2=lite), required, storage-type, http-
link, readonly, http-link-target, link class(es)
        [ 'UserTitle',      'Title',      'title',      1, 0, 'var', '', 0 ],
        [ 'UserFirstname',  'Firstname',  'first_name', 1, 1, 'var', '', 0 ],
        [ 'UserLastname',   'Lastname',   'last_name',  1, 1, 'var', '', 0 ],
        [ 'UserLogin',      'Username',   'login',      1, 1, 'var', '', 0 ],
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        [ 'UserPassword',   'Password',   'pw',         0, 0, 'var', '', 0 ],
        [ 'UserEmail',      'Email',      'email',      1, 1, 'var', '', 0 ],
#        [ 'UserEmail',      Translatable('Email'), 'email',           1, 1, 'var', '[%
 Env("CGIHandle") %]?Action=AgentTicketCompose;ResponseID=1;TicketID=[% Data.TicketID | uri
 %];ArticleID=[% Data.ArticleID | uri %]', 0, '', 'AsPopup OTRSPopup_TicketAction' ],
        [ 'UserCustomerID', 'CustomerID', 'customer_id', 0, 1, 'var', '', 0 ],
#        [ 'UserCustomerIDs', 'CustomerIDs', 'customer_ids', 1, 0, 'var', '', 0 ],
        [ 'UserPhone',        'Phone',       'phone',        1, 0, 'var', '', 0 ],
        [ 'UserFax',          'Fax',         'fax',          1, 0, 'var', '', 0 ],
        [ 'UserMobile',       'Mobile',      'mobile',       1, 0, 'var', '', 0 ],
        [ 'UserStreet',       'Street',      'street',       1, 0, 'var', '', 0 ],
        [ 'UserZip',          'Zip',         'zip',          1, 0, 'var', '', 0 ],
        [ 'UserCity',         'City',        'city',         1, 0, 'var', '', 0 ],
        [ 'UserCountry',      'Country',     'country',      1, 0, 'var', '', 0 ],
        [ 'UserComment',      'Comment',     'comments',     1, 0, 'var', '', 0 ],
        [ 'ValidID',          'Valid',       'valid_id',     0, 1, 'int', '', 0 ],

        # Dynamic field example
#        [ 'DynamicField_Name_X', undef, 'Name_X', 0, 0, 'dynamic_field', undef, 0, undef,
 undef, ],
    ],
    # default selections
    Selections => {
        UserTitle => {
            'Mr.' => 'Mr.',
            'Mrs.' => 'Mrs.',
        },
    },
};

顧客情報をカスタマイズしたい場合は、カラム・ヘッダーを変更するか、あるいは新規ものを
OTRSデータベース中のcustomer_userテーブルに加えてください。例として、下記のスクリプト
は、room番号用の新規フィールドを加える方法を教えます。

linux:~# mysql -p
Enter password:
Welcome to the MySQL monitor.  Commands end with ; or \g.
Your MySQL connection id is 116 to server version: 5.0.18-Debian_7-log

Type 'help;' or '\h' for help. Type '\c' to clear the buffer.

mysql> use otrs;
Reading table information for completion of table and column names
You can turn off this feature to get a quicker startup with -A

Database changed
mysql> ALTER TABLE customer_user ADD room VARCHAR (250);
Query OK, 1 rows affected (0.01 sec)
Records: 1  Duplicates: 0  Warnings: 0

mysql> quit
Bye
linux:~#

スクリプト:　roomフィールドのcustomer_userテーブルへの追加。

次のスクリプトで示されるように、さて、新規カラムをKernel/Config.pm中のMAP配列に追加
してください。

    # var, frontend, storage, shown (1=always,2=lite), required, storage-type, http-link,
 readonly, http-link-target, link class(es)
    [...]
    [ 'UserRoom',      'Room',      'room',       0, 1, 'var', '', 0 ],

スクリプト:roomフィールドのKernel/Config.pmファイルへの追加。

担当者インターフェースの顧客リンクによってこの顧客情報をすべて編集することも可能です。
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注記

Please note that you may omit http-link-target and link class keys in
map array elements, if they are not to be used. These keys add target="" and
class="" attributes to the HTTP link element, respectively. They are ignored if
http-link is not set.

5.2.1.1. Customer with Multiple IDs (Company Tickets)

顧客に1つを超える顧客IDを割り当てることは可能です。顧客が他の顧客のチケットへアクセスし
なければならないならばこれは役立ちます。（例えば、スーパーバイザはアシスタントのチケット
を見たい。）顧客が他の顧客のチケットへアクセスできるならば、OTRSの会社チケット機能が使わ
れます。会社チケットは、顧客パネル中の「会社チケット」リンクによってアクセスすることがで
きます。

会社チケットを使用するために、顧客にとってアクセス可能であるべきIDを備えた新規カラムを
OTRSデータベース中のcustomer_userテーブルに加えなければなりません(下記のスクリプトを
参照)。

linux:~# mysql -p
Enter password:
Welcome to the MySQL monitor.  Commands end with ; or \g.
Your MySQL connection id is 124 to server version: 5.0.18-Debian_7-log

Type 'help;' or '\h' for help. Type '\c' to clear the buffer.

mysql> use otrs;
Reading table information for completion of table and column names
You can turn off this feature to get a quicker startup with -A

Database changed
mysql> ALTER TABLE customer_user ADD customer_ids VARCHAR (250);
Query OK, 1 rows affected (0.02 sec)
Records: 1  Duplicates: 0  Warnings: 0

mysql> quit
Bye
linux:~#

スクリプト: customer_idsフィールドのcustomer_userテーブルへの追加。

スクリプトの中で下に示されるように、新規カラムをKernel/Config.pm中のMAP配列に加えな
ければなりません。

    # var, frontend, storage, shown (1=always,2=lite), required, storage-type, http-link,
 readonly, http-link-target, link class(es)
    [...]
    [ 'UserCustomerIDs', 'CustomerIDs', 'customer_ids', 1, 0, 'var', '', 0 ],

スクリプト: UserCustomerIDsフィールドの Kernel/Config.pmファイル への追加。

ここで、多数の顧客IDのための新規カラムは、顧客管理のためのセクションの中で担当者・イン
ターフェース経由で編集することができます。

To ensure that one customer can access the tickets of other customers, add the IDs of
these other users into the new field for the multiple customer IDs. Each ID has to be
separated by a semicolon (see Example below).

例4.8 Using Company Tickets with a DB Backend

顧客A、BおよびCはあなたのシステムに存在します。また、Aは顧客パネルからBとCのチケットに
アクセスしたい。BとCは他のユーザのチケットにアクセスするべきではありません。
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このセットアップを実現するためには、上に記述されるようなKernel/Config.pm中の
customer_userテーブルおよびMappingを変更してください。次に、担当者インターフェースあ
るいは管理者ページの顧客リンクから、顧客Aのための設定をロードしてください。設定が表示さ
れる場合、CustomerIDsのためのフィールドへ値「B;C;」を追加して下さい。

5.2.2. LDAP
顧客情報を備えたLDAPディレクトリーを持っているならば、下記の例において示されるよう
に、OTRSの顧客バックエンドとしてそれを使用することができます。

例4.9 LDAP顧客バックエンドの構成

# CustomerUser
# (customer ldap backend and settings)
$Self->{CustomerUser} = {
    Name => 'LDAP Data Source',
    Module => 'Kernel::System::CustomerUser::LDAP',
    Params => {
        # ldap host
        Host => 'bay.csuhayward.edu',
        # ldap base dn
        BaseDN => 'ou=seas,o=csuh',
        # search scope (one|sub)
        SSCOPE => 'sub',
        # The following is valid but would only be necessary if the
        # anonymous user does NOT have permission to read from the LDAP tree
        UserDN => '',
        UserPw => '',
        # in case you want to add always one filter to each ldap query, use
        # this option. e. g. AlwaysFilter => '(mail=*)' or AlwaysFilter =>
 '(objectclass=user)'
        AlwaysFilter => '',
            # if the charset of your ldap server is iso-8859-1, use this:
#            SourceCharset => 'iso-8859-1',

            # Net::LDAP new params (if needed - for more info see perldoc Net::LDAP)
            Params => {
                port => 389,
                timeout => 120,
                async => 0,
                version => 3,
            },
    },
    # customer unique id
    CustomerKey => 'uid',
    # customer #
    CustomerID => 'mail',
    CustomerUserListFields => ['cn', 'mail'],
    CustomerUserSearchFields => ['uid', 'cn', 'mail'],
    CustomerUserSearchPrefix => '',
    CustomerUserSearchSuffix => '*',
    CustomerUserSearchListLimit => 250,
    CustomerUserPostMasterSearchFields => ['mail'],
    CustomerUserNameFields => ['givenname', 'sn'],
    # show not own tickets in customer panel, CompanyTickets
    CustomerUserExcludePrimaryCustomerID => 0,
    # add an ldap filter for valid users (expert setting)
#    CustomerUserValidFilter => '(!(description=locked))',
    # administrator can't change customer preferences
    AdminSetPreferences => 0,
#    # cache time to live in sec. - cache any database queries
#    CacheTTL => 0,
    Map => [
        # note: Login, Email and CustomerID are mandatory!
        # var, frontend, storage, shown (1=always,2=lite), required, storage-type, http-
link, readonly, http-link-target, link class(es)
        [ 'UserTitle',      'Title',      'title',           1, 0, 'var', '', 0 ],
        [ 'UserFirstname',  'Firstname',  'givenname',       1, 1, 'var', '', 0 ],
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        [ 'UserLastname',   'Lastname',   'sn',              1, 1, 'var', '', 0 ],
        [ 'UserLogin',      'Username',   'uid',             1, 1, 'var', '', 0 ],
        [ 'UserEmail',      'Email',      'mail',            1, 1, 'var', '', 0 ],
        [ 'UserCustomerID', 'CustomerID', 'mail',            0, 1, 'var', '', 0 ],
#        [ 'UserCustomerIDs', 'CustomerIDs', 'second_customer_ids', 1, 0, 'var', '', 0 ],
        [ 'UserPhone',      'Phone',      'telephonenumber', 1, 0, 'var', '', 0 ],
        [ 'UserAddress',    'Address',    'postaladdress',   1, 0, 'var', '', 0 ],
        [ 'UserComment',    'Comment',    'description',     1, 0, 'var', '', 0 ],
    ],
};

追加の顧客属性（マネージャーの名前、携帯電話番号あるいは部署のような）が、あなたのLDAP
ディレクトリーに格納されていて、この情報をOTRSに表示したいならば、次のスクリプトの中で
示されるように、これらの属性へのエントリーを備えたKernel/Config.pm 中のMAP配列をただ
拡張してください。

    # var, frontend, storage, shown (1=always,2=lite), required, storage-type, http-link,
 readonly, http-link-target, link class(es)
    [...]
    [ 'UserPhone',      'Phone',      'telephonenumber', 1, 0, 'var', '', 0 ],

スクリプト:新規フィールドのKernel/Config.pmファイルへの追加

5.2.2.1. Customer with Multiple IDs (Company Tickets)

LDAPバックエンドを使用する場合、顧客にひとつ以上の顧客IDを割り当てることが可能です。会
社チケットを使用するために、新規フィールドを顧客によってアクセス可能なIDを含んでいる
LDAPディレクトリーに加えなければなりません。

LDAPディレクトリーの新規フィールドが作成されている場合、スクリプトの中で下に示されるよ
うに、新規エントリーをKernel/Config.pm中のMAP配列に加えなければなりません。

    # var, frontend, storage, shown (1=always,2=lite), required, storage-type, http-link,
 readonly
    [...]
    [ 'UserCustomerIDs', 'CustomerIDs', 'customer_ids', 1, 0, 'var', '', 0 ],

スクリプト:　新規フィールドのKernel/Config.pmファイルへのMaping

複数の顧客IDのためのフィールドをLDAPディレクトリーで直接編集しなければなりません。OTRS
はLDAPから単に読み込むだけで書き込むことはできません。

To ensure access by a customer to the tickets of other customers, add the customer IDs of
the customers whose tickets should be accessed to the new field in your LDAP directory.
Each ID has to be separated by a semicolon (see Example below).

例4.10 LDAPバックエンドを備えた会社チケットの使用

顧客A、BおよびCはあなたのシステムに存在します。また、Aは顧客パネルからBとCのチケットに
アクセスしたい。BとCは他のユーザのチケットにアクセスするべきではありません。

このセットアップを実現するためには、上に記述されるようなKernel/Config.pm中のLDAPディ
レクトリーおよびMappingを変更してください。その後、CustomerIDsのためのフィールドへ値
「B; C;」をあなたのLDAPディレクトリーの顧客Aのために追加して下さい。

5.2.3. Using More than One Customer Backend with
OTRS

If you want to utilize more than one customer data source used with OTRS (e.g. an LDAP
and a database backend), the CustomerUser config parameter should be expanded with
a number, e.g. "CustomerUser1", "CustomerUser2" (see Example below).

103



例4.11 OTRSでひとつ以上の顧客バックエンドを使用する
以下は、OTRSでLDAPとデータベース顧客バックエンドの両方を使用する構成例です。

# 1. Customer user backend: DB
# (customer database backend and settings)
$Self->{CustomerUser1} = {
    Name => 'Customer Database',
    Module => 'Kernel::System::CustomerUser::DB',
    Params => {
        # if you want to use an external database, add the
        # required settings
#        DSN => 'DBI:odbc:yourdsn',
#        Type => 'mssql', # only for ODBC connections
#        DSN => 'DBI:mysql:database=customerdb;host=customerdbhost',
#        User => '',
#        Password => '',
        Table => 'customer_user',
    },
    # customer unique id
    CustomerKey => 'login',
    # customer #
    CustomerID => 'customer_id',
    CustomerValid => 'valid_id',
    CustomerUserListFields => ['first_name', 'last_name', 'email'],
    CustomerUserSearchFields => ['login', 'last_name', 'customer_id'],
    CustomerUserSearchPrefix => '',
    CustomerUserSearchSuffix => '*',
    CustomerUserSearchListLimit => 250,
    CustomerUserPostMasterSearchFields => ['email'],
    CustomerUserNameFields => ['title','first_name','last_name'],
    CustomerUserEmailUniqCheck => 1,
#    # show not own tickets in customer panel, CompanyTickets
#    CustomerUserExcludePrimaryCustomerID => 0,
#    # generate auto logins
#    AutoLoginCreation => 0,
#    AutoLoginCreationPrefix => 'auto',
#    # admin can change customer preferences
#    AdminSetPreferences => 1,
#    # cache time to live in sec. - cache any database queries
#    CacheTTL => 0,
#    # just a read only source
#    ReadOnly => 1,
    Map => [

        # note: Login, Email and CustomerID needed!
        # var, frontend, storage, shown (1=always,2=lite), required, storage-type, http-
link, readonly, http-link-target
        [ 'UserTitle',      'Title',      'title',        1, 0, 'var', '', 0 ],
        [ 'UserFirstname',  'Firstname',  'first_name',   1, 1, 'var', '', 0 ],
        [ 'UserLastname',   'Lastname',   'last_name',    1, 1, 'var', '', 0 ],
        [ 'UserLogin',      'Username',   'login',        1, 1, 'var', '', 0 ],
        [ 'UserPassword',   'Password',   'pw',           0, 0, 'var', '', 0 ],
        [ 'UserEmail',      'Email',      'email',        1, 1, 'var', '', 0 ],
        [ 'UserCustomerID', 'CustomerID', 'customer_id',  0, 1, 'var', '', 0 ],
        [ 'UserPhone',      'Phone',      'phone',        1, 0, 'var', '', 0 ],
        [ 'UserFax',        'Fax',        'fax',          1, 0, 'var', '', 0 ],
        [ 'UserMobile',     'Mobile',     'mobile',       1, 0, 'var', '', 0 ],
        [ 'UserStreet',     'Street',     'street',       1, 0, 'var', '', 0 ],
        [ 'UserZip',        'Zip',        'zip',          1, 0, 'var', '', 0 ],
        [ 'UserCity',       'City',       'city',         1, 0, 'var', '', 0 ],
        [ 'UserCountry',    'Country',    'country',      1, 0, 'var', '', 0 ],
        [ 'UserComment',    'Comment',    'comments',     1, 0, 'var', '', 0 ],
        [ 'ValidID',        'Valid',      'valid_id',     0, 1, 'int', '', 0 ],
    ],
    # default selections
    Selections => {
        UserTitle => {
            'Mr.' => 'Mr.',
            'Mrs.' => 'Mrs.',
        },
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    },
};

# 2. Customer user backend: LDAP
# (customer ldap backend and settings)
$Self->{CustomerUser2} = {
    Name => 'LDAP Datasource',
    Module => 'Kernel::System::CustomerUser::LDAP',
    Params => {
        # ldap host
        Host => 'bay.csuhayward.edu',
        # ldap base dn
        BaseDN => 'ou=seas,o=csuh',
        # search scope (one|sub)
        SSCOPE => 'sub',
        # The following is valid but would only be necessary if the
        # anonymous user does NOT have permission to read from the LDAP tree
        UserDN => '',
        UserPw => '',
        # in case you want to add always one filter to each ldap query, use
        # this option. e. g. AlwaysFilter => '(mail=*)' or AlwaysFilter =>
 '(objectclass=user)'
        AlwaysFilter => '',
        # if the charset of your ldap server is iso-8859-1, use this:
#        SourceCharset => 'iso-8859-1',

        # Net::LDAP new params (if needed - for more info see perldoc Net::LDAP)
        Params => {
            port => 389,
            timeout => 120,
            async => 0,
            version => 3,
        },
    },
    # customer unique id
    CustomerKey => 'uid',
    # customer #
    CustomerID => 'mail',
    CustomerUserListFields => ['cn', 'mail'],
    CustomerUserSearchFields => ['uid', 'cn', 'mail'],
    CustomerUserSearchPrefix => '',
    CustomerUserSearchSuffix => '*',
    CustomerUserSearchListLimit => 250,
    CustomerUserPostMasterSearchFields => ['mail'],
    CustomerUserNameFields => ['givenname', 'sn'],
    # show not own tickets in customer panel, CompanyTickets
    CustomerUserExcludePrimaryCustomerID => 0,
    # add a ldap filter for valid users (expert setting)
#    CustomerUserValidFilter => '(!(description=locked))',
    # admin can't change customer preferences
    AdminSetPreferences => 0,
    Map => [
        # note: Login, Email and CustomerID needed!
        # var, frontend, storage, shown (1=always,2=lite), required, storage-type, http-
link, readonly
        [ 'UserTitle',      'Title',      'title',           1, 0, 'var', '', 0 ],
        [ 'UserFirstname',  'Firstname',  'givenname',       1, 1, 'var', '', 0 ],
        [ 'UserLastname',   'Lastname',   'sn',              1, 1, 'var', '', 0 ],
        [ 'UserLogin',      'Username',   'uid',             1, 1, 'var', '', 0 ],
        [ 'UserEmail',      'Email',      'mail',            1, 1, 'var', '', 0 ],
        [ 'UserCustomerID', 'CustomerID', 'mail',            0, 1, 'var', '', 0 ],
#        [ 'UserCustomerIDs', 'CustomerIDs', 'second_customer_ids', 1, 0, 'var', '', 0 ],
        [ 'UserPhone',      'Phone',      'telephonenumber', 1, 0, 'var', '', 0 ],
        [ 'UserAddress',    'Address',    'postaladdress',   1, 0, 'var', '', 0 ],
        [ 'UserComment',    'Comment',    'description',     1, 0, 'var', '', 0 ],
    ],
};

10までの異なる顧客バックエンドを統合することは可能です。全ての顧客情報を見るか編集する
(書き込みアクセス権限が可能と仮定して)ためにOTRSの中で顧客管理インターフェースを使用して
ください。
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5.2.4. Storing CustomerUser Data in Dynamic Fields
顧客データを直接チケットの動的フィールドに格納することも時には役立つかもしれません。（例
えばこのデータで特別な統計を作成するような目的で）

チケットが作成される場合、あるいはチケットの顧客が変更される場合、動的フィールド値がセッ
トされます。動的フィールドの値は顧客データから得られます。これはすべてのバックエンドのた
めに働きますが、特にLDAPバックエンドに役立ちます。

To activate this optional feature of OTRS, please activate the
settings Ticket::EventModulePost###950-DynamicFieldFromCustomerUser and
DynamicFieldFromCustomerUser::Mapping. The latter setting contains the
configuration of which CustomerUser field entry should be stored in which ticket
dynamic field. The fields must be present in the system and should be enabled for
AgentTicketFreeText, so that they can be set manually. They mustn't be enabled for
AgentTicketPhone, AgentTicketEmail and AgentTicketCustomer. If they were, they
would have precedence over the automatically set values.

5.3. Backends to Authenticate Agents and
Customers

OTRSは、異なるバックエンドに対する、担当者および顧客を認証するオプションを提示します。

5.3.1. 担当者のための認証バックエンド

5.3.1.1. DB(デフォルト)

The backend to authenticate agents which is used by default is the OTRS database. Agents
can be added and edited via the agent management interface in the Admin page (see
Example below).

例4.12 DBバックエンドに対する認証エージェント

 $Self->{'AuthModule'} = 'Kernel::System::Auth::DB';

5.3.1.2. LDAP

LDAPディレクトリが担当者データをすべて保存する場合、OTRSの中のユーザを認証するために
LDAPモジュールを使用することができます(下記の例を参照)。このモジュールはLDAPツリーに対
して単に読み取り権限を有しています。それは、担当者管理インターフェース経由で利用者データ
を編集することができないことを意味します。

例4.13 LDAPバックエンドに対する認証エージェント

# This is an example configuration for an LDAP auth. backend.
# (Make sure Net::LDAP is installed!)
$Self->{'AuthModule'} = 'Kernel::System::Auth::LDAP';
$Self->{'AuthModule::LDAP::Host'} = 'ldap.example.com';
$Self->{'AuthModule::LDAP::BaseDN'} = 'dc=example,dc=com';
$Self->{'AuthModule::LDAP::UID'} = 'uid';

# Check if the user is allowed to auth in a posixGroup
# (e. g. user needs to be in a group xyz to use otrs)
$Self->{'AuthModule::LDAP::GroupDN'} = 'cn=otrsallow,ou=posixGroups,dc=example,dc=com';
$Self->{'AuthModule::LDAP::AccessAttr'} = 'memberUid';
# for ldap posixGroups objectclass (just uid)
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#  $Self->{'AuthModule::LDAP::UserAttr'} = 'UID';
# for non ldap posixGroups objectclass (with full user dn)
#  $Self->{'AuthModule::LDAP::UserAttr'} = 'DN';

# The following is valid but would only be necessary if the
# anonymous user do NOT have permission to read from the LDAP tree
$Self->{'AuthModule::LDAP::SearchUserDN'} = '';
$Self->{'AuthModule::LDAP::SearchUserPw'} = '';

# in case you want to add always one filter to each ldap query, use
# this option. e. g. AlwaysFilter => '(mail=*)' or AlwaysFilter => '(objectclass=user)'
$Self->{'AuthModule::LDAP::AlwaysFilter'} = '';

# in case you want to add a suffix to each login name, then
# you can use this option. e. g. user just want to use user but
# in your ldap directory exists user@domain.com
#    $Self->{'AuthModule::LDAP::UserSuffix'} = '@domain.com';

# Net::LDAP new params (if needed - for more info see perldoc Net::LDAP)
$Self->{'AuthModule::LDAP::Params'} = {
    port => 389,
    timeout => 120,
    async => 0,
    version => 3,
};

スクリプトの中で下に示される構成パラメータは、ローカルのOTRSデータベースの中へのLDAP
ディレクトリーからの利用者データを同期させるために使用することができます。これは、LDAP
サーバーにリクエストの数を減らし、OTRSでの認証の速度を向上させます。担当者が最初に認証す
る場合、データ同期は終っています。ローカルのOTRSデータベースへデータを同期することがで
きますが、LDAPディレクトリーは認証のための最後の実体（インスタンス）です、したがっ
て、LDAPツリー内の活性化されていないユーザは認証することができません。アカウント・デー
タがOTRSデータベースに既に保存されている場合さえ。LDAPディレクトリーの担当者データ
は、OTRSのウェブインターフェース経由で編集することができません。したがって、LDAPツリー
にデータを直接管理しなければなりません。

# AuthModule用にAuthSyncBackend (AuthSyncModule)定義します。
# キーが存在しそれが空ならば、Syncにならないでしょう。
# サンプル値: AuthSyncBackend, AuthSyncBackend2
$Self->{'AuthModule::UseSyncBackend'} = 'AuthSyncBackend';

# LDAPに対する担当者データ sync
$Self->{'AuthSyncModule'} = 'Kernel::System::Auth::Sync::LDAP';
$Self->{'AuthSyncModule::LDAP::Host'} = 'ldap://ldap.example.com/';
$Self->{'AuthSyncModule::LDAP::BaseDN'} = 'dc=otrs, dc=org';
$Self->{'AuthSyncModule::LDAP::UID'} = 'uid';
$Self->{'AuthSyncModule::LDAP::SearchUserDN'} = 'uid=sys, ou=user, dc=otrs, dc=org';
$Self->{'AuthSyncModule::LDAP::SearchUserPw'} = 'some_pass';
$Self->{'AuthSyncModule::LDAP::UserSyncMap'} = {
    # DB -> LDAP
    UserFirstname => 'givenName',
    UserLastname  => 'sn',
    UserEmail     => 'mail',
};
[...]

# AuthSyncModule::LDAP::UserSyncInitialGroups
# (最初の担当者のログインの初期の作成後に、rw許可を持つsync followingグループ）
$Self->{'AuthSyncModule::LDAP::UserSyncInitialGroups'} = [
    'users',
];

スクリプト：OTRSデータベースの中へのLDAPディレクトリーからの利用者データを同期させる
こと。

Alternatively, you can use LDAP groups to determine group memberships or roles in
OTRS. For more information and examples, see Kernel/Config/Defaults.pm. Here is an
example for synchronizing from LDAP into OTRS groups.
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# Attributes needed for group syncs
# (attribute name for group value key)
$Self->{'AuthSyncModule::LDAP::AccessAttr'} = 'memberUid';
# (select the attribute for type of group content UID/DN for full ldap name)
# $Self->{'AuthSyncModule::LDAP::UserAttr'} = 'UID';
# $Self->{'AuthSyncModule::LDAP::UserAttr'} = 'DN';

AuthSyncModule::LDAP::UserSyncGroupsDefinition
# (If "LDAP" was selected for AuthModule and you want to sync LDAP
# groups to otrs groups, define the following.)
$Self->{'AuthSyncModule::LDAP::UserSyncGroupsDefinition'} = {
    # your ldap group
    'cn=agent,o=otrs' => {
        # otrs group(s)
        'admin' => {
            # permission
            rw => 1,
            ro => 1,
        },
        'faq' => {
            rw => 0,
            ro => 1,
        },
    },
    'cn=agent2,o=otrs' => {
        'users' => {
            rw => 1,
            ro => 1,
        },
    }
};
    

5.3.1.3. 担当者のためのHTTPBasicAuth

If you want to implement a "single sign on" solution for all your agents, you can use HTTP
basic authentication (for all your systems) and the HTTPBasicAuth module for OTRS (see
Example below).

例4.14 HTTPBasicを使用して、担当者を認証します。

# これはapache ($ENV{REMOTE_USER})認証バックエンド用のサンプル構成です。
# apache http-basic-authのシングル・サインオンを持ちたければそれを使います。
$Self->{'AuthModule'} = 'Kernel::System::Auth::HTTPBasicAuth';

# Note:
#
# このモジュールを使うなら、代替手段として次の構成設定を使うべきです。
#（もしユーザがapache ($ENV{REMOTE_USER})として認証されていないならば）
$Self->{LoginURL} = 'http://host.example.com/not-authorised-for-otrs.html';
$Self->{LogoutURL} = 'http://host.example.com/thanks-for-using-otrs.html';

5.3.1.4. Radius

The configuration parameters shown in Example below can be used to authenticate
agents against a Radius server.

例4.15 Radiusバックエンドに対する担当者を認証します。

# これは、radiusサーバに対するauth. agentsへのサンプル構成です。
$Self->{'AuthModule'} = 'Kernel::System::Auth::Radius';
$Self->{'AuthModule::Radius::Host'} = 'radiushost';
$Self->{'AuthModule::Radius::Password'} = 'radiussecret';
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5.3.2. Authentication Backends for Customers

5.3.2.1. データベース(デフォルト)

The default user authentication backend for customers in OTRS is the OTRS database.
With this backend, all customer data can be edited via the web interface of OTRS (see
Example below).

例4.16 DBバックエンドに対する顧客ユーザ認証

# これはthe otrs dbに対する認証モジュールです。
$Self->{'Customer::AuthModule'} = 'Kernel::System::CustomerAuth::DB';
$Self->{'Customer::AuthModule::DB::Table'} = 'customer_user';
$Self->{'Customer::AuthModule::DB::CustomerKey'} = 'login';
$Self->{'Customer::AuthModule::DB::CustomerPassword'} = 'pw';
#$Self->{'Customer::AuthModule::DB::DSN'} =
 "DBI:mysql:database=customerdb;host=customerdbhost";
#$Self->{'Customer::AuthModule::DB::User'} = "some_user";
#$Self->{'Customer::AuthModule::DB::Password'} = "some_password";

5.3.2.2. LDAP

If you have an LDAP directory with all your customer data, you can use the LDAP module
to authenticate your customers to OTRS (see Example below). Because this module has
only read-access to the LDAP backend, it is not possible to edit the customer data via the
OTRS web interface.

例4.17 LDAPバックエンドに対する顧客ユーザ認証

# This is an example configuration for an LDAP auth. backend.
# (make sure Net::LDAP is installed!)
$Self->{'Customer::AuthModule'} = 'Kernel::System::CustomerAuth::LDAP';
$Self->{'Customer::AuthModule::LDAP::Host'} = 'ldap.example.com';
$Self->{'Customer::AuthModule::LDAP::BaseDN'} = 'dc=example,dc=com';
$Self->{'Customer::AuthModule::LDAP::UID'} = 'uid';

# Check if the user is allowed to auth in a posixGroup
# (e. g. user needs to be in a group xyz to use otrs)
$Self->{'Customer::AuthModule::LDAP::GroupDN'} =
 'cn=otrsallow,ou=posixGroups,dc=example,dc=com';
$Self->{'Customer::AuthModule::LDAP::AccessAttr'} = 'memberUid';
# for ldap posixGroups objectclass (just uid)
$Self->{'Customer::AuthModule::LDAP::UserAttr'} = 'UID';
# for non ldap posixGroups objectclass (full user dn)
#$Self->{'Customer::AuthModule::LDAP::UserAttr'} = 'DN';

# The following is valid but would only be necessary if the
# anonymous user does NOT have permission to read from the LDAP tree
$Self->{'Customer::AuthModule::LDAP::SearchUserDN'} = '';
$Self->{'Customer::AuthModule::LDAP::SearchUserPw'} = '';

# in case you want to add always one filter to each ldap query, use
# this option. e. g. AlwaysFilter => '(mail=*)' or AlwaysFilter => '(objectclass=user)'
$Self->{'Customer::AuthModule::LDAP::AlwaysFilter'} = '';

# in case you want to add a suffix to each customer login name, then
# you can use this option. e. g. user just want to use user but
# in your ldap directory exists user@domain.com
#$Self->{'Customer::AuthModule::LDAP::UserSuffix'} = '@domain.com';

# Net::LDAP new params (if needed - for more info see perldoc Net::LDAP)
$Self->{'Customer::AuthModule::LDAP::Params'} = {
    port => 389,
    timeout => 120,
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    async => 0,
    version => 3,
};

5.3.2.3. HTTPBasicAuth for Customers

If you want to implement a "single sign on" solution for all your customer users, you can
use HTTPBasic authentication (for all your systems) and use the HTTPBasicAuth module
with OTRS (no login is needed with OTRS any more). See Example below.

例4.18 HTTPBasicを備えた顧客ユーザ認証

# apache ($ENV{REMOTE_USER})認証バックエンド用のサンプル構成です。
# apache http-basic-authのシングル・サインオンを
# 持ちたければそれを使います。
$Self->{'Customer::AuthModule'} = 'Kernel::System::CustomerAuth::HTTPBasicAuth';

# ノート:
# このモジュールを使うなら、代替手段として次の構成設定を使うべきです。
# もしユーザがapache ($ENV{REMOTE_USER})として認証されていないならば
$Self->{CustomerPanelLoginURL} = 'http://host.example.com/not-authorised-for-otrs.html';
$Self->{CustomerPanelLogoutURL} = 'http://host.example.com/thanks-for-using-otrs.html';

5.3.2.4. Radius

The settings shown in Example below can be used to authenticate your customers against
a Radius server.

例4.19 Radiasのバックエンドに対する顧客ユーザ認証

# これはRaduisサーバへの認証顧客へのサンプル構成です。
$Self->{'Customer::AuthModule'} = 'Kernel::System::Auth::Radius';
$Self->{'Customer::AuthModule::Radius::Host'} = 'radiushost';
$Self->{'Customer::AuthModule::Radius::Password'} = 'radiussecret';

5.4. Customizing the Customer Self-
Registration
新規顧客(customer.plパネルによってアクセス可能)のための自己登録をカスタマイズすることは
可能です。新規の任意または必須フィールド（room番号、アドレスあるいは状態のような）を追
加することができます。

次の例は、顧客のroom番号を格納するためには、この場合どのように顧客データベースの中であ
なたが必須フィールドを指定することができるか示します。

5.4.1. Customizing the Web Interface
To display the new field for the room number in the customer.pl web interface, the .tt file
responsible for the layout in this interface has to be modified. Edit the Kernel/Output/
HTML/Templates/Standard/CustomerLogin.tt file, adding the new field around line 130
(see Script below).

[...]
<div class="NewLine">
    <label for="Room">[% Translate("Room{CustomerUser}") | html %]</label>
    <input title="[% Translate("Room Number") | html %]" name="Room" type="text"
 id="UserRoom" maxlength="50" />

110



</div>
[...]

スクリプト:ウェブインターフェースでの新規フィールドの表示

5.4.2. Customer Mapping
次のステップで、顧客マッピングはroom番号への新規エントリーで拡張しなければなりません。
変更がアップデート後に失われないことを確実にするためには、Kernel/Config.pm に Kernel/
Config/Defaults.pmからの「CustomerUser」設定を入れてください。スクリプト中で下に示さ
れるように、MAP配列を変更して、新規room番号フィールドを追加してください。

# CustomerUser
# （顧客データベース・バックエンドと設定）
$Self->{CustomerUser} = {
    Name => 'Database Backend',
    Module => 'Kernel::System::CustomerUser::DB',
    Params => {
        # 外部データベースを使いたければ、
        # 必須設定を追加する必要があります。
#        DSN => 'DBI:odbc:yourdsn',
#        Type => 'mssql', # only for ODBC connections
#        DSN => 'DBI:mysql:database=customerdb;host=customerdbhost',
#        User => '',
#        Password => '',
        Table => 'customer_user',
    },
    # customer unique id
    CustomerKey => 'login',
    # customer #
    CustomerID => 'customer_id',
    CustomerValid => 'valid_id',
    CustomerUserListFields => ['first_name', 'last_name', 'email'],
#    CustomerUserListFields => ['login', 'first_name', 'last_name', 'customer_id', 'email'],
    CustomerUserSearchFields => ['login', 'last_name', 'customer_id'],
    CustomerUserSearchPrefix => '',
    CustomerUserSearchSuffix => '*',
    CustomerUserSearchListLimit => 250,
    CustomerUserPostMasterSearchFields => ['email'],
    CustomerUserNameFields => ['title', 'first_name', 'last_name'],
    CustomerUserEmailUniqCheck => 1,
#    # 顧客パネルで自身のチケットではなく顧客チケットを表示します。
#    CustomerUserExcludePrimaryCustomerID => 0,
#    # 自動ログインを生成します。
#    AutoLoginCreation => 0,
#    AutoLoginCreationPrefix => 'auto',
#    # 管理者は顧客の選択（選好）を変更できます。
#    AdminSetPreferences => 1,
#    # キャッシュが生存する秒数 - キャッシュ・データベース必須
#    CacheTTL => 0,
#    # 読み込み専用のソース
#    ReadOnly => 1,
    Map => [

        # ノート：ログイン、Eメール、顧客IDは必要です！
        # 変数、フロントエンド、保存場所、表示(1=常時,2=軽度)、必須、
        # 保存タイプ、httpリンク、読み込み専用、httpリンク・ターゲット。
        [ 'UserTitle',      'Title',      'title',       1, 0, 'var', '', 0 ],
        [ 'UserFirstname',  'Firstname',  'first_name',  1, 1, 'var', '', 0 ],
        [ 'UserLastname',   'Lastname',   'last_name',   1, 1, 'var', '', 0 ],
        [ 'UserLogin',      'Username',   'login',       1, 1, 'var', '', 0 ],
        [ 'UserPassword',   'Password',   'pw',          0, 0, 'var', '', 0 ],
        [ 'UserEmail',      'Email',      'email',       1, 1, 'var', '', 0 ],
        [ 'UserCustomerID', 'CustomerID', 'customer_id', 0, 1, 'var', '', 0 ],
        [ 'UserPhone',      'Phone',      'phone',       1, 0, 'var', '', 0 ],
        [ 'UserFax',        'Fax',        'fax',         1, 0, 'var', '', 0 ],
        [ 'UserMobile',     'Mobile',     'mobile',      1, 0, 'var', '', 0 ],
        [ 'UserRoom',       'Room',       'room',        1, 0, 'var', '', 0 ],
        [ 'UserStreet',     'Street',     'street',      1, 0, 'var', '', 0 ],
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        [ 'UserZip',        'Zip',        'zip',         1, 0, 'var', '', 0 ],
        [ 'UserCity',       'City',       'city',        1, 0, 'var', '', 0 ],
        [ 'UserCountry',    'Country',    'country',     1, 0, 'var', '', 0 ],
        [ 'UserComment',    'Comment',    'comments',    1, 0, 'var', '', 0 ],
        [ 'ValidID',        'Valid',      'valid_id',    0, 1, 'int', '', 0 ],
    ],
    # default selections
    Selections => {
        UserTitle => {
            'Mr.' => 'Mr.',
            'Mrs.' => 'Mrs.',
        },
    },
};

スクリプト: マッピング配列の変更

5.4.3. Customizing the customer_user Table in the OTRS
DB
最後のステップは、新しいroom番号カラムをOTRSデータベース中customer_userテーブルに追
加することです(下記のスクリプトを参照)。このカラムでは、room番号へのエントリーは格納され
ます。

linux:~# mysql -p
Enter password:
Welcome to the MySQL monitor.  Commands end with ; or \g.
Your MySQL connection id is 6 to server version: 5.0.18-Debian_7-log

Type 'help;' or '\h' for help. Type '\c' to clear the buffer.

mysql> use otrs;
Reading table information for completion of table and column names
You can turn off this feature to get a quicker startup with -A

Database changed
mysql> ALTER TABLE customer_user ADD room VARCHAR (200);
Query OK, 3 rows affected (0.01 sec)
Records: 3  Duplicates: 0  Warnings: 0

mysql> quit
Bye
linux:~#

スクリプト:新しいカラムをcustomer_userテーブルに追加

Now the new field for the room should be displayed in the Customer Information panel if
filled, and in the Customer User administration screens. Also, new customers should have
to insert their room number if they register a new account.

6. チケット設定
6.1. チケットの状態
6.1.1. 事前定義された状態

OTRSでは、事前定義されたチケット状態とタイプを変更または新規追加することができます。状
態名と状態タイプという2つの属性が状態にとって重要です。

OTRSのデフォルト状態は以下の通りです。「完了（成功）」（'closed successful'）、「完了（不
成功）」（'closed unsuccessful'）、「結合済」（'merged'）、「新規」（'new'）、「対応中」
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（'open'）、「保留（自動完了＋）」（'pending auto close+'）、「保留（自動完了- 」（'pending
auto close-'）、「保留（期限付）」（'pending reminder'）、「削除」（'removed'.）。

6.1.1.1. 「新規」（New）

チケットは、受信Eメールから作成された時、通常この状態です。

6.1.1.2. 対応中（open）

これはキューと担当者に割り当てられたチケットのためのデフォルト状態です。

6.1.1.3. 保留（期限付）

保留時間が終了すると、チケット所有者はチケットに関するリマインダーEメールを受信します。
チケットがロックされていなければ、リマインダーはキュー中の全担当者へ送られます。リマイン
ダーチケットは単に業務時間に送信され、チケット状態が担当者によって変更されるまで、24時間
ごとに繰り返し送信されます。このステータスでのチケットによって費やされた時間は、さらにエ
スカレーション時間として追加計上されます。

6.1.1.4. 保留（自動完了-）

保留時間が終了したらこの状態のチケットは「完了（不成功）」（'closed unsuccessful'）にセット
されます。このステータスでのチケットによって費やされた時間は、さらにエスカレーション時間
として追加計上されます。

6.1.1.5. 保留（自動完了＋）

保留時間が終了したらこの状態のチケットは「完了（成功）」（'closed successful'）にセットされ
ます。この状態のチケットに費やされた時間は、さらにエスカレーション時間として追加計上され
ます。

6.1.1.6. 結合済

これは他のチケットと結合されたチケットの状態です。

6.1.1.7. Removed

This is the state for tickets that have been removed by the customer. Tickets will not really
be deleted, they are just no longer shown as open. In order to enable this state in the
customer interface you need to add the state type "removed" to the sysconfig setting
"Ticket::Frontend::CustomerTicketZoom###StateType".

6.1.1.8. 完了（成功）

これはうまく解決されたチケットの最終状態です。構成に依存しますが、一旦完了したチケットを
再対応可能にも不可能にも構成可能です。

6.1.1.9. 完了（不成功）

これは解決できなかったチケット用の最終状態です。構成に依存しますが、一旦完了したチケット
を再対応可能にも不可能にも構成可能です。

6.1.2. 状態のカスタマイズ
Every state has a name (state-name) and a type (state-type). Click on the States link
on the Admin page and press the button "Add state" to create a new state. You can
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freely choose the name of a new state. The state types can not be changed via the web
interface. The database has to be directly modified if you want to add new types or change
existing names. The default state types should typically not be modified as this can yield
unpredictable results. For instance, escalation calculations and the unlock feature are
based on specific state types.

既存の状態名は変更することができます。あるいは、新規状態はこの画面から追加されます。「新
規」状態が、ウェブインターフェース経由で変更されたなら、この変更も、構成ファイル
Kernel/Config.pmまたはSysConfigインターフェイス経由で構成変更されねばなりません。以
下のスクリプトで指定された設定は、「新規」に変更された状態で、OTRSが確実に稼働するように
変更されなければなりません。

    [...]
    # PostmasterDefaultState
    # (新規チケットのデフォルト状態)  [default: new]
    $Self->{PostmasterDefaultState} = 'new';

    # CustomerDefaultState
    # (新規顧客チケットのデフォルト状態)
    $Self->{CustomerDefaultState} = 'new';
    [...]

スクリプト:Kernel/Config.pmの設定修正

万一新規状態タイプが加えられるならば、OTRSデータベースにあるthe ticket_state_typeテーブ
ルは、下記のスクリプトで表示されるように、データベース・クライアント・プログラムで変更さ
れる必要があります。

linux:~# mysql -p
Enter password:
Welcome to the MySQL monitor.  Commands end with ; or \g.
Your MySQL connection id is 23 to server version: 5.0.16-Debian_1-log

Type 'help;' or '\h' for help. Type '\c' to clear the buffer.

mysql> use otrs;
Reading table information for completion of table and column names
You can turn off this feature to get a quicker startup with -A

Database changed
mysql> insert into ticket_state_type (name,comments) values ('own','Own
state type');
Query OK, 1 row affected (0.00 sec)

mysql> quit
Bye
linux:~#

スクリプト:OTRSデータベースの修正

あなたが今作成した新規状態タイプを使用することは可能である。状態がこの新規状態タイプとリ
ンクされた後、OTRS構成も、さらに新規状態が使用可能であることを確実にするために変更されな
ければならない。SysConfigにて次のオプションを修正してください:

Frontend::Agent::Ticket::ViewPhoneNew > AgentTicketPhone###StateDefault  - to
define the default next state for new phone tickets.

Frontend::Agent::Ticket::ViewPhoneNew > AgentTicketPhone###StateType  - to define
the available next states for new phone tickets.

Frontend::Agent::Ticket::ViewEmailNew > AgentTicketEmail###StateDefault  - to define
the default next state for new email tickets.
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Frontend::Agent::Ticket::ViewEmailNew > AgentTicketEmail###StateType  - to define
the available next states for new email tickets.

Frontend::Agent::Ticket::ViewPhoneOutbound > AgentTicketPhoneOutbound###State  -
to define the default next state for new phone articles.

Frontend::Agent::Ticket::ViewPhoneOutbound >
AgentTicketPhoneOutbound###StateType  - to define the available next states for new
phone articles.

Frontend::Agent::Ticket::ViewMove > AgentTicketMove###State  - to define the default
next state for moving a ticket.

Frontend::Agent::Ticket::ViewMove > AgentTicketMove###StateType  - to define the
available next states for moving a ticket.

Frontend::Agent::Ticket::ViewBounce > StateDefault  - to define the default next state
after bouncing a ticket.

Frontend::Agent::Ticket::ViewBounce > StateType  - to define the available next states
in the bounce screen.

Frontend::Agent::Ticket::ViewBulk > StateDefault  - to define the default next state in a
bulk action.

Frontend::Agent::Ticket::ViewBulk > StateType  - to define the available next states in
the bulk action screen.

Frontend::Agent::Ticket::ViewClose > StateDefault  - to define the default next state after
closing a ticket.

Frontend::Agent::Ticket::ViewClose > StateType  - to define the available next states in
the close screen.

Frontend::Agent::Ticket::ViewCompose > StateDefault  - to define the default next state
in the Compose (reply) screen.

Frontend::Agent::Ticket::ViewCompose > StateType  - to define the available next states
in the Compose (reply) screen.

Frontend::Agent::Ticket::ViewForward > StateDefault  - to define the default next state
after forwarding a ticket.

Frontend::Agent::Ticket::ViewForward > StateType  - to define the available next states
in the Forward screen.

Frontend::Agent::Ticket::ViewForward > StateDefault  - to define the default next state
of a ticket in the free text screen.

Frontend::Agent::Ticket::ViewForward > StateType  - to define the available next states
in the free text screen.

Core::PostMaster > PostmasterDefaultState  - to define the state of tickets created from
emails.

Core::PostMaster > PostmasterFollowUpState  - to define the state of tickets after a follow-
up has been received.

Core::PostMaster > PostmasterFollowUpStateClosed  - to define the state of tickets after
a follow-up has been received on an already closed ticket.
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Core::Ticket > ViewableStateType  - to define the state types that are displayed at various
places in the system, for example in the Queueview.

Core::Ticket > UnlockStateType  - to define the state types for unlocked tickets.

Core::Ticket > PendingReminderStateType  - to define the state type for reminder tickets.

Core::Ticket > PendingAutoStateType  - to define the state type for Pending Auto tickets.

Core::Ticket > StateAfterPending  - to define the state a ticket is set to after the Pending
Auto timer of the configured state has expired.

6.2. Ticket Priorities
OTRSには、５つのデフォルトの優先度レベルが付属しています。それは、管理者ページにある
「プロパティ」"Priorities"
　経由で変更可能です。カスタマイズされた優先度リストを作成する場合、ユーザ・インター
フェース中の優先度選択箱の中でそれらがアルファベット順にソートされると心に留めておいてく
ださい。さらに、OTRSはQueueViewの中の内部データベースIDによってチケットを順序づけしま
す。

注記

他のOTRS実体でそうであるように、優先度は、削除できないかもしれませんし、有効オプ
ションを無効まはた無効-暫定にする設定によって、単に非活性化されるかもしれません。

重要

新規優先度が加えられた場合、あるいは既存のものが変更された場合、SysConfigの中のい
くつかの値を修正したいと思うかもしれません:

• Core::Postmaster::PostmasterDefaultPriority - defines the default priority for all
incoming emails.

• Frontend::Agent:Ticket::ViewPhoneNew:Priority - defines the default priority in
the New Phone Ticket screen for agents.

• Frontend::Agent:Ticket::ViewEmailNew:Priority - defines the default priority in
the New Email Ticket screen for agents.

• ExternalFrontend::TicketCreate###PriorityDefault - defines the default priority
in the New Ticket screen in the external frontend.

6.3. チケット責任者とチケットの監視
OTRS 2.1からチケットの所有者に加えて、１チケットに対して１名の責任者を割り当てることが
可能です。さらに、チケットと関係のある全ての活動はチケットの所有者以外の誰かに見られるよ
うにできます。これらの2つの機能性は、チケット責任者（TicketResponsible）とチケット監視者
（TicketWatcher）としてインプリメントされ、タスクの割り当ておよび階層的チーム構造内に働
くことを手助けします。

6.3.1. チケット責任者
The ticket responsibility feature facilitates the complete processing of a ticket by an agent
other than the ticket owner. Thus an agent who has locked a ticket can pass it on to another
agent, who is not the ticket owner, in order for the second to respond to a customer
request. After the request has been dealt with, the first agent can withdraw the ticket
responsibility from the second agent.
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With the configuration parameter Ticket::Responsible, the ticket responsibility feature can
be activated. This will cause 3 new links to appear in the ticket activities menu of a zoomed
ticket in the agent interface.

チケット責任者は、チケット内容を呼び出して割り当てることができます。そしてチケット活動メ
ニュー「責任者」リンク（担当者インターフェイスにあるズームチケットにある）をクリックしま
す。（下図参照）

図4.82 Changing the Responsibility of a ticket in its zoomed view

After clicking on "Responsible", a pop-up dialog to change the responsibility of that ticket
will open (see figure below). This dialog can also be used to send a message to the new
responsible agent.

図4.83 Pop-up dialog to change a ticket's responsibility

チケット責任者機能が活性化されるとすぐに、担当者が責任を負う全チケットのリストは、OTRS担
当者インターフェイスの責任者ビューを通してアクセスできます。

6.3.2. チケットの監視
OTRS2.1から　「チケット監視」機能を使えば
　スーパバイザのような担当者を選ぶことにより、システム内の特定のチケットを処理することな
く監視することができます。

The TicketWatcher feature can be activated with the configuration parameter
Ticket::Watcher which adds new links to your actions toolbar. Using Ticket::WatcherGroup,
one or more user groups with permission to watch tickets can also be defined.

In order to watch a ticket, go to its zoomed view and click on the "Subscribe" link in the
ticket activities menu (see figure below).
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図4.84 Subscribing to watching a ticket in its zoomed view

If you no longer want to watch a specific ticket, go to its zoomed view and click on the
"Unsubscribe" link in the ticket activities menu (see figure below).

図4.85 Unsubscribing from watching a ticket in its zoomed view

The list of all watched tickets can be accessed through the Watched view of the OTRS
agent interface (see figure below), as soon as the ticket watcher feature gets activated.

図4.86 Watched tickets view

7. Date and Time Related Functions
7.1. 業務時間、祝祭日とタイムゾーンの設定

Some functions in OTRS, like escalations and automatic unlocking of tickets, depend on
a proper configuration of business hours, time zones and holidays. You can define these
via the SysConfig interface, in Core::Time. You can also specify different sets of business
hours, holidays and time zones as separate 'Calendars' in Core::Time::Calendar1 through
Core::Time::Calendar9. Calendars can be defined by queue settings, or on SLA levels. This
means that, for example, you can specify a calendar with 5 x 8 business hours for your
'standard' SLA, but create a separate calendar with 7 x 24 support for your 'gold' SLA;
as well as set a calendar for your 'Support-USA' queue with a different time window than
your 'Support-Japan' queue. OTRS can handle up to 99 different calendars.
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7.1.1. Time zones
OTRS needs to know which time zone should be used to store date and time related data
in the database. You can set this in Core::Time:OTRSTimeZone. The default is UTC and if
you set up a new OTRS it is strongly recommended to leave it at this. If you updated from
an OTRS older than version 6, you must ensure that OTRSTimeZone is being set to a time
zone that matches your previous setup. Otherwise new data will be stored with a different
time zone than your existing data. Once you decided on a time zone and data was stored
(tickets, etc.), you shouldn't change the time zone anymore because otherwise you would
end up with data stored in different time zones.

You can set a default time zone for new agents and customer users via
Core::Time:UserDefaultTimeZone. This time zone will be used for all users that don't have
selected a time zone in their preferences.

7.1.2. 業務時間
Set up the working hours for your system in SysConfig Core::Time:TimeWorkingHours, or
for your specific calendar in the calendar's configuration. OTRS can handle a granularity
of one hour. Checking the marks in the boxes 8, 9, 10 ... 17 corresponds with business
hours of 8:00 AM - 6:00 PM.

業務時間内にのみエスカレーション・チケットを作成することができます。エスカレーションの通
知や送信された保留チケットロックされていないチケットも同様です。

7.1.3. 日付の
Holidays that are on a fixed date every year, such as New Year's Day or the Fourth of July,
can be specified in TimeVacationDays, or in the corresponding section for the calendars
1-9.

チケットはエスカレーションしませんしまた、TimeVacationDaysに定義された日付にアンロックさ
れません。

注記

OTRS出荷のデフォルトでドイツの祝祭日をインストールしています。

7.1.4. Floating Holidays
Holidays such as Easter that do not have a yearly fixed date but instead vary each year,
can be specified in TimeVacationDaysOneTime.

チケットはエスカレーションしませんしまた、TimeVacationDaysに定義された日付にアンロックさ
れません。

注記

OTRSは、一度だけの休日をつけて出荷しません。イースターまたは感謝祭のような休日は
OTRSを構成する際にご自身でシステムに追加して下さい。

7.2. 自動アンロック
ロックされたチケットは、システムによって自動的に対応中にすることができます。この機能はこ
んな場合に有用でしょう。例えば、担当者が処理される必要のあるチケットをロックしているが、
彼が何らかの理由でそれらを処理できなければ、「彼は今緊急の用事のためオフィスの外にいま
す」ということができます。自動アンロック機能は、ロックされたチケットがないことが忘れられ
ないことを確実にするために与えられた時間の後でチケットをアンロックします。
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The amount of time before a ticket is unlocked can be specified in the queue settings for
every queue. The command bin/otrs.Console.pl Maint::Ticket::Unlock, which is
executed periodically as a cron job, performs the automated unlocking of tickets.

「マイ・キュー」にあるアンロックされたチケット・セットを持つキューを持っている担当者。個
人的選択（選好）のアンロック・チケットに関する通知を活性化した担当者。

次の条件がすべて満たされれば、チケットはアンロックされます:

• チケットがあるキューのために定義されたアンロック・タイムアウトがあります。

• チケットはロック済にセットされています。

• チケットの状態は対応中です。

アンロック・タイマーは担当者がチケットに新しい外部記事を追加すればリセットされます。それ
は次のタイプのうちのいずれかでしょう。: 外部Eメール、電話、ファックス、smsあるいは外部
ノート。

さらに、チケット中の最後の記事が担当者によって作成され、顧客が別のものを加えれば、ウェブ
あるいはEメール応答のいずれかによって、アンロック・タイマーはリセットされるでしょう。

アンロック・タイマーをリセットする最後のイベントは、チケットがもう一人の担当者にいつ割り
当てられるかです。

8. Customizing the PDF Output
このセクションは、OTRSの中のPDF出力に対する構成可能なオプションを扱います。

If you use the Print action from anywhere within the OTRS interface, it will generate a
formatted PDF file.

You can adjust the look of the files generated by OTRS by creating your own logo and
adding it to PDF::LogoFile. You can use PDF::PageSize to define the standard page size of
the generated PDF file (DIN-A4 or Letter), and also PDF::MaxPage to specify the maximum
number of pages for a PDF file, which is useful if a user generates a huge output file by
mistake.

9. Reporting
OTRS has an extensible reporting mechanism that allows to define a customized
operational statistics and generate custom reports associated with OTRS usage. The OTRS
system uses the term "statistic" generically to refer to a single report presenting various
indicators, while "report" refers to a collection of several statistics in one PDF document
that can be easily configured and automatically generated and distributed.

9.1. 統計
OTRS統計モジュールの適切な構成は多くの必要条件および考察に関連しています。これらは以下
を含んでいます。様々な評価すべきOTRSモジュール、ユーザ許可設定、計算指標とそれらの複雑
さのレベル、統計モジュールの構成の簡易化・軽減、計算の高速化・効率化、豊富な出力セットの
サポート。

統計要素(つまり特定の必要条件用の統計モジュールの機能性を補足するファイル)は、複雑な統計
の計算のために統合することができます。

9.1.1. 統計の設定および使用方法
担当者としてサインオンしたとき、統計モジュールは、メインメニューで「レポート」を選択し、
次に「統計」を選択して開くことができます。
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9.1.1.1. 概要

Selecting the "Statistics" link in the navigation bar, and then the sub-menu link
"Statistics", calls up the Overview screen. The Overview screen presents a list of all pre-
configured reports an agent can use (see figure below).

図4.87 Overview of the standard statistics.

統計モジュールがインストールされている場合、それはシステムへインポートされた少数のサンプ
ルのレポートでプレインストールされた状態になります。これらは概要ページのリストとして示さ
れます。概要リストが単一のページを越えるものまで及ぶ場合、担当者は異なるページをブラウズ
することができます。レポートのリストは、リスト中の希望のカラム・ヘッダーをクリックするこ
とで、好みに応じてソートすることができます。特別のレポートを生成するためには、概要リスト
中でレポートに関連したstat番号をクリックしてください。これによりレポート用の「ビュー」イ
ンターフェイスが表示されます。

9.1.1.2. 生成

The View screen provides the display for statistic's configuration settings (see figure
below).

図4.88 Viewing a specific statistic.

Configuration settings for a particular statistic can be set within the range of options in the
View screen. Either the statistic creator or any others with the appropriate permissions
can change the settings.

「スタート」ボタン(画面の下部)を押すことは、レポートを生成する最後のステップです。
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9.1.1.3. 構成

Agents with write rights can edit an existing report configuration by calling up the edit
screen of the statistics module. Alternately, they may create a new report.

There are four possible steps in the configuration of a statistic: the general specification
data, configuring the x-axis, y-axis and possible data filters for the reported data (or
restrictions). Let's create a new statistic as an example by clicking the "Add" button in
the overview screen. Our goal will be to get an overview of how many tickets with very
high priority are in every queue (x-axis) and state (y-axis).

図4.89 Adding a new statistic, first step.

初めに、追加する統計のタイプを選択する必要があり、3つのタイプが用意されています。

Dynamic Matrix Statistics

This type of statistics will generate a matrix of computed values (e.g. new tickets per
day of month and queue). All value cells in the matrix have the same type (number,
average time, etc). Values are computed from entities in the system (e.g. tickets).
Some matrix statistics support a summation column and/or row (only useful for certain
data).

Dynamic List Statistics

This kind of statistic will generate a table where every line (not cell) represents an
entity in the system (e.g. a ticket). The columns in this row are usually configurable
(x-axis, see below) and contain the data of this object (e.g. ticket attributes). All value
cells in one column have the same type.

Static Statistics

この種の統計は非常に設定が困難であり、通常非常に特別なおよび/または複雑な計算に使用さ
れます。

それでは、私たちの例については、「動的マトリックス」を選択してみましょう。そして、「一般
仕様」の設定は、統計タイプの選択の下に表示されます。
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図4.90 Adding a new statistic, second step.

After providing a title and description for the new statistic, we have to select the statistics
backend that we want to use. This is the actual backend module which is responsible to
collect and analyze the data for our statistic. In our case we'll select "TicketAccumulation".

担当者が事前定義のレポートを後で閲覧し生成できるように許可設定。グループ（担当者も）の制
限を緩和して下さい。このように様々なレポートを、それらを必要とする異なる部署やワークグ
ループに割り付けることができます。

例4.20 デフォルトの統計許可グループ

The "stats" group was selected. The report is viewable for all users having at least RO
rights for the "stats" group. This access is available by default.

例4.21 カスタマイズされた統計許可グループ

A group named "sales" was selected. All users with RO rights for the "sales" group can
see the stat in the view mode and generate it. However, the statistic will not be available
for viewing by other users.

さらに、可能な出力フォーマットを選択することができます。ここでは、ちょうどすべての出力形
式を維持し、実際に統計を生成するときに使用する1つを選択することができます。それでは、統
計を保存してみましょう。

次の画面へ行く次のステップが強調表示されているボタンで示されています：x軸を設定する必要
があります。ボタンをクリックするとダイアログが表示され、x軸に使用する要素を選択すること
ができます。このケースでは、キューになります：
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図4.91 Configuring the x-axis of a statistic.

We can optionally limit the queues to be shown by selecting some in the queue field. With
the checkbox we can control if the agent who generates the statistic can make changes
to the queue selection. We'll keep the defaults and press "Save".

ここで、同じような方法でy軸を設定することができます：stateフィールドを選択します。

図4.92 Configuring the y-axis of a statistic.

Here it is possible to select one element or two. In the first case, every value of the element
will be one element on the y-axis. If two elements are selected, their permutations will
be the elements on the value series. For example you could select "state" and "priority",
and the resulting elements will be "new - 1 very low", "new - 2 low", ... "open - 1 very low"
and so on. Let's just use the state and press "Save".

Now in the last step we could add data filters to only include tickets belonging to a certain
customer, with certain priorities and so on. We'll add a filter for very high priority tickets:

図4.93 Configuring the data filter of a statistic.

ここでもう一度「保存」を押します。設定が終了します。

あなたは既に設定ダイアログで構成設定の効果を確認することができるプレビュー領域があること
をに注目ている可能性があります。
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図4.94 Configuring the data filter of a statistic.

注記

プレビュー画面ではランダムデータを利用しており、またデータ・フィルタを考慮してい
ませんのでご留意下さい。

統計は設定されました。 「今すぐ実行」ボタンを押すことによって、我々は、所望の出力フォー
マットを選択することができ、統計を別の形式で生成することができビュー画面に行くことができ
ます。

9.1.1.4. インポート

The Import screen can be accessed by pressing the "Import" button on the Overview
screen. RW permissions for the statistics module are required.

図4.95 Statistics import

Import screen facilitates the importing of statistics, and when combined with the export
function of the module, is a very handy functionality. Statistics can be created and tested
conveniently on test systems, then imported into the production system.
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9.1.2. Statistics System Administration
このセクションでは、統計モジュールを取り扱うOTRS管理者のタスクおよび責任に関する情報を
提供します。

9.1.2.1. 許可設定、グループ及びキュー

The default configuration of the module registration gives all agents with "stats" group
permissions access to the statistics module.

許可設定による権限:

• rw. Allows configuring statistics.

• ro. Permits generating pre-configured statistics.

The OTRS administrator decides whether agents with the permission to generate pre-
configured statistics are allocated RO rights in the "stats" group, or if their respective
groups are added in the module registration in SysConfig.

9.1.2.2. SysConfig Settings

The SysConfig groups Core::Stats and Frontend::Agent::View::Stats contain all
configuration parameters for the basic set-up of the statistics module. Moreover,
the configuration parameter $Self->{'Frontend::Module'}->{'AgentStats'} controls the
arrangement and registration of the modules and icons within the statistics module.

9.1.2.3. Generating Statistics on the Command Line

Statistics can be generated on the command line with the command bin/
otrs.Console.pl Maint::Stats::Generate. As an example, see the command line call
in the following script.

shell> bin/otrs.Console.pl Maint::Stats::Generate --number 10004 --target-directory /tmp
Generating statistic number 10004...
  Writing file /tmp/List_of_the_most_time-consuming_tickets_Created_2015-09-08_14-51.csv.
Done.
                    

A view from the statistic configuration "Stat#10004" is generated and saved as a CSV
file in the /tmp directory.

The generated statistic can also be sent as an e-mail. More information can be called up
with the command in the script below.

shell> bin/otrs.Console.pl Maint::Stats::Generate --help
                    

It usually does not make sense to generate statistics manually via the command line,
as the statistics module has a convenient graphical user interface. However, generating
statistics manually does make sense when combined with a cron job.

Imagine the following scenario: On the first day of every month, the heads of department
want to receive a statistic for the past month. By combining a cron job and a command
line call the statistics can be sent to them automatically by e-mail. For more complex
scenarios where more the one statistic is needed to be sent and/or if a more professional
and executive look and feel is needed, please consider to use The Report Generator.
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9.2. The Report Generator
The report generator allows to combine multiple statistics for sending/downloading.
Reports can be configured to be sent automatically on specified times or run manually.

9.2.1. Report Generation Configuration and Usage
The Report Generator can be opened by selecting "Reports" and then "Reports" in the
main menu.

9.2.1.1. 概要

Selecting the "Reports" link in the navigation bar, and then the sub-menu link "Reports",
calls up the Overview screen. The Overview screen presents a list of all user defined
reports the agent can use (see figure below).

図4.96 Overview of the defined reports.

By default the system does not have any defined reports, it is a task for the administrators
to create such reports. To start with the process, click on the "Add" action button located
in the sidebar.

9.2.1.2. Creating Reports

After you've entered title and description for your report in the first step, you'll be able
to set up your report.

9.2.1.2.1. General Settings

Set up title, description and validity of the report. This information will not be visible in
the report.

図4.97 Automatic generation settings

9.2.1.2.2. Automatic Generation Settings

If the report should be generated automatically (e.g. once per day), you can set up subject,
text and recipients for the email which is going to be sent and which will contain the report
as an attachment. You'll also need to add information on how often the report should be
sent. The configuration format is taken from the cron mechanism of UNIX-based operating
systems. For more information on which settings are possible, please refer to official cron
documentation sources or wikipedia.
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図4.98 Automatic generation settings

9.2.1.2.3. Output Settings

In this section, you can set up additional information which should be contained in the
report (e.g. a preamble or an epilogue). This could be used for adding copyright or data
protection information.

図4.99 Output settings

9.2.1.3. Manually Generating Reports

To generate a report, you can use the Run now button from the reports overview. You'll be
asked for confirmation and afterwards the report will be created and sent immediately.
Please find screenshots of a generated report below.
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図4.100 Report: Front page

図4.101 Report: Table of contents
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図4.102 Report: Preamble

図4.103 Report: Statistics
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9.2.2. Report Generation Administration
This section provides information about the tasks and responsibilities of the OTRS
administrator dealing with the report generator module.

9.2.2.1. Permission settings and Groups

The default configuration of the module registration gives all agents with "stats" group
permissions access to the report generator module.

許可設定による権限:

• rw. Allows configuring, adding and deleting reports.

• ro. Permits generating already defined reports.

9.2.2.2. SysConfig Settings

The SysConfig navigation group Core::Stats::Reports contains all configuration
parameters for the basic set-up of reports.

9.2.2.3. Generating reports manually on the Command Line

Reports can be generated on the command line with the command bin/otrs.Console.pl
Maint::Stats::Reports::Generate. As an example, see the command line call in the
following script.

shell> bin/otrs.Console.pl Maint::Stats::Reports::Generate --report-name Testreport --
target-path /tmp/Testreport.pdf
Generating report...
Done.
                    

The report "Testreport" is generated and saved as "Testreport.pdf" file in the /tmp
directory.

9.2.2.4. Generating reports automatically on the Command Line

Usually OTRS daemon will generate and send by email all reports that are configured
for that on their 'Automatic Generation Settings' using their preferred schedule,
however if for any reason this is needed to be done at an arbitrary moment, OTRS
administrators can use the command line with the command bin/otrs.Console.pl
Maint::Stats::Reports::GenerateCron. As an example, see the command line call
below:

shell> bin/otrs.Console.pl Maint::Stats::Reports::GenerateCron
Generating reports...
  New tickets & ticket overview...
    Sent email to someone@otrs.com.
Done.
                    

10. 動的フィールド
10.1. 導入
動的フィールドは、チケットか記事上に格納された情報を拡張するために作られて、OTRSの中の特
別の種類のフィールドです。これらのフィールドはシステムに固定されません。 そして、それらは
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特定の画面にのみ現われる場合があります。それらが必須であれ、そうでなかれ、それらの画面上
の表現はそれらの作成時間に定義されたフィールドタイプに依存します。その作成時間はフィール
ドによって保持されるデータよります。例えば、テキスト、日付、アイテムの選択を保持する
フィールドがあります。

Dynamic fields are the evolution of TicketFreeText, TicketFreeKey, TicketFreeTime,
ArticleFreeText and ArticleFreeKey fields that where commonly used in OTRS 3.0 and
before. The limitation of these "Free Fields" was that they can be defined up to 16 (text
or dropdown) fields and 6 time fields for a ticket and 3 (text or dropdown) fields for each
article only, not more.

今、動的フィールドで、チケットまたは記事についてフィールドの数の中の制限は撤去される、チ
ケットか記事のいずれかのために希望する数だけ動的フィールドとして作成することができます。
また、それを越えて、動的フィールドの背後のフレームワークは、単なるチケットや記事だけはな
く、他のオブジェクト用カスタム・フィールドを扱う準備ができています。

動的フィールドを扱うこの新規フレームワークは、モジュール的アプローチを使用して、構成され
ている。ここでの各種類の動的フィールドは、フレームワーク用のプラグインモジュールと見なす
ことができます。このことは、公開されているOTRSモジュール、OTRSアドオン、OTRSカスタム開
発および他のカスタム開発によって容易に動的フィールドの種類を拡張することができることを意
味します。

次の動的フィールド・タイプがこのリリースで含まれている:

• テキスト(テキストの1行のライン)

• テキスト領域(テキストの多数の行)

• チェックボックス

• ドロップダウン(単一の選択、複数の値)

• マルチ選択(多項式選択の多数の値)

• 日付

• Date / Time

10.2. 構成
By default, a clean installation of OTRS comes with two pre-installed internal dynamic
fields, which cannot be removed. If you plan to use such fields in tickets, articles, customer
users or customer companies you need to create new, custom dynamic fields.

Please note that dynamic fields for customer users and companies need to be configured
accordingly in the CustomerUser and CustomerCompany mapping, usually to find in
Kernel/Config.pm of your OTRS installation. Examples for configuring them can be found
in Kernel/Config/Defaults.pm.

動的フィールドの構成はふたつの部分に分かれています。ひとつは新しい動的フィールドを追加す
るため。もうひとつは、既存の動的フィールドを管理するためです。（既存のものは「動的フィー
ルド」リンクにある「管理者」パネルへとあなたが案内する必要があります。）画面の中で、必須
として表示するため、あるいは動的フィールドを非表示にするため、あなたは「SysConfig」画面
の中でOTRS設定を変更する必要があります。

10.2.1. 動的フィールドの追加
Click on the "Admin" button located in the navigation bar, then click on the "Dynamic
Fields" link inside "Ticket Settings" box located in the lower center of the screen. The
dynamic fields overview will display as follows:
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図4.104 Dynamic fields overview screen.

作られてた全ての動的フィールドをリストへ、あなたがさらに動的フィールドを追加すると、この
画面が変化することにご留意下さい。インストレーションがOTRSのより古いバージョンから更新
された場合、この画面には既にいくつかのフィールドがあるかもしれません。

The Actions in the side bar at the left of the screen describes four possibilities: Article,
Ticket, CustomerUser and CustomerCompany, each one has its own dropdown selection
of dynamic fields.

注記
OTRSパッケージのインストレーションはより多くのオブジェクトをアクション・サイド・
バーに追加しました。

動的フィールドを作る基本手順は次のとおりです:

• アクション・サイド・バーで、希望する動的フィールドオブジェクトのドロップダウンをクリッ
クしてください。

• リストから追加したい動的フィールドタイプをクリックしてください。

• 構成を記入してください。

• 保存してください。

動的フィールドのための構成ダイアログはふたつの部分に分かれます。上部のセクションはすべて
のフィールド中に一般的です。また、下方部分は別のタイプへの1つのタイプの動的フィールドと
は異なるかもしれません。

一般的な動的フィールドセッティング:

• 名前:必須で、ユニークで、文字および数字だけが許可されます。

これは、1つの画面の中で例えばフィールドを表示または非表示するために使用するような、
フィールドの内部名前である。フィールド名のどんな修正する(推奨しませんが)場合でも、
フィールドがreferenciated（参照）される「SysConfig」設定の手動のアップデートが必要で
す。

• ラベル：必須

これは画面に表示されるフィールド名である。それは翻訳を支援します。

注記
ラベルの翻訳を言語変換ファイルに手動で加えなければならない。

• フィールド順：必須

相対的な順序を定義します。画面で表示されるフィールドの相対的な順序を定義します。デフォ
ルトでは各々の新規フィールドは最後尾に位置します。この設定の変更は他に作られた動的
フィールドの順序に影響します。このセッティングの変化は、他の作られた動的フィールドの順
序に影響するでしょう。

• 有効性:必須
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如何に表示するように構成しても、無効の動的フィールドはどの画面にも表示されません。

• フィールド・タイプ:必須。読み込み専用。

現在の選択されたフィールド・タイプを示します。

• オブジェクト・タイプ:必須。読み込み専用

フィールドの範囲を示します。

注記

例では、特定のフィールド・タイプの設定を各々説明するために、少数のフィールドが追
加されます。これらの新規フィールドは後のセクションの中でreferenciated（参照）され
るでしょう。

For the following examples all the dynamic fields will be created for the Ticket
object. If you need to create a dynamic field for Article object, just choose the field
from the Article dropdown list.

表4.6 次のフィールドがシステムへ追加されます。:

Name ラベル タイプ
Field1 My Field 1 テキスト
Field2 My Field 2 Textarea
Field3 My Field 3 チェックボックス
Field4 My Field 4 ドロップダウン
Field5 My Field 5 Multiselect
Field6 My Field 6 日付
Field7 My Field 7 Date / Time

10.2.2. テキスト動的フィールドの構成
テキスト動的フィールドは単一行の文字列を格納するために使用されます。

テキスト動的フィールド設定:

• デフォルト値:オプション。

これは、デフォルトでは編集画面上に表示される値です。(新規電話チケットまたはチケットが作
成されるような画面）

• リンクの表示：オプション。

セットされたら、フィールド値は、表示画面用に（チケット・ズームや概要のように）クリック
可能なリンクに変換されます。

例えば、「リンクを表示」を「http://www.otrs.com」にセットするなら、値を入力してクリッ
クすれば、ブラウザでOTRSウェブページが開きます。

注記

The use of [% Data.NameX | uri %] in the Set link value, where NameX is the
name of the field, will add the field value as part of the link reference.
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図4.105 動的フィールド・テキストの構成ダイアログ。

10.2.3. テキスト領域動的フィールド構成
テキスト領域の動的フィールドは複数行の文字列を格納するために使用されます。

テキストエリア動的フィールドの設定:

• 列の数:オプション、整数。

編集画面(新規電話チケットあるいはチケット作成のように)にフィールドの高さを定義するため
に使用されます。

• 列の数：オプション、整数。

この値は、編集画面でフィールドの幅を定義するために使用されます。

• デフォルト値:オプション。

これは、編集画面中のデフォルトによって示される値です。(複数行テキストも可)
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図4.106 動的フィールドテキストエリアの構成ダイアログ。

10.2.4. チェックボックス動的フィールド構成
チェックボックス動的フィールドは、真偽値を格納するために使用されます。チックボックス内の
チェックの有無で表現されます。

チェックボックス動的フィールドの設定:

• デフォルト値:必須。

これは、編集画面上デフォルトによって示される値です。(新規電話チケットあるいはチケット作
成のように)このフィールド用のデフォルト値は、チェックの有無をすることができる閉じた選択
です。

図4.107 動的フィールド・チェックボックスの構成ダイアログ
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10.2.5. ドロップダウン動的フィールドの構成
ドロップダウン動的フィールドは単一の値を格納するために閉じたリストから使用されます。

ドロップダウン動的フィールドの設定:

• 可能な値：必須。

例えば、「リンクを表示」が「http://www.otrs.com」にセットするなら、値を入力してクリッ
クすれば、ブラウザでOTRSウェブページが開きます。

• デフォルト値:オプション。

これは、編集画面上にデフォルトで示される値です(新規電話チケットあるいはチケット作成のよ
うに)。このフィールドのデフォルト値は、可能な値によって定義されるような閉じた選択です。

• 空の値の追加：必須、(はい/いいえ）

このオプションが活性化される場合、特別な値が、可能な値のリスト中で「-」を表示されて定義
されます。この特別な値は内部的には空です。

• 翻訳可能な値:必須、(はい/いいえ）

この設定は、このフィールドが翻訳可能な値であることの指標として使われます。単に翻訳され
る表示上の値であり、内部的な値に影響を与えるものではありません。翻訳値は手動で言語ファ
イルに追加する必要があります。

• リンクの表示：オプション。

セットされたら、フィールド値は、表示画面用に（チケット・ズームや概要のように）クリック
可能なリンクに変換されます。

例えば、「リンクを表示」を「http://www.otrs.com」にセットするなら、値を入力してクリッ
クすれば、ブラウザでOTRSウェブページが開きます。

注記

The use of [% Data.NameX | uri %] in the Set link value, where NameX is the
name of the field, will add the field value as part of the link reference.
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図4.108 動的フィールド・ドロップダウンの構成ダイアログ

10.2.6. 多重選択動的フィールドの構成
多重選択動的フィールドは多数の値を格納するために閉じたリストから使用されます。

多重選択動的フィールドの設定:

• 可能な値：必須。

フォームを選択するための値のリスト。
　追加のリスト項目を追加するなら、キー（内部値）と値（表示値）を指定する必要がありま
す。

• デフォルト値:オプション。

これは、編集画面上にデフォルトで示される値です(新規電話チケットあるいはチケット作成のよ
うに)。このフィールドのデフォルト値は、可能な値によって定義されるような閉じた選択です。

• 空の値の追加：必須、(はい/いいえ）

このオプションが活性化される場合、特別な値が、可能な値のリスト中で「-」を表示されて定義
されます。この特別な値は内部的には空です。

• 翻訳可能な値:必須、(はい/いいえ）

この設定は、このフィールドが翻訳可能な値であることの指標として使われます。単に翻訳され
る表示上の値であり、内部的な値に影響を与えるものではありません。翻訳値は手動で言語ファ
イルに追加する必要があります。
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図4.109 動的フィールド 複数選択の構成ダイアログ

10.2.7. 日付動的フィールド設定
日付動的フィールドは日付値(日、月および年)を格納するために使用されます。

日付動的フィールド設定:

• デフォルトの時差：オプション、整数

編集画面でデフォルトで表示される（新規電話チケットまたはチケット作成のように）現在の日
付と選択した日付間の秒数（正負可）

• Define years period: Mandatory, (Yes / No).

Used to set a defined number of years in the past and the future based on the current
date of the year select for this field. If set to Yes the following options are available:

• 過去の年：オプション、正の整数

編集画面の年選択で表示する現在の日付から過去の年数を定義します。

• 将来の年：オプション、正の整数

編集画面にある年選択で表示するために現在の日付から将来の年数を定義します。

• リンクの表示：オプション。

セットされたら、フィールド値は、表示画面用に（チケット・ズームや概要のように）クリック
可能なリンクに変換されます。

For example, if "Show link" is set to "http://www.otrs.com", clicking on the filed value
will make your browser to open the OTRS web page.
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注記

The use of [% Data.NameX | uri %] in the Set link value, where NameX is the
name of the field will add the field value as part of the link reference.

図4.110 動的フィールド 日付/時刻の構成ダイアログ

10.2.8. 日付/時刻　動的フィールドの編集
日付/時刻
　動的フィールドは日付/時刻の値（分、時、日、月と年）を格納するために使用されます。

日付/時刻　動的フィールドの設定：

• デフォルトの時差：オプション、整数

編集画面でデフォルトで表示される（新規電話チケットまたはチケット作成のように）現在の日
付と選択した日付間の秒数（正負可）

• Define years period: Mandatory, (Yes / No).

Used to set a defined number of years in the past and the future based on the current
date of the year select for this field. If set to Yes the following options are available:

• 過去の年：オプション、正の整数

編集画面の年選択で表示する現在の日付から過去の年数を定義します。

• 将来の年：オプション、正の整数

編集画面にある年選択で表示するために現在の日付から将来の年数を定義します。

• リンクの表示：オプション。
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セットされたら、フィールド値は、表示画面用に（チケット・ズームや概要のように）クリック
可能なリンクに変換されます。

For example, if "Show link" is set to "http://www.otrs.com", clicking on the filed value
will make your browser to open the OTRS web page.

注記

The use of [% Data.NameX | uri %] in the Set link value, where NameX is the
name of the field will add the field value as part of the link reference.

図4.111 動的フィールド 日付 の構成ダイアログ

10.2.9. 動的フィールドの編集
入力された動的フィールドの概要画面は（前回のサンプルと）同様に見えるはずです。
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図4.112 サンプルデータで埋められた動的フィールドの概要画面

動的フィールドを変更・編集するために、少なくともひとつのフィールドを定義し、動的フィール
ドの概要画面から既に追加済フィールドを選択し、その設定を更新しなければいけません。

注記

すべての動的フィールド設定が変更できるわけではありません。フィールド・タイプとオ
ブジェクト・タイプはフィールドの選択から固定し、それらを変更することができませ
ん。

ラベルはいつでも変更することができますが、フィールド内部名の変更は推奨されませ
ん。もし内部名が変更されるならば、全ての特別なフィールドを参照するSysConfig設定
は、ユーザ選択（定義されていれば）同様に更新されるべきです。

10.2.10. 画面上での動的フィールドの表示
特別の画面に動的フィールドを表示するために、2つの必須条件があります:

1.動的フィールドは有効でなければいけません。

2.動的フィールドは画面の構成の中で1または2にセットされなければいけません。

画面の中で動的フィールドを表示する次のステップに進みます。

• 必ず動的フィールドを有効にセットして下さい。フィールドフォームの有効性を動的フィールド
概要画面から確認できます。必要ならフィールドを編集して有効にして下さい。

• 「Sysconfig」を開き、画面左側のアクション・サイドバーにあるドロップダウンリストから「チ
ケット」を選択して下さい。

注記

さらに、既にそれを知っていれば、上記の検索ボックスあるいは「sysconfig」キー中の
「動的フィールド」を直接検索することができます。

• 探している画面用サブグループ設定へ行ってそれをクリックします。例えば
「Frontend::Agent::Ticket::ViewPhoneNew」。
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• "###DynamicField"で終わるセッティングを検索してください。例え
ば"Ticket::Frontend::AgentTicketPhone###DynamicField"。

• セッティングが空か必須の動的フィールド名がない場合は、新規エントリーを加えるためには
「+」ボタンをクリックしてください。例えばキー:Field1、Content:1．

設定にすでに動的フィールド名がリストされてることが確かならば、フィールドに表示するため
には「1」をセットし、必須として表示するためには「2」をセットします。

• Save the configuration by clicking on the "Update" button at the bottom of the screen
and navigate to the screen where you want the field to be displayed.

10.2.10.1. サンプルの表示
下記は、異なる画面上の動的フィールドを表示するか非表示にするかの「sysconfig」構成例です。

例4.22 新規電話チケット画面にあるフィールド１を活性化します。
• グループ: チケット

• サブグループ: Frontend::Agent::Ticket::ViewPhoneNew

• 設定: Ticket::Frontend::AgentTicketPhone###DynamicField

• 値:

キー 内容
Field1 1

図4.113 Field1 in New Phone Ticket Screen

例4.23 新規電話チケット画面中の必須フィールド1を活性化
• グループ: チケット

• サブグループ: Frontend::Agent::Ticket::ViewPhoneNew

• 設定: Ticket::Frontend::AgentTicketPhone###DynamicField

• 値:

キー 内容
Field1 2

図4.114 Field1 in New Phone Ticket Screen as mandatory
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例4.24 必須として新規電話チケット画面中のフィールド1を活性化

• グループ: チケット

• サブグループ: Frontend::Agent::Ticket::ViewPhoneNew

• 設定: Ticket::Frontend::AgentTicketPhone###DynamicField

• 値:

キー 内容
Field1 1
Field2 1
Field3 1
Field4 1
Field5 1
Field6 1
Field7 1

図4.115 Several fields in New Phone Ticket Screen as mandatory

例4.25 新規電話チケット画面中の複数の必須フィールドを非活性化

• グループ: チケット

• サブグループ: Frontend::Agent::Ticket::ViewPhoneNew

• 設定: Ticket::Frontend::AgentTicketPhone###DynamicField

• 値:

キー 内容
Field1 1
Field2 0
Field3 1
Field4 0
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キー 内容
Field5 1
Field6 0
Field7 1

図4.116 Some deactivated fields in New Phone Ticket Screen as
mandatory

例4.26 チケットズーム画面でフィールド１を活性化

• グループ: チケット

• サブグループ: Frontend::Agent::Ticket::ViewZoom

• 設定: Ticket::Frontend::AgentTicketZoom###DynamicField

• 値:

キー 内容
Field1 1

図4.117 Field1 in Ticket Zoom Screen

例4.27 チケット概要小画面の中のField1を活性化

• グループ: チケット

• サブグループ: Frontend::Agent::TicketOverview
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• 設定: Ticket::Frontend::OverviewSmall###DynamicField

• 値:

キー 内容
Field1 1

図4.118 Field1 in Ticket Overview Small Screen

This setting affects: Escalation View, Locked View, Queue View, Responsible View, Status
View, Service View and Watch View screens.

10.2.11. チケット・イベント・モジュールによってデフォルト値を
設定

フィールドが値をまだ持っていない場合、チケット・イベント(例えば、チケット作成)は、ある
フィールド用の値セットを引き起こすことができます。

注記

この方法の使用によって、値がチケットの生成の後にセットされるので、このデフォルト
値は編集画面(例えば新規電話チケット)で見られません。

この特徴を活性化するために、次のセッティングを可能にすることが必要で
す:"Ticket::EventModulePost###TicketDynamicFieldDefault".

例4.28 チケット作成イベントのフィールド１を活性化

• グループ: チケット

• サブグループ: Core::TicketDynamicFieldDefault

• 設定: Ticket::TicketDynamicFieldDefault###Element1

注記

この構成は、16のTicket::TicketDynamicFieldDefault###Element セッティングの
うちのどの中でもセットすることができます。

16フィールド以上をセットアップする必要があるなら、$OTRS_HOME/Kernel/Config/
files　ディレクトリにあるXMLファイルは置き換えてこの機能を拡張します。

• 値:

キー 内容
イベント チケット作成
Name Field1
値 新しい値
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10.2.12. ユーザー選択によってデフォルト値をセット
動的フィールドデフォルト値は、ユーザー選択に格納されたユーザに定義された値で上書きするこ
とができます。

この方法を使用して、フィールドのデフォルト値は、フィールドが活性化されている画面に表示さ
れます。(フィールドが異なる値をまだ持っていない場合)

「Sysconfig」設定は、サブグループ「Frontend::Agent::Preferences」の
「PreferencesGroups###DynamicField」に存在します。この設定は、選ばれたユーザのために排
他的な動的フィールドデフォルト値をセットするために、ユーザー選択画面でエントリーを作る方
法の例です。この設定の制限は、単にそれが1つの動的フィールドの使用を許すということです。2
つ以上のフィールドがこの特徴を使用する場合、これに似ているより多くの設定を加える、カスタ
ムXML設定ファイルを作成することが必要です。

注記
Remember, if more settings are added in a new XML
each setting name needs to be unique in the system
and different than "PreferencesGroups###DynamicField". For example:
PreferencesGroups###101-DynamicField-Field1, PreferencesGroups###102-
DynamicField-Field2, PreferencesGroups###My-Field1,
PreferencesGroups###My-Field2, etc.

例4.29 ユーザー選択でのField1を活性化
• グループ: チケット

• サブグループ: Frontend::Agent::Preferences

• 設定: PreferencesGroups###101-DynamicField-Field1

• 値:

キー 内容
イベント チケット作成
Active 1
Block 入力
Column その他の設定
Data: [% Env("UserDynamicField_Field1") %]
Key: My Field 1
Label: My Field 1用のデフォルト値
Module: Kernel::Output::HTML::PreferencesGeneric
PrefKey: UserDynamicField_Field1
Prio: 7000

図4.119 Field1 in User preferences screen
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11. 一般インターフェイス
OTRSの一般インターフェースは、OTRSをウェブサービスによって他のシステムと通信させる複合
レイヤーのフレームワークから成ります。このコミュニケーションは双方向になりえます。:

• 供給者としてのOTRS: OTRSは、外部システムからのリクエストを聞き、要求されたアクション
を行なって、情報を処理し、リクエストに答えるサーバーとして働きます。

• 依頼者としてのOTRS: OTRSは、遠隔のシステムにリクエストを送り、レスポンスを待って、ク
ライアント情報収集者として働きます。

11.1. 一般インターフェース・レイヤー
一般インターフェースは柔軟で、かつカスタマイズするのが簡単になるようにレイヤー・モデルに
基づいた構造である。

レイヤーとは、汎用インターフェイスがWebサービスのさまざまな部分をどのように実行するかを
制御する一連のファイルです。 適切な構成を使用すると、新しいモジュールを作成することなく、
さまざまな外部システム用に異なるWebサービスを構築できます。

注記

遠隔のシステムが一般インターフェースの現在の束ねられたモジュールを支援しない場
合、その特定のウェブサービスのために特別のモジュールを開発している必要がある。

OTRS出荷時に提供される一般インタフェース・モジュールのリストは今後更新され増加し
ていくでしょう。
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図4.120 The graphical interface layers

11.1.1. ネットワーク・トランスポート
このレイヤーは遠隔のシステムとの正確なコミュニケーションに責任を持ちます。依頼を受け取
り、供給者として働く場合、レスポンスを生成し、依頼者として働く場合、依頼および受信応答を
生成します。

供給者コミュニケーションは「nphgenericinterface.pl」と呼ばれる新規ウェブサーバによって取り
扱われます。

要求者の通信は、汎用インタフェースモジュールまたは他の任意のOTRSモジュールによってトリ
ガされたイベントの間に開始することができる。 このイベントは、イベントハンドラによって
キャッチし、イベントがリクエスタオブジェクトで直接処理またはスケジューラ（非同期タスクを
処理するように設計された分離デーモン）に委任された構成に応じています。

11.1.2. データマッピング
このレイヤーは、データ構造とOTRSそしてリモートシステムの間の翻訳について責任を持ちます
(データ内部およびデータ外部層)。通常遠隔のシステムはOTRS(異なる値およびそれらの値の名前を
含む)とは異なっているデータ構造を持っています。そしてここに受信情報を「OTRSが理解する何
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かへと変更するレイヤーの重要性が存在します。また、逆にデータ辞書を使うリモートシステムへ
の送信情報についてもです。

例:「優先度」(OTRS)は遠隔のシステムでの「Prio」と呼ばれるかもしれません。また、それは、
値「1 低」(OTRS)が遠隔のシステムについての「情報」にマッピングされるべきです。

11.1.3. コントローラー
コントローラーは同様のオペレーションあるいは依頼アクション(Invokers)の集合です。例えば、
チケット・コントローラーはいくつかの標準チケット・オペレーションを含んでいます。カスタ
ム・コントローラは実装可能です。例えば「チケット外部会社」コントローラーは標準チケット・
コントローラーと同様の機能を含みます。しかし異なるデータ・インターフェイスまたは機能名
（リモート・システム機能名に適応する）または異なるコードを完成します。

一般インターフェースのための1つのアプリケーションは、同じ種類のもう一つのリモートシステ
ムと話すことだけができるようなリモートシステムと情報を同期できるようになります。この場
合、新規コントローラーは開発される必要があります。そして、オペレーションと依頼アクション
(Invokers)は、リモートシステムの振る舞いをエミュレートしなければいけません。その振る舞い
は、OTRSが提供するインターフェイスがリモートシステムのインターフェイスと同様です。

11.1.4. オペレーション(供給者としてのOTRS)
オペレーションはOTRSの内に行なうことができる単一の行為です。オペレーションにはすべて同
じプログラミングインターフェースがあります、それらは1つの特定のパラメタへデータを受け取
り、成功ステータス、潜在的なエラーメッセージおよび返るデータを持ったデータ構造を返しま
す。

通常、オペレーションは、コアモジュールを呼び出すために、すでにマップされたデータ（内部）
を使います。そしてOTRSでアクション（チケット作成、ユーザー更新、キューの無効か、通知送
信）を実行します。オペレーションはアクションを実行するOTRS APIへのフルの権限を持ってい
ます。

11.1.5. 依頼アクション (依頼者としてのOTRS)
依頼アクション（Invokers）とは、OTRSがリモートシステムに対して行うアクションのことです。
依頼アクション(Invokers)は、リクエストを作成する必要とされる情報を処理し収集するために
OTRSコア・モジュールを使用します。情報が準備ができている場合、リモート・システムに送る
ためにリモート・システムのフォーマットにそれをマッピングしなければなりません。それはアク
ションを実行する情報を処理し、成功を処理するためか、エラーを取り扱うためのいずれかのため
に返答を送信します。

11.2. ウェブサービス・コマンドライン・インタフェー
ス
一般インターフェイスは、供給者としてそして同様に要求者としてアクションを実施するために定
義済フローをも待っています。

これらのフローは以下に記述されます。

11.2.1. 供給者としてのOTRS

11.2.1.1. リモートリクエスト：

1. HTTPリクエスト

• OTRSは、HTTPリクエストを受け取りそれをレイヤーに渡します。
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• 供給者モジュールはこれらのアクションを実行しコントロールすることを担当しています。

2.ネットワーク・トランスポート

• ネットワーク・トランスポート・モジュールは、データ・ペイロードをデコードし、オペレー
ション名とデータのそれ以外の部分とを区別します。

• オペレーション名およびオペレーションデータは供給者に返されます。

3.データ外部

• リモートシステムから送信されたデータ（これはモジュールベースのレイヤーではありませ
ん）。

4.マッピング

• データは、このオペレーション(入信する依頼データ用マッピング)のためのマッピング構成で
指定されるように、外部システム・フォーマットからOTRS内部形式へ変換されます。

• 既に変換されたデータは、供給者に返されます。

5.データ内部

• 変換され、そしてオペレーション(これはモジュールベースのレイヤではありませんん)に渡さ
れる準備が整ったデータ。

6.オペレーション

• データを受取り、有効化します。

• ユーザ・アクセス・コントロールを行います。

• アクションを実行します。

11.2.1.2. OTRSレスポンス:

1.オペレーション

• 供給者に結果データを返します。

2.データ内部

• オペレーションから返されるデータ。

3.マッピング

• データは、マッピング構成(発信の応答データ用マッピング)で指定されるリモート・システ
ム・フォーマットに変換されます。

• 既に変換されたデータは、供給者に返されます。

4.データ外部

• 返答としてネットワーク・トランスポートに渡されるために変換され、準備されるようなデー
タ。

5.ネットワーク・トランスポート

• 既にリモート・システム・フォーマット済みのデータを受け取ります。

• このネットワーク・トランスポートタイプのための有効なレスポンスを構成します。
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6. HTTPレスポンス

• 応答はウェブサービス・クライアントに返送されます。

• エラーの場合には、エラー・レスポンスが、遠隔のシステム(例えばSOAPエラー、HTTPエ
ラーなど)に送られます。

11.2.2. 依頼者としてのOTRS

11.2.2.1. OTRS依頼:

1.イベント・トリガー・ハンドラ

• ウェブサービス構成に基づいて、依頼が同期か非同期かを決定します。

• 同期

• 要求者への直接呼び出しは、新しい要求を作成し、それをレイヤーに渡すために行われま
す。

• 非同期

• OTRSデーモン用の新しいGeneric Interface（要求者）タスクを作成します（Scehduler
デーモンに要求実行を委任することにより、ユーザーエクスペリエンスが大幅に向上する
ことが可能になります。そうでなければ、これらの要求のトリガによって、要求を準備す
るのとリモート実行に必要な時間が必要になります）。

• 次のサイクルでは、OTRSデーモンプロセスが新規タスクを読んで、リクエスタへの呼び出
しを作成します。このリクエスタは新しい要求を作成し、それをレイヤーに渡します。

2.依頼アクション(Invokers)

• イベントからデータを受け取ります。

• 受信したデータを検証します（必要な場合）。

• データを補完するためにコアモジュールを呼び出します（必要な場合）。

• 要求データ構造を返すか、要求側に停止通信信号を送信し、正しく要求をキャンセルします。

3.データ内部

• 呼び出し元から渡されたデータ(これはモジュールベースのレイヤではありません)。

4.マッピング

• データは、マッピング構成(発信の応答データ用マッピング)で指定されるリモート・システ
ム・フォーマットに変換されます。

• 既に変換されたデータは、依頼者に返されます。

5.データ外部

• リモートシステムに送信するために変換され準備されたデータ。

6.ネットワーク・トランスポート

• リモート・オペレーション名と、既にリモート・システム・フォーマットに変換されたデータ
を要求側から受信します。

• ネットワーク・トランスポートの有効な依頼を構成します。
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• 要求をリモートシステムに送信し、応答を待ちます。

11.2.2.2. リモート応答:

1.ネットワーク・トランスポート

• 応答を受信し、データペイロードをデコードします。

• データを要求側に返します。

2.データ外部

• リモートシステムから受信したデータ。

3.マッピング

• データは、この操作のマッピング設定で指定されているように、外部システムフォーマットか
らOTRS内部フォーマットに変換されます（受信応答データのマッピング）。

• 既に変換されたデータは、依頼者に返されます。

4.データ内部

• データは変換され、依頼者に返送される準備ができています。

5.依頼アクション(Invokers)

• 返信データを受け取る

• 各Invokerによって必要に応じてデータを処理します(存在する場合はエラー処理を含みま
す)。

• 依頼者に実行者の結果とデータを返します。

6.イベントハンドラまたはOTRSデーモン

• 依頼者からデータを受信します。 OTRSデーモンの場合、このデータには将来のタスクを作成
するための情報が含まれている可能性があります。

11.3. ウェブサービス
Webサービスは、2つのシステム間の通信方法です。ここでは、OTRSとリモートシステムです。

Webサービスの中心は、Webサービスが内部的に実行できるアクション（操作）、OTRS要求が実行
できるアクション（呼び出し元）、データがシステム間でどのように変換されるかを定義する設定
です マッピング）。そしてどのプロトコルを介して通信が行われるか（トランスポート）を決定し
ます。

汎用インターフェイスは、互いに独立しており、互換性があり、既に作られたビルディングブロッ
クを使用して、事前に定義された方法で、OTRSのためのWebサービスを作成することを可能にする
フレームワークです。

11.4. ウェブサービス・グラフィカル・インターフェー
ス
ウェブサービスGUI(GUI)は、ユーザー・フレンドリーで便利なインターフェースで複雑なウェブ
サービス構成を構築することを可能にするツールです。それは次のものに許可します:

• ウェブサービスを作成および削除します。
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• 既存のウェブサービスのためのエクスポート/インポート構成(YAMLファイルフォーマット中
の)。

• ビュー、ウェブサービスで既存のウェブサービス用の復旧と旧構成のエクスポート

• デバッガ画面中の各ウェブサービスのすべてのコミュニケーション・ログを追跡してください。

11.4.1. ウェブサービス概要
The Web Services link in the main screen of Admin Interface (in the System Administration
box) leads to the web services overview screen, where you are able to manage your web
service configurations. You can add new web services or change the configuration of the
existing ones from this screen.

Every web service configuration screen has in the upper part of the screen a bread crumbs
style navigation path. This navigation path is useful to know exactly in which part of the
web service configuration we are, and also enables the user to jump back to any part of
the configuration process at any time (this action will not save any changes).

注記

To create a new web service, press the button Add web service, and provide the
required information.

図4.121 Web services overview

11.4.2. ウェブサービスの追加
The only required field in this part is the web service Name that needs to be unique in the
system and can not be left empty. Other fields are also necessary for the configuration like
the Debug Threshold and Validity but these fields are already populated with the default
value for each list.

The default value for Debug Threshold is debug. When configured in this manner all
communication logs are registered in the database. Each subsequent Debug Threshold
value is more restrictive and discards communication logs of lower order than the one
set in the system.

デバッグ閾値レベル（下から上へ）

• Debug

• Info

• 通知

• Error

It is also possible to define the network transport protocol for OTRS as Provider and OTRS
as requester.

Click on the Save button to register the new web service in the database or click Cancel
to discard this operation. You will now be returned to the web service overview screen.

154



If you already have a web service configuration file in YAML format you can click on the
Import web service button on the left side of the screen. For more information on importing
web services please check the next section Web Service Change.

注記
ウェブサービスに、より多くの詳細を変更・追加するためには、ウェブサービス概要画面
中のウェブサービス名をクリックしてください。

図4.122 Web services add

11.4.3. Web Service Example Import
Did you know there are example web services available in the OTRS Business Solution™?

11.4.4. ウェブサービス変更
この画面においては、ウェブサービスのすべての部分を扱う機能の完全セットを持っています。ア
クション・カラムの左側に
　いくつかのボタンがあります。それによりウェブサービス上で全ての可能なアクションを実行で
きます。

• Clone web service.(クローン・ウェブサービス)

• Export web service.(エクスポート・ウェブサービス)

155

http://otrs.github.io/doc/manual/otrs-business-solution/stable/en/html/import-example-web-service.html


• Import web service.(インポート・ウェブサービス)

• Configuration History.(構成履歴)

• Delete web service.(ウェブサービスの削除)

• Debugger.(デバッガ)

注記

Configuration history and Debugger will lead you to different screens.

11.4.4.1. ウェブサービスのクローン

To clone a web service, you need to click on the Clone web service button. A dialog will
be shown where you can use the default name or set a new name for the (cloned) web
service.

注記

Remember that the name of the web service must be unique within the system.

Click on Clone button to create the web service clone or Cancel to close the dialog.

図4.123 ウェブサービス・クローン

11.4.4.2. ウェブサービスのエクスポート

The Export web service button gives you the opportunity to dump the configuration of
the current web service into a YAML file, to download it and to store it on your file system.
This can be specially useful if you want to migrate the web service from one server to
another, for example from a testing environment to a production system.

警告

ウェブサービス構成中の格納されたパスワードはすべて、プレインテキスト・フォーマッ
トでエクスポートされます。

Right after clicking the Export web service button a save dialog of your browser will
appear, just like when you click on a file download link on a web page.

注記

各オペレーティング・システム上のブラウザにはそれぞれそれ自身の保存ダイアログ画面
およびスタイルがあります。ブラウザとその構成によってはダイアログが示されないこと
はありえます。また、ファイルはデフォルト・ディレクトリにあなたのファイルシステム
上に保存されます。必要な場合はより特殊な指示があるかブラウザ・ドキュメンテーショ
ンをチェックしてください。
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図4.124 Web services export

11.4.4.3. ウェブサービスのインポート

A valid web service configuration YAML file is required to use the import web service
feature. Click on the Import web service button, browse for the configuration file or provide
the complete path in the input box.

Click Import button to create a new web service from a file or "Cancel" to close the dialog.

注記
The web service name will be taken from the configuration file name (e.g. if
the file name is MyWebservice.yml the resulting web service will be named
MyWebservice). If a web service is registered in the system with the same name
as the web service that you want to import, the system will lead you to the web
service change screen to let you change the name of the imported web service.

図4.125 Web services import

11.4.4.4. ウェブサービス履歴

Every change to the web service configuration creates a new entry in the web service
history (as a journal). The web service history screen displays a list of all configuration
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versions for a web service. Each row (version) in the Configuration History List represents
a single revision in the web service history.

Click on one of the rows to show the whole configuration as it was on that particular date /
time. The configuration will be shown in the History details section of this screen. Here
you are also able to export the selected web service configuration version or to restore
that version into the current web service configuration.

The Export web service configuration behaves exactly as the "Export web service" feature
in the web service change screen. For more information refer to that section.

If changes to the current web service configuration do not work as expected and it
is not easy to revert the changes manually, you can click on the Revert web service
configuration button. This will open a dialog to ask you if you are sure to revert the web
service configuration. Click Revert web service configuration in this dialog to replace the
current configuration with the selected version, or click Cancel to close the dialog.

警告

ウェブサービス構成に格納されたどんなパスワードもプレインテキスト・フォーマットで
エクスポートされるだろうということを覚えておいてください。

Please be careful when you restore a configuration because this process is
irreversible.

図4.126 Web service history
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11.4.4.5. ウェブサービスの削除

Sometimes it is necessary to delete a web service completely. To do this you can press
on the Delete web service button and a new dialog will appear asking for confirmation.

Click on Delete to confirm the removal of the web service or on Cancel to close the dialog.

警告

ウェブサービスの削除はやり直しがききません。ウェブサービスを削除する場合、注意し
てください。

図4.127 ウェブサービスの削除

11.4.4.6. ウェブサービス・デバッガ

デバッガは、ウェブサービスのログを格納します。デバッガ画面では、供給者あるいは依頼者タイ
プのいずれかのためのウェブサービス・コミュニケーションをすべて追跡することができます。

この画面が示される場合、依頼リストがロードし始めます。リストが完全に満たされた後、その詳
細をチェックするために列のうちの1つを選ぶことができます。(列とはコミュニケーション・シー
ケンスを意味します)これは詳述します、下のボックスに現われます。

画面の右側ではフィルタを使用して、コミュニケーション・リストを狭くすることができます。次
のものによってフィルタすることができます：

• コミュニケーション・タイプ(供給者または依頼者)

• 日付:前、及び/または特定の日付の後

• リモートのIPアドレス

• すべての組み合わせ

After filter settings are set, push the Refresh button and a new list will be displayed
meeting your search criteria.

注記

フィルターの検索基準に依存しますが、新規リストが結果を返さないこともあり得ます。

On the left part of the screen under the action column you can select Go back to the web
service or clear the debugger log by pushing the Clear button. This will open a dialog that
ask you to confirm erasing of the log. Click Clear in the dialog button to perform the action
or click on Cancel to close this dialog.

In the Request details section you can see all the details for the selected communication.
Here you can track the complete flow and check for possible errors or confirm success
responses.
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図4.128 Web service debugger

11.4.4.7. ウェブサービス構成変更

Returning to the web service change screen, now we are going to review the right side
of it. Here we have the possibility to modify all the general data for a web service such
as name, description, debug threshold, etc. Also there are two more sections below that
allows us to modify specific parameters for communication types OTRS as Provider and
OTRS as Requester.

ウェブサービス構成は各レベル上に保存する必要があります。このことは設定が変われば、現在の
構成レベルを保存してしまうことで、他へのリンクや構成の深い部分が無効にしてしまうことを意
味します。保存後に、無効となったリンクは
　再び構成を継続することを可能にすることで、再度可能にできます。

On the OTRS as provider section it is possible to set or configure the network transport
protocol. Only network transport back-ends that are registered are shown on the list. To
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configure the network transport click on the Configure button. It is also possible to add
new operations in this box. To do this select one of the available operations from the Add
Operation list. This will lead you to the operation configuration screen. After saving the
new operation it will be listed in the table above.

OTRS as requester is very similar to the previous one, but instead of operations you can
add invokers here.

Click the Save button to save and continue configuring the web service, Save and finish
to save and return to the web service overview screen, or Cancel to discard current
configuration level changes and return to web service overview screen.

図4.129 Web services change

注記

Like the other Generic Interface configuration screens such as Network Transport,
Operation, Invoker and Mapping, the initial configuration (add) screen will only
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present two options: Save and Cancel. If the configuration is re-visited, a new
option Save and Finish will appear. The behavior of this feature is defined below.

Save will store the current configuration level in the database and it will return to
the previous screen to review your changes or to configure deeper settings.

Save and Finish will store the current configuration level in the database and it
will return to the previous screen in the configuration hierarchy (to the immediate
upper configuration level).

Cancel will discard any configuration change to the current configuration level and
will return to the previous screen in the configuration hierarchy.

11.4.4.7.1. ウェブサービス供給者のネットワーク・トランスポート

In future the list of available network transports will be increased. Currently only
HTTP::SOAP and HTTP::REST transports are available. Each transport has different
configuration options to setup and they might use different frontend modules to configure
them.

It is quite simple to configure the HTTP::SOAP protocol as provider. There are only two
settings: Namespace and Maximum message length. These fields are required. The first
one is a URI to give SOAP methods a context, reducing ambiguities, and the second one
is a field where you can specify the maximum size (in bytes) for SOAP messages that
OTRS will process.

図4.130 Web service provider network transport (HTTP::SOAP)

Optionally, you may want to define additional response headers. These may be used to
add static header values to every response. Just click on Add response header and fill
both key and value fields. There is no limit in number of additional header lines.

For HTTP::REST the configuration might be a bit more complicated, as it grows
dynamically for each configured operation by adding: Route mapping for Operation
'<OperationName>': and Valid request methods for Operation '<OperationName>':
settings to the default transport settings Maximum message length: and Send Keep-Alive:

• Route mapping for Operation '<OperationName>':

In this setting a resource path is set. This path must be defined according to the needs of
the web service considering that the path in conjunction with the HTTP request method
determines the Generic Interface operation to be executed.

Path can contain variables in the form of ':<VariableName>' each path string that fits
on the position of the variable name will be added to the request payload using the
variable name defined in this setting.

サンプル:

Route mapping: /Resource

• Valid requests:

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource
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http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource?
Param1=One

• Invalid requests:

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/
OtherResource

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/
OtherResource?Param1=One

Route mapping: /Resource/:ID

• Valid requests:

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/1

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/1?
Param1=One

In both cases ID = 1 will be sent to the operation as part of the payload. In the second
case also Param1 = One will be added, depending on the HTTP request method other
parameters will be added if they come as a JSON string in the request header.

• Invalid requests:

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource?
Param1=One

Route mapping: /Resource/OtherResource/:ID/:Color

• Valid requests:

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/
OtherResource/1/Red

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/
OtherReosurce/123/Blue?Param1=One

In the first example ID = 1 and Color = Red, while in the second ID = 123 and Color
= Blue.

• Invalid requests:

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/1

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/
OtherResource/1

http://localhost/otrs/nph-genericinterface.pl/Webservice/Test/Resource/
OtherResource/1?Param1=One

In the first example the part of the path '/OtherResource' is missing as well as
the :Color variable, on the second example just :Color variable is missing.

• Valid request methods for Operation '<OperationName>':
163



The HTTP request methods to determine the operation to use together with the route
mapping, possible options: CONNECT, DELETE, GET, HEAD, OPTIONS, PATCH, POST, PUT
and TRACE.

Totally different operations can share exactly the same mapping path, but the request
method must be unique for each operation, in order to determine correctly the operation
to use on each request.

図4.131 Web service provider network transport (HTTP::REST)

11.4.4.7.2. ウェブサービス・オペレーション

The actions that can be performed when you are using OTRS as a provider are
called Operations. Each operation belongs to a controller. Controllers are collections of
operations or invokers, normally operations from the same controller need similar settings
and share the same configuration dialog. But each operation can have independent
configuration dialogs if needed.

Name, Description, Backend and Mappings are fields that normally appear on every
operation, other special fields can appear in non default configuration dialogs to fulfill
specific needs of the operation.

通常は、各オペレーションに2つのマッピングする構成セクションがあります。一つは入信デー
タ、もう一つは発信データです。各マッピング指示のために異なるマッピングするタイプ(バックエ
ンド)を選ぶことができます。なぜなら、それらの構成が互いから独立して、さらにオペレーショ
ン・バックエンドから独立しているからです。正常で、最も一般的な実行は、両方のケースに（逆
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の構成を持つ）同じマッピングタイプを使うオペレーションです。完全なマッピング構成は、マッ
ピングタイプに依存して個別の画面の中で行われます。

オペレーション・バックエンドは事前に投入されており編集可能ではありません。ウェブサービス
編集画面に対するオペレーションを選択する時、このパラメタを見るでしょう。フィールドは参考
に過ぎません。

In the left part of the screen on the action column you have the options: Go back to web
service (discarding all changes since the last save) and Delete. If you click on the last
one, a dialog will open and ask you if you like to remove the operation. Click on Delete
button to confirm the removal of the operation and its configuration or Cancel to close
the delete dialog.

図4.132 Web service operation

11.4.4.7.3. ウェブサービス依頼者ネットワーク・トランスポート

The network transport configuration for the requester is similar to the configuration for the
provider. For the Requester HTTP::SOAP network transport there are more fields to be set.

Apart from the Endpoint (URI of the Remote System web service interface to accept
requests) and Namespace which are required fields, you can also specify:

• SOAPメッセージのための符号化(utf-8, latin1, iso-8859-1, cp1250など)

• SOAPAction Header: you can use this to send an empty or filled SOAPAction header. Set
to No and the SOAPAction header on the SOAP message will be an empty string, or set
to Yes to send the SOAP action in Namespace#Action format and define the separator
(typically "/" for .Net web services and "#" for the REST).

• 認証: 認証機構をセットするためには、いかなる認証も使わないか、またはリストからひとつを
選択するために、「-」をセットします。そうすればフィールド詳細が現れるでしょう。

注記

Currently only the BasicAuth (HTTP) authentication mechanism is implemented.
You can decide whether or not to use it depending on the Remote System
configuration. If used, you must provide the User Name and the Password to access
the remote system.

警告

認証用パスワードを供給しそのあとでYAMLファイルをウェブサービスへエクスポートする
ならば、このパスワードは暴露され、TYAMLファイルの内部のプレインテキスト文字列に
書き込まれるでしょう。必要に応じて予防措置を講じてください。

165



図4.133 Web service requester network transport (HTTP::SOAP)

In the case of HTTP::REST, this configuration also grows dynamically depending on the
configured invokers by adding Controller mapping for Invoker '<InvokerName>': and Valid
request command for Invoker '<InvokerName>': for each invoke. Authentication and SSL
options are similar to the ones in HTTP::SOAP

• ホスト

The host name or IP Address and port of the remote system, if no port is specified, port
80 is used by default.

• Controller mapping for Invoker '<InvokerName>':

In this setting a resource path is set. This path must be defined according to the needs
of the remote web service and following its definition.

Path can contain variables in the form of ':<VariableName>' for each variable name
that matches the current data (to be sent), will be replaced by the corresponding data
value. This matched variable names and values will be removed from the current data.
Depending on the HTTP request command the remaining data could be sent as a JSON
string in the request body or as query parameters within the URI.

サンプル:

For data: Var1 = One, Var2 = Two, Var3 = Three and Var4 = Four.

Controller mapping: /Resource

• After Replacements:

/Resource

• Remaining Data:

Var1 = One, Var2 = Two, Var3 = Three and Var4 = Four
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Controller mapping: /Resource/:Var1

• After Replacements:

/Resource/One

• Remaining Data:

Var2 = Two, Var3 = Three and Var4 = Four

Controller mapping: /Resource/:Var1?Param1=:Var2&Var3=:Var3

• After Replacements:

/Resource/One?Param1=Two&Var3=Three

• Remaining Data:

Var4 = Four

• Valid request command for Invoker '<InvokerName>':

This determine the HTTP request method to use, possible options: CONNECT, DELETE,
GET, HEAD, OPTIONS, PATCH, POST, PUT and TRACE. If no command is selected, Default
command is used.

• デフォルトコマンド

Used as a fall-back for all Invokers without a defined request command.

図4.134 Web service requester network transport (HTTP::REST)

11.4.4.7.4. ウェブサービス依頼アクション(Invokers)

The actions that can be performed when you are using OTRS as a requester are called
Invokers. Each invoker belongs to a controller (controllers are collections of operations
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or invokers). Usually invokers from the same controller need similar settings and share
the same configuration dialogs. Each invoker can have independent configuration dialogs
if needed.

Name, Description, Backend and Mappings are fields that normally appear on every
invoker. Additionally the list of event triggers and other special fields can appear on non
default configuration dialogs to fulfill special needs of the invoker.

通常は、各依頼アクション(Invokers)につき2つのマッピング構成セクションがあります。ひとつ
は入信データでもう一方は発信データです。それらの構成が相互に独立して、さらに依頼アクショ
ン(Invokers)バックエンドから独立しているので、各マッピング指示のために異なるマッピングす
るタイプ(バックエンド)を選ぶことができます。正常で、最も一般的な実行は、依頼アクション
(Invokers)が逆の構成で、両方の場合の中で同じマッピングタイプを使用するということです。完
全なマッピング構成は個別の画面の中で行われます。それはマッピングタイプに依存します。

依頼アクション(Invokers)バックエンドは事前に投入されており編集可能ではありません。ウェブ
サービス編集画面に対する依頼アクション(Invokers)を選択する時、このパラメタを見るでしょ
う。フィールドは参考に過ぎません。

Event triggers are events within OTRS such as TicketCreate, ArticleSend, etc. These
can act as triggers to execute the invoker. Each invoker needs to have at least one
event trigger registered, or the invoker will be useless, because it will never be called.
Additionally a set of rules (conditions) for each event can be defined to have more control
over the triggering of the events. These rules depend on the data of the object associated
with the event. The asynchronous property of the event triggers define if the OTRS process
will handle the invoker or if it will be delegated to the OTRS Daemon.

注記

The OTRS Daemon is a separate set of process that executes tasks in the
background. Using this the OTRS process itself will not be affected if the Remote
System takes a long time to respond, if it is not available or if there are network
problems. If you don't use the OTRS Daemons using web services can make OTRS
slow or non-responsive. Therefore it is highly recommend to use asynchronous
event triggers as often as possible.

To add an Event trigger, first select the event family from the first list, then the event
name from the second list, then set the asynchronous property (if unchecked means that
the event trigger will not be asynchronous) and finally click on the plus button. A new
event trigger will be created and it will be listed on the invoker Event Triggers list.

From the Event Triggers list each events shows if it contains conditions or not. The edit
button next to the condition property allows to add or edit the current conditions of the
event.

To delete an Event trigger, simply locate the event trigger to be deleted in the Event
Triggers list and click on the trash icon at the end of the row. This will open a dialog that
asks you if you are sure to delete the event trigger. Click Delete to remove the event
trigger from the list, or Cancel to close the dialog.

In the left part of the screen on the action column you have the options: Go back to web
service (discarding all changes since the last save) and "Delete". If you click on the last
one, a dialog will emerge and ask you if you like to remove the invoker. Click on the Delete
button to confirm the removal of the invoker and its configuration or Cancel to close the
delete dialog.
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図4.135 Web service invoker

11.4.4.7.5. Web Service Invoker Event

Sometimes defining an event to trigger an invoker could result in many unnecessary or
wrong request to a remote server. Event conditions could be set to restrict the triggering
of the invoker in such cases.

To access the event settings screen where the conditions can be defined is necessary to
be in the invoker screen and from there click on the edit icon next to the condition status
on the event where this condition should take effect.

Within the event settings screen in the action bar there is a button to go back to the
invoker screen as well as a button to remove all the event conditions. By default the screen
is pre-populated with the first condition. Update the Type of linkings between conditions
if more than one condition is planned, then change the Type of linking from Condition 1 if
more than one field is planned. Both linking fields accept and, or or xor as values.

Fill the Field name, set the matching type (String for exact match,
Regexp for regular expression or Validation Module) and set Value
to match (in case of Validation Module the full class name like:
Kernel::GenericInterface::Event::Validation::ValidateDemo).

To add more fields to the condition, click on the + button in the fields header. To remove
a field, click on the - button in the field row. It is necessary to keep at least one field per
condition.

To add more conditions click on the button below the last condition box. To remove a
condition, click on the - button in the condition header. It is necessary to keep at least
one condition in the set. To remove all conditions use the button in the sidebar.
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図4.136 Web service invoker event

11.4.4.7.6. ウェブサービスマッピング

There are cases where you need to transform the data from one format to another (map
or change data structure), because normally a web service is used to interact with a
Remote System, that is highly probable that is not another OTRS system and / or could not
understand the OTRS data structures and values. In these cases some or all values have
to be changed, and sometimes even the names of the values (keys) or even the complete
structure, in order to match with the expected data on the other end. To accomplish this
task the Generic Interface Mapping Layer exists.

Each Remote System has it own data structures and it is possible to create new
mapping modules for each case (e.g. there is a customized mapping module for SAP
Solution Manager shipped with OTRS), but it is not always necessary. The module
Mapping::Simple should cover most of the mapping needs.

注記
When Mapping::Simple does not cover all mapping needs for a web service, a
new mapping module should be created. To learn more about how to create new
mapping modules please consult the OTRS Development Manual.

このモジュールは、デフォルト値をマッピングさせる機会を与えます。各キーあるいは全体のコ
ミュニケーション・データに見合う値のために。

画面の初めに、あなたがデフォルトルールをセットできる一般的なセクションを見ます。そのルー
ルは全てのマップされていないキーや値に適用します。利用可能な3つのオプションがあり、これ
らのオプションは下のようにリストされます:

• 保持（変更しないままにして）：キーや値をとにかく触りません。

• 無視（キー/値ペアを捨てます):これがキーに適用されれば、それはキーと値を削除します。なぜ
ならキーが削除されると続いてその関連値も削除されるからです。これが値に適用されれば、値
だけが削除され、キーは保持されます。この時それは空の値に関連付けられます。

• MapTo（デフォルトとして供給されたキーまたは値の使用）：定義されたマップルールのない全
てのキーとまたは値は、デフォルトとしてこれを使います。このオプションを選択するとき、新
規のテキストフィールドがこのデフォルトをセットするために現れます。
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Clicking on the + button for new key map, will display a new box for a single mapping
configuration. You can add as many key mappings as needed. Just click on the + button
again and a new mapping box will appear below the existing one. From this mapping
boxes you can define a map for a single key, with the next options:

• 正確な値(s):古いキーが正確に一致すれば、古い重要な文字列は新規ものに変更されます。

• Regular expression: the key string will be replaced following a regular expression rule.

Pressing the new value map + button will display a new row for a value map. Here it
is also possible to define rules for each value to be mapped with the same options as
for the key map (Exact value and Regular expression). You can add as many values to
map as needed, and if you want to delete one of them, just click on the - button for each
mapping value row.

Deleting the complete key mapping section (box) is possible, just push on the - button
located on the up right corner of each box that you want to delete.

If you need to delete a complete mapping configuration: go back to the corresponding
operation or invoker screen, look for the mapping direction that you select before and set
its value to -, and save the configuration to apply changes.

図4.137 Web service mapping

11.5. ウェブサービス・コマンドライン・インターフェ
イス

The bin/otrs.Console.pl Admin::WebService::* commands were developed in order
to create basic, but fast and powerful tools to work with web service configurations. They
give you the ability to perform the following actions:

• 追加：構成ソースとしてYAMLファイルを使うウェブサービスを作成します。

• 更新：既存のウェブサービスを変更します。異なるまたは変更されたYAMLファイルを使って構
成は変更可能です。

• Dump: to save the current web service configuration to a file.

• リスト:システムに登録されたですべてのウェブサービスの完全なリストを入手します。

• 削除:システムからウェブサービスを削除すること。このアクションは取消不能なので利用の際は
ご注意ください。

サンプル : 新規ウェブサービス構成の作成:
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shell> bin/otrs.Console.pl Admin::WebService::Add --name <webservice_name> --source-path /
path/to/yaml/file
        

11.6. ウェブサービス構成
その設計から、ウェブサービスは
　単一のOTRSシステムから別のシステム（例えば、テストか開発環境からプロダクション・シス
テムまで）まで
　ポータブルになるように着想されました。したがって、それはデータベースからウェブサービス
構成を抽出し、かつそれを別のものにインポートする、容易な方法を持つために必要でした。この
タスクを遂行するために、一般インターフェースはウェブサービス構成基礎としてYAMLファイル
を使用します。

なぜYAMLなのでしょう?
　YAMLは人間が読み書きするのに優しいことを目指したマークアップ言語です(JSONより理解す
るほうが簡単です)。YAMLは数的タグのようなXMLが持ついくつかの制限を持ちません。それは
オープンで標準化されており、全ウェブサービス構成を格納するほどに十分に完全です。

注記

YAMLについてより知りたければ http://www.yaml.org/ をご覧ください。

下記はYAMLフォーマットによるウェブサービス設定ファイル例です:

---
Debugger:
  DebugThreshold: debug
Description: This an example of a web service configuration
Provider:
  Operation:
    CloseIncident:
      Description: This is a test operation
      MappingInbound: {}
      MappingOutbound: {}
      RemoteSystemGuid: ''
      Type: Test::Test
    Test:
      Description: This is a test operation
      MappingInbound:
        Config:
          KeyMapDefault:
            MapTo: ''
            MapType: Keep
          KeyMapExact:
            Prio: Priority
          ValueMap:
            Priority:
              ValueMapExact:
                Critical: 5 Very High
                Information: 1 Very Low
                Warning: 3 Normal
          ValueMapDefault:
            MapTo: 3 Normal
            MapType: MapTo
        Type: Simple
      MappingOutbound:
        Config:
          KeyMapDefault:
            MapTo: ''
            MapType: Ignore
          KeyMapExact:
            Priority: Prio
          ValueMap:
            Prio:
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              ValueMapExact:
                1 Very Low: Information
                3 Normal: Warning
                5 Very High: Critical
          ValueMapDefault:
            MapTo: ''
            MapType: Ignore
        Type: Simple
      Type: Test::Test
  Transport:
    Config:
      MaxLength: 10000000
      NameSpace: http://www.example.com/actions
    Type: HTTP::SOAP
RemoteSystem: remote.system.description.example.com
Requester:
  Invoker:
    Test:
      Description: This is a test invoker
      Events:
        - Asynchronous: 1
        Condition:
          Condition:
            '1':
              Fields:
                Queue:
                  Match: Raw
                  Type: String
              Type: and
          ConditionLinking: and
          Event: TicketCreate
        - Asynchronous: 0
          Event: ArticleUpdate
      MappingInbound:
        Type: Simple
      MappingOutbound:
        Type: Simple
      Type: Test::Test
  Transport:
    Config:
      Authentication:
        Password: '*******'
        Type: BasicAuth
        User: otrs
      Encoding: utf-8
      Endpoint: http://www.example.com:8080/endpoint
      NameSpace: http://www.example.com/actions
      SOAPAction: Yes
      SOAPActionSeparator: '#'
    Type: HTTP::SOAP
            
        

11.6.1. 構成詳細
11.6.1.1. 一般

• Description: a short text that describes the web service.

• RemoteSystem: a short description of the Remote System.

• Debugger: a container for the debugger settings.

• Provider: a container for the provider settings.

• Requester: a container for the requester settings.

11.6.1.2. Debugger
• DebugThreshold: the debugger level.
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可能な値

• debug: all logs are stored in the database.

• info: info, notice and error level logs are stored in the database.

• notice: notice and error level logs are stored in the database.

• error: only error level logs are stored in the database.

11.6.1.3. Provider
• Operation: a container for each operation settings.

• Transport: a container for provider network transport settings.

11.6.1.3.1. Operation

• <OperationName>: Unique name for the operation, container for its own operation
settings (cardinality 0..n, but not duplicate).

11.6.1.3.1.1. <OperationName>

This section is based on operations from type Test::Test other operations might contain
more or different settings.

• Description: a short text that describes the operation.

• MappingInbound: a container for the mapping settings for the incoming request data.

• MappingOutbound: a container for the mapping settings for the outgoing response data.

• Type: the operation backend, in Controller::Operation format.

11.6.1.3.1.1.1. MappingInbound

This section is based on mappings from type Simple. Other mappings might contain more
or different settings.

• Config: a container for this mapping settings.

• Type: the mapping backend.

11.6.1.3.1.1.1.1. Config

• KeyMapDefault: a container for all non mapped keys settings.

• ValueMapDefault: a container for all non mapped values settings.

• KeyMapExact: a container for all exact key mappings (cardinality 0 .. 1).

• KeyMapRegEx: a container for all regular expression key mappings (cardinality 0 .. 1).

• ValueMap: a container for all value mappings (cardinality 0 .. 1).

11.6.1.3.1.1.1.1.1. KeyMapDefault

• MapTo: the new value to be used (only applicable if MapType is set to MapTo).

• MapType: the rule for the mapping.

可能な値

• Keep: leave unchanged.

174



• Ignore: drop.

• MapTo: change to the MapTo value.

11.6.1.3.1.1.1.1.2. ValueMapDefault

Similar to KeyMapDefault.

11.6.1.3.1.1.1.1.3. KeyMapExact

• <oldkey>: <newkey> (cardinality 0 .. n but not duplicate).

11.6.1.3.1.1.1.1.4. KeyMapRegEx

• <oldkey(RegEx)>: <newkey> ( cardinality 0 .. n but no duplicates).

11.6.1.3.1.1.1.1.5. ValueMap

• <newkey>: a container for value mappings for this new key (cardinality depends on the
new keys from KeyMapExact and KeyMapRegEx).

11.6.1.3.1.1.1.1.5.1. <newkey>

• ValueMapExact: a container for all exact value mappings (cardinality 0 .. 1).

• ValueMapRegEx: a container for all regular expression value mappings (cardinality 0 ..
1).

11.6.1.3.1.1.1.1.5.1.1. ValueMapExact

• <oldvalue>: <newvalue> ( cardinality 0 .. n but not duplicate).

11.6.1.3.1.1.1.1.5.1.2. ValueMapRegEx

• <oldvalue(RegEx)>: <newvalue> ( cardinality 0 .. n but not duplicate).

11.6.1.3.1.1.2. MappingOutbound

Same as MappingInbound.

11.6.1.3.1.1.3. Transport

このセクションは、供給者ネットワーク・トランスポートHTTP::SOAPに基づきます。他のトラン
スポートはより多く異なるセッティングを含んでいるかもしれません。

• Config: a container for the specific network transport configuration settings.

• Type: the provider network transport backend.

11.6.1.3.1.1.3.1. Config

• MaxLength: the maximum length in bytes to be read in a SOAP message by OTRS.

• NameSpace: an URI that gives a context to all operations that belongs to this web service.

11.6.1.4. Requester
• Invoker: a container for each invokers' settings.

• Transport: a container for requester network transport settings.

11.6.1.4.1. Invoker

• <InvokerName>: Unique name for the invoker, container for its own invoker settings
(cardinality 0..n, but not duplicate).
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11.6.1.4.1.1. <InvokerName>

This section is based on invokers from type Test::Test other invokers might contain
more or different settings.

• Description: a short text that describes the invoker.

• Events: a container for a unnamed list of event trigger settings.

• MappingInbound: a container for the mapping settings for the incoming response data.

• MappingOutbound: a container for the mapping settings for the outgoing request data.

• Type: the invoker backend, in Controller::Invoker format.

11.6.1.4.1.1.1. Events

• List Element: (cardinality 0 .. n).

• Asynchronous: to set if the invoker execution will be delegated to the OTRS Daemon.

可能な値

• 0: not handled by the OTRS Daemon.

• 1: handled by the OTRS Daemon.

• Condition: Container for event conditions to trigger the invoker, if there are no
conditions, event will always trigger the invoker.

• Event: the name of the event trigger.

Possible values (for ticket events)
• TicketCreate

• TicketDelete

• TicketTitleUpdate

• TicketUnlockTimeoutUpdate

• TicketQueueUpdate

• TicketTypeUpdate

• TicketServiceUpdate

• TicketSLAUpdate

• TicketCustomerUpdate

• TicketPendingTimeUpdate

• TicketLockUpdate

• TicketArchiveFlagUpdate

• TicketStateUpdate

• TicketOwnerUpdate

• TicketResponsibleUpdate
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• TicketPriorityUpdate

• HistoryAdd

• HistoryDelete

• TicketAccountTime

• TicketMerge

• TicketSubscribe

• TicketUnsubscribe

• TicketFlagSet

• TicketFlagDelete

• TicketSlaveLinkAdd

• TicketSlaveLinkDelete

• TicketMasterLinkDelete

Possible values (for article events)

• ArticleCreate

• ArticleUpdate

• ArticleSend

• ArticleBounce

• ArticleAgentNotification

• ArticleCustomerNotification

• ArticleAutoResponse

• ArticleFlagSet

• ArticleFlagDelete

11.6.1.4.1.1.1.1. Condition

• Condition: Container to actual event conditions.

• ConditionLinking: Defines how multiple condition interacts with each other.

Possible values (for condition linking)

• and

• or

• xor

11.6.1.4.1.1.1.1.1. Condition -> Condition

• <ConditionName>: Container for the condition elements.
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11.6.1.4.1.1.1.1.1.1. <ConditionName>

Unique name for the condition within the invoker and event the GUI assigns consecutive
integer condition names starting from 1.

• Fields: Container for field conditions.

• Type: Define how multiple fields interact within its condition.

Possible values (for condition linking)

• and

• or

• xor

11.6.1.4.1.1.1.1.1.1.1. Fields

• <FieldName>: Container field attributes.

11.6.1.4.1.1.1.1.1.1.1.1. <FieldName>

The name of a field from the event object (e.g. for Ticket Events, the fields could be Queue,
Priority, Type, etc).

• Match: The value to match from the selected against the event object using the Type
modifier.

• Type: Modifier to the Match value.

Possible values (for type modifier)

• String: Direct compare between object field value and Match value.

• Regexp: Compare object field value with the regular expression defined in the Match
value.

• Module: Use the module defined in the Match with the object data.

11.6.1.4.1.1.2. MappingInbound

Same as OperationMappingInbound.

11.6.1.4.1.1.3. MappingOutbound

Same as OperationMappingInbound.

11.6.1.4.1.1.4. Transport

このセクションは、依頼者ネットワーク・トランスポートHTTP::SOAPに基づきます。他のトラン
スポートはより多く異なる設定を含むかもしれません。

• Config: a container for the specific network transport configuration settings.

• Type: the requester network transport backend.

11.6.1.4.1.1.4.1. Config

• Authentication: a container for authentication settings.
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• Encoding: the SOAP Message request encoding.

• Endpoint: the URI of the Remote Server web service to accept OTRS requests.

• NameSpace: an URI that gives a context to all invokers that belongs to this web service.

• SOAPAction: to send an empty or filled SOAPAction header in the SOAP message (in
<NameSpace> <Separator> <Action> format).

可能な値

• Yes: to send a filled SOAPAction header.

• No: to send an empty SOAPAction header.

• SOAPActionSeparator: to set the <Separator> of a filled SOAPAction header.

可能な値

• '/': used for .net web services.

• '#': used for all the rest web services.

11.6.1.4.1.1.4.1.1. Authentication

• User: the privileged user name that has access to the remote web service.

• Password: the password for privileged user in plain text.

• Type: the type of authentication.

11.7. コネクタ
コネクタは、OTRSがウェブサービス供給者あるいは依頼アクションとして働く場合、あるい
は、OTRSがウェブサービス依頼者として働く場合、オペレーションとも呼ばれるアクションのセッ
トの核心になります。しかし、さらに、それは特別のマッピングあるいはトランスポートも含むこ
とができます。

1つのコネクタは、オペレーションのみ、依頼アクション(Invokers)のみ、あるいはその両方だ
け、であり得ます。コネクタはマッピングやトランスポートのように他のコネクタのパーツを利用
することさえ可能です。そのようなことは何もコネクタにとっては特殊なことではなくむしろそれ
らを実装しようとしている。

言いかえれば、コネクタは単なるコントローラー層に制限されていない。しかし、もし必要ならば
それはデータマッピングまたはネットワークのトランスポート層まで拡張することができます。

一般インターフェースのモジュール設計により、コネクタはプラグ・インと見なすことができま
す。;これは、コネクタを加えることによって、次のものを使用して、一般インターフェースの能力
を拡張することができることを意味します: 使用法：OTRS機能追加、OTRSカスタム・モジュール、
サードパーティ・モジュール等。

11.7.1. バンドル・コネクタ
Included with this version of OTRS the following connectors are ready to be used:

• FAQ（よくある質問）

• セッション

• チケット
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11.7.1.1. FAQ Connector

This connector get and search public FAQ items, as well as list FAQ languages and
categories.

提供：

• オペレーション:

• LanguageList

• PublicCategoryList

• PublicFAQGet

• PublicFAQSearch

11.7.1.1.1. オペレーション

11.7.1.1.1.1. LanguageList

For this operation is not necessary to send any special parameter to the server, you just
need to request the web service directly indicating the "LanguageList" operation. The
operation will return a list of languages including ID and the Name for each language on
the system.

可能な属性:

                            
      <LanguageList/>
                            
                        

11.7.1.1.1.2. PublicCategoryList

For this operation is also not necessary any special parameter, just the simple call for
requesting the web service with the operation name 'PublicCategoryList' as a response
you will receive a list of categories including the ID and the Name (long format) for each
category.

可能な属性:

                            
      <PublicCategoryList/>
                            
                        

11.7.1.1.1.3. PublicFAQGet

To be able to get one or more FAQ entries, you should send the ItemID(s) as a parameter for
the FAQ entry you want to get. You will receive the entire FAQ record with all attachments
included. Note that attachment contents will be transferred as base64-encoded strings.

Setting GetAttachmentContents to 0 will prevent to fetch the content of the attachment
this will increase the performance of the operation when the attachment contents are
not really needed.

可能な属性:

                            
      <PublicFAQGet>
         <ItemID>?</ItemID>
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         <!-- optional, defaults to 1 -->
         <GetAttachmentContents>?</GetAttachmentContents>
      </PublicFAQGet>
                            
                        

11.7.1.1.1.4. PublicFAQSearch

For this operation you can specify the following optional parameters: Name, Title, What
(full text search), Keyword, LanguageIDs and CategoryIDs to narrow the search results.
You may also specify the order of the results by the following parameters: OrderBy and
OrderByDirection.

Send a request to the web service with the operation name 'PublicFAQSearch' as a
response you will receive a list of FAQ item IDs.

注記
The full FAQ item data can be retrieved for each ID by using 'PublicFAQGet'
operation separately.

可能な属性:

                            
      <PublicFAQSearch>
         <!--Optional:-->
         <Number>?</Number>
         <!--Optional:-->
         <Title>?</Title>
         <!--Optional:-->
         <What>?</What>
         <!--Optional:-->
         <Keyword>?</Keyword>
         <!--Zero or more repetitions:-->
         <LanguageIDs>?</LanguageIDs>
         <!--Zero or more repetitions:-->
         <CategoryIDs>?</CategoryIDs>
         <!--Zero or more repetitions:-->
         <SortBy>?</SortBy>
         <!--Optional:-->
         <OrderBy>?</OrderBy>
         <!--Optional:-->
         <OprderByDirection>?</OprderByDirection>
      </PublicFAQSearch>
                            
                        

11.7.1.2. セッション・コネクタ
このコネクタは他のオペレーションの中で使用することができる有効なSessionIDを作成するのに
有能である。

提供：

• オペレーション:

• セッション作成

• SessionGet

11.7.1.2.1. オペレーション

11.7.1.2.1.1. セッション作成

Creates a new valid SessionID to be used in other operations from other connectors like
TicketCreate.
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注記
他のコネクタからの他のオペレーションの中でSessionIDを使用するために、オペレー
ションはSessionIDによって認証を実装する必要がある。バンドルされたオペレーション
の残りはすべて認証方法として有効なSessionIDを受け入れることができます。

可能な属性:

                            
      <SessionCreate>
         <!--このレベルでは次の２つの必須選択項目があります。-->
         <!--Optional:-->
         <UserLogin>?</UserLogin>
         <!--Optional:-->
         <CustomerUserLogin>?</CustomerUserLogin>
         <!--Optional:-->
         <Password>?</Password>
      </SessionCreate>
                            
                        

11.7.1.2.1.2. セッション作成

Gathers data from a valid session excluding sensitive information such as user password
or challenge token.

注記
If any of its values is a complex structure then it is automatically converted to a
JSON string.

可能な属性:

                            
      <SessionGet>
         <SessionID>?</SessionID>
      </SessionGet>
                            
                        

11.7.1.3. チケット・コネクタ
This connector supplies the basic functionality to interact with tickets.

提供：

• オペレーション:

• チケット作成

• TicketCreate(チケット作成)

• TicketGet(チケット取得)

• TicketSearch(チケット検索)

• TicketHistoryGet

11.7.1.3.1. オペレーション

11.7.1.3.1.1. チケット作成

TicketCreateは、OTRSにチケットを作成するインターフェースを提供します。チケットは記事を
含んでいなければいけないし、いくつか添付を含むことができます。全ての定義された動的フィー
ルドも、TicketCreateオペレーション上でセットすることができます。
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可能な属性:

                            
      <TicketCreate>
         <!--You have a MANDATORY CHOICE of the next 3 items at this level-->
         <!--Optional:-->
         <UserLogin>?</UserLogin>
         <!--Optional:-->
         <CustomerUserLogin>?</CustomerUserLogin>
         <!--Optional:-->
         <SessionID>?</SessionID>
         <!--Optional:-->
         <Password>?</Password>
         <Ticket>
            <Title>?</Title>
            <!--You have a MANDATORY CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <QueueID>?</QueueID>
            <!--Optional:-->
            <Queue>?</Queue>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <TypeID>?</TypeID>
            <!--Optional:-->
            <Type>?</Type>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <ServiceID>?</ServiceID>
            <!--Optional:-->
            <Service>?</Service>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <SLAID>?</SLAID>
            <!--Optional:-->
            <SLA>?</SLA>
            <!--You have a MANDATORY CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <StateID>?</StateID>
            <!--Optional:-->
            <State>?</State>
            <!--You have a MANDATORY CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <PriorityID>?</PriorityID>
            <!--Optional:-->
            <Priority>?</Priority>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <OwnerID>?</OwnerID>
            <!--Optional:-->
            <Owner>?</Owner>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <ResponsibleID>?</ResponsibleID>
            <!--Optional:-->
            <Responsible>?</Responsible>
            <CustomerUser>?</CustomerUser>
            <!--Optional:-->
            <CustomerID>?</CustomerID>
            <!--Optional:-->
            <PendingTime>
               <!--You have a CHOICE of the next and the other 5 items at this level-->
               <Diff>?</Diff>
               <Year>?</Year>
               <Month>?</Month>
               <Day>?</Day>
               <Hour>?</Hour>
               <Minute>?</Minute>
            </PendingTime>
         </Ticket>
         <Article>
            <!--You have a CHOICE of the next 2 items at this level-->
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            <!--Optional:-->
            <CommunicationChannelID>?</CommunicationChannelID>
            <!--Optional: Possible values Email, Internal or Phone-->
            <CommunicationChannel>?</CommunicationChannel>
            <IsVisibleForCustomer>?</IsVisibleForCustomer>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <SenderTypeID>?</SenderTypeID>
            <!--Optional:-->
            <SenderType>?</SenderType>
            <!--Optional:-->
            <From>?</From>
            <!--Optional:-->
            <To>?</To>
            <!--Optional:-->
            <Cc>?</Cc>
            <!--Optional:-->
            <Bcc>?</Bcc>
            <Subject>?</Subject>
            <Body>?</Body>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <ContentType>?</ContentType>
            <Charset>?</Charset>
            <MimeType>?</MimeType>
            <!--Optional:-->
            <HistoryType>?</HistoryType>
            <!--Optional:-->
            <HistoryComment>?</HistoryComment>
            <!--Optional:-->
            <AutoResponseType>?</AutoResponseType>
            <!--Optional:-->
            <TimeUnit>?</TimeUnit>
            <!--Optional:-->
            <NoAgentNotify>?</NoAgentNotify>
            <!--Zero or more repetitions:-->
            <ForceNotificationToUserID>?</ForceNotificationToUserID>
            <!--Zero or more repetitions:-->
            <ExcludeNotificationToUserID>?</ExcludeNotificationToUserID>
            <!--Zero or more repetitions:-->
            <ExcludeMuteNotificationToUserID>?</ExcludeMuteNotificationToUserID>
         </Article>
         <!--Zero or more repetitions:-->
         <DynamicField>
            <Name>?</Name>
            <!--1 or more repetitions:-->
            <Value>?</Value>
         </DynamicField>
         <!--Zero or more repetitions:-->
         <Attachment>
            <Content>cid:61886944659</Content>
            <ContentType>?</ContentType>
            <Filename>?</Filename>
         </Attachment>
      </TicketCreate>
                            
                        

11.7.1.3.1.2. TicketCreate(チケット作成)

チケット更新オペレーションは、既存のチケットからの属性を修正するかあるいは新規記事を追加
する能力を追加します。その記事は、チケットと新規記事のための添付と全ての定義済動的フィー
ルドを含みます。

注記
チケット属性を修正する新規記事を作成することは必要ではありません。

可能な属性:
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      <TicketUpdate>
         <!--You have a MANDATORY CHOICE of the next 3 items at this level-->
         <!--Optional:-->
         <UserLogin>?</UserLogin>
         <!--Optional:-->
         <CustomerUserLogin>?</CustomerUserLogin>
         <!--Optional:-->
         <SessionID>?</SessionID>
         <!--Optional:-->
         <Password>?</Password>
         <!--You have a CHOICE of the next 2 items at this level-->
         <TicketID>?</TicketID>
         <TicketNumber>?</TicketNumber>
         <!--Optional:-->
         <Ticket>
            <!--Optional:-->
            <Title>?</Title>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <QueueID>?</QueueID>
            <!--Optional:-->
            <Queue>?</Queue>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <TypeID>?</TypeID>
            <!--Optional:-->
            <Type>?</Type>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <ServiceID>?</ServiceID>
            <!--Optional:-->
            <Service>?</Service>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <SLAID>?</SLAID>
            <!--Optional:-->
            <SLA>?</SLA>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <StateID>?</StateID>
            <!--Optional:-->
            <State>?</State>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <PriorityID>?</PriorityID>
            <!--Optional:-->
            <Priority>?</Priority>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <OwnerID>?</OwnerID>
            <!--Optional:-->
            <Owner>?</Owner>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <ResponsibleID>?</ResponsibleID>
            <!--Optional:-->
            <Responsible>?</Responsible>
            <!--Optional:-->
            <CustomerUser>?</CustomerUser>
            <!--Optional:-->
            <CustomerID>?</CustomerID>
            <!--Optional:-->
            <PendingTime>
               <!--You have a CHOICE of the next and the other 5 items at this level-->
               <Diff>?</Diff>
               <Year>?</Year>
               <Month>?</Month>
               <Day>?</Day>
               <Hour>?</Hour>
               <Minute>?</Minute>
            </PendingTime>
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         </Ticket>
         <!--Optional:-->
         <Article>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <CommunicationChannelID>?</CommunicationChannelID>
            <!--Optional: Possible values Email, Internal or Phone-->
            <CommunicationChannel>?</CommunicationChannel>
            <IsVisibleForCustomer>?</IsVisibleForCustomer>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <SenderTypeID>?</SenderTypeID>
            <!--Optional:-->
            <SenderType>?</SenderType>
            <!--Optional:-->
            <From>?</From>
            <!--Optional:-->
            <To>?</To>
            <!--Optional:-->
            <Cc>?</Cc>
            <!--Optional:-->
            <Bcc>?</Bcc>
            <Subject>?</Subject>
            <Body>?</Body>
            <!--You have a CHOICE of the next 2 items at this level-->
            <!--Optional:-->
            <ContentType>?</ContentType>
            <Charset>?</Charset>
            <MimeType>?</MimeType>
            <!--Optional:-->
            <HistoryType>?</HistoryType>
            <!--Optional:-->
            <HistoryComment>?</HistoryComment>
            <!--Optional:-->
            <AutoResponseType>?</AutoResponseType>
            <!--Optional:-->
            <TimeUnit>?</TimeUnit>
            <!--Optional:-->
            <NoAgentNotify>?</NoAgentNotify>
            <!--Zero or more repetitions:-->
            <ForceNotificationToUserID>?</ForceNotificationToUserID>
            <!--Zero or more repetitions:-->
            <ExcludeNotificationToUserID>?</ExcludeNotificationToUserID>
            <!--Zero or more repetitions:-->
            <ExcludeMuteNotificationToUserID>?</ExcludeMuteNotificationToUserID>
         </Article>
         <!--Zero or more repetitions:-->
         <DynamicField>
            <Name>?</Name>
            <!--1 or more repetitions:-->
            <Value>?</Value>
         </DynamicField>
         <!--Zero or more repetitions:-->
         <Attachment>
            <Content>cid:166861569966</Content>
            <ContentType>?</ContentType>
            <Filename>?</Filename>
         </Attachment>
      </TicketUpdate>
                            
                        

11.7.1.3.1.3. TicketGet(チケット取得)

このオペレーションは全てのチケットの属性を得るために使用されます。（この属性は、動的
フィールド、すべての記事、およびチケットに属する全ての添付を含みます。）

可能な属性:

                            
      <TicketGet>
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         <!--You have a MANDATORY CHOICE of the next 3 items at this level-->
         <!--Optional:-->
         <UserLogin>?</UserLogin>
         <!--Optional:-->
         <CustomerUserLogin>?</CustomerUserLogin>
         <!--Optional:-->
         <SessionID>?</SessionID>
         <!--Optional:-->
         <Password>?</Password>
         <!--1 or more repetitions:-->
         <TicketID>?</TicketID>
         <!--Optional:-->
         <DynamicFields>?</DynamicFields>
         <!--Optional:-->
         <Extended>?</Extended>
         <!--Optional:-->
         <AllArticles>?</AllArticles>
         <!--Optional:-->
         <ArticleSenderType>?</ArticleSenderType>
         <!--Optional:-->
         <ArticleOrder>?</ArticleOrder>
         <!--Optional:-->
         <ArticleLimit>?</ArticleLimit>
         <!--Optional:-->
         <Attachments>?</Attachments>
         <!--Optional:-->
         <GetAttachmentContents>?</GetAttachmentContents>
         <!--Optional:-->
         <HTMLBodyAsAttachment>?</HTMLBodyAsAttachment>
      </TicketGet>
                            
                        

11.7.1.3.1.4. TicketSearch(チケット検索)

TicketSearchオペレーションは、事前定義された基準に一致するチケットIDのリストを返しま
す。

可能な属性:

                            
      <TicketSearch>
         <!--You have a MANDATORY CHOICE of the next 3 items at this level-->
         <!--Optional:-->
         <UserLogin>?</UserLogin>
         <!--Optional:-->
         <CustomerUserLogin>?</CustomerUserLogin>
         <!--Optional:-->
         <SessionID>?</SessionID>
         <!--Optional:-->
         <Password>?</Password>
         <!--Optional:-->
         <Limit>?</Limit>
         <!--Zero or more repetitions:-->
         <TicketNumber>?</TicketNumber>
         <!--Zero or more repetitions:-->
         <Title>?</Title>
         <!--Zero or more repetitions:-->
         <Queues>?</Queues>
         <!--Zero or more repetitions:-->
         <QueueIDs>?</QueueIDs>
         <!--Optional:-->
         <UseSubQueues>?</UseSubQueues>
         <!--Zero or more repetitions:-->
         <Types>?</Types>
         <!--Zero or more repetitions:-->
         <TypeIDs>?</TypeIDs>
         <!--Zero or more repetitions:-->
         <States>?</States>
         <!--Zero or more repetitions:-->
         <StateIDs>?</StateIDs>
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         <!--Zero or more repetitions:-->
         <StateType>?</StateType>
         <!--Zero or more repetitions:-->
         <StateTypeIDs>?</StateTypeIDs>
         <!--Zero or more repetitions:-->
         <Priorities>?</Priorities>
         <!--Zero or more repetitions:-->
         <PriorityIDs>?</PriorityIDs>
         <!--Zero or more repetitions:-->
         <Services>?</Services>
         <!--Zero or more repetitions:-->
         <ServiceIDs>?</ServiceIDs>
         <!--Zero or more repetitions:-->
         <SLAs>?</SLAs>
         <!--Zero or more repetitions:-->
         <SLAIDs>?</SLAIDs>
         <!--Zero or more repetitions:-->
         <Locks>?</Locks>
         <!--Zero or more repetitions:-->
         <LockIDs>?</LockIDs>
         <!--Zero or more repetitions:-->
         <OwnerIDs>?</OwnerIDs>
         <!--Zero or more repetitions:-->
         <ResponsibleIDs>?</ResponsibleIDs>
         <!--Zero or more repetitions:-->
         <WatchUserIDs>?</WatchUserIDs>
         <!--Zero or more repetitions:-->
         <CustomerID>?</CustomerID>
         <!--Zero or more repetitions:-->
         <CustomerUserLogin>?</CustomerUserLogin>
         <!--Zero or more repetitions:-->
         <CreatedUserIDs>?</CreatedUserIDs>
         <!--Zero or more repetitions:-->
         <CreatedTypes>?</CreatedTypes>
         <!--Zero or more repetitions:-->
         <CreatedTypeIDs>?</CreatedTypeIDs>
         <!--Zero or more repetitions:-->
         <CreatedPriorities>?</CreatedPriorities>
         <!--Zero or more repetitions:-->
         <CreatedPriorityIDs>?</CreatedPriorityIDs>
         <!--Zero or more repetitions:-->
         <CreatedStates>?</CreatedStates>
         <!--Zero or more repetitions:-->
         <CreatedStateIDs>?</CreatedStateIDs>
         <!--Zero or more repetitions:-->
         <CreatedQueues>?</CreatedQueues>
         <!--Zero or more repetitions:-->
         <CreatedQueueIDs>?</CreatedQueueIDs>
         <!--Zero or more repetitions:-->
         <DynamicField>
            <Name>?<Name>
            <!--You have a MANDATORY CHOICE of the next 6 items at this level-->
            <!--Optional:-->
            <Equals>?</Equals>
            <!--Optional:-->
            <Like>?</Like>
            <!--Optional:-->
            <GreaterThan>?</GreaterThan>
            <!--Optional:-->
            <GreaterThanEquals>?</GreaterThanEquals>
            <!--Optional:-->
            <SmallerThan>?</SmallerThan>
            <!--Optional:-->
            <SmallerThanEquals>?</SmallerThanEquals>
         </DynamicField>
         <!--Optional:-->
         <Ticketflag>
            <!--Optional:-->
            <Seen>?</Seen>
         </Ticketflag>
         <!--Optional:-->
         <From>?</From>

188



         <!--Optional:-->
         <To>?</To>
         <!--Optional:-->
         <Cc>?</Cc>
         <!--Optional:-->
         <Subject>?</Subject>
         <!--Optional:-->
         <Body>?</Body>
         <!--Optional:-->
         <FullTextIndex>?</FullTextIndex>
         <!--Optional:-->
         <ContentSearch>?</ContentSearch>
         <!--Optional:-->
         <ConditionInline>?</ConditionInline>
         <!--Optional:-->
         <ArticleCreateTimeOlderMinutes>?</ArticleCreateTimeOlderMinutes>
         <!--Optional:-->
         <ArticleCreateTimeNewerMinutes>?</ArticleCreateTimeNewerMinutes>
         <!--Optional:-->
         <ArticleCreateTimeNewerDate>?</ArticleCreateTimeNewerDate>
         <!--Optional:-->
         <ArticleCreateTimeOlderDate>?</ArticleCreateTimeOlderDate>
         <!--Optional:-->
         <TicketCreateTimeOlderMinutes>?</TicketCreateTimeOlderMinutes>
         <!--Optional:-->
         <ATicketCreateTimeNewerMinutes>?</ATicketCreateTimeNewerMinutes>
         <!--Optional:-->
         <TicketCreateTimeNewerDate>?</TicketCreateTimeNewerDate>
         <!--Optional:-->
         <TicketCreateTimeOlderDate>?</TicketCreateTimeOlderDate>
         <!--Optional:-->
         <TicketLastChangeTimeOlderMinutes>?</TicketLastChangeTimeOlderMinutes>
         <!--Optional:-->
         <TicketLastChangeTimeNewerMinutes>?</TicketLastChangeTimeNewerMinutes>
         <!--Optional:-->
         <TicketLastChangeTimeNewerDate>?</TicketLastChangeTimeNewerDate>
         <!--Optional:-->
         <TicketLastChangeTimeOlderDate>?</TicketLastChangeTimeOlderDate>
         <!--Optional:-->
         <TicketChangeTimeOlderMinutes>?</TicketChangeTimeOlderMinutes>
         <!--Optional:-->
         <TicketChangeTimeNewerMinutes>?</TicketChangeTimeNewerMinutes>
         <!--Optional:-->
         <TicketChangeTimeNewerDate>?</TicketChangeTimeNewerDate>
         <!--Optional:-->
         <TicketChangeTimeOlderDate>?</TicketChangeTimeOlderDate>
         <!--Optional:-->
         <TicketCloseTimeOlderMinutes>?</TicketCloseTimeOlderMinutes>
         <!--Optional:-->
         <TicketCloseTimeNewerMinutes>?</TicketCloseTimeNewerMinutes>
         <!--Optional:-->
         <TicketCloseTimeNewerDate>?</TicketCloseTimeNewerDate>
         <!--Optional:-->
         <TicketCloseTimeOlderDate>?</TicketCloseTimeOlderDate>
         <!--Optional:-->
         <TicketPendingTimeOlderMinutes>?</TicketPendingTimeOlderMinutes>
         <!--Optional:-->
         <TicketPendingTimeNewerMinutes>?</TicketPendingTimeNewerMinutes>
         <!--Optional:-->
         <TicketPendingTimeNewerDate>?</TicketPendingTimeNewerDate>
         <!--Optional:-->
         <TicketPendingTimeOlderDate>?</TicketPendingTimeOlderDate>
         <!--Optional:-->
         <TicketEscalationTimeOlderMinutes>?</TicketEscalationTimeOlderMinutes>
         <!--Optional:-->
         <TTicketEscalationTimeNewerMinutes>?</TTicketEscalationTimeNewerMinutes>
         <!--Optional:-->
         <TicketEscalationTimeNewerDate>?</TicketEscalationTimeNewerDate>
         <!--Optional:-->
         <TicketEscalationTimeOlderDate>?</TicketEscalationTimeOlderDate>
         <!--Optional:-->
         <ArchiveFlags>?</ArchiveFlags>
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         <!--Zero or more repetitions:-->
         <OrderBy>?</OrderBy>
         <!--Zero or more repetitions:-->
         <SortBy>?</SortBy>
         <!--Zero or more repetitions:-->
         <CustomerUserID>?</CustomerUserID>
      </TicketSearch>
                            
                        

11.7.1.3.1.5. TicketHistoryGet

This operation is used to get all the history entries from a ticket or tickets.

可能な属性:

                            
      <TicketHistoryGet>
         <!--You have a MANDATORY CHOICE of the next 2 items at this level-->
         <!--Optional:-->
         <UserLogin>?</UserLogin>
         <!--Optional:-->
         <SessionID>?</SessionID>
         <!--Optional:-->
         <Password>?</Password>
         <!--1 or more repetitions:-->
         <TicketID>?</TicketID>
      </TicketHistoryGet>
                            
                        

11.7.2. サンプル:
11.7.2.1. ウェブサービス構成

The following is a basic but complete web service configuration file in YAML format
to use all the Ticket Connector operations with the SOAP network transport. In order
to use it in OTRS you need to copy the content, save it into a file and call it
GenericTicketConnectorSOAP.yml, and import it into OTRS in the Web Services screen
in the Admin panel by clicking in the "Add web service" button from the overview screen
and then clicking in the "Import web service" button in the add screen.

                    
---
Debugger:
  DebugThreshold: debug
  TestMode: 0
Description: Ticket Connector SOAP Sample
FrameworkVersion: 3.4.x git
Provider:
  Operation:
    SessionCreate:
      Description: Creates a Session
      MappingInbound: {}
      MappingOutbound: {}
      Type: Session::SessionCreate
    TicketCreate:
      Description: Creates a Ticket
      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketCreate
    TicketUpdate:
      Description: Updates a Ticket
      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketUpdate
    TicketGet:
      Description: Retrieves Ticket data
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      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketGet
    TicketSearch:
      Description: Search for Tickets
      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketSearch
    TicketHistoryGet:
      Description: Retrieves history of a Ticket
      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketHistoryGet
  Transport:
    Config:
      MaxLength: 100000000
      NameSpace: http://www.otrs.org/TicketConnector/
    Type: HTTP::SOAP
RemoteSystem: ''
Requester:
  Transport:
    Type: ''
                    
                

Similar example can be done for the REST network transport, REST web services uses
HTTP operations such as "POST", "GET", "PUT", "PATCH" etc. This operations in conjunction
with a URI path called resource defines a OTRS Generic Interface Operation or Invoker
(depending on the communication way).

The following example uses /Session resource for SessionCreate, /Ticket resource
for TicketSearch and TicketCreate and resource /Ticket/{TicketID} for TicketGet and
TicketUpdate (Where {TicketID} is the actual TicketID value of a ticket e.g. /Ticket/123).
In order to use it in OTRS you need to copy the content, save it into a file and call it
GenericTicketConnectorREST.yml, and import it into OTRS in the Web Services screen
in the Admin panel by clicking in the "Add web service" button from the overview screen
and then clicking in the "Import web service" button in the add screen.

                    
---
Debugger:
  DebugThreshold: debug
  TestMode: '0'
Description: Ticket Connector REST Sample
FrameworkVersion: 3.4.x git
Provider:
  Operation:
    SessionCreate:
      Description: Creates a Session
      MappingInbound: {}
      MappingOutbound: {}
      Type: Session::SessionCreate
    TicketCreate:
      Description: Creates a Ticket
      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketCreate
    TicketGet:
      Description: Retrieves Ticket data
      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketGet
    TicketSearch:
      Description: Search for Tickets
      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketSearch
    TicketUpdate:
      Description: Updates a Ticket
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      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketUpdate
    TicketHistoryGet:
      Description: Retrieves history of a Ticket
      MappingInbound: {}
      MappingOutbound: {}
      Type: Ticket::TicketHistoryGet
  Transport:
    Config:
      KeepAlive: ''
      MaxLength: '100000000'
      RouteOperationMapping:
        SessionCreate:
          RequestMethod:
          - POST
          Route: /Session
        TicketCreate:
          RequestMethod:
          - POST
          Route: /Ticket
        TicketGet:
          RequestMethod:
          - GET
          Route: /Ticket/:TicketID
        TicketSearch:
          RequestMethod:
          - GET
          Route: /Ticket
        TicketUpdate:
          RequestMethod:
          - PATCH
          Route: /Ticket/:TicketID
        TicketHistoryGet:
          RequestMethod:
          - GET
          Route: /TicketHistory/:TicketID
    Type: HTTP::REST
RemoteSystem: ''
Requester:
  Transport:
    Type: ''
                    
                

11.7.2.2. パールSOAP依頼者

The following code is a Perl script that can connect to OTRS via the generic interface.
In order to perform the operations provided by the Ticket Connector, it uses two Perl
CPAN modules SOAP::Lite and Data::Dumper. Please make sure that your environment is
capable to use these modules before you try to run the script.

                    
#!/usr/bin/perl -w
# --
# otrs.SOAPRequest.pl - sample to send a SOAP request to OTRS Generic Interface Ticket
 Connector
# Copyright (C) 2001-2018 OTRS AG, https://otrs.com/
# --
# This program is free software: you can redistribute it and/or modify
# it under the terms of the GNU General Public License as published by
# the Free Software Foundation, either version 3 of the License, or
# (at your option) any later version.
#
# This program is distributed in the hope that it will be useful,
# but WITHOUT ANY WARRANTY; without even the implied warranty of
# MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
# GNU General Public License for more details.
#
# You should have received a copy of the GNU General Public License
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# along with this program. If not, see https://www.gnu.org/licenses/gpl-3.0.txt.
# --

use strict;
use warnings;

# use ../ as lib location
use File::Basename;
use FindBin qw($RealBin);
use lib dirname($RealBin);

use SOAP::Lite;
use Data::Dumper;

# ---
# Variables to be defined.

# this is the URL for the web service
# the format is
# <HTTP_TYPE>:://<OTRS_FQDN>/nph-genericinterface.pl/Webservice/<WEB_SERVICE_NAME>
# or
# <HTTP_TYPE>:://<OTRS_FQDN>/nph-genericinterface.pl/WebserviceID/<WEB_SERVICE_ID>
my $URL = 'http://localhost/otrs/nph-genericinterface.pl/Webservice/GenericTicketConnector';

# this name space should match the specified name space in the SOAP transport for the web
 service.
my $NameSpace = 'http://www.otrs.org/TicketConnector/';

# this is operation to execute, it could be TicketCreate, TicketUpdate, TicketGet,
 TicketSearch
# or SessionCreate. and they must to be defined in the web service.
my $Operation = 'TicketCreate';

# this variable is used to store all the parameters to be included on a request in XML
 format. Each
# operation has a determined set of mandatory and non mandatory parameters to work
 correctly. Please
# check the OTRS Admin Manual in order to get a complete list of parameters.
my $XMLData = '
<UserLogin>some user login</UserLogin>
<Password>some password</Password>
<Ticket>
    <Title>some title</Title>
    <CustomerUser>some customer user login</CustomerUser>
    <Queue>some queue</Queue>
    <State>some state</State>
    <Priority>some priority</Priority>
</Ticket>
<Article>
    <Subject>some subject</Subject>
    <Body>some body</Body>
    <ContentType>text/plain; charset=utf8</ContentType>
</Article>
';

# ---

# create a SOAP::Lite data structure from the provided XML data structure.
my $SOAPData = SOAP::Data
    ->type( 'xml' => $XMLData );

my $SOAPObject = SOAP::Lite
    ->uri($NameSpace)
    ->proxy($URL)
    ->$Operation($SOAPData);

# check for a fault in the soap code.
if ( $SOAPObject->fault ) {
    print $SOAPObject->faultcode, " ", $SOAPObject->faultstring, "\n";
}

# otherwise print the results.
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else {

    # get the XML response part from the SOAP message.
    my $XMLResponse = $SOAPObject->context()->transport()->proxy()->http_response()-
>content();

    # deserialize response (convert it into a perl structure).
    my $Deserialized = eval {
        SOAP::Deserializer->deserialize($XMLResponse);
    };

    # remove all the headers and other not needed parts of the SOAP message.
    my $Body = $Deserialized->body();

    # just output relevant data and no the operation name key (like TicketCreateResponse).
    for my $ResponseKey ( keys %{$Body} ) {
        print Dumper( $Body->{$ResponseKey} );
    }
}
                    
                

11.7.2.3. Perl REST Requester

The following code is a Perl script that can connect to OTRS via the generic interface. In
order to perform the operations provided by the Ticket Connector, it uses three Perl CPAN
modules JSON, REST::Client and Data::Dumper. Please make sure that your environment
is capable to use these modules before you try to run the script.

                    
#!/usr/bin/perl
# --
# Copyright (C) 2001-2018 OTRS AG, https://otrs.com/
# --
# This program is free software: you can redistribute it and/or modify
# it under the terms of the GNU General Public License as published by
# the Free Software Foundation, either version 3 of the License, or
# (at your option) any later version.
#
# This program is distributed in the hope that it will be useful,
# but WITHOUT ANY WARRANTY; without even the implied warranty of
# MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
# GNU General Public License for more details.
#
# You should have received a copy of the GNU General Public License
# along with this program. If not, see https://www.gnu.org/licenses/gpl-3.0.txt.
# --

use strict;
use warnings;
use utf8;

## nofilter(TidyAll::Plugin::OTRS::Perl::Dumper)

# use ../ as lib location
use File::Basename;
use FindBin qw($RealBin);
use lib dirname($RealBin);

use JSON;
use REST::Client;

# This is the HOST for the web service the format is:
# <HTTP_TYPE>:://<OTRS_FQDN>/nph-genericinterface.pl
my $Host = 'http://localhost/otrs/nph-genericinterface.pl';

my $RestClient = REST::Client->new(
    {
        host => $Host,
    }
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);

# These are the Controllers and Providers the format is:
# /Webservice/<WEB_SERVICE_NAME>/<RESOURCE>/<REQUEST_VALUE>
# or
# /WebserviceID/<WEB_SERVICE_ID>/<RESOURCE>/<REQUEST_VALUE>
#
# See the documentation on how to setup Providers.
#
# This example will retrieve the Ticket with the TicketID = 1 (<REQUEST_VALUE>)
my $GetControllerAndRequest = '/Webservice/GenericTicketConnectorREST/Ticket/1';

# This example is the base URL for Ticket Create
my $CreateControllerAndRequest = '/Webservice/GenericTicketConnectorREST/Ticket';

# This example will update the Ticket with the TicketID = 1 (<REQUEST_VALUE>)
my $UpdateControllerAndRequest = '/Webservice/GenericTicketConnectorREST/Ticket/1';

# This is the base URL for Ticket Search
my $SearchControllerAndRequest = '/Webservice/GenericTicketConnectorREST/Ticket';

# This is the base URL for Ticket history with the TicketID = 1 (<REQUEST_VALUE>)
my $HistoryControllerAndRequest = '/Webservice/GenericTicketConnectorREST/TicketHistory/1';

# TicketGet Example
# See the documentation of OTRSGenericInterfaceREST on how to setup
#   - webservice
#   - transport
#   - operations
my $GetParams = {
    UserLogin => "some agent user login",       # to be filled with valid agent login
    Password  => "some agent user password",    # to be filled with valid agent password
};

# Build GetParams as part of the URL for REST-GET requests
my $QueryParams = $RestClient->buildQuery( %{$GetParams} );
$GetControllerAndRequest .= $QueryParams;

$RestClient->GET($GetControllerAndRequest);

my $GetResponseCode = $RestClient->responseCode();

if ( $GetResponseCode ne '200' ) {
    print "Get request failed, response code was: $GetResponseCode\n";
}
else {

    # If the request was answered correctly, we receive a JSON string here.
    my $ResponseContent = $RestClient->responseContent();

    my $Data = decode_json $ResponseContent;

    # Just to print out the returned Data structure:
    use Data::Dumper;
    print "Get response was:\n";
    print Dumper($Data);

}

# TicketSearch Example
# See the documentation of OTRSGenericInterfaceREST on how to setup
#   - webservice
#   - transport
#   - operations
my $SearchParams = {
    UserLogin => "some agent user login",       # to be filled with valid agent login
    Password  => "some agent user password",    # to be filled with valid agent password
    Queues    => ['Raw'],
};

# Build SearchParams as part of the URL for REST-GET requests
$QueryParams = $RestClient->buildQuery( %{$SearchParams} );
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$SearchControllerAndRequest .= $QueryParams;

$RestClient->GET($SearchControllerAndRequest);

# If the host isn't reachable, wrong configured or couldn't serve the requested page:
my $SearchResponseCode = $RestClient->responseCode();

if ( $SearchResponseCode ne '200' ) {
    print "Search request failed, response code was: $SearchResponseCode\n";
}
else {

    # If the request was answered correctly, we receive a JSON string here.
    my $ResponseContent = $RestClient->responseContent();

    my $Data = decode_json $ResponseContent;

    # Just to print out the returned Data structure:
    use Data::Dumper;
    print "Search Response was:\n";
    print Dumper($Data);

}

# TicketCreate Example
# See the documentation of OTRSGenericInterfaceREST on how to setup
# - webservice
# - transport
# - operations
my $CreateOrUpdateParams = {
    UserLogin => "some agent user login",       # to be filled with valid agent login
    Password  => "some agent user password",    # to be filled with valid agent password
    Ticket    => {
        Title        => 'some ticket title',
        Queue        => 'Raw',
        Lock         => 'unlock',
        Type         => 'Unclassified',
        State        => 'new',
        Priority     => '3 normal',
        Owner        => 'some agent user login',
        CustomerUser => 'customer-1',
    },
    Article => {
        Subject     => 'some subject',
        Body        => 'some body',
        ContentType => 'text/plain; charset=utf8',
    },
};

my $CreateJSONParams = encode_json $CreateOrUpdateParams;

my @CreateRequestParam = (
    $CreateControllerAndRequest,
    $CreateJSONParams
);

# We have to use REST-POST requests in order to send UserLogin and Password correctly
# though other REST methods would fit better.
$RestClient->POST(@CreateRequestParam);

# If the host isn't reachable, wrong configured or couldn't serve the requested page:
my $CreateResponseCode = $RestClient->responseCode();

if ( $CreateResponseCode ne '200' ) {
    print "Create request failed, response code was: $CreateResponseCode\n";
}
else {

    # If the request was answered correctly, we receive a JSON string here.
    my $ResponseContent = $RestClient->responseContent();

    my $Data = decode_json $ResponseContent;
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    # Just to print out the returned Data structure:
    use Data::Dumper;
    print "Create Response was:\n";
    print Dumper($Data);

}

# TicketUpdate Example
# See the documentation of OTRSGenericInterfaceREST on how to setup
#   - webservice
#   - transport
#   - operations
my $UpdateJSONParams = encode_json $CreateOrUpdateParams;

my @UpdateRequestParam = (
    $UpdateControllerAndRequest,
    $UpdateJSONParams
);

# We have to use REST-PATCH requests in order to send UserLogin and Password correctly
# though other REST methods would fit better.
$RestClient->PATCH(@UpdateRequestParam);

# If the host isn't reachable, wrong configured or couldn't serve the requested page:
my $UpdateResponseCode = $RestClient->responseCode();
if ( $UpdateResponseCode ne '200' ) {
    print "Update request failed, response code was: $UpdateResponseCode\n";
}
else {

    # If the request was answered correctly, we receive a JSON string here.
    my $ResponseContent = $RestClient->responseContent();

    my $Data = decode_json $ResponseContent;

    # Just to print out the returned Data structure:
    use Data::Dumper;
    print "Update response was:\n";
    print Dumper($Data);

}

# TicketHistoryGet Example
# See the documentation of OTRSGenericInterfaceREST on how to setup
#   - webservice
#   - transport
#   - operations
my $HistoryParams = {
    UserLogin => "some agent user login",       # to be filled with valid agent login
    Password  => "some agent user password",    # to be filled with valid agent password
    TicketID  => [1],
};

# Build SearchParams as part of the URL for REST-GET requests
$QueryParams = $RestClient->buildQuery( %{$HistoryParams} );
$HistoryControllerAndRequest .= $QueryParams;

$RestClient->GET($HistoryControllerAndRequest);

# If the host isn't reachable, wrong configured or couldn't serve the requested page:
my $HistoryResponseCode = $RestClient->responseCode();

if ( $HistoryResponseCode ne '200' ) {
    print "History request failed, response code was: $HistoryResponseCode\n";
}
else {

    # If the request was answered correctly, we receive a JSON string here.
    my $ResponseContent = $RestClient->responseContent();

    my $Data = decode_json $ResponseContent;
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    # Just to print out the returned Data structure:
    use Data::Dumper;
    print "History Response was:\n";
    print Dumper($Data);

}

                    
                

11.7.2.4. cURL Examples for REST Requests

Given the above example on a REST configuration for Generic Ticket Connector we have
that:

For Ticket Create: use POST method on /Ticket path.

For Ticket Search: use GET method on /Ticket path.

For Ticket Update: use PATCH method on /Ticket/{TicketID} path (where {TicketID} is
a template represented by :TicketID in the transport configuration)

For Ticket Get: use GET method on /Ticket/{TicketID} path (where {TicketID} is a
template represented by :TicketID in the transport configuration)

For Ticket History Get: use GET method on /TicketHistory/{TicketID} path (where
{TicketID} is a template represented by :TicketID in the transport configuration)

11.7.2.4.1. Create a New Ticket

cURL Command:

shell> curl "http://localhost/otrs/nph-genericinterface.pl/Webservice/
GenericTicketConnectorREST/Ticket?UserLogin=agent&Password=123" -H "Content-Type:
 application/json" -d "{\"Ticket\":{\"Title\":\"REST Create Test\", \"Type\": \"Unclassified
\", \"Queue\":\"Raw\",\"State\":\"open\",\"Priority\":\"3 normal\",\"CustomerUser\":
\"customer\"},\"Article\":{\"Subject\":\"Rest Create Test\",\"Body\":\"This is only a test
\",\"ContentType\":\"text/plain; charset=utf8\"}}"  -X POST

                    

Response:

{
  "ArticleID":5484,
  "TicketNumber":"1001936",
  "TicketID":"1686"
}
                    

11.7.2.4.2. Get Ticket Details

cURL Command:

curl "http://localhost/otrs/nph-genericinterface.pl/Webservice/GenericTicketConnectorREST/
Ticket/1686?UserLogin=agent&Password=123"

                    

Response:
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{
  "Ticket": [
    {
      "Age": 777,
      "PriorityID": 3,
      "ServiceID": "",
      "Type": "Unclassified",
      "Responsible": "root@localhost",
      "StateID": 4,
      "ResponsibleID": 1,
      "ChangeBy": 2,
      "EscalationTime": 0,
      "Changed": "2014-06-30 19:08:14",
      "OwnerID": 2,
      "RealTillTimeNotUsed": 0,
      "GroupID": 1,
      "Owner": "agent",
      "CustomerID": "OTRS",
      "TypeID": 1,
      "Created": "2014-06-30 19:08:12",
      "Priority": "3 normal",
      "UntilTime": 0,
      "EscalationUpdateTime": 0,
      "QueueID": 2,
      "Queue": "Raw",
      "State": "open",
      "Title": "REST Create Test",
      "CreateBy": 2,
      "TicketID": 1686,
      "StateType": "open",
      "EscalationResponseTime": 0,
      "UnlockTimeout": 0,
      "EscalationSolutionTime": 0,
      "LockID": 1,
      "TicketNumber": "1001936",
      "ArchiveFlag": "n",
      "Lock": "unlock",
      "CreateTimeUnix": 1404173292,
      "SLAID": "",
      "CustomerUserID": "customer"
    }
  ]
}
                    

11.7.2.4.3. Update Ticket

cURL Command:

curl "http://localhost/otrs/nph-genericinterface.pl/Webservice/GenericTicketConnectorREST/
Ticket/1686?UserLogin=agent&Password=123" -H "Content-Type: application/json" -d "{\"Ticket
\":{\"Queues\":\"Postmaster\"}}"  -X PATCH

                    

Response:

{
  "TicketNumber":"1001936",
  "TicketID":"1686"
}
                    

11.7.2.4.4. Search for Tickets

cURL Command:
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curl "http://localhost/otrs/nph-genericinterface.pl/Webservice/GenericTicketConnectorREST/
Ticket?UserLogin=agent&Password=123&Queue=Postmaster"

                    

Response:

{
  "TicketID": [
    "1686",
    "102",
    "100",
    "1"
  ]
}
                    

11.7.2.4.5. Get Ticket History Details

cURL Command:

curl "http://localhost/otrs/nph-genericinterface.pl/Webservice/GenericTicketConnectorREST/
TicketHistory/1686?UserLogin=agent&Password=123"

                    

Response:

{
  "TicketHistory":[
    {
      "History":[
        {
          "CreateBy":1,
          "HistoryType":"NewTicket",
          "TicketID":"1",
          "CreateTime":"2017-06-08 22:44:48",
          "TypeID":1,
          "OwnerID":1,
          "QueueID":1,
          "Name":"New Ticket [2015071510123456] created.",
          "StateID":1,
          "PriorityID":3,
          "ArticleID":"1",
          "HistoryTypeID":1
        }
      ],
      "TicketID":"1"
    }
  ]
}
                    

12. The OTRS Daemon
The OTRS Daemon is an independent set of system processes that plan and execute
tasks in background, either on a recurrent basis or triggered by events. OTRS Daemon is
fundamental for the correct system operation.

In previous versions of OTRS (from 3.1 to 4) there was another process called OTRS
Scheduler that does part of the work that the OTRS Demon do in OTRS 5. This old process
is replaced by the OTRS Daemon which was re-written from the ground to make it more
stable, scalable and robust than its predecessor.
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The OTRS Daemon is capable to handle up to 10 tasks at the same time and it can
work cooperatively with other OTRS Daemons on different frontend servers in a cluster
environment.

When idle OTRS Daemon consist in six processes:

• The main daemon (bin/otrs.Daemon.pl)

This process is in charge to start and keep running the other children daemons.

• Task worker daemon (Kernel/System/Daemon/DaemonModules/
SchedulerTaskWorker.pm)

This daemon executes all tasks that have in a list, in a first in first out basis. It can handle
simultaneous tasks by creating its own children processes and it checks the task list
several times per second. The task list can be filled by task manager daemons, event
handlers, and other parts of the system.

Its main mission is to handle all the tasks in the list as soon as possible.

• Future task manager daemon (Kernel/System/Daemon/DaemonModules/
SchedulerFutureTaskManager.pm)

This daemon checks for non recurring tasks that are set to be executed in the future
(e.g. when a Generic Interface invoker tries to reach a server and it can't, a task could
be set to schedule for execution in the next 5 minutes). At the correct time it sends it
the task worker daemon.

• Cron task manager daemon (Kernel/System/Daemon/DaemonModules/
SchedulerCronTaskManager.pm)

This daemon calculates when is the next execution time of all recurring tasks (e.g. a
cache cleanup one time per week ). This kind of tasks are specified in the SysConfig. At
the right time for each task it sends the required information to the task worker daemon
to execute them.

注記
If a task execution time definition is changed in SysConfig, it might take up to
an hour for the daemon to pick up the change automatically. Alternatively the
OTRS Daemon can be restarted to apply the change immediately.

• Generic Agent task manager daemon (Kernel/System/Daemon/DaemonModules/
SchedulerGenericAgentTaskManager.pm)

This daemon scans for Generic Agent jobs stored in the database that have a time
schedule (discarding all other Generic Agent jobs that are set to executed by events).
When is time to run a Generic Agent job it sends the task information to the task worker
daemon to handle the task.

• System Configuration sync manager daemon (Kernel/System/Daemon/
DaemonModules/SystemConfigurationSyncManager.pm)

This daemon verifies that the configuration files Kernel/Config/
Files/ZZZAAuto.pmKernel/Config/Files/ZZZACL.pm and Kernel/Config/Files/
ZZZProcessManagement.pm are up to date with the deployment information from the
database, otherwise the files are updated. and signal the main daemon to restart all
daemon modules with the updated configuration.

Additionally if any other .pm file in Kernel/Config/Files/ is modified while the
daemon is running, it will also signal the main daemon to restart all daemon modules.

201



注記

The number of active processes depends on the number of tasks that the OTRS
Daemon is executing simultaneously in a time frame.

By default the each daemon logs all error messages on a separated file located in /opt/
otrs/var/log/Daemon/*.log. These logs are kept in the system for a defined period. To
change this behavior and/or to also log the non error messages, please update SysConfig
settings in Daemon -> Core::Log.

When a task could not be executed successfully for any reason, an email is sent to
a predefined recipient reporting the issue. The content of the email includes the error
messages and trace (if available).

The OTRS Daemon is an automated process that normally does not require human
interaction. However it is possible to query its status and start or stop it if needed.

To be sure that the OTRS Daemon is running there is a Cron job that constantly checks
that the process is alive. The main daemon is prepared to work even without a database
connection, so is perfectly safe if the Cron task to start it is executed even before the
database process in the system startup, and it is also tolerant to database disconnections.

If for any reason the OTRS Daemon needs to be stop (for example during a system
maintenance), all unhandled tasks are saved, and as soon as the process is started again
it continues with all pending tasks. For recurring tasks it will only execute the last instance
of the task (if its due time was during the downtime).

12.1. OTRS Daemon Graphical Interface
The OTRS Daemon is not visible in the OTRS Graphical User Interface unless it stops
running.

When the system detects that the OTRS Daemon is not running, a notification is presented
to a defined group of users ("admin" by default).

To disable the notification (not recommended), change or add the notification groups,
please edit the Frontend::NotifyModule###800-Daemon-Check setting in the SysConfig.

図4.138 Daemon notification

Clicking the notification the system presents an overlay window explaining the steps to
bring the OTRS Daemon up and running.

図4.139 Start Daemon
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12.2. OTRS Daemon Command Line Interface
The OTRS Daemon command line tools let you control the main daemon process (Start /
Stop) or query its status. There are also tools to get more detailed information about the
other four children daemons.

12.2.1. Main Daemon Tools
To start, stop or query daemon status bin/otrs.Daemon.pl script is used.

例4.30 Example to start the OTRS Daemon

shell> cd /opt/otrs/
shell> OTRS_HOME/bin/otrs.Daemon.pl start
                    

利用可能なオプション

• start - to start the OTRS Daemon process.

• stop - to stop the OTRS Daemon process.

• status - to query the OTRS Damon process status.

• start --debug - to start the OTRS Daemon process in debug mode.

In this mode each daemon reports different messages depending on the actions that
are been executed. This mode is not recommended for production environments.

• stop --force - to stop the OTRS Daemon process in reducing the wait for children
processes to finish.

A forced stop reduces the amount of time the main daemon waits to successful stop
the other children processes from 30 seconds (normal) to 5 seconds (forced).

12.2.2. Other Daemon Tools
To list all configured child daemons that the main daemon should start and keep running
use the console command: Maint::Daemon::List.

例4.31 Example to list all configured daemons

shell> cd /opt/otrs/
shell> bin/otrs.Console.pl Maint::Daemon::List
                    

To list detailed information of all daemons use the console command:
Maint::Daemon::Summary.

例4.32 Example to a summary of all daemon tasks

shell> cd /opt/otrs/
shell> bin/otrs.Console.pl Maint::Daemon::Summary
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第5章 カスタマイズ
1. アクセス・コントロール・リスト(ACL)
1.1. 導入

From OTRS 2.0 on, Access Control Lists (ACLs) can be used to control access to tickets,
modules, queues, etc., or to influence actions on tickets (closing, moving, etc.) in certain
situations. ACLs can be used to supplement the existing permission system of roles and
groups. Using ACLs, rudimentary work-flows within the system can be mapped, based on
ticket attributes.

In a general way ACLs are used to reduce the possible options for a ticket based on a
defined set of rules.

ACLs can be directly entered into the Kernel/Config.pm file. However this is not any
more recommended as OTRS comes now with a GUI Access Control Lists in the Admin
panel that allows to save the ACLs in the Database as the first step and then deploy them
into a file when they are ready.

This chapter has some ACL examples which will walk you through the process of defining
ACL definitions, and a reference of all possible important ACL settings.

警告
The default user 'root@localhost' is not affected by the Ticket ACLs

1.2. 記述
The ACL definition can be split into two big parts, 'Matching' and 'Change'. In the matching
sections the ACLs contains attributes that has to be met in order to use the ACL. If the
attributes defined in the ACL does not match with the attributes that are sent, then the
ACL does not take any affect, but any other match ACL will. The change sections contains
the rules to reduce the possible options for a ticket.

Matching Sections

• 項目

This section contains matching options that can be changed on the fly. For example on
a ticket creation time the data of the ticket changes dynamically as the agent sets the
information. If an ACL is set to match a ticket attribute then only when the matching
attribute is selected the ACL will be active and might reduce other ticket attributes, but
as soon as another value is selected the ACL will not take any affect.

• PropertiesDatabase

This section is similar to Properties but does not take changes in ticket attributes that
are not saved into the DataBase, this means that changing an attribute without submit
will not make any effect. This section is not use for ticket creation screens (as tickets
are not yet created in the Database).

Change Sections

• Possible

Possible section resets the data to be reduce to only the elements that are set in this
section.
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• PossibleAdd

Elements in PossibleAdd section add missing elements that were reduced in other ACLs.
PossibleAdd is only used in together with other ACLs that have Possible or PossibleNot
sections.

• PossibleNot

This section is used to remove specific elements from the current data. It could be used
stand alone or together with other ACLs with a Possible or PossibleAdd sections.

In order to make the development of ACLs easier and more powerful there is a set of so
called modifiers for the attributes on each section. This modifiers are explained below:

Modifiers

• [Not]

This modifier is used to negate a value for example: '[Not]2 low' in this case talking
about ticket priorities will be the same as to have: '1 very low', '3 normal', '4 high', '5
very high'.

• [RegExp]

指定文字列に一致する正規表現を定義します。例えば '[RegExp]low' は、優先度のプロパティに
於ける '1 very low', '2 low' と等価です。

• [regexp]

[RegExp] と似ていますが、こちらは大文字・小文字を識別しません。

• [NotRegExp]

指定文字列に一致しない正規表現を定義します。例えば '[RegExp]low' は、優先度のプロパティ
に於ける '3 normal', '4 high', '5 very high' と等価です。

• [Notregexp]

[NotRegExp] と似ていますが、こちらは大文字・小文字を識別しません。

1.3. サンプル
The following examples are shown in both ways graphical and text based.

例5.1 ACLはチケット優先度5のチケットのみをキューへの移動を許可します。

This example shows you the basic structure of an ACL. First, it needs to have a name. In
this case, it is "100-Example-ACL". Note that the ACLs will be numerically sorted before
execution, so you should use the names carefully.

Secondly, you have a "Properties" section which is a filter for your tickets. All the criteria
defined here will be applied to a ticket to determine if the ACL must be applied or not. In
our example, a ticket will match if it is in the queue "Raw" and has priority "5 very high".
This is also affected by changes in the form (e.g. if the ticket is the queue "Raw" and had
a priority "3 normal" at this moment the ACL will not match, but then priority drop-down
is selected and the priority is changed now to "5 very high" then will also match).

最後に、「可能」セクションは画面への修正を定義します。この場合、利用可能キューから、「警
告」キューだけがチケット・画面の中で選択することができます。
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図5.1 ACL 100-Example-ACL

# ticket acl
$Self->{TicketAcl}->{'100-Example-ACL'} = {
    # match properties
    Properties => {
        # current ticket match properties
        Ticket => {
            Queue => ['Raw'],
            Priority => ['5 very high'],
        }
    },
    # return possible options (white list)
    Possible => {
        # possible ticket options (white list)
        Ticket => {
            Queue => ['Alert'],
        },
    },
};
                

例5.2 データベースに格納された優先度5のチケットだけのキューへ移動を許可す
るACL

この例は先のものに非常に似ています。しかしながら、この例では、「生で」かつ優先度が「５：
非常に高い」チケットのみが両者ともにデータベースに保存されて、マッチします。チケットが
データベースの中で実際に更新される前に、この種のACLはフォームの変更を考慮しません。
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図5.2 ACL 102-Example-ACL

# ticket acl
$Self->{TicketAcl}->{'102-Example-ACL'} = {
    # match properties
    PropertiesDatabase => {
        # current ticket match properties
        Ticket => {
            Queue => ['Raw'],
            Priority => ['5 very high'],
        }
    },
    # return possible options (white list)
    Possible => {
        # possible ticket options (white list)
        Ticket => {
            Queue => ['Alert'],
        },
    },
};
                

例5.3 未対応のキュー中のチケットの完了を不能にし、閉じるボタンを隠すACL

この例では、どのようにチケット・フィールド（の状態）が、（フォームを選択する１つ以上の可
能な値で）フィルターされるかを理解できるでしょう。あるチケット用に実行することができる
　アクションを制限することも可能です。この場合、チケットは完了できません。
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図5.3 ACL 102-Second-Example-ACL

$Self->{TicketAcl}->{'102-Second-Example-ACL'} = {
    # match properties
    Properties => {
        # current ticket match properties
        Ticket => {
            Queue => ['Raw'],
        }
    },
    # return possible options (white list)
    Possible => {
        # possible ticket options (white list)
        Ticket => {
            State => ['new', 'open', 'pending reminder'],
        },
    },
    # return also not possible options (black list)
    PossibleNot => {
        # not possible action options
        Action => [ 'AgentTicketClose' ],
    },
};
                

例5.4 状態：「閉鎖成功」を常に削除するACL

ここの例では、否定フィルタ（状態：「完了（成功）」を取り除く）をどのようにして定義可能か
例示します。チケット用のマッチ・プロパティを定義しなければ、どんなチケットでもマッチする
こともわかります。例えばACLが常に当てはまります。これは、もしデフォルトで特定の値を非表
示にしたくかつ、特殊な環境（例えば担当者が特定のグループにいるならば）だけにそれらを可能
にしたいなら活用可能になります。
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図5.4 ACL 103-Third-ACL-Example

$Self->{TicketAcl}->{'103-Third-ACL-Example'} = {
    # match properties
    Properties => {
        # current ticket match properties (match always)
    },
    # return possible options
    PossibleNot => {
        # possible ticket options
        Ticket => {
            State => ['closed successful'],
        },
    },
};
                

例5.5 "HW"で始まるキューが作成されるハードウェア・サービス・チケットのみ
を表示するACL
ここでは、マッチするチケットと利用可能なオプションのフィルタリングのための正規表現を使用
することができるかについても例示します。

図5.5 ACL 104-Only-Hardware-Services-for-HW-Queues-ACL
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$Self->{TicketAcl}->{'104-Only-Hardware-Services-for-HW-Queues-ACL'} = {
    # match properties
    # note we don't have "Ticket => {" because there's no ticket yet
    Properties => {
    Queue => {
        Name => ['[RegExp]HW'],
        }
    },
    # return possible options
    Possible => {
        # possible ticket options
        Ticket => {
            Service => ['[RegExp]^(Hardware)'],
        },
    },
};
                

例5.6 ACL to restrict a Process in the customer frontend using the
CustomerID.

図5.6 ACL 105-Disallow-Process-For-CustomerID

$Self->{TicketAcl}->{"105-Disallow-Process-For-CustomerID"} = {
    'Possible' => {},
    'PossibleNot' => {
        'Process' => [
            'P14'
        ]
    },
    'Properties' => {
        'CustomerUser' => {
            'UserCustomerID' => [
                'CustomerID'
            ]
        }
    },
    'PropertiesDatabase' => {},
    'StopAfterMatch' => 0
};
                

1.4. 参照
下記の例において、ACLで使用可能な全パラメーターのリストがあります。
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Please see the section on ACLs in the ProcessManagement documentation for a detailed
description of how to use ACLs for process tickets.

例5.7 全ての可能かつ重要なACL設定を示すリファレンス（参照）

# ticket acl
$Self->{TicketAcl}->{'200-ACL-Reference'} = {
    # match properties (current values from the form)
    Properties => {

        # the used frontend module
        Frontend => {
            Action => ['AgentTicketPhone', 'AgentTicketEmail'],

            # or

            # (not to be used together with 'Action')
            Endoint => ['ExternalFrontend::TicketCreate'],
        },

        # the logged in agent
        User => {
            UserLogin => ['some login'],
            Group_rw => [
                'hotline',
            ],
            Role => [
                'admin',
            ],
            # ...
        },

        # the logged in customer
        CustomerUser => {
            UserLogin => ['some login'],
            UserCustomerID => ['some customer id'],
            Group_rw => [
                'hotline',
            ],
            # ...
        },

        # process properties
        Process => {
            ProcessEntityID        => ['Process-9c378d7cc59f0fce4cee7bb9995ee3eb'],        
 # the Process that the current ticket is part of
            ActivityEntityID       => ['Activity-f8b2fdebe54eeb7b147a5f8e1da5e35c'],       
 # the current Activity of the ticket
            ActivityDialogEntityID => ['ActivityDialog-aff0ae05fe6803f38de8fff6cf33b7ce'], 
 # the current ActivityDialog that the Agent/Customer is using
        },

        # ticket properties
        Queue => {
            Name     => ['Raw'],
            QueueID  => ['some id'],
            GroupID  => ['some id'],
            Email    => ['some email'],
            RealName => ['OTRS System'],
            # ...
        },
        Service => {
            ServiceID => ['some id'],
            Name      => ['some name'],
            ParentID  => ['some id'],
            # ...
        },
        Type => {
            ID   => ['some id'],
            Name => ['some name'],
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            # ...
        },
        Priority = {
            ID   => ['some id'],
            Name => ['some name'],
            # ...
        },
        SLA = {
            SLAID    => ['some id'],
            Name     => ['some name'],
            Calendar => ['some calendar'],
            # ...
        },
        State = {
            ID       => ['some id'],
            Name     => ['some name'],
            TypeName => ['some state type name'],,
            TypeID   => ['some state type id'],
            # ...
        },
        Owner => {
            UserLogin => ['some login'],
            Group_rw => [
                'some group',
            ],
            Role => [
                'admin',
            ],
            # ...
        },
        Responsible => {
            UserLogin => ['some login'],
            Group_rw => [
                'some group',
            ],
            Role => [
                'admin',
            ],
            # ...
        },
        DynamicField => {
            # Names must be in DynamicField_<field_name> format.
            # Values in [ ... ] must always be the untranslated internal data keys
            #   specified in the dynamic field definition and
            #   not the data values shown to the user.
            DynamicField_Field1          => ['some value'],
            DynamicField_OtherField      => ['some value'],
            DynamicField_TicketFreeText2 => ['some value'],
            # ...
        },
        # alternatively, ticket properties can be specified in the ticket hash
        Ticket => {
            Queue                => ['Raw'],
            State                => ['new', 'open'],
            Priority             => ['some priority'],
            Lock                 => ['lock'],
            CustomerID           => ['some id'],
            CustomerUserID       => ['some id'],
            Owner                => ['some owner'],
            DynamicField_Field1  => ['some value'],
            DynamicField_MyField => ['some value'],
            # ...
        },
    },

    # match properties (existing values from the database)
    PropertiesDatabase => {
        # See section "Properties", the same config can be used here.
        # ...
    }

    # reset possible options (white list)
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    Possible => {
        # possible ticket options (white list)
        Ticket => {
            Queue => ['Hotline', 'Coordination'],
            State => ['some state'],
            Priority => ['5 very high'],
            DynamicField_Field1  => ['some value'],
            DynamicField_MyField => ['some value'],
            # ...
            NewOwner => ['some owner'],
            OldOwner => ['some owner'],
            # ...
        },

        # Limit the number of possible ActivityDialogs the Agent/Customer
        #   can use in a process ticket.
        ActivityDialog => ['AD1', 'AD3'],

        # Limit the number of possible Processes that can be started
        Process => ['Process-9c378d7cc59f0fce4cee7bb9995ee3eb',
 'Process-12345678901234567890123456789012'],

        # possible action options (white list)
        Action => [
            'AgentTicketBounce',
            'AgentTicketPhone'.      # only used to show/hide the Split action
            'AgentLinkObject',       # only used to show/hide the Link action
            # ...
        ],
    },
    # add options (white list)
    PossibleAdd => {
        # See section "Possible"
        # ...
    },
    # remove options (black list)
    PossibleNot => {
        # See section "Possible"
        # ...
    },
};
                

注記

ACLとマッチしている間に、CustomerUserIDパラメーターが送られると、ACLメカニズム
は、CustomerUserハッシュを満たすCustomerUser詳細を集めるために、供給された
CustomerUserIDを使用して、定義されたACLを比較します。またそれは、プロパティ
（特性）・マッチ用のチケット・ハッシュ中の顧客情報を無効に(override)します。この
計算もPropertiesDatabase部分のためになされるが、その一方で、データを集めるため
に基礎としてチケット・顧客(the Ticket Customer)を使用しています。

顧客・インターフェースでは、CustomerUserIDが現在の記録された顧客ユーザとともに常
に送信されることに注目してください。

Be aware that in ticket search screens (AgentTicketSearch and
CustomerTicketSearch) the only affected attributes by ACLs are the Dynamic
Fields. This means that this screens you can not restrict any other attribute like
ticket type, state, queue, etc.

From OTRS 4 the 'Action' parameter is not longer a hash but an array reference
and it can be used in any of the Change sections using any of the Modifiers.
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2. 工程管理
2.1. 導入

This feature of OTRS allows you to model processes (work-flows) in the ticket system.
The basic idea is to be able to define recurring processes, and to delegate work items to
different people, as well as leading the progress of a process in different directions based
on certain criteria.

2.2. サンプル・プロセス
より実地的なサンプルで見てみましょう。ここでは本の注文プロセスを定義します:

2.2.1. 要求の記録
Before an order can be placed, the demand for literature by an employee will be recorded.
The following book is needed in our example:

タイトル：Prozessmanagement für Dummies、著者：Thilo Knuppertz、ISBN：3527703713

2.2.2. マネージャーによる承認
従業員の部長は注文に関して以下を決定する必要があります。否認の場合には、理由がマネー
ジャーによって記録されるべきです。承認の場合には、オーダーが購買部に渡されます。

2.2.3. 購買部による処理
購入するとは、本を最良の条件で本を注文する場所を見つける職務です。品切れの場合、注文に記
録します。購入が成約した場合はサプライヤー、購入価格、配達日を記録します。

2.2.4. 郵便室による処理
貨物が会社に入荷すると、貨物の入荷受付部は、その貨物をチェックし受領日を記録します。従業
員はこの注文が到着を知らされ、貨物を取りに行く準備をするでしょう。

2.3. 例の実行
If we assume that a ticket acts in this workflow like an accompanying document that can
receive change notes, we already have a clear picture of process tickets.

サンプル・プロセスの分析から、次の必須アイテムを識別することができます。

• Possibilities to record data, let's call them User Task Activity Dialogs,

• Checks which can react to changed data automatically, let's call them Sequence Flows,

• Changes which can be applied to a process ticket after successful moving between the
activities of a process ticket, let's call them Sequence Flow Actions.

さらにそれほど明白でないかもしれない追加項目を必要とします:

• A possibility to offer more than just one User Task Activity Dialog to be available. In our
example this is needed when the manager must have the choice between "Approve"
and "Deny". Let's call this User Task Activity.

Now, with User Task Activities, User Task Activity Dialogs, Sequence Flows and Sequence
Flow Actions we have the necessary tools to model the individual steps of our example.
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What's still missing is an area where for each work-flow the order of the steps can be
specified. Let's call this Process. To be able to refer to all these entities later, we will
assign to them an abbreviation in parentheses. This abbreviation is based on an internal
identification mechanism called EntityIDs.

エンティティIDs(EntityIDs)は、1個あるいは2個の文字（プロセス部分あるいは実体に依存しま
す）と連続した番号で組み合わせて作られます。

• プロセス（Process）: 'P1', 'P2' ... 'Pn'.

• アクティビティ（Activity）: 'A1', 'A2' ... 'An'.

• User Task Activity Dialog: 'AD1', 'AD2' ... 'ADn'.

• Sequence Flow: 'SF1', 'SF2' ... 'SFn'.

• Sequence Flow Action: 'SFA1', 'SFA2' ... 'SFAn'.

Before the creation of the process and its parts, it is necessary to prepare the system, we
will need to define some Queues, Users and Dynamic Fields as well as set some SysConfig
options.

次のキューを作成します：

• 管理： Management

• 顧客： Employees

• 購買：Purchasing

• 郵便局： Post office

次のユーザーを作成します。

• 管理者：Manager

• 顧客：Employee

次の動的フィールドを作成します。

• タイトル

ラベル タイトル

タイプ テキスト

オブジェクト チケット

• 著者

ラベル 著者

タイプ テキスト

オブジェクト チケット

• ISBN

ラベル ISBN
タイプ テキスト

オブジェクト チケット
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• 状態

ラベル 状態

タイプ ドロップダウン

オブジェクト チケット

可能な値 • 承認

• 承認拒否

• 承認済

• 注文拒否

• 発注済

• 貨物受取済

Note: Please use exactly these possible values for "Key" and "Value" in the Dynamic
Field setup.

• サプライヤー

ラベル サプライヤー

タイプ テキスト

オブジェクト チケット

• 価格

ラベル 価格

タイプ テキスト

オブジェクト チケット

• 配達日（DeliveryDate）

ラベル 配達日

タイプ 日付

オブジェクト チケット

• 受領日（DateOfReceipt）

ラベル 受領日

タイプ 日付

オブジェクト チケット

次のSysConfigの設定をセットします：

• 'Ticket::Responsible': はい

• 'Ticket::Frontend::AgentTicketZoom###ProcessWidgetDynamicFieldGroups':

キー: コンテンツ:

本 タイトル、著者、ISBN

一般 状態

注文 価格、サプライヤー、配達日
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キー: コンテンツ:

配送 受領日（DateOfReceipt）

• 'Ticket::Frontend::AgentTicketZoom###ProcessWidgetDynamicField':

キー: コンテンツ:

著者 1
受領日（DateOfReceipt） 1
配達日（DeliveryDate） 1
ISBN 1
価格 1
状態 1
サプライヤー 1
タイトル 1

それでは、実際のプロセス管理職員で開始しましょう。次のステップで、必要とする個々の実体を
定義します。

2.3.1. プロセス(コンテナーとしての)
To create a new process it is necessary to click on the "Process Management" link in
the 'Processes & Automation' section in the Admin panel, which will lead to the Process
Management Overview screen. After the creation of the process, we can create all other
entities (or process parts).

注記
Activities, User Task Activity Dialogs, Sequence Flows and Sequence Flow Actions
defined in one process will be available for all the processes in the system.

図5.7 OTRS管理者画面 - システム管理

アクション・ボックスから「新しいプロセスを作成する」アクションをクリックしてください。

図5.8 新しいプロセス・ボタンの作成
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Fill the process information, set Process Name and the Description, but leave the process
State as "inactive", until we finish all the tasks. Save the process.

図5.9 新しいプロセスの追加

2.3.2. User Task Activity Dialogs
Click on the new process name in the Process Management Overview Screen, then in the
"Available Process Elements" click on "User Task Activity Dialogs" (this action will expand
the user task activity dialog options and will collapse all others doing an accordion like
effect). Finally, click on "Create New User Task Activity Dialog".

図5.10 Create New User Task Activity Dialog button

In the opened popup screen fill the "Dialog Name" as well as the "Description (short)"
field. For this example, we will leave all other fields as the default. To assign fields to the
User Task Activity Dialog, simply drag the required field from the "Available Fields" pool
and drop it into the "Assigned Fields" pool. The order in the "Assigned Fields" pool is the
order that the fields will have in the screen: in order to modify the order simply drag and
drop a field within the pool to rearrange it in the correct place.

218



図5.11 Add new User Task Activity Dialog

As soon as the fields are dropped into the "Assigned Fields" pool another popup screen
is shown with some details about the field. We will leave the default options and only for
Article fields we should make sure that the CommunicationChannel field is set to "Internal"
and that the IsVisibleForCustomer is not active.

図5.12 フィールド詳細(記事)の編集

全てのフィールドが指定された後で、変更を保存するためにメインのポップアップ画面にて、送信
ボタンをクリックします。

In this example we will use Article field for comments, but another option could be to
create a TextArea type Dynamic Field. The rest of the mentioned fields in the lines below
are the Dynamic Fields that we already defined before.
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Please be aware that in this screen all the Dynamic Fields have the prefix "DynamicField_"
as in "DynamicField_Title". Do not confuse this with the field "Title" that is actually the
Ticket Title.

Create the following User Task Activity Dialogs:

• 「依頼の記録」(AD1)

A user task activity dialog that contains all the required fields for the data to be collected
for the order (Title, Author and ISBN), and a Status field with the possibility to choose
"Approval".

• 「承認拒否」(AD2)

A user task activity dialog with a comment field (Article) and a Status field with the
option "Approval denied".

• 「承認済」(AD3)

ここでは「承認済」オプションを持つ状態フィールドが必要となります。

• 「注文拒否」 (AD4)

A user task activity dialog which makes it possible for purchasing to reject an impossible
order (book out of stock). Here we also need a comment field and the Status field with
the option "Order denied".

• 「発注」(AD5)

A user task activity dialog with the fields Supplier, Price and Delivery date for purchasing
and the Status field with the option "Order placed".

• 「貨物受取」(AD6)

A user task activity dialog for the mail room with a field for the Date of receipt and the
Status field with the option "Shipment received".

To restrict the Status field for each user task activity dialog, we need to add some ACLs
in the Kernel/Config.pm or to a new Perl file located in Kernel/Config/Files.

    $Self->{TicketAcl}->{'P1-AD1-1'} = {
        Properties => {
            Process => {
                ActivityDialogEntityID => ['AD1'],
            },
        },
        Possible => {
            Ticket => {
                DynamicField_Status => ['Approval'],
            },
        },
    };

    $Self->{TicketAcl}->{'P1-AD2-1'} = {
        Properties => {
            Process => {
                ActivityDialogEntityID => ['AD2'],
            },
        },
        Possible => {
            Ticket => {
                DynamicField_Status => ['Approval denied'],
            },
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        },
    };

    $Self->{TicketAcl}->{'P1-AD3-1'} = {
        Properties => {
            Process => {
                ActivityDialogEntityID => ['AD3'],
            },
        },
        Possible => {
            Ticket => {
                DynamicField_Status => ['Approved'],
            },
        },
    };

    $Self->{TicketAcl}->{'P1-AD4-1'} = {
        Properties => {
            Process => {
                ActivityDialogEntityID => ['AD4'],
            },
        },
        Possible => {
            Ticket => {
                DynamicField_Status => ['Order denied'],
            },
        },
    };

    $Self->{TicketAcl}->{'P1-AD5-1'} = {
        Properties => {
            Process => {
                ActivityDialogEntityID => ['AD5'],
            },
        },
        Possible => {
            Ticket => {
                DynamicField_Status => ['Order placed'],
            },
        },
    };

    $Self->{TicketAcl}->{'P1-AD6-1'} = {
        Properties => {
            Process => {
                ActivityDialogEntityID => ['AD6'],
            },
        },
        Possible => {
            Ticket => {
                DynamicField_Status => ['Shipment received'],
            },
        },
    };
                    

2.3.3. Sequence Flows
In the "Available Process Elements" click on "Sequence Flows", then click on "Create New
Sequence Flow".
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図5.13 Create New Sequence Flow button

In the opened popup screen fill the "Sequence Flow Name", then in the sequence flow
condition expressions, for this example, we will add just one condition expression and just
one field. For both we can leave the Type of Linking as "and" and we will use the filled
match type value as "String".

図5.14 Add new Sequence Flow

After all sequence flow condition expressions are set, click on the submit button to save
the changes.

Create the following Sequence Flows:

• "Approval" (SF1)

A sequence flow which checks if the Status field is set to "Approval".

• "Approval denied" (SF2)

A sequence flow which checks if the Status field is set to "Approval denied".

• "Approved" (SF3)

A sequence flow which checks if the Status field is set to "Approved".

• "Order denied" (SF4)

A sequence flow which checks if the Status field is set to "Order denied".

• "Order placed" (SF5)

A sequence flow which checks if the Status field is set to "Order placed".
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• "Shipment received" (SF6)

A sequence flow which checks if the Status field is set to "Shipment received".

2.3.4. Sequence Flow Actions
Click on "Sequence Flow Actions" in the "Available Process Elements", then click on
"Create New Sequence Flow Action".

図5.15 Create New Sequence Flow Action button

In the opened popup screen, fill the "Sequence Flow Action Name", and the "Sequence
Flow Action module", then add the required and optional parameter names and values.

All the Sequence Flow Action Modules are shared with the Script Task Activities and they
are located in Kernel/System/ProcessManagement/Modules. Following is the list of all
bundled Sequence Flow Action Modules included in this release:

• DynamicFieldSet (動的フィールドのセット)

• TicketArticleCreate（チケット記事の作成）

• チケット作成

• TicketCustomerSet（チケット・顧客・セット）

• TicketLockSet（チケット・ロック・セット）

• TicketOwnerSet（チケット・所有者・セット）

• TicketQueueSet（チケット・キュー・セット）

• TicketResponsibleSet（チケット・責任者・セット）

• TicketSendEmail

• TicketServiceSet（チケット・サービス・セット）

• TicketSLASet（チケット・SLA・セット）

• TicketStateSet（チケット・状態・セット）

• TicketTitleSet（チケット・タイトル・セット）

• TicketTypeSet（チケット・タイプ・セット）

Each module has its own specific parameters. Please review the module documentation
to learn all required and optional parameters.
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注記

From OTRS 4.0.1, parameters are not longer mandatory fixed values, but instead,
they can inherit from the original ticket using format: <OTRS_Ticket_property>.

From OTRS 4.0.6, the format <OTRS_TICKET_property> is now supported, older
format is still usable, but deprecated as it will be dropped in further versions.

注記

From OTRS 7.0.1, you can use new OTRS smart tags in the "Body" parameter of
TicketCreate and TicketArticleCreate modules: <OTRS_AGENT_BODY_RICHTEXT>
and <OTRS_CUSTOMER_BODY_RICHTEXT>.

For both tags you can specify a set of parameters to influence the content
of the body, please check the TicketCreate module documentation and
TicketArticleCreate module documentation.

As already mentioned, both OTRS smart tags are only supported in TicketCreate
and TicketArticleCreate modules.

図5.16 Add new Sequence Flow Action

After setting the sequence flow action name and module, click on 'Save' button, and after
a reload, 'Configure' button next to the selected module will appear. Click on it to set all
parameters.

図5.17 Configure Sequence Flow Action

After all parameters and values are set click on the 'Save and Finish' button to save the
parameters and return to the sequence flow action screen again, then click on 'Save and
Finish' (again) to save all data and return to the main process screen.

Create the following Sequence Flow Actions:

• "Move the process ticket into the 'Management' queue" (SFA1)

This action is supposed to be executed when the sequence flow "Approval" (SF1) is
applied.

• "Change ticket responsible to 'manager'" (SFA2)

To be executed when the sequence flow "Approval" (SF1) is applied.

• "Move process ticket into the 'Employees' queue" (SFA3)

以下の場合実行されるべきです：

• The sequence flow "Approval denied" (SF2) is applied
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• The sequence flow "Order denied" (SF4) is applied

• The sequence flow "Shipment received" (SF6) is applied

• "Change ticket responsible to 'Employee'" (SFA4)

以下の場合実行されるべきです：

• The sequence flow "Approval denied" (SF2) is applied

• The sequence flow "Order denied" (SF4) is applied

• The sequence flow "Shipment received" (SF6) is applied

• "Move process ticket into the 'Purchasing' queue" (SFA5)

To be executed when the sequence flow "Approved" (SF3) is applied.

• "Move process ticket into the 'Post office' queue" (SFA6)

To be executed when the sequence flow "Order placed" (SF5) is applied.

• "Close ticket successfully" (SFA7)

以下の場合実行されるべきです：

• The sequence flow "Shipment received" (SF6) is applied

• "Close ticket unsuccessfully" (SFA8)

以下の場合実行されるべきです：

• The sequence flow "Approval denied" (SF2) is applied

• The sequence "Order denied" (SF4) is applied

As you can see, there are places where the same Sequence Flow Actions should be
executed. Therefore it is reasonable to make it possible to link Sequence Flow Actions
freely with Sequence Flow to be able to reuse them.

2.3.5. アクティビティ
There are three types of activities:

• Script Task Activities

This tasks executes a script module automatically when the activity is reached, these
modules are shared with the Sequence Flow Actions.

• Service Task Activities

Triggers an invoker from a Generic Interface web service when the activity is reached.

• User Task Activities

They could be seen as a bundle which can contain one or more User Task Activity
Dialogs.

「利用可能なプロセス要素」中の「アクティビティ」をクリックして、次に、「新規アクティビ
ティの作成」をクリックしてください。
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図5.18 新規アクティビティボタンの作成

In the opened popup screen fill the "Activity Name", and be sure that "User task activity"
is set in the "Activity type" field, then drag the required User Task Activity Dialogs from
the "Available User Task Activity Dialogs" pool, and drop them into to the "Assigned User
Task Activity Dialogs" pool. This dialog will be presented (in the ticket zoom screen) in the
same order as it is defined on this screen translating from top to bottom, from left to right.

This order is especially important in the first Activity, since the first User Task Activity
Dialog for this activity is the only one that is presented when the process starts.

注記
Script and Service task activities at the very beginning of the processes will present
a default dialog to trigger the process start by executing the script or invoker.

Create the following User Task Activities:

• 「依頼（要求）の記録」（A1)

Contains the User Task Activity Dialog "Recording the demand" (AD1)

• 「承認」(A2)

Contains the User Task Activity Dialogs "Approval denied" (AD2) as well as
"Approved" (AD3)

• 「注文」（A3)

Contains the User Task Activity Dialogs "Order rejected" (AD4) as well as "Order
placed" (AD5)

• 「入荷」(A4)

Contains the User Task Activity Dialog "Shipment received" (AD6)

• "Process complete" (A5)

This is a User task Activity without possible User Task Activity Dialogs. It will be set after
"Approval denied", "Order denied" or "Shipment received" and represents the end of
the process.

Now we can clearly see that Activities are precisely defined states of a process ticket.
After a successful Sequence flow a process ticket moves from one Activity to another.

2.3.6. 本の注文プロセスのパス
フローの記述者としてのプロセス、パズルの最後の欠けた１ピースで私たちの例を終えることにし
ましょう。私たちのケースでは、これは全注文ワークフローです。他のプロセスは事務用品注文あ
るいは完全に異なるプロセスでありえます。
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The process has a starting point which consists of the start User Task Activity and the
start User Task Activity Dialog. For any new book order, the start User Task Activity Dialog
(first User Task Activity Dialog for the first User Task Activity) is the first screen that is
displayed. If this is completed and saved, the Process ticket will be created and can follow
the configured work-flow.

The process also contains the directions for how the process ticket can move through the
Process. Let's call this the "Path". It consists of the start Activity, one or more Sequence
Flows (possibly with Sequence Flow Actions), and other Activities.

Assuming that the User Task Activities have already assigned their User Task Activity
Dialogs, drag an Activity from the accordion (in the left part of the screen) and drop it into
the canvas area (below process information). Notice that an arrow from the process start
(green circle) to the Activity is placed automatically. (This is the first User Task Activity and
its first User Task Activity Dialog is the first screen that will be shown when the process
starts).

図5.19 キャンバスに第1のアクティビティをドラッグしてください。

Next, drag another Activity into the canvas too. Now we will have two Activities in the
canvas. The first one is connected to the start point and the second has no connections.
You can hover the mouse over each activity to reveal their own User Task Activity Dialogs
(in case of other type of activities, relative information is shown such as the selected
script or web service and invoker).

図5.20 第二のアクティビティをキャンバスにドラッグします。

Then let's create the "Path" (connection) between these two Activities, for this we will use
the Sequence Flows. Click on Sequence Flows in the accordion, drag a Sequence Flow
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and drop it inside the first Activity. Notice that the Activity changes its color indicating
that the Sequence Flow is attached. As soon as the Sequence Flow is dropped, the end
point of the Sequence FLow arrow will be placed next to the process start point. Drag
the Sequence Flow arrow end point and drop it inside the other Activity to create the
connection between the Activities.

図5.21 Drag a Sequence Flow into the canvas

Now that the "Path" between the Activities is defined, we need to assign the Sequence
Flow Actions to the Sequence Flows. Double click the Sequence Flow label (on the canvas),
this will open a new popup window.

図5.22 Connect Activities using Sequence Flows

Drag the needed Sequence Flow Actions from Available Sequence Flow Actions pool and
drop them into the Assigned Sequence Flow Actions pool and click on submit button.
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図5.23 Assign Sequence Flow Actions

メインプロセス編集画面に戻って（キャンバス下にある他のすべての変更を保存するための）保存
ボタンをクリックします。

Complete the "path" adding the following Activities, Sequence Flows and Sequence Flow
Actions:

「承認」まで依頼・要求を記録すること

• 出発点:アクティビティ「依頼・要求の記録」(A1)

• Possible Sequence Flow: "Approval" (SF1)

• If the sequence flow condition expression of this activity is fulfilled, the ticket will
move to Activity: "Approval" (A2)

• Additionally, the following Sequence Flow Actions are executed:

• "Move the process ticket into the 'Management' queue" (SFA1)

• "Change ticket responsible to 'manager'" (SFA2)

The Activity: "Recording the demand" (A1) is a defined step of the process ticket, where
there is the possibility for the Sequence Flow: "Approval" (SF1). If this applies, the ticket
will move to the next Activity: "Approval" (A2), and the Sequence Flow Actions: "Move
the process ticket into the 'Management' queue" (SFA1) and "Change ticket responsible
to 'manager'" (SFA2) are executed. In the Activity: "Approval" (A2), the User Task Activity
Dialogs: "Approval denied" (AD2) and "Approved" (AD3) are available.

承認

• 出発点:アクティビティ：「承認」(A2)

• Possible Sequence Flows:

• "Approval denied" (SF2)

• これが一致すれば、プロセス・チケットはアクティビティ「プロセス完了」(A5)に移りま
す。
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• Additionally, the following Sequence Flow Actions are executed:

• "Move process ticket into the 'Employees' queue" (SFA3)

• "Change ticket responsible to 'Employee'" (SFA4)

• "Close ticket unsuccessfully" (SFA8)

• "Approved" (SF3)

• これが一致すれば、プロセス・チケットはアクティビティ：「注文」に移ります（A3）

• Additionally, the following Sequence Flow Action is executed:

• "Move process ticket into the 'Purchasing' queue" (SFA5)

We can see that from the current Activity, which defines a step of the process ticket, there
are one or more possibilities for moving to other Activities using a Sequence Flow which
has exactly one target Activity (and possibly one or more Sequence Flow Actions).

注文

• 開始点：アクティビティ「注文」（A3)

• Possible Sequence Flows:

• "Order denied" (SF4)

• これが一致すれば、プロセス・チケットはアクティビティ「プロセス完了」(A5)に移りま
す。

• Additionally, the following Sequence Flow Actions are executed:

• "Move process ticket into the 'Employees' queue" (SFA3)

• "Set ticket responsible to 'Employee'" (SFA4)

• "Close ticket unsuccessfully" (SFA8)

• "Order placed" (SF5)

• これが一致すれば、プロセス・チケットはアクティビティ「入信」(A5)に移ります。

• Additionally, the following Sequence Flow Action is executed:

• "Move process ticket into the 'Post office' queue" (SFA6)

Incoming（入信）

• 出発点：アクティビティ「入信」A4

• Possible Sequence Flows:

• "Shipment received" (SF6)

• これが一致すれば、プロセス・チケットはアクティビティ「プロセス完了」(A5)に移りま
す。

• Additionally, the following Sequence Flow Actions are executed:

• "Move process ticket into the 'Employees' queue" (SFA3)

• "Set ticket responsible to 'Employee'" (SFA4)
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• "Close ticket successfully" (SFA7)

The complete Path for the book ordering Process will then looks like this:

図5.24 本の注文の完全なプロセス・パス

After you finish the process path please click on "Save and Finish" button in the lower
part of the canvas and then click on "Synchronize All Processes" button. This will gather
all processes information form the Database and create a cache file (in Perl language).
This cache file is actually the processes configuration that the system will use to create
or use process tickets.

プロセス(GUIの中の)に行なわれるどんな変更も、システムで変更を反映するために再度キャッ
シュ・ファイルを同期させる必要があります。

さらに、YAMLファイルから全工程をインポートすることは可能です。しかし、インポートの前に
各プロセスによって必要な動的フィールド、ユーザ、キューなどをすべて作ることがまだ必要で
す。

プロセスがACLの使用を要求する場合、手動でセットされることも必要であることに注目してくだ
さい。

以下は、本の注文プロセス用サンプルYAMLファイルの全文引用です:

---
Activities:
  A1:
    ActivityDialogs:
      - AD1
    ChangeTime: 2012-11-23 14:49:22
    Config:
      ActivityDialog:
        1: AD1
    CreateTime: 2012-11-23 11:49:38
    EntityID: A1
    ID: 151
    Name: Recording the demand
    Type: UserTask
  A2:
    ActivityDialogs:
      - AD2
      - AD3
    ChangeTime: 2012-12-13 00:55:12
    Config:
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      ActivityDialog:
        1: AD2
        2: AD3
    CreateTime: 2012-11-23 11:50:11
    EntityID: A2
    ID: 152
    Name: Approval
    Type: UserTask
  A3:
    ActivityDialogs:
      - AD4
      - AD5
    ChangeTime: 2012-11-23 18:12:14
    Config:
      ActivityDialog:
        1: AD4
        2: AD5
    CreateTime: 2012-11-23 11:50:35
    EntityID: A3
    ID: 153
    Name: Order
    Type: UserTask
  A4:
    ActivityDialogs:
      - AD6
    ChangeTime: 2012-11-23 18:12:35
    Config:
      ActivityDialog:
        1: AD6
    CreateTime: 2012-11-23 11:51:00
    EntityID: A4
    ID: 154
    Name: Incoming
    Type: UserTask
  A5:
    ActivityDialogs: []
    ChangeTime: 2012-11-23 11:51:33
    Config: {}
    CreateTime: 2012-11-23 11:51:33
    EntityID: A5
    ID: 155
    Name: Process complete
    Type: UserTask
ActivityDialogs:
  AD1:
    ChangeTime: 2012-12-06 02:16:21
    Config:
      DescriptionLong: ''
      DescriptionShort: Recoding the demand
      FieldOrder:
        - DynamicField_Author
        - DynamicField_ISBN
        - DynamicField_Title
        - DynamicField_Status
      Fields:
        DynamicField_Author:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_ISBN:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_Status:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_Title:
          DefaultValue: ''
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          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
      Interface:
        - AgentInterface
      Permission: ''
      RequiredLock: 0
      SubmitAdviceText: ''
      SubmitButtonText: ''
    CreateTime: 2012-11-23 14:34:43
    EntityID: AD1
    ID: 154
    Name: Recording the demand
  AD2:
    ChangeTime: 2012-11-23 14:57:41
    Config:
      DescriptionLong: ''
      DescriptionShort: Approval denied
      FieldOrder:
        - Article
        - DynamicField_Status
      Fields:
        Article:
          Config:
            CommunicationChannel:  'Internal'
            IsVisibleForCustomer: '0'
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_Status:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
      Interface:
        - AgentInterface
      Permission: ''
      RequiredLock: 0
      SubmitAdviceText: ''
      SubmitButtonText: Deny Request
    CreateTime: 2012-11-23 14:36:39
    EntityID: AD2
    ID: 155
    Name: Approval denied
  AD3:
    ChangeTime: 2012-12-14 03:14:23
    Config:
      DescriptionLong: ''
      DescriptionShort: Approved
      FieldOrder:
        - DynamicField_Status
      Fields:
        DynamicField_Status:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
      Interface:
        - AgentInterface
      Permission: ''
      RequiredLock: 0
      SubmitAdviceText: ''
      SubmitButtonText: Approve Request
    CreateTime: 2012-11-23 14:37:35
    EntityID: AD3
    ID: 156
    Name: Approved
  AD4:
    ChangeTime: 2012-11-23 14:58:52
    Config:
      DescriptionLong: ''
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      DescriptionShort: Order rejected
      FieldOrder:
        - Article
        - DynamicField_Status
      Fields:
        Article:
          Config:
            CommunicationChannel:  'Internal'
            IsVisibleForCustomer: '0'
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_Status:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
      Interface:
        - AgentInterface
      Permission: ''
      RequiredLock: 0
      SubmitAdviceText: ''
      SubmitButtonText: Reject Order
    CreateTime: 2012-11-23 14:38:48
    EntityID: AD4
    ID: 157
    Name: Order rejected
  AD5:
    ChangeTime: 2012-12-06 02:20:12
    Config:
      DescriptionLong: ''
      DescriptionShort: Order placed
      FieldOrder:
        - DynamicField_DeliveryDate
        - DynamicField_Price
        - DynamicField_Supplier
        - DynamicField_Status
      Fields:
        DynamicField_DeliveryDate:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_Price:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_Status:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_Supplier:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
      Interface:
        - AgentInterface
      Permission: ''
      RequiredLock: 0
      SubmitAdviceText: ''
      SubmitButtonText: Place Order
    CreateTime: 2012-11-23 14:41:28
    EntityID: AD5
    ID: 158
    Name: Order placed
  AD6:
    ChangeTime: 2012-11-23 14:42:43
    Config:
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      DescriptionLong: ''
      DescriptionShort: Shipment received
      FieldOrder:
        - DynamicField_DateOfReceipt
        - DynamicField_Status
      Fields:
        DynamicField_DateOfReceipt:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
        DynamicField_Status:
          DefaultValue: ''
          DescriptionLong: ''
          DescriptionShort: ''
          Display: 1
      Interface:
        - AgentInterface
      Permission: ''
      RequiredLock: 0
      SubmitAdviceText: ''
      SubmitButtonText: ''
    CreateTime: 2012-11-23 14:42:43
    EntityID: AD6
    ID: 159
    Name: Shipment received
Process:
  Activities:
    - A1
    - A2
    - A3
    - A4
    - A5
  ChangeTime: 2012-12-06 02:31:59
  Config:
    Description: The process to order a book
    Path:
      A1:
        SF1:
          ActivityEntityID: A2
          SequenceFlowAction:
            - SFA2
            - SFA1
      A2:
        SF2:
          ActivityEntityID: A5
          SequenceFlowAction:
            - SFA3
            - SFA4
            - SFA8
        SF3:
          ActivityEntityID: A3
          SequenceFlowAction:
            - SFA5
      A3:
        T4:
          ActivityEntityID: A5
          SequenceFlowAction:
            - SFA3
            - SFA4
            - SFA8
        SF5:
          ActivityEntityID: A4
          SequenceFlowAction:
            - SFA6
      A4:
        SF6:
          ActivityEntityID: A5
          SequenceFlowAction:
            - SFA3
            - SFA4
            - SFA7
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      A5: {}
    StartActivity: A1
    StartActivityDialog: AD1
  CreateTime: 2012-11-23 11:45:12
  EntityID: P1
  ID: 94
  Layout:
    A1:
      left: 172
      top: 63
    A2:
      left: 402
      top: 156
    A3:
      left: 649
      top: 255
    A4:
      left: 774
      top: 391
    A5:
      left: 194
      top: 410
  Name: Book ordering
  State: Active
  StateEntityID: S1
  SequenceFlowActions:
    - SFA1
    - SFA2
    - SFA3
    - SFA4
    - SFA8
    - SFA5
    - SFA3
    - SFA4
    - SFA8
    - SFA6
    - SFA3
    - SFA4
    - SFA7
  SequenceFlows:
    - SF1
    - SF2
    - SF3
    - SF4
    - SF5
    - SF6
SequenceFlowActions:
  SFA1:
    ChangeTime: 2012-11-23 16:01:37
    Config:
      Config:
        Queue: Management
      Module: TicketQueueSet
    CreateTime: 2012-11-23 15:50:59
    EntityID: SFA1
    ID: 61
    Name: Move the process ticket into the "Management" queue
  SFA2:
    ChangeTime: 2012-11-23 16:02:12
    Config:
      Config:
        Responsible: manager
      Module: TicketResponsibleSet
    CreateTime: 2012-11-23 15:58:22
    EntityID: TA2
    ID: 62
    Name: Change ticket responsible to "manager"
  SFA3:
    ChangeTime: 2012-11-24 14:27:02
    Config:
      Config:
        Queue: Employees
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      Module: TicketQueueSet
    CreateTime: 2012-11-23 16:02:54
    EntityID: TA3
    ID: 63
    Name: Move the process ticket into the "Employees" queue
  SFA4:
    ChangeTime: 2012-11-23 16:04:06
    Config:
      Config:
        Responsible: Employee
      Module: TicketResponsibleSet
    CreateTime: 2012-11-23 16:04:06
    EntityID: TA4
    ID: 64
    Name: Change ticket responsible to "Employee"
  SFA5:
    ChangeTime: 2012-12-06 02:18:34
    Config:
      Config:
        Queue: Purchasing
      Module: TicketQueueSet
    CreateTime: 2012-11-23 16:04:54
    EntityID: TA5
    ID: 65
    Name: Move process ticket into the "Purchasing" queue
  SFA6:
    ChangeTime: 2012-12-06 02:18:48
    Config:
      Config:
        Queue: Post office
      Module: TicketQueueSet
    CreateTime: 2012-11-23 16:06:20
    EntityID: TA6
    ID: 66
    Name: Move process ticket into the "Post office" queue
  SFA7:
    ChangeTime: 2012-12-06 02:29:55
    Config:
      Config:
        State: closed successful
      Module: TicketStateSet
    CreateTime: 2012-12-06 02:29:27
    EntityID: TA7
    ID: 67
    Name: Close ticket successfully
  SFA8:
    ChangeTime: 2012-12-06 02:31:12
    Config:
      Config:
        State: closed unsuccessful
      Module: TicketStateSet
    CreateTime: 2012-12-06 02:31:12
    EntityID: TA8
    ID: 68
    Name: Close ticket unsuccessfully
SequenceFlows:
  SF1:
    ChangeTime: 2012-11-23 15:12:20
    Config:
      Condition:
        1:
          Fields:
            DynamicField_Status:
              Match: Approval
              Type: String
          Type: and
      ConditionLinking: and
    CreateTime: 2012-11-23 11:53:52
    EntityID: T1
    ID: 94
    Name: Approval
  SF2:
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    ChangeTime: 2012-11-23 15:12:50
    Config:
      Condition:
        1:
          Fields:
            DynamicField_Status:
              Match: Approval denied
              Type: String
          Type: and
      ConditionLinking: and
    CreateTime: 2012-11-23 11:54:26
    EntityID: T2
    ID: 95
    Name: Approval denied
  SF3:
    ChangeTime: 2012-11-23 15:13:29
    Config:
      Condition:
        1:
          Fields:
            DynamicField_Status:
              Match: Approved
              Type: String
          Type: and
      ConditionLinking: and
    CreateTime: 2012-11-23 11:54:54
    EntityID: T3
    ID: 96
    Name: Approved
  SF4:
    ChangeTime: 2012-11-23 15:14:08
    Config:
      Condition:
        1:
          Fields:
            DynamicField_Status:
              Match: Order denied
              Type: String
          Type: and
      ConditionLinking: and
    CreateTime: 2012-11-23 11:55:25
    EntityID: T4
    ID: 97
    Name: Order denied
  SF5:
    ChangeTime: 2012-11-23 18:30:33
    Config:
      Condition:
        1:
          Fields:
            DynamicField_Status:
              Match: Order placed
              Type: String
          Type: and
      ConditionLinking: and
    CreateTime: 2012-11-23 11:56:15
    EntityID: T5
    ID: 98
    Name: Order placed
  SF6:
    ChangeTime: 2012-11-23 15:15:30
    Config:
      Condition:
        1:
          Fields:
            DynamicField_Status:
              Match: Shipment received
              Type: String
          Type: and
      ConditionLinking: and
    CreateTime: 2012-11-23 11:56:48
    EntityID: T6
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    ID: 99
    Name: Shipment received

                

2.4. プロセス構成リファレンス
2.4.1. プロセス

A Process models the path of a workflow/process. The waypoints on this path can be
Activities or Sequence Flows, we'll talk about these later.

2.4.1.1. プロセス構成

While the Process configuration can be done directly in a perl file such as Kernel/
Config.pm this practice is discouraged since the GUI offers the majority of the needed
features and is easier to maintain.

In case that is absolutely required to create a process directly in a perl file then it is
strongly recommended to create new files like Kernel/Config/Files/MyProcess.pm.
Notice that the GUI generates the file Kernel/Config/Files/ZZZProcessManagement,
so please avoid using that specific filename, otherwise it will be overwritten when you
sync processes.

Let's see an example process configuration (from the process cache file):

$Self->{'Process'} = {
    'P1' => {
        Name                => '本の注文',
        CreateTime          => '16-02-2012 13:37:00',
        CreateBy            => '1',
        ChangeTime          => '17-02-2012 13:37:00',
        ChangeBy            => '1',
        State               => 'Active',
        StartActivity       => 'A1',
        StartActivityDialog => 'AD1',
        Path => {
            'A1' => {
                'T1' => {
                    ActivityEntityID => 'A2',
                },
            },
            'A2' => {
                'T2' =>  {
                    ActivityEntityID => 'A3',
                },
            },
        },
    },
    'P2' => {
        Name                => 'IT 注文',
        CreateTime          => '26-02-2012 13:37:00',
        CreateBy            => '1',
        ChangeTime          => '27-02-2012 13:37:00',
        ChangeBy            => '1',
        State               => 'Active',
        StartActivity       => 'A2',
        StartActivityDialog => 'AD2',
        Path => {
            'A2' => {
                'T3' => {
                    ActivityEntityID => 'A4',
                },
            },
        },
    }
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};
                    

2.4.1.2. Name

プロセスの名前、新しいプロセス・チケットを作成する場合、担当者はこれを選択することができ
ます。

2.4.1.3. CreateTime

プロセスの作成日時

2.4.1.4. CreateBy

プロセスを作成するユーザのUID

2.4.1.5. ChangeTime

プロセスの変更時刻

2.4.1.6. ChangeBy

プロセスの最終変更ユーザのUID

2.4.1.7. State

プロセスの状態を定義します。可能な値:

• 「Active（アクティブ）」は、新しいプロセス・チケットの中で使用することができる全てのプ
ロセスです。

• 「FadeAway（消失）」は、
　もはやさらなる新規チケットを選択できないプロセスです。既存チケットはまだプロセスを使
用可能です。

• 「Inactive」（インアクティブ）は、不活性化されたプロセスです。新規も既存チケットも使用
できません。

2.4.1.8. StartActivity

When creating a new process ticket, a StartActivity must be defined. As soon as the ticket
is created, this Activity will be set and used as the base for the first sequence flow checks.

2.4.1.9. StartActivityDialog

For new process tickets, if the initial activity is of the type 'User task activity' then a
StartActivityDialog must be defined. This will be shown when creating a new process
ticket (after the process was selected). At this point, the ticket does not exist yet, it will
be created after submitting the StartActivityDialog. In case of a non 'User task activity' a
default activity dialog will be presented to start the process.

2.4.1.10. パス

The Path contains the structure of the Activities, and the possible Sequence Flows
between them, for the current process. Additionally, path also contains the Sequence Flow
Actions that happen when moving from one activity to another. They control the way that
a process ticket can take. Example:

'A1' => {
    'SF1' => {
        ActivityEntityID => 'A2',
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    },
    'SF2' => {
        ActivityEntityID => 'A3',
    },
    'SF3' => {
        ActivityEntityID   => 'A4',
        SequenceFlowAction => ['SFA1', 'SFA2'],
    },
},
                    

If a process ticket is in Activity A1, it has three possible ways to get to another Activity. In
the Sequence Flows SF1 to SF3, sequence flow condition expressions are defined, that a
process ticket must fulfill to move (transit) to another Activity.

If in this case all the values of the process ticket and its dynamic fields that are needed for
the Sequence Flow SF2 are correct, the ticket will be moved from Activity A1 to A3. After
a User Task Activity Dialog is submitted, or any other change is made to the ticket, it will
be checked for possible Sequence Flows from the current Activity. If multiple Sequence
Flows are possible, the first one will be used (based on numerical sorting of the Sequence
Flow EntityIDs).

Additionally, it is possible to assign Sequence Flow Actions to Sequence Flows in the Path
configuration. These are modules which are executed after a successful move from one
activity to the next one. They have to be specified in array form as in the example, we'll
talk about the details later.

2.4.2. アクティビティ
An Activity can contain one or more Activity Dialogs, a module or a web service ID and
an invoker depending on the activity type. Activities models a step in the process. For
User Task Activities all their User Task Activity Dialogs of the current Activity are displayed
in the ticket zoom and can be used until the Sequence Flow Condition Expressions of a
Sequence Flow are fulfilled. For non User Task Activities a notification is shown to indicate
that the Activity is a self executing task.

2.4.2.1. アクティビティ構成

サンプルのアクティビティ構成を見ましょう:

$Self->{'Process::Activity'} =
{
    'A1' => {
        Name       => 'Activity 1 optional',
        CreateTime => '16-02-2012 13:37:00',
        CreateBy   => '1',
        ChangeTime => '17-02-2012 13:37:00',
        ChangeBy   => '1',
        ActivityDialog => {
            1 => 'AD1',
        },
        Config => '',
        Type   => 'UserTask',
    },
    'A2' => {
        Name       => 'Activity 2 optional',
        CreateTime => '16-02-2012 13:37:00',
        CreateBy   => '1',
        ChangeTime => '17-02-2012 13:37:00',
        ChangeBy   => '1',
        ActivityDialog => {
            1 => 'AD5',
            2 => 'AD6',
            3 => 'AD1',
        },
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        Config => '',
        Type   => 'UserTask',
    },
    'A3' => {
        Name => 'Activity 3 optional',
        CreateTime => '2018-01-30 03:44:30',
        CreateBy   => '1',
        ChangeTime => '2018-01-30 03:44:30',
        ChageBy    => '1',
        ActivityDescription => 'This Activity fires an Invoker form a Web Service',
        ActivityErrorCode   => '',
        ActivityDialog      => '',
        WebServiceID => '1'
        Invoker      => 'test_operation',
        Interface    => [
            'AgentInterface',
        ],
        Config       => '',
        Type => 'ServiceTask',
    },
    'A4' => {
        Name => 'Activity 4 optional',
        CreateTime => '2018-01-30 03:44:30',
        CreateBy   => '1',
        ChangeTime => '2018-01-30 03:44:30',
        ChageBy    => '1',
        ActivityDialog => '',
        ActivityDescription => 'This Activity executes a script module',
        ActivityErrorCode   => '',
        Module => 'DynamicFieldSet',
        Config => {
          'DynamicField_NameX' => 'Hello',
        },
        Interface => [
          'AgentInterface',
          'CustomerInterface',
        ],
        Type => 'ScriptTask',
    },
};
                

2.4.2.2. Name
アクティビティの名前

2.4.2.3. CreateTime
アクティビティの作成日時

2.4.2.4. CreateBy
アクティビティの作成ユーザーのユーザのUID

2.4.2.5. ChangeTime
アクティビティの変更時刻

2.4.2.6. ChangeBy
アクティビティの最終変更ユーザのユーザのUID

2.4.2.7. ActivityDialog（アクティビティ・ダイアログ）
Activity Dialog contains the list of User Task Activity Dialogs which are available in this
Activity (only for User Task Activities). All Activity Dialogs of the current Activity are
displayed in the ticket zoom. Their order is set by the order in the configuration, here AD5
is shown before AD6 and AD1.
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2.4.2.8. ActivityDescription

Field used to store the purpose of an activity is only available for "Script Task" and "Service
Task" Activities.

2.4.2.9. ActivityErrorCode

It's used to send a custom error code in case of a failure, and if it's not defined error code
'1' is used by default. This is only available for "Script Task" and "Service Task" Activities.

2.4.2.10. WebServiceID

Holds the ID of the Web Service used by the activity. This is only available for "Service
Task" Activities.

2.4.2.11. 依頼アクション(Invokers)

Stores the name of an Invoker from the selected Web Service used by the activity. This
is only available for "Service Task" Activities.

2.4.2.12. Module（モジュール）

The name of a script module used by the activity, (located in Kernel/System/
ProcessManagement/Modules). This is only available for "Script Task" Activities.

2.4.2.13. Config（構成）

Configuration parameters for the selected script used by the activity. This is only available
for "Script Task" Activities.

2.4.2.14. Interface

List of interfaces where the activity can start a processes (if it's the first activity). If value
does not contain the name of the current interface, the process is not listed for selection.
This is only available for "Service Task" and "Script Task" Activities.

2.4.2.15. タイプ

Defines the type of the activity, possible values are: 'User task activity', 'Service task
activity' and 'Script task activity'.

2.4.3. ActivityDialog（アクティビティ・ダイアログ）
A User Task Activity Dialog is a representation or render of a User Task Activity as a screen.
User Task Activity Dialogs can be shared among the User Task Activities.

2.4.3.1. ActivityDialog（アクティビティ・ダイアログ）の構成

サンプルのコンフィグを見てみましょう。

$Self->{'Process::ActivityDialog'} = {
    'AD1' => {
        Name             => 'ActivityDialog 1 optional',
        DescriptionShort => 'Basic info',
        DescriptionLong  => 'Please insert the necessary basic information for IT orders',
        CreateTime       => '28-02-2012 13:37:00',
        CreateBy         => '1',
        ChangeTime       => '29-02-2012 13:37:00',
        ChangeBy         => '1',
        Fields => {
            PriorityID => {
                DescriptionShort => 'Priority ID',
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                DescriptionLong  => 'Enter the priority here',
                Display          => 2,
            },
        },
        FieldOrder       => [ 'PriorityID' ],
        SubmitAdviceText => 'Note: If you submit the form...',
        SubmitButtonText => 'Send request',
    },
    'AD2' => {
        Name             => 'ActivityDialog 2 optional',
        DescriptionShort => 'Basic info',
        DescriptionLong  => 'Please insert the necessesary basic information for Book
 orders',
        CreateTime       => '28-02-2012 13:37:00',
        CreateBy         => '1',
        ChangeTime       => '29-02-2012 13:37:00',
        ChangeBy         => '1',
        Fields => {
            StateID => {
                DescriptionShort => 'State ID',
                DescriptionLong  => 'Enter the state here',
                Display          => 2,
                DefaultValue     => '2',
            },
            Queue => {
                DescriptionShort => 'Queue ID',
                DescriptionLong  => 'Enter the queue here',
                Display          => 2,
                DefaultValue     => 'Raw',
            },
            Title => {
                DescriptionShort => 'Title',
                DescriptionLong  => 'Enter the title here',
                Display          => 1,
                DefaultValue     => 'Default Title',
            },
            DynamicField_Anzahl => {
                DescriptionShort => 'Amount',
                DescriptionLong  => 'Enter the amount here',
                Display          => 2,
                DefaultValue     => '4',
            },
        },
        FieldOrder       => [ 'DynamicField_Anzahl', 'StateID', 'Queue', 'Title' ],
        SubmitAdviceText => 'Note: If you submit the form...',
        SubmitButtonText => 'Send request',
    },
};
                    

2.4.3.2. Name

アクティビティ・ダイアログの名前

2.4.3.3. CreateTime

アクティビティの作成日時

2.4.3.4. CreateBy

このアクティビティ・ダイアログを作成したユーザのUID

2.4.3.5. ChangeTime

アクティビティの変更時刻

2.4.3.6. ChangeBy

このアクティビティダイアログの最終変更者のユーザのUID
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2.4.3.7. フィールド

このアクティビティダイアログで表示することができる全てのフィールドを含んでいます。次の
フィールドは現在使用することができます:

    Title
    State
    StateID
    Priority
    PriorityID
    Lock
    LockID
    Queue
    QueueID
    Customer
    CustomerID
    CustomerNo
    CustomerUserID
    Owner
    OwnerID
    Type
    TypeID
    SLA
    SLAID
    Service
    ServiceID
    Responsible
    ResponsibleID
    PendingTime
    DynamicField_$FieldName  # 全ての動的フィールド用
                    

単一のフィールド構成の例：

StateID => {
    DescriptionShort => 'State ID',
    DescriptionLong  => 'Enter the state here',
    Display          => 2,
    DefaultValue     => '2',
},
                    

The field Article is a special case. If it is present in the Fields configuration, the Activity
Dialog will contain a complete Rich-text editor with subject field and attachment handling.
The entered text will then be added to the ticket as an article. Let's see an example Article
field configuration:

Article => {
    DescriptionShort => 'Please insert your comment here.',
    DescriptionLong => '',
    Display         => 1,
    Config          => {
        CommunicationChannel => 'Internal'
        IsVisibleForCustomer => '0'
        LabelSubject => '',
        LabelBody    => '',
    },
},
                    

フィールド構成オプションを見ましょう:

2.4.3.7.1. DescriptionShort（短い摘要）

フィールドタイトルで表示される短い摘要（オプション）。

245



2.4.3.7.2. DescriptionLong（長い摘要）

マウスがフィールド上に乗る時、表示されるより長い摘要（オプション）。フィールドの入力方法
についての例示アドバイス。

2.4.3.7.3. Display（表示）

Controls if the field is shown and/or mandatory. Possible values:

• 0: field is invisible. This can be helpful if field values should automatically be set. The
configured DefaultValue will be stored in this case.

• 1: field is visible, but optional.

• 2: field is visible and mandatory. The following fields can only be invisible or mandatory:

    QueueID
    Queue
    State
    StateID
    Lock
    LockID
    Priority
    PriorityID
    Type
    TypeID
                                    

フィールドが任意として設定され、ユーザが値を送信しなければ、アクティビティ・ダイアログが
ユーザによって送信される時、デフォルト値が保存されます。

2.4.3.7.4. DefaultValue（デフォルト値）

For fields with ID (like QueueID, OwnerID), this refers to the database ID of the value. For
other fields without ID (like Queue, Owner), the DefaultValue must contain the value
itself. Example:

Queue => {
    DescriptionShort => 'Queue',
    DescriptionLong  => 'Enter the queue here',
    Display          => 2,
    DefaultValue     => 'Raw',
},
                        

2.4.3.8. FieldOrder（フィールド順序）

ここで、フィールドの表示順序は設定されます。重要:保存する時単に設定されたフィールドが考慮
されるので、目に見えないフィールドはさらにここで設定されなければいけません。設定されない
フィールドは保存されないでしょう。

2.4.3.9. SubmitAdviceText（アドバイス用テキストの送信）

補足的ヘルプかアドバイス用テキストのための送信ボタン上に示される任意のテキスト。

2.4.3.10. SubmitButtonText（送信ボタンのテキスト）

送信ボタンのための任意のカスタム・テキスト。

2.4.4. SequenceFlow
A Sequence Flow decides, based on configurable Sequence Flow Condition Expressions,
which path in the Process is taken, i.e. to which Activity a Process ticket can be moved.
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2.4.4.1. Sequence Flow configuration

サンプルを見ましょう:

$Self->{'Process::SequenceFlow'} = {
    'SF1' => {
        Name => 'Sequence Flow 1',
        CreateTime => '14-03-2012 13:37:00', # optional
        CreateBy   => '1',                   # optional
        ChangeTime => '15-03-2012 13:37:00', # optional
        ChangeBy   => '15-03-2012 13:37:00', # optional
        Condition  => {
            Cond1  => {
                Fields => {
                    StateID => {
                        Type  => 'String',
                        Match => '1',
                    },
                },
            },
        },
    },
    'SF2' => {
        Name       => 'SequenceFlow 2 optional',
        CreateTime => 'DATE',   # optional
        CreateBy   => 'USERID', # optional
        ChangeTime => 'DATE',   # optional
        ChangeBy => 'USERID',   # optional
        Condition => {
            Cond1 => {
                Queue               => 'Raw',
                DynamicField_Farbe  => '2',
                DynamicField_Anzahl => '1',
            },
        },
    },
};
                    

2.4.4.2. Name

Name of the sequence flow.

2.4.4.3. CreateTime

アクティビティ・ダイアログ作成日時

2.4.4.4. CreateBy

UID of the user who created this Sequence Flow.

2.4.4.5. ChangeTime

アクティビティ・ダイアログの最終変更時刻

2.4.4.6. ChangeBy

UID of the last user who changed this Sequence Flow.

2.4.4.7. Condition（条件）

Contains all sequence flow condition expressions that are necessary for this Sequence
Flow to take effect. Example:
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Condition => {
    Type  => 'and',
    Cond1 => {
        Type   => 'and',
        Fields => {
            StateID => {
                Type  => 'String',
                Match => '1',
            },
            DynamicField_Marke => {
                Type  => 'String',
                Match => 'VW',
        },
    },
    Cond2 => {
        Type => 'and',
        Fields => {
            Queue => {
                Type  => 'String',
                Match => 'Raw',
            },
        },
    },
},
                    

Let's look at the Sequence Flow Condition Expression configuration in detail.

2.4.4.7.1. Type (Condition Expression Linking)

Specifies the way the different condition expression elements are connected to each
other. Possible values:

• and: This is the default. All condition expressions must be met for the sequence flow
to take effect.

• or: At least one condition expression must match.

• xor: Exactly one condition expression must match, not more.

2.4.4.7.2. Cond1

This is the name of an example condition expression. It can be freely chosen. Conditions
are evaluated in sorted order.

2.4.4.7.3. Type (Field)

Specifies the way how the individual field tests of this condition expression are connected
to each other. Possible values:

• and: This is the default. All field tests must match for this condition expression to match.

• or: At least one field test must match.

• xor: Exactly one field test must match, not more.

2.4.4.7.4. フィールド

Specifies the particular fields whose values should be tested. From our example:

Fields => {
    StateID => {
        Type  => 'String',
        Match => '1',
    },
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2.4.4.7.5. StateID

Example of a field name. The following ticket fields can be used:

    Title
    State
    StateID
    Priority
    PriorityID
    Lock
    LockID
    Queue
    QueueID
    Customer
    CustomerID
    CustomerNo
    CustomerUserID
    Owner
    OwnerID
    Type
    TypeID
    SLA
    SLAID
    Service
    ServiceID
    Responsible
    ResponsibleID
    DynamicField_$FieldName # for all DynamicFields
                        

「ID」(SLAIDのように)を備えたフィールドをテストする時、フィールドのデータベースIDは、実
際の値がそのために使用される他のフィールド(SLAのような)のための試験に使用されます。

2.4.4.7.6. タイプ

フィールド試験の種類を決定します。可能な値:

• String: Compares the field value with the string specified in Match. Matches if they
are exactly the same.

• Hash: Compares the field value (hash) with the hash specified in Match. All hash values
must be the same.

• Array: Compares the field value (array) with the array specified in Match. Both lists
must be the same.

• Regex: The field value can be tested with a regular expression. It is important to
understand that Match contains qr{}xms as a base condition. Between the braces the
actual regular expression will be inserted.

• Module: Allows you to use a perl module for condition expression
checking. If it returns 1, the check was positive. You can find
an example module in Kernel/System/ProcessManagement/SequenceFlow/
ConditionExpression/Validation/ValidateDemo.pm.

2.4.5. Sequence Flow Actions
Sequence Flow Actions are actions which can be triggered after successfully applied
sequence flows (when a process ticket moves from one activity to another). These
Sequence Flow Actions can be used to perform different changes on the ticket, e.g. change
the Queue or the Owner of the ticket. You can also create your own Sequence Flow Actions
to perform other complex changes.
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2.4.5.1. Sequence Flow Action configuration

サンプルを見ましょう:

$Self->{'Process::SequenceFlowAction'} = {
    'SFA1' => {
        Name   => 'Queue Move',
        Module => 'TicketQueueSet',
        Config => {
            Queue  => 'Junk',
            UserID => 123,
        },
    },
};
                    

2.4.5.2. Name

The name of the Sequence Flow Action.

2.4.5.3. Module（モジュール）

Specifies the Perl module to be used (from the list in Kernel/System/
ProcessManagement/ Modules).

2.4.5.4. Config（構成）

This parameter contains all settings which are required for the module. Its content
depends on the particular Sequence Flow Action module which is used, some modules
might require even more complex configurations than just simple key - value pairs. Please
see the documentation of the individual modules for details. In our example, only the
Queue must be specified. Nevertheless we are also sending UserID parameter, by using
the UserID value. The sequence flow action will be executed impersonating the user with
the given UserID.

The use of UserID inside the Config parameter of a Sequence Flow Action is accepted
by all Sequence Flow Actions Modules (since OTRS 3.2.4). In this example it could
be particularly important if the user that triggers the Sequence Flow does not have
permissions to move the ticket to the queue Junk, while the user with the UserID 123
might have.

2.4.5.5. Reusing Sequence Flow Action modules

To use Sequence Flow Action modules multiple times, just specify several Sequence Flow
Actions in your configuration. Example:

    $Self->{'Process::SequenceFlowAction'} = {
        'SFA1' => {
            Name   => 'Queue Move Junk',
            Module => 'TicketQueueSet',
            Config => {
                Queue => 'Junk',
            },
        },
        'SFA2' => {
            Name   => 'Queue Move Raw',
            Module => 'TicketQueueSet',
            Config => {
                Queue => 'Raw',
            },
        },
    };
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Here the same module is used to move a process ticket into the Raw queue, and another
time to move it into the Junk queue. The Sequence Flow Action which must be used for a
particular Sequence Flow is determined from the Path setting of the Process configuration.

2.4.5.6. Available Sequence Flow Actions

OTRS comes with several Sequence Flow Actions that can be used in your processes. Here
you can find their documentation and how they need to be configured.

2.4.5.6.1. DynamicFieldSet (動的フィールドのセット)

プロセス・チケットで1つ以上の動的フィールドをセットします。

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Set DynamicField MasterSlave to Master and Approved to 1',
        Module => 'DynamicFieldSet',
        Config => {
            MasterSlave => 'Master',
            Approved    => '1',

        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

MasterSlave and Approved are given as examples of DynamicField names. The values of
the fields (Master and 1) will be set by this Sequence Flow Action.

2.4.5.6.2. TicketArticleCreate（チケット記事の作成）

Creates an article, the %DataPayload parameters depends on the given communication
channel, by default Internal is used. Example:

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Article Create Note',
        Module => 'TicketArticleCreate',
        Config => {

        Config                   => {
            SenderType           => 'agent',                # (required) agent|system|
customer
            IsVisibleForCustomer => 1,                      # 0 or 1
            CommunicationChannel => 'Internal',             # Internal|Phone|Email|...,
 default: Internal

            %DataPayload,                                   # some parameters depending of
 each communication channel

            # specific for <OTRS_AGENT_BODY_RICHTEXT> / <OTRS_CUSTOMER_BODY_RICHTEXT> OTRS
 smart tags:
            AgentBodyRichTextQuote    => 0,                 # optional, 0 or 1, insert the
 last agent article as quote like 'AgentTicketCompose' frontend
            CustomerBodyRichTextQuote => 0,                 # optional, 0 or 1, insert the
 last customer article as quote like 'AgentTicketCompose' frontend

            AgentBodyRichTextInlineImagesInclude    => 0,   # optional, 0 or 1, inline
 attachments of the last agent article are taken over to the new article
            CustomerBodyRichTextInlineImagesInclude => 0,   # optional, 0 or 1, inline
 attachments of the last customer article are taken over to the new article
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            AgentBodyRichTextAttachmentsInclude    => 0,    # optional, 0 or 1, all
 attachments of the last agent article are taken over to the new article
            CustomerBodyRichTextAttachmentsInclude => 0,    # optional, 0 or 1, all
 attachments of the last customer article are taken over to the new article
        },
    },
};
                        

The following is the %DataPayload for MIME based Communication channels (Email,
Internal and Phone).

            SenderType       => 'agent',                                                #
 agent|system|customer
            ContentType      => 'text/plain; charset=ISO-8859-15',                      # or
 optional Charset & MimeType (e.g. 'text/html; charset=UTF-8')
            Subject          => 'some short description',                               #
 required
            Body             => 'the message text',                                     #
 required
            HistoryType      => 'OwnerUpdate',                                          #
 EmailCustomer|Move|AddNote|PriorityUpdate|WebRequestCustomer|...
            HistoryComment   => 'Some free text!',
            From             => 'Some Agent <email@example.com>',                       #
 not required but useful
            To               => 'Some Customer A <customer-a@example.com>',             #
 not required but useful
            Cc               => 'Some Customer B <customer-b@example.com>',             #
 not required but useful
            ReplyTo          => 'Some Customer B <customer-b@example.com>',             #
 not required
            InReplyTo        => '<asdasdasd.12@example.com>',                           #
 not required but useful
            References       => '<asdasdasd.1@example.com> <asdasdasd.12@example.com>', #
 not required but useful
            NoAgentNotify    => 0,                                                      # if
 you don't want to send agent notifications
            AutoResponseType => 'auto reply',                                           #
 auto reject|auto follow up|auto reply/new ticket|auto remove

            ForceNotificationToUserID   => '1,43,56',                                    #
 if you want to force somebody
            ExcludeNotificationToUserID => '43,56',
                 # if you want full exclude somebody from notifications,
                 # will also be removed in To: line of article,
                 # higher prio as ForceNotificationToUserID
            ExcludeMuteNotificationToUserID => '43,56',
                 # the same as ExcludeNotificationToUserID but only the
                 # sending gets muted, agent will still shown in To:
                 # line of article
                        

Name specifies the name of the configured Sequence Flow Action. It can be freely chosen,
but should reflect the purpose of the configured action.

SenderType defines the sender type of the article. Possible values: agent, system,
customer.

IsVisibleForCustomer defines if the article should be displayed in the customer
interface.

CommunicationChannel defines the type of the article to be created. Possible values:
Email, Internal and Phone. This list could be extended by installing new communication
channels via an OTRS Package.

ContentType defines the content type of the article. Possible values: text/plain;
charset=ISO-8859-15 or any other valid charset and mime type.
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Subject defines the article title. Mandatory.

Body defines the article content. Mandatory.

HistoryType defines the type of the history entry. Possible
values: AddNote, ArchiveFlagUpdate, Bounce, CustomerUpdate, EmailAgent,
EmailCustomer, EscalationResponseTimeNotifyBefore, EscalationResponseTimeStart,
EscalationResponseTimeStop, EscalationSolutionTimeNotifyBefore,
EscalationSolutionTimeStart, EscalationSolutionTimeStop,
EscalationUpdateTimeNotifyBefore, EscalationUpdateTimeStart,
EscalationUpdateTimeStop, FollowUp, Forward, Lock, LoopProtection, Merged,
Misc, Move, NewTicket, OwnerUpdate, PhoneCallAgent, PhoneCallCustomer,
PriorityUpdate, Remove, ResponsibleUpdate, SendAgentNotification, SendAnswer,
SendAutoFollowUp, SendAutoReject, SendAutoReply, SendCustomerNotification,
ServiceUpdate, SetPendingTime, SLAUpdate, StateUpdate, Subscribe, SystemRequest,
TicketDynamicFieldUpdate, TicketLinkAdd, TicketLinkDelete, TimeAccounting,
TypeUpdate, Unlock, Unsubscribe, WebRequestCustomer.

HistoryComment defines the content of the history entry.

From, To, Cc and ReplyTo take email addresses in the notation specified above.

InReplyTo and References take email message IDs.

NoAgentNotify - if set to 1, the email notification for an agent will not be sent.

AutoResponseType can take the following values: auto follow up, auto reject, auto
remove, auto reply, auto reply/new ticket.

ForceNotificationToUserID, ExcludeNotificationToUserID,
ExcludeMuteNotificationToUserID can take a list of UserIDs that are either always
notified, not notified or listed as notified but not actually sent a notification email.

OTRS smart tags like <OTRS_CUSTOMER_BODY> or <OTRS_AGENT_BODY> are now supported
in the Sequence Flow Action TicketArticleCreate. Those smart tags could be used to
create a new article and insert data from the process ticket to this article. The usage of
the OTRS smart tags is identical to the text templates in Ticket Notifications.

2.4.5.6.3. チケット作成

Creates a ticket with an article, the new ticket can be linked with process ticket. Example:

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Ticket Create',
        Module => 'TicketCreate',
        Config => {

            # ticket required:
            Title         => 'Some Ticket Title',
            Queue         => 'Raw',              # or QueueID => 123,
            Lock          => 'unlock',
            Priority      => '3 normal',         # or PriorityID => 2,
            State         => 'new',              # or StateID => 5,
            CustomerID    => '123465',
            CustomerUser  => 'customer@example.com',
            OwnerID       => 'someuserlogin',    # or OwnerID => 123,

            # ticket optional:
            TN              => $TicketObject->TicketCreateNumber(), # optional
            Type            => 'Incident',            # or TypeID => 1, not required
            Service         => 'Service A',           # or ServiceID => 1, not required
            SLA             => 'SLA A',               # or SLAID => 1, not required
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            ResponsibleID   => 123,                   # not required
            ArchiveFlag     => 'y',                   # (y|n) not required
            PendingTime     => '2011-12-23 23:05:00', # optional (for pending states)
            PendingTimeDiff => 123 ,                  # optional (for pending states)

            # article required:
            SenderType           => 'agent',           # agent|system|customer
            CommunicationChannel => 'Internal'         # Internal|Phone|Email|..., default:
 Internal
            IsVisibleForCustomer => '0'

            %DataPayload,                             # some parameters depending of each
 communication channel

            # article optional:
            TimeUnit                        => 123

            # other:
            DynamicField_NameX => $Value,
            LinkAs => $LinkType,                                        # Normal, Parent,
 Child, etc. (respective original ticket)
            UserID => 123,                                              # optional, to
 override the UserID from the logged user

            # specific for <OTRS_AGENT_BODY_RICHTEXT> / <OTRS_CUSTOMER_BODY_RICHTEXT> OTRS
 smart tags:
            AgentBodyRichTextQuote    => 0,                             # optional, 0 or 1,
 insert the last agent article as quote like 'AgentTicketCompose' frontend
            CustomerBodyRichTextQuote => 0,                             # optional, 0 or 1,
 insert the last customer article as quote like 'AgentTicketCompose' frontend

            AgentBodyRichTextInlineImagesInclude    => 0,               # optional, 0 or 1,
 inline attachments of the last agent article are taken over to the new article
            CustomerBodyRichTextInlineImagesInclude => 0,               # optional, 0 or 1,
 inline attachments of the last customer article are taken over to the new article

            AgentBodyRichTextAttachmentsInclude    => 0,                # optional, 0 or 1,
 all attachments of the last agent article are taken over to the new article
            CustomerBodyRichTextAttachmentsInclude => 0,                # optional, 0 or 1,
 all attachments of the last customer article are taken over to the new article
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action. It can be freely chosen,
but should reflect the purpose of the configured action.

Title The ticket title.

Queue or QueueID specifies the name or id of the queue to be used in the new ticket.

Lock or LockID sets the lock status of the ticket.

Priority or PriorityID specifies the name or ID of the priority to be used in the new
ticket.

State or StateID specifies the name or ID of the state to be used in the new ticket.

CustomerID, the customer ID to be set for the new ticket.

CustomerUser, the login of the customer that will be assigned in the ticket.

OwnerID or OwnerID, specifies the login or ID of the agent that will be the new ticket owner.

TN, custom number for the new ticket.

Type or TypeID specifies the name or ID of the ticket type to be used in the new ticket.
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Service or ServiceID specifies the name or ID of the service to be used in the new ticket.

SLA or SLAID specifies the name or ID of the SLA to be used in the new ticket.

ResponsibleID, the ID of the agent that will be the new ticket responsible.

PendingTime, a predefined date to set the Ticket Pending Times, when the ticket state
belongs to a pending state type.

PendingTimeDiff, a dynamically date (expressed in seconds from current date/time) to
set the Ticket Pending Times, when the ticket state belongs to a pending state type.

SenderType defines the sender type of the article. Possible values: agent, system,
customer.

IsVisibleForCustomer defines if the article should be displayed in the customer
interface.

CommunicationChannel defines the type of the article to be created. Possible values:
Email, Internal and Phone. This list could be extended by installing new communication
channels via an OTRS Package.

Please check the additional parameters for different article channels.

TimeUnit the time invested in the current ticket article expressed in seconds, minutes,
hours, etc.

DynamicField_NameX where DynamicField_ is a required prefix and NameX is the name
of a Dynamic Field to be set in the new ticket (on ticket level, not article levels).

LinkAs to define the new ticket relation with originator ticket, from the new ticket point
of view, for example Normal, Parent, Child etc.

OTRS smart tags like <OTRS_CUSTOMER_BODY> or <OTRS_CUSTOMER_REALNAME> are now
supported in the Sequence Flow Action TicketCreate. Those smart tags could be used to
create a new ticket and insert data from the process ticket to this child ticket. The usage
of the OTRS smart tags is identical to the text templates in Ticket Notifications.

2.4.5.6.4. TicketCustomerSet（チケット・顧客・セット）

顧客にプロセス・チケットをセットします。例：

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Customer Set Customer to test',
        Module => 'TicketCustomerSet',
        Config => {
            No      => 'test',
            User    => 'client-user-123',
            # or in other words
            # CustomerID     => 'client123',
            # CustomerUserID => 'client-user-123',

        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

No or CustomerID set the Customer ID of the customer.

User or CustomerUserID set the Username of the customer.
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2.4.5.6.5. TicketLockSet（チケット・ロック・セット）

プロセス・チケットのロックを変更します。例:

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Set Lock to lock',
        Module => 'TicketLockSet',
        Config => {
            Lock   => 'lock',
            # or
            LockID => 2,
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

Lock defines the new lock of the process ticket.

LockID defines the internal ID of the new lock.

2.4.5.6.6. TicketOwnerSet（チケット・所有者・セット）

プロセス・チケットの所有者を変更します。

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Owner Set root@localhost',
        Module => 'TicketOwnerSet',
        Config => {
            Owner => 'root@localhost',
            # or
            OwnerID => 1,
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

Owner specifies the login name of the new owner.

OwnerID specifies the internal ID of the new owner.

2.4.5.6.7. TicketQueueSet（チケット・キュー・セット）

ターゲット・キューにチケットを移動します。

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Queue Move Raw',
        Module => 'TicketQueueSet',
        Config => {
            Queue => 'Raw',
            # or
            # QueueID => '2',
        },
    },
};
                        

Name specifies the name of the configured Sequence FlowAction.
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Queue specifies the name of the target queue.

QueueID specifies the internal ID of the target queue.

2.4.5.6.8. TicketResponsibleSet（チケット・責任者・セット）

プロセス・チケットの責任者を変更します。

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Responsible Set root@localhost',
        Module => 'TicketResponsibleSet',
        Config => {
            Responsible => 'root@localhost',
            # or
            ResponsibleID => 1,
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

Responsible specifies the login name of the new responsible.

ResponsibleID specifies the internal ID of the new responsible.

2.4.5.6.9. TicketServiceSet（チケット・サービス・セット）

Assigns a service to a process ticket. The ticket requires to have a customer and the
service must be assigned to that customer. Example:

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Set MyService service',
        Module => 'TicketServiceSet',
        Config => {
            Service   => 'MyService',
            # or
            ServiceID => 123,
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

Service defines the new service of the process ticket. The full name is required (e.g.
GramdFatherService::FatherService::SonService ).

ServiceID defines the internal ID of the new service.

2.4.5.6.10. TicketSLASet（チケット・SLA・セット）

Assigns a service level agreement to a process ticket. The ticket requires to have a service
and the SLA must be assigned to that service. Example:

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Set MySLA SLA',
        Module => 'TicketSLASet',
        Config => {
            SLA   => 'MySLA',
            # or
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            SLAID => 123,
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

SLA defines the new service level agreement of the process ticket.

SLAID defines the internal ID of the new SLA.

2.4.5.6.11. TicketStateSet（チケット・状態・セット）

プロセス・チケットの状態を変更します。

$Self->{'Process::Sequence Flow Action'} = {
    'TA1' => {
        Name   => 'Set State to open',
        Module => 'TicketStateSet',
        Config => {
            State   => 'open',
            # or
            StateID => 4,

            PendingTimeDiff => 123,
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

State defines the new state of the process ticket.

StateID defines the internal ID of the new state.

PendingTimeDiff used only for pending type states, defines the time difference in
seconds relative (relative to the Sequence Flow Action execution time) to set ticket
pending time (e.g. 3600 means that the pending time is 1 hr after the Sequence Flow
Action is executed).

2.4.5.6.12. TicketTitleSet（チケット・タイトル・セット）

プロセス・チケットのチケット・タイトルをセットします。例:

$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Set Ticket Title to Ticket-title',
        Module => 'TicketTitleSet',
        Config => {
            Title => 'Ticket-title',
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

Title specifies the new title of the ticket.

2.4.5.6.13. TicketTypeSet（チケット・タイプ・セット）

チケット・タイプのプロセス・チケットをセットします。例:
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$Self->{'Process::SequenceFlowAction'} = {
    'TA1' => {
        Name   => 'Set Ticket Type to default',
        Module => 'TicketTypeSet',
        Config => {
            Type     => 'default',
            # or
            # TypeID => '1',
        },
    },
};
                        

Name specifies the name of the configured Sequence Flow Action.

Type specifies the name of the ticket type.

TypeID specifies the internal ID of the ticket type.

2.4.6. アクセス・コントロール・リスト(ACL)
With the help of ACLs, you can limit selectable values in process tickets. Please also see
the ACL reference for a description of the full ticket ACL syntax.

2.4.6.1. ACL構成

ACLは単にKernel/Config.pmに定義することができます。例:

$Self->{TicketAcl}->{'001-ACL-ProcessProperties'} = {
    Properties => {
        Process => {
            ProcessEntityID        => ['P1'],
            ActivityEntityID       => ['A1'],
            ActivityDialogEntityID => ['AD1'],
        }
    },
    Possible => {
        ActivityDialog => ['AD1', 'AD3'],
    },
    PossibleNot => {
        ActivityDialog => ['AD3'],
    },
};
                    

2.4.6.2. 001-ACL-ProcessProperties

ACL規則の名前。ACL規則一般についてのさらに詳しい情報については、ACLマニュアルを調べて
ください:

2.4.6.3. プロセス

これはACLが適用されなければいけないかどうかをチェックするために使用されるセクションで
す。それが指定された値を持っている場合、規則が適用されます。次の値は使用することができま
す:

2.4.6.3.1. ProcessEntityID

プロセスのID、プロセス。チケットがこのプロセスに割り当てられる場合マッチします。

2.4.6.3.2. ActivityEntityID

プロセス・チケットが現在割り当てられるアクティビティのID。
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2.4.6.3.3. ActivityDialogEntityID

The ID of the User Task Activity Dialog that is currently open for a process ticket.

2.4.6.4. Possible/PossibleNot User Task Activity Dialog

Here you can specify a list of User Task Activity Dialog IDs. This list will limit the possible
User Task Activity Dialogs that are offered to the user in the ticket zoom mask.

Possible lists the User Task Activity Dialogs that are allowed. The setting above will only
allow AD1 and AD3 of the list of configured User Task Activity Dialogs.

PossibleNot lists the User Task Activity Dialogs that are not allowed. In the example
above, the setting will remove AD3 from the list of configured User Task Activity Dialogs.

If both Possible and PossibleNot are specified, the list of configured User Task Activity
Dialogs will first be filtered by Possible, leaving only AD1 and AD3 in our example. Then
PossibleNot will be applied and filter out AD3, so that only AD1 remains and is shown as
a possible User Task Activity Dialog that the user can use.

If multiple ACL rules match, the intersection of all matching rules will be calculated to
determine the possible User Task Activity Dialogs. Example:

Configured User Task Activity Dialogs: AD1, AD2, AD3, AD4, AD5, AD6, AD7.

$Self->{TicketAcl}->{'001-ACL-Status'} = {
    Properties => {
        Ticket => {
            Status => 'new',
        }
    },
    Possible => {
        ActivityDialog => ['AD1', 'AD2', 'AD3', 'AD6', 'AD7'],
    },
};
$Self->{TicketAcl}->{'002-ACL-Queue'} = {
    Properties => {
        Ticket => {
            Queue => ['Raw']
        }
    },
    Possible => {
        ActivityDialog => ['AD2', 'AD3', 'AD4', 'AD7'],
    },
};
$Self->{TicketAcl}->{'003-ACL-Priority'} = {
    Properties => {
        Ticket => {
            Priority => ['3 normal']
        }
    },
    PossibleNot => {
        ActivityDialog => ['AD3', 'AD4'],
    },
};
                    

If a process ticket has the state new, is in the Raw queue and has a priority 3 normal, then
all three ACL rules will match.

The first rule reduces the User Task Activity Dialogs from AD1, AD2, AD3, AD4, AD5, AD6, AD7
to AD1, AD2, AD3, AD6, AD7 and forbids AD4 and AD5.

The second rule will now further reduce the remaining User Task Activity Dialogs. In our
example, AD2, AD3, AD7 will remain.
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Now the third rule will further reduce the list by PossibleNot. AD3 is removed from the
list. AD4 is not removed, since it was not on the list in the first place. At the end, AD2 and
AD7 remain as possible User Task Activity Dialogs that the user can utilize.

It is also possible to limit the processes that can be displayed in the New process ticket
screen. The functionality is similar to limiting the User Task Activity Dialogs with one
exception: The ACLs could only be based on Users.

以下のサンプルを御覧ください。

$Self->{TicketAcl}->{'200-ACL-Process'} = {
    # match properties
    Properties => {
        User => {
            UserID => [2, 3],
        },
    },
    Possible => {
       Process => ['P1', 'P2', 'P3'],
    },
    PossibleNot => {
        Process => ['P4'],
    },
};
                    

$Self->{TicketAcl}->{'201-ACL-Process'} = {
    # match properties
    Properties => {
        User => {
            Group_rw => [ 'MyGroup' ],
        },
    },
    Possible => {
       Process => ['P1', 'P2', 'P3'],
    },
    PossibleNot => {
        Process => ['P4'],
    },
};
                    

$Self->{TicketAcl}->{'202-ACL-Process'} = {
    # match properties
    Properties => {
        User => {
            Role => [ 'MyRole' ],
        },
    },
    Possible => {
       Process => ['P1', 'P2', 'P3'],
    },
    PossibleNot => {
        Process => ['P4'],
    },
};
                    

2.5. Import Ready2Adopt process
2.5.1. インポート

On the AdminProcessManagement screen you can find an Ready2Adopt Processes widget,
where you can find best practice Ready2Adopt processes. Currently, there is only
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an Application for leave process available, but you can find additional Ready2Adopt
processes in the OTRS Business Solution™.

図5.25 Import Ready2Adopt Processes widget

Select process from the drop-down menu and click on the Import Ready2Adopt process
button. After the process is imported, don't forget to deploy changes.

3. Localization of the OTRS Front End
Procedures for localization for the OTRS framework, steps to be followed to create a new
language translation, as well as procedures for translation customizations, can be found in
the "Language Translations" chapter from the developer manual on http://otrs.github.io/
doc.
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第6章 機能
1. The Appointment Calendar
1.1. 導入
1.1.1. 機能

Appointment calendar feature provides a calendar implementation that allows agents to
manage and display multiple calendars and their appointments.

1.1.1.1. Management of multiple calendars

Via a management interface it is possible to add and edit calendars.

Beside calendar names, it is possible to assign colors and access groups, as well as the
current validity of the calendars.

1.1.1.2. Exports and imports

Once different calendars are created, it is possible to export either the complete calendar
definition (including the calendar appointments) in the well-known YAML format or just
export the related appointments of a calendar to ICS format.

It is also possible to import complete calendar structures using previously exported YAML
files to restore calendar definitions or import just calendar appointments to an existing
calendar using ICS file uploads.

That offers the possibility to backup and restore single calendars or transfer them to a
different OTRS installation or an external calendar tool.

1.1.1.3. Management of calendar appointments

If at least one calendar is created and accessible by a certain agent, new or already
existing appointments can be managed via a calendar overview and an agenda overview.

Within the calendar overview, an agent is able to display, create, edit and/or delete
appointments of different calendars, depending on their permission level to the related
calendars. Such appointments can be created or edited via drag and drop within this
screen.

The visibility of single calendars can be enabled or disabled through the calendar list
within the screen.

To have a good overview of available appointments within different calendars and the
related dates they start or end, it is possible to select different view modes, like weekly
view, monthly view, different timeline related views etc.

Within the agenda overview, an agent is able to display the appointments of all available
(accessible) calendars in a table-like overview. This overview is designed to have a
detailed list of upcoming appointments in a structured table. Like in the calendar
overview, appointments can be created, edited or deleted. This view supports a monthly,
weekly and daily point of view on available appointments.

1.1.1.4. Repeating appointments

If recurring appointments needs to be archived, it is possible to setup detailed information
about the occurrences of a single appointment.
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Beside pre-defined frequencies like daily, weekly, monthly etc. it is possible to setup
custom repeats and exclude weekdays or dates of months, define the amount of
recurrences and/or the end date after the appointment stops to repeat.

1.1.1.5. 通知

Within the edit screen of an appointment, it is possible to setup a date to notify about
the appointment.

As in the settings for appointment repeat, it is possible to use pre-defined templates for
notifications (i.e. 5 minutes before, 15 minutes before etc.) or setup a custom point of
time.

The custom settings for notifications allows to setup a relative point of time (like 5 minutes
after the appointment has been started) or an explicit date/time expression.

1.1.1.6. Event-based appointment/calendar notifications

As in the well-known ticket notifications, this package comes up with an event based
notification mechanism, that can be handled using an administration interface. Within
that interface, notification event entries can be created, updated and/or deleted to react
on different OTRS events with related filters, recipients and content templates.

The content of notifications can be dynamically filled-up using OTRS smart tags, like in
the event based ticket notifications.

1.1.1.7. Managed ticket appointments

This package offers the possibility to automatically create and update appointments in
calendars based on ticket data, using special rules defined within the calendar edit screen.
Any ticket date/time value (i.e. pending time, escalation times or dynamic fields) can be
used to define appointment start and end dates.

1.1.1.8. Link tickets to appointments

Within the edit screen of an appointment, it is possible link existing tickets.

Tickets can be searched by their ticket numbers and/or titles.

Links between tickets and appointments appear in the ticket zoom like every other linked
objects in a related table.

Those links can either be created through an existing appointment, using the overviews
or via the link feature in the ticket zoom.

It's also possible to create a new appointment out of the ticket zoom, which links the
related ticket automatically to the new appointment.

1.1.1.9. Dashboard widget for upcoming appointments

Every agent can activate a dashboard widget Appointments in the dashboard.

This widget shows the upcoming appointments of the different calendars for today,
tomorrow and the next 5 days.

1.2. Usage
1.2.1. カレンダー管理

Via a management interface it is possible to add and edit calendars.
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図6.1 Calendar management overview

If a new calendar needs to be created or edited, it's necessary to define a calendar name,
a color and the permission group the calendar belongs to. This is needed for agents to
access the calendar properly with the related permissions.

図6.2 Calendar edit screen

The color can be selected with the built-in color picker, like in the following screenshot.
There are three ways to select a color with the color picker. After clicking on the
preselected color, a window opens with a set of pre-defined colors ready to be used. If your
preferred color is not available, you can click on the More button to open the advanced
mode.

図6.3 Color picker in calendar edit screen

Within that mode, you can either select a certain color by using the color bar and the
color field with your mouse or you're able to directly use a hexadecimal code of a desired
color. By clicking on the Less button, you can shrink the color picker back again to the
standard mode. Right after a click on the Confirm button, the new color is selected and
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visible in the preview field. Even if you selected a certain color within the advanced mode,
the previous color will be selected again (and visible in the preview field) if you click on
the Cancel button, but this just works if you didn't confirmed your selection yet. If that's
the case (but you did not save the calendar yet), you may just reload your screen and
see you current color setting again.

For the selected permission group of your calendar, an agent who should have access to,
needs at least a read permission within the related group. Enclosed is a list of permissions
to access certain feature-levels within the different calendars:

RO

The related agent can see the calendar and its appointments, but can't do any
changes.

MOVE_INTO

The related agent can update existing appointments, but can't create new ones or
delete existing ones.

CREATE

The related agent can create new appointments.

RW

The related agent is able to delete appointments.

The validity field indicates if a calendar is valid. Invalid calendars won't show up in the
different overviews, even if agents have access to it.

1.2.2. Exporting calendars and/or appointments
Once different calendars are created, it is possible to export either the complete calendar
definition (including the calendar appointments) in the well-known YAML format or just
export the related appointments of a calendar to ICS format.

To export a complete calendar structure to the YAML format, the calendar list in the
calendar management screen can be used. By clicking on the related link within column
Export, a YAML structure named Export_Calendar_CalendarName.yml, including the
calendar meta-data (calendar name, color, permission group, validity state) can be
downloaded. The structure also includes all calendar appointments. This functionality can
be used to simply backup a certain calendar and/or transfer it to a foreign OTRS instance.

To export just the calendar appointments in ICS format, the link within column Download
can be used. After clicking on the related link, an ICS file named CalendarName.ics can
be downloaded, including all appointments of the related calendar. This file can be used to
backup just the appointments of a certain calendar and/or transfer it to either an existing
calendar on a foreign OTRS instance or any other calendar tool, which supports the ICS
standard, to display the appointments.

1.2.3. Importing calendars and/or appointments
As an equivalent to the export function, it is possible to either import a complete calendar
structure including related appointments in the YAML format, or just a set of appointments
to an already existing calendar in the ICS format.

To import a complete calendar structure, the related Calendar Import widget on the left
side of the calendar management screen can be used. Within this widget, a YML file can be
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selected and uploaded to import the calendar. The checkbox Overwrite existing entities
indicates if a calendar with the same name as the imported one should be overwritten.
If a calendar with the same name exists, but the checkbox is empty during the upload,
a related error message will be displayed.

To import a set of appointments to an already existing calendar, the Import Appointments
button can be clicked to access the appointment import screen.

図6.4 Appointment import in calendar management overview

Here it's needed to select an ICS file to be used for the import. Right after that, a
calendar needs to be selected from the related list to import the new appointments in. The
checkbox Update existing appointments indicates, if already existing appointments with
the same UniqueID shall be overwritten or not. Appointments with the same UniqueID but
already existing in the related calendar won't be omitted during the import process. They
will be inserted again and will be available multiple times in case of doubt, if the option
to overwrite appointments is not enabled.

1.2.4. カレンダー表示
If at least one calendar is created and accessible by a certain agent, new or already
existing appointments can be managed via a calendar overview and an agenda overview.

Within the calendar overview, an agent is able to display, create, edit and/or delete
appointments of different calendars, depending on their permission level to the related
calendars, as described above.

図6.5 Calendar overview screen

As visible in the following screenshot, the calendar overview contains the management
tools for the calendars and appointments on the left side and the calendar view on the
right side. With the buttons in the Actions widget it's possible to either access the calendar
management directly or add a new appointment (if the agent has the permission).

267



図6.6 Sidebar in calendar overview screen

The Calendars widget contains all calendars accessible by the agent. The checkboxes are
used to enable or disable the view of certain calendars, like it's the case in many foreign
calendar tools.

Since all appointments of any active calendar for every agent will be provided by the
server (and not stored or cached on the client), it can result in heavy load on the server if
too many calendars are active at the same time. Therefore a system configuration option
AppointmentCalendar::CalendarLimitOverview limits the maximum number of active
calendars per agent. If the limit is reached by an agent, a related error message will be
displayed, indicating there are too many active calendars.

The URL column provides an external link to the calendar, which is used to subscribe. This
functionality is described later in this document.

To have a good overview of available appointments within different calendars and the
related dates the appointments start or end, we provide different view modes to be used
by the agents.
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図6.7 View modes in calendar overview screen

They are separated in timeline modes and non-timeline modes with different time ranges,
to have the best view on different appointments for the related situations. On most of the
view modes, a red line indicates the current time of the current day.

The information in the middle of the top-bar shows the current time range the agent is in,
for the current view. Within the timeline views, the current calendar week will be displayed
in light gray, when possible. Within the non-timeline views, the current calendar week is
displayed as a single column on the left side, if possible.

Enclosed a screenshot of the non-timeline weekly view:

図6.8 Weekly view in calendar overview screen

and the non-timeline monthly view:
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図6.9 Monthly view in calendar overview screen

On the upper right side, the agents can access the navigation controls.

図6.10 Navigation controls in calendar overview screen

The left- and right-arrow buttons are used to navigate through the dates of the current
time range. The Today button brings the agent back to the current date to save time.

The Jump button is used to access a certain date directly without a need to go every date
in between to access a certain date (maybe one year earlier or later). A click on the button
opens a date picker, which highlights all dates which have already appointments stored.
A mouseover shows the number of appointments with to the current date. A click on a
date brings the agent to the related time range and displays all appointments.

図6.11 Today and Jump buttons in calendar overview screen

On the right side of the main widget (on top of the navigation buttons) a gear wheel
appears on mouse over, which is used to access a visibility filter:
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図6.12 User preferences for calendar overview screen

Here you can choose, if you want to see all available appointments, or just the ones that
are directly assigned to you.

1.2.5. アジェンダ表示
Within the agenda overview, an agent is able to display the appointments of all available
(accessible) calendars in a table-like overview. This overview is designed to have a
detailed list of upcoming appointments in a structured table. Like in the calendar overview
appointments can be created, edited or deleted. This view supports a monthly, weekly
and daily point of view on available appointments.

図6.13 Agenda overview screen

1.2.6. Management of calendar appointments
Within the calendar overview, to add new appointments it's either possible to click on the
Add Appointment button or click on the overview widget. It's also possible to drag over a
range of the widget to setup a rough time span. Right after that, a modal dialog appears
where the data can be inserted:
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図6.14 Appointment edit screen

The only mandatory fields of the basic information are the appointment title and
the related calendar to assign the appointment to. The description and location
are optional fields. If the location contains a value, a related link icon will show
up next to the field which by default links to Google map to get a better picture
of the location. This link is configurable through the system configuration option
AgentAppointmentEdit::Location::Link.

Within the Date/Time section, the related start date and end date needs to be selected.

The All-day checkbox indicates that the appointment takes place on the whole day. If it's
activated, time of the start date and the end date will be disabled and set to 00:00.
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The Repeat option is used to define appointment recurrences and will be described
separately, see section Repeating appointments below.

The Notification option is used to define appointment notifications and will be described
separately, see section Notifications below.

The Link option is used to define appointment links to foreign objects (like tickets) and
will be described separately, see section Link tickets to appointments below.

If the appointment already exists, the Copy and Delete buttons appear at the bottom
of the modal dialog, provided that the current agent has the related permissions. The
Copy button will just ignore the changes in the dialog and create a copy of the current
appointment at the same time range with same information. The Delete button will delete
related appointment, but the agent will face a question if they are really sure they want
to delete the appointment, for security reasons.

Once the appointment has been saved, it appears in the overview of the page:

図6.15 Appointment display in calendar overview screen

With a click on the appointment, the modal dialog opens again and appointment can be
edited. If the agent has the correct permission, the appointment can also be edited via
drag and drop to either move the complete appointment to another place (date/time) or
just increase/decrease the start- and/or the end-time by dragging the appointment on the
related handles on the left or the right end.

If the cursor of the mouse hovers over a certain appointment, a tooltip with the related
appointment information appears:
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図6.16 Appointment tooltip

1.2.7. Repeating appointments
If appointments needs to be created in a recurring manner, it is possible to setup detailed
information about the occurrences of an appointment.

For this to work it is either possible to use pre-defined frequencies of the occurrences, or
to define custom settings:

図6.17 Edit screen of a repeating appointment
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After the selection is finished, it's necessary to define the runtime of the recurrences. It's
possible to choose either a date to repeat until, or an amount of times to repeat.

After all decisions are made and the settings are saved successfully, the appointment will
be marked a recurring appointment. The parent appointment will be marked with circle-
arrow-symbol and the child appointments with a chain-symbol.

図6.18 Repeating appointments in calendar overview screen

Future changes to the parent appointment will affect the children automatically, without
any further message. If an agent is about to change one of the child appointments, a
message will ask what would they like to update:

図6.19 Edit screen of a repeating child appointment

If the update affects all appointments, the behavior will be the same as with the update
of the parent appointment. All options (including the recurring settings) are changeable.

If just the current (child) occurrence is affected, it's not possible to change the repeating
settings, but a related message and a link to the parent appointment will be provided:

図6.20 Repeating settings of a child appointment

The enabled repeating option will be additionally displayed in the tooltip of the related
appointment(s).

1.2.8. 通知
Within the edit screen of an appointment, it is possible to setup a date to notify about the
appointment. As in the settings for appointment repeat, it is possible to use pre-defined
templates for notifications (i.e. 5 minutes before, 15 minutes before etc.) or to setup a
custom point of time:
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図6.21 Notification settings in appointment edit screen

The custom settings for notifications are split into a relative point of time (like 5 minutes
after the appointment has been started, 2 hours before the appointment ends etc.) and
an explicit date time value, which can additionally be selected with a date picker. The
related section needs to be enabled with a radio button, hence the disabled section will
be ignored.

If an appointment has an active notification setting, the date/time string of the notification
will be displayed in the tooltip. In addition to that, the appointment will be marked with
a bell-symbol to indicate that there is an active notification set, without any mouse over
actions.

1.2.9. Event-based appointment/calendar notifications
As in the well-known ticket notifications, this package comes up with an event based
notification mechanism, that can be handled using an administration interface. Within
that interface, notification event entries can be created, updated and/or deleted to react
on different OTRS events with related filters, recipients and content templates.

During the installation of the package, one default entry Appointment reminder
notification will be installed.

The management frontend for notification templates can be reached using the
administration menu:
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図6.22 Calendar/Appointment notification management link

In the notification overview, all available notification templates can be displayed. Within
that overview, such templates can be created, edited, imported/exported and, of course,
deleted.

図6.23 Calendar/Appointment notification management overview

From the left sidebar, notification entries can either be created, exported or imported.
The complete set of available entries can be exported, or an already exported file can be
used to import notification entries.

図6.24 Sidebar in calendar/appointment notification overview
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The main table on the right side will display the available appointment notifications. For
each line, the related entry can be edited by clicking on the name column, exported with
a click on the export icon, copied with a click on the copy icon or even deleted. All icons
relates just to the single entries (not like the export notifications button in the sidebar).

図6.25 Table in calendar/appointment notification overview

In order to create a new or update an existing entry, edit screen can be used, same as in
the ticket notifications. Within that screen, it is needed to define some basic parameters,
like a name, which needs to be unique for the OTRS system (it cannot even conflict with
a name from the ticket notifications).

Each notification entry can be made selectable as an option in the agent preferences.
Optionally, a tooltip message for the related notification entry in the user preferences can
be inserted, which will be displayed to the user on mouse over.

If needed, a comment for the entry can be added which will be displayed in the overview
screen of the administration interface. Last but not least, the validity state can be selected
(valid by default).

To let the template react on OTRS events, at least one of the available events need to be
selected from the list in Events widget.

図6.26 Event definition for calendar/appointment notifications

Enclosed is a list of possible events with description:

AppointmentCreate

Executed after an appointment has been created.

AppointmentUpdate

Executed after an appointment has been updated.

AppointmentDelete

Executed after an appointment has been deleted.

AppointmentNotification

This is a special appointment event that will be executed by the OTRS daemon in time.
If an appointment contains a date/time value for notifications, as already described
in this documentation, and such a notification date is reached, the OTRS daemon
will execute the event AppointmentNotification for every related appointment
separately.

CalendarCreate

Executed after a calendar has been created.

CalendarUpdate

Executed after a calendar has been updated.
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The appointment filter widget can optionally be used to narrow the list of appointments
by matching configured values:

図6.27 Filter settings in calendar/appointment notifications

For example, here it's possible to select which calendar the related appointment needs
to be part of, or a part or complete title or location of the appointment. Also, it's possible
to choose from a list of teams or resources assigned to the appointments (available only
with OTRS Business Solution™).

Within the Recipient widget, the related recipients can be selected which would receive
generated notifications.

図6.28 Recipient settings in calendar/appointment notifications

All resource related list entries are available only with OTRS Business Solution™.

Within the Notification Methods widget, an available transport can be selected (Email,
SMS or Web View), as well as additional recipients and email templates.

図6.29 Notification methods in calendar/appointment notifications
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The main content of a notification can be defined in the localized subject and the body
fields. Here it's possible to define static text content mixed with OTRS smart tags, if
needed. The default notification entry shows how such a body and subject can look like.

図6.30 Notification body in calendar/appointment notifications

A full list of available smart tags is provided in the Tag Reference widget at the bottom
of the page.

For every added notification entry which has the option Show in agent preferences
enabled, a new option will be displayed in the related user preferences widget of every
agent. With these options, every agent can select which types of notifications and by
which available transport method they want to receive.

図6.31 Show in agent preferences option in calendar/appointment
notifications

1.2.10. Link tickets to appointments
The appointment calendar comes with an abstraction layer to link external objects with
appointments, using the OTRS internal link object. Those additional objects can come
up with external packages without any further need to update the code of the calendar
directly.

Basically, within the edit screen of an appointment it is possible to link existing tickets.
Tickets can be searched by their ticket numbers and/or ticket titles via an autocompletion
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field. Once the agent clicks on a result, the related ticket will be saved in a result box and
after the appointment has been saved, the ticket will be linked to the appointment.

図6.32 Ticket link option in appointment edit screen

Additionally, it's possible to link multiple tickets to one appointment. Since the normal
OTRS link object is used to create the connection between both objects, the link will be
displayed in the ticket zoom screen as well.

図6.33 Linked appointments table in ticket zoom screen

Those links can either be created through an existing appointment in the related edit
dialog, using the overviews or via the link feature in the ticket zoom.

図6.34 Appointment linking from ticket zoom screen

Via the ticket zoom screen, it's additionally possible to create a new appointment, which
links the related ticket automatically to the newly created appointment. There is a new
option New Appointment located in the ticket action menu Miscellaneous.
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図6.35 New appointment link in ticket zoom screen

After a click on the link, the agent will be forwarded to the calendar overview, which
automatically opens a new appointment dialog, that has the related ticket pre-linked and
can be filled out as usual.

1.2.11. Managed ticket appointments
To make a step back to the calendar management, the package offers the possibility to
automatically create and update appointments in calendars, using a special ticket search
rule within the calendar edit screen.

Tickets can have special date/time entries like pending times, escalation times (first
response time, update time etc.) or assigned dynamic field from type date/time.
Logically, the calendars are able to show those date/time entries, but since the calendar
appointments needs to have time ranges consisting of a start time and an end time, it's
needed to define a related end time for managed appointments, as times like the pending
time points to just a single date/time value.

Below the basic calendar configuration in the calendar edit screen, a special widget called
Ticket Appointments takes care about the rules to be used for automatic appointment
creation.

図6.36 Ticket appointments configuration in calendar edit screen

It's necessary to define rules to describe a ticket search for tickets, which will result in
automatically created and managed appointments in the related calendar. It's possible to
define multiple rules with different parameters to combine several types of tickets within
the same calendar.

A rule consists of the following parameters to generate proper ticket searches:
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開始日

A dropdown list, that indicates the special date/time value of the related tickets. This
can be either the pending time, the different escalation times or a dynamic field from
type date/time assigned to the ticket.

終了日時

This can be a relative time value, counted from the selected start time (like +5
minutes, +1 hour etc.) or a dynamic field from type date/time, pointing to an absolute
date and time value.

キュー

A multi-selectable dropdown list, that indicates the queues the related tickets needs
to be located in. This field is mandatory and can't be left unfilled.

検索属性

This is a list of additional (optional) search attributes to provide more detailed filter
possibilities to the agent. It acts like the search attributes in ticket search screen of
the agent interface. Single attributes can be selected, added to the form and filled
out with filter values.

An overview of the configuration for such a rule looks as follows:

図6.37 Ticket appointment rule in calendar edit screen

The rule in the screenshot will find all tickets that have a pending time and would add
one hour to the related pending time to generate the end time and create appointments
for the set of found tickets during the search. The tickets additionally needs to be located
in queue Raw.

An example of an automatically added appointment looks as follows:
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図6.38 Ticket appointment in calendar overview screen

The P symbol indicates that this appointment includes a pending time as the start time
value. The end time value is a dynamic field from type date/time in this example to display
a bigger appointment for that test purpose.

Special appointments of different types will be marked with related symbols:

P

Appointments of tickets with pending time as the start time.

E

Appointments of tickets with escalation times as the start time (first response time,
update time, solution time).

D

Appointments of tickets with a dynamic field from type date/time as the start time.

The edit screen of such a special appointment looks as follows:
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図6.39 Edit screen of a ticket appointment

The appointment title will be displayed as ticket number and title and cannot be changed,
since it's automatically created, updated and removed, depending on the related ticket.
Title will be displayed as a link to the related ticket zoom screen.

Of course, it's still possible to define basic information like a description and a location,
which will be stored for that single appointment. For such appointments it's also possible
to define notification times and link additional tickets.

Some of those start time values are variable and therefore updatable by the related agent
and some are not.
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For instance the pending time is a value that can be changed using the pending ticket
action in the ticket zoom of the related ticket. Dynamic field values can be changed easily,
too.

An escalation value like first response time or the update time are special values which
will be computed using a Service / SLA entry assigned to the related ticket.

If, for instance, an automatically created appointment of type pending time is changed
using the calendar overview, the related value will be updated in the ticket as well, which
is the same behavior as for special appointments of type dynamic field. Therefore it's
either possible to update the related ticket using the ticket zoom, or by just updating the
appointment that writes back all needed changes to the ticket.

Appointments from type escalation time cannot be updated using the related
appointments, as those values are not changeable directly by the agent. Such
appointments are simply read-only on the related values, as well as on the drag and drop
features/handles.

On every update on the calendar definition or the related tickets, the automatically
created appointments will be updated as well. This work will be done by the OTRS daemon
in the background. Therefore, it's necessary to have the daemon running for this feature
to work properly!

1.2.12. Dashboard widget for upcoming appointments
To have a quick overview about upcoming appointments, it's possible to enable a
dashboard widget called Appointments.

図6.40 Today filter in upcoming appointments dashboard widget

This widget displays upcoming appointments of every accessible calendar by the agent
in a simplified manner.

It offers the possibility to create new appointments with a click on the New Appointment
button, which forwards the agent to the calendar overview screen and opens a new
appointment dialog.

The widget content consists of three filter entries:

本日

Displays upcoming appointments for the current date.
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翌日

Displays upcoming appointments for the next day.

すぐに

Soon means the next five days, excluding today and tomorrow.

Like in the other dashboard widgets, the agent can switch between the filters by clicking
on the filter name:

図6.41 Soon filter in upcoming appointments dashboard widget

Since the appointment information is simplified and needs to be compact in order to be
displayed properly in the small widget, it's possible to show more detailed information
about every value in the related tooltip while hovering over the column, as visible in the
previous screenshot.

Basically just the color of the related calendar, the start time of the appointment and the
appointment title will be displayed to the agent. On hovering over the related column,
further information will be displayed if needed. If the agent clicks on such an appointment,
the browser redirects to the calendar overview screen and opens the related appointment
to show the full set of information.

2. The Ticket Timeline View
2.1. 摘要

The ticket timeline view provides a chronological view of all actions which happened on
a ticket (which includes articles, owner changes, incoming mails, etc). With the ticket
timeline view, agents are able to get a good overview of a ticket in less time.

2.2. 構成
システム構成

NoTimelineViewAutoArticle

Navigation: Frontend::Agent

Disables automatic opening of the last customer article in the timeline view in
AgentTicketZoom.
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2.3. Usage
図6.42 Switching to the Ticket Timeline View

To access the ticket timeline view, use the gear icon in the top right corner of the article
widget in the ticket zoom screen. You will be redirected to the timeline view and this view
will be kept as a preference until you change back to another view.

In the ticket timeline view, you can work on the ticket as you're used to. You can inspect
the time of each event in the timeline by hovering the little square next to each event
with your mouse cursor. You can view the full content of articles by using the zoom icon
on top of the certain articles box, where you will find all common article actions such as
Reply, Split, Forward, etc.

図6.43 Using the Ticket Timeline View
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3. The Article Attachment Overview
3.1. 摘要

The article attachment overview enables you to view a list of all attachments in a ticket.
Attachments will be listed by attributes such as file name, file type, file size, date of
addition and which article they belong to. From the overview screen, you can download
certain attachments or create an archive file which contains multiple or all attachments
of the ticket you're viewing.

3.2. 構成
No further configuration needed.

3.3. Usage
図6.44 Switching to the article attachment overview

Once a ticket has at least one attachment, a new menu entry, Attachments, will appear
under the 'Miscellaneous' menu cluster. Clicking it will open a popup which contains a list
of all attachments.

図6.45 Using the article attachment overview
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4. System Configuration User Specific
Settings
4.1. 摘要

This functionality allows agent users to define their own values for some system
configuration settings. These values can be defined in the user preferences section in the
new Advanced pane.

Administrators are able to review the user defined values for those settings and reset
them if necessary and to forbid or allow user modifications on specific settings.

4.2. 構成
No further configuration needed.

4.3. Usage
4.3.1. Set user specific value

Every agent can define a value for a setting using the Personal preferences screen. Once
you are in this screen, select the Advanced option in the preferences panel.

図6.46 Accessing the user specific settings

Using the navigation widget in the left side bar, select the desired group of settings. Then
you can change the value for a specific setting and save it using the check mark button
in the right side of the setting widget.

Once you modified a value, it is possible to revert this change using the Reset to default
icon button present in the right top corner of the modified setting widget.

図6.47 Reverting a setting to default value

4.3.2. Review user specific settings
When a setting is available for user modification, all users are able to set their own values.
Depending on the nature of the setting, values can be very different among users, and
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also compared to the original global value. OTRS includes an administrative tool to review
and delete user set values if needed.

Click on the Show user settings button from the alternative menu on the settings that are
enabled to show the Review users setting values screen.

図6.48 Access to user values of a particular setting

On this screen all of the user specific values for the selected setting will be shown. To
delete a single value click on the trash can icon in the right corner of every setting widget,
or delete all user values for this setting by clicking on the trash icon in the outer setting
widget.

図6.49 Usage of the user specific values screen

4.3.3. Reset globally and locally
For the settings that are enabled to hold user values Reset setting button will either reset
the setting completely or just the user values.

図6.50 Access to the setting reset dialog

Clicking on the Reset setting button will display a dialog showing the possible reset
options.
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図6.51 Choosing the reset scope

5. Notification Methods
5.1. 摘要

Ticket and appointment calendar notifications can be sent to their recipients using one
or multiple methods. Every notification can activate its preferred method to be sent, and
by default all notifications are sent using the email method, where the information about
the notification is embedded into an email for the recipient.

However, OTRS offers more transportation methods to send the notifications, please take
a look below for their configuration and usage.

5.2. Notification Web View
This transportation method is only intended for agents and instead of actually sending the
notifications in any form, they are stored in the system database in order to be displayed
in an special screen in the agent interface.

5.2.1. Setting up and Using the Notification Web View
To set up the notification web view for agents, it's just as simple as clicking on its activation
check-box for every notification.

図6.52 Enabling the Notification Web View

Once you've enabled the notification web view for a certain notification, agents will see a
new icon on top of their screen in OTRS (within the tool-bar) every time a new notification
arrives.
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図6.53 Notification Web View Icon on the Tool-bar

Clicking this icon, agents will get an overview of all of their notifications where they can
read and dismiss them.

図6.54 Notification Web View Overview

図6.55 Notification Web View Detail

5.3. SMS Notifications
SMS notification is technically a notification method besides the existing email method
and can be activated for each notification (e.g. Ticket new note notification or Ticket
create notification) on the Notification Event screen in the Admin interface.

5.3.1. Setting up SMS Notifications
Before taking advantage of SMS notification transport method, you must first activate the
SMS cloud service.

In order to use SMS as a way of notification for users and customers, you have to buy an
SMS unit package. Please get in touch with sales@otrs.com on this matter. Once you've
bought a package, you will be able to look up your current contingent of remaining SMS
units on the admin screen for the SMS cloud service.

To make SMS available for notifications, you have to enable it for the notification of your
choice in Ticket Notification or Appointment Notification screen in the Admin interface.
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Besides the existing Email notification method, you can enable SMS notifications by
enabling the checkbox as to be seen in the screenshot below.

Please be careful using the Send by default checkbox on SMS notifications. Enabling this
checkbox will cause this notification to be sent by SMS to all agents with a phone number
stored in the configured field. This could cause a high usage of your available SMS units!

On this screen, you can also add more generic phone numbers (e.g. for archiving
purposes) which will receive all of the relevant notifications (besides the addressed
agents). Please note that all of these recipients will be treated as customers (regarding
article creation).

図6.56 Enabling SMS Notifications

If you configured a notification to be visible in the agent preferences, agents will now be
able to enable/disable SMS notifications manually on their own for this notification.

図6.57 Agent Preferences SMS Notification Settings

SMS notification text will be constructed on fly by combining both Subject and Text fields
of the corresponding language. You can of course use supported OTRS tags in these fields,
and additionally URLs can be shortened by activating URL shortening option in cloud
service configuration.

図6.58 SMS Notification Text Fields

6. The SLA Field Selection Dialog
6.1. 摘要

The field selection dialog enables you to configure alert messages customers should see
when they select specific SLAs on ticket creation on the customer frontend. These popup
messages could contain information about the SLA the customer is about to select and
to give them the possibility to re-think their decision.

6.2. 構成
No further configuration needed.
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6.3. Usage
6.3.1. Configuring the SLA message

図6.59 SLA configuration

You can configure the message on each SLA by using the SLA administration screen.

6.3.2. How the message looks in the customer
frontend

図6.60 SLA message

This is what the customer will see once he selects the SLA this message is configured
for. He can either confirm or deny his selection, the latter one will reset the SLA selection
afterwards.

7. SMS Communication Channel
7.1. 摘要

This feature brings another communication channel to your OTRS instance: SMS (Short
Message Service). It allows you to leverage SMS cloud service to send out messages and
store them as article in tickets.

7.2. Activating SMS Cloud Service
Before taking advantage of SMS cloud service, you must first activate it. To do so, please
visit the Cloud Services screen in Admin interface, and click on SMS entry in table.

図6.61 Cloud Services Screen in Admin Interface
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注記

In order to use SMS cloud service, you have to buy an SMS unit package. Please
get in touch with sales@otrs.com on this matter. Once you've bought a package,
you will be able to look up your current contingent of remaining SMS units in the
sidebar of the cloud service configuration screen.

To activate SMS cloud service, make sure to accept the Data Protection agreement by
selecting the checkbox.

図6.62 Activating SMS Cloud Service

On this screen, you can also set up some additional parameters of the SMS cloud service,
e.g. the sender string which should be used for the SMS text messages or the agent/
customer preference field name which should be used to take the mobile phone number
from.

注記

If you change value for the customer preference field, make sure to update the
configuration options of the address book in the system configuration to reflect
this change:

• CustomerUser::Frontend::AgentCustomerUserAddressBook###SearchParameters###SMS

• CustomerUser::Frontend::AgentCustomerUserAddressBook###DefaultFields###SMS

• CustomerUser::Frontend::AgentCustomerUserAddressBook###ShowColumns###SMS

This will make sure your configuration stays in sync and phone numbers can be
found/copied from correct fields.

Allowed role members is an optional white list of agent roles whose members will be able
to receive SMS notifications. If undefined, all agents will have a possibility of receiving
SMS notifications.

Perform URL shortening checkbox controls the feature of shortening links in SMS texts.
If enabled, any link submitted as part of SMS text will be shortened by using OTRS cloud
URL shortening service. Links will be shortened only if their length is larger than resulting
shortened URL, in order to keep SMS costs down.

By adding specific phone numbers to the Phone black list, you can make sure these
numbers will never receive any SMS text via cloud service (whether it's a notification or
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an article). Make sure to input phone numbers in international format, complete with plus
sign (+) and country code, without any spaces.

7.3. Configuring SMS Templates
In order to benefit from SMS templates, you must first configure them for specific screens
and assign them to correct queues. You can find SMS template management screen in
the Admin interface.

図6.63 Manage SMS Templates

SMS templates behave similar to regular email templates. You define them first, and then
assign to queues with which you would like to use them.

Template Type field determines for which screen the template will be visible:

Answer

Template will be visible for Reply via SMS article action.

Create

Template will be visible in New SMS ticket screen.

SMSOutbound

Template will be visible in SMS Outbound screen.

注記

Create type templates only supports these smart tags: <OTRS_CURRENT_*> and
<OTRS_CONFIG_*>.

When you define an SMS template, don't forget to add them to queues. You can do this by
following link in the sidebar or via SMS Templates ↔ Queues link in the admin interface.

図6.64 Manage SMS Templates

7.4. Creating SMS Tickets
To create a ticket with SMS article as a first one, please go to the New SMS ticket screen
accessible via Tickets menu on the main tool-bar.
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図6.65 New SMS Ticket Screen

This screen behaves similar to new email and phone screens, with some notable
exceptions. Instead of email addresses, Recipients field accepts only phone numbers in
international format, complete with plus sign (+) and country code. You can also search
for customer users via this field, provided they have a valid phone number stored in
preference field which is configured in cloud service configuration screen.

You may also utilize address book by clicking on small icon next to the recipients field.
Search form will allow you to find customer user you are looking for, and add their phone
number to the list of recipients.

注記

Ticket Title field will not be included in SMS and is for internal use only. Customer
will receive message based exclusively on the contents of the Text field.

If you have configured SMS templates of type Create, and you have them assigned to
currently chosen Queue, you will have the option of populating the Text field with pre-
configured message.

Flash message checkbox controls if message will be showed directly on the device without
user interaction and not stored automatically.

注記

Support for flash messages (also known as Class 0 messages) may vary by device
and provider. OTRS cannot guarantee if this flag will be honored by service provider
or supported by receiving device.

By clicking Send SMS button, ticket will be created with an SMS article, provided SMS
cloud service accepted the message. If any errors were encountered, you will be notified,
and ticket will not be created.

7.5. Creating SMS Articles
To add an SMS to an existing ticket, you can use SMS Outbound action on the main ticket
tool-bar (Communication section).
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図6.66 New SMS Ticket Screen

If you already have an article, you can also use Reply via SMS action on the article tool-
bar. Simply select the article in question, and either click on the button, or choose name
of the template (if you have it configured for this screen).

図6.67 New SMS Ticket Screen

If customer user has defined phone number, it will be automatically inserted in the
recipients list. It doesn't matter if article was created in a different communication channel
(e.g. Email), it should be correctly recognized and substituted with valid phone number.

注記
Please note that SMS character counter might not be reflecting the final message
size. This is especially true if message text contains OTRS tags or links and URL
shorting feature is turned on. Since text replacement will occur during sending of
the message, there is no way to guarantee final size, and counter should be taken
only for informative purposes.

7.6. Displaying SMS Articles
SMS articles can be displayed as they were sent out right in the ticket zoom screen. Their
contents will reflect the final state of the message as queued by the SMS cloud service
for sending (with all tags replaced and links shortened).

Recipients of an SMS article are listed inside the Recipients field. They can be shown in two
formats: just phone numbers or phone numbers with name of corresponding customer
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users. In addition to this field, Transaction Numbers will contain a reference message
ID mapped to the recipients phone number. These numbers can be used for debugging
purposes, since they can be connected to specific messages handled by the cloud service.

図6.68 SMS Article Display

In addition to the article header field, transaction numbers can also be found in Ticket
History screen. This screen will contain an entry for every message sent out via SMS cloud
service, with corresponding transaction and phone number in it.

図6.69 SMS Ticket History Entries

8. The Dynamic Field Contact with
Data

This feature allows to add contacts with data to tickets.

8.1. 摘要
8.1.1. Definition of Data Sources

The data sources for this feature reside on the Dynamic Fields of the new Contact with
data type, this mean that each dynamic field of this type is a new data source. The name
of the dynamic field will become the name of the data source, as they are both the same.

For each data source (dynamic field) a list of contact attributes can be defined (each
attribute can contain only one text based value). The contact attributes can be set as
mandatory and searchable if needed. The sort order of the attributes can be also defined.

Contact attributes for each data source could contain any information about the contact
as needed, such as different addresses, telephone, birthday, anniversaries, favorite food,
hobbies, etc.
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注記
The attributes Name and ValidID are always mandatory and they are not
automatically added, so for each new data source these attributes must be added
manually.

Within the data source definition (or dynamic field configuration) they must be
represented by the keys Name and ValidID respectively while the values could be
Name and Validity for example.

8.1.2. Contact Management
After having at least one data source (Contact with data Dynamic Field) defined, contacts
information can be added to the source to populate it.

Apart from the Name and ValidID, each data source could contain different contact
information as defined by the data source (e.g. a data source could have an E-mail field
while another could contain Telephone and/or Mobile fields).

The management (adding or updating) contact for the data sources is done by an special
screen that can be called from the Ticket menu (Edit contacts with data) in the main
navigation bar.

8.1.3. Adding Contacts to Tickets
For each configured contact with data dynamic field, a contact created specifically for
this dynamic field (or data source) can be chosen from any ticket create or ticket action
screen where the dynamic filed has been previously configured.

The contact attributes will be shown in the ticket zoom screen.

8.1.4. Usage of Contacts in Search and Statistics
Tickets can be found in search and statistics via the required attribute Name.

The Name can also be returned as a field value.

8.2. 構成
システム構成

AdminContactWithData::RunInitialWildcardSearch

Navigation: Frontend::Admin::View::ContactWithData

Defines if a search with placeholder should be executed when initially calling the
contact management.

Frontend::Module###AdminContactWithData

Navigation: Frontend::Admin::ModuleRegistration

Allows to distribute contact and contact detail management permissions via group
definition.

8.3. Usage
An exemplary usage of contacts with data is as follows:

1. Create a new dynamic field of type Contact with data.
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2. Set the possible contact attributes (possible values). Name and ValidID are required
for any Contact with data Dynamic Field.

• Add Name attribute (Key: Name, Value: Name).

• Add ValidID attribute (Key: ValidID, Value: Validity).

• Add any other attribute such as Telephone attribute (Key: Telephone, Value: Phone).

3. Add the list of mandatory attribute keys comma separated (Name and ValidID are not
needed).

4. Set the attribute key order list comma separated as: Name,Telephone,ValidID.

5. Add the list of searchable attribute keys comma separated (Name is not needed).

6. Populate the data source by adding at least one contact in the newly created data
source by using Tickets → Edit contacts with data screen from the main navigation bar.

7. Add the new dynamic field to the screen's configuration where it should be shown.
For example in New Phone Ticket screen by updating the system configuration
setting: Ticket::Frontend::AgentTicketPhone###DynamicField and do the same
for Ticket::Frontend::AgentTicketZoom###DynamicField.

8. Go to New phone ticket screen, and notice that the new field is there. Add all ticket
needed information.

9. Select an existing contact using autocomplete and choosing a contact.

10.The assigned contact and its attributes will be shown in the ticket zoom screen.

11.It is possible to update the attributes of the contact by clicking the Edit contact
data button that appears in the right side of the title of the contact data box (if
the current user is a member of the groups defined in system configuration setting
Frontend::Module###AdminDynamicFieldContactWithData).

12.If is necessary to change the contact for this ticket, it can be done via any other ticket
action where the dynamic field is configured for display.

9. The Chat
9.1. 摘要

The chat feature allows for chats between agents and customers using the OTRS frontend.
Once enabled, customers (or public users) can start chats with agents and vice versa.
Finished chats can be archived and attached to tickets, or can be downloaded as PDF by
agents, customers and public users.

Each chat is assigned to a chat channel. Chat channels are like chat rooms. Each chat
channel is assigned to a certain group which controls the permissions for this channel. If
no chat channel is selected when a chat is created, this chat will be created in a default
channel (which is automatically created if it doesn't exist).

9.2. 構成
The following system configuration options are relevant for this feature. Please note that
you can also define a list of fixed texts which are being displayed to public users and
customers in the chat module. For more information on which texts can be changed,
please have a look at the system configuration (Core::Chat).
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ChatEngine::Active

Controls whether or not the chat feature is enabled.

ChatEngine::ChatDirection::PublicToAgent

Controls whether or not public users should be able to start chats (please
note that the frontend module configuration for the public chat frontend in
PublicFrontend::Module###PublicChat has to be enabled, too).

ChatEngine::ChatDirection::CustomerToAgent

Controls whether or not customers should be able to start chats (please
note that the frontend module configuration for the customer chat frontend in
CustomerFrontend::Module###CustomerChat has to be enabled, too).

ChatEngine::ChatDirection::AgentToCustomer

Controls whether or not agents should be able to start chats with customers directly.

ChatEngine::ChatDirection::AgentToAgent

Controls whether or not agents should be able chat with each other.

ChatEngine::PermissionGroup::ChatReceivingAgents,
ChatEngine::PermissionGroup::ChatNotificationAgents,
ChatEngine::PermissionGroup::ChatStartingAgents

Defines groups for the certain features. Receiving: Groups which can receive and
accept chat requests. Notification: Groups which can receive notifications about new/
pending chat requests. Starting: Groups which are allowed to start new chats at all.

ChatEngine::DefaultAgentName

A default name which should be displayed to customers and public users instead of
the real name of the chatting agents. If empty or disabled, the real agent name will
be shown.

ChatEngine::DefaultAgentNameNumbers

Controls whether or not numbers should be added to the agents default name in
case more than one agent is in a chat to allow customers/public users to distinguish
between the different agents (e.g. "Support Agent 1", "Support Agent 2" etc.).

ChatEngine::PublicInterface::AllowChatChannels

Defines, if chat channel selection should be enabled for public users. If set
to "no", chats from public users will go to the default channel automatically
(ChatEngine::DefaultChatChannel).

ChatEngine::PublicInterface::AvailabilityCheck

Defines, if chat channels should only be selectable in the public interface if at least
one agent with sufficient permissions is available in this channel.

ChatEngine::CustomerInterface::AllowChatChannels

Defines, if chat channel selection should be enabled for customer users. If set
to "no", chats from customer users will go to the default channel automatically
(ChatEngine::DefaultChatChannel).

ChatEngine::CustomerInterface::AvailabilityCheck

Defines, if chat channels should only be selectable in the customer interface if at least
one agent with sufficient permissions is available in this channel.
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ChatEngine::CustomerThreshold

Amount of minutes which need to pass before a no agent is
available message is being displayed to the customer/public user who
started the chat request. The message can be configured using
ChatEngine::Texts::CustomerFrontend::NoAgentsAvailable::NewTicket or
ChatEngine::Texts::CustomerFrontend::NoAgentsAvailable::AddToExisiting
(customer interface) and
ChatEngine::Texts::PublicFrontend::NoAgentsAvailable (public interface).

ChatEngine::AgentOnlineThreshold

If an agent is not active in OTRS within this threshold, they will be automatically set
to unavailable for chat (see Agents: Set up availability).

ChatEngine::DefaultChatChannel

Name of the default chat channel. This channel must not be created manually and
can't be deleted. This channel is taken as target chat channel in case chat channel
selection is disabled for any interface.

ChatEngine::ChatTTL

After how many hours a closed chat should be deleted from the database. Closed
chats can still be viewed and downloaded by customers. After a chat has been deleted
from the database, it will no longer be possible for customers to view or download it.

ChatEngine::ChatDecayTime

After how many days chats which are not closed should be deleted from the database
automatically in order to keep the database clean. Please note that this setting can
possibly delete chats which are still in use if they are older than the configured amount
of days.

ChatEngine::ChatOrder

Defines, if new chats should be prepended or appended to the list of active chats in
the active chats widget in the chat manager.

9.3. Setup
In order to be able to create your first chat, you need to setup certain things in your OTRS
instance.

9.3.1. Admin: Create chat channels and assign
permissions

In the admin area in OTRS, you'll find a new entry Chat Channel (AdminChatChannel).
Use this screen to add new channels. You'll need to assign an existing agent group to
each channel you'll create. You can use the screens Agents ↔ Groups or Agents ↔ Roles to
assign permissions. There are new chat-specific permissions which are described below.

Available Chat Permissions

CHAT_OBSERVER

Users with this permission type will only be able to observe chats in this channel after
they have been invited to them. They will not be able to accept or observe chats in
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this channel on their own and if they are the only agents currently available in this
channel, customers/public users will not be able to create a new chat in this channel.
Observers can still invite other agents to a chat they currently observe.

CHAT_PARTICIPANT

Users with this permission type will be able to take part in a chat, but only after they
get invited to it. After they're in a chat, they can change the chat channel, discard
the chat etc. They will not be able to accept a customer/public user chat request on
their own.

CHAT_OWNER

Users with this permission type will be able to accept chat customer/public requests
and do all kinds of observer and participant actions on a chat.

注記

To use the chat in general, agents still need to have at least ro permissions
to the groups set up in ChatEngine::PermissionGroup::ChatReceivingAgents
and ChatEngine::PermissionGroup::ChatStartingAgents.

9.3.2. Agents: Select Active Chat Channels

図6.70 Setting up preferred chat channels

As an agent, you'll need to select in which chat channels you want to be available.
Customers will only be able to create a new chat request on a certain channel if at least
one agent with owner permissions has selected this channel in their preferences and is
set as available for external chats (see next section).

9.3.3. Agents: Set up Availability

図6.71 Setting up Chat Availability

To be available for any chats, you'll need to use the chat tool-bar switch. It's a three-
way switch with these states: unavailable for chats (empty circle), available for internal
(agent-to-agent) chats (empty circle with tick sign), available for internal and external
(customer-to-agent, public-to-agent) chats (filled circle with tick sign). Just click the toggle
in order to change your availability.

注記

Your availability will be reset to internal chats only each time you log in to OTRS
again.
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9.4. General Usage
9.4.1. The Chat Manager

図6.72 The Chat Managing Screen

The chat manager is the central point of the chat feature. As an agent, here you can
manage your chats and see and accept open requests. The chat manager provides a list of
chat requests from customers, public users and other agents, as well as an overview over
all active chats. Open the chat manager by using Chat in the main navigation of OTRS.

9.4.2. Starting New Chats
• Agent to agent

To start a chat with another agent, you can use the user on-line widget from the
dashboard. Agents who are able to use the chat, will have a chat icon next to their name
which you can click on. Once clicked, a chat form will open which you can use to enter
your first chat message to this agent. After the chat request has been sent to the other
agent, you can watch the chat in the chat manager.

• Agent to customer

To start a chat with a customer, you can use the customer user widget from the customer
information center when viewing a certain customer. On-line customers will have a chat
icon next to their name which you can click on. Once clicked, a chat form will open
which you can use to enter your first chat message to this customer user. After the chat
request has been sent to the customer, you can watch the chat in the chat manager.

Another possibility is to create a chat from the ticket zoom. If the customer user who is
selected in this ticket is currently on-line, you'll be able to use a chat icon next to their
user name in the customer information box in right sidebar (see figure below).
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図6.73 Starting an A2C chat from ticket zoom

Additionally, you will be able to start chat with customer users by clicking on chat icons
next to their name in the user on-line widget on the dashboard.

図6.74 Starting an A2C chat from dashboard

• Customer to agent

Customers are not able to start a chat directly with a certain agent, but only to create
generic chat requests. To do this, customers can use the item Chats → Create new chat
from the customer interface main navigation.

図6.75 Starting a C2A chat

• Public to agent

Users of the public interface are also not able to start a chat directly with a certain agent,
but only to create generic chat requests using the public chat module (public.pl?
Action=PublicChat). If you would like to integrate the public chat module into your
website, you can use the IsIframe parameter. The OTRS header and footer will then be
removed from the view (public.pl?Action=PublicChat;IsIframe=1).
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9.4.3. Handling Chat Requests
If there is a new chat request in one of the channels you (as an agent) have permissions
for, you'll receive a browser notification which allows you to go directly to the chat
manager. After you've opened the chat manager, you can see a list of open requests of
all types (see figure below).

図6.76 An Open Chat Request

Use the Open chat button from the list to see the details of the request. Clicking the button
will open an overlay which provides several actions on this request. Given that you've got
sufficient permissions, you can accept the request or change the channel for this request.
Changing the channel will follow the same rules as creating new request: you can only
move the request to a channel which has active agents in it.

Changing the chat channel without accepting the request could be used to dispatch chats
to the right department for example.

図6.77 Open Chat Request Details

If you want to enter a chat, you can use the Accept button from the chat detail overlay box.
The chat will then be removed from the list of requests, added to the list of your active
chats and the customer/public user will receive a message that you've entered the chat.
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9.4.4. The Chat Widget
図6.78 The chat widget

The chat widget is the main component you'll use when chatting with other people. It
provides a history of all messages in the chat as well as list of possible actions (depending
on your permission level).

To send messages, you can use the text field in the chat widget in your list of active chats.
Once you are done with typing your message, submit it by either clicking the send icon
next to the text field, or using tab and enter (consecutively). When the message has been
sent, the cursor will jump back to the text field to allow for easily continuing to type.

Following you'll find a list of possible actions in the chat widget.

• Action: Monitor & close

From the chat widget head top right hand side, you can close the chat by clicking the
"x" icon. Clicking the circle icon right next to the close icon, allows you to set up a
personal monitoring for this chat, which is again a three-way switch (no monitoring =
empty circle, only monitor customer activity = empty circle with tick icon, monitor all
actions = filled circle with tick icon). When monitoring a chat, browser notifications will
show up each time there is a new action in this chat.

Also from the header, you can expand a tool-bar of advanced chat actions for this chat
using the triangle icon. The tool-bar also shows you the channel this chat takes place
in and which role you have in this chat (e.g. Owner).

図6.79 Monitor a chat

図6.80 Advanced chat actions

• Action: Phone ticket

Using the Phone ticket link from the advanced tool-bar, allows you to create a phone
ticket to which the current chat will be appended to as an article. After you've
successfully created the ticket, the chat will get closed automatically.

• Action: Append
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Allows you to append this chat as an article to a selected ticket. After the article has
been created, the chat will get closed automatically.

• Action: Invite

Allows you to invite another agent to this chat. You can select from a list of available
agents who you want to invite. Once you've invited the agent, a new agent-to-agent
chat request will be sent to this agent. After the request has accepted, a new internal
chat will be established between you and the invited agent. In this internal chat, the
invited agent has two more actions available in the advanced actions tool-bar: Observer
and Participant.

• Action: Channel change

Using this link, you can change the channel for this chat. For the selection of the target
channel the same rules apply as for initially selecting a chat channel.

• Action: Download

Lets you download the complete history of this chat as PDF.

• Action: New window

Opens this chat in a separate popup window. You can use this window in the same way
as the chat widget and both the widget and the popup can be used at the same time.

• Action: Observer

When you have been invited to a chat by another agent, you can decide if you want to
join the chat as observer or participant (depending on your permission level). Once you
click the action from your tool-bar, a new chat widget will be added to the list of your
active chats which is the chat you have been invited to. If you join the chat as observer,
you will only be able to read what others are contributing to the chat and you will be
invisible to customers or public users. Agents will still receive a message that you joined
the chat as observer. As an observer, you have the possibility to become a participant
anytime by using the advanced action tool-bar in your chat widget (depending on your
permission level).

• Action: Participant

If you want to contribute something to the chat you have been invited to, you can join
it as a participant. Customers/public users and agents will receive a message that you
have entered the chat. As a participant, you can become an observer anytime by using
the advanced action tool-bar in your chat widget.

9.4.5. User availability
図6.81 The chat widget
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Every chat participant has colored icon (circle) before his/her name in the Chat widget
header, which represents participant availability. Icon color represents participant state
as follows:

• Active - participant is active (available and on-line).

• Away - participant is away (available, but there was no request sent to the server from
this user for some time - default 5 minutes, see ChatEngine::AgentOnlineThreshold).

• Inactive - participant is inactive (chat request is not accepted yet or participant left the
chat).

• Unavailable - participant is unavailable (set via Availability button).

• Off-line - participant has logout or session has expired.

9.5. Advanced Usage
9.5.1. Chat Integration in Web Pages

You can easily integrate the public chat into a website. In the chat manager,
administrators can access a button to open public chat integration configuration and
snippet generator.

図6.82 Configure Chat Integration Button

9.5.1.1. 構成

Configuration tab contains several parameters that can be tweaked to suit your needs.
While most of them are self-explanatory, General Settings section contains several
important options:

Display Chat if no agent is available

If enabled, this option controls whether the chat will be displayed regardless of agent's
presence in the system. If not enabled, if there are no agents currently on-line and
available for chat, widget will be hidden.

Fall-back URL

This option is taken into account only if above option is enabled. If there are no agents
present and after some time, users of the public chat will be presented with a message
containing this link.

Pre-selected channel

Default chat channel selection for public chat requests. This chat channel will be pre-
selected in the chat widget, but users will be able to change it if needed.
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図6.83 Configuration Tab

All other options pertains layout, colors and texts used by the chat widget. You can tweak
them to match your overall website theme.

注記

Please note that changes made in the configuration tab will not be saved. Every
time you open this dialog, all fields will be reset to default values.

9.5.1.2. Integration Code

Integration Code tab contains necessary code snippets for insertion in a website, so
public chat can work. All changes in the Configuration tab are applied immediately to
the snippets, so you can make your changes and copy the code to your clipboard right
afterwards.
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図6.84 Integration Code Tab

Code from the first field should be added to the <HEAD> section of your web page.

Code from the second field should be inserted into the bottom of the page: before closure
of the <BODY> tag, but after the line that loads jQuery library.

注記

Please note that your web page must also include jQuery library for the code
snippets to work. This can be recognized by reference to the jquery.js or
jquery.min.js file somewhere in the page.

9.5.1.3. Preview

Using the Preview tab you can see the chat widget in action. In the browser simulator
below, you can see the chat widget look based on current configuration.
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図6.85 Preview Tab

By clicking on the reload icon, you can refresh the simulation at any time.

注記

Please note that the preview uses the real chat module. If the chat widget doesn't
show up after the configured amount of time, there are probably no agents
available for chatting and you have configured the chat shouldn't show up in this
case.

9.5.1.4. Troubleshooting

• If you cannot see the chat widget, but everything seems in order, make sure you have
at least one agent who is externally available for chat. Or switch on the Display Chat if
no agent is available option in the Configuration tab, and refresh the code.

• If you get mixed-content warnings in your browser console, make sure that OTRS
configuration option HttpType is properly set. For example, if you are running OTRS on
SSL, this configuration option must be set to https. Your website must run on the same
protocol for chat widget to work.

• If you get errors saying that $ variable is undefined, make sure that jQuery library is
included in your web page, and that chat related code is placed below it.
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10. Video and Audio Calls
10.1. 摘要

The video and audio calls feature provides real-time calls between two users right from
the comfort of the OTRS frontend. The calls will be provided over a direct peer-to-peer
connection established between two users, where possible. This feature depends heavily
on the chat, which must be active for video and audio calls to be possible.

注記

Video and audio calls are based on a quite young technology called WebRTC. The
implementation of WebRTC APIs in modern browsers is an ongoing effort. Currently,
OTRS video and audio calls are supported only in the latest versions of Mozilla
Firefox and Google Chrome (for Chrome a HTTPS Enabled Web Server is required).

To use this feature correctly the OTRS system must have a valid contract with the
OTRS group.

10.2. 構成
The following system configuration options are relevant for this feature.

ChatEngine::Active

Controls whether or not the video and audio calling feature is enabled. Please note
that the same switch will control the chat feature too.

ChatEngine::PermissionGroup::VideoChatAgents

Defines the group for the video and audio calling features. Only agents with permission
in this group will be able to make video and audio calls.

10.3. Setup
In order to be able to start video and audio calls, you need to setup certain things in your
OTRS instance.

10.3.1. Chat Setup
You need a working chat setup in your system. Make sure to carefully read the Setup
section of the chat feature.

10.3.2. HTTPS Enabled Web Server
Currently, Google Chrome will allow access to a user's media streams only to web
applications served over the HTTPS protocol (SSL) with valid signed certificates. Make
sure you have set the HttpType config option to https, too. Setting up a web server to
be accessible via HTTPS is outside of the scope of this manual.

10.3.3. Availability for calls
To be available for video and audio calls, you have to make sure you are available for chats
too. Please refer to the instructions in Agents: Set up Availability for more information.
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10.3.4. On-line User Dashboard Widget
For a convenient way to start the calls, please activate the On-line widget on the
Dashboard.

1. Go to the Dashboard and expand the Settings widget.

2. Check the On-line widget and make sure to click Save settings.

図6.86 Setting up the On-line widget on Dashboard

10.4. Usage
10.4.1. Chat Requirement

Video and audio calls are tied to existing chats. As an agent, you will be able to initiate
calls inside and outside of chats. Customer users will be able to initiate calls only from
an active chat.
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If a chat does not yet exist, it will be created when the call is initiated. In these "ad-hoc"
chats, the chat parties are joined automatically. When a call is terminated, these chats
will remain active until they are closed manually.

10.4.2. Making the Video Calls
To make a call inside of an active chat, simply click on the small video camera button in
the chat header.

図6.87 Making a call inside the chat

A popup window will open, and depending on your browser, you will be asked to share
your video and audio streams. On systems with several cameras and microphones, you
will be able to choose exactly the one you would like to use from the drop down list.

図6.88 Media Permission Request

Once you confirm your choice, an invitation will be sent to the other party asking them
to join. You will be notified of the progress via a message in the center of the screen.
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図6.89 Waiting for the other party

Please just wait a little while until the connection is established. Then you will be able to
see and hear the other party.

図6.90 Established Connection
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To control your streams, simply toggle the mute buttons on the left side.

図6.91 Mute Buttons

To leave a call, simply click on the big red Close button. The other party will be notified.

10.4.3. Audio Calls
The only difference between video and audio calls is that audio calls will mute your video
stream initially (which you will be able to turn on later in the call). The video stream will
be muted for both parties by default, but they will be able to control it.

If the other party has muted their video stream, instead of the video you will see a large
microphone icon in the center, along with their name. The icon will reflect the state of
their audio stream, and if they mute it too, it will be crossed.

図6.92 Audio Only

10.4.4. Call Invitations
If you have made yourself available for chats (either internal or external), video and audio
call invitations are received automatically by one of the active tabs in the same user
session. When you receive an invitation, a modal dialog will be displayed on your screen,
allowing you to accept or decline the invitation.
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図6.93 Call Invitation

Your browser may also present you a notification with sound. This heavily depends on
the used browser and operating system settings, and if permission has been granted to
OTRS to trigger such notifications. A permission request will be displayed the first time
you change your chat availability.

図6.94 Notification Permission Request

10.4.5. Other ways to start Video and Audio Calls
• Agent to Agent

To start a video or audio call with another agent, with whom you do not have an active
chat, you can use the On-line widget on the dashboard.
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図6.95 Online widget on the Dashboard

Agents who are able to receive calls will have a video camera and microphone icon next
to their name which you can click on. Once clicked, a popup window will open, asking
you to share your media streams. The connection will be established afterwards.

Calling other agents is possible also via Owner and Responsible fields in ticket zoom.
In this case, check will also be done to make sure the other agent is available, before
allowing the call to be initiated.

図6.96 Calling other agents from Ticket Zoom

• Agent to Customer

To start a video or audio call with a customer, with whom you do not have an active
chat, you can use the customer user widget in the Customer Information Center when
viewing a certain customer. Available customers will have call icons next to their name

321



which you can click on. Once clicked, a popup window will open asking you to share
your media streams. The connection will be established afterwards.

図6.97 Making a call from Customer Information Center

Another possibility is to make a call directly from the ticket zoom. If the customer user
who is assigned to this ticket is currently on-line, you'll be able to use call buttons next
to their user name in customer information box in right sidebar.

図6.98 Making a call from Ticket Zoom

• Customer to Agent

Customer users will be able to initiate calls from an active chat only. To do this,
customers can use the video and audio call links in the header of an active chat to
initiate calls.

図6.99 Starting a Video Call from Customer interface

When customers click on a link, they will be asked for permission to their media streams,
similar to agents. An invitation will be sent and the connection will be established if the
agent on the other side accepts the request.

The difference between video and audio calls in the customer interface compared to
the agent interface is minimal. Customers will see their calls inside the same window
as the chat. Only one additional button is provided: Fullscreen. It will resize the video to
the extent of the browser window. Other than that, everything as in the agent interface
applies.

• Public to Agent

Users of the public interface are not able to make audio and video calls.
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10.5. Connection
In the best case scenario, video and audio calls will be streamed over a direct peer-to-peer
connection between users' browsers. The requirement is that the user's network allows
connection over a high port that WebRTC uses, and can advertise this to the other party.
To this end, there are several mechanisms in place to aid in connecting.

• STUN (Session Traversal Utilities for NAT)

STUN is a standardized set of methods and a network protocol to allow an end host to
discover its public IP address if it is located behind a NAT. OTRS provides a cloud service
with STUN to all systems with a valid contract, and this data is shared with the other
party to allow the connection to be established.

In case of a connection via STUN, only the connection data is stored on the OTRS servers,
the connection itself is still directly between two users.

• TURN (Traversal Using Relays around NAT) over UDP

TURN is a protocol that assists in traversal of network address translators or firewalls for
multimedia applications. OTRS also provides TURN cloud service which can help clients
on networks masqueraded by symmetric NAT devices and it supports the connection
of a user behind a NAT.

In case of a connection established via TURN server, media streams will be routed
through the server (like a proxy). In this situation, all packets are securely transmitted
to the other side. The access to the TURN server is encrypted and secured by often
changed credentials, which are provided automatically.

• TURN over TCP

In case all UDP traffic is blocked between two users, the TURN server over TCP is a last
resort for a successful connection. While TCP is not an ideal protocol for transmitting
media packets, it's a last resort in an effort to connect two users and share their streams.

Same as with TURN over UDP, media streams will be routed through the server and sent
to the other side. The infrastructure for all STUN and TURN services is highly scalable
based on demand and can even be provided for different geographic locations, in order
to provide the best possible throughput.

11. FAQ（よくある質問）
11.1. 摘要

The FAQ functionality provides an FAQ or rather a knowledge database.

It facilitates speeding-up the knowledge transfer between agents or (using a public web
interface) between organizations and their customers, therefore effectively saving time.

11.2. 構成
The following system configuration options are relevant for this feature.

DynamicFields::ObjectType###FAQ

DynamicField object registration.

FAQ::CacheTTL

Cache Time To Leave for FAQ items.
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FAQ::Default::Language

Default language for FAQ articles on single language mode.

FAQ::Default::RootCategoryComment

Default category name.

FAQ::Default::RootCategoryName

Default category name.

FAQ::Default::State

Default state for FAQ entry.

FAQ::FAQHook

The identifier for a FAQ, e.g. FAQ#, KB#, MyFAQ#. The default is FAQ#.

FAQ::MultiLanguage

Enable multiple languages on FAQ module.

FAQ::TitleSize

Default maximum size of the titles in a FAQ article to be shown.

FAQ::Voting

Enable voting mechanism on FAQ module.

FAQ::ApprovalGroup

Group for the approval of FAQ articles.

FAQ::ApprovalQueue

Queue for the approval of FAQ articles.

FAQ::ApprovalRequired

New FAQ articles need approval before they get published.

FAQ::ApprovalTicketBody

Ticket body for approval of FAQ article.

FAQ::ApprovalTicketDefaultState

Default state of tickets for the approval of FAQ articles.

FAQ::ApprovalTicketPriority

Default priority of tickets for the approval of FAQ articles.

FAQ::ApprovalTicketSubject

Ticket subject for approval of FAQ article.

FAQ::ApprovalTicketType

Default type of tickets for the approval of FAQ articles.
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FAQ::Explorer::ItemList::VotingResultColors

CSS color for the voting result.

FAQ::Explorer::ItemList::VotingResultDecimalPlaces

Decimal places of the voting result.

FAQ::Explorer::LastChange::Limit

Number of shown items in last changes.

FAQ::Explorer::LastChange::Show

Show last change items in defined interfaces.

FAQ::Explorer::LastChange::ShowSubCategoryItems

Show items of subcategories.

FAQ::Explorer::LastCreate::Limit

Number of shown items in last created.

FAQ::Explorer::LastCreate::Show

Show last created items in defined interfaces.

FAQ::Explorer::LastCreate::ShowSubCategoryItems

Show items of subcategories.

FAQ::Explorer::Path::Show

Show FAQ path yes/no.

FAQ::Explorer::QuickSearch::Show

Interfaces where the quick search should be shown.

FAQ::Explorer::Top10::Limit

Number of shown items in the top 10 feature.

FAQ::Explorer::Top10::Show

Show top 10 items in defined interfaces.

FAQ::Explorer::Top10::ShowSubCategoryItems

Show items of subcategories.

FAQ::Item::Field1

Definition of FAQ item free text field.

FAQ::Item::Field2

Definition of FAQ item free text field.

FAQ::Item::Field3

Definition of FAQ item free text field.

FAQ::Item::Field4

Definition of FAQ item free text field.
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FAQ::Item::Field5

Definition of FAQ item free text field.

FAQ::Item::Field6

Definition of FAQ item free text field.

FAQ::Item::HTML

Show FAQ Article with HTML.

FAQ::Item::Voting::Rates

Rates for voting. Key must be in percent.

FAQ::Item::Voting::Show

Show voting in defined interfaces.

FAQ::Agent::RelatedArticles::Enabled

Enable the related article feature for the agent frontend.

FAQ::Customer::RelatedArticles::Enabled

Enable the related article feature for the customer frontend.

FAQ::KeywordArticeList::SearchLimit

Limit for the search to build the keyword FAQ article list.

FAQ::TicketCompose###IncludeInternal

Include internal fields on a FAQ based Ticket.

FAQ::TicketCompose###InsertMethod

Defines the information to be inserted in a FAQ based Ticket. "Full FAQ" includes text,
attachments and inline images.

FAQ::TicketCompose###ShowFieldNames

Include the name of each field in a FAQ based Ticket.

FAQ::TicketCompose###ShowInsertLinkButton

Show "Insert FAQ Link" Button in AgentFAQZoomSmall for public FAQ Articles.

FAQ::TicketCompose###ShowInsertTextAndLinkButton

Show "Insert FAQ Text & Link" / "Insert Full FAQ & Link" Button in AgentFAQZoomSmall
for public FAQ Articles.

FAQ::TicketCompose###ShowInsertTextButton

Show "Insert FAQ Text" / "Insert Full FAQ" Button in AgentFAQZoomSmall.

FAQ::TicketCompose###UpdateArticleSubject

Define if the FAQ title should be concatenated to article subject.

LinkObject::PossibleLink###8301

This setting defines that a 'FAQ' object can be linked with other 'FAQ' objects using
the 'Normal' link type.
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LinkObject::PossibleLink###8302

This setting defines that a 'FAQ' object can be linked with other 'FAQ' objects using
the 'ParentChild' link type.

LinkObject::PossibleLink###8303

This setting defines that a 'FAQ' object can be linked with other 'Ticket' objects using
the 'Normal' link type.

LinkObject::PossibleLink###8304

This setting defines that a 'FAQ' object can be linked with other 'Ticket' objects using
the 'ParentChild' link type.

FAQ::Agent::StateTypes

List of state types which can be used in the agent interface.

Frontend::HeaderMetaModule###3-FAQSearch

Module to generate html OpenSearch profile for short FAQ search.

FAQ::Frontend::JournalOverview###Small

Defines an overview module to show the small view of a FAQ journal.

FAQ::Frontend::Overview###Small

Defines an overview module to show the small view of a FAQ list.

FAQ::Frontend::OverviewSmall###DynamicField

Dynamic fields shown in the FAQ small format overview screen of the agent interface.

FAQ::Frontend::AgentFAQRelatedArticles###DefaultLanguages

The default languages for the related FAQ articles.

FAQ::Frontend::AgentFAQRelatedArticles###Position

Defines the position where the related FAQ articles widget is located.

FAQ::Frontend::AgentFAQRelatedArticles###QueuesEnabled

List of queue names for which the related article feature is enabled.

FAQ::Frontend::AgentFAQRelatedArticles###ShowLimit

Output limit for the related FAQ articles.

LinkObject::ComplexTable###FAQ

Define which columns are shown in the linked FAQs widget (LinkObject::ViewMode
= "complex"). Note: Only FAQ attributes and Dynamic Fields (DynamicField_NameX)
are allowed for DefaultColumns. Possible settings: 0 = Disabled, 1 = Available, 2 =
Enabled by default.

LinkObject::ComplexTable::SettingsVisibility###FAQ

Define Actions where a settings button is available in the linked objects
widget (LinkObject::ViewMode = "complex"). Please note that these Actions
must have registered the following JS and CSS files: Core.AllocationList.css,
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Core.UI.AllocationList.js, Core.UI.Table.Sort.js, Core.Agent.TableFilters.js and
Core.Agent.LinkObject.js.

Frontend::Module###AgentFAQAdd

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQCategory

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQDelete

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQEdit

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQExplorer

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQHistory

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQJournal

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQLanguage

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQPrint

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQRelatedArticles

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQRichText

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQSearch

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQSearchSmall

Frontend module registration for the agent interface.

Frontend::Module###AgentFAQZoom

Frontend module registration for the agent interface.

Loader::Module::AgentFAQAdd###002-FAQ

Loader module registration for the agent interface.

Loader::Module::AgentFAQCategory###002-FAQ

Loader module registration for the agent interface.
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Loader::Module::AgentFAQEdit###002-FAQ

Loader module registration for the agent interface.

Loader::Module::AgentFAQExplorer###002-FAQ

Loader module registration for the agent interface.

Loader::Module::AgentFAQJournal###002-FAQ

Loader module registration for the agent interface.

Loader::Module::AgentFAQLanguage###002-FAQ

Loader module registration for the agent interface.

Loader::Module::AgentFAQSearch###002-FAQ

Loader module registration for the agent interface.

Loader::Module::AgentFAQZoom###002-FAQ

Loader module registration for the agent interface.

Frontend::Navigation###AgentFAQAdd###002-FAQ

Main menu item registration.

Frontend::Navigation###AgentFAQCategory###002-FAQ

Main menu item registration.

Frontend::Navigation###AgentFAQExplorer###002-FAQ

Main menu item registration.

Frontend::Navigation###AgentFAQJournal###002-FAQ

Main menu item registration.

Frontend::Navigation###AgentFAQLanguage###002-FAQ

Main menu item registration.

Frontend::Navigation###AgentFAQSearch###002-FAQ

Main menu item registration.

Frontend::Navigation###AgentFAQSearchSmall###002-FAQ

Main menu item registration.

Frontend::Search###FAQ

FAQ search backend router of the agent interface.

Frontend::ToolBarModule###90-FAQ::AgentFAQAdd

Toolbar Item for a shortcut.

DashboardBackend###0398-FAQ-LastChange

Defines the parameters for the dashboard backend. "Limit" defines the number of
entries displayed by default. "Group" is used to restrict access to the plugin (e. g.
Group: admin;group1;group2;). "Default" indicates if the plugin is enabled by default
or if the user needs to enable it manually.
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DashboardBackend###0399-FAQ-LastCreate

Defines the parameters for the dashboard backend. "Limit" defines the number of
entries displayed by default. "Group" is used to restrict access to the plugin (e. g.
Group: admin;group1;group2;). "Default" indicates if the plugin is enabled by default
or if the user needs to enable it manually.

FAQ::Frontend::AgentFAQAdd###DynamicField

Dynamic fields shown in the FAQ add screen of the agent interface.

FAQ::Frontend::AgentFAQAdd###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

FAQ::Frontend::AgentFAQAdd###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

FAQ::Frontend::AgentFAQEdit###DynamicField

Dynamic fields shown in the FAQ edit screen of the agent interface.

FAQ::Frontend::AgentFAQEdit###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

FAQ::Frontend::AgentFAQEdit###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

FAQ::Frontend::AgentFAQExplorer###Order::Default

Defines the default FAQ order in the FAQ Explorer result of the agent interface. Up:
oldest on top. Down: latest on top.

FAQ::Frontend::AgentFAQExplorer###SearchLimit

Maximum number of FAQ articles to be displayed in the FAQ Explorer result of the
agent interface.

FAQ::Frontend::AgentFAQExplorer###ShowColumns

Defines the shown columns in the FAQ Explorer. This option has no effect on the
position of the column.

FAQ::Frontend::AgentFAQExplorer###ShowInvalidFAQItems

Show invalid items in the FAQ Explorer result of the agent interface.

FAQ::Frontend::AgentFAQExplorer###SortBy::Default

Defines the default FAQ attribute for FAQ sorting in the FAQ Explorer of the agent
interface.

FAQ::Frontend::AgentFAQExplorer###TitleSize

Maximum size of the titles in a FAQ article to be shown in the FAQ Explorer in the
agent interface.
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FAQ::Frontend::AgentFAQJournal###JournalLimit

Maximum number of FAQ articles to be displayed in the FAQ journal in the agent
interface.

FAQ::Frontend::AgentFAQJournal###ShowColumns

Defines the shown columns in the FAQ journal. This option has no effect on the position
of the column.

FAQ::Frontend::AgentFAQJournal###TitleSize

Maximum size of the titles in a FAQ article to be shown in the FAQ journal in the agent
interface.

FAQ::Frontend::AgentFAQPrint###DynamicField

Dynamic fields shown in the FAQ print screen of the agent interface.

FAQ::Frontend::AgentFAQSearch###Defaults###ApprovedSearch

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###CategoryIDs

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###CreatedUserIDs

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###Fulltext

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###ItemChangeTimePoint

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###ItemChangeTimeSlot

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###ItemCreateTimePoint

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###ItemCreateTimeSlot

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###Keyword

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###LanguageIDs

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###LastChangedUserIDs

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###Number

Defines the default shown FAQ search attribute for FAQ search screen.
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FAQ::Frontend::AgentFAQSearch###Defaults###RateSearchType

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###StateIDs

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###Title

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###ValidIDs

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###Defaults###VoteSearchType

Defines the default shown FAQ search attribute for FAQ search screen.

FAQ::Frontend::AgentFAQSearch###DynamicField

Dynamic fields shown in the FAQ search screen of the agent interface.

FAQ::Frontend::AgentFAQSearch###Order::Default

Defines the default FAQ order of a search result in the agent interface. Up: oldest on
top. Down: latest on top.

FAQ::Frontend::AgentFAQSearch###SearchCSVDynamicField

Dynamic Fields used to export the search result in CSV format.

FAQ::Frontend::AgentFAQSearch###SearchLimit

Maximum number of FAQ articles to be displayed in the result of a search in the agent
interface.

FAQ::Frontend::AgentFAQSearch###ShowColumns

Defines the shown columns in the FAQ search. This option has no effect on the position
of the column.

FAQ::Frontend::AgentFAQSearch###SortBy::Default

Defines the default FAQ attribute for FAQ sorting in a FAQ search of the agent interface.

FAQ::Frontend::AgentFAQSearch###TitleSize

Maximum size of the titles in a FAQ article to be shown in the FAQ Search in the agent
interface.

FAQ::Frontend::AgentFAQZoom###DynamicField

Dynamic fields shown in the FAQ zoom screen of the agent interface.

FAQ::Frontend::AgentHTMLFieldHeightDefault

Set the default height (in pixels) of inline HTML fields in AgentFAQZoom.

FAQ::Frontend::AgentHTMLFieldHeightMax

Set the maximum height (in pixels) of inline HTML fields in AgentFAQZoom.

FAQ::Frontend::MenuModule###000-Back

Shows a link in the menu to go back in the FAQ zoom view of the agent interface.
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FAQ::Frontend::MenuModule###010-Edit

Shows a link in the menu to edit a FAQ in the its zoom view of the agent interface.

FAQ::Frontend::MenuModule###020-History

Shows a link in the menu to access the history of a FAQ in its zoom view of the agent
interface.

FAQ::Frontend::MenuModule###030-Print

Shows a link in the menu to print a FAQ in the its zoom view of the agent interface.

FAQ::Frontend::MenuModule###040-Link

Shows a link in the menu that allows linking a FAQ with another object in the zoom
view of such FAQ of the agent interface.

FAQ::Frontend::MenuModule###050-Delete

Shows a link in the menu that allows to delete a FAQ in its zoom view in the agent
interface.

PreferencesGroups###FAQJournalOverviewSmallPageShown

Parameters for the pages (in which the FAQ items are shown) of the small FAQ journal
overview.

PreferencesGroups###FAQOverviewSmallPageShown

Parameters for the pages (in which the FAQ items are shown) of the small FAQ
overview.

Loader::Agent::CommonCSS###200-FAQ

List of CSS files to always be loaded for the agent interface.

Loader::Agent::CommonJS###200-FAQ

List of JS files to always be loaded for the agent interface.

Frontend::Output::OutputFilterTextAutoLink###FAQ

A filter for HTML output to add links behind a defined string. The element Image allows
two input kinds. First the name of an image (e.g. faq.png). In this case the OTRS image
path will be used. The second possibility is to insert the link to the image.

CustomerFrontend::HeaderMetaModule###3-FAQSearch

Module to generate HTML OpenSearch profile for short FAQ search in the customer
interface.

FAQ::Customer::StateTypes

List of state types which can be used in the customer interface.

FAQ::Frontend::CustomerFAQOverview###DynamicField

Dynamic fields shown in the FAQ overview screen of the customer interface.

FAQ::Frontend::CustomerFAQRelatedArticles###DefaultLanguages

The default languages for the related FAQ articles.
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FAQ::Frontend::CustomerFAQRelatedArticles###QueuesEnabled

List of queue names for which the related article feature is enabled.

FAQ::Frontend::CustomerFAQRelatedArticles###ShowLimit

Output limit for the related FAQ articles.

FAQ::Frontend::CustomerFAQRelatedArticles###VoteStarsVisible

Show the stars for the articles with a rating equal or greater like the defined value
(set value '0' to deactivate the output).

CustomerFrontend::Module###CustomerFAQExplorer

Frontend module registration for the customer interface.

CustomerFrontend::Module###CustomerFAQPrint

Frontend module registration for the customer interface.

CustomerFrontend::Module###CustomerFAQRelatedArticles

Frontend module registration for the customer interface.

CustomerFrontend::Module###CustomerFAQSearch

Frontend module registration for the customer interface.

CustomerFrontend::Module###CustomerFAQZoom

Frontend module registration for the customer interface.

Loader::Module::CustomerFAQExplorer###002-FAQ

Loader module registration for the agent interface.

Loader::Module::CustomerFAQSearch###002-FAQ

Loader module registration for the agent interface.

Loader::Module::CustomerFAQZoom###002-FAQ

Loader module registration for the agent interface.

Loader::Module::CustomerTicketMessage###002-FAQ

Loader module registration for the agent interface.

CustomerFrontend::Navigation###CustomerFAQExplorer###002-FAQ

Main menu item registration.

CustomerFrontend::Navigation###CustomerFAQSearch###002-FAQ

Main menu item registration.

FAQ::Frontend::CustomerFAQExplorer###Order::Default

Defines the default FAQ order in the FAQ Explorer result of the customer interface. Up:
oldest on top. Down: latest on top.

FAQ::Frontend::CustomerFAQExplorer###SearchLimit

Maximum number of FAQ articles to be displayed in the FAQ Explorer result of the
customer interface.
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FAQ::Frontend::CustomerFAQExplorer###SearchPageShown

Number of FAQ articles to be displayed in the FAQ Explorer of the customer interface.

FAQ::Frontend::CustomerFAQExplorer###SortBy::Default

Defines the default FAQ attribute for FAQ sorting in the FAQ Explorer of the customer
interface.

FAQ::Frontend::CustomerFAQExplorer###TitleSize

Maximum size of the titles in a FAQ article to be shown in the FAQ Explorer in the
customer interface.

FAQ::Frontend::CustomerFAQPrint###DynamicField

Dynamic fields shown in the FAQ print screen of the customer interface.

FAQ::Frontend::CustomerFAQSearch###DynamicField

Dynamic fields shown in the FAQ search screen of the customer interface.

FAQ::Frontend::CustomerFAQSearch###Order::Default

Defines the default FAQ order of a search result in the customer interface. Up: oldest
on top. Down: latest on top.

FAQ::Frontend::CustomerFAQSearch###SearchCSVDynamicField

Dynamic Fields used to export the search result in CSV format.

FAQ::Frontend::CustomerFAQSearch###SearchLimit

Maximum number of FAQ articles to be displayed in the result of a search in the
customer interface.

FAQ::Frontend::CustomerFAQSearch###SearchPageShown

Number of FAQ articles to be displayed on each page of a search result in the customer
interface.

FAQ::Frontend::CustomerFAQSearch###SortBy::Default

Defines the default FAQ attribute for FAQ sorting in a FAQ search of the customer
interface.

FAQ::Frontend::CustomerFAQSearch###TitleSize

Maximum size of the titles in a FAQ article to be shown in the FAQ Search in the
customer interface.

FAQ::Frontend::CustomerFAQZoom###DynamicField

Dynamic fields shown in the FAQ zoom screen of the customer interface.

FAQ::Frontend::CustomerHTMLFieldHeightDefault

Set the default height (in pixels) of inline HTML fields in CustomerFAQZoom (and
PublicFAQZoom).

FAQ::Frontend::CustomerHTMLFieldHeightMax

Set the maximum height (in pixels) of inline HTML fields in CustomerFAQZoom (and
PublicFAQZoom).
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FAQ::Public::StateTypes

List of state types which can be used in the public interface.

PublicFrontend::CommonParam###Action

Default value for the Action parameter for the public frontend. The Action parameter
is used in the scripts of the system.

PublicFrontend::HeaderMetaModule###3-FAQSearch

Module to generate HTML OpenSearch profile for short FAQ search in the public
interface.

FAQ::Frontend::PublicFAQOverview###DynamicField

Dynamic fields shown in the FAQ overview screen of the public interface.

Loader::Module::PublicFAQExplorer###002-FAQ

Loader module registration for the public interface.

Loader::Module::PublicFAQRSS###002-FAQ

Loader module registration for the public interface.

Loader::Module::PublicFAQSearch###002-FAQ

Loader module registration for the public interface.

Loader::Module::PublicFAQZoom###002-FAQ

Loader module registration for the public interface.

PublicFrontend::Module###PublicFAQ

Frontend module registration for the public interface.

PublicFrontend::Module###PublicFAQExplorer

Frontend module registration for the public interface.

PublicFrontend::Module###PublicFAQPrint

Frontend module registration for the public interface.

PublicFrontend::Module###PublicFAQRSS

Frontend module registration for the public interface.

PublicFrontend::Module###PublicFAQSearch

Frontend module registration for the public interface.

PublicFrontend::Module###PublicFAQZoom

Frontend module registration for the public interface.

PublicFrontend::Navigation###PublicFAQExplorer###002-FAQ

Main menu item registration.

PublicFrontend::Navigation###PublicFAQSearch###002-FAQ

Main menu item registration.
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FAQ::Frontend::PublicFAQExplorer###Order::Default

Defines the default FAQ order in the FAQ Explorer result of the public interface. Up:
oldest on top. Down: latest on top.

FAQ::Frontend::PublicFAQExplorer###SearchLimit

Maximum number of FAQ articles to be displayed in the FAQ Explorer result of the
public interface.

FAQ::Frontend::PublicFAQExplorer###SearchPageShown

Number of FAQ articles to be displayed in the FAQ Explorer of the public interface.

FAQ::Frontend::PublicFAQExplorer###SortBy::Default

Defines the default FAQ attribute for FAQ sorting in the FAQ Explorer of the public
interface.

FAQ::Frontend::PublicFAQExplorer###TitleSize

Maximum size of the titles in a FAQ article to be shown in the FAQ Explorer in the
public interface.

FAQ::Frontend::PublicFAQPrint###DynamicField

Dynamic fields shown in the FAQ print screen of the public interface.

FAQ::Frontend::PublicFAQSearch###DynamicField

Dynamic fields shown in the FAQ search screen of the public interface.

FAQ::Frontend::PublicFAQSearch###Order::Default

Defines the default FAQ order of a search result in the public interface. Up: oldest on
top. Down: latest on top.

FAQ::Frontend::PublicFAQSearch###SearchCSVDynamicField

Dynamic Fields used to export the search result in CSV format.

FAQ::Frontend::PublicFAQSearch###SearchLimit

Maximum number of FAQ articles to be displayed in the result of a search in the public
interface.

FAQ::Frontend::PublicFAQSearch###SearchPageShown

Number of FAQ articles to be displayed on each page of a search result in the public
interface.

FAQ::Frontend::PublicFAQSearch###SortBy::Default

Defines the default FAQ attribute for FAQ sorting in a FAQ search of the public interface.

FAQ::Frontend::PublicFAQSearch###TitleSize

Maximum size of the titles in a FAQ article to be shown in the FAQ Search in the public
interface.

FAQ::Frontend::PublicFAQZoom###DynamicField

Dynamic fields shown in the FAQ zoom screen of the public interface.
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GenericInterface::Operation::Module###FAQ::LanguageList

GenericInterface module registration for the operation layer.

GenericInterface::Operation::Module###FAQ::PublicCategoryList

GenericInterface module registration for the operation layer.

GenericInterface::Operation::Module###FAQ::PublicFAQGet

GenericInterface module registration for the operation layer.

GenericInterface::Operation::Module###FAQ::PublicFAQSearch

GenericInterface module registration for the operation layer.

11.3. Included Features
11.3.1. FAQ Explorer

Intuitive navigation and flexible mapping of theme hierarchies within the FAQ Explorer
enable easy navigation through the database.

11.3.2. WYSIWYG Editor
Using the WYSIWYG Editor you can change the formatting of articles and include screen-
shots or images.

11.3.3. FAQ Articles
FAQ articles with various attributes like "Symptom", "Problem", "Solution", "Title",
"Language", "Category", "Keywords", "State", "Created" and "Changed"

11.3.4. FAQ Attachments
You can add attachments to FAQ articles, which are available in the customer interface,
too (e. g. user guides in pdf format).

11.3.5. Agent And Customer Interfaces
Using the FAQ state you can determine the interface(s), in which an FAQ article should be
displayed. Articles with their state set to "internal" are only visible for agents via the Agent
Interface; Articles whose state is set to "external" are also displayed in the protected
customer section, and articles tagged as "public" are available in the non-protected public
area as well.

11.3.6. Comfortable Navigation / Clickable Keywords
The key words feature enables comfortable navigation to alternative articles using
clickable key words.

11.3.7. Linked Objects
FAQ articles can be linked to other objects such as tickets, FAQ articles or (CMDB)
configuration items.

11.3.8. Full-text And Quick Search
You can execute a full-text and quick search in the entire knowledge database. You can
also use OTRS operators for "AND" or "OR" relations.
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11.3.9. Top 10 Articles
An overview showing the Top 10 most often accessed, most recently generated and most
recently changed articles.

11.3.10. Ranking / Voting Of FAQ Articles
A personal ranking / voting of FAQ articles providing other users with information about
the quality of FAQ articles.

11.3.11. This might be helpful (agent and customer
ticket creation)

An additional widget for the customer ticket creation providing you helpful faq article
related for the insert subject and text.

11.3.12. Inserting FAQ Articles In OTRS Replies
You can insert FAQ articles (including images and attachments) in new tickets or replies
you generate in OTRS.

11.3.13. Release Workflow
Workflow to release FAQ articles that have been newly generated or changed.

11.3.14. RSS Feeds For Public FAQ Articles
In the public area, an option is provided to subscribe to RSS Feeds providing information
about changes in FAQ articles.

11.3.15. OpenSearch Format
The FAQ Module supports Open Search format (enabling quick searches directly from the
browser).

11.3.16. Create Links Using The Category Name
It is possible to refer to FAQ items by creating a link for web browser using the category
name instead of just the category ID

Category parameter is the full category path, each sub-category is separated by
"::" (which is also called the "Category Long Name"). Imagine the following category tree:

                    
    |--GrandParent
    |  |--Parent
    |  |  |--|Son
                    
                

To create a link to the "Son" category we need to specify the following path:
Category=GrandParent::Parent::Son.

See the link examples below:

from:  http://localhost/otrs/index.pl?Action=AdminFAQExplorer;CategoryID=1

to:  http://localhost/otrs/index.pl?Action=AdminFAQExplorer;Category=Misc
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Other Examples:

http://localhost/otrs/index.pl?Action=AdminFAQExplorer;Category=My%20Category

http://localhost/otrs/index.pl?
Action=CustomerFAQExplorer;Category=GrandParent::Parent::Son

http://localhost/otrs/index.pl?Action=PublicFAQExplorer;Category=My
%20Category::Subcategory

11.3.17. Generic Interface FAQ Connector For Public
Interface

Allow you to use the functions for FAQ public interface via OTRS Generic Interface by
adding the following operations.

• LanguageList

This operation returns the list of all FAQ languages available in the system. The response
of this operation is a list of languages including the ID and Name for each language.

• PublicCategoryList

This operation is used to get the system FAQ categories that have at least one public
FAQ item, as a consequence also the category ancestors are also listed even if they don't
have any public FAQ item. The output of this operation is a list of categories including
ID and Name for each category.

• PublicFAQSearch

By using this operation is possible to perform a FAQ search for the public FAQ items
using the same search parameters as in the public web interface. It will return a list of
IDs for matched FAQ items.

• PublicFAQGet

This operation can be used to easily obtain one or more FAQ items. The response will one
or more main containers called 'FAQItem' that has all the FAQ item information, including
attachments, each attachment is represented by an 'Attachment' sub-containers and
they could be more than one.

11.3.18. Dynamic Fields for FAQ
Basic Dynamic Fields (Text, TextArea, Checkbox, Dropdown, Multiselect, Date and Date/
Time) has been implemented for FAQ items. It creation, behavior and configuration is
similar to the Dynamic Fields for Ticket.

Already created Dynamic Fields can not be used for FAQ, new Dynamic Fields for FAQ
(exclusively) has to be created (Same as Ticket and Article Dynamic Fields).

Dynamic Fields extend FAQ by adding multiple options to store and present information
on FAQ Items, beyond the normal fields (e.g. Symptom, Problem, Solution, etc. ).

11.4. Usage
This functionality use default system groups:

• All users are able to:

• Use FAQ Explorer.
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• Add, Edit, Delete, Zoom, Print and Link FAQ Articles.

• Use FAQ Journal.

• Use FAQ Search.

• admin.

Users in this group are able to:

• Add, Edit and Delete FAQ Categories.

• Add, Edit and Delete FAQ Languages.

• users.

Users in this group are able to:

• Approve FAQ Articles.

注記

The group to approve FAQ Articles can be changed using SysConfig.

All users regardless of their group membership will have a new menu called "FAQ" in the
navigation bar that is in the top of the screen (after re-login), similar to the "Ticket" menu.

11.4.1. Create A New FAQ Article
This example shows how to create a new FAQ article.

1. From the Navigation Bar, click on "FAQ" and then on "New" (from the opened FAQ menu
option).

2. Fill the required information.

There are tree possible FAQ states: "internal": only agents can see the FAQ article,
"external": agents and registered customer can see the FAQ article and "public": this
FAQ articles are accessible from the OTRS public interface.

By default the system has the Category "Misc" and the Languages "en" for English and
"de" for German. (more Categories and Languages can be added to the system).

On a clean system there are four multiple line fields (with other two more than can be
added if needed), their names an visibility can be changed in the system configuration.

3. Click on the "Create" button.

This will create a new FAQ article that can be accessed from the FAQ Explorer

注記

By default the FAQ article does not need an approval procedure, if this functionality
is enabled and the user is also a member of the FAQ Approval group, a selection
to set the approval state is also shown in this screen.

11.4.2. Create a New Category
This example shows how to create a new FAQ category.
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注記

Be sure that the logged user is a member of "admin" group.

1. From FAQ menu click on "Category Management".

A list of available categories is shown (from there is also possible to edit or delete them)

2. Click on "Add Category" from the Actions side bar.

3. Fill the required information.

Notice that a category can be a sub item from a wider category, this is helpful to
organize FAQ articles in a hierarchical way (this hierarchies can be drilled drown from
the FAQ Explorer).

4. Click on "Submit" button, and the new category will be ready to use.

11.4.3. Related Articles (This might be helpful during
the customer ticket creation)

A new widget in the customer ticket creation will be visible. The widget should help the
customer to get directly a helpful solution without a ticket creation. The user must type
a subject or text to get a list of helpful resources.

For the output of the helpful article list all external and public FAQ article will be considered
(but only FAQ article with the default language or the user language).
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11.4.4. Related Articles (This might be helpful during
the agent ticket creation)

A widget in the agent ticket phone and email creation will be visible. The widget should
help the agent to get directly a helpful solution for the current situation. The agent must
type a subject or text to get a list of helpful resources.

For the output of the helpful article list all internal, external and public FAQ article will be
considered (but only FAQ article with the default language or the user language).
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11.4.5. Collection/Sorting for the related (helpful)
articles

For the related FAQ article collection the insert content in the subject and text will be used.
After every whitespace (for the subject only after 10 characters or if already some text
in the text field exists) a check in the background collect possible new helpful FAQ article
for the list. The keywords (every single word) from the insert subject and text will be
compared with all keywords from the FAQ articles and all matched articles will be added
to the result list. The matched articles will be ordered with a keyword quantifier, the last
change time and the create time.

The occurrence of the words in the text and title will be counted and the quantifier will
be calculated with the defined keywords in the FAQ articles. If the word is a keyword in
a FAQ article the quantifier for this FAQ article will be increased (word counter + current
FAQ article quantifier). Here is a example for the related FAQ article ordering:

                
    We have some FAQ Article with the following keywords:
        - FAQArticle 1 with keywords:  'itsm', 'changemanagement', 'ticket'
        - FAQArticle 2 with keywords: 'itsm', 'changemangement'
        - FAQArticle 3 with keywords: 'ticket'
    Some example words from the subject and text (with a counter for the occur in the
 subject and text):
        - changemanagement (5)
        - ticket (4)
        - itsm (1)
    Result for the collection (FAQArticleID => Calculated Quantifier):
        - FAQArticle 1 => 11 - ( changemanagement (5) + ticket (4) + itsm (1) = Quantifier
 (11) )
        - FAQArticle 2 => 6  - ( changemanagement (5) + itsm (1) = Quantifier (6) )
        - FAQArticle 3 => 4  - ( ticket (4) = Quantifier (4) )
                
            

If two articles have the same keyword quantifier the last change time and create time
will also be used for the sorting.

To provide good helpful FAQ article for the ticket creation, you need good maintained
keywords in the FAQ articles.

12. Share Search Templates
12.1. 摘要

This functionality allows agent users to share their own search templates with all agents.

12.2. 構成
システム構成

Ticket::Frontend::AgentTicketSearch###GlobalProfileGroup

Navigation: Frontend::Agent::View::TicketSearch

Defines the groups whose agents can set up global search templates.
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12.3. Usage
12.3.1. AgentTicketSearch - Add share search profile

Switch to the ticket search area (AgentTicketSearch). Now select a name for your search
template and press "Add". You can then configure the search parameters as usual.

You will now also see the new option "Deploy template for each agent". If this option is
set and you then perform your search, your search template is then available for every
other agent.

図6.100 Deploy template for each agent

Groups can be defined using the SysConfig option
"Ticket::Frontend::AgentTicketSearch####GlobalProfileGroup". Only agents in these
groups can create "Global" search templates.

Global search templates can only be revoked by the agent who created the template.
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第7章 パフォーマンス・チューニング
以下はOTRS導入のための強化テクニックのパフォーマンスのリストです。構成、コーディング、メ
モリー使用、その他を含みます。

1. OTRS
OTRSのパフォーマンスを改善するいくつかのオプションがあります。

1.1. TicketIndexModule
There are two backend modules for the index for the ticket queue view:

Kernel::System::Ticket::IndexAccelerator::RuntimeDB

This is the default option, and will generate each queue view on the fly from the ticket
table. You will not have performance trouble until you have about 60,000 open tickets
in your system.

Kernel::System::Ticket::IndexAccelerator::StaticDB

The most powerful module, should be used when you have above 80,000 open tickets.
It uses an extra ticket_index table, which will be populated with keywords based
on ticket data. Use bin/otrs.Console.pl Maint::Ticket::QueueIndexRebuild for
generating an initial index after switching backends.

You can change the used IndexAccelerator module via SysConfig.

1.2. Ticket Search Index
OTRS uses a special search index to perform full-text searches across fields in articles
from different communication channels.

To create an initial index, use bin/otrs.Console.pl Maint::Ticket::FulltextIndex
--rebuild.

注記

Actual article indexing happens via an OTRS daemon job in the background. While
articles which were just added in the system are marked for indexing immediately,
it could happen their index is available within a few minutes.

There are some options available for fine tuning the search index:

Ticket::SearchIndex::IndexArchivedTickets

Defines if archived tickets will be included in the search index (off by default). This
is advisable to keep the index small on large systems with archived tickets. If this is
turned off, archived tickets will not be found by full-text searches.

Ticket::SearchIndex::Attribute

The attribute WordCountMax defines the maximum number of words which will be
processed to build up the index. For example only the first 1000 words of an
article body are stored in the article search index. The attributes WordLengthMin
and WordLengthMax are used as word length boundaries. Only words with a length
between these two values are stored in the article search index.
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Ticket::SearchIndex::Filters

There are three default filters defined:

• The first filter strips out special chars like: , & < > ? " ! * | ; [ ] ( ) + $ ^=

• The second filter strips out words which begin or ends with one of following chars:
' : .

• The third filter strips out words which do not contain a word-character: a-z, A-Z,
0-9, _

Ticket::SearchIndex::StopWords

There are so-called stop-words defined for some languages. These stop-words will be
skipped while creating the search index.

1.3. Article Storage (Email, Phone and
Internal Articles)

There are two different backend modules for the article
storage of phone, email and internal articles (configured via
Ticket::Article::Backend::MIMEBase::ArticleStorage):

Kernel::System::Ticket::Article::Backend::MIMEBase::ArticleStorageDB

This default module will store attachments in the database.

注記

Don't use it with large setups.

Pro: works with multiple front end servers.

Con: requires much storage space in the database.

Kernel::System::Ticket::Article::Backend::MIMEBase::ArticleStorageFS

Use this module to store attachments on the local file system.

注記

Recommended for large setups.

賛成意見: 速いですね!

Con: If you have multiple front end servers, you must make sure the file system is
shared between the servers. Place it on an NFS share or preferably a SAN or similar
solution.

注記

You can switch from one back-end to the other on the fly. You can switch
the backend in the SysConfig, and then run the command line utility bin/
otrs.Console.pl Admin::Article::StorageSwitch to put the articles from the
database onto the filesystem or the other way around. You can use the --target
option to specify the target backend. Please note that the entire process can take
considerable time to run, depending on the number of articles you have and the
available CPU power and/or network capacity.
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shell> bin/otrs.Console.pl Admin::Article::StorageSwitch --target ArticleStorageFS
                

スクリプト:記憶バックエンドをデータベースからファイルシステムまで切り替えること。

If you want to keep old attachments in the database, you can activate the SysConfig
option Ticket::Article::Backend::MIMEBase::CheckAllStorageBackends to make
sure OTRS will still find them.

1.4. チケットのアーカイブに保管
監査に耐えうるシステムとしてOTRSを使うならば、完了したチケットを削除することはよい考え
とはいえません。そのため我々はチケットをアーカイブすることができる機能を実装しました。

Tickets that match certain criteria can be marked as "archived". These tickets are not
accessed if you do a regular ticket search or run a Generic Agent job. The system itself
does not have to deal with a huge amount of tickets any longer as only the "latest" tickets
are taken into consideration when using OTRS. This can result in a huge performance gain
on large systems.

アーカイブ機能を使用するには次のステップに従います:

1. SysConfigのアーカイブシステムを活性化します。

管理者ページで、SysConfigに行って、グループ・チケットを選択してくださ
い。Core::Ticketでは、デフォルトで「no」にセットされるオプショ
ンTicket::ArchiveSystemを見つけます。この設定を「yes」に変更し変更を保存します。

2. GenericAgentジョブを定義する

On the Admin page, select GenericAgent and add a new job there.

a.ジョブ設定

アーカイブに保管するジョブの名前を与え、この仕事を予定する適切なオプションを選択し
てください。

b.チケット・フィルタ

チケット・フィルタは選択された基準と一致するチケット検索です。完了した状態（数か月
前に完了したた）のチケットのみをアーカイブするのは良い考えです。

c. チケット・アクション

このセクションでは、「選択したチケットをアーカイブ」「チケットをアーカイブ」とラベ
ルしたフィールドをセットしてください。

d.仕事を保存する

ページの終わりに、仕事を保存するオプションを見つけるでしょう。

e.影響を受けたチケット

システムは、一般担当者のジョブを実行する時にアーカイブされる全てのチケットを表示し
ます。

3.チケット検索

チケットを検索する場合、システムはデフォルトでアーカイブに保管されないチケットを探索し
ます。さらにアーカイブに保管されたチケットを捜したい場合は、検索基準を定義する時に単に
「archive search」を加えてください。
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1.5. キャッシュ
OTRS caches a lot of temporary data in /opt/otrs/var/tmp. Please make sure that this
uses a high performance file system/storage. If you have enough RAM, you can also try
to put this directory on a ramdisk like this:

shell> /opt/otrs/bin/otrs.Console.pl Maint::Session::DeleteAll
shell> /opt/otrs/bin/otrs.Console.pl Maint::Cache::Delete
shell> sudo mount -o size=16G -t tmpfs none /opt/otrs/var/tmp

# add persistent mount point in /etc/fstab
                

注記
Please note that this will be a non-permanent storage that will be lost on server
reboot. All your sessions (if you store them in the filesystem) and your cache data
will be lost.

There is also a centralized memcached based cache backend available for purchase from
OTRS Group.

2. データベース
DB発行は使用されているデータベースによって変わります。データベース管理者とデータベース
かチェックのためのドキュメンテーションを研究してください。

2.1. MySQL
MySQLテーブル・タイプMyISAM(デフォルトです)を使用し、テーブルの大部分を削除したなら
ば、あるいは可変長列(VARCHAR、BLOBあるいはTEXTカラムがあるテーブル)でテーブルに多くの
変更を加えていれば、「optimize（最適化）」コマンドでデータ・ファイル(テーブル)をフラグメ
ンテーション解消しなければいけません。

mysqldデーモンがCPU時間の多くを必要とする場合、テーブルの最適化を試みるべきです。- チ
ケット、ticket_historyおよび記事(下記のスクリプトを参照)。

shell> mysql -u user -p database
mysql> optimize table ticket;
mysql> optimize table ticket_history;
mysql> optimize table article;
            

スクリプト:データ・ベース・テーブルの最適化。

2.2. PostgreSQL
PostgreSQL is best tuned by modifying the postgresql.conf file in your PostgreSQL data
directory. For advice on how to do this, reference the following articles:

• http://www.revsys.com/writings/postgresql-performance.html

• http://varlena.com/GeneralBits/Tidbits/perf.html

• http://varlena.com/GeneralBits/Tidbits/annotated_conf_e.html

If performance is still not satisfactory, we suggest that you join the PostgreSQL
Performance mailing list ( http://www.postgresql.org/community/lists/ ), and ask questions
there. The folks on the PostgreSQL list are very friendly and can probably help.
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3. Web Server
OTRS comes with a built-in web server that is correctly preconfigured for many production
use cases. Please see the file Kernel/WebApp.conf for further tuning possibilities in high-
load environments, where for example the number of active worker processes needs to
be increased.
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付録A 追加の資料
otrs.com

OTRSのソースコード、ドキュメントや最新情報を掲載したWebサイトは、 www.otrs.comに
あります。また、そこには、OTRSグループ（OTRSの作者）からの専門サービスや、OTRS管理者
向けトレーニングセミナーの情報もあります。

メーリングリスト

表A.1 メーリングリスト

Name & URL 摘要

announce@otrs.org 新しいOTRSリリースおよびセキュリティ問題
に関するアナウンスのためリスト。英語で、
転送量は少量です。

otrs@otrs.org 全ての関連質問および製品サポートについて
のリスト。英語で、流量は中/多量です。

otrs-de@otrs.org 全ての関連質問および製品サポートについて
のリスト。ドイツ語で、流量は中/多量です。

dev@otrs.org OTRS開発者がさまざまなデザインや実装の問
題を議論するリスト。英語で、流量は中度で
す。

翻訳

You can help translate OTRS to your language at Transifex.

バグ・トラッキング

To report software defects, please visit http://bugs.otrs.org/ (see figure below). Please
take note of the difference between a bug and a configuration issue. Configuration
issues are problems that you encounter when setting a system, or general questions
regarding the use of OTRS. Bug reports should only be used for issues with the source
code of OTRS or other open source OTRS modules itself. For configuration issues, you
should either use the commercial support, available from OTRS, or the public mailing
lists.
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図A.1 バグ・トラッキング・ツール
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付録B 構成オプションリファレンス
1. CloudService

CloudServices::Disabled

Defines if the communication between this system and OTRS Group servers that
provide cloud services is possible. If set to 'Disable cloud services', some functionality
will be lost such as system registration, support data sending, upgrading to and use
of OTRS Business Solution™, OTRS Verify™, OTRS News and product News dashboard
widgets, among others.

この設定は標準では有効ではありません。

デフォルト値:

--- 0

2. CloudService → Admin →
ModuleRegistration

CloudService::Admin::Module###200-SMS

Cloud service admin module registration for the transport layer.

デフォルト値:

---
ConfigDialog: AdminCloudServiceSMS
Description: This will allow the system to send text messages via SMS.
Icon: fa fa-mobile
Name: SMS

3. Core
ConfigImportAllowed

Controls if the admin is allowed to import a saved system configuration in SysConfig.

この設定は無効化することはできません。

デフォルト値:

--- '1'

DemoSystem

Runs the system in "Demo" mode. If enabled, agents can change preferences, such
as selection of language and theme via the agent web interface. These changes are
only valid for the current session. It will not be possible for agents to change their
passwords.

この設定は無効化することはできません。

デフォルト値:

--- 0
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FQDN

フルに認定されたシステムのドメイン名を定義します。この設定は変数OTRS_CONFIG_FQDN
として使用され、アプリケーションによって使用されるメッセージングの全てのフォームに存
在し、ご利用のシステム内のチケットへのリンクを作成することとなります。

この設定は無効化することはできません。

デフォルト値:

--- yourhost.example.com

Organization

Company name which will be included in outgoing emails as an X-Header.

この設定は無効化することはできません。

デフォルト値:

--- Example Company

ProductName

ウェブ・インタフェース、ウェブ・ブラウザのタブおよびタイトル・バーに表示されるアプリ
ケーション名を定義します。

この設定は無効化することはできません。

デフォルト値:

--- OTRS 7

Secure::DisableBanner

If enabled, the OTRS version tag will be removed from the Webinterface, the HTTP
headers and the X-Headers of outgoing mails. NOTE: If you change this option, please
make sure to delete the cache.

この設定は無効化することはできません。

デフォルト値:

--- 0

SystemID

システム識別子を定義します。すべてのチケット番号とHTTPセッションの文字列は、このID
が含まれています。これはをシステムに属している唯一のチケットがフォローアップとして処
理されることを確実にします。（2つのOTRSのインスタンス間で通信する場合に便利です）

この設定は無効化することはできません。

デフォルト値:

--- '10'

4. Core → AppointmentCalendar
AgentAppointmentEdit::Location::Link###1-GoogleMaps

Defines an icon with link to the google map page of the current location in appointment
edit screen.

デフォルト値:
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---
CSSClass: GoogleMaps
IconName: fa-globe fa-lg
Target: _blank
Text: Location
URL: http://maps.google.com/maps?z=7&q=

AppointmentCalendar::CalendarColors

List of colors in hexadecimal RGB which will be available for selection during calendar
creation. Make sure the colors are dark enough so white text can be overlayed on
them.

デフォルト値:

---
- '#000000'
- '#1E1E1E'
- '#3A3A3A'
- '#545453'
- '#6E6E6E'
- '#878687'
- '#888787'
- '#A09FA0'
- '#B8B8B8'
- '#D0D0D0'
- '#E8E8E8'
- '#FFFFFF'
- '#891100'
- '#894800'
- '#888501'
- '#458401'
- '#028401'
- '#018448'
- '#008688'
- '#004A88'
- '#001888'
- '#491A88'
- '#891E88'
- '#891648'
- '#FF2101'
- '#FF8802'
- '#FFFA03'
- '#83F902'
- '#05F802'
- '#03F987'
- '#00FDFF'
- '#008CFF'
- '#002EFF'
- '#8931FF'
- '#FF39FF'
- '#FF2987'
- '#FF726E'
- '#FFCE6E'
- '#FFFB6D'
- '#CEFA6E'
- '#68F96E'
- '#68FDFF'
- '#68FBD0'
- '#6ACFFF'
- '#6E76FF'
- '#D278FF'
- '#FF7AFF'
- '#FF7FD3'

AppointmentCalendar::CalendarLimitOverview

Maximum number of active calendars in overview screens. Please note that large
number of active calendars can have a performance impact on your server by making
too much simultaneous calls.
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デフォルト値:

--- '10'

AppointmentCalendar::Import::RecurringMonthsLimit

OTRS doesn't support recurring Appointments without end date or number
of iterations. During import process, it might happen that ICS file contains
such Appointments. Instead, system creates all Appointments in the past, plus
Appointments for the next N months (120 months/10 years by default).

この設定は無効化することはできません。

デフォルト値:

--- '120'

5. Core → AppointmentCalendar →
Plugin

AppointmentCalendar::Plugin###0100-Ticket

予定のカレンダーのチケットプラグインを定義します。

デフォルト値:

---
Module: Kernel::System::Calendar::Plugin::Ticket
Name: Ticket
URL: <OTRS_CONFIG_HttpType>://<OTRS_CONFIG_FQDN>/<OTRS_CONFIG_ScriptAlias>index.pl?
Action=AgentTicketZoom;TicketID=%s

6. Core → AppointmentCalendar →
TicketAppointments

AppointmentCalendar::TicketAppointmentSearchParam

Defines the list of params that can be passed to ticket search function.

デフォルト値:

---
CustomerID: CustomerID
CustomerUserLogin: Customer user
Locks: Lock state
MIMEBase_AttachmentName: Attachment Name
MIMEBase_Body: Body
MIMEBase_Cc: Cc
MIMEBase_From: From
MIMEBase_Subject: Subject
MIMEBase_To: To
OwnerIDs: Owner
Priorities: Priority
ResponsibleIDs: Responsible
SLAs: SLA
Services: Service
StateType: State type
States: State
Title: Title
Types: Type

AppointmentCalendar::TicketAppointmentType###0100-FirstResponseTime

Defines the ticket appointment type backend for ticket escalation time.
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デフォルト値:

---
Event: TicketSLAUpdate|TicketQueueUpdate|TicketStateUpdate|TicketCreate|ArticleCreate
Key: FirstResponseTime
Mark: E
Module: Kernel::System::Calendar::Ticket::EscalationTime
Name: First response time

AppointmentCalendar::TicketAppointmentType###0200-UpdateTime

Defines the ticket appointment type backend for ticket escalation time.

デフォルト値:

---
Event: TicketSLAUpdate|TicketQueueUpdate|TicketStateUpdate|TicketCreate|ArticleCreate
Key: UpdateTime
Mark: E
Module: Kernel::System::Calendar::Ticket::EscalationTime
Name: Update time

AppointmentCalendar::TicketAppointmentType###0300-SolutionTime

Defines the ticket appointment type backend for ticket escalation time.

デフォルト値:

---
Event: TicketSLAUpdate|TicketQueueUpdate|TicketStateUpdate|TicketCreate|ArticleCreate
Key: SolutionTime
Mark: E
Module: Kernel::System::Calendar::Ticket::EscalationTime
Name: Solution time

AppointmentCalendar::TicketAppointmentType###0400-PendingTime

Defines the ticket appointment type backend for ticket pending time.

デフォルト値:

---
Event: TicketPendingTimeUpdate
Key: PendingTime
Mark: P
Module: Kernel::System::Calendar::Ticket::PendingTime
Name: Pending time

AppointmentCalendar::TicketAppointmentType###0500-DynamicField

Defines the ticket appointment type backend for ticket dynamic field date time.

デフォルト値:

---
Event: TicketDynamicFieldUpdate_.*
Key: DynamicField_%s
Mark: D
Module: Kernel::System::Calendar::Ticket::DynamicField
Name: DynamicField_%s

7. Core → Auth → Agent → TwoFactor
AuthTwoFactorModule

Defines the two-factor module to authenticate agents.

この設定は標準では有効ではありません。
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デフォルト値:

--- Kernel::System::Auth::TwoFactor::GoogleAuthenticator

AuthTwoFactorModule::AllowEmptySecret

Defines if agents should be allowed to login if they have no shared secret stored in
their preferences and therefore are not using two-factor authentication.

デフォルト値:

--- '1'

AuthTwoFactorModule::AllowPreviousToken

Defines if the previously valid token should be accepted for authentication. This is
slightly less secure but gives users 30 seconds more time to enter their one-time
password.

デフォルト値:

--- '1'

AuthTwoFactorModule::SecretPreferencesKey

Defines the agent preferences key where the shared secret key is stored.

この設定は無効化することはできません。

デフォルト値:

--- UserGoogleAuthenticatorSecretKey

8. Core → Auth → Customer
Customer::AuthModule

顧客を認証するモジュールを定義します。

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::CustomerAuth::DB

Customer::AuthModule::DB::CryptType

If "DB" was selected for Customer::AuthModule, the encryption type of passwords
must be specified.

この設定は無効化することはできません。

デフォルト値:

--- sha2

Customer::AuthModule::DB::CustomerKey

もし、Customer::AuthModuleに関して“DB”が選択されていた場合、顧客テーブル内の
CustomerKeyのためのコラム名を特定する必要があります。

この設定は無効化することはできません。

デフォルト値:
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--- login

Customer::AuthModule::DB::CustomerPassword

もし、Customer::AuthModuleに関して“DB”が選択されていた場合、顧客テーブル内の
CustomerPasswordのためのコラム名を特定する必要があります。

この設定は無効化することはできません。

デフォルト値:

--- pw

Customer::AuthModule::DB::DSN

もし、Customer::AuthModuleに関して“DB”が選択されていた場合、顧客テーブルに対する接続
のためのDSNを特定する必要があります。

この設定は標準では有効ではありません。

デフォルト値:

--- DBI:mysql:database=customerdb;host=customerdbhost

Customer::AuthModule::DB::Password

もし、Customer::AuthModuleに関して“DB”が選択されていた場合、顧客テーブルに接続するた
めのパスワードを特定できます。

この設定は標準では有効ではありません。

デフォルト値:

--- some_password

Customer::AuthModule::DB::Table

もし、Customer::AuthModuleに関して“DB”が選択されていた場合、顧客データが格納されるべ
きテーブル名を特定する必要があります。

この設定は無効化することはできません。

デフォルト値:

--- customer_user

Customer::AuthModule::DB::Type

もし、Customer::AuthModuleに関して“DB”が選択されていた場合、データベース・ドライバー
（通常は自動ディテクションが使用される）を特定できます。

この設定は標準では有効ではありません。

デフォルト値:

--- mysql

Customer::AuthModule::DB::User

もし、Customer::AuthModuleに関して“DB”が選択されていた場合、顧客テーブルに接続するた
めのユーザ名を特定できます。

この設定は標準では有効ではありません。

デフォルト値:
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--- some_user

Customer::AuthModule::DB::bcryptCost

If "bcrypt" was selected for CryptType, use cost specified here for bcrypt hashing.
Currently max. supported cost value is 31.

この設定は無効化することはできません。

デフォルト値:

--- '12'

Customer::AuthModule::HTTPBasicAuth::Replace

Customer::AuthModuleに関して"HTTPBasicAuth"が選択されていた場合、ユーザ名の始まり
の部分を削除することができます（例：ドメインにおいて、example_domain\userをuserに変
える）。

この設定は標準では有効ではありません。

デフォルト値:

--- example_domain\\

Customer::AuthModule::HTTPBasicAuth::ReplaceRegExp

Customer::AuthModuleに関して"HTTPBasicAuth"が選択されていた場合、（RegExpを使用す
ることで）REMOTE_USERの部分を削除することができます（例：trailing domainsを削除する
など）。RegExp-Note, $1が新しいログインとなります。

この設定は標準では有効ではありません。

デフォルト値:

--- ^(.+?)@.+?$

Customer::AuthModule::LDAP::AccessAttr

Customer::AuthModuleに関して、“LDAP”が選択されていた場合、ここにおいてアクセス属
性を特定することができます。

この設定は標準では有効ではありません。

デフォルト値:

--- memberUid

Customer::AuthModule::LDAP::AlwaysFilter

“LDAP”が選択されていた場合、LDAPクエリーそれぞれにフィルタを追加することができます。
例えば、(mail=*), (objectclass=user), (!objectclass=computer)などです。

この設定は標準では有効ではありません。

デフォルト値:

--- (!objectclass=computer)

Customer::AuthModule::LDAP::BaseDN

Customer::AuthModuleに関して、“LDAP”が選択されていた場合、BaseDNを特定する必要が
あります。

この設定は標準では有効ではありません。
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デフォルト値:

--- dc=example,dc=com

Customer::AuthModule::LDAP::Die

Customer::AuthModuleに関して“LDAP”が選択されている場合に、例えばサーバー接続が
ネットワークの問題で確立できない際に、アプリケーションを停止させるかどうかを設定でき
ます。

デフォルト値:

--- '1'

Customer::AuthModule::LDAP::GroupDN

Customer::AuthModuleに関して“LDAP”が選択されていた場合、ユーザについて、例えば
OTRSを利用するためグループxyzにいる必要がある場合に、posixGroupにいるという理由で
認証することを許可されるかどうかを、確認することができます。システムにアクセスする可
能性があるグループを特定してください。

この設定は標準では有効ではありません。

デフォルト値:

--- cn=otrsallow,ou=posixGroups,dc=example,dc=com

Customer::AuthModule::LDAP::Host

Customer::AuthModuleに関して、“LDAP”が選択されていた場合、LDAPホストを特定できま
す。

この設定は標準では有効ではありません。

デフォルト値:

--- ldap.example.com

Customer::AuthModule::LDAP::Params

Customer::AuthModuleに関して“LDAP”が選択されていて、Net::LDAP perl モジュールに対し
て特別なパラメータが必要な場合、ここで設定できます。パラメータに関するより詳細な情報
は、"perldoc Net::LDAPを参照ください。

この設定は標準では有効ではありません。

デフォルト値:

---
async: '0'
port: '389'
timeout: '120'
version: '3'

Customer::AuthModule::LDAP::SearchUserDN

Customer::AuthModuleに関して“LDAP”が選択されていて、ユーザがLDAPツリーに対して匿
名アクセスのみを持っていて、しかしながらデータを検索したいという場合、これをLDAP
ディレクトリへのアクセスを持つユーザによって行うことができます。この特別なユーザにつ
いて、ここでユーザ名を特定してください。

この設定は標準では有効ではありません。

デフォルト値:

--- cn=binduser,ou=users,dc=example,dc=com
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Customer::AuthModule::LDAP::SearchUserPw

Customer::AuthModuleに関して“LDAP”が選択されていて、ユーザがLDAPツリーに対して匿
名アクセスのみを持っていて、しかしながらデータを検索したいという場合、これをLDAP
ディレクトリへのアクセスを持つユーザによって行うことができます。この特別なユーザにつ
いて、ここでパスワードを設定してください。

この設定は標準では有効ではありません。

デフォルト値:

--- some_password

Customer::AuthModule::LDAP::UID

Customer::AuthModuleに関して、“LDAP”が選択されていた場合、ユーザ識別子を特定する
必要があります。

この設定は標準では有効ではありません。

デフォルト値:

--- uid

Customer::AuthModule::LDAP::UserAttr

Customer::AuthModuleに関して、“LDAP”が選択されていた場合、ユーザ属性を特定するこ
とができます。LDAPのためにposixGroupはUIDを使用し、non LDAP posixGroupはfull user
DNを使用します。

この設定は標準では有効ではありません。

デフォルト値:

--- UID

Customer::AuthModule::LDAP::UserSuffix

Customer::AuthModuleに関して“LDAP”が選択されていて、全ての顧客ログイン名に
suffix（後ろに付く接尾辞）を追加したい場合、ここで特定してください。例えば、ユーザ名の
みを書いても、ユーザがLDAPディレクトリの中ではuser@domainとして存在するなどです。

この設定は標準では有効ではありません。

デフォルト値:

--- '@domain.com'

Customer::AuthModule::Radius::Die

Customer::AuthModuleに関して“Radius”が選択されていた場合、例えばサーバー接続がネッ
トワークの問題で確立できない際に、アプリケーションを停止させるかどうかを設定できま
す。

デフォルト値:

--- '1'

Customer::AuthModule::Radius::Host

Customer::AuthModuleに関して“Radius”が選択されていた場合、radiusホストを特定する必
要があります。

この設定は標準では有効ではありません。
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デフォルト値:

--- radiushost

Customer::AuthModule::Radius::Password

Customer::AuthModuleに関して“Radius”が選択されていた場合、radiusホストに対する認証
を行うためのパスワードを特定する必要があります。

この設定は標準では有効ではありません。

デフォルト値:

--- radiussecret

9. Core → Auth → Customer →
TwoFactor

Customer::AuthTwoFactorModule

Defines the two-factor module to authenticate customers.

この設定は標準では有効ではありません。

デフォルト値:

--- Kernel::System::CustomerAuth::TwoFactor::GoogleAuthenticator

Customer::AuthTwoFactorModule::AllowEmptySecret

Defines if customers should be allowed to login if they have no shared secret stored
in their preferences and therefore are not using two-factor authentication.

デフォルト値:

--- '1'

Customer::AuthTwoFactorModule::AllowPreviousToken

Defines if the previously valid token should be accepted for authentication. This is
slightly less secure but gives users 30 seconds more time to enter their one-time
password.

デフォルト値:

--- '1'

Customer::AuthTwoFactorModule::SecretPreferencesKey

Defines the customer preferences key where the shared secret key is stored.

この設定は無効化することはできません。

デフォルト値:

--- UserGoogleAuthenticatorSecretKey

10. Core → Autoload
AutoloadPerlPackages###1000-Test

パッケージの自動ロード設定の例

363



この設定は標準では有効ではありません。

デフォルト値:

---
- Kernel::Autoload::Test

11. Core → Cache
Cache::InBackend

If enabled, the cache data will be stored in cache backend.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Cache::InMemory

If enabled, the cache data be held in memory.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Cache::Module

使用するキャッシュバックエンドを選択してください。

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::Cache::FileStorable

Cache::SubdirLevels

Specify how many sub directory levels to use when creating cache files. This should
prevent too many cache files being in one directory.

この設定は無効化することはできません。

デフォルト値:

--- '2'

12. Core → Chat
ChatEngine::Active

チャットサポートを有効にする

この設定は無効化することはできません。

デフォルト値:

--- 0
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ChatEngine::ChatDecayTime

チャットが削除されるまでの日数

デフォルト値:

--- '365'

ChatEngine::ChatDirection::AgentToAgent

エージェント画面からエージェントとのチャットが開始出来るようにする

この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::ChatDirection::AgentToCustomer

エージェント画面から顧客とのチャットが開始出来るようにする

この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::ChatDirection::CustomerToAgent

Makes it possible to start a chat with an agent from the external interface as
authenticated user.

この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::ChatDirection::PublicToAgent

Makes it possible to start a chat with an agent from the external interface as
unauthenticated user.

この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::ChatIntegration::VideoChatEnabled

Defines if the video and audio calling feature is enabled for integrated chat.

この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::ChatOrder

Defines the order of chat windows.

この設定は無効化することはできません。
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デフォルト値:

--- '1'

ChatEngine::ChatTTL

チャットが削除されるまでの時間

デフォルト値:

--- '24'

ChatEngine::DefaultAgentName

Default agent name in the external interface. If enabled, the real name of the agent
will not be visible to users while using the chat.

この設定は標準では有効ではありません。

デフォルト値:

--- Support Agent

ChatEngine::DefaultAgentNameNumbers

Defines if numbers should be appended to DefaultAgentName. If enabled, together
with DefaultAgentName will be numbers (e.g. 1,2,3,...).

この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::DefaultChatChannel

Name of default chat channel. If this channel does not exist, it will be created
automatically. Please do not create a chat channel with the same name as default
chat channel. The default channel won't be displayed, if chat channels are enabled in
Customer interface and Public interface. All agent to agent chats will be in the default
channel.

この設定は無効化することはできません。

デフォルト値:

--- Default channel

ChatEngine::ExternalFrontend::AllowChatChannels

Defines if users in the external interface are able to select Chat Channel. If not, chat
will be created in default Chat Channel.

この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::ExternalFrontend::AvailabilityCheck

Allow users to select only channels that have available agent(s) in the external
interface.
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この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::ExternalFrontend::NoAnswerThreshold

Defines the period of time (in minutes) before no answer message is displayed to the
users in the external interface.

この設定は無効化することはできません。

デフォルト値:

--- '5'

ChatEngine::ExternalFrontend::VideoChatEnabled

Defines if the video and audio calling feature is enabled for users of the external
interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

ChatEngine::PermissionGroup::ChatReceivingAgents

チャットと、チャットリクエストを受けることの出来るエージェントグループ

この設定は無効化することはできません。

デフォルト値:

--- users

ChatEngine::PermissionGroup::ChatStartingAgents

チャットリクエストが作成できるエージェントグループ

この設定は無効化することはできません。

デフォルト値:

--- users

ChatEngine::PermissionGroup::VideoChatAgents

Agent group that can use video calling feature in chats.

この設定は無効化することはできません。

デフォルト値:

--- users

Ticket::Agent::DisplayNotificationIfUnavailable

If enabled, a notification will be displayed on each page if the current agent is not
available for chat.

デフォルト値:
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--- '1'

Ticket::Agent::StartChatFromTicket###AllowChatOnlyIfCustomerAvailable

If enabled, starting a chat from agent ticket zoom view will only be possible, if the
ticket customer is on-line.

デフォルト値:

--- '1'

Ticket::Agent::StartChatFromTicket###Allowed

Sets if a chat request can be sent out from agent ticket zoom view.

デフォルト値:

--- '1'

Ticket::Agent::StartChatFromTicket###PermissionLevel

Permission level to start a chat with customer from agent ticket zoom view.

デフォルト値:

--- ro

Ticket::Agent::StartChatFromTicket###RequiredLock

Defines if locking a ticket is required to start a chat with the customer from the ticket
zoom view.

デフォルト値:

--- 0

Ticket::Agent::StartChatWOTicket

If enabled, agents can start a chat with a customer without a ticket.

デフォルト値:

--- '1'

Ticket::Agent::UnavailableForExternalChatsOnLogin

If enabled it will check agents availability on login. If user is available for external
chats, it will reduce availability to internal chats only.

デフォルト値:

--- '1'

13. Core → CommunicationChannel
CommunicationChannel###Chat

チャット・コミュニケーション・チャネルを定義します。

デフォルト値:

---
Description: Chat communication channel.
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Icon: fa-comment
Module: Kernel::System::CommunicationChannel::Chat
Name: Chat

CommunicationChannel###Email

電子メール・コミュニケーション・チャネルを定義します。

デフォルト値:

---
Description: Email communication channel.
Icon: fa-envelope
Module: Kernel::System::CommunicationChannel::Email
Name: Email

CommunicationChannel###Internal

内部コミュニケーション・チャネルを定義します。

デフォルト値:

---
Description: Internal communication channel.
Icon: fa-cloud
Module: Kernel::System::CommunicationChannel::Internal
Name: OTRS

CommunicationChannel###Phone

電話コミュニケーション・チャネルを定義します。

デフォルト値:

---
Description: Phone communication channel.
Icon: fa-phone
Module: Kernel::System::CommunicationChannel::Phone
Name: Phone

CommunicationChannel###SMS

Defines SMS communication channel.

デフォルト値:

---
Description: SMS communication channel.
Icon: fa-mobile
Module: Kernel::System::CommunicationChannel::SMS
Name: SMS

14. Core → CommunicationChannel →
MIMEBase

Ticket::Article::Backend::MIMEBase::ArticleDataDir

Specifies the directory to store the data in, if "FS" was selected for ArticleStorage.

この設定は無効化することはできません。

デフォルト値:

--- <OTRS_CONFIG_Home>/var/article
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Ticket::Article::Backend::MIMEBase::ArticleStorage

Saves the attachments of articles. "DB" stores all data in the database (not
recommended for storing big attachments). "FS" stores the data on the filesystem; this
is faster but the webserver should run under the OTRS user. You can switch between
the modules even on a system that is already in production without any loss of data.
Note: Searching for attachment names is not supported when "FS" is used.

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::Ticket::Article::Backend::MIMEBase::ArticleStorageDB

Ticket::Article::Backend::MIMEBase::CheckAllStorageBackends

Specifies whether all storage backends should be checked when looking for
attachments. This is only required for installations where some attachments are in the
file system, and others in the database.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Article::Backend::MIMEBase::IndexAttachmentNames

Specifies whether the (MIMEBase) article attachments will be indexed and searchable.

この設定は無効化することはできません。

デフォルト値:

--- '1'

15. Core → CommunicationLog
CommunicationLog::PurgeAfterHours::AllCommunications

Defines the number of hours a communication will be stored, whichever its status.

この設定は無効化することはできません。

デフォルト値:

--- '744'

CommunicationLog::PurgeAfterHours::SuccessfulCommunications

Defines the number of hours a successful communication will be stored.

この設定は無効化することはできません。

デフォルト値:

--- '168'

CommunicationLog::Transport###CloudService

Registers a log module, that can be used to log communication related information.

この設定は無効化することはできません。
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デフォルト値:

---
Module: Kernel::System::CommunicationLog::Transport::CloudService
Name: CloudService

CommunicationLog::Transport###Email

Registers a log module, that can be used to log communication related information.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::System::CommunicationLog::Transport::Email
Name: Email

16. Core → Crypt → PGP
PGP

PGPを有効化します。PGPサポートでメールの署名と暗号化が有効になっている場合
は、.gnupgフォルダにアクセスする際の権限問題を回避するため、WebサーバーをOTRSユー
ザーとして実行することを強くお勧めします。

この設定は無効化することはできません。

デフォルト値:

--- 0

PGP::Bin

PGPバイナリへのパスを定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- /usr/bin/gpg

PGP::Key::Password

秘密PGP鍵のためのパスワードを設定します。

この設定は無効化することはできません。

デフォルト値:

---
488A0B8F: SomePassword
D2DF79FA: SomePassword

PGP::Log

PGPのための利用者独自のログテキストを設定します。

この設定は無効化することはできません。

デフォルト値:

---
BADSIG: The PGP signature with the keyid has not been verified successfully.
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ERRSIG: It was not possible to check the PGP signature, this may be caused by a missing
  public key or an unsupported algorithm.
EXPKEYSIG: The PGP signature was made by an expired key.
GOODSIG: Good PGP signature.
KEYREVOKED: The PGP signature was made by a revoked key, this could mean that the
  signature is forged.
NODATA: No valid OpenPGP data found.
NO_PUBKEY: No public key found.
REVKEYSIG: The PGP signature was made by a revoked key, this could mean that the
 signature
  is forged.
SIGEXPIRED: The PGP signature is expired.
SIG_ID: Signature data.
TRUST_UNDEFINED: This key is not certified with a trusted signature!.
VALIDSIG: The PGP signature with the keyid is good.

PGP::Method

Sets the method PGP will use to sing and encrypt emails. Note Inline method is not
compatible with RichText messages.

この設定は無効化することはできません。

デフォルト値:

--- Detached

PGP::Options

PGPバイナリのためのオプションを設定します。

この設定は無効化することはできません。

デフォルト値:

--- --homedir /opt/otrs/.gnupg/ --batch --no-tty --yes

PGP::Options::DigestPreference

Sets the preferred digest to be used for PGP binary.

デフォルト値:

--- sha256

PGP::TrustedNetwork

Enable this if you trust in all your public and private pgp keys, even if they are not
certified with a trusted signature.

デフォルト値:

--- 0

17. Core → Crypt → SMIME
SMIME

S/MIMEサポートを有効にします。

この設定は無効化することはできません。

デフォルト値:

--- 0
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SMIME::Bin

sslバイナリを開くためのパスを定義します。HOME env ($ENV{HOME} = '/var/lib/
wwwrun';).が必要になるかもしれません。

この設定は標準では有効ではありません。

デフォルト値:

--- /usr/bin/openssl

SMIME::CacheTTL

Cache time in seconds for the SSL certificate attributes.

この設定は無効化することはできません。

デフォルト値:

--- '86400'

SMIME::CertPath

SSL認証が格納されるディレクトリを特定します。

この設定は標準では有効ではありません。

デフォルト値:

--- /etc/ssl/certs

SMIME::FetchFromCustomer

顧客ユーザー情報サポートからS / MIME設定を取得できるようにします。

この設定は無効化することはできません。

デフォルト値:

--- 0

SMIME::PrivatePath

秘密SSL認証が格納されるディレクトリを特定します。

この設定は標準では有効ではありません。

デフォルト値:

--- /etc/ssl/private

18. Core → Customer
Customer::DefaultUserID

Defines the (agent) user identifier for actions triggered by customers.

この設定は無効化することはできません。

デフォルト値:

--- '1'
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CustomerDisableCompanyTicketAccess

This option will deny the access to customer company tickets, which are not created
by the customer user.

この設定は無効化することはできません。

デフォルト値:

--- 0

CustomerGroupAlwaysGroups

全顧客が所属するグループを定義します（CustomerGroupSupportが有効であり、全顧客ユー
ザをこれらのグループで管理したくない場合）。

この設定は無効化することはできません。

デフォルト値:

---
- users

CustomerGroupCompanyAlwaysGroups

Defines the groups every customer will be in (if CustomerGroupSupport is enabled
and you don't want to manage every customer for these groups).

この設定は無効化することはできません。

デフォルト値:

---
- users

CustomerGroupPermissionContext###001-CustomerID-same

Defines a permission context for customer to group assignment.

この設定は無効化することはできません。

デフォルト値:

---
Description: Gives customer users group based access to tickets from customer users
  of the same customer (ticket CustomerID is a CustomerID of the customer user).
Name: Same Customer
Value: Ticket::CustomerID::Same

CustomerGroupPermissionContext###100-CustomerID-other

Defines a permission context for customer to group assignment.

この設定は標準では有効ではありません。

デフォルト値:

---
Description: Provides customer users access to tickets even if the tickets are not
  assigned to a customer user of the same customer ID(s), based on permission groups.
Name: Other Customers
Value: Ticket::CustomerID::Other

CustomerGroupSupport

Activates support for customer and customer user groups.
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この設定は無効化することはできません。

デフォルト値:

--- 0

CustomerPreferences

顧客プレファレンス・テーブルのためのパラメータを定義してください。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::System::CustomerUser::Preferences::DB
Params:
  Table: customer_preferences
  TableKey: preferences_key
  TableUserID: user_id
  TableValue: preferences_value

19. Core → DB → Mirror
Core::MirrorDB::AdditionalMirrors###1

Configure any additional readonly mirror databases that you want to use.

この設定は標準では有効ではありません。

デフォルト値:

---
DSN: DBI:mysql:database=mirrordb;host=mirrordbhost
Password: some_password
User: some_user

Core::MirrorDB::AdditionalMirrors###2

Configure any additional readonly mirror databases that you want to use.

この設定は標準では有効ではありません。

デフォルト値:

---
DSN: DBI:mysql:database=mirrordb;host=mirrordbhost
Password: some_password
User: some_user

Core::MirrorDB::AdditionalMirrors###3

Configure any additional readonly mirror databases that you want to use.

この設定は標準では有効ではありません。

デフォルト値:

---
DSN: DBI:mysql:database=mirrordb;host=mirrordbhost
Password: some_password
User: some_user

Core::MirrorDB::AdditionalMirrors###4

Configure any additional readonly mirror databases that you want to use.
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この設定は標準では有効ではありません。

デフォルト値:

---
DSN: DBI:mysql:database=mirrordb;host=mirrordbhost
Password: some_password
User: some_user

Core::MirrorDB::AdditionalMirrors###5

Configure any additional readonly mirror databases that you want to use.

この設定は標準では有効ではありません。

デフォルト値:

---
DSN: DBI:mysql:database=mirrordb;host=mirrordbhost
Password: some_password
User: some_user

Core::MirrorDB::DSN

OTRSは、フルテキスト検索や統計生成などの高価な操作に、1つまたは複数の読み取り専用ミ
ラーデータベースを使用できます。 ここでは、最初のミラーデータベースのDSNを指定できま
す。

この設定は標準では有効ではありません。

デフォルト値:

--- DBI:mysql:database=mirrordb;host=mirrordbhost

Core::MirrorDB::Password

データベースの第一ミラーの認証パスワードを指定してください。

この設定は標準では有効ではありません。

デフォルト値:

--- some_password

Core::MirrorDB::User

Specify the username to authenticate for the first mirror database.

この設定は標準では有効ではありません。

デフォルト値:

--- some_user

20. Core → DocumentSearch → Driver
DocumentSearch::Drivers::Appointment::Enabled

It controls availability for Appointment search driver.

この設定は無効化することはできません。

デフォルト値:
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--- '1'

DocumentSearch::Drivers::ArticleChat::Enabled

It controls availability for ArticleChat search driver.

この設定は無効化することはできません。

デフォルト値:

--- '1'

DocumentSearch::Drivers::ArticleMIME::Enabled

It controls availability for ArticleMIME search driver.

この設定は無効化することはできません。

デフォルト値:

--- '1'

DocumentSearch::Drivers::ArticleSMS::Enabled

It controls availability for ArticleSMS search driver.

この設定は無効化することはできません。

デフォルト値:

--- '1'

DocumentSearch::Drivers::CustomPageContent::Enabled

It controls availability for Custom Page Content search driver.

この設定は無効化することはできません。

デフォルト値:

--- '1'

DocumentSearch::Drivers::FAQ::Enabled

It controls availability for FAQ search driver.

この設定は無効化することはできません。

デフォルト値:

--- '1'

DocumentSearch::Drivers::ServiceCatalogueContent::Enabled

It controls availability for Customer Service Catalogue Content search driver.

この設定は無効化することはできません。

デフォルト値:

--- '1'

DocumentSearch::Drivers::Ticket::Enabled

It controls availability for Ticket search driver.
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この設定は無効化することはできません。

デフォルト値:

--- '1'

21. Core → Draft
FormDraftTTL###Ticket

Defines time in minutes since last modification for drafts of specified type before they
are considered expired.

デフォルト値:

--- '10080'

22. Core → DynamicFields →
DriverRegistration

DynamicFields::Driver###ActivityID

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
ConfigDialog: AdminDynamicFieldText
DisabledAdd: '1'
DisplayName: ActivityID
Module: Kernel::System::DynamicField::Driver::ProcessManagement::ActivityID

DynamicFields::Driver###Checkbox

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
ConfigDialog: AdminDynamicFieldCheckbox
DisplayName: Checkbox
Module: Kernel::System::DynamicField::Driver::Checkbox

DynamicFields::Driver###ContactWithData

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
ConfigDialog: AdminDynamicFieldContactWithData
DisplayName: Contact with data
Module: Kernel::System::DynamicField::Driver::ContactWithData

DynamicFields::Driver###Date

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
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ConfigDialog: AdminDynamicFieldDateTime
DisplayName: Date
Module: Kernel::System::DynamicField::Driver::Date

DynamicFields::Driver###DateTime

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
ConfigDialog: AdminDynamicFieldDateTime
DisplayName: Date / Time
Module: Kernel::System::DynamicField::Driver::DateTime

DynamicFields::Driver###Dropdown

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
ConfigDialog: AdminDynamicFieldDropdown
DisplayName: Dropdown
Module: Kernel::System::DynamicField::Driver::Dropdown

DynamicFields::Driver###Multiselect

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
ConfigDialog: AdminDynamicFieldMultiselect
DisplayName: Multiselect
ItemSeparator: ', '
Module: Kernel::System::DynamicField::Driver::Multiselect

DynamicFields::Driver###ProcessID

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
ConfigDialog: AdminDynamicFieldText
DisabledAdd: '1'
DisplayName: ProcessID
Module: Kernel::System::DynamicField::Driver::ProcessManagement::ProcessID

DynamicFields::Driver###Text

ダイナミック・フィールドのバックエンド登録

デフォルト値:

---
ConfigDialog: AdminDynamicFieldText
DisplayName: Text
Module: Kernel::System::DynamicField::Driver::Text

DynamicFields::Driver###TextArea

ダイナミック・フィールドのバックエンド登録

デフォルト値:
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---
ConfigDialog: AdminDynamicFieldText
DisplayName: Textarea
Module: Kernel::System::DynamicField::Driver::TextArea

23. Core → DynamicFields →
ObjectTypeRegistration

DynamicFields::ObjectType###Article

ダイナミックフィールドのオブジェクト登録

デフォルト値:

---
DisplayName: Article
Module: Kernel::System::DynamicField::ObjectType::Article
Prio: '110'

DynamicFields::ObjectType###CustomerCompany

ダイナミックフィールドのオブジェクト登録

デフォルト値:

---
DisplayName: Customer
Module: Kernel::System::DynamicField::ObjectType::CustomerCompany
Prio: '120'
UseObjectName: '1'

DynamicFields::ObjectType###CustomerUser

ダイナミックフィールドのオブジェクト登録

デフォルト値:

---
DisplayName: Customer User
Module: Kernel::System::DynamicField::ObjectType::CustomerUser
Prio: '130'
UseObjectName: '1'

DynamicFields::ObjectType###FAQ

ダイナミックフィールドのオブジェクト登録

デフォルト値:

---
DisplayName: FAQ
Module: Kernel::System::DynamicField::ObjectType::FAQ
Prio: '200'

DynamicFields::ObjectType###Ticket

ダイナミックフィールドのオブジェクト登録

デフォルト値:

---
DisplayName: Ticket
Module: Kernel::System::DynamicField::ObjectType::Ticket
Prio: '100'
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24. Core → Email
AdminEmail

システム管理者のEメール・アドレスを定義します。アプリケーションのエラー画面に表示さ
れるものです。

この設定は無効化することはできません。

デフォルト値:

--- support@<OTRS_CONFIG_FQDN>

CheckEmailAddresses

アプリケーションにEメール・アドレスのシンタクスをチェックさせます。

この設定は無効化することはできません。

デフォルト値:

--- '1'

CheckEmailInvalidAddress

アプリケーションで使用されるべきではない全Eメール・アドレスをフィルタするための、一
般表現を定義します。

この設定は無効化することはできません。

デフォルト値:

--- '@(example)\.(..|...)$'

CheckEmailValidAddress

一部のアドレスをシンタクスのチェックから除外する、通常の表現を定義します
（"CheckEmailAddresses"が“Yes”に設定されている場合）。このフィールドに、構文的には有
効でないがシステムには必要であるEメールアドレス（例："root@localhost"）に関するregrex
を入力してください。

この設定は無効化することはできません。

デフォルト値:

--- ^(root@localhost|admin@localhost)$

CheckMXRecord

Eメールの送信または電話/Eメール・チケットの提出の前に、アプリケーションにEメール・ア
ドレスのMXレコードをチェックさせるようにします。

この設定は無効化することはできません。

デフォルト値:

--- '1'

CheckMXRecord::Nameserver

必要な場合には"CheckMXRecord"検索のための、専用DNSサーバのアドレスを定義します。

この設定は標準では有効ではありません。
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デフォルト値:

--- ns.example.com

Fetchmail::Bin

Defines the fall-back path to open fetchmail binary. Note: The name of the binary
needs to be 'fetchmail', if it is different please use a symbolic link.

この設定は標準では有効ではありません。

デフォルト値:

--- /usr/bin/fetchmail

NotificationSenderEmail

Specifies the email address that should be used by the application when sending
notifications. The email address is used to build the complete display name for the
notification master (i.e. "OTRS Notifications" otrs@your.example.com). You can use
the OTRS_CONFIG_FQDN variable as set in your configuation, or choose another email
address.

この設定は無効化することはできません。

デフォルト値:

--- otrs@<OTRS_CONFIG_FQDN>

NotificationSenderName

Specifies the name that should be used by the application when sending notifications.
The sender name is used to build the complete display name for the notification
master (i.e. "OTRS Notifications" otrs@your.example.com).

この設定は無効化することはできません。

デフォルト値:

--- OTRS Notifications

Sendmail::DefaultHeaders

Defines default headers for outgoing emails.

この設定は標準では有効ではありません。

デフォルト値:

---
'Auto-Submitted:': auto-generated
'Precedence:': bulk

SendmailBcc

Bccを経由して特定されたアドレスに送信Eメールを送ります。バックアップ目的のためにのみ
使用してください。

デフォルト値:

--- ''

SendmailEncodingForce

送信Eメールのエンコードを強制します(7bit|8bit|quoted-printable|base64)。
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この設定は標準では有効ではありません。

デフォルト値:

--- base64

SendmailEnvelopeFrom

If set, this address is used as envelope sender in outgoing messages (not notifications
- see below). If no address is specified, the envelope sender is equal to queue e-mail
address.

この設定は標準では有効ではありません。

デフォルト値:

--- ''

SendmailModule

メールを送信するためのモジュールを定義します。"Sendmail"は、ご利用のオペレーティン
グ・システムのsendmailバイナリを直接使用します。"SMTP"メカニズムのいずれもが、特定
された（外部）メール・サーバを使用します。"DoNotSendEmail"は、Eメールを送らないもの
で、システム・テストの際に役立ちます。

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::Email::Sendmail

SendmailModule::AuthPassword

"SMTP"構造のいずれかがSendmailモジュールとして選択され、かつメール・サーバへの認証
が必要な場合、パスワードを特定する必要があります。

この設定は標準では有効ではありません。

デフォルト値:

--- MailserverPassword

SendmailModule::AuthUser

"SMTP"構造のいずれかがSendmailモジュールとして選択され、かつメール・サーバへの認証
が必要な場合、ユーザ名を特定する必要があります。

この設定は標準では有効ではありません。

デフォルト値:

--- MailserverLogin

SendmailModule::CMD

"Sendmail"がSendmailモジュールとして選択された場合、sendmailバイナリおよび必要オプ
ションのロケーションが特定されている必要があります。

この設定は無効化することはできません。

デフォルト値:

--- /usr/sbin/sendmail -i -f
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SendmailModule::Host

"SMTP"構造のいずれかがSendmailモジュールとして選択された場合、メールを送信するメー
ル・ホストが特定されている必要があります。

この設定は無効化することはできません。

デフォルト値:

--- mail.example.com

SendmailModule::Port

"SMTP"構造のいずれかがSendmailモジュールとして選択された場合、メール・サーバが受信
接続をlistenしている（待っている）ポートが特定されている必要があります。

この設定は標準では有効ではありません。

デフォルト値:

--- '25'

SendmailNotificationEnvelopeFrom

If set, this address is used as envelope sender header in outgoing notifications.
If no address is specified, the envelope sender header is empty (unless
SendmailNotificationEnvelopeFrom::FallbackToEmailFrom is set).

この設定は標準では有効ではありません。

デフォルト値:

--- ''

SendmailNotificationEnvelopeFrom::FallbackToEmailFrom

If no SendmailNotificationEnvelopeFrom is specified, this setting makes it possible to
use the email's from address instead of an empty envelope sender (required in certain
mail server configurations).

この設定は標準では有効ではありません。

デフォルト値:

--- 0

25. Core → Email → PostMaster
AutoResponseForWebTickets

If this option is enabled, tickets created via the web interface, via external or agent
interface, will receive an autoresponse if configured. If this option is not enabled, no
autoresponses will be sent.

この設定は無効化することはできません。

デフォルト値:

--- '1'

KeepStateHeader

Defines the PostMaster header to be used on the filter for keeping the current state
of the ticket.
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デフォルト値:

--- X-OTRS-FollowUp-State-Keep

LoopProtectionLog

ログ・ファイルのパスです（LoopProtectionModuleに関して“FS”が選択されており、それが強
制である場合にのみ適用されます）。

この設定は無効化することはできません。

デフォルト値:

--- <OTRS_CONFIG_Home>/var/log/LoopProtection

LoopProtectionModule

デフォルトのループ・プロテクション・モジュールです。

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::PostMaster::LoopProtection::DB

PostMaster::CheckFollowUpModule###0000-BounceEmail

Executes follow-up checks on OTRS Header 'X-OTRS-Bounce'.

デフォルト値:

---
Module: Kernel::System::PostMaster::FollowUpCheck::BounceEmail

PostMaster::CheckFollowUpModule###0100-Subject

Checks if an E-Mail is a followup to an existing ticket by searching the subject for a
valid ticket number.

デフォルト値:

---
Module: Kernel::System::PostMaster::FollowUpCheck::Subject

PostMaster::CheckFollowUpModule###0200-References

Executes follow-up checks on In-Reply-To or References headers for mails that don't
have a ticket number in the subject.

デフォルト値:

---
Module: Kernel::System::PostMaster::FollowUpCheck::References

PostMaster::CheckFollowUpModule###0300-Body

Executes follow-up checks on email body for mails that don't have a ticket number
in the subject.

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::System::PostMaster::FollowUpCheck::Body
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PostMaster::CheckFollowUpModule###0400-Attachments

Executes follow-up checks on attachment contents for mails that don't have a ticket
number in the subject.

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::System::PostMaster::FollowUpCheck::Attachments

PostMaster::CheckFollowUpModule###0500-RawEmail

Executes follow-up checks on the raw source email for mails that don't have a ticket
number in the subject.

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::System::PostMaster::FollowUpCheck::RawEmail

PostMaster::NewTicket::AutoAssignCustomerIDForUnknownCustomers

Controls if CustomerID is automatically copied from the sender address for unknown
customers.

この設定は無効化することはできません。

デフォルト値:

--- '1'

PostMaster::PreCreateFilterModule###000-FollowUpArticleVisibilityCheck

Module to check if arrived emails should be marked as internal (because of original
forwarded internal email). IsVisibleForCustomer and SenderType define the values for
the arrived email/article.

デフォルト値:

---
IsVisibleForCustomer: '0'
Module: Kernel::System::PostMaster::Filter::FollowUpArticleVisibilityCheck
SenderType: customer

PostMaster::PreFilterModule###000-DecryptBody

Module to filter encrypted bodies of incoming messages.

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::System::PostMaster::Filter::Decrypt
StoreDecryptedBody: '0'

PostMaster::PreFilterModule###000-DetectAttachment

Module used to detect if attachments are present.

デフォルト値:

386



---
Module: Kernel::System::PostMaster::Filter::DetectAttachment

PostMaster::PreFilterModule###000-DetectBounceEmail

Module to check if a incoming e-mail message is bounce.

デフォルト値:

---
Module: Kernel::System::PostMaster::Filter::DetectBounceEmail

PostMaster::PreFilterModule###000-ExternalTicketNumberRecognition1

Recognize if a ticket is a follow-up to an existing ticket using an external ticket number.

この設定は標準では有効ではありません。

デフォルト値:

---
DynamicFieldName: Name_X
FromAddressRegExp: \s*@example.com
IsVisibleForCustomer: '1'
Module: Kernel::System::PostMaster::Filter::ExternalTicketNumberRecognition
Name: Some Description
NumberRegExp: \s*Incident-(\d.*)\s*
SearchInBody: '1'
SearchInSubject: '1'
SenderType: system
TicketStateTypes: new;open

PostMaster::PreFilterModule###000-ExternalTicketNumberRecognition2

Recognize if a ticket is a follow-up to an existing ticket using an external ticket number.

この設定は標準では有効ではありません。

デフォルト値:

---
DynamicFieldName: Name_X
FromAddressRegExp: \s*@example.com
IsVisibleForCustomer: '1'
Module: Kernel::System::PostMaster::Filter::ExternalTicketNumberRecognition
Name: Some Description
NumberRegExp: \s*Incident-(\d.*)\s*
SearchInBody: '1'
SearchInSubject: '1'
SenderType: system
TicketStateTypes: new;open

PostMaster::PreFilterModule###000-ExternalTicketNumberRecognition3

Recognize if a ticket is a follow-up to an existing ticket using an external ticket number.

この設定は標準では有効ではありません。

デフォルト値:

---
DynamicFieldName: Name_X
FromAddressRegExp: \s*@example.com
IsVisibleForCustomer: '1'
Module: Kernel::System::PostMaster::Filter::ExternalTicketNumberRecognition
Name: Some Description
NumberRegExp: \s*Incident-(\d.*)\s*
SearchInBody: '1'
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SearchInSubject: '1'
SenderType: system
TicketStateTypes: new;open

PostMaster::PreFilterModule###000-ExternalTicketNumberRecognition4

Recognize if a ticket is a follow-up to an existing ticket using an external ticket number.

この設定は標準では有効ではありません。

デフォルト値:

---
DynamicFieldName: Name_X
FromAddressRegExp: \s*@example.com
IsVisibleForCustomer: '1'
Module: Kernel::System::PostMaster::Filter::ExternalTicketNumberRecognition
Name: Some Description
NumberRegExp: \s*Incident-(\d.*)\s*
SearchInBody: '1'
SearchInSubject: '1'
SenderType: system
TicketStateTypes: new;open

PostMaster::PreFilterModule###000-MatchDBSource

データベース・フィルター・ストレージを使用するモジュールです。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::System::PostMaster::Filter::MatchDBSource

PostMaster::PreFilterModule###000-SMIMEFetchFromCustomer

Module to fetch customer users SMIME certificates of incoming messages.

デフォルト値:

---
Module: Kernel::System::PostMaster::Filter::SMIMEFetchFromCustomer

PostMaster::PreFilterModule###1-Match

受信メッセージについてフィルターし操作するためのモジュールです。From: noreply@
addressを用いて、全てのスパム・メールをブロック/無視します。

この設定は標準では有効ではありません。

デフォルト値:

---
Match:
  From: noreply@
Module: Kernel::System::PostMaster::Filter::Match
Set:
  X-OTRS-Ignore: yes

PostMaster::PreFilterModule###2-Match

受信メッセージについてフィルターし操作するためのモジュールです。チケットのフリーテキ
ストに対して4桁の数字を得て、「Match」において正規表現を使用します。 （例：From / '(.
+?)@.+?'とし、「Set」にて「[***]」として後方参照を使用します。）

この設定は標準では有効ではありません。
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デフォルト値:

---
Match:
  Subject: SomeNumber:(\d\d\d\d)
Module: Kernel::System::PostMaster::Filter::Match
Set:
  X-OTRS-DynamicField-TicketFreeKey1: SomeNumber
  X-OTRS-DynamicField-TicketFreeText1: '[***]'

PostMaster::PreFilterModule###3-NewTicketReject

件名に有効なチケット番号を持たない全ての受信メールを、From: @example.com address
を用いてブロックします。

この設定は標準では有効ではありません。

デフォルト値:

---
Match:
  From: '@example.com'
Module: Kernel::System::PostMaster::Filter::NewTicketReject
Set:
  X-OTRS-Ignore: yes

PostMaster::PreFilterModule###4-CMD

CMD例のセットアップです。外部CMDがSTDOUTにおいてアウトプットを戻してくる場合にE
メールを無視します（Eメールは、STDIN of some.binへとパイプされます）。

この設定は標準では有効ではありません。

デフォルト値:

---
CMD: /usr/bin/some.bin
Module: Kernel::System::PostMaster::Filter::CMD
Set:
  X-OTRS-Ignore: yes

PostMaster::PreFilterModule###5-SpamAssassin

スパム・アサシンのセットアップ例です。スパム・アサシンによってマークされたEメールを
無視します。

この設定は標準では有効ではありません。

デフォルト値:

---
CMD: '/usr/bin/spamassassin | grep -i "X-Spam-Status: yes"'
Module: Kernel::System::PostMaster::Filter::CMD
Set:
  X-OTRS-Ignore: yes

PostMaster::PreFilterModule###6-SpamAssassin

SpamAssassinのセットアップ例です。マークされたメールを、スパム・キューへ移動しま
す。

この設定は標準では有効ではありません。

デフォルト値:

---
CMD: '/usr/bin/spamassassin | grep -i "X-Spam-Status: yes"'

389



Module: Kernel::System::PostMaster::Filter::CMD
Set:
  X-OTRS-Queue: spam

PostMaster::PreFilterModule::NewTicketReject::Body

リジェクトされたEメールの本文を定義します。

この設定は無効化することはできません。

デフォルト値:

--- "\nDear Customer,\n\nUnfortunately we could not detect a valid ticket number\nin
  your subject, so this email can't be processed.\n\nPlease create a new ticket via
  the customer panel.\n\nThanks for your help!\n\n Your Helpdesk Team\n"

PostMaster::PreFilterModule::NewTicketReject::Sender

Defines the sender for rejected emails.

この設定は標準では有効ではありません。

デフォルト値:

--- noreply@example.com

PostMaster::PreFilterModule::NewTicketReject::Subject

リジェクトされたEメールの件名を定義します。

この設定は無効化することはできません。

デフォルト値:

--- Email Rejected

PostMasterMaxEmailSize

POP3/POP3S/IMAP/IMAPS経由で取ってくることが可能なメールのKBytesの最大値です。

この設定は無効化することはできません。

デフォルト値:

--- '16384'

PostMasterReconnectMessage

一度にメール取得を実施可能な最大数に達しました。

この設定は無効化することはできません。

デフォルト値:

--- '20'

PostmasterAutoHTML2Text

HTMLメールをテキストメッセージに変換

この設定は無効化することはできません。

デフォルト値:

--- '1'
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PostmasterBounceEmailAsFollowUp

Indicates if a bounce e-mail should always be treated as normal follow-up.

この設定は無効化することはできません。

デフォルト値:

--- '1'

PostmasterDefaultPriority

新規チケットのデフォルトの優先度を定義します。

この設定は無効化することはできません。

デフォルト値:

--- 3 normal

PostmasterDefaultQueue

ポストマスターのデフォルトのキューを定義します。

この設定は無効化することはできません。

デフォルト値:

--- Raw

PostmasterDefaultState

新規チケットのデフォルトの状態を定義します。

この設定は無効化することはできません。

デフォルト値:

--- new

PostmasterFollowUpOnUnlockAgentNotifyOnlyToOwner

チケットがアンロックされた際に、所有者にのみ担当者フォローアップ通知を送信します (デ
フォルト設定では、全ての担当者に通知を送ります)。

この設定は無効化することはできません。

デフォルト値:

--- 0

PostmasterFollowUpState

フォローアップを受け取った場合のチケットの状態を定義します。

この設定は無効化することはできません。

デフォルト値:

--- open

PostmasterFollowUpStateClosed

クローズされたチケットに対してフォローアップを受け取った場合のチケットの状態を定義し
ます。
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この設定は標準では有効ではありません。

デフォルト値:

--- open

PostmasterHeaderFieldCount

Defines the number of header fields in frontend modules for add and update
postmaster filters. It can be up to 99 fields.

この設定は無効化することはできません。

デフォルト値:

--- '12'

PostmasterMaxEmails

1日においてEメール・アドレスを入手する自動メールによる返答の最大数です（ループ・プロ
テクション）。

この設定は無効化することはできません。

デフォルト値:

--- '40'

PostmasterMaxEmailsPerAddress

Maximal auto email responses to own email-address a day, configurable by email
address (Loop-Protection).

デフォルト値:

--- {}

PostmasterUserID

ポストマスター・データベースのユーザIDを特定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

PostmasterX-Header

スキャンされるべき全てのX－ヘッダーを定義します。

この設定は無効化することはできません。

デフォルト値:

---
- From
- To
- Cc
- Reply-To
- ReplyTo
- Subject
- Message-ID
- Message-Id
- Resent-To
- Resent-From
- Precedence
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- Mailing-List
- List-Id
- List-Archive
- Errors-To
- References
- In-Reply-To
- Auto-Submitted
- X-Loop
- X-Spam
- X-Spam-Flag
- X-Spam-Level
- X-Spam-Score
- X-Spam-Status
- X-No-Loop
- X-Priority
- Importance
- X-Mailer
- User-Agent
- Organization
- X-Original-To
- Delivered-To
- Envelope-To
- X-Envelope-To
- Return-Path
- X-OTRS-AttachmentExists
- X-OTRS-AttachmentCount
- X-OTRS-Owner
- X-OTRS-OwnerID
- X-OTRS-Responsible
- X-OTRS-ResponsibleID
- X-OTRS-Loop
- X-OTRS-Priority
- X-OTRS-Queue
- X-OTRS-Lock
- X-OTRS-Ignore
- X-OTRS-State
- X-OTRS-State-PendingTime
- X-OTRS-Type
- X-OTRS-Service
- X-OTRS-SLA
- X-OTRS-Title
- X-OTRS-CustomerNo
- X-OTRS-CustomerUser
- X-OTRS-SenderType
- X-OTRS-IsVisibleForCustomer
- X-OTRS-FollowUp-Owner
- X-OTRS-FollowUp-OwnerID
- X-OTRS-FollowUp-Responsible
- X-OTRS-FollowUp-ResponsibleID
- X-OTRS-FollowUp-Priority
- X-OTRS-FollowUp-Queue
- X-OTRS-FollowUp-Lock
- X-OTRS-FollowUp-State
- X-OTRS-FollowUp-State-PendingTime
- X-OTRS-FollowUp-Type
- X-OTRS-FollowUp-Service
- X-OTRS-FollowUp-SLA
- X-OTRS-FollowUp-SenderType
- X-OTRS-FollowUp-IsVisibleForCustomer
- X-OTRS-FollowUp-Title
- X-OTRS-FollowUp-State-Keep
- X-OTRS-BodyDecrypted

SendNoAutoResponseRegExp

ここで指定した文言（正規表現）にマッチした場合、オート・レスポンダーによりメッセージ
は送られません。

この設定は無効化することはできません。

デフォルト値:
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--- (MAILER-DAEMON|postmaster|abuse)@.+?\..+?

26. Core → Event →
AppointmentCalendar

AppointmentCalendar::EventModulePost###100-Notification

Appointment calendar event module that prepares notification entries for
appointments.

デフォルト値:

---
Event: (AppointmentCreate|AppointmentUpdate|AppointmentDelete|AppointmentNotification|
CalendarCreate|CalendarUpdate)
Module: Kernel::System::Calendar::Event::Notification

AppointmentCalendar::EventModulePost###200-TicketAppointments

Appointment calendar event module that updates the ticket with data from ticket
appointment.

デフォルト値:

---
Event: AppointmentUpdate
Module: Kernel::System::Calendar::Event::TicketAppointments

27. Core → Event → CustomPage
CustomPage::EventModulePost###1000-IndexManagement

Marks down the object involved on the event.

デフォルト値:

---
Event: (CustomPageContentAdd|CustomPageContentUpdate|CustomPageContentDelete)
Module: Kernel::System::CustomPage::Event::CustomPageContentIndexManagement
Transaction: '0'

28. Core → Event → CustomerCompany
CustomerCompany::EventModulePost###2000-UpdateCustomerUsers

Event module that updates customer users after an update of the Customer.

デフォルト値:

---
Event: CustomerCompanyUpdate
Module: Kernel::System::CustomerCompany::Event::CustomerUserUpdate
Transaction: '0'

CustomerCompany::EventModulePost###2100-
UpdateDynamicFieldObjectName

Event module that updates customer company object name for dynamic fields.

デフォルト値:

---
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Event: CustomerCompanyUpdate
Module: Kernel::System::CustomerCompany::Event::DynamicFieldObjectNameUpdate
Transaction: '0'

CustomerCompany::EventModulePost###2300-UpdateTickets

Event module that updates tickets after an update of the Customer.

デフォルト値:

---
Event: CustomerCompanyUpdate
Module: Kernel::System::CustomerCompany::Event::TicketUpdate
Transaction: '0'

CustomerCompany::EventModulePost###9900-GenericInterface

Performs the configured action for each event (as an Invoker) for each configured web
service.

デフォルト値:

---
Event: ''
Module: Kernel::GenericInterface::Event::Handler
Transaction: '1'

29. Core → Event → CustomerUser
CustomerUser::EventModulePost###2000-UpdateDynamicFieldObjectName

Event module that updates customer user object name for dynamic fields.

デフォルト値:

---
Event: CustomerUserUpdate
Module: Kernel::System::CustomerUser::Event::DynamicFieldObjectNameUpdate
Transaction: '0'

CustomerUser::EventModulePost###2100-UpdateSearchProfiles

Event module that updates customer user search profiles if login changes.

デフォルト値:

---
Event: CustomerUserUpdate
Module: Kernel::System::CustomerUser::Event::SearchProfileUpdate
Transaction: '0'

CustomerUser::EventModulePost###2200-UpdateServiceMembership

Event module that updates customer user service membership if login changes.

デフォルト値:

---
Event: CustomerUserUpdate
Module: Kernel::System::CustomerUser::Event::ServiceMemberUpdate
Transaction: '0'

CustomerUser::EventModulePost###2300-UpdateTickets

Event module that updates tickets after an update of the Customer User.

デフォルト値:
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---
Event: CustomerUserUpdate
Module: Kernel::System::CustomerUser::Event::TicketUpdate
Transaction: '0'

CustomerUser::EventModulePost###9900-GenericInterface

Performs the configured action for each event (as an Invoker) for each configured web
service.

デフォルト値:

---
Event: ''
Module: Kernel::GenericInterface::Event::Handler
Transaction: '1'

30. Core → Event → DynamicField
DynamicField::EventModulePost###9900-GenericInterface

Performs the configured action for each event (as an Invoker) for each configured web
service.

デフォルト値:

---
Event: ''
Module: Kernel::GenericInterface::Event::Handler
Transaction: '1'

31. Core → Event → FAQ
FAQ::EventModulePost###1000-IndexManagement

Marks down the object involved on the event.

デフォルト値:

---
Event: ''
Module: Kernel::System::FAQ::Event::FAQIndexManagement

32. Core → Event → LinkObject
LinkObject::EventModulePost###9900-GenericInterface

Performs the configured action for each event (as an Invoker) for each configured web
service.

デフォルト値:

---
Event: ''
Module: Kernel::GenericInterface::Event::Handler
Transaction: '1'

33. Core → Event → Package
Package::EventModulePost###9000-SupportDataSend

Package event module to file a scheduler task for update registration.
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デフォルト値:

---
Event: (PackageInstall|PackageReinstall|PackageUpgrade|PackageUninstall)
Module: Kernel::System::Package::Event::SupportDataSend
Transaction: '1'

Package::EventModulePost###9100-TriggerWebserverReload

Package event module to trigger a production web server reload, if allowed by the
configuration.

デフォルト値:

---
Event: (PackageInstall|PackageReinstall|PackageUpgrade|PackageUninstall)
Module: Kernel::System::Package::Event::TriggerWebserverReload
Transaction: '1'

Package::EventModulePost###9900-GenericInterface

Performs the configured action for each event (as an Invoker) for each configured web
service.

デフォルト値:

---
Event: ''
Module: Kernel::GenericInterface::Event::Handler
Transaction: '1'

34. Core → Event → Queue
DynamicField::EventModulePost###1000-TicketIndexManagement

Event module that performs an update statement on document search indices if a
dynamic field was deleted.

デフォルト値:

---
Event: DynamicFieldDelete
Module: Kernel::System::DynamicField::Event::IndexManagement
Transaction: '0'

Queue::EventModulePost###2300-UpdateQueue

Event module that performs an update statement on TicketIndex to rename the queue
name there if needed and if StaticDB is actually used.

デフォルト値:

---
Event: QueueUpdate
Module: Kernel::System::Queue::Event::TicketAcceleratorUpdate
Transaction: '0'

Queue::EventModulePost###2400-TicketIndexManagement

Event module that performs an update statement on document search ticket index
if group has been changed.

デフォルト値:

---
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Event: QueueUpdate
Module: Kernel::System::Queue::Event::TicketIndexManagement
Transaction: '0'

Queue::EventModulePost###9900-GenericInterface

Performs the configured action for each event (as an Invoker) for each configured web
service.

デフォルト値:

---
Event: ''
Module: Kernel::GenericInterface::Event::Handler
Transaction: '1'

35. Core → Event →
ServiceCatalogueItem

ServiceCatalogueItem::EventModulePost###1000-
ServiceCatalogueIndexManagement

Marks down the object involved on the event.

デフォルト値:

---
Event: (ItemContentAdd|ItemContentUpdate|ItemContentDelete)
Module: Kernel::System::ServiceCatalogue::Event::ServiceCatalogueContentIndexManagement
Transaction: '0'

36. Core → Event → Ticket
AppointmentCalendar::EventModulePost###1000-IndexManagement

Marks down the object involved on the event.

デフォルト値:

---
Event: ''
Module: Kernel::System::Calendar::Event::IndexManagement

Ticket::EventModulePost###1000-IndexManagement

Marks down the object involved on the event.

デフォルト値:

---
Event: ''
Module: Kernel::System::Ticket::Event::IndexManagement

Ticket::EventModulePost###2300-ArchiveRestore

Restores a ticket from the archive (only if the event is a state change to any open
available state).

デフォルト値:

---
Event: TicketStateUpdate
Module: Kernel::System::Ticket::Event::ArchiveRestore
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Ticket::EventModulePost###2600-AcceleratorUpdate

チケット・インデックス・アクセラレイタのアップです

デフォルト値:

---
Event: TicketStateUpdate|TicketQueueUpdate|TicketLockUpdate
Module: Kernel::System::Ticket::Event::TicketAcceleratorUpdate

Ticket::EventModulePost###2700-ForceOwnerResetOnMove

チケットの所有者を、チケットが移動された、または別のキューに移動した場合、リセットお
よびアンロックします。

この設定は標準では有効ではありません。

デフォルト値:

---
Event: TicketQueueUpdate
Module: Kernel::System::Ticket::Event::ForceOwnerReset

Ticket::EventModulePost###2800-ForceStateChangeOnLock

ロックのアクションの後に、（現状から）異なるチケット状態を強制的に選択します。現在の
状態をキーとして定義し、ロック・アクションの後に来る次の状態をコンテンツとして選択し
てください。

この設定は標準では有効ではありません。

デフォルト値:

---
Event: TicketLockUpdate
Module: Kernel::System::Ticket::Event::ForceState
new: open

Ticket::EventModulePost###3000-ResponsibleAutoSet

最初の所有者が設定されるときに、自動的にチケットの責任者を設定します（まだ設定されて
いなければ）。

デフォルト値:

---
Event: TicketOwnerUpdate
Module: Kernel::System::Ticket::Event::ResponsibleAutoSet

Ticket::EventModulePost###3100-LockAfterCreate

担当者がチケットを作成すると、自動的にチケットをロックするかどうかを設定します。

この設定は標準では有効ではありません。

デフォルト値:

---
Action: AgentTicketPhone|AgentTicketEmail
Event: TicketCreate
Module: Kernel::System::Ticket::Event::LockAfterCreate
Transaction: '1'

Ticket::EventModulePost###3300-TicketPendingTimeReset

状態が非ペンディング状態に変更された場合、チケットのペンディング・タイムを0に設定し
ます。
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デフォルト値:

---
Event: TicketStateUpdate
Module: Kernel::System::Ticket::Event::TicketPendingTimeReset

Ticket::EventModulePost###3600-ForceUnlockOnMove

チケットが他のキューに移動された後に、強制的にアンロックします。

デフォルト値:

---
Event: TicketQueueUpdate
Module: Kernel::System::Ticket::Event::ForceUnlock

Ticket::EventModulePost###4000-TicketArticleNewMessageUpdate

全ての項目が確認された、または新規のArticleが作成された場合に、チケット“Seen”フラグを
アップデートします。

デフォルト値:

---
Event: ArticleCreate|ArticleFlagSet|ArticleCustomerFlagSet
Module: Kernel::System::Ticket::Event::TicketNewMessageUpdate

Ticket::EventModulePost###4100-DynamicFieldFromCustomerUser

This event module stores attributes from CustomerUser as DynamicFields tickets.
Please see DynamicFieldFromCustomerUser::Mapping setting for how to configure the
mapping.

この設定は標準では有効ではありません。

デフォルト値:

---
Event: (TicketCreate|TicketCustomerUpdate)
Module: Kernel::System::Ticket::Event::DynamicFieldFromCustomerUser

Ticket::EventModulePost###4300-EscalationStopEvents

Ticket event module that triggers the escalation stop events.

デフォルト値:

---
Event: TicketSLAUpdate|TicketQueueUpdate|TicketStateUpdate|ArticleCreate
Module: Kernel::System::Ticket::Event::TriggerEscalationStopEvents
Transaction: '0'

Ticket::EventModulePost###7000-NotificationEvent

Sends the notifications which are configured in the admin interface under "Ticket
Notifications".

デフォルト値:

---
Event: ''
Module: Kernel::System::Ticket::Event::NotificationEvent
Transaction: '1'

Ticket::EventModulePost###950-TicketAppointments

Triggers add or update of automatic calendar appointments based on certain ticket
times.
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デフォルト値:

---
Event: TicketSLAUpdate|TicketQueueUpdate|TicketStateUpdate|TicketCreate|ArticleCreate|
TicketPendingTimeUpdate|TicketDynamicFieldUpdate_.*
Module: Kernel::System::Ticket::Event::TicketAppointments
Transaction: '1'

Ticket::EventModulePost###9600-TicketDynamicFieldDefault

Event module registration. For more performance you can define a trigger event (e.
g. Event => TicketCreate). This is only possible if all Ticket dynamic fields need the
same event.

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::System::Ticket::Event::TicketDynamicFieldDefault
Transaction: '1'

Ticket::EventModulePost###9700-GenericAgent

Event module registration. For more performance you can define a trigger event (e.
g. Event => TicketCreate).

デフォルト値:

---
Event: ''
Module: Kernel::System::Ticket::Event::GenericAgent
Transaction: '1'

Ticket::EventModulePost###9800-TicketProcessSequenceFlows

Event module registration. For more performance you can define a trigger event (e.
g. Event => TicketCreate).

デフォルト値:

---
Event: ''
Module: Kernel::System::Ticket::Event::TicketProcessSequenceFlows
Transaction: '1'

Ticket::EventModulePost###9900-GenericInterface

Performs the configured action for each event (as an Invoker) for each configured web
service.

デフォルト値:

---
Event: ''
Module: Kernel::GenericInterface::Event::Handler
Transaction: '1'

Ticket::EventModulePost###9990-EscalationIndex

チケット属性がアップデートされた後に、チケット・エスカレーション・インデックスをアッ
プデートします。

デフォルト値:

---
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Event: TicketSLAUpdate|TicketQueueUpdate|TicketStateUpdate|TicketCreate|ArticleCreate|
TicketDynamicFieldUpdate|TicketTypeUpdate|TicketServiceUpdate|TicketCustomerUpdate|
TicketPriorityUpdate|TicketMerge
Module: Kernel::System::Ticket::Event::TicketEscalationIndex
Transaction: '1'

37. Core → FAQ
FAQ::Agent::StateTypes

担当者インターフェイスで利用可能なステートタイプリスト

この設定は無効化することはできません。

デフォルト値:

---
- internal
- external
- public

FAQ::CacheTTL

FAQ項目から離脱するまでのキャッシュ時間

この設定は無効化することはできません。

デフォルト値:

--- '172800'

FAQ::Customer::StateTypes

顧客画面で利用可能なステートタイプリスト

この設定は無効化することはできません。

デフォルト値:

---
- external
- public

FAQ::Default::Language

規定の言語（単一言語モードで運用時）

この設定は標準では有効ではありません。

デフォルト値:

--- en

FAQ::Default::RootCategoryComment

既定のカテゴリ

この設定は無効化することはできません。

デフォルト値:

--- default comment

FAQ::Default::RootCategoryName

既定のカテゴリ
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この設定は無効化することはできません。

デフォルト値:

--- FAQ

FAQ::Default::State

記事エントリー時の規定のステータス

この設定は無効化することはできません。

デフォルト値:

--- internal (agent)

FAQ::FAQHook

FAQ用の識別子 例. FAQ#, KB#, MyFAQ#. デフォルトでは FAQ# となっています

この設定は無効化することはできません。

デフォルト値:

--- FAQ#

FAQ::MultiLanguage

多言語を有効にする

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::Public::StateTypes

公開画面で利用可能なステートタイプリスト

この設定は無効化することはできません。

デフォルト値:

---
- public

FAQ::TitleSize

デフォルトで表示されるFAQ項目タイトルのデフォルト最大値

この設定は無効化することはできません。

デフォルト値:

--- '50'

FAQ::Voting

評価の機能を有効にする

この設定は無効化することはできません。

デフォルト値:

--- '1'
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38. Core → FAQ → Approval
FAQ::ApprovalGroup

FAQの記事の承認のためのグループ

この設定は無効化することはできません。

デフォルト値:

--- users

FAQ::ApprovalQueue

記事承認キュー

この設定は無効化することはできません。

デフォルト値:

--- FAQ_Approval

FAQ::ApprovalRequired

新規 FAQ 項目を公開するには事前に承認されることが必要です

この設定は無効化することはできません。

デフォルト値:

--- 0

FAQ::ApprovalTicketBody

FAQ承認チケット用　チケット本文

この設定は無効化することはできません。

デフォルト値:

--- "Hi,\n\na new FAQ article needs your approval before it can be published.\n\n
  \ FAQ#   : <OTRS_FAQ_NUMBER>\n  Title  : <OTRS_FAQ_TITLE>\n  Author :
 <OTRS_FAQ_AUTHOR>\n
  \ State  : <OTRS_FAQ_STATE>\n\nIf you want to do this, click on this link:\n
\n<OTRS_CONFIG_HttpType>://<OTRS_CONFIG_FQDN>/<OTRS_CONFIG_ScriptAlias>index.pl?
Action=AgentFAQEdit;ItemID=<OTRS_FAQ_ITEMID>\n\nYour
  OTRS Notification Master\n            "

FAQ::ApprovalTicketDefaultState

FAQへの取り込みを行うチケットの優先順位の既定値

この設定は無効化することはできません。

デフォルト値:

--- new

FAQ::ApprovalTicketPriority

FAQへの取り込みを行うチケットの優先順位の既定値

この設定は無効化することはできません。

デフォルト値:
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--- 3 normal

FAQ::ApprovalTicketSubject

FAQ承認チケット用　チケット件名

この設定は無効化することはできません。

デフォルト値:

--- FAQ approval required for FAQ# <OTRS_FAQ_NUMBER>

FAQ::ApprovalTicketType

FAQ項目承認用デフォルトチケットタイプ

この設定は無効化することはできません。

デフォルト値:

--- Unclassified

39. Core → FAQ → Explorer
FAQ::Explorer::LastChange::Limit

「最近の変更」に何件まで表示するか

この設定は無効化することはできません。

デフォルト値:

--- '3'

FAQ::Explorer::LastChange::Show

最新の変更を表示する画面（担当者用/顧客用/公開）を定義

この設定は無効化することはできません。

デフォルト値:

---
internal: internal (agent)

FAQ::Explorer::LastChange::ShowSubCategoryItems

サブカテゴリーのトピックを表示する/表示しない

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::Explorer::LastCreate::Limit

「最新の新規作成」に何件まで表示するか

この設定は無効化することはできません。

デフォルト値:

--- '3'
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FAQ::Explorer::LastCreate::Show

最新の新規作成を表示する画面（担当者用/顧客用/公開）を定義

この設定は無効化することはできません。

デフォルト値:

---
internal: internal (agent)

FAQ::Explorer::LastCreate::ShowSubCategoryItems

サブカテゴリーのトピックを表示する/表示しない

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::Explorer::Path::Show

記事のパスを表示する/表示しない

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::Explorer::QuickSearch::Show

クイック検索が表示される画面

この設定は無効化することはできません。

デフォルト値:

--- {}

FAQ::Explorer::Top10::Limit

「トップ10記事」に何件まで表示するか

この設定は無効化することはできません。

デフォルト値:

--- '10'

FAQ::Explorer::Top10::Show

トップ10を表示する画面（担当者用/顧客用/公開）を定義

この設定は無効化することはできません。

デフォルト値:

---
internal: internal (agent)

FAQ::Explorer::Top10::ShowSubCategoryItems

サブカテゴリーのトピックを表示する/表示しない
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この設定は無効化することはできません。

デフォルト値:

--- '1'

40. Core → FAQ → Item
FAQ::Item::Field1

FAQのフリーテキストフィールドの定義。

この設定は無効化することはできません。

デフォルト値:

---
Caption: Symptom
Prio: '100'
Show: public

FAQ::Item::Field2

FAQのフリーテキストフィールドの定義。

この設定は無効化することはできません。

デフォルト値:

---
Caption: Problem
Prio: '200'
Show: public

FAQ::Item::Field3

FAQのフリーテキストフィールドの定義。

この設定は無効化することはできません。

デフォルト値:

---
Caption: Solution
Prio: '300'
Show: public

FAQ::Item::Field4

FAQのフリーテキストフィールドの定義。

この設定は無効化することはできません。

デフォルト値:

---
Caption: Field4
Prio: '400'
Show: ''

FAQ::Item::Field5

FAQのフリーテキストフィールドの定義。

この設定は無効化することはできません。
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デフォルト値:

---
Caption: Field5
Prio: '500'
Show: ''

FAQ::Item::Field6

FAQのフリーテキストフィールドの定義。

この設定は無効化することはできません。

デフォルト値:

---
Caption: Comment
Prio: '600'
Show: internal

FAQ::Item::HTML

記事でHTMLタグを表示する/表示しない

この設定は無効化することはできません。

デフォルト値:

--- '1'

41. Core → FAQ → Item → Voting
FAQ::Item::Voting::Show

評価を表示する画面（担当者用/顧客用/公開）を定義

この設定は無効化することはできません。

デフォルト値:

---
external: external (customer)
internal: internal (agent)
public: public (public)

42. Core → FAQ → RelatedArticles
FAQ::Agent::RelatedArticles::Enabled

Enable the related article feature for the agent frontend.

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::KeywordArticeList::SearchLimit

Limit for the search to build the keyword FAQ article list.

この設定は無効化することはできません。

デフォルト値:
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--- '5000'

43. Core → FAQ → TicketCompose
FAQ::TicketCompose###IncludeInternal

FAQ由来のチケットに含まれる内部項目

この設定は無効化することはできません。

デフォルト値:

--- 0

FAQ::TicketCompose###InsertMethod

FAQ記事からチケットへの挿入される情報を定義する。「FAQすべて」にはテキスト・添付・
及びインラインの画像が含まれます。

この設定は無効化することはできません。

デフォルト値:

--- Full

FAQ::TicketCompose###ShowFieldNames

FAQ由来のチケットに含まれる内部項目すべての名称

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::TicketCompose###ShowInsertLinkButton

'AgentFAQZoomSmall'の設定。公開画面において「リンクを挿入する」ボタンを表示する/表示
しない

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::TicketCompose###ShowInsertTextAndLinkButton

公開されたFAQ記事のAgentFAQZoomSmallに"FAQのテキスト、およびリンクを挿入" / "FAQ
のすべて、およびリンクを挿入" ボタンを表示する

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::TicketCompose###ShowInsertTextButton

AgentFAQZoomSmallに"FAQのテキストを挿入" / "FAQのすべてを挿入"ボタンを表示する

この設定は無効化することはできません。

デフォルト値:
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--- '1'

FAQ::TicketCompose###UpdateArticleSubject

FAQタイトルが記事の件名に連結するかどうかを定義します

この設定は無効化することはできません。

デフォルト値:

--- '1'

44. Core → GoogleChrome
GoogleChrome::Bin

Defines the path to the Google Chrome or Chromium binary.

この設定は標準では有効ではありません。

デフォルト値:

--- /usr/bin/chromium

45. Core → LinkObject
LinkObject::IgnoreLinkedTicketStateTypes

Defines, which tickets of which ticket state types should not be listed in linked ticket
lists.

デフォルト値:

---
- merged
- removed

LinkObject::PossibleLink###0200

“ノーマル”タイプのリンクを持つチケットへのリンクです。.

デフォルト値:

---
Object1: Ticket
Object2: Ticket
Type: Normal

LinkObject::PossibleLink###0201

“親子”タイプのリンクを持つチケットへのリンクです。

デフォルト値:

---
Object1: Ticket
Object2: Ticket
Type: ParentChild

LinkObject::PossibleLink###1200

Links appointments and tickets with a "Normal" type link.

デフォルト値:
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---
Object1: Appointment
Object2: Ticket
Type: Normal

LinkObject::PossibleLink###8301

‘Normal’リンク・タイプを使用して、‘FAQ’オブジェクトが他の‘FAQ’オブジェクトとリンクされ
るように、定義します。

デフォルト値:

---
Object1: FAQ
Object2: FAQ
Type: Normal

LinkObject::PossibleLink###8302

‘ParentChild’リンク・タイプを使用して、‘FAQ’オブジェクトが他の‘FAQ’オブジェクトとリンク
されるように、定義します。

デフォルト値:

---
Object1: FAQ
Object2: FAQ
Type: ParentChild

LinkObject::PossibleLink###8303

‘Normal’リンク・タイプを使用して、‘FAQ’オブジェクトが他の‘ Ticket ’オブジェクトとリンクさ
れるように、定義します。

デフォルト値:

---
Object1: FAQ
Object2: Ticket
Type: Normal

LinkObject::PossibleLink###8304

‘ParentChild’リンク・タイプを使用して、‘FAQ’オブジェクトが他の‘ Ticket ’オブジェクトとリン
クされるように、定義します。

デフォルト値:

---
Object1: FAQ
Object2: Ticket
Type: ParentChild

LinkObject::ShowDeleteButton

Determines if a button to delete a link should be displayed next to each link in each
zoom mask.

この設定は無効化することはできません。

デフォルト値:

--- '1'

LinkObject::StrikeThroughLinkedTicketStateTypes

For these state types the ticket numbers are striked through in the link table.
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デフォルト値:

---
- merged

LinkObject::Type###Normal

リンク・タイプ"ノーマル"の定義です。もしソース名およびターゲット名が同じ値を含んでい
る場合、結果のリンクは非直接リンクになり、そうでない結果は直接リンクになります。

この設定は無効化することはできません。

デフォルト値:

---
SourceName: Normal
TargetName: Normal

LinkObject::Type###ParentChild

リンク・タイプ'ParentChild'の定義です。もしソース名およびターゲット名が同じ値を含んで
いる場合、結果のリンクは非直接リンクになり、そうでない結果は直接リンクになります。

この設定は無効化することはできません。

デフォルト値:

---
SourceName: Parent
TargetName: Child

LinkObject::TypeGroup###0001

リンク・タイプのグループの定義です。同じグループのリンク・タイプは、お互いにキャンセ
ルするように働きます。もしチケットAがチケットBと共に"ノーマル"にリンクされている場
合、これらのチケットは'ParentChild'関係のリンクとともに追加的にリンクされることはでき
ません。

デフォルト値:

---
- Normal
- ParentChild

LinkObject::ViewMode

リンクされたオブジェクトがそれぞれのズームマスクで表示される方式を定義します。

この設定は無効化することはできません。

デフォルト値:

--- Simple

46. Core → Log
CGILogPrefix

ログ・ファイルの中でCGIスクリプト・エントリーを意味するテキストを規定します。

この設定は無効化することはできません。

デフォルト値:

--- OTRS-CGI

412



LogModule

システムのログ・モジュールを定義します。"ファイル"は、与えられたログファイルの全メッ
セージをライトし、"SysLog"はそのシステムのsyslog daemon、つまりsyslogdを使用しま
す。

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::Log::SysLog

LogModule::LogFile

もしログ・モジュールに関して"File"が選択されていた場合、ログ・ファイルが必ず特定されま
す。もしファイルが存在しなければ、システムにより作成されます。

この設定は無効化することはできません。

デフォルト値:

--- /tmp/otrs.log

LogModule::LogFile::Date

OTRSログ・ファイルに対して、実際の年と月による接尾辞を追加します。毎月のログファイ
ルが作成されます。

この設定は無効化することはできません。

デフォルト値:

--- 0

LogModule::SysLog::Charset

もしログ・モジュールに関して"SysLog"が選択されていた場合、ロギングで使用されるべき文
字セットが特定されます。

この設定は無効化することはできません。

デフォルト値:

--- utf-8

LogModule::SysLog::Facility

もしログ・モジュールに関して"SysLog"が選択されていた場合、特別なログ・ファシリティが
特定されます。

この設定は無効化することはできません。

デフォルト値:

--- user

MinimumLogLevel

Set the minimum log level. If you select 'error', just errors are logged. With 'debug' you
get all logging messages. The order of log levels is: 'debug', 'info', 'notice' and 'error'.

この設定は無効化することはできません。

デフォルト値:
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--- error

47. Core → MailQueue
MailQueue

メールキューの構成を設定

この設定は無効化することはできません。

デフォルト値:

---
IncrementAttemptDelayInMinutes: '2'
ItemMaxAttempts: '3'

48. Core → PDF
PDF::LogoFile

ページ・ヘッダーにおいて、ロゴのためのファイルへのパスを特定します(gif|jpg|png, 700 x
100 pixel)。

この設定は無効化することはできません。

デフォルト値:

--- <OTRS_CONFIG_Home>/var/logo-otrs.png

PDF::MaxPages

PDFファイルごとの最大ページ数を定義します。

この設定は無効化することはできません。

デフォルト値:

--- '100'

PDF::PageSize

PDFページの標準サイズを定義します。

この設定は無効化することはできません。

デフォルト値:

--- a4

PDF::TTFontFile###Monospaced

PDFドキュメントで、等幅フォントを扱うための、パスおよびTTF-Fileを定義します。

この設定は無効化することはできません。

デフォルト値:

--- DejaVuSansMono.ttf

PDF::TTFontFile###MonospacedBold

PDFドキュメントで、太字の等幅フォントを扱うための、パスおよびTTF-Fileを定義します。

この設定は無効化することはできません。
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デフォルト値:

--- DejaVuSansMono-Bold.ttf

PDF::TTFontFile###MonospacedBoldItalic

PDFドキュメントで、太字でイタリックの等幅のフォントを扱うための、パスおよびTTF-File
を定義します。

この設定は無効化することはできません。

デフォルト値:

--- DejaVuSansMono-BoldOblique.ttf

PDF::TTFontFile###MonospacedItalic

PDFドキュメントで、イタリックの等幅フォントを扱うための、パスおよびTTF-Fileを定義し
ます。

この設定は無効化することはできません。

デフォルト値:

--- DejaVuSansMono-Oblique.ttf

PDF::TTFontFile###Proportional

PDFドキュメントのプロポーショナル・フォントを扱うための、パスおよびTTF-Fileを定義し
ます。

この設定は無効化することはできません。

デフォルト値:

--- DejaVuSans.ttf

PDF::TTFontFile###ProportionalBold

PDFドキュメントで、太字のプロポーショナル・フォントを扱うための、パスおよびTTF-File
を定義します。

この設定は無効化することはできません。

デフォルト値:

--- DejaVuSans-Bold.ttf

PDF::TTFontFile###ProportionalBoldItalic

PDFドキュメントで、太字でイタリックのプロポーショナル・フォントを扱うための、パスお
よびTTF-Fileを定義します。

この設定は無効化することはできません。

デフォルト値:

--- DejaVuSans-BoldOblique.ttf

PDF::TTFontFile###ProportionalItalic

PDFドキュメントで、イタリックのプロポーショナル・フォントを扱うための、パスおよび
TTF-Fileを定義します。

この設定は無効化することはできません。
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デフォルト値:

--- DejaVuSans-Oblique.ttf

49. Core → Package
OTRSBusiness::ReleaseChannel

Specify the channel to be used to fetch OTRS Business Solution™ updates. Warning:
Development releases might not be complete, your system might experience
unrecoverable errors and on extreme cases could become unresponsive!

この設定は無効化することはできません。

デフォルト値:

--- '1'

Package::AllowLocalModifications

If this setting is enabled, local modifications will not be highlighted as errors in the
package manager and support data collector.

この設定は標準では有効ではありません。

デフォルト値:

--- 0

Package::AllowNotVerifiedPackages

If this setting is enabled, it is possible to install packages which are not verified by
OTRS Group. These packages could threaten your whole system!

デフォルト値:

--- 0

Package::FileUpload

パッケージ・マネジャー・フロントエンドでの、ファイル・アップロードを有効にします。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Package::Proxy

プロキシ経由でパッケージを取ってきます（フェッチ）。"WebUserAgent::Proxy"を上書きし
ます。

この設定は標準では有効ではありません。

デフォルト値:

--- http://proxy.sn.no:8001/

Package::RepositoryAccessRegExp

ローカル・レポジトリにアクセスするための、IPの正規表現を定義します。ローカル・レポジ
トリにアクセスするために、これを有効にする必要があり、またpackage::RepositoryListは
リモート・ホストにおいて必要とされます。
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この設定は標準では有効ではありません。

デフォルト値:

--- 127\.0\.0\.1

Package::RepositoryList

Defines the list of online repositories. Another installations can be used as repository,
for example: Key="http://example.com/otrs/public.pl?Action=PublicRepository;File="
and Content="Some Name".

この設定は標準では有効ではありません。

デフォルト値:

---
ftp://ftp.example.com/pub/otrs/misc/packages/: '[Example] ftp://ftp.example.com/'

Package::RepositoryRoot

追加的パッケージに関して、オンラインのレポジトリー・リストにアクセスするためのロケー
ションを定義します。1つめの利用可能な結果が使用されます。

この設定は標準では有効ではありません。

デフォルト値:

--- []

Package::ShowFeatureAddons

Toggles display of OTRS FeatureAddons list in PackageManager.

デフォルト値:

--- '1'

Package::Timeout

パッケージ・ダウンロードのためのタイムアウト（秒）を設定しま
す。"WebUserAgent::Timeout"を上書きします。

この設定は無効化することはできません。

デフォルト値:

--- '120'

50. Core → PerformanceLog
PerformanceLog

パフォーマンス・ログを有効にします（ページ・レスポンス・タイムのログを取ります）。シ
ステム・パフォーマンスに影響が出ます。Frontend::Module###AdminPerformanceLogを有効
とする必要があります。

デフォルト値:

--- 0

PerformanceLog::File

パフォーマンス・ログのためのファイルのパスを特定します。
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この設定は無効化することはできません。

デフォルト値:

--- <OTRS_CONFIG_Home>/var/log/Performance.log

PerformanceLog::FileMax

ログ・ファイルの最大サイズ（MB）を定義します。

この設定は無効化することはできません。

デフォルト値:

--- '25'

51. Core → Permission
EditAnotherUsersPreferencesGroup

Specifies the group where the user needs rw permissions so that they can edit other
users preferences.

この設定は無効化することはできません。

デフォルト値:

--- admin

SwitchToUser

管理者が、ユーザ管理パネルを通じて、別のユーザとしてログインすることを許可します。

この設定は無効化することはできません。

デフォルト値:

--- 0

System::Customer::Permission

アプリケーション内で顧客が利用できる標準の許可を定義します。もし、より多くの許可が必
要になった場合、ここに入力してください。許可が効力を持つためには、ハード・コーディン
グされる必要があります。なお、前述した許可のいずれかを追加する場合、“rw”許可が、最後
のエントリとなることを確実にしてください。

この設定は無効化することはできません。

デフォルト値:

---
- ro
- rw

System::Permission

アプリケーション内で担当者にとって標準的に利用可能な許可です。もし、さらに多くの許可
が必要であれば、ここで加えることができます。許可は、効果的になるように設定する必要が
あります。いくつか他の良い許可も、ビルト・インで提供されています：note, close,
pending, customer, freetext, move, compose, responsible, forward, bounce。“rw”は、
常に最後の登録許可であることを確認してください。

この設定は無効化することはできません。
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デフォルト値:

---
- ro
- move_into
- create
- note
- owner
- priority
- chat_observer
- chat_participant
- chat_owner
- rw

52. Core → ProcessManagement
Process::ActivityTypes

Defines the activity types which can be used in the system.

デフォルト値:

---
ScriptTask: Script task activity
ServiceTask: Service task activity
UserTask: User task activity

Process::CacheTTL

Cache time in seconds for the DB process backend.

この設定は無効化することはできません。

デフォルト値:

--- '3600'

Process::DefaultLock

このオプションは、プロセスチケットの標準ロック状態を定義します。

この設定は無効化することはできません。

デフォルト値:

--- unlock

Process::DefaultPriority

このオプションは、プロセスチケットの標準重要度を定義します。

この設定は無効化することはできません。

デフォルト値:

--- 3 normal

Process::DefaultQueue

このオプションは、プロセスチケットの標準キューを定義します。

この設定は無効化することはできません。

デフォルト値:

--- Raw
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Process::DefaultState

このオプションは、プロセスチケットのデフォルトのステータスを定義します。

この設定は無効化することはできません。

デフォルト値:

--- new

Process::DynamicFieldProcessManagementActivityID

このオプションは、プロセス管理のアクティビティ・エンティティIDを格納するためのダイナ
ミック・フィールドを定義します。

この設定は無効化することはできません。

デフォルト値:

--- ProcessManagementActivityID

Process::DynamicFieldProcessManagementActivityStatus

This option defines the dynamic field in which the most recent Process Management
activity status is stored.

この設定は無効化することはできません。

デフォルト値:

--- ProcessManagementActivityStatus

Process::DynamicFieldProcessManagementProcessID

このオプションは、プロセス管理のプロセス・エンティティIDを格納するためのダイナミッ
ク・フィールドを定義します。

この設定は無効化することはできません。

デフォルト値:

--- ProcessManagementProcessID

Process::Entity::Prefix

Default ProcessManagement entity prefixes for entity IDs that are automatically
generated.

この設定は無効化することはできません。

デフォルト値:

---
Activity: A
ActivityDialog: AD
Process: P
SequenceFlow: SF
SequenceFlowAction: SFA

Process::NavBarOutput::CacheTTL

チケットプロセスナビゲーションバー出力モジュールのキャッシュ時間（秒）。

この設定は無効化することはできません。

デフォルト値:
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--- '900'

ProcessManagement::SequenceFlow::Debug::Enabled

If enabled debugging information for sequence flows is logged.

この設定は無効化することはできません。

デフォルト値:

--- 0

ProcessManagement::SequenceFlow::Debug::Filter###00-Default

Filter for debugging sequence flows. Note: More filters can be added in the format
<OTRS_TICKET_Attribute> e.g. <OTRS_TICKET_Priority>.

この設定は標準では有効ではありません。

デフォルト値:

---
<OTRS_TICKET_TicketNumber>: ''
SequenceFlowEntityID: ''

ProcessManagement::SequenceFlow::Debug::LogPriority

Defines the priority in which the information is logged and presented.

この設定は標準では有効ではありません。

デフォルト値:

--- debug

53. Core → Queue
QueuePreferences###ChatChannel

Chat channel to queue mapping.

デフォルト値:

---
Block: Option
Cols: '50'
Desc: Chat channel that will be used for communication related to the tickets in this
  queue.
Label: Chat channel
Module: Kernel::Output::HTML::QueuePreferences::ChatChannel
PrefKey: ChatChannel
Rows: '5'

QueuePreferences###Comment2

example queue attribute Comment2のパラメータです。

この設定は標準では有効ではありません。

デフォルト値:

---
Block: TextArea
Cols: '50'
Desc: Define the queue comment 2.
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Label: Comment2
Module: Kernel::Output::HTML::QueuePreferences::Generic
PrefKey: Comment2
Rows: '5'

54. Core → ReferenceData
ReferenceData::OwnCountryList

This setting allows you to override the built-in country list with your own list of
countries. This is particularly handy if you just want to use a small select group of
countries.

この設定は標準では有効ではありません。

デフォルト値:

---
AT: Austria
CH: Switzerland
DE: Germany

55. Core → SLA
SLAPreferences###Comment2

example SLA attribute Comment2のパラメータです。

この設定は標準では有効ではありません。

デフォルト値:

---
Block: TextArea
Cols: '50'
Desc: Define the sla comment 2.
Label: Comment2
Module: Kernel::Output::HTML::SLAPreferences::Generic
PrefKey: Comment2
Rows: '5'

SLAPreferences###FieldSelectionDialogText

Text which is being displayed on selection of this SLA on the new ticket screen.

デフォルト値:

---
Block: TextArea
Cols: '51'
Desc: Is being displayed if a customer chooses this SLA on ticket creation.
Label: Dialog message
Module: Kernel::Output::HTML::SLAPreferences::Generic
PrefKey: FieldSelectionDialogText
Rows: '5'

56. Core → SMS
SMS::MessageTextLimit

Defines the hard limit for number of characters that can be sent via SMS per message.

この設定は無効化することはできません。
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デフォルト値:

--- '1600'

SMSTemplate::Types

Defines the list of types for SMS templates.

この設定は無効化することはできません。

デフォルト値:

---
Answer: Answer
Create: Create
SMSOutbound: SMSOutbound

57. Core → SOAP
SOAP::Keep-Alive

Enable keep-alive connection header for SOAP responses.

この設定は無効化することはできません。

デフォルト値:

--- 0

58. Core → Service
ServicePreferences###Comment2

example service attribute Comment2のパラメータです。

この設定は標準では有効ではありません。

デフォルト値:

---
Block: TextArea
Cols: '50'
Desc: Define the service comment 2.
Label: Comment2
Module: Kernel::Output::HTML::ServicePreferences::Generic
PrefKey: Comment2
Rows: '5'

59. Core → Session
AgentSessionLimit

Sets the maximum number of active agents within the timespan defined in
SessionMaxIdleTime.

デフォルト値:

--- '100'

AgentSessionLimitPriorWarning

Sets the maximum number of active agents within the timespan defined in
SessionMaxIdleTime before a prior warning will be visible for the logged in agents.
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この設定は標準では有効ではありません。

デフォルト値:

--- '90'

AgentSessionPerUserLimit

Sets the maximum number of active sessions per agent within the timespan defined
in SessionMaxIdleTime.

デフォルト値:

--- '20'

CustomerSessionLimit

Sets the maximum number of active customers within the timespan defined in
SessionMaxIdleTime.

デフォルト値:

--- '100'

CustomerSessionPerUserLimit

Sets the maximum number of active sessions per customers within the timespan
defined in SessionMaxIdleTime.

デフォルト値:

--- '20'

SessionAgentOnlineThreshold

Defines the period of time (in minutes) before agent is marked as "away" due to
inactivity (e.g. in the "Logged-In Users" widget or for the chat).

この設定は無効化することはできません。

デフォルト値:

--- '5'

SessionCSRFProtection

CSRF (Cross Site Request Forgery)攻撃に対するプロテクションです（さらに詳細はhttp://
en.wikipedia.org/wiki/Cross-site_request_forgeryを参照ください）。

この設定は無効化することはできません。

デフォルト値:

--- '1'

SessionCheckRemoteIP

Turns on the remote ip address check. It should not be enabled if the application is
used, for example, via a proxy farm or a dialup connection, because the remote ip
address is mostly different for the requests.

この設定は無効化することはできません。

デフォルト値:
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--- '1'

SessionCustomerOnlineThreshold

Defines the period of time (in minutes) before customer is marked as "away" due to
inactivity (e.g. in the "Logged-In Users" widget or for the chat).

この設定は無効化することはできません。

デフォルト値:

--- '5'

SessionDeleteIfNotRemoteID

もしセッションIDが、無効なリモートIPアドレスと共に使用されている場合、セッションを削
除します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

SessionDeleteIfTimeToOld

リクエストされたセッションがタイムアウトしている場合に削除します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

SessionDir

セッション・モジュールに"FS"が選択されていた場合、セッション・データが格納されるディ
レクトリを特定する必要があります。

この設定は無効化することはできません。

デフォルト値:

--- <OTRS_CONFIG_Home>/var/sessions

SessionMaxIdleTime

Sets the inactivity time (in seconds) to pass before a session is killed and a user is
logged out.

この設定は無効化することはできません。

デフォルト値:

--- '7200'

SessionMaxTime

セッションIDのための最大有効時間（秒）を定義します。

この設定は無効化することはできません。

デフォルト値:

--- '57600'
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SessionModule

セッション・データを格納するために使用されるモジュールを定義します。"DB"により、フロ
ント・エンドのサーバをdbサーバから分離させることができます。"FS"はより速いものです。

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::AuthSession::DB

SessionName

セッション・キーの名前を定義します。つまり、Session、SessionID、OTRSです。

この設定は無効化することはできません。

デフォルト値:

--- OTRSAgentInterface

SessionTable

セッション・モジュールに"DB"が選択されていた場合、セッション・データが格納されるデー
タベースのテーブルを特定する必要があります。

この設定は無効化することはできません。

デフォルト値:

--- sessions

SessionUseCookieAfterBrowserClose

ブラウザが閉じられた後に、クッキーを格納します。

この設定は無効化することはできません。

デフォルト値:

--- 0

60. Core → Stats
Stats::DynamicObjectRegistration###Ticket

チケット統計を作成するためのモジュールです。

デフォルト値:

---
Module: Kernel::System::Stats::Dynamic::Ticket

Stats::DynamicObjectRegistration###TicketAccountedTime

アカウンテッド・タイム・チケット統計を生成するモジュールです。

デフォルト値:

---
Module: Kernel::System::Stats::Dynamic::TicketAccountedTime

Stats::DynamicObjectRegistration###TicketList

レポート・モジュールがチケットリストを生成するかどうかを決定します。
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デフォルト値:

---
Module: Kernel::System::Stats::Dynamic::TicketList

Stats::DynamicObjectRegistration###TicketSolutionResponseTime

チケット・ソリューションおよびレスポンス・タイム統計を生成するためのモジュールです。

デフォルト値:

---
Module: Kernel::System::Stats::Dynamic::TicketSolutionResponseTime

Stats::MaxXaxisAttributes

タイム・スケールに関するX軸属性の、デフォルト最大数を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- '1000'

Stats::StatsHook

統計フックを設定します。

この設定は無効化することはできません。

デフォルト値:

--- Stat#

Stats::StatsStartNumber

統計カウンティングの数をスタートします。全ての新規統計はこの数字を増加させます。

この設定は無効化することはできません。

デフォルト値:

--- '10000'

61. Core → Stats → Reports
StatsReportConfig::CacheTTL

Cache time in seconds for the statistics reports backend.

この設定は無効化することはできません。

デフォルト値:

--- '3600'

62. Core → SystemMaintenance
SystemMaintenance::IsActiveDefaultLoginErrorMessage

Sets the default error message for the login screen in the agent interface, it's shown
when a running system maintenance period is active.
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デフォルト値:

--- We are performing scheduled maintenance. Login is temporarily not available.

SystemMaintenance::IsActiveDefaultLoginMessage

Sets the default message for the login screen in the agent interface, it's shown when
a running system maintenance period is active.

デフォルト値:

--- We are performing scheduled maintenance. We should be back online shortly.

SystemMaintenance::IsActiveDefaultNotification

Sets the default message for the notification is shown on a running system
maintenance period.

デフォルト値:

--- We are performing scheduled maintenance.

SystemMaintenance::TimeNotifyUpcomingMaintenance

Sets the minutes a notification is shown for notice about upcoming system
maintenance period.

デフォルト値:

--- '30'

63. Core → Ticket
AdminTemplate::SubjectMethod###KeepTicketNumber

Defines the behavior for the subject method "overwrite". If the option is enabled, the
ticket number will not be overwritten.

デフォルト値:

--- 0

AgentSelfNotifyOnAction

担当者が自分自身のアクションに関してEメール通知を受け取る必要があるかどうか、を設定
します。

この設定は無効化することはできません。

デフォルト値:

--- 0

CustomerNotifyJustToRealCustomer

Sends customer notifications just to the mapped customer.

この設定は無効化することはできません。

デフォルト値:

--- 0
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DynamicFieldFromCustomerUser::Mapping

Define a mapping between variables of the customer user data (keys) and dynamic
fields of a ticket (values). The purpose is to store customer user data in ticket
dynamic fields. The dynamic fields must be present in the system and should
be enabled for AgentTicketFreeText, so that they can be set/updated manually
by the agent. They mustn't be enabled for AgentTicketPhone, AgentTicketEmail
and AgentTicketCustomer. If they were, they would have precedence over the
automatically set values. To use this mapping, you have to also activate the
Ticket::EventModulePost###4100-DynamicFieldFromCustomerUser setting.

この設定は標準では有効ではありません。

デフォルト値:

---
UserFirstname: CustomerFirstname

OTRSEscalationEvents::DecayTime

The duration in minutes after emitting an event, in which the new escalation notify
and start events are suppressed.

デフォルト値:

--- '1440'

StandardTemplate2QueueByCreating

作成時に新しいキューに自動的に割り当てられるデフォルトの標準テンプレートのリスト。

この設定は標準では有効ではありません。

デフォルト値:

--- []

StandardTemplate::Types

Defines the list of types for templates.

デフォルト値:

---
Answer: Answer
Create: Create
Email: Email
Forward: Forward
Note: Note
PhoneCall: Phone call
ProcessDialog: Process dialog

Ticket::ArchiveSystem

チケット・アーカイブ・システムを有効にすることで、チケットの一部をデイリーの範囲から
外し、システムのスピードを速くします。これらのチケットを検索する際には、チケット検索
においてアーカイブ・フラッグを有効にする必要があります。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::ArchiveSystem::RemoveSeenFlags

Controls if the ticket and article seen flags are removed when a ticket is archived.
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この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::ArchiveSystem::RemoveTicketWatchers

チケットがアーカイブされるとき、チケット監視者の情報を削除する。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::ChangeOwnerToEveryone

全員に対して、チケット所有者の変更を行います（ASPにおいて便利です）。通常は、チケッ
トのキューにおいてrw許可を持つ担当者のみが、表示されます。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::CustomModule###001-CustomModule

Kernel::System::Ticketに既に存在している機能を多重定義（再定義）します。簡単にカスタ
マイズを追加したい場合に使用されます。

この設定は標準では有効ではありません。

デフォルト値:

--- Kernel::System::Ticket::Custom

Ticket::CustomQueue

カスタム・キューの名前です。カスタム・キューとは、利用者が特に優先するキューの一覧で
あり、プレファレンス設定から選択できます。

この設定は無効化することはできません。

デフォルト値:

--- My Queues

Ticket::CustomService

Name of custom service. The custom service is a service selection of your preferred
services and can be selected in the preferences settings.

この設定は無効化することはできません。

デフォルト値:

--- My Services

Ticket::CustomerArchiveSystem

カスタマー・インターフェースでチケット・アーカイブ・システムの検索を有効化します。
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この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::DefineEmailFrom

EメールのFromフィールドについて（回答およびEメールチケットからの目標）が、どのよう
に見えるべきかを定義します。

この設定は無効化することはできません。

デフォルト値:

--- SystemAddressName

Ticket::DefineEmailFromSeparator

担当者の実名と与えられたキューのEメールアドレスに間に置く分離を定義します。

この設定は無効化することはできません。

デフォルト値:

--- via

Ticket::Frontend::DefaultRecipientDisplayType

Default display type for recipient (To,Cc) names in the ticket zoom screen of the agent
interface.

デフォルト値:

--- Realname

Ticket::Frontend::DefaultSenderDisplayType

Default display type for sender (From) names in the ticket zoom screen of the agent
interface.

デフォルト値:

--- Realname

Ticket::GenericAgentRunLimit

Set the limit of tickets that will be executed on a single genericagent job execution.

デフォルト値:

--- '4000'

Ticket::GenericAgentTicketSearch###ExtendedSearchCondition

Allows extended search conditions in ticket search of the generic agent interface.
With this feature you can search e. g. ticket title with this kind of conditions like
"(*key1*&&*key2*)" or "(*key1*||*key2*)".

この設定は無効化することはできません。

デフォルト値:

--- '1'
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Ticket::Hook

例えばTicket#, Call#, MyTicket#などのチケットの識別子です。デフォルトはTicket#で
す。

この設定は無効化することはできません。

デフォルト値:

--- Ticket#

Ticket::HookDivider

チケットフックとチケット番号の間の仕切りです。例：': '

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::IncludeUnknownTicketCustomers

Include unknown customers in ticket filter.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::IndexModule

IndexAccelerator: to choose your backend TicketViewAccelerator module.
"RuntimeDB" generates each queue view on the fly from ticket table (no performance
problems up to approx. 60.000 tickets in total and 6.000 open tickets in the system).
"StaticDB" is the most powerful module, it uses an extra ticket-index table that works
like a view (recommended if more than 80.000 and 6.000 open tickets are stored in the
system). Use the command "bin/otrs.Console.pl Maint::Ticket::QueueIndexRebuild" for
initial index creation.

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::Ticket::IndexAccelerator::RuntimeDB

Ticket::InvalidOwner::StateChange

Automatically change the state of a ticket with an invalid owner once it is unlocked.
Maps from a state type to a new ticket state.

デフォルト値:

---
pending auto: open
pending reminder: open

Ticket::MergeDynamicFields

マージ操作中にメインチケットにマージされるダイナミック・フィールドの リスト 。 メイン
チケットで空の ダイナミック・フィールド のみが設定されます。

この設定は無効化することはできません。
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デフォルト値:

--- []

Ticket::NewArticleIgnoreSystemSender

Ignore system sender article types (e. g. auto responses or email notifications) to be
flagged as 'Unread Article' in AgentTicketZoom or expanded automatically in Large
view screens.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::NumberGenerator

Selects the ticket number generator module. "AutoIncrement" increments the
ticket number, the SystemID and the counter are used with SystemID.counter
format (e.g. 1010138, 1010139). With "Date" the ticket numbers will be generated
by the current date, the SystemID and the counter. The format looks like
Year.Month.Day.SystemID.counter (e.g. 200206231010138, 200206231010139). With
"DateChecksum" the counter will be appended as checksum to the string of
date and SystemID. The checksum will be rotated on a daily basis. The format
looks like Year.Month.Day.SystemID.Counter.CheckSum (e.g. 2002070110101520,
2002070110101535).

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::Ticket::Number::DateChecksum

Ticket::NumberGenerator::CheckSystemID

Checks the SystemID in ticket number detection for follow-ups. If not enabled,
SystemID will be changed after using the system.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::NumberGenerator::Date::UseFormattedCounter

Enables the minimal ticket counter size (if "Date" was selected as
TicketNumberGenerator).

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::NumberGenerator::MinCounterSize

Sets the minimal ticket counter size if "AutoIncrement" was selected as
TicketNumberGenerator. Default is 5, this means the counter starts from 10000.

この設定は無効化することはできません。

デフォルト値:
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--- '5'

Ticket::PendingAutoStateType

タイム・リミットを越えてから状態を変更したペンディング・チケットに対して、可能となる
状態を定義します。

この設定は無効化することはできません。

デフォルト値:

---
- pending auto

Ticket::PendingNotificationNotToResponsible

チケットの責任者である担当者への、リマインダー通知の送信を無効にします
(Ticket::Responsibleが有効にされる必要があります)。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::PendingNotificationOnlyToOwner

リマインダ日付を迎えたら、アンロック・チケットのリマインダ通知を送信します（チケット
所有者だけに送信されます）。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::PendingReminderStateType

ペンディング・チケットに関するリマインダーの状態タイプを定義します。

この設定は無効化することはできません。

デフォルト値:

---
- pending reminder

Ticket::Responsible

特定のチケットにコールバックするため、チケット責任者機能を有効にします。

デフォルト値:

--- 0

Ticket::ResponsibleAutoSet

Automatically sets the owner of a ticket as the responsible for it (if ticket responsible
feature is enabled). This will only work by manually actions of the logged in
user. It does not work for automated actions e.g. GenericAgent, Postmaster and
GenericInterface.

デフォルト値:
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--- '1'

Ticket::Service

チケットに関するサービスおよびSLA（例：email, desktop, network, ...)、およびSLAのエス
カレーション属性を定義することを、許可します（チケット・サービス/SLA機能が有効となっ
ている場合）。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Service::Default::UnknownCustomer

Allows default services to be selected also for non existing customers.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Service::KeepChildren

Retains all services in listings even if they are children of invalid elements.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::StateAfterPending

状態（キー）のペンディング・タイムが終了した後に、どの状態が自動的に設定されるべきか
（コンテンツ）を定義します。

この設定は無効化することはできません。

デフォルト値:

---
pending auto close+: closed successful
pending auto close-: closed unsuccessful

Ticket::SubjectFormat

The format of the subject. 'Left' means '[TicketHook#:12345] Some Subject',
'Right' means 'Some Subject [TicketHook#:12345]', 'None' means 'Some Subject'
and no ticket number. In the latter case you should verify that the setting
PostMaster::CheckFollowUpModule###0200-References is activated to recognize
followups based on email headers.

この設定は無効化することはできません。

デフォルト値:

--- Left

Ticket::SubjectFwd

Eメールが転送された際の、件名の最初のテキストです。例：FW, Fwd, WG。
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この設定は無効化することはできません。

デフォルト値:

--- Fwd

Ticket::SubjectRe

Eメール・リプライにおける件名の最初のテキストです。例：RE, AW, AS。

この設定は無効化することはできません。

デフォルト値:

--- Re

Ticket::SubjectSize

Max size of the subjects in an email reply and in some overview screens.

この設定は無効化することはできません。

デフォルト値:

--- '100'

Ticket::Type

Enables ticket type feature.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Type::Default

Defines the default ticket type.

この設定は無効化することはできません。

デフォルト値:

--- Unclassified

Ticket::UnlockOnAway

メモが追加され、所有者が外出中の場合は、チケットのロックを解除します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::UnlockStateType

Defines the valid states for unlocked tickets. To unlock tickets the script "bin/
otrs.Console.pl Maint::Ticket::UnlockTimeout" can be used.

この設定は無効化することはできません。

デフォルト値:

436



---
- new
- open

Ticket::ViewableLocks

Defines the viewable locks of a ticket. NOTE: When you change this setting, make sure
to delete the cache in order to use the new value. Default: unlock, tmp_lock.

この設定は無効化することはできません。

デフォルト値:

---
- '''unlock'''
- '''tmp_lock'''

Ticket::ViewableSenderTypes

チケットについて視認できる、デフォルトの送信者タイプを定義します（デフォルト：
customer）。

この設定は無効化することはできません。

デフォルト値:

---
- '''customer'''

Ticket::ViewableStateType

チケットについて有効な状態タイプを定義します。

この設定は無効化することはできません。

デフォルト値:

---
- new
- open
- pending reminder
- pending auto

Ticket::Watcher

所有者または責任者になること無くチケットのコールバックを続けるため、チケット監視機能
を有効または無効にします。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::WatcherGroup

リストされたグループためにのみ、チケット監視機能を有効にします。

この設定は標準では有効ではありません。

デフォルト値:

---
- admin
- users
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64. Core → Ticket → ACL
ACL::CacheTTL

Cache time in seconds for the DB ACL backend.

この設定は無効化することはできません。

デフォルト値:

--- '3600'

ACLKeysLevel1Change

Defines which items are available in first level of the ACL structure.

デフォルト値:

---
Possible: Possible
PossibleAdd: PossibleAdd
PossibleNot: PossibleNot

ACLKeysLevel1Match

Defines which items are available in first level of the ACL structure.

デフォルト値:

---
Properties: Properties
PropertiesDatabase: PropertiesDatabase

ACLKeysLevel2::Possible

Defines which items are available in second level of the ACL structure.

デフォルト値:

---
Action: Action
ActivityDialog: ActivityDialog
Endpoint: Endpoint
Process: Process
Ticket: Ticket

ACLKeysLevel2::PossibleAdd

Defines which items are available in second level of the ACL structure.

デフォルト値:

---
Action: Action
ActivityDialog: ActivityDialog
Endpoint: Endpoint
Process: Process
Ticket: Ticket

ACLKeysLevel2::PossibleNot

Defines which items are available in second level of the ACL structure.

デフォルト値:

---
Action: Action
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ActivityDialog: ActivityDialog
Endpoint: Endpoint
Process: Process
Ticket: Ticket

ACLKeysLevel2::Properties

Defines which items are available in second level of the ACL structure.

デフォルト値:

---
CustomerUser: CustomerUser
DynamicField: DynamicField
Frontend: Frontend
Owner: Owner
Priority: Priority
Process: Process
Queue: Queue
Responsible: Responsible
SLA: SLA
Service: Service
State: State
Ticket: Ticket
Type: Type
User: User

ACLKeysLevel2::PropertiesDatabase

Defines which items are available in second level of the ACL structure.

デフォルト値:

---
CustomerUser: CustomerUser
DynamicField: DynamicField
Owner: Owner
Priority: Priority
Process: Process
Queue: Queue
Responsible: Responsible
SLA: SLA
Service: Service
State: State
Ticket: Ticket
Type: Type
User: User

ACLKeysLevel3::Actions###100-Default

Defines which items are available for 'Action' in third level of the ACL structure.

デフォルト値:

---
- AgentTicketBounce
- AgentTicketClose
- AgentTicketCompose
- AgentTicketCustomer
- AgentTicketForward
- AgentTicketEmail
- AgentTicketEmailOutbound
- AgentTicketEmailResend
- AgentTicketFreeText
- AgentTicketHistory
- AgentTicketLink
- AgentTicketLock
- AgentTicketMerge
- AgentTicketMove
- AgentTicketNote
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- AgentTicketOwner
- AgentTicketPending
- AgentTicketPhone
- AgentTicketPhoneInbound
- AgentTicketPhoneOutbound
- AgentTicketPlain
- AgentTicketPrint
- AgentTicketPriority
- AgentTicketProcess
- AgentTicketResponsible
- AgentTicketSearch
- AgentTicketWatcher
- AgentTicketZoom
- AgentLinkObject
- AgentSplitSelection

Ticket::Acl::Module###1-Ticket::Acl::Module

親チケットについて、その全ての子チケットが既にクローズされている場合にのみ、クローズ
することを許可するACLモジュールです（“State”は、全ての子チケットがクローズされるま
で、親チケットにどの状態が適用不可であるかを示しています）。

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::System::Ticket::Acl::CloseParentAfterClosedChilds
State:
- closed successful
- closed unsuccessful

TicketACL::Debug::Enabled

If enabled debugging information for ACLs is logged.

この設定は無効化することはできません。

デフォルト値:

--- 0

TicketACL::Debug::Filter###00-Default

Filter for debugging ACLs. Note: More ticket attributes can be added in the format
<OTRS_TICKET_Attribute> e.g. <OTRS_TICKET_Priority>.

この設定は標準では有効ではありません。

デフォルト値:

---
<OTRS_TICKET_TicketNumber>: ''
ACLName: ''

TicketACL::Debug::LogPriority

Defines the priority in which the information is logged and presented.

この設定は標準では有効ではありません。

デフォルト値:

--- debug

TicketACL::Default::Action

チケット・アクションに関するデフォルトのACLの値です。
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この設定は無効化することはできません。

デフォルト値:

--- {}

65. Core → Ticket →
DynamicFieldDefault

Ticket::TicketDynamicFieldDefault###Element1

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: TicketCreate
Name: Field1
Value: Default

Ticket::TicketDynamicFieldDefault###Element10

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element11

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element12

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".
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この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element13

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element14

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element15

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element16

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。
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デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element2

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element3

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element4

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element5

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:
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---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element6

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element7

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element8

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
Event: ''
Name: ''
Value: ''

Ticket::TicketDynamicFieldDefault###Element9

Configures a default TicketDynamicField setting. "Name" defines the dynamic field
which should be used, "Value" is the data that will be set, and "Event" defines the
trigger event. Please check the developer manual (http://otrs.github.io/doc/), chapter
"Ticket Event Module".

この設定は標準では有効ではありません。

デフォルト値:

---
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Event: ''
Name: ''
Value: ''

66. Core → Ticket → FulltextSearch
Ticket::SearchIndex::Attribute

Basic fulltext index settings. Execute "bin/otrs.Console.pl
Maint::Ticket::FulltextIndexRebuild" in order to generate a new index.

この設定は無効化することはできません。

デフォルト値:

---
WordCountMax: '1000'
WordLengthMax: '30'
WordLengthMin: '3'

Ticket::SearchIndex::Filters

Fulltext index regex filters to remove parts of the text.

この設定は無効化することはできません。

デフォルト値:

---
- '[,\&\<\>\?"\!\*\|;\[\]\(\)\+\$\^=]'
- ^[':.]|[':.]$
- ^[^\w]+$

Ticket::SearchIndex::ForceUnfilteredStorage

Force the storage of the original article text in the article search index, without
executing filters or applying stop word lists. This will increase the size of the search
index and thus may slow down fulltext searches.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::SearchIndex::IndexArchivedTickets

Defines whether to index archived tickets for fulltext searches.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::SearchIndex::StopWords###Custom

Customizable stop words for fulltext index. These words will be removed from the
search index.

この設定は標準では有効ではありません。

デフォルト値:

---
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- MyStopWord

Ticket::SearchIndex::StopWords###de

German stop words for fulltext index. These words will be removed from the search
index.

デフォルト値:

---
- aber
- als
- am
- an
- auch
- auf
- aus
- bei
- bin
- bis
- bist
- da
- dadurch
- daher
- darum
- das
- daß
- dass
- dein
- deine
- dem
- den
- der
- des
- dessen
- deshalb
- die
- dies
- dieser
- dieses
- doch
- dort
- du
- durch
- ein
- eine
- einem
- einen
- einer
- eines
- er
- es
- euer
- eure
- für
- hatte
- hatten
- hattest
- hattet
- hier
- hinter
- ich
- ihr
- ihre
- im
- in
- ist
- ja
- jede
- jedem
- jeden
- jeder
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- jedes
- jener
- jenes
- jetzt
- kann
- kannst
- können
- könnt
- machen
- mein
- meine
- mit
- muß
- mußt
- musst
- müssen
- müßt
- nach
- nachdem
- nein
- nicht
- nun
- oder
- seid
- sein
- seine
- sich
- sie
- sind
- soll
- sollen
- sollst
- sollt
- sonst
- soweit
- sowie
- und
- unser
- unsere
- unter
- vom
- von
- vor
- wann
- warum
- was
- weiter
- weitere
- wenn
- wer
- werde
- werden
- werdet
- weshalb
- wie
- wieder
- wieso
- wir
- wird
- wirst
- wo
- woher
- wohin
- zu
- zum
- zur
- über

Ticket::SearchIndex::StopWords###en

English stop words for fulltext index. These words will be removed from the search
index.
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デフォルト値:

---
- a
- about
- above
- after
- again
- against
- all
- am
- an
- and
- any
- are
- aren't
- as
- at
- be
- because
- been
- before
- being
- below
- between
- both
- but
- by
- can't
- cannot
- could
- couldn't
- did
- didn't
- do
- does
- doesn't
- doing
- don't
- down
- during
- each
- few
- for
- from
- further
- had
- hadn't
- has
- hasn't
- have
- haven't
- having
- he
- he'd
- he'll
- he's
- her
- here
- here's
- hers
- herself
- him
- himself
- his
- how
- how's
- i
- i'd
- i'll
- i'm
- i've
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- if
- in
- into
- is
- isn't
- it
- it's
- its
- itself
- let's
- me
- more
- most
- mustn't
- my
- myself
- no
- nor
- not
- of
- off
- on
- once
- only
- or
- other
- ought
- our
- ours
- ourselves
- out
- over
- own
- same
- shan't
- she
- she'd
- she'll
- she's
- should
- shouldn't
- so
- some
- such
- than
- that
- that's
- the
- their
- theirs
- them
- themselves
- then
- there
- there's
- these
- they
- they'd
- they'll
- they're
- they've
- this
- those
- through
- to
- too
- under
- until
- up
- very
- was
- wasn't
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- we
- we'd
- we'll
- we're
- we've
- were
- weren't
- what
- what's
- when
- when's
- where
- where's
- which
- while
- who
- who's
- whom
- why
- why's
- with
- won't
- would
- wouldn't
- you
- you'd
- you'll
- you're
- you've
- your
- yours
- yourself
- yourselves

Ticket::SearchIndex::StopWords###es

Spanish stop words for fulltext index. These words will be removed from the search
index.

デフォルト値:

---
- un
- una
- unas
- unos
- uno
- sobre
- todo
- también
- tras
- otro
- algún
- alguno
- alguna
- algunos
- algunas
- ser
- es
- soy
- eres
- somos
- sois
- estoy
- esta
- estamos
- estais
- estan
- como
- en
- para
- atras
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- porque
- por qué
- estado
- estaba
- ante
- antes
- siendo
- ambos
- pero
- por
- poder
- puede
- puedo
- podemos
- podeis
- pueden
- fui
- fue
- fuimos
- fueron
- hacer
- hago
- hace
- hacemos
- haceis
- hacen
- cada
- fin
- incluso
- primero
- desde
- conseguir
- consigo
- consigue
- consigues
- conseguimos
- consiguen
- ir
- voy
- va
- vamos
- vais
- van
- vaya
- gueno
- ha
- tener
- tengo
- tiene
- tenemos
- teneis
- tienen
- el
- la
- lo
- las
- los
- su
- aqui
- mio
- tuyo
- ellos
- ellas
- nos
- nosotros
- vosotros
- vosotras
- si
- dentro
- solo
- solamente
- saber
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- sabes
- sabe
- sabemos
- sabeis
- saben
- ultimo
- largo
- bastante
- haces
- muchos
- aquellos
- aquellas
- sus
- entonces
- tiempo
- verdad
- verdadero
- verdadera
- cierto
- ciertos
- cierta
- ciertas
- intentar
- intento
- intenta
- intentas
- intentamos
- intentais
- intentan
- dos
- bajo
- arriba
- encima
- usar
- uso
- usas
- usa
- usamos
- usais
- usan
- emplear
- empleo
- empleas
- emplean
- ampleamos
- empleais
- valor
- muy
- era
- eras
- eramos
- eran
- modo
- bien
- cual
- cuando
- donde
- mientras
- quien
- con
- entre
- sin
- trabajo
- trabajar
- trabajas
- trabaja
- trabajamos
- trabajais
- trabajan
- podria
- podrias
- podriamos
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- podrian
- podriais
- yo
- aquel

Ticket::SearchIndex::StopWords###fr

French stop words for fulltext index. These words will be removed from the search
index.

デフォルト値:

---
- alors
- au
- aucuns
- aussi
- autre
- avant
- avec
- avoir
- bon
- car
- ce
- cela
- ces
- ceux
- chaque
- ci
- comme
- comment
- dans
- des
- du
- dedans
- dehors
- depuis
- deux
- devrait
- doit
- donc
- dos
- droite
- début
- elle
- elles
- en
- encore
- essai
- est
- et
- eu
- fait
- faites
- fois
- font
- force
- haut
- hors
- ici
- il
- ils
- je
- juste
- la
- le
- les
- leur
- là
- ma
- maintenant
- mais
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- mes
- mine
- moins
- mon
- mot
- même
- ni
- nommés
- notre
- nous
- nouveaux
- ou
- où
- par
- parce
- parole
- pas
- personnes
- peut
- peu
- pièce
- plupart
- pour
- pourquoi
- quand
- que
- quel
- quelle
- quelles
- quels
- qui
- sa
- sans
- ses
- seulement
- si
- sien
- son
- sont
- sous
- soyez
- sujet
- sur
- ta
- tandis
- tellement
- tels
- tes
- ton
- tous
- tout
- trop
- très
- tu
- valeur
- voie
- voient
- vont
- votre
- vous
- vu
- ça
- étaient
- état
- étions
- été
- être

Ticket::SearchIndex::StopWords###it

Italian stop words for fulltext index. These words will be removed from the search
index.
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デフォルト値:

---
- a
- adesso
- ai
- al
- alla
- allo
- allora
- altre
- altri
- altro
- anche
- ancora
- avere
- aveva
- avevano
- ben
- buono
- che
- chi
- cinque
- comprare
- con
- consecutivi
- consecutivo
- cosa
- cui
- da
- del
- della
- dello
- dentro
- deve
- devo
- di
- doppio
- due
- e
- ecco
- fare
- fine
- fino
- fra
- gente
- giu
- ha
- hai
- hanno
- ho
- il
- indietro
- invece
- io
- la
- lavoro
- le
- lei
- lo
- loro
- lui
- lungo
- ma
- me
- meglio
- molta
- molti
- molto
- nei
- nella
- no
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- noi
- nome
- nostro
- nove
- nuovi
- nuovo
- o
- oltre
- ora
- otto
- peggio
- pero
- persone
- piu
- poco
- primo
- promesso
- qua
- quarto
- quasi
- quattro
- quello
- questo
- qui
- quindi
- quinto
- rispetto
- sara
- secondo
- sei
- sembra
- sembrava
- senza
- sette
- sia
- siamo
- siete
- solo
- sono
- sopra
- soprattutto
- sotto
- stati
- stato
- stesso
- su
- subito
- sul
- sulla
- tanto
- te
- tempo
- terzo
- tra
- tre
- triplo
- ultimo
- un
- una
- uno
- va
- vai
- voi
- volte
- vostro

Ticket::SearchIndex::StopWords###nl

Dutch stop words for fulltext index. These words will be removed from the search
index.

デフォルト値:
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---
- de
- zijn
- een
- en
- in
- je
- het
- van
- op
- ze
- hebben
- het
- hij
- niet
- met
- er
- dat
- die
- te
- wat
- voor
- naar
- gaan
- kunnen
- zeggen
- dat
- maar
- aan
- veel
- zijn
- worden
- uit
- ook
- komen
- als
- om
- moeten
- we
- doen
- bij
- goed
- haar
- dan
- nog
- of
- maken
- zo
- wel
- mijn
- zien
- over
- willen
- staan
- door
- kijken
- zullen
- heel
- nu
- weten
- zitten
- hem
- schrijven
- vinden
- woord
- hoe
- geen
- dit
- mens
- al
- jij
- ander
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- groot
- waar
- maar
- weer
- kind
- me
- vragen
- een
- denken
- twee
- horen
- iets
- deze
- krijgen
- ons
- zich
- lezen
- hun
- welk
- zin
- laten
- mogen
- hier
- jullie
- toch
- geven
- jaar
- tegen
- al
- eens
- echt
- houden
- alleen
- lopen
- mee
- ja
- roepen
- tijd
- dag
- elkaar
- even
- lang
- land
- liggen
- waarom
- zetten
- vader
- laat
- beginnen
- blijven
- nee
- moeder
- huis
- nou
- na
- af
- keer
- dus
- tot
- vertellen
- wie
- net
- jou
- les
- want
- man
- nieuw
- elk
- tekst
- omdat
- gebruiken
- u
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Ticket::SearchIndex::WarnOnStopWordUsage

Display a warning and prevent search when using stop words within fulltext search.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::SearchIndexModule

Helps to extend your articles full-text search (From, To, Cc, Subject and Body search).
It will strip all articles and will build an index after article creation, increasing
fulltext searches about 50%. To create an initial index use "bin/otrs.Console.pl
Maint::Ticket::FulltextIndexRebuild".

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::Ticket::ArticleSearchIndex::DB

67. Core → Ticket → Permission
CustomerTicket::Permission###1-GroupCheck

顧客がチケットにアクセスするためのグループ・パーミッションをチェックするモジュールで
す。

デフォルト値:

---
Granted: '0'
Module: Kernel::System::Ticket::CustomerPermission::GroupCheck
Required: '1'

CustomerTicket::Permission###2-CustomerUserIDCheck

Module to grant access if the CustomerUserID of the ticket matches the
CustomerUserID of the customer.

デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::CustomerPermission::CustomerUserIDCheck
Required: '0'

CustomerTicket::Permission###3-CustomerIDCheck

Module to grant access if the CustomerID of the ticket matches the CustomerID of
the customer.

デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::CustomerPermission::CustomerIDCheck
Required: '0'

CustomerTicket::Permission###4-CustomerGroupCheck

Module to grant access if the CustomerID of the customer has necessary group
permissions.
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デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::CustomerPermission::CustomerGroupCheck
Required: '0'

Ticket::Permission###1-OwnerCheck

Module to grant access to the owner of a ticket.

デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::Permission::OwnerCheck
Required: '0'

Ticket::Permission###2-ResponsibleCheck

Module to grant access to the agent responsible of a ticket.

デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::Permission::ResponsibleCheck
Required: '0'

Ticket::Permission###3-GroupCheck

チケットにアクセスするためのグループ・パーミッションをチェックするモジュールです。

デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::Permission::GroupCheck
Required: '0'

Ticket::Permission###4-WatcherCheck

Module to grant access to the watcher agents of a ticket.

デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::Permission::WatcherCheck
Required: '0'

Ticket::Permission###5-CreatorCheck

Module to grant access to the creator of a ticket.

この設定は標準では有効ではありません。

デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::Permission::CreatorCheck
Required: '0'

Ticket::Permission###6-InvolvedCheck

Module to grant access to any agent that has been involved in a ticket in the past
(based on ticket history entries).
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この設定は標準では有効ではありません。

デフォルト値:

---
Granted: '1'
Module: Kernel::System::Ticket::Permission::InvolvedCheck
Required: '0'

Ticket::Permission::CreatorCheck::Queues

Optional queue limitation for the CreatorCheck permission module. If set, permission
is only granted for tickets in the specified queues.

この設定は標準では有効ではありません。

デフォルト値:

---
Misc: note
Postmaster: ro, move, note
Raw: rw

Ticket::Permission::InvolvedCheck::Queues

Optional queue limitation for the InvolvedCheck permission module. If set, permission
is only granted for tickets in the specified queues.

この設定は標準では有効ではありません。

デフォルト値:

---
Misc: note
Postmaster: ro, move, note
Raw: rw

Ticket::Permission::OwnerCheck::Queues

Optional queue limitation for the OwnerCheck permission module. If set, permission
is only granted for tickets in the specified queues.

この設定は標準では有効ではありません。

デフォルト値:

---
Misc: note
Postmaster: ro, move, note
Raw: rw

Ticket::Permission::ResponsibleCheck::Queues

Optional queue limitation for the ResponsibleCheck permission module. If set,
permission is only granted for tickets in the specified queues.

この設定は標準では有効ではありません。

デフォルト値:

---
Misc: note
Postmaster: ro, move, note
Raw: rw
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68. Core → Time
CalendarWeekDayStart

日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

MaximumCalendarNumber

Maximum Number of a calendar shown in a dropdown.

この設定は標準では有効ではありません。

デフォルト値:

--- '50'

OTRSTimeZone

Sets the time zone being used internally by OTRS to e. g. store dates and times in the
database. WARNING: This setting must not be changed once set and tickets or any
other data containing date/time have been created.

この設定は無効化することはできません。

デフォルト値:

--- UTC

ShowUserTimeZoneSelectionNotification

If enabled, users that haven't selected a time zone yet will be notified to do so. Note:
Notification will not be shown if (1) user has not yet selected a time zone and (2)
OTRSTimeZone and UserDefaultTimeZone do match and (3) are not set to UTC.

この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeInputFormat

フォームで使用されるデータ・インプット・フォーマットを定義します（オプションまたはイ
ンプット・フィールド）。

この設定は無効化することはできません。

デフォルト値:

--- Option

TimeInputMinutesStep

Defines the available steps in time selections. Select "1 minute" to be able to select
all minutes of one hour from 1-59. Select "30 minutes" to only make full and half hours
available.

この設定は無効化することはできません。

デフォルト値:
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--- '1'

TimeShowAlwaysLong

Shows time in long format (days, hours, minutes), if enabled; or in short format (days,
hours), if not enabled.

この設定は無効化することはできません。

デフォルト値:

--- 0

TimeShowCompleteDescription

Shows time use complete description (days, hours, minutes), if enabled; or just first
letter (d, h, m), if not enabled.

この設定は無効化することはできません。

デフォルト値:

--- 0

TimeVacationDays

Adds the permanent vacation days.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime

Adds the one time vacation days.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours

業務時間とカウントする時間と週の平日数を定義します。

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'

463



- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone

This setting is deprecated. Set OTRSTimeZone instead.
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この設定は標準では有効ではありません。

デフォルト値:

--- '+0'

UserDefaultTimeZone

Sets the time zone that will be assigned to newly created users and will be used for
users that haven't yet set a time zone. This is the time zone being used as default to
convert date and time between the OTRS time zone and the user's time zone.

この設定は無効化することはできません。

デフォルト値:

--- UTC

69. Core → Time → Calendar1
CalendarWeekDayStart::Calendar1

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeVacationDays::Calendar1

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar1

Adds the one time vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours::Calendar1

Defines the hours and week days of the indicated calendar, to count the working time.
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この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
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- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar1

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.

この設定は標準では有効ではありません。

デフォルト値:

--- UTC

TimeZone::Calendar1Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:

--- Calendar Name 1

70. Core → Time → Calendar2
CalendarWeekDayStart::Calendar2

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeVacationDays::Calendar2

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar2

Adds the one time vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
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  '1':
    '1': test

TimeWorkingHours::Calendar2

Defines the hours and week days of the indicated calendar, to count the working time.

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
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- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar2

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.

この設定は標準では有効ではありません。

デフォルト値:

--- UTC

TimeZone::Calendar2Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:

--- Calendar Name 2

71. Core → Time → Calendar3
CalendarWeekDayStart::Calendar3

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeVacationDays::Calendar3

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar3

Adds the one time vacation days for the indicated calendar.
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この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours::Calendar3

Defines the hours and week days of the indicated calendar, to count the working time.

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
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- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar3

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.

この設定は標準では有効ではありません。

デフォルト値:

--- UTC

TimeZone::Calendar3Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:

--- Calendar Name 3

72. Core → Time → Calendar4
CalendarWeekDayStart::Calendar4

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeVacationDays::Calendar4

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day

471



  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar4

Adds the one time vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours::Calendar4

Defines the hours and week days of the indicated calendar, to count the working time.

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
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- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar4

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.

この設定は標準では有効ではありません。

デフォルト値:

--- UTC

TimeZone::Calendar4Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:

--- Calendar Name 4

73. Core → Time → Calendar5
CalendarWeekDayStart::Calendar5

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeVacationDays::Calendar5

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:
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---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar5

Adds the one time vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours::Calendar5

Defines the hours and week days of the indicated calendar, to count the working time.

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
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- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar5

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.

この設定は標準では有効ではありません。

デフォルト値:

--- UTC

TimeZone::Calendar5Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:

--- Calendar Name 5

74. Core → Time → Calendar6
CalendarWeekDayStart::Calendar6

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'
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TimeVacationDays::Calendar6

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar6

Adds the one time vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours::Calendar6

Defines the hours and week days of the indicated calendar, to count the working time.

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
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Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar6

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.

この設定は標準では有効ではありません。

デフォルト値:

--- UTC

TimeZone::Calendar6Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:

--- Calendar Name 6

75. Core → Time → Calendar7
CalendarWeekDayStart::Calendar7

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。
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この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeVacationDays::Calendar7

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar7

Adds the one time vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours::Calendar7

Defines the hours and week days of the indicated calendar, to count the working time.

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
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- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar7

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.

この設定は標準では有効ではありません。

デフォルト値:

--- UTC

TimeZone::Calendar7Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:
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--- Calendar Name 7

76. Core → Time → Calendar8
CalendarWeekDayStart::Calendar8

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeVacationDays::Calendar8

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar8

Adds the one time vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours::Calendar8

Defines the hours and week days of the indicated calendar, to count the working time.

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
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- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar8

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.

この設定は標準では有効ではありません。

デフォルト値:

--- UTC
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TimeZone::Calendar8Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:

--- Calendar Name 8

77. Core → Time → Calendar9
CalendarWeekDayStart::Calendar9

インシデントカレンダーの日付ピッカーにおける週の開始曜日を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

TimeVacationDays::Calendar9

Adds the permanent vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'1':
  '1': New Year's Day
'12':
  '24': Christmas Eve
  '25': First Christmas Day
  '26': Second Christmas Day
  '31': New Year's Eve
'5':
  '1': International Workers' Day

TimeVacationDaysOneTime::Calendar9

Adds the one time vacation days for the indicated calendar.

この設定は無効化することはできません。

デフォルト値:

---
'2004':
  '1':
    '1': test

TimeWorkingHours::Calendar9

Defines the hours and week days of the indicated calendar, to count the working time.

この設定は無効化することはできません。

デフォルト値:

---
Fri:
- '8'
- '9'
- '10'
- '11'
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- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Mon:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Sat: []
Sun: []
Thu:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Tue:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'
Wed:
- '8'
- '9'
- '10'
- '11'
- '12'
- '13'
- '14'
- '15'
- '16'
- '17'
- '18'
- '19'
- '20'

TimeZone::Calendar9

Defines the time zone of the indicated calendar, which can be assigned later to a
specific queue.
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この設定は標準では有効ではありません。

デフォルト値:

--- UTC

TimeZone::Calendar9Name

インシデントカレンダーの名称を設定してください。

この設定は無効化することはできません。

デフォルト値:

--- Calendar Name 9

78. Core → Web
Frontend::Module###AdminSystemConfigurationUser

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: System Configuration User Settings

79. Core → WebUserAgent
WebUserAgent::DisableSSLVerification

透過型HTTPSプロキシを利用するなどの理由によりSSL証明書の有効性チェックを無効化する
こともありますが、自己責任で実施願います。

この設定は無効化することはできません。

デフォルト値:

--- 0

WebUserAgent::Proxy

プロキシ経由で、http/ftpのための接続を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- http://proxy.sn.no:8001/

WebUserAgent::Timeout

http/ftp downloadsのためのタイムアウト（秒）を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '15'
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80. Daemon
Daemon::PID::Path

If enabled the daemon will use this directory to create its PID files. Note: Please stop
the daemon before any change and use this setting only if <$OTRSHome>/var/run/
can not be used.

この設定は標準では有効ではありません。

デフォルト値:

--- /opt/otrs/var/run/

81. Daemon → Log
Daemon::Log::DaysToKeep

Defines the number of days to keep the daemon log files.

この設定は標準では有効ではありません。

デフォルト値:

--- '1'

Daemon::Log::RotationType

Type of daemon log rotation to use: Choose 'OTRS' to let OTRS system to handle the
file rotation, or choose 'External' to use a 3rd party rotation mechanism (i.e. logrotate).
Note: External rotation mechanism requires its own and independent configuration.

この設定は無効化することはできません。

デフォルト値:

--- otrs

Daemon::Log::STDERR

If enabled the daemon will redirect the standard error stream to a log file.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Daemon::Log::STDOUT

If enabled the daemon will redirect the standard output stream to a log file.

この設定は無効化することはできません。

デフォルト値:

--- 0

82. Daemon → ModuleRegistration
DaemonModules###SchedulerCronTaskManager

The daemon registration for the scheduler cron task manager.
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この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::System::Daemon::DaemonModules::SchedulerCronTaskManager

DaemonModules###SchedulerFutureTaskManager

The daemon registration for the scheduler future task manager.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::System::Daemon::DaemonModules::SchedulerFutureTaskManager

DaemonModules###SchedulerGenericAgentTaskManager

The daemon registration for the scheduler generic agent task manager.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::System::Daemon::DaemonModules::SchedulerGenericAgentTaskManager

DaemonModules###SchedulerTaskWorker

The daemon registration for the scheduler task worker.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::System::Daemon::DaemonModules::SchedulerTaskWorker

DaemonModules###SystemConfigurationSyncManager

The daemon registration for the configuration deployment sync manager.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::System::Daemon::DaemonModules::SystemConfigurationSyncManager

83. Daemon →
SchedulerCronTaskManager → Task

Daemon::SchedulerCronTaskManager::Task###AccessTokenDeleteExpired

Delete expired access-tokens.

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::AccessToken
Params:

486



- --purge
Schedule: 00 01 * * *
TaskName: AccessTokenDeleteExpired

Daemon::SchedulerCronTaskManager::Task###AccessTokenGenerateNewKey

Generate new access-token key, and from now on all new tokens will use this key, and
also purges the older ones.

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::AccessToken::Keys
Params:
- --generate
- --keep
- '3'
Schedule: 00 04 * * *
TaskName: AccessTokenGenerateNewKey

Daemon::SchedulerCronTaskManager::Task###ArticleSearchIndexRebuild

Checks for articles that needs to be updated in the article search index.

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Ticket::FulltextIndexRebuildWorker
Params:
- --children
- '4'
- --limit
- '20000'
Schedule: '* * * * *'
TaskName: ArticleSearchIndexRebuild

Daemon::SchedulerCronTaskManager::Task###CommunicationLogDelete

削除するコミュニケーション・ログのエントリをチェックします。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Log::CommunicationLog
Params:
- --purge
Schedule: 00 03 * * *
TaskName: CommunicationLogDelete

Daemon::SchedulerCronTaskManager::Task###ConfigurationDeploymentCleanup

古いシステム設定のデプロイを削除します。（日曜の朝）

この設定は無効化することはできません。

デフォルト値:

---
Function: ConfigurationDeployCleanup
MaximumParallelInstances: '1'
Module: Kernel::System::SysConfig
Params: []
Schedule: 40 0 * * 0
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TaskName: ConfigurationDeploymentCleanup

Daemon::SchedulerCronTaskManager::Task###ContractCheck

Checks the contract status of the system.

この設定は無効化することはできません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::SystemContract::ContractStatusCheck
Params: []
Schedule: '*/5 * * * *'
TaskName: ContractCheck

Daemon::SchedulerCronTaskManager::Task###CoreCacheCleanup

Delete expired cache from core modules.

デフォルト値:

---
Function: CleanUp
MaximumParallelInstances: '1'
Module: Kernel::System::Cache
Params:
- Expired
- '1'
Schedule: 20 0 * * 0
TaskName: CoreCacheCleanup

Daemon::SchedulerCronTaskManager::Task###Custom1

Executes a custom command or module. Note: if module is used, function is required.

この設定は標準では有効ではありません。

デフォルト値:

---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom1

Daemon::SchedulerCronTaskManager::Task###Custom2

Executes a custom command or module. Note: if module is used, function is required.

この設定は標準では有効ではありません。

デフォルト値:

---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom2

Daemon::SchedulerCronTaskManager::Task###Custom3

Executes a custom command or module. Note: if module is used, function is required.
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この設定は標準では有効ではありません。

デフォルト値:

---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom3

Daemon::SchedulerCronTaskManager::Task###Custom4

Executes a custom command or module. Note: if module is used, function is required.

この設定は標準では有効ではありません。

デフォルト値:

---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom4

Daemon::SchedulerCronTaskManager::Task###Custom5

Executes a custom command or module. Note: if module is used, function is required.

この設定は標準では有効ではありません。

デフォルト値:

---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom5

Daemon::SchedulerCronTaskManager::Task###Custom6

Executes a custom command or module. Note: if module is used, function is required.

この設定は標準では有効ではありません。

デフォルト値:

---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom6

Daemon::SchedulerCronTaskManager::Task###Custom7

Executes a custom command or module. Note: if module is used, function is required.

この設定は標準では有効ではありません。

デフォルト値:
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---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom7

Daemon::SchedulerCronTaskManager::Task###Custom8

Executes a custom command or module. Note: if module is used, function is required.

この設定は標準では有効ではありません。

デフォルト値:

---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom8

Daemon::SchedulerCronTaskManager::Task###Custom9

Executes a custom command or module. Note: if module is used, function is required.

この設定は標準では有効ではありません。

デフォルト値:

---
Function: ''
MaximumParallelInstances: '1'
Module: ''
Params: []
Schedule: '* * * * *'
TaskName: Custom9

Daemon::SchedulerCronTaskManager::Task###EscalationCheck

Triggers ticket escalation events and notification events for escalation.

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Ticket::EscalationCheck
Params: []
Schedule: '*/5 * * * *'
TaskName: EscalationCheck

Daemon::SchedulerCronTaskManager::Task###FetchMail

Fetch emails via fetchmail.

この設定は標準では有効ではありません。

デフォルト値:

---
Function: Fetch
MaximumParallelInstances: '1'
Module: Kernel::System::FetchMail
Params: []
Schedule: '*/5 * * * *'

490



TaskName: FetchMail

Daemon::SchedulerCronTaskManager::Task###FetchMailSSL

Fetch emails via fetchmail (using SSL).

この設定は標準では有効ではありません。

デフォルト値:

---
Function: Fetch
MaximumParallelInstances: '1'
Module: Kernel::System::FetchMail
Params:
- SSL
- '1'
Schedule: '*/5 * * * *'
TaskName: FetchMailSSL

Daemon::SchedulerCronTaskManager::Task###GenerateDashboardStats

ダッシュボードのレポート情報を生成します。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Stats::Dashboard::Generate
Params: []
Schedule: 5 * * * *
TaskName: GenerateDashboardStats

Daemon::SchedulerCronTaskManager::Task###GenericAgentFile1

Run file based generic agent jobs (Note: module name needs to be specified in -
configuration-module param e.g. "Kernel::System::GenericAgent").

この設定は標準では有効ではありません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::GenericAgent::Run
Params:
- --configuration-module
- <ModuleName>
Schedule: '*/20 * * * *'
TaskName: GenericAgentFile1

Daemon::SchedulerCronTaskManager::Task###GenericAgentFile2

Run file based generic agent jobs (Note: module name needs to be specified in -
configuration-module param e.g. "Kernel::System::GenericAgent").

この設定は標準では有効ではありません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::GenericAgent::Run
Params:
- --configuration-module
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- <ModuleName>
Schedule: '*/20 * * * *'
TaskName: GenericAgentFile2

Daemon::SchedulerCronTaskManager::Task###GenericAgentFile3

Run file based generic agent jobs (Note: module name needs to be specified in -
configuration-module param e.g. "Kernel::System::GenericAgent").

この設定は標準では有効ではありません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::GenericAgent::Run
Params:
- --configuration-module
- <ModuleName>
Schedule: '*/20 * * * *'
TaskName: GenericAgentFile3

Daemon::SchedulerCronTaskManager::Task###GenericAgentFile4

Run file based generic agent jobs (Note: module name needs to be specified in -
configuration-module param e.g. "Kernel::System::GenericAgent").

この設定は標準では有効ではありません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::GenericAgent::Run
Params:
- --configuration-module
- <ModuleName>
Schedule: '*/20 * * * *'
TaskName: GenericAgentFile4

Daemon::SchedulerCronTaskManager::Task###GenericAgentFile5

Run file based generic agent jobs (Note: module name needs to be specified in -
configuration-module param e.g. "Kernel::System::GenericAgent").

この設定は標準では有効ではありません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::GenericAgent::Run
Params:
- --configuration-module
- <ModuleName>
Schedule: '*/20 * * * *'
TaskName: GenericAgentFile5

Daemon::SchedulerCronTaskManager::Task###GeneticInterfaceDebugLogCleanup

Renew existing SMIME certificates from customer backend. Note: SMIME and
SMIME::FetchFromCustomer needs to be enabled in SysConfig and customer backend
needs to be configured to fetch UserSMIMECertificate attribute.

デフォルト値:
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---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::GenericInterface::DebugLog::Cleanup
Params:
- --created-before-days
- '14'
Schedule: 02 03 * * *
TaskName: GeneticInterfaceDebugLogCleanup

Daemon::SchedulerCronTaskManager::Task###IndexMaintenance

Verify indices structure and index missing documents.

この設定は無効化することはできません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::DocumentSearch::IndexWorker
Params:
- --verify-index
Schedule: '*/1 * * * *'
TaskName: IndexMaintenance

Daemon::SchedulerCronTaskManager::Task###LoaderCacheDelete

Delete expired loader cache weekly (Sunday mornings).

デフォルト値:

---
Function: CacheDelete
MaximumParallelInstances: '1'
Module: Kernel::System::Loader
Params: []
Schedule: 30 0 * * 0
TaskName: LoaderCacheDelete

Daemon::SchedulerCronTaskManager::Task###MailAccountFetch

Fetch incoming emails from configured mail accounts.

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::PostMaster::MailAccountFetch
Params: []
Schedule: '*/10 * * * *'
TaskName: MailAccountFetch

Daemon::SchedulerCronTaskManager::Task###MailQueueSend

Checks for queued outgoing emails to be sent.

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Email::MailQueue
Params:
- --send
Schedule: '* * * * *'
TaskName: MailQueueSend
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Daemon::SchedulerCronTaskManager::Task###NotificationViewDeleteExpired

Delete expired notifications from Notification View screen.

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::NotificationView::DeleteExpired
Params:
- --user-type
- Customer
Schedule: 00 02 * * *
TaskName: NotificationViewDeleteExpired

Daemon::SchedulerCronTaskManager::Task###RegistrationUpdateSend

Sends registration information to OTRS group.

この設定は無効化することはできません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Registration::UpdateSend
Params: []
Schedule: 30 * * * *
TaskName: RegistrationUpdateSend

Daemon::SchedulerCronTaskManager::Task###RemoveClosedChats

ChatEngine::ChatTTL より古い、終了したチャットを削除する

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Chat::Cleanup::Closed
Params: []
Schedule: 7 23 * * *
TaskName: RemoveClosedChats

Daemon::SchedulerCronTaskManager::Task###RemoveOldChats

古いチャットを削除する

この設定は標準では有効ではありません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Chat::Cleanup::Old
Params: []
Schedule: 15 3 * * 0
TaskName: RemoveClosedChats

Daemon::SchedulerCronTaskManager::Task###RenewCustomerSMIMECertificates

Renew existing SMIME certificates from customer backend. Note: SMIME and
SMIME::FetchFromCustomer needs to be enabled in SysConfig and customer backend
needs to be configured to fetch UserSMIMECertificate attribute.
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デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::SMIME::CustomerCertificate::Renew
Params: []
Schedule: 02 02 * * *
TaskName: RenewCustomerSMIMECertificates

Daemon::SchedulerCronTaskManager::Task###SessionDeleteExpired

期限切れのセッションデータを削除する。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Session::DeleteExpired
Params: []
Schedule: 55 */2 * * *
TaskName: SessionDeleteExpired

Daemon::SchedulerCronTaskManager::Task###SpoolMailsReprocess

Reprocess mails from spool directory that could not be imported in the first place.

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::PostMaster::SpoolMailsReprocess
Params: []
Schedule: 10 0 * * *
TaskName: SpoolMailsReprocess

Daemon::SchedulerCronTaskManager::Task###StatsReportsGenerateCron

Generate statistics reports.

この設定は無効化することはできません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Stats::Reports::GenerateCron
Params: []
Schedule: '*/10 * * * *'
TaskName: StatsReportsGenerateCron

Daemon::SchedulerCronTaskManager::Task###SupportDataCollectAsynchronous

Collect support data for asynchronous plug-in modules.

この設定は無効化することはできません。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::SupportData::CollectAsynchronous
Params: []
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Schedule: 1 * * * *
TaskName: SupportDataCollectAsynchronous

Daemon::SchedulerCronTaskManager::Task###TicketAcceleratorRebuild

AgentTicketQueueのチケットインデックスを再構築します。

デフォルト値:

---
Function: TicketAcceleratorRebuild
MaximumParallelInstances: '1'
Module: Kernel::System::Ticket
Params: []
Schedule: 01 01 * * *
TaskName: TicketAcceleratorRebuild

Daemon::SchedulerCronTaskManager::Task###TicketDraftDeleteExpired

期限切れのチケット下書きエントリを削除します。

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::FormDraft::Delete
Params:
- --object-type
- Ticket
- --expired
Schedule: 55 * * * *
TaskName: TicketDraftDeleteExpired

Daemon::SchedulerCronTaskManager::Task###TicketNumberCounterCleanup

Removes old ticket number counters (each 10 minutes).

この設定は無効化することはできません。

デフォルト値:

---
Function: TicketNumberCounterCleanup
MaximumParallelInstances: '1'
Module: Kernel::System::Ticket::Number::AutoIncrement
Params: []
Schedule: '*/10 * * * *'
TaskName: TicketNumberCounterCleanup

Daemon::SchedulerCronTaskManager::Task###TicketPendingCheck

保留中プロセスチケット

デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Ticket::PendingCheck
Params: []
Schedule: 45 */2 * * *
TaskName: TicketPendingCheck

Daemon::SchedulerCronTaskManager::Task###TicketUnlockTimeout

アンロック期限を過ぎたチケットはロックが解除されます。
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デフォルト値:

---
Function: Execute
MaximumParallelInstances: '1'
Module: Kernel::System::Console::Command::Maint::Ticket::UnlockTimeout
Params: []
Schedule: 35 * * * *
TaskName: TicketUnlockTimeout

Daemon::SchedulerCronTaskManager::Task###WebUploadCacheCleanup

Delete expired upload cache hourly.

デフォルト値:

---
Function: FormIDCleanUp
MaximumParallelInstances: '1'
Module: Kernel::System::Web::UploadCache
Params: []
Schedule: 46 * * * *
TaskName: WebUploadCacheCleanup

84. Daemon →
SchedulerGenericAgentTaskManager

Daemon::SchedulerGenericAgentTaskManager::SleepTime

Defines a sleep time in microseconds between tickets while they are been processed
by a job.

この設定は無効化することはできません。

デフォルト値:

--- 0

Daemon::SchedulerGenericAgentTaskManager::TicketLimit

Defines the maximum number of affected tickets per job.

この設定は無効化することはできません。

デフォルト値:

--- '4000'

85. Daemon →
SchedulerGenericInterfaceTaskManager

Daemon::SchedulerGenericInterfaceTaskManager::FutureTaskTimeDiff

Defines the default the number of seconds (from current time) to re-schedule a generic
interface failed task.

この設定は無効化することはできません。

デフォルト値:

--- '300'
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86. Daemon → SchedulerTaskWorker
Daemon::SchedulerTaskWorker::MaximumWorkers

Defines the maximum number of tasks to be executed as the same time. Note: Options
below 5 might result in a slow processing of the tasks and are not recommended.

この設定は無効化することはできません。

デフォルト値:

--- '5'

Daemon::SchedulerTaskWorker::NotificationRecipientEmail

Specifies the email addresses to get notification messages from scheduler tasks.

この設定は無効化することはできません。

デフォルト値:

--- root@localhost

87. Frontend → Admin
Events###Appointment

List of all appointment events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- AppointmentCreate
- AppointmentUpdate
- AppointmentDelete
- AppointmentNotification

Events###Article

List of all article events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- ArticleCreate
- ArticleUpdate
- ArticleSend
- ArticleBounce
- ArticleAgentNotification
- ArticleCustomerNotification
- ArticleAutoResponse
- ArticleFlagSet
- ArticleFlagDelete
- ArticleCustomerFlagSet
- ArticleCustomerFlagDelete
- ArticleAgentNotification
- ArticleCustomerNotification
- ArticleEmailSendingQueued
- ArticleEmailSendingSent
- ArticleEmailSendingError
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Events###Calendar

List of all calendar events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- CalendarCreate
- CalendarUpdate

Events###CustomerCompany

List of all CustomerCompany events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- CustomerCompanyAdd
- CustomerCompanyUpdate

Events###CustomerUser

List of all CustomerUser events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- CustomerUserAdd
- CustomerUserUpdate

Events###DynamicField

List of all DynamicField events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- DynamicFieldAdd
- DynamicFieldUpdate
- DynamicFieldDelete

Events###LinkObject

List of all LinkObject events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- LinkObjectLinkAdd
- LinkObjectLinkDelete

Events###Package

List of all Package events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:
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---
- PackageInstall
- PackageReinstall
- PackageUpgrade
- PackageUninstall

Events###Queue

List of all queue events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- QueueCreate
- QueueUpdate

Events###Ticket

List of all ticket events to be displayed in the GUI.

この設定は無効化することはできません。

デフォルト値:

---
- TicketCreate
- TicketDelete
- TicketTitleUpdate
- TicketUnlockTimeoutUpdate
- TicketQueueUpdate
- TicketTypeUpdate
- TicketServiceUpdate
- TicketSLAUpdate
- TicketCustomerUpdate
- TicketPendingTimeUpdate
- TicketLockUpdate
- TicketArchiveFlagUpdate
- TicketStateUpdate
- TicketOwnerUpdate
- TicketResponsibleUpdate
- TicketPriorityUpdate
- HistoryAdd
- HistoryDelete
- TicketAccountTime
- TicketMerge
- TicketSubscribe
- TicketUnsubscribe
- TicketFlagSet
- TicketCustomerFlagSet
- TicketFlagDelete
- TicketCustomerFlagDelete
- EscalationResponseTimeNotifyBefore
- EscalationUpdateTimeNotifyBefore
- EscalationSolutionTimeNotifyBefore
- EscalationResponseTimeStart
- EscalationUpdateTimeStart
- EscalationSolutionTimeStart
- EscalationResponseTimeStop
- EscalationUpdateTimeStop
- EscalationSolutionTimeStop
- NotificationNewTicket
- NotificationFollowUp
- NotificationLockTimeout
- NotificationOwnerUpdate
- NotificationResponsibleUpdate
- NotificationAddNote
- NotificationMove
- NotificationPendingReminder
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- NotificationEscalation
- NotificationEscalationNotifyBefore
- NotificationServiceUpdate

88. Frontend → Admin →
ModuleRegistration

Frontend::Module###Admin

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin Area.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: ''

Frontend::Module###AdminACL

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Access Control Lists (ACL)

Frontend::Module###AdminAppointmentCalendarManage

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Calendar manage screen.
Group:
- admin
GroupRo: []
NavBarName: Calendar
Title: Manage Calendars

Frontend::Module###AdminAppointmentNotificationEvent

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Appointment Notifications

Frontend::Module###AdminAttachment

担当者インタフェースに関するフロントエンド・モジュールの登録です。

501



デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Attachments

Frontend::Module###AdminAutoResponse

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Auto Responses

Frontend::Module###AdminChatChannel

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS Business Solution™.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Chat Channel

Frontend::Module###AdminCloudServiceSMS

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: SMS

Frontend::Module###AdminCloudServices

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Cloud Services

Frontend::Module###AdminCommunicationLog

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Communication Log GUI

Frontend::Module###AdminContactWithData

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin contact with data.
Group:
- admin
GroupRo: []
NavBarName: Ticket
Title: Admin Contact With Data

Frontend::Module###AdminCustomPage

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Admin Custom Page

Frontend::Module###AdminCustomerCompany

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Edit Customer Companies.
Group:
- admin
- users
GroupRo: []
NavBarName: Customers
Title: Customer Companies

Frontend::Module###AdminCustomerGroup

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Customers ↔ Groups

Frontend::Module###AdminCustomerUser

担当者インタフェースに関するフロントエンド・モジュールの登録です。

503



デフォルト値:

---
Description: Edit Customer Users.
Group:
- admin
- users
GroupRo: []
NavBarName: Customers
Title: Customer Users

Frontend::Module###AdminCustomerUserCustomer

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Customer Users ↔ Customers

Frontend::Module###AdminCustomerUserGroup

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Customer Users ↔ Groups

Frontend::Module###AdminCustomerUserService

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Customer Users ↔ Services

Frontend::Module###AdminDynamicField

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Dynamic Fields GUI

Frontend::Module###AdminDynamicFieldCheckbox

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Dynamic Fields Checkbox Backend GUI

Frontend::Module###AdminDynamicFieldContactWithData

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS Business Solution™.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Dynamic Fields Contact Data Backend GUI

Frontend::Module###AdminDynamicFieldDateTime

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Dynamic Fields Date Time Backend GUI

Frontend::Module###AdminDynamicFieldDropdown

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Dynamic Fields Drop-down Backend GUI

Frontend::Module###AdminDynamicFieldInvalid

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Dynamic Fields Invalid Backend GUI

Frontend::Module###AdminDynamicFieldMultiselect

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Dynamic Fields Multiselect Backend GUI

Frontend::Module###AdminDynamicFieldText

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Dynamic Fields Text Backend GUI

Frontend::Module###AdminEmail

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Admin Notification

Frontend::Module###AdminExternalHomePage

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Admin External Home Page

Frontend::Module###AdminExternalLayout

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Admin External Interface Layout

Frontend::Module###AdminGenericAgent

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: GenericAgent

Frontend::Module###AdminGenericInterfaceDebugger

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface Debugger GUI

Frontend::Module###AdminGenericInterfaceErrorHandlingDefault

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface ErrorHandling GUI

Frontend::Module###AdminGenericInterfaceErrorHandlingRequestRetry

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface ErrorHandling GUI

Frontend::Module###AdminGenericInterfaceInvokerDefault

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface Invoker GUI

Frontend::Module###AdminGenericInterfaceInvokerEvent

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface Invoker Event GUI

Frontend::Module###AdminGenericInterfaceMappingSimple

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface Web Service Mapping GUI

Frontend::Module###AdminGenericInterfaceMappingXSLT

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface Web Service Mapping GUI

Frontend::Module###AdminGenericInterfaceOperationDefault

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface Operation GUI

Frontend::Module###AdminGenericInterfaceOperationRPC

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface RPC Operation GUI

Frontend::Module###AdminGenericInterfaceTransportHTTPREST

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface TransportHTTPREST GUI

Frontend::Module###AdminGenericInterfaceTransportHTTPSOAP

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface TransportHTTPSOAP GUI

Frontend::Module###AdminGenericInterfaceWebservice

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: GenericInterface Web Service GUI

Frontend::Module###AdminGenericInterfaceWebserviceHistory

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: GenericInterface Web Service History GUI

Frontend::Module###AdminGroup

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Groups

Frontend::Module###AdminInit

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Initialization

Frontend::Module###AdminLog

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: System Log

Frontend::Module###AdminMailAccount

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Mail Accounts

Frontend::Module###AdminNotificationEvent

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Ticket Notifications

Frontend::Module###AdminPGP

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: PGP Key Management

Frontend::Module###AdminPackageManager

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: Software Package Manager.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Package Manager

Frontend::Module###AdminPerformanceLog

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Performance Log

Frontend::Module###AdminPostMasterFilter

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: PostMaster Filters

Frontend::Module###AdminPriority

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Priorities

Frontend::Module###AdminProcessManagement

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Process Management

Frontend::Module###AdminProcessManagementActivity

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Process Management Activity GUI

Frontend::Module###AdminProcessManagementActivityDialog

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Process Management Activity Dialog GUI

Frontend::Module###AdminProcessManagementPath

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Process Management Path GUI

Frontend::Module###AdminProcessManagementSequenceFlow

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Process Management Sequence Flow GUI

Frontend::Module###AdminProcessManagementSequenceFlowAction

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Process Management Sequence Flow Action GUI

Frontend::Module###AdminQueue

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Queues

Frontend::Module###AdminQueueAutoResponse

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Queues ↔ Auto Responses

Frontend::Module###AdminQueueSMSTemplates

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: SMS Templates ↔ Queues

Frontend::Module###AdminQueueTemplates

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Templates ↔ Queues

Frontend::Module###AdminRegistration

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: System Registration

Frontend::Module###AdminRole

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Roles

Frontend::Module###AdminRoleGroup

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Roles ↔ Groups

Frontend::Module###AdminRoleUser

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Agents ↔ Roles

Frontend::Module###AdminSLA

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Service Level Agreements

Frontend::Module###AdminSMIME

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: S/MIME Management

Frontend::Module###AdminSMSTemplate

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: SMS Templates

Frontend::Module###AdminSalutation

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Salutations

Frontend::Module###AdminSelectBox

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: SQL Box

Frontend::Module###AdminService

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Services

Frontend::Module###AdminServiceCatalogue

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Admin Customer Service Catalogue.

Frontend::Module###AdminServiceCatalogueCategories

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Admin Customer Service Catalogue Categories

Frontend::Module###AdminServiceCatalogueItems

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Admin Customer Service Catalogue Items

Frontend::Module###AdminSession

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Session Management

Frontend::Module###AdminSignature

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Signatures

Frontend::Module###AdminState

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: States

Frontend::Module###AdminSupportDataCollector

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Support Data Collector

Frontend::Module###AdminSystemAddress

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Email Addresses

Frontend::Module###AdminSystemConfiguration

担当者インタフェースに関するフロントエンド・モジュールの登録です。

この設定は無効化することはできません。

デフォルト値:

---
Description: Admin.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: System Configuration

Frontend::Module###AdminSystemConfigurationDeployment

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Manage System Configuration Deployments.
Group:
- admin
- users
GroupRo: []
NavBarName: SystemConfiguration
Title: System Configuration Deployment

Frontend::Module###AdminSystemConfigurationGroup

担当者インタフェースに関するフロントエンド・モジュールの登録です。

この設定は無効化することはできません。

デフォルト値:

---
Description: Admin.
Group:
- admin
GroupRo: []
NavBarName: Admin
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Title: System Configuration Group

Frontend::Module###AdminSystemMaintenance

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: System Maintenance

Frontend::Module###AdminTemplate

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Templates

Frontend::Module###AdminTemplateAttachment

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Templates ↔ Attachments

Frontend::Module###AdminType

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Types

Frontend::Module###AdminUser

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Create and manage agents.
Group:
- admin
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GroupRo: []
NavBarName: Admin
Title: Agents

Frontend::Module###AdminUserGroup

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: This module is part of the admin area of OTRS.
Group:
- admin
GroupRo: []
NavBarName: Admin
Title: Agents ↔ Groups

Frontend::Module###AgentDaemonInfo

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Admin
Group:
- admin
GroupRo: []
NavBarName: ''
Title: Shows information on how to start OTRS Daemon

Frontend::NavBarModule###11-AdminContactWithData

Agent frontend module registration (disable 'Edit contacts with data' link if if there is
no source field configured).

デフォルト値:

---
Module: Kernel::Output::HTML::NavBar::AdminContactWithData

89. Frontend → Admin →
ModuleRegistration → AdminOverview

Frontend::NavigationModule###Admin

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: ''
Description: Admin modules overview.
Group:
- admin
GroupRo: []
IconBig: ''
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: ''

Frontend::NavigationModule###AdminACL

担当者Webインタフェースの管理ナビゲーション

519



デフォルト値:

---
Block: Automation
Description: Configure and manage ACLs.
Group:
- admin
GroupRo: []
IconBig: fa-check-square-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Access Control Lists (ACL)

Frontend::NavigationModule###AdminAppointmentCalendarManage

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Administration
Description: Create and manage calendars.
Group:
- admin
GroupRo: []
IconBig: fa-calendar
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Calendars

Frontend::NavigationModule###AdminAppointmentNotificationEvent

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
Description: Create and manage appointment notifications.
Group:
- admin
GroupRo: []
IconBig: fa-bell-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Appointment Notifications

Frontend::NavigationModule###AdminAttachment

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage attachments.
Group:
- admin
GroupRo: []
IconBig: fa-paperclip
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Attachments

Frontend::NavigationModule###AdminAutoResponse

担当者Webインタフェースの管理ナビゲーション

デフォルト値:
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---
Block: Ticket
Description: Create and manage responses that are automatically sent.
Group:
- admin
GroupRo: []
IconBig: fa-reply
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Auto Responses

Frontend::NavigationModule###AdminChatChannel

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Administration
Description: Create and manage chat channels.
Group:
- admin
GroupRo: []
IconBig: fa-comments-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Chat Channel

Frontend::NavigationModule###AdminCloudServices

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: OTRSGroup
Description: Manage OTRS Group cloud services.
Group:
- admin
GroupRo: []
IconBig: fa-cloud
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Cloud Services

Frontend::NavigationModule###AdminCommunicationLog

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
Description: Display communication log entries.
Group:
- admin
GroupRo: []
IconBig: fa-table
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Communication Log

Frontend::NavigationModule###AdminCustomPage

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
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Block: External
Description: Manage Custom Pages.
Group:
- admin
GroupRo: []
IconBig: fa-file-text-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Custom Pages

Frontend::NavigationModule###AdminCustomerCompany

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Create and manage customers.
Group:
- admin
- users
GroupRo: []
IconBig: fa-building-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Customers

Frontend::NavigationModule###AdminCustomerGroup

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Link customers to groups.
Group:
- admin
GroupRo: []
IconBig: fa-building-o
IconSmall: fa-users
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Customers ↔ Groups

Frontend::NavigationModule###AdminCustomerUser

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Create and manage customer users.
Group:
- admin
- users
GroupRo: []
IconBig: fa-male
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Customer User

Frontend::NavigationModule###AdminCustomerUserCustomer

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
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Block: Users
Description: Link customer users to customers.
Group:
- admin
GroupRo: []
IconBig: fa-male
IconSmall: fa-building-o
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Customer Users ↔ Customers

Frontend::NavigationModule###AdminCustomerUserGroup

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Link customer users to groups.
Group:
- admin
GroupRo: []
IconBig: fa-male
IconSmall: fa-users
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Customer Users ↔ Groups

Frontend::NavigationModule###AdminCustomerUserService

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Link customer users to services.
Group:
- admin
GroupRo: []
IconBig: fa-male
IconSmall: fa-wrench
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Customer Users ↔ Services

Frontend::NavigationModule###AdminDynamicField

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Automation
Description: Create and manage dynamic fields.
Group:
- admin
GroupRo: []
IconBig: fa-align-left
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Dynamic Fields

Frontend::NavigationModule###AdminEmail

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
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Description: Send notifications to users.
Group:
- admin
GroupRo: []
IconBig: fa-quote-right
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Admin Notification

Frontend::NavigationModule###AdminExternalHomePage

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: External
Description: Manage the Home Page.
Group:
- admin
GroupRo: []
IconBig: fa-home
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Home Page

Frontend::NavigationModule###AdminExternalLayout

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: External
Description: Manage the Layout.
Group:
- admin
GroupRo: []
IconBig: fa-paint-brush
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Layout

Frontend::NavigationModule###AdminGenericAgent

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Automation
Description: Manage tasks triggered by event or time based execution.
Group:
- admin
GroupRo: []
IconBig: fa-database
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: GenericAgent

Frontend::NavigationModule###AdminGenericInterfaceWebservice

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Automation
Description: Create and manage web services.
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Group:
- admin
GroupRo: []
IconBig: ''
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Web Services

Frontend::NavigationModule###AdminGroup

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Create and manage groups.
Group:
- admin
GroupRo: []
IconBig: fa-users
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Groups

Frontend::NavigationModule###AdminLog

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Administration
Description: View system log messages.
Group:
- admin
GroupRo: []
IconBig: fa-file-text-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: System Log

Frontend::NavigationModule###AdminMailAccount

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
Description: Manage POP3 or IMAP accounts to fetch email from.
Group:
- admin
GroupRo: []
IconBig: fa-envelope-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: PostMaster Mail Accounts

Frontend::NavigationModule###AdminNotificationEvent

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
Description: Create and manage ticket notifications.
Group:
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- admin
GroupRo: []
IconBig: fa-bell-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Ticket Notifications

Frontend::NavigationModule###AdminPGP

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
Description: Manage PGP keys for email encryption.
Group:
- admin
GroupRo: []
IconBig: fa-user-secret
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: PGP Keys

Frontend::NavigationModule###AdminPackageManager

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Administration
Description: Update and extend your system with software packages.
Group:
- admin
GroupRo: []
IconBig: fa-plug
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Package Manager

Frontend::NavigationModule###AdminPerformanceLog

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Administration
Description: View performance benchmark results.
Group:
- admin
GroupRo: []
IconBig: fa-bar-chart
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Performance Log

Frontend::NavigationModule###AdminPostMasterFilter

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
Description: Filter incoming emails.
Group:
- admin
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GroupRo: []
IconBig: fa-filter
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: PostMaster Filters

Frontend::NavigationModule###AdminPriority

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage ticket priorities.
Group:
- admin
GroupRo: []
IconBig: fa-list-ol
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Priorities

Frontend::NavigationModule###AdminProcessManagement

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Automation
Description: Configure Processes.
Group:
- admin
GroupRo: []
IconBig: fa-sitemap
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Process Management

Frontend::NavigationModule###AdminQueue

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage queues.
Group:
- admin
GroupRo: []
IconBig: fa-folder
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Queues

Frontend::NavigationModule###AdminQueueAutoResponse

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Link queues to auto responses.
Group:
- admin
GroupRo: []
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IconBig: fa-reply
IconSmall: fa-folder
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Queues ↔ Auto Responses

Frontend::NavigationModule###AdminQueueSMSTemplates

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Link SMS templates to queues.
Group:
- admin
GroupRo: []
IconBig: fa-mobile
IconSmall: fa-folder
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: SMS Templates ↔ Queues

Frontend::NavigationModule###AdminQueueTemplates

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Link templates to queues.
Group:
- admin
GroupRo: []
IconBig: fa-file-text-o
IconSmall: fa-folder
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Templates ↔ Queues

Frontend::NavigationModule###AdminRegistration

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: OTRSGroup
Description: Manage system registration.
Group:
- admin
GroupRo: []
IconBig: fa-edit
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: System Registration

Frontend::NavigationModule###AdminRole

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Create and manage roles.
Group:
- admin
GroupRo: []
IconBig: fa-circle-o
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IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Roles

Frontend::NavigationModule###AdminRoleGroup

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Link roles to groups.
Group:
- admin
GroupRo: []
IconBig: fa-circle-o
IconSmall: fa-users
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Roles ↔ Groups

Frontend::NavigationModule###AdminRoleUser

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Link agents to roles.
Group:
- admin
GroupRo: []
IconBig: fa-user
IconSmall: fa-circle-o
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Agents ↔ Roles

Frontend::NavigationModule###AdminSLA

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage Service Level Agreements (SLAs).
Group:
- admin
GroupRo: []
IconBig: fa-ticket
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Service Level Agreements

Frontend::NavigationModule###AdminSMIME

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
Description: Manage S/MIME certificates for email encryption.
Group:
- admin
GroupRo: []
IconBig: fa-user-secret
IconSmall: ''
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Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: S/MIME Certificates

Frontend::NavigationModule###AdminSMSTemplate

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage SMS templates.
Group:
- admin
GroupRo: []
IconBig: fa-mobile
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: SMS Templates

Frontend::NavigationModule###AdminSalutation

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage salutations.
Group:
- admin
GroupRo: []
IconBig: fa-comment-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Salutations

Frontend::NavigationModule###AdminSelectBox

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Administration
Description: Execute SQL statements.
Group:
- admin
GroupRo: []
IconBig: fa-terminal
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: SQL Box

Frontend::NavigationModule###AdminService

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage services.
Group:
- admin
GroupRo: []
IconBig: fa-wrench
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
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Name: Services

Frontend::NavigationModule###AdminServiceCatalogue

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: External
Description: Manage Customer Service Catalogue.
Group:
- admin
GroupRo: []
IconBig: fa-sitemap
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Customer Service Catalogue

Frontend::NavigationModule###AdminSession

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Administration
Description: Manage existing sessions.
Group:
- admin
GroupRo: []
IconBig: fa-clock-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Session Management

Frontend::NavigationModule###AdminSignature

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage signatures.
Group:
- admin
GroupRo: []
IconBig: fa-file-text-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Signatures

Frontend::NavigationModule###AdminState

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage ticket states.
Group:
- admin
GroupRo: []
IconBig: fa-ticket
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: States
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Frontend::NavigationModule###AdminSupportDataCollector

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: OTRSGroup
Description: Manage support data.
Group:
- admin
GroupRo: []
IconBig: fa-search
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Support Data Collector

Frontend::NavigationModule###AdminSystemAddress

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Communication
Description: Set sender email addresses for this system.
Group:
- admin
GroupRo: []
IconBig: fa-at
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Email Addresses

Frontend::NavigationModule###AdminSystemConfiguration

担当者Webインタフェースの管理ナビゲーション

この設定は無効化することはできません。

デフォルト値:

---
Block: Administration
Description: Edit the system configuration settings.
Group:
- admin
GroupRo: []
IconBig: ''
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: System Configuration

Frontend::NavigationModule###AdminSystemMaintenance

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Administration
Description: Schedule a maintenance period.
Group:
- admin
GroupRo: []
IconBig: fa-wrench
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
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Name: System Maintenance

Frontend::NavigationModule###AdminTemplate

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage templates.
Group:
- admin
GroupRo: []
IconBig: fa-file-text-o
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Templates

Frontend::NavigationModule###AdminTemplateAttachment

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Link templates to attachments.
Group:
- admin
GroupRo: []
IconBig: fa-paperclip
IconSmall: fa-file-text-o
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Templates ↔ Attachments

Frontend::NavigationModule###AdminType

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Ticket
Description: Create and manage ticket types.
Group:
- admin
GroupRo: []
IconBig: fa-ticket
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Types

Frontend::NavigationModule###AdminUser

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Create and manage agents.
Group:
- admin
GroupRo: []
IconBig: fa-user
IconSmall: ''
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Agents
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Frontend::NavigationModule###AdminUserGroup

担当者Webインタフェースの管理ナビゲーション

デフォルト値:

---
Block: Users
Description: Link agents to groups.
Group:
- admin
GroupRo: []
IconBig: fa-user
IconSmall: fa-users
Module: Kernel::Output::HTML::NavBar::ModuleAdmin
Name: Agents ↔ Groups

90. Frontend → Admin →
ModuleRegistration → Loader

Loader::Module::Admin###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.css
JavaScript:
- Core.Agent.Admin.js
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js

Loader::Module::AdminACL###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ACL.css
JavaScript:
- Core.Agent.Admin.ACL.js

Loader::Module::AdminAppointmentCalendarManage###002-Calendar

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AppointmentCalendar.Manage.css
- thirdparty/spectrum-1.8.0/spectrum.css
JavaScript:
- thirdparty/clipboardjs-1.7.1/clipboard.min.js
- thirdparty/spectrum-1.8.0/spectrum.js
- Core.Agent.Admin.AppointmentCalendar.Manage.js

Loader::Module::AdminAppointmentNotificationEvent###002-Calendar

担当者Webインタフェースのローダーモジュール登録

デフォルト値:
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---
CSS:
- Core.Agent.Admin.NotificationEvent.css
JavaScript:
- Core.Agent.Admin.NotificationEvent.js

Loader::Module::AdminAttachment###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Attachment.js

Loader::Module::AdminAutoResponse###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.AutoResponse.js

Loader::Module::AdminCloudServiceSMS###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.CloudService.SMS.css
JavaScript:
- Core.Agent.Admin.CloudServiceSMS.js

Loader::Module::AdminCloudServices###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.CloudServices.css

Loader::Module::AdminCommunicationLog###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.CommunicationLog.css
JavaScript:
- Core.Agent.Admin.CommunicationLog.js
- thirdparty/jquery-tablesorter-2.28.14/jquery.tablesorter.js
- Core.UI.Table.Sort.js

Loader::Module::AdminCustomPage###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
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JavaScript:
- Core.Agent.Admin.CustomPage.js
- Core.UI.InputFields.js

Loader::Module::AdminCustomerCompany###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.CustomerCompany.js

Loader::Module::AdminCustomerGroup###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.CustomerGroup.js

Loader::Module::AdminCustomerUser###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.Admin.CustomerUser.js

Loader::Module::AdminCustomerUserCustomer###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.CustomerUserService.js

Loader::Module::AdminCustomerUserGroup###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.CustomerGroup.js

Loader::Module::AdminCustomerUserService###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.CustomerUserService.js

Loader::Module::AdminDynamicField###002-Ticket

担当者Webインタフェースのローダーモジュール登録
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デフォルト値:

---
CSS:
- Core.Agent.Admin.DynamicField.css
JavaScript:
- Core.Agent.Admin.DynamicField.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminDynamicFieldCheckbox###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.DynamicField.js
- Core.Agent.Admin.DynamicFieldCheckbox.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminDynamicFieldContactWithData###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.DynamicField.css
JavaScript:
- Core.Agent.Admin.DynamicField.js
- Core.Agent.Admin.DynamicFieldDropdown.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminDynamicFieldDateTime###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.DynamicField.css
JavaScript:
- Core.Agent.Admin.DynamicField.js
- Core.Agent.Admin.DynamicFieldDateTime.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminDynamicFieldDropdown###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.DynamicField.css
JavaScript:
- Core.Agent.Admin.DynamicField.js
- Core.Agent.Admin.DynamicFieldDropdown.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminDynamicFieldInvalid###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:
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---
CSS:
- Core.Agent.Admin.DynamicField.css
JavaScript:
- Core.Agent.Admin.DynamicField.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminDynamicFieldMultiselect###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.DynamicField.css
JavaScript:
- Core.Agent.Admin.DynamicField.js
- Core.Agent.Admin.DynamicFieldMultiselect.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminDynamicFieldText###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.DynamicField.js
- Core.Agent.Admin.DynamicFieldText.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminExternalHomePage###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ExternalHomePage.css
- thirdparty/spectrum-1.8.0/spectrum.css
JavaScript:
- thirdparty/spectrum-1.8.0/spectrum.js
- Core.UI.InputFields.js
- Core.Agent.Admin.ExternalHomePage.js

Loader::Module::AdminExternalLayout###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ExternalHomePage.css
- Core.Agent.Admin.ExternalLayout.css
- thirdparty/spectrum-1.8.0/spectrum.css
JavaScript:
- thirdparty/spectrum-1.8.0/spectrum.js
- Core.UI.InputFields.js
- Core.Agent.Admin.ExternalLayout.js

Loader::Module::AdminGenericAgent###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:
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---
JavaScript:
- Core.Agent.Admin.GenericAgent.js

Loader::Module::AdminGenericInterfaceDebugger###002-GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceDebugger.js

Loader::Module::AdminGenericInterfaceErrorHandlingDefault###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceErrorHandling.js

Loader::Module::AdminGenericInterfaceErrorHandlingRequestRetry###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceErrorHandling.js
- Core.Agent.Admin.GenericInterfaceErrorHandlingRequestRetry.js

Loader::Module::AdminGenericInterfaceInvokerDefault###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceInvoker.js

Loader::Module::AdminGenericInterfaceInvokerEvent###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
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- Core.Agent.Admin.GenericInterfaceInvokerEvent.js

Loader::Module::AdminGenericInterfaceMappingSimple###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceMapping.js

Loader::Module::AdminGenericInterfaceMappingXSLT###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceMappingXSLT.js

Loader::Module::AdminGenericInterfaceOperationDefault###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceOperation.js

Loader::Module::AdminGenericInterfaceOperationRPC###001-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceOperation.js

Loader::Module::AdminGenericInterfaceTransportHTTPREST###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceTransportHTTPREST.js
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Loader::Module::AdminGenericInterfaceTransportHTTPSOAP###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
- Core.Agent.SortedTree.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceTransportHTTPSOAP.js
- Core.Agent.SortedTree.js

Loader::Module::AdminGenericInterfaceWebservice###002-GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceWebservice.js

Loader::Module::AdminGenericInterfaceWebserviceHistory###002-
GenericInterface

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.GenericInterface.css
JavaScript:
- Core.Agent.Admin.GenericInterfaceWebserviceHistory.js

Loader::Module::AdminGroup###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Group.js

Loader::Module::AdminLog###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Log.js

Loader::Module::AdminMailAccount###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
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JavaScript:
- Core.Agent.Admin.MailAccount.js

Loader::Module::AdminNotificationEvent###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.NotificationEvent.css
JavaScript:
- Core.Agent.Admin.NotificationEvent.js

Loader::Module::AdminPGP###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.PGP.js

Loader::Module::AdminPackageManager###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.PackageManager.css
JavaScript:
- Core.Agent.Admin.PackageManager.js

Loader::Module::AdminPerformanceLog###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.PerformanceLog.css

Loader::Module::AdminPostMasterFilter###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.PostMasterFilter.css
JavaScript:
- Core.Agent.Admin.PostMasterFilter.js

Loader::Module::AdminPriority###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Priority.js
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- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminProcessManagement###002-ProcessManagement

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ProcessManagement.css
- Core.AllocationList.css
JavaScript:
- thirdparty/jsplumb-1.6.4/jsplumb.js
- thirdparty/farahey-0.5/farahey.js
- thirdparty/jsplumb-labelspacer/label-spacer.js
- Core.Agent.Admin.ProcessManagement.js
- Core.Agent.Admin.ProcessManagement.Canvas.js
- Core.UI.AllocationList.js

Loader::Module::AdminProcessManagementActivity###002-
ProcessManagement

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ProcessManagement.css
- Core.AllocationList.css
JavaScript:
- Core.Agent.Admin.ProcessManagement.js
- Core.Agent.Admin.ProcessManagement.ModuleConfiguration.MultiLanguageRichText.js
- Core.UI.AllocationList.js

Loader::Module::AdminProcessManagementActivityDialog###002-
ProcessManagement

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ProcessManagement.css
- Core.AllocationList.css
JavaScript:
- Core.Agent.Admin.ProcessManagement.js
- Core.UI.AllocationList.js

Loader::Module::AdminProcessManagementPath###002-ProcessManagement

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ProcessManagement.css
- Core.AllocationList.css
JavaScript:
- Core.Agent.Admin.ProcessManagement.js
- Core.UI.AllocationList.js

Loader::Module::AdminProcessManagementSequenceFlow###002-
ProcessManagement

担当者Webインタフェースのローダーモジュール登録
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デフォルト値:

---
CSS:
- Core.Agent.Admin.ProcessManagement.css
JavaScript:
- Core.Agent.Admin.ProcessManagement.js

Loader::Module::AdminProcessManagementSequenceFlowAction###002-
ProcessManagement

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ProcessManagement.css
JavaScript:
- Core.Agent.Admin.ProcessManagement.ModuleConfiguration.MultiLanguageRichText.js
- Core.Agent.Admin.ProcessManagement.js

Loader::Module::AdminQueue###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Queue.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminQueueAutoResponse###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.QueueAutoResponse.js

Loader::Module::AdminQueueSMSTemplates###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.QueueSMSTemplates.js

Loader::Module::AdminQueueTemplates###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.QueueTemplates.js

Loader::Module::AdminRegistration###001-Framework

担当者Webインタフェースのローダーモジュール登録
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デフォルト値:

---
CSS:
- Core.Agent.Admin.Registration.css
JavaScript:
- Core.Agent.Admin.Registration.js

Loader::Module::AdminRole###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Role.js

Loader::Module::AdminRoleGroup###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.RoleGroup.js

Loader::Module::AdminRoleUser###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.RoleUser.js

Loader::Module::AdminSLA###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.SLA.js

Loader::Module::AdminSMIME###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.SMIME.js

Loader::Module::AdminSMSTemplate###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.SMSTemplate.js
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Loader::Module::AdminSalutation###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Salutation.js

Loader::Module::AdminSelectBox###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.SelectBox.js

Loader::Module::AdminService###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Service.js

Loader::Module::AdminServiceCatalogue###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.ServiceCatalogue.css

Loader::Module::AdminServiceCatalogueCategories###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.ServiceCatalogue.Categories.js

Loader::Module::AdminServiceCatalogueItems###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.ServiceCatalogue.Items.js

Loader::Module::AdminSession###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
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JavaScript:
- Core.Agent.Admin.Session.js

Loader::Module::AdminSignature###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Signature.js

Loader::Module::AdminState###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.State.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminSupportDataCollector###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.SupportDataCollector.css
JavaScript:
- Core.Agent.Admin.SupportDataCollector.js

Loader::Module::AdminSystemAddress###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.SystemAddress.js

Loader::Module::AdminSystemConfiguration###001-Framework

担当者Webインタフェースのローダーモジュール登録

この設定は無効化することはできません。

デフォルト値:

---
CSS:
- Core.Agent.Admin.SystemConfiguration.css
JavaScript:
- thirdparty/clipboardjs-1.7.1/clipboard.min.js
- Core.SystemConfiguration.js
- Core.SystemConfiguration.Date.js
- Core.SystemConfiguration.DateTime.js
- Core.SystemConfiguration.VacationDays.js
- Core.SystemConfiguration.VacationDaysOneTime.js
- Core.SystemConfiguration.WorkingHours.js
- Core.Form.js
- Core.Agent.Admin.SystemConfiguration.js
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Loader::Module::AdminSystemConfigurationDeployment###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.SystemConfiguration.css
JavaScript:
- thirdparty/clipboardjs-1.7.1/clipboard.min.js
- Core.SystemConfiguration.js
- Core.Agent.Admin.SystemConfiguration.js

Loader::Module::AdminSystemConfigurationGroup###001-Framework

担当者Webインタフェースのローダーモジュール登録

この設定は無効化することはできません。

デフォルト値:

---
CSS:
- Core.Agent.Admin.SystemConfiguration.css
JavaScript:
- thirdparty/clipboardjs-1.7.1/clipboard.min.js
- Core.SystemConfiguration.js
- Core.SystemConfiguration.Date.js
- Core.SystemConfiguration.DateTime.js
- Core.SystemConfiguration.VacationDays.js
- Core.SystemConfiguration.VacationDaysOneTime.js
- Core.SystemConfiguration.WorkingHours.js
- Core.Form.js
- Core.Agent.Admin.SystemConfiguration.js

Loader::Module::AdminSystemConfigurationUser###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Admin.SystemConfiguration.css
JavaScript:
- thirdparty/clipboardjs-1.7.1/clipboard.min.js
- Core.SystemConfiguration.js
- Core.Form.js
- Core.Agent.Admin.SystemConfiguration.js
- Core.Agent.Admin.SystemConfigurationUser.js

Loader::Module::AdminSystemMaintenance###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.SystemMaintenance.js

Loader::Module::AdminTemplate###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
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JavaScript:
- Core.Agent.Admin.Template.js

Loader::Module::AdminTemplateAttachment###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.TemplateAttachment.js

Loader::Module::AdminType###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.Type.js
- Core.Agent.Admin.SysConfig.Entity.js

Loader::Module::AdminUserGroup###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.Admin.UserGroup.js

91. Frontend → Admin →
ModuleRegistration → MainMenu

Frontend::Navigation###Admin###001-Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: a
  Block: ItemArea
  Description: Admin modules overview.
  Group:
  - admin
  GroupRo: []
  Link: Action=Admin
  LinkOption: ''
  Name: Admin
  NavBar: Admin
  Prio: '10000'
  Type: Menu

Frontend::Navigation###AdminACL###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []
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Frontend::Navigation###AdminAppointmentCalendarManage###002-
Calendar

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ItemArea
  Description: Manage different calendars.
  Group:
  - admin
  GroupRo: []
  Link: Action=AdminAppointmentCalendarManage
  LinkOption: ''
  Name: Manage Calendars
  NavBar: Calendar
  Prio: '9000'
  Type: ''

Frontend::Navigation###AdminAppointmentNotificationEvent###002-
Calendar

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminAttachment###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminAutoResponse###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminChatChannel###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminCloudServiceSMS###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。
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デフォルト値:

--- []

Frontend::Navigation###AdminCloudServices###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminCommunicationLog###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminContactWithData###002-Ticket

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ''
  Description: Edit contacts with data.
  Group:
  - admin
  GroupRo: []
  Link: Action=AdminContactWithData
  LinkOption: ''
  Name: Edit contacts with data
  NavBar: Ticket
  Prio: '900'
  Type: ''

Frontend::Navigation###AdminCustomPage###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminCustomerCompany###001-Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ItemArea
  Description: Create and manage customers.
  Group:
  - admin
  - users
  GroupRo: []
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  Link: Action=AdminCustomerCompany;Nav=Agent
  LinkOption: ''
  Name: Customer Administration
  NavBar: Customers
  Prio: '9100'
  Type: ''

Frontend::Navigation###AdminCustomerGroup###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminCustomerUser###001-Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ItemArea
  Description: Create and manage customer users.
  Group:
  - admin
  - users
  GroupRo: []
  Link: Action=AdminCustomerUser;Nav=Agent
  LinkOption: ''
  Name: Customer User Administration
  NavBar: Customers
  Prio: '9000'
  Type: ''

Frontend::Navigation###AdminCustomerUserCustomer###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminCustomerUserGroup###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminCustomerUserService###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []
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Frontend::Navigation###AdminDynamicField###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminEmail###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminExternalHomePage###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminExternalLayout###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminGenericAgent###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminGenericInterfaceDebugger###002-
GenericInterface

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminGenericInterfaceWebservice###002-
GenericInterface

Main menu item registration.
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この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminGroup###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminLog###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminMailAccount###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminNotificationEvent###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminPGP###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminPackageManager###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []
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Frontend::Navigation###AdminPerformanceLog###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminPostMasterFilter###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminPriority###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminProcessManagement###002-
ProcessManagement

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminQueue###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminQueueAutoResponse###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminQueueSMSTemplates###001-Framework

Main menu item registration.
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この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminQueueTemplates###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminRegistration###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminRole###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminRoleGroup###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminRoleUser###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSLA###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []
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Frontend::Navigation###AdminSMIME###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSMSTemplate###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSalutation###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSelectBox###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminService###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminServiceCatalogue###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminServiceCatalogueCategories###001-
Framework

Main menu item registration.
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この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminServiceCatalogueItems###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSession###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSignature###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminState###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSupportDataCollector###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSystemAddress###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []
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Frontend::Navigation###AdminSystemConfiguration###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSystemConfigurationDeployment###001-
Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSystemConfigurationGroup###001-
Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminSystemMaintenance###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminTemplate###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminTemplateAttachment###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminType###002-Ticket

Main menu item registration.
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この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminUser###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AdminUserGroup###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

92. Frontend → Admin → View →
ContactWithData

AdminContactWithData::RunInitialWildcardSearch

Runs an initial wildcard search of the existing contacts with data when accessing the
AdminContactWithData module.

この設定は無効化することはできません。

デフォルト値:

--- '1'

93. Frontend → Admin → View →
CustomPage

Frontend::Admin::AdminCustomPage###RichText

チケット通知の作成と表示確認にリッチテキストを利用します。

デフォルト値:

--- '1'

Frontend::Admin::AdminCustomPage###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:
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--- '320'

Frontend::Admin::AdminCustomPage###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

94. Frontend → Admin → View →
CustomerCompany

AdminCustomerCompany::RunInitialWildcardSearch

Runs an initial wildcard search of the existing customer company when accessing the
AdminCustomerCompany module.

この設定は無効化することはできません。

デフォルト値:

--- '1'

95. Frontend → Admin → View →
CustomerUser

AdminCustomerUser::RunInitialWildcardSearch

AdminCustomerUserモジュールにアクセスした時に、存在する顧客ユーザに関して最初のワ
イルド・カード検索を実行します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

AdminCustomerUser::UseAutoComplete

Controls if the autocomplete field will be used for the customer ID selection in the
AdminCustomerUser interface.

この設定は無効化することはできません。

デフォルト値:

--- 0

96. Frontend → Admin → View →
NotificationEvent

AppointmentNotification::Transport###Email

Defines all the parameters for this notification transport.
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デフォルト値:

---
AgentEnabledByDefault: '1'
Icon: fa fa-envelope
Module: Kernel::System::Calendar::Event::Transport::Email
Name: Email
Prio: '100'

AppointmentNotification::Transport###NotificationView

Defines all the parameters for this notification transport.

デフォルト値:

---
AgentEnabledByDefault: '0'
Icon: fa fa-th-list
Module: Kernel::System::Calendar::Event::Transport::NotificationView
Name: Web View
Prio: '110'

AppointmentNotification::Transport###SMS

Defines all the parameters for this notification transport.

デフォルト値:

---
AgentEnabledByDefault: '0'
Icon: fa fa-mobile
Module: Kernel::System::Calendar::Event::Transport::SMS
Name: SMS (Short Message Service)
Prio: '120'

Frontend::Admin::AdminAppointmentNotificationEvent###EventObjectTypes

Defines the event object types that will be handled via
AdminAppointmentNotificationEvent.

デフォルト値:

---
- Calendar
- Appointment

Frontend::Admin::AdminAppointmentNotificationEvent###RichText

チケット通知の作成と表示確認にリッチテキストを利用します。

デフォルト値:

--- '1'

Frontend::Admin::AdminAppointmentNotificationEvent###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '320'

Frontend::Admin::AdminAppointmentNotificationEvent###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).
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デフォルト値:

--- '620'

Frontend::Admin::AdminNotificationEvent###RichText

チケット通知の作成と表示確認にリッチテキストを利用します。

デフォルト値:

--- '1'

Frontend::Admin::AdminNotificationEvent###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '320'

Frontend::Admin::AdminNotificationEvent###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Notification::CharactersPerLine

Defines the number of character per line used in case an HTML article preview
replacement on TemplateGenerator for EventNotifications.

この設定は無効化することはできません。

デフォルト値:

--- '80'

Notification::Transport###Email

Defines all the parameters for this notification transport.

デフォルト値:

---
AgentEnabledByDefault: '1'
Icon: fa fa-envelope
Module: Kernel::System::Ticket::Event::NotificationEvent::Transport::Email
Name: Email
Prio: '100'

Notification::Transport###NotificationView

Defines all the parameters for this notification transport.

デフォルト値:

---
AgentEnabledByDefault: '0'
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Icon: fa fa-th-list
Module: Kernel::System::Ticket::Event::NotificationEvent::Transport::NotificationView
Name: Web View
Prio: '110'

Notification::Transport###SMS

Defines all the parameters for this notification transport.

デフォルト値:

---
AgentEnabledByDefault: '0'
Icon: fa fa-mobile
Module: Kernel::System::Ticket::Event::NotificationEvent::Transport::SMS
Name: SMS (Short Message Service)
Prio: '120'

97. Frontend → Admin → View →
SelectBox

AdminSelectBox::AllowDatabaseModification

Controls if the admin is allowed to make changes to the database via AdminSelectBox.

この設定は無効化することはできません。

デフォルト値:

--- 0

98. Frontend → Admin → View →
SysConfig

ConfigLevel

管理者の設定レベルの設定です。設定レベルに拠り、いくつかのシステム設定オプションは表
示されなくなります。設定レベルは昇順です：Expert, Advanced, Beginner。設定レベルが高
いほど（Beginnerを最高とします）、ユーザが、システムを二度と使用できなくなるような設
定を誤って行うことが、起こりにくくなります。

この設定は無効化することはできません。

デフォルト値:

--- '100'

99. Frontend → Agent
AgentLoginLogo

The logo shown on top of the login box of the agent interface. The URL to the image
can be a relative URL to the skin image directory, or a full URL to a remote web server.

デフォルト値:

---
StyleHeight: 70px
URL: skins/Agent/default/img/loginlogo_default.png

564



AgentLogo

The logo shown in the header of the agent interface. The URL to the image can be a
relative URL to the skin image directory, or a full URL to a remote web server.

デフォルト値:

---
StyleHeight: 50px
StyleRight: 30px
StyleTop: 20px
StyleWidth: 120px
URL: skins/Agent/default/img/loginlogo_default.png

AgentLogoCustom###default

スキン"デフォルト"時に担当者インターフェイスで表示されるロゴ。詳細は"AgentLogo"を参照
してください。

この設定は標準では有効ではありません。

デフォルト値:

---
StyleHeight: 50px
StyleRight: 30px
StyleTop: 20px
StyleWidth: 120px
URL: skins/Agent/default/img/loginlogo_default.png

AgentLogoCustom###highcontrast

The logo shown in the header of the agent interface for the skin "High Contrast". See
"AgentLogo" for further description.

デフォルト値:

---
StyleHeight: 50px
StyleRight: 25px
StyleTop: 20px
StyleWidth: 50px
URL: skins/Agent/highcontrast/img/otrs-signet-white.png

AgentLogoCustom###slim

スキン"slim"時に担当者インターフェイスで表示されるロゴ。詳細は"AgentLogo"を参照してく
ださい。

デフォルト値:

---
StyleHeight: 30px
StyleRight: 15px
StyleTop: 13px
StyleWidth: 30px
URL: skins/Agent/default/img/otrs-signet.png

AutoComplete::Agent###CustomerSearch

Defines the config options for the autocompletion feature.

デフォルト値:

---
AutoCompleteActive: '1'
ButtonText: Search Customer
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MaxResultsDisplayed: '20'
MinQueryLength: '2'
QueryDelay: '100'

AutoComplete::Agent###Default

Defines the config options for the autocompletion feature.

デフォルト値:

---
AutoCompleteActive: '1'
ButtonText: Search
MaxResultsDisplayed: '20'
MinQueryLength: '2'
QueryDelay: '100'

AutoComplete::Agent###DynamicFieldContactWithData

Defines the config options for the autocompletion feature.

この設定は無効化することはできません。

デフォルト値:

---
AutoCompleteActive: '1'
ButtonText: Search
MaxResultsDisplayed: '20'
MinQueryLength: '2'
QueryDelay: '100'

AutoComplete::Agent###UserSearch

Defines the config options for the autocompletion feature.

デフォルト値:

---
AutoCompleteActive: '1'
ButtonText: Search User
MaxResultsDisplayed: '20'
MinQueryLength: '2'
QueryDelay: '100'

CustomerDBLink

Defines an external link to the database of the customer (e.g. 'http://yourhost/
customer.php?CID=[% Data.CustomerID %]' or '').

この設定は無効化することはできません。

デフォルト値:

--- '[% Env("CGIHandle") %]?Action=AgentCustomerInformationCenter;CustomerID=[%
 Data.CustomerID
  | uri %]'

CustomerDBLinkClass

システム識別子を定義します。すべてのチケット番号とHTTPセッションの文字列は、このID
が含まれています。これはをシステムに属している唯一のチケットがフォローアップとして処
理されることを確実にします。（2つのOTRSのインスタンス間で通信する場合に便利です）

この設定は無効化することはできません。

デフォルト値:

566



--- ''

CustomerDBLinkTarget

外部顧客データベースへのリンクにおける、ターゲット属性を定義します。例：'target="cdb"'

この設定は無効化することはできません。

デフォルト値:

--- ''

DefaultOverviewColumns

General ticket data shown in the ticket overviews (fall-back). Note that TicketNumber
can not be disabled, because it is necessary.

この設定は無効化することはできません。

デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '1'
EscalationUpdateTime: '1'
Lock: '2'
Owner: '2'
PendingTime: '1'
Priority: '1'
Queue: '2'
Responsible: '1'
SLA: '1'
Sender: '2'
Service: '1'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
Type: '1'

Frontend::AvatarEngine

Define which avatar engine should be used for the agent avatar on the header
and the sender images in AgentTicketZoom. If 'None' is selected, initials will be
displayed instead. Please note that selecting anything other than 'None' will transfer
the encrypted email address of the particular user to an external service.

この設定は無効化することはできません。

デフォルト値:

--- Gravatar

Frontend::CommonParam###Action

担当者インタフェースにおいてURLにActionパラメータが与えられない場合、デフォルトで使
用されるFrontend-Moduleを定義します。

この設定は無効化することはできません。
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デフォルト値:

--- AgentDashboard

Frontend::CommonParam###QueueID

担当者インタフェースにおいて、システムによって使用されるデフォルトのキューIDです。

この設定は無効化することはできません。

デフォルト値:

--- 0

Frontend::CommonParam###TicketID

担当者インタフェースにおいて、システムによって使用されるデフォルトのチケットIDです。

この設定は無効化することはできません。

デフォルト値:

--- ''

Frontend::CustomerUser::Item###1-GoogleMaps

顧客情報ブロックの最後において、Googleマップのアイコンを作成するための顧客アイテムを
定義します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

---
Attributes: UserStreet;UserCity;UserCountry;
CSS: Core.Agent.CustomerUser.GoogleMaps.css
CSSClass: GoogleMaps
IconName: fa-globe
Module: Kernel::Output::HTML::CustomerUser::Generic
Required: UserStreet;UserCity;
Target: _blank
Text: Location
URL: http://maps.google.com/maps?z=7&q=

Frontend::CustomerUser::Item###15-OpenTickets

Customer item (icon) which shows the open tickets of this customer as info block.
Setting CustomerUserLogin to 1 searches for tickets based on login name rather than
CustomerID.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

---
Action: AgentTicketSearch
Attributes: StateType=Open;
CSS: Core.Agent.CustomerUser.OpenTicket.css
CSSClassNoOpenTicket: NoOpenTicket
CSSClassOpenTicket: OpenTicket
CustomerUserLogin: '0'
IconNameNoOpenTicket: fa-check-circle
IconNameOpenTicket: fa-exclamation-circle
Module: Kernel::Output::HTML::CustomerUser::GenericTicket
Subaction: Search
Target: _blank
Text: Open tickets (customer)
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Frontend::CustomerUser::Item###16-OpenTicketsForCustomerUserLogin

Customer item (icon) which shows the open tickets of this customer as info block.
Setting CustomerUserLogin to 1 searches for tickets based on login name rather than
CustomerID.

この設定は標準では有効ではありません。

デフォルト値:

---
Action: AgentTicketSearch
Attributes: StateType=Open;
CSS: Core.Agent.CustomerUser.OpenTicket.css
CSSClassNoOpenTicket: NoOpenTicket
CSSClassOpenTicket: OpenTicket
CustomerUserLogin: '1'
IconNameNoOpenTicket: fa-check-circle
IconNameOpenTicket: fa-exclamation-circle
Module: Kernel::Output::HTML::CustomerUser::GenericTicket
Subaction: Search
Target: _blank
Text: Open tickets (customer user)

Frontend::CustomerUser::Item###17-ClosedTickets

Customer item (icon) which shows the closed tickets of this customer as info block.
Setting CustomerUserLogin to 1 searches for tickets based on login name rather than
CustomerID.

この設定は標準では有効ではありません。

デフォルト値:

---
Action: AgentTicketSearch
Attributes: StateType=Closed;
CSS: Core.Agent.CustomerUser.OpenTicket.css
CSSClassNoOpenTicket: NoOpenTicket
CSSClassOpenTicket: OpenTicket
CustomerUserLogin: '0'
IconNameNoOpenTicket: fa-power-off
IconNameOpenTicket: fa-power-off
Module: Kernel::Output::HTML::CustomerUser::GenericTicket
Subaction: Search
Target: _blank
Text: Closed tickets (customer)

Frontend::CustomerUser::Item###18-ClosedTicketsForCustomerUserLogin

Customer item (icon) which shows the closed tickets of this customer as info block.
Setting CustomerUserLogin to 1 searches for tickets based on login name rather than
CustomerID.

この設定は標準では有効ではありません。

デフォルト値:

---
Action: AgentTicketSearch
Attributes: StateType=Closed;
CSS: Core.Agent.CustomerUser.OpenTicket.css
CSSClassNoOpenTicket: NoOpenTicket
CSSClassOpenTicket: OpenTicket
CustomerUserLogin: '1'
IconNameNoOpenTicket: fa-power-off
IconNameOpenTicket: fa-power-off
Module: Kernel::Output::HTML::CustomerUser::GenericTicket
Subaction: Search
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Target: _blank
Text: Closed tickets (customer user)

Frontend::CustomerUser::Item###2-Google

顧客情報ブロックの最後において、Googleマップのアイコンを作成するための顧客アイテムを
定義します。

この設定は標準では有効ではありません。

デフォルト値:

---
Attributes: UserFirstname;UserLastname;
CSS: Core.Agent.CustomerUser.Google.css
CSSClass: Google
IconName: fa-google
Module: Kernel::Output::HTML::CustomerUser::Generic
Required: UserFirstname;UserLastname;
Target: _blank
Text: Google
URL: http://google.com/search?q=

Frontend::CustomerUser::Item###2-LinkedIn

顧客情報ブロックの最後において、LinkedInアイコンを作成するための顧客アイテムを定義し
ます。

この設定は標準では有効ではありません。

デフォルト値:

---
Attributes: UserFirstname;UserLastname;
CSS: Core.Agent.CustomerUser.LinkedIn.css
CSSClass: LinkedIn
IconName: fa-linkedin
Module: Kernel::Output::HTML::CustomerUser::Generic
Required: UserFirstname;UserLastname;
Target: _blank
Text: LinkedIn
URL: http://www.linkedin.com/commonSearch?type=people&keywords=

Frontend::CustomerUser::Item###3-XING

顧客情報ブロックの最後において、XINGアイコンを作成するための顧客アイテムを定義しま
す。

この設定は標準では有効ではありません。

デフォルト値:

---
Attributes: UserFirstname;UserLastname;
CSS: Core.Agent.CustomerUser.Xing.css
CSSClass: Xing
IconName: fa-xing
Module: Kernel::Output::HTML::CustomerUser::Generic
Required: UserFirstname;UserLastname;
Target: _blank
Text: XING
URL: https://www.xing.com/app/search?op=search;keywords=

Frontend::Gravatar::ArticleDefaultImage

Define which avatar default image should be used for the article view if no gravatar is
assigned to the mail address. Check http://gravatar.com/site/implement/images/ for
further information.
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この設定は無効化することはできません。

デフォルト値:

--- mm

Frontend::Gravatar::DefaultImage

Define which avatar default image should be used for the current agent if no
gravatar is assigned to the mail address of the agent. Check http://gravatar.com/site/
implement/images/ for further information.

この設定は無効化することはできません。

デフォルト値:

--- mm

Frontend::HeaderMetaModule###100-Refresh

Defines the module to generate code for periodic page reloads.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::HeaderMeta::Refresh

Frontend::HeaderMetaModule###2-TicketSearch

担当者インタフェースにおいて、ショート・チケット検索のためのhtml OpenSearchプロ
フィールを生成するモジュールです。

デフォルト値:

---
Action: AgentTicketSearch
Module: Kernel::Output::HTML::HeaderMeta::AgentTicketSearch

Frontend::HeaderMetaModule###3-FAQSearch

Module to generate html OpenSearch profile for short FAQ search.

デフォルト値:

---
Action: AgentFAQSearch
Module: Kernel::Output::HTML::HeaderMeta::AgentFAQSearch

InfoFile

File that is displayed in the Kernel::Modules::AgentInfo module, if located under Kernel/
Output/HTML/Templates/Standard/AgentInfo.tt.

この設定は無効化することはできません。

デフォルト値:

--- AgentInfo

InfoKey

Kernel::Modules::AgentInfoモジュールによってチェックされるキーを定義します。もし、こ
のユーザ・プレファレンス・キーがtrueである場合、メッセージはシステムにより受諾されま
す。
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この設定は無効化することはできません。

デフォルト値:

--- wpt22

LoginURL

Defines an alternate login URL for the agent interface.

この設定は標準では有効ではありません。

デフォルト値:

--- http://host.example.com/login.html

LogoutURL

Defines an alternate logout URL for the agent interface.

この設定は標準では有効ではありません。

デフォルト値:

--- http://host.example.com/thanks-for-using-otrs.html

LostPassword

担当者インタフェースにおいて、パスワード忘れ機能を有効にします。

この設定は無効化することはできません。

デフォルト値:

--- '1'

ModernizeFormFields

Use new type of select and autocomplete fields in agent interface, where applicable
(InputFields).

この設定は無効化することはできません。

デフォルト値:

--- '1'

NewTicketInNewWindow::Enabled

有効にされた場合、TicketPhoneおよびTicketEmailは新しいウィンドウで開きます。

この設定は無効化することはできません。

デフォルト値:

--- 0

NoTimelineViewAutoArticle

Disables automatic opening of the last customer article in the timeline view in
AgentTicketZoom.

この設定は無効化することはできません。

デフォルト値:
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--- 0

NotificationBodyLostPassword

Defines the body text for notification mails sent to agents, about new password.

この設定は無効化することはできません。

デフォルト値:

--- "Hi <OTRS_USERFIRSTNAME>,\n\n\nHere's your new OTRS password.\n\nNew password:
  <OTRS_NEWPW>\n\nYou can log in via the following URL:\n\n<OTRS_CONFIG_HttpType>://
<OTRS_CONFIG_FQDN>/<OTRS_CONFIG_ScriptAlias>index.pl\n
  \           "

NotificationBodyLostPasswordToken

Defines the body text for notification mails sent to agents, with token about new
requested password.

この設定は無効化することはできません。

デフォルト値:

--- "Hi <OTRS_USERFIRSTNAME>,\n\nYou or someone impersonating you has requested to
  change your OTRS\npassword.\n\nIf you want to do this, click on the link below.
  You will receive another email containing the password.\n
\n<OTRS_CONFIG_HttpType>://<OTRS_CONFIG_FQDN>/<OTRS_CONFIG_ScriptAlias>index.pl?
Action=LostPassword;Token=<OTRS_TOKEN>\n\nIf
  you did not request a new password, please ignore this email.\n            "

NotificationSubjectLostPassword

新しいパスワードに関して、担当者に送信される通知メールの件名を定義します。

この設定は無効化することはできません。

デフォルト値:

--- New OTRS password

NotificationSubjectLostPasswordToken

新規にリクエストされたパスワードに関するトークンと共に、担当者に送信される通知メール
の件名を定義します。

この設定は無効化することはできません。

デフォルト値:

--- New OTRS password request

OpenMainMenuOnHover

有効にした場合、メイン・メニューの1つめのレベルのものが、マウスを乗せるだけで開きま
す（1回クリックの代わりに）。

この設定は無効化することはできません。

デフォルト値:

--- 0

PossibleNextActions

Defines the list of possible next actions on an error screen, a full path is required, then
is possible to add external links if needed.
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デフォルト値:

---
'[% Env(''CGIHandle'') %]?Action=AgentDashboard': Go to dashboard!

PreApplicationModule###AgentInfo

特定のユーザ・オプションをロードしたり、ニュースを表示したりするための、役に立つモ
ジュールを定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- Kernel::Modules::AgentInfo

ShowMotd

担当者インタフェースのログイン画面において、その日のメッセージを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AccountTime

タイム・アカウンティングを有効にします。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::BulkAccountedTime

タイム・アカウンティングがバルク・アクションにおける全てのチケットに対して、必ず設定
されるかどうかを定義します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::CustomerInfoCompose

構成画面において、顧客ユーザ情報（電話およびEメール）を表示します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::CustomerInfoComposeMaxSize

Max size (in characters) of the customer information table (phone and email) in the
compose screen.

この設定は無効化することはできません。

デフォルト値:

--- '22'
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Ticket::Frontend::CustomerInfoZoomMaxSize

チケットズームビューにおける、顧客情報テーブルの最大サイズ (文字) です。

この設定は無効化することはできません。

デフォルト値:

--- '22'

Ticket::Frontend::DynamicFieldsZoomMaxSizeArticle

Maximum length (in characters) of the dynamic field in the article of the ticket zoom
view.

この設定は無効化することはできません。

デフォルト値:

--- '160'

Ticket::Frontend::DynamicFieldsZoomMaxSizeSidebar

Maximum length (in characters) of the dynamic field in the sidebar of the ticket zoom
view.

この設定は無効化することはできません。

デフォルト値:

--- '18'

Ticket::Frontend::InformAgentMaxSize

Max size (in rows) of the informed agents box in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- '3'

Ticket::Frontend::InvolvedAgentMaxSize

Max size (in rows) of the involved agents box in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- '3'

Ticket::Frontend::ListType

システム内に存在する親/子キューのリストを、ツリーまたはリストの形式で表示します。

この設定は無効化することはできません。

デフォルト値:

--- tree

Ticket::Frontend::MaxQueueLevel

Define the max depth of queues.

この設定は無効化することはできません。
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デフォルト値:

--- '5'

Ticket::Frontend::NeedAccountedTime

Defines if time accounting is mandatory in the agent interface. If enabled, a note must
be entered for all ticket actions (no matter if the note itself is configured as active or
is originally mandatory for the individual ticket action screen).

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::NewOwnerSelection

担当者インタフェースにおいて、電話およびEメールのチケットにおける所有者のセレクショ
ンを表示します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::NewQueueOwnSelection

Determines which options will be valid of the recipient (phone ticket) and the sender
(email ticket) in the agent interface.

この設定は標準では有効ではありません。

デフォルト値:

---
'1': First Queue
'2': Second Queue

Ticket::Frontend::NewQueueSelectionString

Determines the strings that will be shown as recipient (To:) of the phone ticket
and as sender (From:) of the email ticket in the agent interface. For Queue
as NewQueueSelectionType "<Queue>" shows the names of the queues and for
SystemAddress "<Realname> <<Email>>" shows the name and email of the
recipient.

この設定は無効化することはできません。

デフォルト値:

--- <Queue>

Ticket::Frontend::NewQueueSelectionType

Defines the recipient target of the phone ticket and the sender of the email ticket
("Queue" shows all queues, "System address" displays all system addresses) in the
agent interface.

この設定は無効化することはできません。

デフォルト値:

--- Queue
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Ticket::Frontend::NewResponsibleSelection

担当者インタフェースにおいて、電話およびEメールのチケットにおける責任者のセレクショ
ンを表示します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::PendingDiffTime

保留中のステートを設定した場合、実際の時間に加えられる時間（秒）です。(default:
86400 = 1 day)

この設定は無効化することはできません。

デフォルト値:

--- '86400'

Ticket::Frontend::RedirectAfterCloseDisabled

Disables the redirection to the last screen overview / dashboard after a ticket is closed.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::ShowCustomerTickets

AgentTicketPhone、AgentTicketEmail、AgentTicketCustomerにおいて、顧客履歴チケットを表
示します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::TextAreaEmail

Eメール・ウィンドウを構成するために許容される幅です。

この設定は無効化することはできません。

デフォルト値:

--- '82'

Ticket::Frontend::TextAreaNote

メモ・ウィンドウを構成するために許容される幅です。

この設定は無効化することはできません。

デフォルト値:

--- '78'

Ticket::Frontend::TimeUnits

優先される時間の単位（例：作業時間、時間、分）を設定します。
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この設定は無効化することはできません。

デフォルト値:

--- ' (work units)'

Ticket::Frontend::UserDefaultQueue

Defines the default queue for new tickets in the agent interface.

この設定は標準では有効ではありません。

デフォルト値:

--- Postmaster

100. Frontend → Agent →
ArticleComposeModule

Ticket::Frontend::ArticleComposeModule###1-EmailSecurity

利用する電子メールのセキュリティオプションを定義するモジュールです（PGPとS/MIMEを選
択可能）

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleCompose::Security
ParamType: Single

Ticket::Frontend::ArticleComposeModule###2-SignEmail

署名されたメッセージを構成するモジュールです（PGP または S/MIME)。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleCompose::Sign
ParamType: Single

Ticket::Frontend::ArticleComposeModule###3-CryptEmail

Module to encrypt composed messages (PGP or S/MIME).

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleCompose::Crypt
ParamType: Multiple

101. Frontend → Agent →
FAQJournalOverview

FAQ::Frontend::JournalOverview###Small

簡易版FAQジャーナル表示用モジュールの概要を定義
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デフォルト値:

---
Module: Kernel::Output::HTML::FAQJournalOverview::Small
Name: Small
NameShort: S

102. Frontend → Agent →
FAQOverview

FAQ::Frontend::Overview###Small

簡易版FAQ一覧表示用モジュールの概要を定義

デフォルト値:

---
Module: Kernel::Output::HTML::FAQOverview::Small
Name: Small
NameShort: S

FAQ::Frontend::OverviewSmall###DynamicField

Dynamic fields shown in the FAQ small format overview screen of the agent interface.

デフォルト値:

--- {}

103. Frontend → Agent →
FAQRelatedArticles

FAQ::Frontend::AgentFAQRelatedArticles###DefaultLanguages

The default languages for the related FAQ articles.

デフォルト値:

---
- en

FAQ::Frontend::AgentFAQRelatedArticles###Position

Defines the position where the related FAQ articles widget is located.

この設定は無効化することはできません。

デフォルト値:

--- '1'

FAQ::Frontend::AgentFAQRelatedArticles###QueuesEnabled

List of queue names for which the related article feature is enabled.

この設定は標準では有効ではありません。

デフォルト値:

---
- Raw
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FAQ::Frontend::AgentFAQRelatedArticles###ShowLimit

Output limit for the related FAQ articles.

この設定は無効化することはできません。

デフォルト値:

--- '10'

104. Frontend → Agent →
FrontendNotification

Frontend::NotifyModule###1000-CloudServicesDisabled

Defines the module to display a notification if cloud services are disabled.

この設定は無効化することはできません。

デフォルト値:

---
Group: admin
Module: Kernel::Output::HTML::Notification::AgentCloudServicesDisabled

Frontend::NotifyModule###1100-SystemContract

Defines the module to display a notification in different interfaces on different
occasions for System Contract.

この設定は無効化することはできません。

デフォルト値:

---
Group: admin
Module: Kernel::Output::HTML::Notification::AgentSystemContract

Frontend::NotifyModule###2000-UID-Check

もし、システムがアドミン・ユーザによって使用されている場合、担当者インタフェースにお
いて通知を表示させるモジュールを定義します（通常はアドミンとして行動する必要はありま
せん）。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::UIDCheck

Frontend::NotifyModule###2500-AgentSessionLimit

Defines the module to display a notification in the agent interface, if the agent session
limit prior warning is reached.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::AgentSessionLimit
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Frontend::NotifyModule###3000-ShowAgentOnline

担当者インタフェースにおいて、現在ログインしている全ユーザを表示させるモジュールを定
義します。

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::AgentOnline
ShowEmail: '1'

Frontend::NotifyModule###4000-ShowCustomerOnline

Defines the module that shows all the currently logged in customers in the agent
interface.

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::CustomerOnline
ShowEmail: '1'

Frontend::NotifyModule###5000-SystemConfigurationIsDirty-Check

Defines the module to display a notification in the agent interface, if there are modified
sysconfig settings that are not deployed yet.

この設定は無効化することはできません。

デフォルト値:

---
Group: admin
Module: Kernel::Output::HTML::Notification::SystemConfigurationIsDirtyCheck

Frontend::NotifyModule###5000-Ticket::TicketEscalation

通知とエスカレーションを表示するためのモジュールです(ShownMax: 最大、表示されたエス
カレーション、EscalationInMinutes: エスカレートされるチケットを表示、CacheTime: 計算さ
れたエスカレーションのキャッシュ秒数)。

この設定は標準では有効ではありません。

デフォルト値:

---
CacheTime: '40'
EscalationInMinutes: '120'
Module: Kernel::Output::HTML::Notification::AgentTicketEscalation
ShownMax: '25'

Frontend::NotifyModule###513-ChatAvailability-Check

Defines the module to display a notification in the agent interface, if the agent is not
available for chat with customers (only if Ticket::Agent::AvailableForChatsAfterLogin
is set to No).

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::ChatAvailabilityCheck
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Frontend::NotifyModule###5200-SystemConfigurationInvalid-Check

Defines the module to display a notification in the agent interface, if there are invalid
sysconfig settings deployed.

この設定は無効化することはできません。

デフォルト値:

---
Group: admin
Module: Kernel::Output::HTML::Notification::SystemConfigurationInvalidCheck

Frontend::NotifyModule###523-ChatPreferredChannels-Check

Defines the module to display a notification in the agent interface, if the agent is
available for external chats, but forgot to set preferred channel(s).

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::ChatPreferredChannelsCheck

Frontend::NotifyModule###5500-OutofOffice-Check

Defines the module to display a notification in the agent interface, if the agent is
logged in while having out-of-office active.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::OutofOfficeCheck

Frontend::NotifyModule###6000-SystemMaintenance-Check

Defines the module to display a notification in the agent interface, if the agent is
logged in while having system maintenance active.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::SystemMaintenanceCheck

Frontend::NotifyModule###6050-SystemConfiguration-OutOfSync-Check

Defines the module to display a notification in the agent interface if the system
configuration is out of sync.

この設定は無効化することはできません。

デフォルト値:

---
AllowedDelayMinutes: '5'
Module: Kernel::Output::HTML::Notification::SystemConfigurationOutOfSyncCheck

Frontend::NotifyModule###7000-AgentTimeZone-Check

Defines the module to display a notification in the agent interface, if the agent has
not yet selected a time zone.
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この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::AgentTimeZoneCheck

Frontend::NotifyModule###8000-Daemon-Check

Defines the module to display a notification in the agent interface if the OTRS Daemon
is not running.

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::DaemonCheck

Frontend::NotifyModule###8000-PackageManager-CheckNotVerifiedPackages

Defines the module to display a notification in the agent interface, if the installation
of not verified packages is activated (only shown to admins).

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::Notification::PackageManagerCheckNotVerifiedPackages

Frontend::NotifyModule###9000-Generic

Defines the module that shows a generic notification in the agent interface. Either
"Text" - if configured - or the contents of "File" will be displayed. Use "Priority" key
to style the notification. If "Link" key is supplied, notification text will be wrapped in
an anchor leading to specified address. You can use "Target" key to define a target
attribute of the defined link.

この設定は標準では有効ではありません。

デフォルト値:

---
File: <OTRS_CONFIG_Home>/var/notify.txt
Link: https://www.otrs.com
Module: Kernel::Output::HTML::Notification::Generic
Priority: Warning
Target: _blank
Text: The OTRS Website

105. Frontend → Agent → LinkObject
LinkObject::ComplexTable###Appointment

Define which columns are shown in the linked appointment widget
(LinkObject::ViewMode = "complex"). Possible settings: 0 = Disabled, 1 = Available,
2 = Enabled by default.

デフォルト値:

---
DefaultColumns:
  CalendarName: '1'
  Changed: '1'
  Created: '1'
  Description: '2'
  EndTime: '2'
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  Location: '1'
  NotificationTime: '1'
  StartTime: '2'
Module: Kernel::Output::HTML::LinkObject::Appointment.pm
Priority:
  CalendarName: '100'
  Changed: '160'
  Created: '170'
  Description: '110'
  EndTime: '130'
  Location: '140'
  NotificationTime: '150'
  StartTime: '120'

LinkObject::ComplexTable###FAQ

Define which columns are shown in the linked FAQs widget (LinkObject::ViewMode
= "complex"). Note: Only FAQ attributes and Dynamic Fields (DynamicField_NameX)
are allowed for DefaultColumns. Possible settings: 0 = Disabled, 1 = Available, 2 =
Enabled by default.

デフォルト値:

---
DefaultColumns:
  Approved: '1'
  CategoryName: '1'
  Changed: '1'
  ContentType: '1'
  Created: '2'
  FAQNumber: '2'
  Language: '1'
  State: '2'
  Title: '2'
Module: Kernel::Output::HTML::LinkObject::FAQ.pm
Priority:
  Approved: '160'
  CategoryName: '140'
  Changed: '180'
  ContentType: '170'
  Created: '130'
  FAQNumber: '100'
  Language: '150'
  State: '120'
  Title: '110'

LinkObject::ComplexTable###Ticket

Define which columns are shown in the linked tickets widget (LinkObject::ViewMode =
"complex"). Note: Only Ticket attributes and Dynamic Fields (DynamicField_NameX)
are allowed for DefaultColumns.

デフォルト値:

---
DefaultColumns:
  Age: '1'
  Changed: '1'
  Created: '2'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
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  Priority: '1'
  Queue: '2'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '2'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Module: Kernel::Output::HTML::LinkObject::Ticket.pm
Priority:
  Age: '110'
  Changed: '120'
  Created: '310'
  CustomerCompanyName: '320'
  CustomerID: '240'
  CustomerName: '250'
  CustomerUserID: '260'
  EscalationResponseTime: '160'
  EscalationSolutionTime: '150'
  EscalationTime: '140'
  EscalationUpdateTime: '170'
  Lock: '200'
  Owner: '220'
  PendingTime: '130'
  Priority: '300'
  Queue: '210'
  Responsible: '230'
  SLA: '290'
  Service: '280'
  State: '190'
  TicketNumber: '100'
  Title: '180'
  Type: '270'

LinkObject::ComplexTable::SettingsVisibility###Appointment

Define Actions where a settings button is available in the linked objects
widget (LinkObject::ViewMode = "complex"). Please note that these Actions
must have registered the following JS and CSS files: Core.AllocationList.css,
Core.UI.AllocationList.js, Core.UI.Table.Sort.js, Core.Agent.TableFilters.js.

デフォルト値:

---
- AgentTicketZoom

LinkObject::ComplexTable::SettingsVisibility###FAQ

リンクオブジェクトウィジェット（LinkObject :: ViewMode = "complex"）で設定ボタンを使
用できるアクションを定義します。 これらのアクションは、次のJSおよびCSSファイルを登録
している必要がありま
す。Core.AllocationList.css、Core.UI.AllocationList.js、Core.UI.Table.Sort.js、Core.Agent.TableFilters.js、
及びCore.Agent .LinkObject.js

デフォルト値:

---
- AgentFAQZoom

LinkObject::ComplexTable::SettingsVisibility###Ticket

Define Actions where a settings button is available in the linked objects
widget (LinkObject::ViewMode = "complex"). Please note that these Actions
must have registered the following JS and CSS files: Core.AllocationList.css,
Core.UI.AllocationList.js, Core.UI.Table.Sort.js, Core.Agent.TableFilters.js.

デフォルト値:
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---
- AgentTicketZoom

106. Frontend → Agent → MIMEViewer
MIME-Viewer###application/excel

ウェブ・インタフェースにて、Microsoft Excelファイルを見られるようにするコンバータへの
パスを特定します。

この設定は標準では有効ではありません。

デフォルト値:

--- xlhtml

MIME-Viewer###application/msword

ウェブ・インタフェースにて、Microsoft Wordファイルを見られるようにするコンバータへの
パスを特定します。

この設定は標準では有効ではありません。

デフォルト値:

--- wvWare

MIME-Viewer###application/pdf

ウェブ・インタフェースにて、PDFドキュメントを見られるようにするコンバータへのパスを
特定します。

この設定は標準では有効ではありません。

デフォルト値:

--- pdftohtml -stdout -i

MIME-Viewer###text/xml

ウェブ・インタフェースにて、XMLファイルを見られるようにするコンバータへのパスを特定
します。

この設定は標準では有効ではありません。

デフォルト値:

--- <OTRS_CONFIG_Home>/scripts/tools/xml2html.pl

107. Frontend → Agent →
ModuleRegistration

Frontend::Module###AdminAppointmentImport

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Import appointments screen.
Group:
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- admin
GroupRo: []
NavBarName: ''
Title: Import Appointments

Frontend::Module###AgentAppointmentAgendaOverview

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Overview of all appointments.
Group: []
GroupRo: []
NavBarName: Calendar
Title: Agenda Overview

Frontend::Module###AgentAppointmentCalendarOverview

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Appointment Calendar overview page.
Group: []
GroupRo: []
NavBarName: Calendar
Title: Overview

Frontend::Module###AgentAppointmentEdit

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Appointment edit screen.
Group: []
GroupRo: []
NavBarName: ''
Title: Edit appointment

Frontend::Module###AgentAppointmentList

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Appointment list.
Group: []
GroupRo: []
NavBarName: ''
Title: Appointment list

Frontend::Module###AgentAppointmentPluginSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Plugin search module for autocomplete.
Group: []
GroupRo: []
NavBarName: ''
Title: Plugin search
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Frontend::Module###AgentChat

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent chat screen.
Group: []
GroupRo: []
NavBarName: Chat
Title: Chat

Frontend::Module###AgentChatAppend

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Append Chat to Ticket.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Append Chat to Ticket

Frontend::Module###AgentChatAvailability

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Chat availability.
Group: []
GroupRo: []
NavBarName: ''
Title: Chat Availability

Frontend::Module###AgentChatDownload

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Chat download.
Group: []
GroupRo: []
NavBarName: ''
Title: Chat Download

Frontend::Module###AgentChatPopup

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Chat popup.
Group: []
GroupRo: []
NavBarName: ''
Title: Chat Popup

Frontend::Module###AgentChatPreview

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: Chat preview.
Group: []
GroupRo: []
NavBarName: ''
Title: Chat Preview

Frontend::Module###AgentContactWithDataSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent contact with data search.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Agent Contact With Data Search

Frontend::Module###AgentCustomerInformationCenter

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Customer Information Center.
Group: []
GroupRo: []
NavBarName: Customers
Title: ''

Frontend::Module###AgentCustomerInformationCenterSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Customer Information Center Search.
Group: []
GroupRo: []
NavBarName: ''
Title: ''

Frontend::Module###AgentCustomerSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent Customer Search.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Agent Customer Search

Frontend::Module###AgentCustomerSearchSMS

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
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Description: Agent Customer Search SMS.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Agent Customer Search SMS

Frontend::Module###AgentCustomerUserAddressBook

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Search customer user.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Search Customer User

Frontend::Module###AgentCustomerUserInformationCenter

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Customer User Information Center.
Group: []
GroupRo: []
NavBarName: Customer Users
Title: ''

Frontend::Module###AgentCustomerUserInformationCenterSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Customer User Information Center Search.
Group: []
GroupRo: []
NavBarName: ''
Title: ''

Frontend::Module###AgentDashboard

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent dashboard.
Group: []
GroupRo: []
NavBarName: Dashboard
Title: Agent Dashboard

Frontend::Module###AgentDocumentSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Document Search
Group: []
GroupRo: []
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NavBarName: Document Search
Title: ''

Frontend::Module###AgentFAQAdd

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Area.
Group: []
GroupRo: []
NavBarName: FAQ
Title: FAQ

Frontend::Module###AgentFAQCategory

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Area.
Group:
- admin
GroupRo: []
NavBarName: FAQ
Title: FAQ

Frontend::Module###AgentFAQDelete

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Delete.
Group: []
GroupRo: []
NavBarName: FAQ
Title: Delete

Frontend::Module###AgentFAQEdit

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Edit.
Group: []
GroupRo: []
NavBarName: FAQ
Title: Edit

Frontend::Module###AgentFAQExplorer

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Area.
Group: []
GroupRo: []
NavBarName: FAQ
Title: FAQ
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Frontend::Module###AgentFAQHistory

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ History.
Group: []
GroupRo: []
NavBarName: FAQ
Title: History

Frontend::Module###AgentFAQJournal

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Area.
Group: []
GroupRo: []
NavBarName: FAQ
Title: FAQ

Frontend::Module###AgentFAQLanguage

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Area.
Group:
- admin
GroupRo: []
NavBarName: FAQ
Title: FAQ

Frontend::Module###AgentFAQPrint

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Print.
Group: []
GroupRo: []
NavBarName: FAQ
Title: Print

Frontend::Module###AgentFAQRelatedArticles

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent FAQ Related Articles.
Group: []
GroupRo: []
NavBarName: ''
Title: Agent FAQ Related Articles

Frontend::Module###AgentFAQRichText

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: FAQ AJAX Responder for Richtext.
Group: []
GroupRo: []
NavBarName: ''
Title: FAQ AJAX Responder

Frontend::Module###AgentFAQSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Area.
Group: []
GroupRo: []
NavBarName: FAQ
Title: FAQ

Frontend::Module###AgentFAQSearchSmall

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Search FAQ Small.
Group: []
GroupRo: []
NavBarName: FAQ
Title: FAQ

Frontend::Module###AgentFAQZoom

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: FAQ Area.
Group: []
GroupRo: []
NavBarName: FAQ
Title: FAQ

Frontend::Module###AgentInfo

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Generic Info module.
Group: []
GroupRo: []
NavBarName: ''
Title: Info

Frontend::Module###AgentLinkObject

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Link Object.
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Group: []
GroupRo: []
NavBarName: ''
Title: Link Object

Frontend::Module###AgentNotificationView

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Notification web view.
Group: []
GroupRo: []
NavBarName: Notification web view
Title: Notification Web View

Frontend::Module###AgentPreferences

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent Preferences.
Group: []
GroupRo: []
NavBarName: Preferences
Title: ''

Frontend::Module###AgentSplitSelection

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket split dialog.
Group: []
GroupRo: []
NavBarName: ''
Title: ''

Frontend::Module###AgentStatistics

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent Statistics.
Group:
- stats
GroupRo:
- stats
NavBarName: Reports
Title: Statistics

Frontend::Module###AgentStatisticsReports

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Statistics reports.
Group:
- stats
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GroupRo:
- stats
NavBarName: Statistics Reports
Title: Statistics Reports

Frontend::Module###AgentSystemContract

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent
Group: []
GroupRo: []
NavBarName: ''
Title: System Contract

Frontend::Module###AgentTicketArticleContent

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: To view HTML attachments.
Group: []
GroupRo: []
NavBarName: Ticket
Title: ''

Frontend::Module###AgentTicketAttachment

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: To download attachments.
Group: []
GroupRo: []
NavBarName: Ticket
Title: ''

Frontend::Module###AgentTicketAttachmentView

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket attachments.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Attachments

Frontend::Module###AgentTicketBounce

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Compose Bounce Email.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Bounce
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Frontend::Module###AgentTicketBulk

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket bulk module.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Bulk Action

Frontend::Module###AgentTicketClose

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Close.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Close

Frontend::Module###AgentTicketCompose

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Compose email Answer.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Compose

Frontend::Module###AgentTicketCustomer

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Customer.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Customer

Frontend::Module###AgentTicketEmail

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Create new email ticket.
Group: []
GroupRo: []
NavBarName: Ticket
Title: New email ticket

Frontend::Module###AgentTicketEmailOutbound

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: Ticket Outbound Email.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Email Outbound

Frontend::Module###AgentTicketEmailResend

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Resend Ticket Email.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Email Resend

Frontend::Module###AgentTicketEscalationView

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Overview of all escalated tickets.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Escalation view

Frontend::Module###AgentTicketForward

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Forward Email.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Forward

Frontend::Module###AgentTicketFreeText

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket FreeText.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Free Fields

Frontend::Module###AgentTicketHistory

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket History.
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Group: []
GroupRo: []
NavBarName: Ticket
Title: History

Frontend::Module###AgentTicketLock

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Lock.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Lock

Frontend::Module###AgentTicketLockedView

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Locked Tickets.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Locked Tickets

Frontend::Module###AgentTicketMerge

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Merge.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Merge

Frontend::Module###AgentTicketMove

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Move.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Move

Frontend::Module###AgentTicketNote

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Note.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Note
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Frontend::Module###AgentTicketOwner

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Owner.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Owner

Frontend::Module###AgentTicketPending

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Pending.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Pending

Frontend::Module###AgentTicketPhone

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Create new phone ticket.
Group: []
GroupRo: []
NavBarName: Ticket
Title: New phone ticket

Frontend::Module###AgentTicketPhoneInbound

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Incoming Phone Call.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Phone-Ticket

Frontend::Module###AgentTicketPhoneOutbound

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Phone Call.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Phone-Ticket

Frontend::Module###AgentTicketPlain

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: Ticket plain view of an email.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Plain

Frontend::Module###AgentTicketPrint

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Print.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Print

Frontend::Module###AgentTicketPriority

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Priority.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Priority

Frontend::Module###AgentTicketProcess

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Create new process ticket.
Group: []
GroupRo: []
NavBarName: Ticket
Title: New process ticket

Frontend::Module###AgentTicketQueue

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Overview of all open Tickets.
Group: []
GroupRo: []
NavBarName: Ticket
Title: QueueView

Frontend::Module###AgentTicketResponsible

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Responsible.
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Group: []
GroupRo: []
NavBarName: Ticket
Title: Responsible

Frontend::Module###AgentTicketResponsibleView

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Responsible Tickets.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Responsible Tickets

Frontend::Module###AgentTicketSMS

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Create new SMS ticket.
Group: []
GroupRo: []
NavBarName: Ticket
Title: New SMS ticket

Frontend::Module###AgentTicketSMSOutbound

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Outbound SMS.
Group: []
GroupRo: []
NavBarName: Ticket
Title: SMS Outbound

Frontend::Module###AgentTicketSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Search Ticket.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Search

Frontend::Module###AgentTicketService

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Overview of all open Tickets.
Group: []
GroupRo: []
NavBarName: Ticket
Title: ServiceView
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Frontend::Module###AgentTicketStatusView

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Overview of all open tickets.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Status view

Frontend::Module###AgentTicketWatchView

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Watched Tickets.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Watched Tickets

Frontend::Module###AgentTicketWatcher

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: A TicketWatcher Module.
Group: []
GroupRo: []
NavBarName: Ticket-Watcher
Title: Ticket Watcher

Frontend::Module###AgentTicketZoom

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Ticket Zoom.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Zoom

Frontend::Module###AgentUserSearch

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Agent User Search.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Agent User Search

Frontend::Module###AgentVideoChat

担当者インタフェースに関するフロントエンド・モジュールの登録です。
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デフォルト値:

---
Description: Video and audio call screen.
Group: []
GroupRo: []
NavBarName: ''

Frontend::Module###AgentZoom

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Compat module for AgentZoom to AgentTicketZoom.
Group: []
GroupRo: []
NavBarName: Ticket
Title: ''

Frontend::Module###AjaxAttachment

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: AJAX attachment.
Group: []
GroupRo: []
NavBarName: ''
Title: AJAX Attachment

Frontend::Module###Logout

担当者インタフェースに関するフロントエンド・モジュールの登録です。

デフォルト値:

---
Description: Logout
Group: []
GroupRo: []
NavBarName: ''
Title: ''

Frontend::Module###PictureUpload

担当者インタフェースに関するフロントエンド・モジュールの登録です。

この設定は無効化することはできません。

デフォルト値:

---
Description: Picture upload module.
Group: []
GroupRo: []
NavBarName: Ticket
Title: Picture Upload

Frontend::NavBarModule###000-CustomerChat

Agent frontend module registration (disable chat link if chat feature is inactive or agent
is not in chat group).

デフォルト値:
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---
Module: Kernel::Output::HTML::NavBar::AgentChat

Frontend::NavBarModule###1-TicketProcesses

フロントエンド・モジュールの登録 (プロセスが利用可能ではない場合、チケット・プロセス画
面リンクは無効)。

デフォルト値:

---
Module: Kernel::Output::HTML::NavBar::AgentTicketProcess

Frontend::NavBarModule###2-AdminFavourites

フロントエンドモジュールを登録（個人用のお気に入りを「管理」のサブナビゲーション項目
として表示）

デフォルト値:

---
Module: Kernel::Output::HTML::NavBar::AdminFavourites

Frontend::NavBarModule###5-TicketSMS

Frontend module registration (disable SMS ticket screen if cloud service is not
activated).

デフォルト値:

---
Module: Kernel::Output::HTML::NavBar::AgentTicketSMS

Frontend::NavBarModule###6-CustomerCompany

フロントエンド・モジュールの登録 (企業機能が使われていない場合、企業リンクは無効)。

デフォルト値:

---
Module: Kernel::Output::HTML::NavBar::CustomerCompany

Frontend::NavBarModule###7-AgentTicketService

フロントエンド・モジュールの登録 (チケット・サービス機能が使われていない場
合、AgentTicketServiceリンクは無効)。

デフォルト値:

---
Module: Kernel::Output::HTML::NavBar::AgentTicketService

108. Frontend → Agent →
ModuleRegistration → Loader

Loader::Module::AgentAppointmentAgendaOverview###002-Calendar

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- thirdparty/fullcalendar-3.4.0/fullcalendar.min.css
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- Core.AppointmentCalendar.css
- Core.AppointmentCalendar.Agenda.css
JavaScript:
- thirdparty/momentjs-2.18.1/moment.min.js
- thirdparty/fullcalendar-3.4.0/fullcalendar.min.js
- Core.Agent.AppointmentCalendar.js

Loader::Module::AgentAppointmentCalendarOverview###002-Calendar

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- thirdparty/fullcalendar-3.4.0/fullcalendar.min.css
- thirdparty/fullcalendar-scheduler-1.6.2/scheduler.min.css
- Core.AppointmentCalendar.css
JavaScript:
- thirdparty/momentjs-2.18.1/moment.min.js
- thirdparty/fullcalendar-3.4.0/fullcalendar.min.js
- thirdparty/fullcalendar-scheduler-1.6.2/scheduler.min.js
- Core.Agent.AppointmentCalendar.js
- thirdparty/clipboardjs-1.7.1/clipboard.min.js

Loader::Module::AgentChat###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- thirdparty/spectrum-1.8.0/spectrum.css
- Core.Agent.Chat.css
JavaScript:
- thirdparty/spectrum-1.8.0/spectrum.js
- Core.Agent.Chat.js

Loader::Module::AgentChatAppend###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Chat.Append.css
JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.Chat.Append.js

Loader::Module::AgentChatPopup###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Chat.css
JavaScript:
- Core.Agent.Chat.js

Loader::Module::AgentChatPreview###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:
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---
JavaScript:
- Core.Agent.Chat.js
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js

Loader::Module::AgentCustomerInformationCenter###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.Dashboard.js
- Core.Agent.TableFilters.js
- Core.Agent.CustomerInformationCenter.js

Loader::Module::AgentCustomerUserAddressBook###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.CustomerUserAddressBook.css
JavaScript:
- Core.Agent.CustomerUserAddressBook.js

Loader::Module::AgentCustomerUserInformationCenter###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.Dashboard.js
- Core.Agent.TableFilters.js
- Core.Agent.CustomerUserInformationCenter.js

Loader::Module::AgentDashboard###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Dashboard.css
- Core.AllocationList.css
- thirdparty/fullcalendar-3.4.0/fullcalendar.min.css
- thirdparty/nvd3-1.7.1/nv.d3.css
JavaScript:
- thirdparty/momentjs-2.18.1/moment.min.js
- thirdparty/fullcalendar-3.4.0/fullcalendar.min.js
- thirdparty/d3-3.5.6/d3.min.js
- thirdparty/nvd3-1.7.1/nvd3.min.js
- thirdparty/nvd3-1.7.1/models/OTRSLineChart.js
- thirdparty/nvd3-1.7.1/models/OTRSMultiBarChart.js
- thirdparty/nvd3-1.7.1/models/OTRSStackedAreaChart.js
- thirdparty/canvg-1.4/rgbcolor.js
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- thirdparty/canvg-1.4/StackBlur.js
- thirdparty/canvg-1.4/canvg.js
- thirdparty/StringView-8/stringview.js
- Core.UI.AdvancedChart.js
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Dashboard.js
- Core.Agent.Statistics.ParamsWidget.js

Loader::Module::AgentFAQAdd###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.FAQ.Detail.css
JavaScript:
- Core.Agent.FAQ.js

Loader::Module::AgentFAQCategory###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.FAQ.ConfirmationDialog.js

Loader::Module::AgentFAQEdit###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.FAQ.Detail.css
JavaScript:
- Core.Agent.FAQ.js

Loader::Module::AgentFAQExplorer###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.FAQ.Detail.css
JavaScript:
- Core.Agent.FAQ.js

Loader::Module::AgentFAQJournal###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

--- {}

Loader::Module::AgentFAQLanguage###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:
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---
JavaScript:
- Core.Agent.FAQ.ConfirmationDialog.js

Loader::Module::AgentFAQSearch###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.FAQ.js

Loader::Module::AgentFAQZoom###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.FAQ.Detail.css
- Core.AllocationList.css
JavaScript:
- Core.Agent.FAQ.ConfirmationDialog.js
- Core.Agent.FAQ.TicketCompose.js
- Core.Agent.FAQ.FAQZoom.js
- Core.UI.AllocationList.js
- Core.UI.Table.Sort.js
- Core.Agent.TableFilters.js
- Core.Agent.LinkObject.js

Loader::Module::AgentLinkObject###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.LinkObject.SearchForm.js

Loader::Module::AgentNotificationView###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AllocationList.css
- Core.Agent.NotificationView.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.NotificationView.js

Loader::Module::AgentPreferences###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Preferences.css
- Core.Agent.Admin.SystemConfiguration.css
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JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Preferences.js
- Core.SystemConfiguration.js
- Core.SystemConfiguration.Date.js

Loader::Module::AgentStatistics###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- thirdparty/nvd3-1.7.1/nv.d3.css
- Core.Agent.Statistics.css
JavaScript:
- thirdparty/d3-3.5.6/d3.min.js
- thirdparty/nvd3-1.7.1/nvd3.min.js
- thirdparty/nvd3-1.7.1/models/OTRSLineChart.js
- thirdparty/nvd3-1.7.1/models/OTRSMultiBarChart.js
- thirdparty/nvd3-1.7.1/models/OTRSStackedAreaChart.js
- thirdparty/canvg-1.4/rgbcolor.js
- thirdparty/canvg-1.4/StackBlur.js
- thirdparty/canvg-1.4/canvg.js
- thirdparty/StringView-8/stringview.js
- Core.Agent.Statistics.js
- Core.UI.AdvancedChart.js
- Core.Agent.Statistics.ParamsWidget.js

Loader::Module::AgentStatisticsReports###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- thirdparty/nvd3-1.7.1/nv.d3.css
- Core.Agent.StatisticsReports.css
JavaScript:
- thirdparty/d3-3.5.6/d3.min.js
- thirdparty/nvd3-1.7.1/nvd3.min.js
- thirdparty/nvd3-1.7.1/models/OTRSLineChart.js
- thirdparty/nvd3-1.7.1/models/OTRSMultiBarChart.js
- thirdparty/nvd3-1.7.1/models/OTRSStackedAreaChart.js
- Core.UI.AdvancedChart.js
- Core.Agent.StatisticsReports.js

Loader::Module::AgentSystemContract###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.SystemContract.css

Loader::Module::AgentTicketAttachmentView###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.AttachmentView.css
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JavaScript:
- thirdparty/jquery-tablesorter-2.28.14/jquery.tablesorter.js
- Core.UI.Table.Sort.js
- Core.Agent.TicketAttachmentView.js

Loader::Module::AgentTicketBounce###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketBounce.js

Loader::Module::AgentTicketBulk###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketBulk.js

Loader::Module::AgentTicketClose###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketActionCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketCompose###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerSearchAutoComplete.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketCompose.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketCustomer###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerSearchAutoComplete.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketEmail###002-FAQ

担当者Webインタフェースのローダーモジュール登録
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デフォルト値:

---
JavaScript:
- Core.Agent.FAQ.RelatedArticles.js

Loader::Module::AgentTicketEmail###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerSearchAutoComplete.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketEmail.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketEmailOutbound###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerSearchAutoComplete.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketEmailOutbound.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketEmailResend###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerSearchAutoComplete.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketEmailResend.js

Loader::Module::AgentTicketEscalationView###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Overview.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketForward###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
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JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerSearchAutoComplete.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketForward.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketFreeText###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketActionCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketHistory###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.TicketHistory.css
JavaScript:
- Core.Agent.TicketHistory.js

Loader::Module::AgentTicketLockedView###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AgentTicketQueue.css
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Overview.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketMerge###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketMerge.js

Loader::Module::AgentTicketMove###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketMove.js
- Core.Agent.TicketFormDraft.js
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Loader::Module::AgentTicketNote###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketActionCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketOwner###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketActionCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketPending###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketActionCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketPhone###002-FAQ

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.FAQ.RelatedArticles.js

Loader::Module::AgentTicketPhone###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerSearchAutoComplete.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketPhone.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketPhoneInbound###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
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- Core.Agent.TicketAction.js
- Core.Agent.TicketPhoneCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketPhoneOutbound###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketPhoneCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketPriority###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
- Core.Agent.TicketActionCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketProcess###002-ProcessManagement

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.TicketProcess.css
JavaScript:
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerSearchAutoComplete.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketProcess.js
- Core.TicketProcess.js

Loader::Module::AgentTicketQueue###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AgentTicketQueue.css
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Overview.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketResponsible###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketAction.js
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- Core.Agent.TicketActionCommon.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketResponsibleView###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Overview.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketSMS###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- thirdparty/libphonenumber-js/libphonenumber-js.min.js
- Core.Agent.CustomerSearchSMS.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketSMS.js

Loader::Module::AgentTicketSMSOutbound###001-Framework

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- thirdparty/libphonenumber-js/libphonenumber-js.min.js
- Core.Agent.CustomerSearchSMS.js
- Core.Agent.TicketAction.js
- Core.Agent.TicketSMS.js
- Core.Agent.TicketFormDraft.js

Loader::Module::AgentTicketSearch###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Overview.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketService###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AgentTicketService.css
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- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Overview.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketStatusView###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Overview.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketWatchView###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.AgentTicketQueue.css
- Core.AllocationList.css
JavaScript:
- Core.UI.AllocationList.js
- Core.Agent.TableFilters.js
- Core.Agent.Overview.js
- Core.Agent.TicketSplit.js

Loader::Module::AgentTicketZoom###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.TicketProcess.css
- Core.Agent.TicketMenuModuleCluster.css
- Core.AllocationList.css
JavaScript:
- thirdparty/jquery-tablesorter-2.28.14/jquery.tablesorter.js
- Core.Agent.TicketSplit.js
- Core.Agent.TicketZoom.js
- Core.UI.AllocationList.js
- Core.UI.Table.Sort.js
- Core.Agent.LinkObject.js
- Core.Agent.TableFilters.js
- Core.Agent.TicketFormDraft.js
- Core.Agent.TicketZoom.TimelineView.js

Loader::Module::AgentTicketZoom###010-TicketSMS

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
JavaScript:
- Core.Agent.TicketSMS.js
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Loader::Module::AgentVideoChat###002-Ticket

担当者Webインタフェースのローダーモジュール登録

デフォルト値:

---
CSS:
- Core.Agent.Chat.VideoChat.css

109. Frontend → Agent →
ModuleRegistration → MainMenu

Frontend::Navigation###AgentAppointmentAgendaOverview###002-
Calendar

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ItemArea
  Description: Overview of all appointments.
  Group: []
  GroupRo: []
  Link: Action=AgentAppointmentAgendaOverview
  LinkOption: ''
  Name: Agenda Overview
  NavBar: Calendar
  Prio: '6500'
  Type: ''

Frontend::Navigation###AgentAppointmentCalendarOverview###002-
Calendar

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ItemArea
  Description: Appointment Calendar overview page.
  Group: []
  GroupRo: []
  Link: Action=AgentAppointmentCalendarOverview
  LinkOption: ''
  Name: Calendar
  NavBar: Calendar
  Prio: '75'
  Type: Menu
- AccessKey: ''
  Block: ItemArea
  Description: Appointment Calendar overview page.
  Group: []
  GroupRo: []
  Link: Action=AgentAppointmentCalendarOverview
  LinkOption: ''
  Name: Calendar Overview
  NavBar: Calendar
  Prio: '6000'
  Type: ''
- AccessKey: ''
  Block: ItemArea
  Description: Resource Overview (OTRSCalendarResourcePlanning)
  Group: []
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  GroupRo: []
  Link: Action=AgentAppointmentCalendarOverview
  LinkOption: class="PackageRequired" data-package-name="OTRSCalendarResourcePlanning"
  Name: Resource Overview
  NavBar: Calendar
  Prio: '7000'
  Type: ''
- AccessKey: ''
  Block: ItemArea
  Description: Create new appointment.
  Group: []
  GroupRo: []
  Link: Action=AgentAppointmentCalendarOverview;Subaction=AppointmentCreate
  LinkOption: ''
  Name: New Appointment
  NavBar: Calendar
  Prio: '8000'
  Type: ''

Frontend::Navigation###AgentAppointmentList###002-Calendar

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AgentChat###002-Ticket

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ItemArea
  Description: ''
  Group: []
  GroupRo: []
  Link: Action=AgentChat
  LinkOption: ''
  Name: Chat
  NavBar: Chat
  Prio: '500'
  Type: Menu

Frontend::Navigation###AgentCustomerInformationCenter###001-
Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: c
  Block: ItemArea
  Description: Customer Information Center search.
  Group: []
  GroupRo: []
  Link: Action=AgentCustomerInformationCenter
  LinkOption: onclick="window.setTimeout(function()
{Core.Agent.CustomerInformationCenterSearch.OpenSearchDialog();},
    0); return false;"
  Name: Customer Information Center
  NavBar: Customers
  Prio: '50'
  Type: ''
- AccessKey: ''
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  Block: ItemArea
  Description: Customer Information Center search.
  Group: []
  GroupRo: []
  Link: Action=AgentCustomerInformationCenter
  LinkOption: ''
  Name: Customers
  NavBar: Customers
  Prio: '60'
  Type: Menu

Frontend::Navigation###AgentCustomerInformationCenterSearch###001-
Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AgentCustomerUserInformationCenter###001-
Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: y
  Block: ItemArea
  Description: Customer User Information Center search.
  Group: []
  GroupRo: []
  Link: Action=AgentCustomerUserInformationCenter
  LinkOption: onclick="window.setTimeout(function()
{Core.Agent.CustomerUserInformationCenterSearch.OpenSearchDialog();},
    0); return false;"
  Name: Customer User Information Center
  NavBar: Customers
  Prio: '55'
  Type: ''

Frontend::Navigation###AgentDashboard###001-Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: d
  Block: ItemArea
  Description: Dashboard overview.
  Group: []
  GroupRo: []
  Link: Action=AgentDashboard
  LinkOption: ''
  Name: Dashboard
  NavBar: Dashboard
  Prio: '50'
  Type: Menu

Frontend::Navigation###AgentFAQAdd###002-FAQ

Main menu item registration.

デフォルト値:
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---
- AccessKey: b
  Block: ''
  Description: New FAQ Article.
  Group: []
  GroupRo: []
  Link: Action=AgentFAQAdd
  LinkOption: ''
  Name: New
  NavBar: FAQ
  Prio: '920'
  Type: ''

Frontend::Navigation###AgentFAQCategory###002-FAQ

Main menu item registration.

デフォルト値:

---
- AccessKey: g
  Block: ''
  Description: Category Management.
  Group:
  - admin
  GroupRo: []
  Link: Action=AgentFAQCategory
  LinkOption: ''
  Name: Category Management
  NavBar: FAQ
  Prio: '950'
  Type: ''

Frontend::Navigation###AgentFAQExplorer###002-FAQ

Main menu item registration.

デフォルト値:

---
- AccessKey: f
  Block: ItemArea
  Description: FAQ Area
  Group: []
  GroupRo: []
  Link: Action=AgentFAQExplorer
  LinkOption: ''
  Name: FAQ
  NavBar: FAQ
  Prio: '350'
  Type: Menu
- AccessKey: x
  Block: ''
  Description: FAQ Explorer
  Group: []
  GroupRo: []
  Link: Action=AgentFAQExplorer
  LinkOption: ''
  Name: Explorer
  NavBar: FAQ
  Prio: '910'
  Type: ''

Frontend::Navigation###AgentFAQJournal###002-FAQ

Main menu item registration.

デフォルト値:

---
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- AccessKey: j
  Block: ''
  Description: FAQ Journal
  Group: []
  GroupRo: []
  Link: Action=AgentFAQJournal
  LinkOption: ''
  Name: Journal
  NavBar: FAQ
  Prio: '930'
  Type: ''

Frontend::Navigation###AgentFAQLanguage###002-FAQ

Main menu item registration.

デフォルト値:

---
- AccessKey: l
  Block: ''
  Description: Language Management.
  Group:
  - admin
  GroupRo: []
  Link: Action=AgentFAQLanguage
  LinkOption: ''
  Name: Language Management
  NavBar: FAQ
  Prio: '940'
  Type: ''

Frontend::Navigation###AgentFAQSearch###002-FAQ

Main menu item registration.

デフォルト値:

---
- AccessKey: z
  Block: ''
  Description: Search FAQ.
  Group: []
  GroupRo: []
  Link: Action=AgentFAQSearch
  LinkOption: onclick="Core.Agent.Search.OpenSearchDialog('AgentFAQSearch'); if
 (event.stopPropagation)
    { event.stopPropagation(); } else { window.event.cancelBubble = true; } return
    false;"
  Name: Search
  NavBar: FAQ
  Prio: '960'
  Type: ''

Frontend::Navigation###AgentFAQSearchSmall###002-FAQ

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AgentLinkObject###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。
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デフォルト値:

--- []

Frontend::Navigation###AgentNotificationView###001-Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ''
  Description: View notifications
  Group: []
  GroupRo: []
  Link: Action=AgentNotificationView
  LinkOption: ''
  Name: Notification web view
  NavBar: ''
  Prio: '910'
  Type: ''

Frontend::Navigation###AgentPreferences###001-Framework

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AgentStatistics###001-Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ItemArea
  Description: Statistics overview.
  Group:
  - stats
  GroupRo:
  - stats
  Link: Action=AgentStatistics;Subaction=Overview
  LinkOption: ''
  Name: Reports
  NavBar: Reports
  Prio: '8500'
  Type: Menu
- AccessKey: ''
  Block: ''
  Description: Statistics overview.
  Group:
  - stats
  GroupRo:
  - stats
  Link: Action=AgentStatistics;Subaction=Overview
  LinkOption: ''
  Name: Statistics
  NavBar: Reports
  Prio: '200'
  Type: ''

Frontend::Navigation###AgentStatisticsReports###001-Framework

Main menu item registration.
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デフォルト値:

---
- AccessKey: ''
  Block: ''
  Description: ''
  Group:
  - stats
  GroupRo:
  - stats
  Link: Action=AgentStatisticsReports;Subaction=Overview
  LinkOption: ''
  Name: Reports
  NavBar: Reports
  Prio: '100'
  Type: ''

Frontend::Navigation###AgentTicketEmail###002-Ticket

Main menu item registration.

デフォルト値:

---
- AccessKey: m
  Block: ''
  Description: Create new email ticket and send this out (outbound).
  Group: []
  GroupRo: []
  Link: Action=AgentTicketEmail
  LinkOption: ''
  Name: New email ticket
  NavBar: Ticket
  Prio: '210'
  Type: ''

Frontend::Navigation###AgentTicketEscalationView###002-Ticket

Main menu item registration.

デフォルト値:

---
- AccessKey: e
  Block: ''
  Description: Overview Escalated Tickets.
  Group: []
  GroupRo: []
  Link: Action=AgentTicketEscalationView
  LinkOption: ''
  Name: Escalation view
  NavBar: Ticket
  Prio: '120'
  Type: ''

Frontend::Navigation###AgentTicketLockedView###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

Frontend::Navigation###AgentTicketPhone###002-Ticket

Main menu item registration.

デフォルト値:
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---
- AccessKey: n
  Block: ''
  Description: Create new phone ticket (inbound).
  Group: []
  GroupRo: []
  Link: Action=AgentTicketPhone
  LinkOption: ''
  Name: New phone ticket
  NavBar: Ticket
  Prio: '200'
  Type: ''

Frontend::Navigation###AgentTicketProcess###002-ProcessManagement

Main menu item registration.

デフォルト値:

---
- AccessKey: p
  Block: ''
  Description: Create New process ticket.
  Group: []
  GroupRo: []
  Link: Action=AgentTicketProcess
  LinkOption: ''
  Name: New process ticket
  NavBar: Ticket
  Prio: '220'
  Type: ''

Frontend::Navigation###AgentTicketQueue###002-Ticket

Main menu item registration.

デフォルト値:

---
- AccessKey: o
  Block: ''
  Description: Overview of all Tickets per assigned Queue.
  Group: []
  GroupRo: []
  Link: Action=AgentTicketQueue
  LinkOption: ''
  Name: Queue view
  NavBar: Ticket
  Prio: '100'
  Type: ''
- AccessKey: t
  Block: ItemArea
  Description: Overview of all Tickets per assigned Queue.
  Group: []
  GroupRo: []
  Link: Action=AgentTicketQueue
  LinkOption: ''
  Name: Tickets
  NavBar: Ticket
  Prio: '200'
  Type: Menu

Frontend::Navigation###AgentTicketResponsibleView###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:
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--- []

Frontend::Navigation###AgentTicketSMS###001-Framework

Main menu item registration.

デフォルト値:

---
- AccessKey: ''
  Block: ''
  Description: Create new SMS ticket and send it out (outbound).
  Group: []
  GroupRo: []
  Link: Action=AgentTicketSMS
  LinkOption: ''
  Name: New SMS ticket
  NavBar: Ticket
  Prio: '230'
  Type: ''

Frontend::Navigation###AgentTicketSearch###002-Ticket

Main menu item registration.

デフォルト値:

---
- AccessKey: s
  Block: ''
  Description: Search Tickets.
  Group: []
  GroupRo: []
  Link: Action=AgentTicketSearch
  LinkOption: onclick="window.setTimeout(function()
{Core.Agent.Search.OpenSearchDialog('AgentTicketSearch');},
    0); return false;"
  Name: Search
  NavBar: Ticket
  Prio: '300'
  Type: ''

Frontend::Navigation###AgentTicketService###002-Ticket

Main menu item registration.

デフォルト値:

---
- AccessKey: i
  Block: ''
  Description: Overview of all open Tickets.
  Group: []
  GroupRo: []
  Link: Action=AgentTicketService
  LinkOption: ''
  Name: Service view
  NavBar: Ticket
  Prio: '105'
  Type: ''

Frontend::Navigation###AgentTicketStatusView###002-Ticket

Main menu item registration.

デフォルト値:

---
- AccessKey: v
  Block: ''
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  Description: Overview of all open Tickets.
  Group: []
  GroupRo: []
  Link: Action=AgentTicketStatusView
  LinkOption: ''
  Name: Status view
  NavBar: Ticket
  Prio: '110'
  Type: ''

Frontend::Navigation###AgentTicketWatchView###002-Ticket

Main menu item registration.

この設定は標準では有効ではありません。

デフォルト値:

--- []

110. Frontend → Agent →
TicketOverview

Ticket::Frontend::Overview###Medium

中程度のフォーマットでのチケット一覧の表示を許可します（CustomerInfo => 1 - 顧客情報
も表示します)。

デフォルト値:

---
CustomerInfo: '0'
Module: Kernel::Output::HTML::TicketOverview::Medium
ModulePriority: '200'
Name: Medium
NameShort: M
OverviewMenuModules: '1'
TicketActionsPerTicket: '1'

Ticket::Frontend::Overview###Preview

チケット一覧のプレビューを表示します(CustomerInfo => 1 - 顧客情報も表示します
CustomerInfoMaxSize max ? 顧客情報の文字サイズです)。

デフォルト値:

---
CustomerInfo: '0'
CustomerInfoMaxSize: '18'
DefaultPreViewLines: '25'
DefaultViewNewLine: '90'
Module: Kernel::Output::HTML::TicketOverview::Preview
ModulePriority: '300'
Name: Large
NameShort: L
OverviewMenuModules: '1'
StripEmptyLines: '0'
TicketActionsPerTicket: '1'

Ticket::Frontend::Overview###Small

小さいフォーマットでのチケット一覧の表示を許可します（CustomerInfo => 1 - 顧客情報も
表示します)。

デフォルト値:
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---
CustomerInfo: '1'
Module: Kernel::Output::HTML::TicketOverview::Small
ModulePriority: '100'
Name: Small
NameShort: S

Ticket::Frontend::Overview::PreviewArticleLimit

Sets the count of articles visible in preview mode of ticket overviews.

この設定は無効化することはできません。

デフォルト値:

--- '5'

Ticket::Frontend::Overview::PreviewArticleSenderTypes

Defines which article sender types should be shown in the preview of a ticket.

この設定は標準では有効ではありません。

デフォルト値:

---
agent: '1'
customer: '1'
system: '1'

Ticket::Frontend::Overview::PreviewIsVisibleForCustomerExpanded

Defines if the first article should be displayed as expanded, that is visible for the
related customer. If nothing defined, latest article will be expanded.

この設定は標準では有効ではありません。

デフォルト値:

--- 0

Ticket::Frontend::OverviewMedium###DynamicField

Dynamic fields shown in the ticket medium format overview screen of the agent
interface.

デフォルト値:

--- {}

Ticket::Frontend::OverviewPreview###DynamicField

担当者インターフェイスのチケットプレビュー形式画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::OverviewSmall###DynamicField

担当者インターフェイスのコンパクトなチケット概要画面に表示するダイナミック・フィール
ド

デフォルト値:

--- {}
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111. Frontend → Agent →
TicketOverview → MenuModule

Ticket::Frontend::OverviewMenuModule###001-Sort

This setting shows the sorting attributes in all overview screen, not only in queue view.

デフォルト値:

---
Module: Kernel::Output::HTML::TicketOverviewMenu::Sort

Ticket::Frontend::PreMenuModule###100-Lock

担当者インタフェースの全チケット一覧で、チケットをロック/アンロックするためのリンクを
メニューに表示します。

デフォルト値:

---
Action: AgentTicketLock
Module: Kernel::Output::HTML::TicketMenu::Lock
Name: Lock
PopupType: ''
Target: ''

Ticket::Frontend::PreMenuModule###200-Zoom

担当者インタフェースの全チケット一覧で、チケットにズームするためのリンクをメニューに
表示します。

デフォルト値:

---
Action: AgentTicketZoom
Description: Look into a ticket!
Link: Action=AgentTicketZoom;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Zoom
PopupType: ''
Target: ''

Ticket::Frontend::PreMenuModule###210-History

担当者インタフェースの全チケット一覧で、チケットのチケット履歴を確認するためのリンク
をメニューに表示します。

デフォルト値:

---
Action: AgentTicketHistory
Description: Show the ticket history
Link: Action=AgentTicketHistory;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: History
PopupType: TicketHistory
Target: ''

Ticket::Frontend::PreMenuModule###300-Priority

担当者インタフェースの全チケット一覧で、チケットの優先度を設定するためのリンクをメ
ニューに表示します。

デフォルト値:
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---
Action: AgentTicketPriority
Description: Change the priority for this ticket
Link: Action=AgentTicketPriority;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Priority
PopupType: TicketAction
Target: ''

Ticket::Frontend::PreMenuModule###420-Note

担当者インタフェースの全チケット一覧で、チケットにメモを追加するためのリンクをメ
ニューに表示します。

デフォルト値:

---
Action: AgentTicketNote
Description: Add a note to this ticket
Link: Action=AgentTicketNote;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Note
PopupType: TicketAction
Target: ''

Ticket::Frontend::PreMenuModule###440-Close

担当者インタフェースの全チケット一覧で、チケットをクローズするためのリンクをメニュー
に表示します。

デフォルト値:

---
Action: AgentTicketClose
Description: Close this ticket
Link: Action=AgentTicketClose;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Close
PopupType: TicketAction
Target: ''

Ticket::Frontend::PreMenuModule###445-Move

担当者インタフェースの全チケット一覧で、チケットを移動するためのリンクをメニューに表
示します。

デフォルト値:

---
Action: AgentTicketMove
Description: Change queue!
Module: Kernel::Output::HTML::TicketMenu::Move
Name: Move

Ticket::Frontend::PreMenuModule###450-Delete

担当者インタフェースの全チケット一覧で、チケットを削除するするためのリンクをメニュー
に表示します。本リンクを表示または非表示にするための追加的アクセス・コントロールにつ
いては、“Group”キーおよび"rw:group1;move_into:group2"のようなコンテンツを使用すること
で可能になります。

この設定は標準では有効ではありません。

デフォルト値:

---
Action: AgentTicketMove
Description: Delete this ticket
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Link: Action=AgentTicketMove;TicketID=[% Data.TicketID %];DestQueue=Delete
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Delete
PopupType: ''
Target: ''

Ticket::Frontend::PreMenuModule###460-Junk

Shows a link in the menu to set a ticket as junk in every ticket overview of the agent
interface. Additional access control to show or not show this link can be done by using
Key "Group" and Content like "rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
Action: AgentTicketMove
Description: Mark as Spam!
Link: Action=AgentTicketMove;TicketID=[% Data.TicketID %];DestQueue=Junk
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Spam
PopupType: ''
Target: ''

TicketOverviewMenuSort###SortAttributes

Defines from which ticket attributes the agent can select the result order.

デフォルト値:

---
Age: '1'
Title: '1'

112. Frontend → Agent → ToolBar
Frontend::ToolBarModule###110-Ticket::AgentTicketQueue

Toolbar Item for a shortcut. Additional access control to show or not show this link can
be done by using Key "Group" and Content like "rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
AccessKey: q
Action: AgentTicketQueue
CssClass: QueueView
Icon: fa fa-folder
Link: Action=AgentTicketQueue
Module: Kernel::Output::HTML::ToolBar::Link
Name: Queue view
Priority: '1010010'

Frontend::ToolBarModule###12-ChatRequests

チャットリクエストを確認するエージェントインターフェース通知モジュール

デフォルト値:

---
AccessKey: ''
CssClass: ChatRequests
Icon: fa fa-comments-o
Module: Kernel::Output::HTML::ToolBar::ChatRequests
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Priority: '1030040'

Frontend::ToolBarModule###12-NotificationWebView::AgentNotificationView

Tool-bar item for a notification web view.

デフォルト値:

---
AccessKey: u
Action: AgentNotificationView
CssClass: NotificationView
Icon: fa fa-flag-o
Link: Action=AgentNotificationView
Module: Kernel::Output::HTML::ToolBar::NotificationView
Name: 'Notifications Unseen:'
Priority: '1040010'

Frontend::ToolBarModule###120-Ticket::AgentTicketStatus

Toolbar Item for a shortcut. Additional access control to show or not show this link can
be done by using Key "Group" and Content like "rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
AccessKey: ''
Action: AgentTicketStatusView
CssClass: StatusView
Icon: fa fa-list-ol
Link: Action=AgentTicketStatusView
Module: Kernel::Output::HTML::ToolBar::Link
Name: Status view
Priority: '1010020'

Frontend::ToolBarModule###13-ChatAvailability

Agent interface availability.

デフォルト値:

---
AccessKey: ''
CssClass: ChatAvailability
Icon: fa fa-circle-o
Module: Kernel::Output::HTML::ToolBar::ChatAvailability
Priority: '1030042'

Frontend::ToolBarModule###130-Ticket::AgentTicketEscalation

Toolbar Item for a shortcut. Additional access control to show or not show this link can
be done by using Key "Group" and Content like "rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
AccessKey: w
Action: AgentTicketEscalationView
CssClass: EscalationView
Icon: fa fa-exclamation
Link: Action=AgentTicketEscalationView
Module: Kernel::Output::HTML::ToolBar::Link
Name: Escalation view
Priority: '1010030'

631



Frontend::ToolBarModule###140-Ticket::AgentTicketPhone

Toolbar Item for a shortcut. Additional access control to show or not show this link can
be done by using Key "Group" and Content like "rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
AccessKey: ''
Action: AgentTicketPhone
CssClass: PhoneTicket
Icon: fa fa-phone
Link: Action=AgentTicketPhone
Module: Kernel::Output::HTML::ToolBar::Link
Name: New phone ticket
Priority: '1020010'

Frontend::ToolBarModule###150-Ticket::AgentTicketEmail

Toolbar Item for a shortcut. Additional access control to show or not show this link can
be done by using Key "Group" and Content like "rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
AccessKey: ''
Action: AgentTicketEmail
CssClass: EmailTicket
Icon: fa fa-envelope
Link: Action=AgentTicketEmail
Module: Kernel::Output::HTML::ToolBar::Link
Name: New email ticket
Priority: '1020020'

Frontend::ToolBarModule###160-Ticket::AgentTicketProcess

Toolbar Item for a shortcut. Additional access control to show or not show this link can
be done by using Key "Group" and Content like "rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
AccessKey: ''
Action: AgentTicketProcess
CssClass: ProcessTicket
Icon: fa fa-sitemap
Link: Action=AgentTicketProcess
Module: Kernel::Output::HTML::ToolBar::Link
Name: New process ticket
Priority: '1020030'

Frontend::ToolBarModule###170-Ticket::TicketResponsible

Agent interface notification module to see the number of tickets an agent is
responsible for. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2".

デフォルト値:

---
AccessKey: r
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AccessKeyNew: ''
AccessKeyReached: ''
CssClass: Responsible
CssClassNew: Responsible New
CssClassReached: Responsible Reached
Icon: fa fa-user
IconNew: fa fa-user
IconReached: fa fa-user
Module: Kernel::Output::HTML::ToolBar::TicketResponsible
Priority: '1030010'

Frontend::ToolBarModule###180-Ticket::TicketWatcher

Agent interface notification module to see the number of watched tickets. Additional
access control to show or not show this link can be done by using Key "Group" and
Content like "rw:group1;move_into:group2".

デフォルト値:

---
AccessKey: ''
AccessKeyNew: ''
AccessKeyReached: ''
CssClass: Watcher
CssClassNew: Watcher New
CssClassReached: Watcher Reached
Icon: fa fa-eye
IconNew: fa fa-eye
IconReached: fa fa-eye
Module: Kernel::Output::HTML::ToolBar::TicketWatcher
Priority: '1030020'

Frontend::ToolBarModule###190-Ticket::TicketLocked

Agent interface notification module to see the number of locked tickets. Additional
access control to show or not show this link can be done by using Key "Group" and
Content like "rw:group1;move_into:group2".

デフォルト値:

---
AccessKey: k
AccessKeyNew: ''
AccessKeyReached: ''
CssClass: Locked
CssClassNew: Locked New
CssClassReached: Locked Reached
Icon: fa fa-lock
IconNew: fa fa-lock
IconReached: fa fa-lock
Module: Kernel::Output::HTML::ToolBar::TicketLocked
Priority: '1030030'

Frontend::ToolBarModule###200-Ticket::AgentTicketService

担当者Webインタフェース通知モジュールを使用して、マイサービスのチケット数を確認しま
す。 このリンクを表示するかどうかを示す追加のアクセス制御は、 "グループ"キーと "rw：
group1; move_into：group2"のようなコンテンツを使用して行うことができます。

この設定は標準では有効ではありません。

デフォルト値:

---
CssClass: ServiceView
Icon: fa fa-wrench
Module: Kernel::Output::HTML::ToolBar::TicketService
Priority: '1030035'
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Frontend::ToolBarModule###210-Ticket::TicketSearchProfile

Agent interface module to access search profiles via nav bar. Additional access control
to show or not show this link can be done by using Key "Group" and Content like
"rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
Block: ToolBarSearchProfile
Description: Search template
MaxWidth: '40'
Module: Kernel::Output::HTML::ToolBar::TicketSearchProfile
Name: Search template
Priority: '1990010'

Frontend::ToolBarModule###220-Ticket::TicketSearchFulltext

Agent interface module to access fulltext search via nav bar. Additional access control
to show or not show this link can be done by using Key "Group" and Content like
"rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
Block: ToolBarSearchFulltext
Description: Fulltext...
Module: Kernel::Output::HTML::ToolBar::Generic
Name: Fulltext
Priority: '1990020'
Size: '10'

Frontend::ToolBarModule###230-CICSearchCustomerID

Agent interface module to access CIC search via nav bar. Additional access control
to show or not show this link can be done by using Key "Group" and Content like
"rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
Block: ToolBarCICSearchCustomerID
Description: CustomerID...
Module: Kernel::Output::HTML::ToolBar::Generic
Name: CustomerID
Priority: '1990030'
Size: '10'

Frontend::ToolBarModule###240-CICSearchCustomerUser

Agent interface module to access CIC search via nav bar. Additional access control
to show or not show this link can be done by using Key "Group" and Content like
"rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
Block: ToolBarCICSearchCustomerUser
Description: Customer user...
Module: Kernel::Output::HTML::ToolBar::Generic
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Name: Customer User
Priority: '1990040'
Size: '10'

Frontend::ToolBarModule###90-FAQ::AgentFAQAdd

ショートカットのためのツールバー・アイテムです。

この設定は標準では有効ではありません。

デフォルト値:

---
AccessKey: ''
Action: AgentFAQAdd
CssClass: FAQ
Icon: fa fa-question
Link: Action=AgentFAQAdd
Module: Kernel::Output::HTML::ToolBar::Link
Name: Add FAQ article
Priority: '1020090'

113. Frontend → Agent → View →
CustomerInformationCenter

AgentCustomerInformationCenter::Backend###0050-CIC-CustomerUserList

Parameters for the dashboard backend of the customer user list overview of the
agent interface . "Limit" is the number of entries shown by default. "Group" is used
to restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin.

デフォルト値:

---
Attributes: ''
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
Description: All customer users of a CustomerID
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::CustomerUserList
Permission: ro
Title: Customer Users

AgentCustomerInformationCenter::Backend###0100-CIC-
TicketPendingReminder

Parameters for the dashboard backend of the ticket pending reminder overview of
the agent interface . "Limit" is the number of entries shown by default. "Group"
is used to restrict the access to the plugin (e. g. Group: admin;group1;group2;).
"Default" determines if the plugin is enabled by default or if the user needs to
enable it manually. "CacheTTLLocal" is the cache time in minutes for the plugin.
Note: Only Ticket attributes and Dynamic Fields (DynamicField_NameX) are allowed
for DefaultColumns.

デフォルト値:

---
Attributes: TicketPendingTimeOlderMinutes=1;StateType=pending
 reminder;SortBy=PendingTime;OrderBy=Down;
Block: ContentLarge
CacheTTLLocal: '0.5'
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Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All tickets with a reminder set where the reminder date has been reached
Filter: Locked
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: ro
Time: UntilTime
Title: Reminder Tickets

AgentCustomerInformationCenter::Backend###0110-CIC-TicketEscalation

Parameters for the dashboard backend of the ticket escalation overview of the
agent interface . "Limit" is the number of entries shown by default. "Group" is used
to restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. Note: Only Ticket
attributes and Dynamic Fields (DynamicField_NameX) are allowed for DefaultColumns.

デフォルト値:

---
Attributes: TicketEscalationTimeOlderMinutes=1;SortBy=EscalationTime;OrderBy=Down;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
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  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All escalated tickets
Filter: All
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: ro
Time: EscalationTime
Title: Escalated Tickets

AgentCustomerInformationCenter::Backend###0120-CIC-TicketNew

Parameters for the dashboard backend of the new tickets overview of the agent
interface. "Limit" is the number of entries shown by default. "Group" is used to restrict
the access to the plugin (e. g. Group: admin;group1;group2;). "Default" determines
if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. Note: Only Ticket
attributes and Dynamic Fields (DynamicField_NameX) are allowed for DefaultColumns.

デフォルト値:

---
Attributes: StateType=new;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All new tickets, these tickets have not been worked on yet
Filter: All
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: ro
Time: Age
Title: New Tickets

AgentCustomerInformationCenter::Backend###0130-CIC-TicketOpen

Parameters for the dashboard backend of the open tickets overview of the agent
interface. "Limit" is the number of entries shown by default. "Group" is used to restrict
the access to the plugin (e. g. Group: admin;group1;group2;). "Default" determines
if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. Note: Only Ticket
attributes and Dynamic Fields (DynamicField_NameX) are allowed for DefaultColumns.
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デフォルト値:

---
Attributes: StateType=open;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All open tickets, these tickets have already been worked on, but need
  a response
Filter: All
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: ro
Time: Age
Title: Open Tickets / Need to be answered

AgentCustomerInformationCenter::Backend###0500-CIC-CustomerIDStatus

Parameters for the dashboard backend of the customer id status widget of the
agent interface . "Group" is used to restrict the access to the plugin (e. g. Group:
admin;group1;group2;). "Default" determines if the plugin is enabled by default or if
the user needs to enable it manually. "CacheTTLLocal" is the cache time in minutes
for the plugin.

デフォルト値:

---
Attributes: ''
Block: ContentSmall
CacheTTLLocal: '0.5'
Default: '1'
Description: Company Status
Group: ''
Module: Kernel::Output::HTML::Dashboard::CustomerIDStatus
Permission: ro
Title: Company Status

AgentCustomerInformationCenter::MainMenu###010-EditCustomerID

Main menu registration.

この設定は標準では有効ではありません。

デフォルト値:
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---
Link: '[% Env("Baselink") %]Action=AdminCustomerCompany;Subaction=Change;CustomerID=[%
  Data.CustomerID | uri %];Nav=0'
Name: Edit customer company

114. Frontend → Agent → View →
CustomerUserAddressBook

CustomerUser::Frontend::Overview###AddressBook

Defines an overview module to show the address book view of a customer user list.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::CustomerUser::OverviewAddressBook
Name: AddressBook

115. Frontend → Agent → View →
CustomerUserInformationCenter

AgentCustomerUserInformationCenter::Backend###0050-CUIC-
CustomerIDList

Parameters for the dashboard backend of the customer id list overview of the agent
interface . "Limit" is the number of entries shown by default. "Group" is used to
restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin.

デフォルト値:

---
Attributes: ''
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
Description: All CustomerIDs of a customer user.
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::CustomerIDList
Permission: ro
Title: Customer IDs

AgentCustomerUserInformationCenter::Backend###0100-CUIC-
TicketPendingReminder

Parameters for the dashboard backend of the ticket pending reminder overview of
the agent interface . "Limit" is the number of entries shown by default. "Group"
is used to restrict the access to the plugin (e. g. Group: admin;group1;group2;).
"Default" determines if the plugin is enabled by default or if the user needs to
enable it manually. "CacheTTLLocal" is the cache time in minutes for the plugin.
Note: Only Ticket attributes and Dynamic Fields (DynamicField_NameX) are allowed
for DefaultColumns. Possible settings: 0 = Disabled, 1 = Available, 2 = Enabled by
default. "AccessibleTickets" determines if the plugin will show only tickets assigned to
a customer user directly (=0) or also all accessible tickets for this customer (=1).

デフォルト値:
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---
Attributes: TicketPendingTimeOlderMinutes=1;StateType=pending
 reminder;SortBy=PendingTime;OrderBy=Down;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All tickets with a reminder set where the reminder date has been reached
Filter: Locked
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: ro
Time: UntilTime
Title: Reminder Tickets

AgentCustomerUserInformationCenter::Backend###0110-CUIC-
TicketEscalation

Parameters for the dashboard backend of the ticket escalation overview of the
agent interface . "Limit" is the number of entries shown by default. "Group" is used
to restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable
it manually. "CacheTTLLocal" is the cache time in minutes for the plugin. Note:
Only Ticket attributes and Dynamic Fields (DynamicField_NameX) are allowed for
DefaultColumns. Possible settings: 0 = Disabled, 1 = Available, 2 = Enabled by
default. "AccessibleTickets" determines if the plugin will show only tickets assigned to
a customer user directly (=0) or also all accessible tickets for this customer (=1).

デフォルト値:

---
Attributes: TicketEscalationTimeOlderMinutes=1;SortBy=EscalationTime;OrderBy=Down;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
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  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All escalated tickets
Filter: All
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: ro
Time: EscalationTime
Title: Escalated Tickets

AgentCustomerUserInformationCenter::Backend###0120-CUIC-TicketNew

Parameters for the dashboard backend of the new tickets overview of the agent
interface. "Limit" is the number of entries shown by default. "Group" is used to
restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable
it manually. "CacheTTLLocal" is the cache time in minutes for the plugin. Note:
Only Ticket attributes and Dynamic Fields (DynamicField_NameX) are allowed for
DefaultColumns. Possible settings: 0 = Disabled, 1 = Available, 2 = Enabled by
default. "AccessibleTickets" determines if the plugin will show only tickets assigned to
a customer user directly (=0) or also all accessible tickets for this customer (=1).

デフォルト値:

---
Attributes: StateType=new;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All new tickets, these tickets have not been worked on yet
Filter: All
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
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Permission: ro
Time: Age
Title: New Tickets

AgentCustomerUserInformationCenter::Backend###0130-CUIC-TicketOpen

Parameters for the dashboard backend of the open tickets overview of the agent
interface. "Limit" is the number of entries shown by default. "Group" is used to
restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable
it manually. "CacheTTLLocal" is the cache time in minutes for the plugin. Note:
Only Ticket attributes and Dynamic Fields (DynamicField_NameX) are allowed for
DefaultColumns. Possible settings: 0 = Disabled, 1 = Available, 2 = Enabled by
default. "AccessibleTickets" determines if the plugin will show only tickets assigned to
a customer user directly (=0) or also all accessible tickets for this customer (=1).

デフォルト値:

---
Attributes: StateType=open;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All open tickets, these tickets have already been worked on, but need
  a response
Filter: All
Group: ''
Limit: '10'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: ro
Time: Age
Title: Open Tickets / Need to be answered

116. Frontend → Agent → View →
CustomerUserSearch

CustomerUser::Frontend::AgentCustomerUserAddressBook###DefaultFields

顧客ユーザーのアドレス帳の検索（CustomerUser又はCustomerCompany）のデフォルトの
フィルターフィールドを定義します。 CustomerCompanyフィールドには、接頭辞
'CustomerCompany_'を追加する必要があります。
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この設定は無効化することはできません。

デフォルト値:

---
Email:
- UserLogin
- UserFirstname
- UserLastname
- UserEmail
- UserCustomerID

CustomerUser::Frontend::AgentCustomerUserAddressBook###DefaultFields###SMS

顧客ユーザーのアドレス帳の検索（CustomerUser又はCustomerCompany）のデフォルトの
フィルターフィールドを定義します。 CustomerCompanyフィールドには、接頭辞
'CustomerCompany_'を追加する必要があります。

この設定は無効化することはできません。

デフォルト値:

---
- UserFirstname
- UserLastname
- UserLogin
- UserMobile
- UserCustomerID

CustomerUser::Frontend::AgentCustomerUserAddressBook###SearchParameters

Defines the search parameters for the AgentCustomerUserAddressBook screen. With
the setting 'CustomerTicketTextField' the values for the recipient field can be specified.

この設定は無効化することはできません。

デフォルト値:

---
Email:
  CustomerTicketTextField: UserMailString
  Order::Default: Up
  PageShown: '50'
  SearchLimit: '10000'
  SortBy::Default: UserLogin

CustomerUser::Frontend::AgentCustomerUserAddressBook###SearchParameters###SMS

Defines the search parameters for the AgentCustomerUserAddressBook screen. With
the setting 'CustomerTicketTextField' the values for the recipient field can be specified.

この設定は無効化することはできません。

デフォルト値:

---
CustomerTicketTextField: UserMobile
Order::Default: Up
PageShown: '50'
SearchLimit: '10000'
SortBy::Default: UserLogin

CustomerUser::Frontend::AgentCustomerUserAddressBook###ShowColumns

Defines the shown columns and the position in the AgentCustomerUserAddressBook
result screen.

この設定は無効化することはできません。
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デフォルト値:

---
Email:
- UserFirstname
- UserLastname
- UserLogin
- UserEmail
- UserCustomerID

CustomerUser::Frontend::AgentCustomerUserAddressBook###ShowColumns###SMS

Defines the shown columns and the position in the AgentCustomerUserAddressBook
result screen.

この設定は無効化することはできません。

デフォルト値:

---
- UserFirstname
- UserLastname
- UserLogin
- UserMobile
- UserCustomerID

117. Frontend → Agent → View →
Dashboard

AgentCustomerInformationCenter::Backend###0600-CIC-
CustomerCompanyInformation

Parameters for the dashboard backend of the customer company information of the
agent interface. "Group" is used to restrict the access to the plugin (e. g. Group:
admin;group1;group2;). "Default" determines if the plugin is enabled by default or if
the user needs to enable it manually. "CacheTTLLocal" is the cache time in minutes
for the plugin.

デフォルト値:

---
Attributes: ''
Block: ContentSmall
Default: '1'
Description: Customer Information
Group: ''
Module: Kernel::Output::HTML::Dashboard::CustomerCompanyInformation
Title: Customer Information

AgentCustomerUserInformationCenter::Backend###0100-CUIC-
CustomerUserInformation

Parameters for the dashboard backend of the customer user information of the
agent interface. "Group" is used to restrict the access to the plugin (e. g. Group:
admin;group1;group2;). "Default" determines if the plugin is enabled by default or if
the user needs to enable it manually. "CacheTTLLocal" is the cache time in minutes
for the plugin.

デフォルト値:

---
Attributes: ''
Block: ContentSmall
Default: '1'
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Description: Customer User Information
Group: ''
Module: Kernel::Output::HTML::Dashboard::CustomerUserInformation
Title: Customer User Information

AgentCustomerUserInformationCenter::Backend###0600-CUIC-
CustomerCompanyInformation

Parameters for the dashboard backend of the customer company information of the
agent interface. "Group" is used to restrict the access to the plugin (e. g. Group:
admin;group1;group2;). "Default" determines if the plugin is enabled by default or if
the user needs to enable it manually. "CacheTTLLocal" is the cache time in minutes
for the plugin.

デフォルト値:

---
Attributes: ''
Block: ContentSmall
Default: '1'
Description: Customer Information
Group: ''
Module: Kernel::Output::HTML::Dashboard::CustomerCompanyInformation
Title: Customer Information

DashboardBackend###0000-ProductNotify

Defines the parameters for the dashboard backend. "Group" is used to restrict access
to the plugin (e. g. Group: admin;group1;group2;). "Default" indicates if the plugin is
enabled by default or if the user needs to enable it manually. "CacheTTLLocal" defines
the cache expiration period in minutes for the plugin. "Mandatory" determines if the
plugin is always shown and can not be removed by agents.

デフォルト値:

---
Block: ContentLarge
CacheTTLLocal: '1440'
Default: '1'
Description: News about OTRS releases!
Group: admin
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::ProductNotify
Title: Product News

DashboardBackend###0100-TicketPendingReminder

Parameters for the dashboard backend of the ticket pending reminder overview of the
agent interface . "Limit" is the number of entries shown by default. "Group" is used
to restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. "Mandatory" determines
if the plugin is always shown and can not be removed by agents. Note: Only Ticket
attributes and Dynamic Fields (DynamicField_NameX) are allowed for DefaultColumns.

デフォルト値:

---
Attributes: TicketPendingTimeOlderMinutes=1;StateType=pending
 reminder;SortBy=PendingTime;OrderBy=Down;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
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  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All tickets with a reminder set where the reminder date has been reached
Filter: Locked
Group: ''
Limit: '10'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: rw
Time: UntilTime
Title: Reminder Tickets

DashboardBackend###0110-TicketEscalation

Parameters for the dashboard backend of the ticket escalation overview of the
agent interface . "Limit" is the number of entries shown by default. "Group" is used
to restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. "Mandatory" determines
if the plugin is always shown and can not be removed by agents. Note: Only Ticket
attributes and Dynamic Fields (DynamicField_NameX) are allowed for DefaultColumns.

デフォルト値:

---
Attributes: TicketEscalationTimeOlderMinutes=1;SortBy=EscalationTime;OrderBy=Down;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
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  Type: '1'
Description: All escalated tickets
Filter: All
Group: ''
Limit: '10'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: rw
Time: EscalationTime
Title: Escalated Tickets

DashboardBackend###0120-TicketNew

Parameters for the dashboard backend of the new tickets overview of the agent
interface. "Limit" is the number of entries shown by default. "Group" is used to restrict
the access to the plugin (e. g. Group: admin;group1;group2;). "Default" determines
if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. "Mandatory" determines
if the plugin is always shown and can not be removed by agents. Note: Only Ticket
attributes and Dynamic Fields (DynamicField_NameX) are allowed for DefaultColumns.

デフォルト値:

---
Attributes: StateType=new;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All new tickets, these tickets have not been worked on yet
Filter: All
Group: ''
Limit: '10'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: rw
Time: Age
Title: New Tickets

DashboardBackend###0130-TicketOpen

Parameters for the dashboard backend of the open tickets overview of the agent
interface. "Limit" is the number of entries shown by default. "Group" is used to restrict
the access to the plugin (e. g. Group: admin;group1;group2;). "Default" determines
if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. "Mandatory" determines
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if the plugin is always shown and can not be removed by agents. Note: Only Ticket
attributes and Dynamic Fields (DynamicField_NameX) are allowed for DefaultColumns.

デフォルト値:

---
Attributes: StateType=open;
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '1'
DefaultColumns:
  Age: '2'
  Changed: '1'
  Created: '1'
  CustomerCompanyName: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  EscalationResponseTime: '1'
  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All open tickets, these tickets have already been worked on.
Filter: All
Group: ''
Limit: '10'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: rw
Time: Age
Title: Open Tickets

DashboardBackend###0140-RunningTicketProcess

Parameters for the dashboard backend of the running process tickets overview of the
agent interface . "Limit" is the number of entries shown by default. "Group" is used
to restrict the access to the plugin (e. g. Group: admin;group1;group2;). "Default"
determines if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. "Mandatory" determines
if the plugin is always shown and can not be removed by agents.

デフォルト値:

---
Attributes: StateType=new;StateType=open;StateType=pending reminder;StateType=pending
  auto
Block: ContentLarge
CacheTTLLocal: '0.5'
Default: '0'
DefaultColumns:
  Age: '2'
  Changed: '1'
  CustomerID: '1'
  CustomerName: '1'
  CustomerUserID: '1'
  DynamicField_ProcessManagementActivityID: '2'
  DynamicField_ProcessManagementProcessID: '2'
  EscalationResponseTime: '1'

648



  EscalationSolutionTime: '1'
  EscalationTime: '1'
  EscalationUpdateTime: '1'
  Lock: '1'
  Owner: '1'
  PendingTime: '1'
  Priority: '1'
  Queue: '1'
  Responsible: '1'
  SLA: '1'
  Service: '1'
  State: '1'
  TicketNumber: '2'
  Title: '2'
  Type: '1'
Description: All tickets with a reminder set where the reminder date has been reached
Group: ''
IsProcessWidget: '1'
Limit: '10'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::TicketGeneric
Permission: rw
Time: UntilTime
Title: Running Process Tickets

DashboardBackend###0200-Image

Defines the parameters for the dashboard backend. "Group" is used to restrict access
to the plugin (e. g. Group: admin;group1;group2;). "Default" indicates if the plugin is
enabled by default or if the user needs to enable it manually. "CacheTTL" indicates
the cache expiration period in minutes for the plugin. "Mandatory" determines if the
plugin is always shown and can not be removed by agents.

この設定は標準では有効ではありません。

デフォルト値:

---
Block: ContentLarge
Default: '1'
Description: Some picture description!
Group: ''
Height: '140'
Link: http://otrs.org/
LinkTitle: http://otrs.org/
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::Image
Title: A picture
URL: http://www.otrs.com/wp-uploads//2013/10/OTRS_Logo-300x170.png
Width: '198'

DashboardBackend###0210-MOTD

Shows the message of the day (MOTD) in the agent dashboard. "Group" is used to
restrict access to the plugin (e. g. Group: admin;group1;group2;). "Default" indicates if
the plugin is enabled by default or if the user needs to enable it manually. "Mandatory"
determines if the plugin is always shown and can not be removed by agents.

この設定は標準では有効ではありません。

デフォルト値:

---
Block: ContentLarge
Default: '1'
Group: ''
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::MOTD
Title: Message of the Day
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DashboardBackend###0250-TicketStats

Parameters for the dashboard backend of the ticket stats of the agent interface. "Limit"
is the number of entries shown by default. "Group" is used to restrict the access to
the plugin (e. g. Group: admin;group1;group2;). "Default" determines if the plugin is
enabled by default or if the user needs to enable it manually. "CacheTTLLocal" is the
cache time in minutes for the plugin. "Mandatory" determines if the plugin is always
shown and can not be removed by agents.

デフォルト値:

---
Block: ContentSmall
CacheTTLLocal: '30'
Changed: '1'
Closed: '1'
Default: '1'
Group: ''
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::TicketStatsGeneric
Permission: rw
Title: 7 Day Stats

DashboardBackend###0260-TicketCalendar

Parameters for the dashboard backend of the upcoming events widget of the agent
interface. "Limit" is the number of entries shown by default. "Group" is used to restrict
the access to the plugin (e. g. Group: admin;group1;group2;). "Default" determines
if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. "Mandatory" determines
if the plugin is always shown and can not be removed by agents.

デフォルト値:

---
Block: ContentSmall
CacheTTL: '2'
Default: '1'
Group: ''
Limit: '6'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::Calendar
OwnerOnly: ''
Permission: rw
Title: Upcoming Events

DashboardBackend###0270-TicketQueueOverview

Parameters for the dashboard backend of the queue overview widget of the
agent interface. "Group" is used to restrict the access to the plugin (e. g. Group:
admin;group1;group2;). "QueuePermissionGroup" is not mandatory, queues are only
listed if they belong to this permission group if you enable it. "States" is a list of states,
the key is the sort order of the state in the widget. "Default" determines if the plugin
is enabled by default or if the user needs to enable it manually. "CacheTTLLocal" is the
cache time in minutes for the plugin. "Mandatory" determines if the plugin is always
shown and can not be removed by agents.

デフォルト値:

---
Block: ContentLarge
CacheTTLLocal: '2'
Default: '1'
Description: Provides a matrix overview of the tickets per state per queue
Group: ''
Mandatory: '0'
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Module: Kernel::Output::HTML::Dashboard::TicketQueueOverview
Permission: rw
QueuePermissionGroup: ''
Sort: SortBy=Age;OrderBy=Up
States:
  '1': new
  '4': open
  '6': pending reminder
Title: Ticket Queue Overview

DashboardBackend###0280-DashboardEventsTicketCalendar

Parameters for the dashboard backend of the ticket events calendar of the agent
interface. "Limit" is the number of entries shown by default. "Group" is used to restrict
the access to the plugin (e. g. Group: admin;group1;group2;). "Default" determines
if the plugin is enabled by default or if the user needs to enable it manually.
"CacheTTLLocal" is the cache time in minutes for the plugin. "Mandatory" determines
if the plugin is always shown and can not be removed by agents.

デフォルト値:

---
Block: ContentLarge
CacheTTL: '0'
Default: '0'
Group: ''
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::EventsTicketCalendar
Title: Events Ticket Calendar

DashboardBackend###0300-IFrame

Defines the parameters for the dashboard backend. "Group" is used to restrict access
to the plugin (e. g. Group: admin;group1;group2;). "Default" indicates if the plugin is
enabled by default or if the user needs to enable it manually. "CacheTTL" indicates
the cache expiration period in minutes for the plugin. "Mandatory" determines if the
plugin is always shown and can not be removed by agents.

この設定は標準では有効ではありません。

デフォルト値:

---
Align: left
Block: ContentLarge
Default: '1'
Description: Some description!
Frameborder: '1'
Group: ''
Height: '800'
Link: http://otrs.org/
LinkTitle: OTRS.org/
Mandatory: '0'
Marginheight: '5'
Marginwidth: '5'
Module: Kernel::Output::HTML::Dashboard::IFrame
Scrolling: auto
Title: A Website
URL: http://www.otrs.org/
Width: '1024'

DashboardBackend###0390-UserOutOfOffice

Defines the parameters for the dashboard backend. "Limit" defines the number of
entries displayed by default. "Group" is used to restrict access to the plugin (e.
g. Group: admin;group1;group2;). "Default" indicates if the plugin is enabled by
default or if the user needs to enable it manually. "CacheTTLLocal" defines the cache
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expiration period in minutes for the plugin. "Mandatory" determines if the plugin is
always shown and can not be removed by agents.

デフォルト値:

---
Block: ContentSmall
CacheTTLLocal: '5'
Default: '1'
Description: Out of Office users.
Group: ''
Limit: '10'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::UserOutOfOffice
SortBy: UserFullname
Title: Out Of Office

DashboardBackend###0398-FAQ-LastChange

ダッシュボードのバックエンドパラメータを定義。「Limit リミット」は標準で表示されるエ
ントリーを定義します。「Group グループ」はプラグインへのアクセスを制限します。(例.
Group: admin;group1;group2)。「Default　デフォルト」はプラグインが標準で有効になって
いるか、ユーザーが手動で有効にする必要があるかを定義します。

デフォルト値:

---
Block: ContentSmall
Default: '1'
Description: ''
Group: ''
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::FAQ
Title: Latest updated FAQ articles
Type: LastChange

DashboardBackend###0399-FAQ-LastCreate

ダッシュボードのバックエンドパラメータを定義。「Limit リミット」は標準で表示されるエ
ントリーを定義します。「Group グループ」はプラグインへのアクセスを制限します。(例.
Group: admin;group1;group2)。「Default　デフォルト」はプラグインが標準で有効になって
いるか、ユーザーが手動で有効にする必要があるかを定義します。

デフォルト値:

---
Block: ContentSmall
Default: '1'
Description: ''
Group: ''
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::FAQ
Title: Latest created FAQ articles
Type: LastCreate

DashboardBackend###0400-UserOnline

Defines the parameters for the dashboard backend. "Limit" defines the number of
entries displayed by default. "Group" is used to restrict access to the plugin (e.
g. Group: admin;group1;group2;). "Default" indicates if the plugin is enabled by
default or if the user needs to enable it manually. "CacheTTLLocal" defines the cache
expiration period in minutes for the plugin. "Mandatory" determines if the plugin is
always shown and can not be removed by agents.

デフォルト値:

---
Block: ContentSmall
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CacheTTLLocal: '5'
Default: '0'
Description: Logged in users.
Filter: Agent
Group: ''
Limit: '10'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::UserOnline
ShowEmail: '0'
SortBy: UserFullname
Title: Logged-In Users

DashboardBackend###0405-News

Defines the parameters for the dashboard backend. "Limit" defines the number of
entries displayed by default. "Group" is used to restrict access to the plugin (e. g.
Group: admin;group1;group2;). "Default" indicates if the plugin is enabled by default
or if the user needs to enable it manually. "CacheTTL" indicates the cache expiration
period in minutes for the plugin. "Mandatory" determines if the plugin is always shown
and can not be removed by agents.

デフォルト値:

---
Block: ContentSmall
CacheTTL: '360'
Default: '1'
Description: News about OTRS.
Group: ''
Limit: '6'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::News
Title: OTRS News

DashboardBackend###0410-RSS

Defines the parameters for the dashboard backend. "Limit" defines the number of
entries displayed by default. "Group" is used to restrict access to the plugin (e. g.
Group: admin;group1;group2;). "Default" indicates if the plugin is enabled by default
or if the user needs to enable it manually. "CacheTTL" indicates the cache expiration
period in minutes for the plugin. "Mandatory" determines if the plugin is always shown
and can not be removed by agents.

この設定は標準では有効ではありません。

デフォルト値:

---
Block: ContentSmall
CacheTTL: '360'
Default: '1'
Description: Custom RSS feed.
Group: ''
Limit: '6'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::RSS
Title: Custom RSS Feed
URL: http://www.otrs.com/en/rss.xml
URL_de: http://www.otrs.com/de/rss.xml
URL_es: http://www.otrs.com/es/rss.xml
URL_nl: http://www.otrs.com/nl/rss.xml
URL_ru: http://www.otrs.com/ru/rss.xml
URL_zh: http://www.otrs.com/cn/rss.xml

DashboardBackend###0420-CmdOutput

Defines the parameters for the dashboard backend. "Cmd" is used to specify command
with parameters. "Group" is used to restrict access to the plugin (e. g. Group:
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admin;group1;group2;). "Default" indicates if the plugin is enabled by default or if the
user needs to enable it manually. "CacheTTL" indicates the cache expiration period
in minutes for the plugin. "Mandatory" determines if the plugin is always shown and
can not be removed by agents.

この設定は標準では有効ではありません。

デフォルト値:

---
Block: ContentSmall
CacheTTL: '60'
Cmd: /bin/echo Configure me please.
Default: '0'
Description: Show command line output.
Group: ''
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::CmdOutput
Title: Sample command output

DashboardBackend###0500-AppointmentCalendar

Defines the parameters for the dashboard backend. "Limit" defines the number of
entries displayed by default. "Group" is used to restrict access to the plugin (e.
g. Group: admin;group1;group2;). "Default" indicates if the plugin is enabled by
default or if the user needs to enable it manually. "CacheTTLLocal" defines the cache
expiration period in minutes for the plugin. "Mandatory" determines if the plugin is
always shown and can not be removed by agents.

デフォルト値:

---
Block: ContentSmall
CacheTTLLocal: '5'
Default: '0'
Description: Appointments
Filter: Today
Group: ''
IdleMinutes: '60'
Limit: '10'
Mandatory: '0'
Module: Kernel::Output::HTML::Dashboard::AppointmentCalendar
ShowEmail: '0'
SortBy: UserFullname
Title: Appointments

118. Frontend → Agent → View →
Dashboard → EventsTicketCalendar

DashboardEventsTicketCalendar###CalendarWidth

カレンダの幅をパーセントで定義します。デフォルトは95%です。

この設定は無効化することはできません。

デフォルト値:

--- '95'

DashboardEventsTicketCalendar###Queues

Defines queues that's tickets are used for displaying as calendar events.

この設定は無効化することはできません。
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デフォルト値:

---
- Raw

DashboardEventsTicketCalendar::DynamicFieldEndTime

Define dynamic field name for end time. This field has to be manually added to the
system as Ticket: "Date / Time" and must be activated in ticket creation screens and/
or in any other ticket action screens.

デフォルト値:

--- TicketCalendarEndTime

DashboardEventsTicketCalendar::DynamicFieldStartTime

Define dynamic field name for start time. This field has to be manually added to the
system as Ticket: "Date / Time" and must be activated in ticket creation screens and/
or in any other ticket action screens.

デフォルト値:

--- TicketCalendarStartTime

DashboardEventsTicketCalendar::DynamicFieldsForEvents

カレンダ・イベントで表示するダイナミック・フィールドを定義します。

この設定は無効化することはできません。

デフォルト値:

---
- TicketCalendarStartTime
- TicketCalendarEndTime

DashboardEventsTicketCalendar::TicketFieldsForEvents

Defines the ticket fields that are going to be displayed calendar events. The "Key"
defines the field or ticket attribute and the "Content" defines the display name.

この設定は無効化することはできません。

デフォルト値:

---
CustomerID: Customer ID
CustomerUserID: Customer user
Priority: Priority
Queue: Queue
SLA: SLA
Service: Service
State: State
Title: Title
Type: Type

119. Frontend → Agent → View →
Dashboard → TicketFilters

OnlyValuesOnTicket

Defines if the values for filters should be retrieved from all available tickets. If enabled,
only values which are actually used in any ticket will be available for filtering. Please
note: The list of customers will always be retrieved like this.
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この設定は無効化することはできません。

デフォルト値:

--- '1'

120. Frontend → Agent → View →
FAQAdd

FAQ::Frontend::AgentFAQAdd###DynamicField

担当者インターフェイス の FAQ 追加画面に表示する ダイナミック・フィールド

デフォルト値:

--- {}

FAQ::Frontend::AgentFAQAdd###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '320'

FAQ::Frontend::AgentFAQAdd###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '620'

121. Frontend → Agent → View →
FAQEdit

FAQ::Frontend::AgentFAQEdit###DynamicField

担当者インターフェイス の FAQ 編集画面に表示する ダイナミック・フィールド

デフォルト値:

--- {}

FAQ::Frontend::AgentFAQEdit###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '320'

FAQ::Frontend::AgentFAQEdit###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).
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デフォルト値:

--- '620'

122. Frontend → Agent → View →
FAQExplorer

FAQ::Frontend::AgentFAQExplorer###Order::Default

担当者インターフェイスにおける、FAQ一覧の表示順の既定値を定義します。Up: 古い順 /
Down: 新しい順

この設定は無効化することはできません。

デフォルト値:

--- Down

FAQ::Frontend::AgentFAQExplorer###SearchLimit

担当者インターフェイスのFAQ一覧で表示する記事の最大数

この設定は無効化することはできません。

デフォルト値:

--- '200'

FAQ::Frontend::AgentFAQExplorer###ShowColumns

担当者画面における、FAQ一覧での表示項目の設定。この設定によって項目の並び順を制御す
ることはできません。

この設定は無効化することはできません。

デフォルト値:

---
Category: '0'
Changed: '0'
Language: '1'
State: '1'
Title: '1'
Valid: '1'

FAQ::Frontend::AgentFAQExplorer###ShowInvalidFAQItems

Show invalid items in the FAQ Explorer result of the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- 0

FAQ::Frontend::AgentFAQExplorer###SortBy::Default

担当者インターフェイス（FAQ一覧）における、FAQ検索結果並び替えに利用する属性順の既
定値を定義します。

この設定は無効化することはできません。

デフォルト値:
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--- FAQID

FAQ::Frontend::AgentFAQExplorer###TitleSize

担当者インターフェイスのFAQ Explorerで表示される件名のFAQ記事の最大サイズ

この設定は標準では有効ではありません。

デフォルト値:

--- '50'

123. Frontend → Agent → View →
FAQJournal

FAQ::Frontend::AgentFAQJournal###JournalLimit

担当者インターフェイスのFAQジャーナルで表示する記事の最大数

この設定は無効化することはできません。

デフォルト値:

--- '200'

FAQ::Frontend::AgentFAQJournal###ShowColumns

顧客用画面における、FAQ一覧での表示項目の設定。この設定によって項目の並び順を制御す
ることはできません。

この設定は無効化することはできません。

デフォルト値:

---
Category: '1'
Name: '1'
Time: '1'
Title: '1'
Valid: '1'

FAQ::Frontend::AgentFAQJournal###TitleSize

担当者インターフェイスのFAQ ジャーナルで表示される件名のFAQ記事の最大サイズ

この設定は標準では有効ではありません。

デフォルト値:

--- '50'

124. Frontend → Agent → View →
FAQPrint

FAQ::Frontend::AgentFAQPrint###DynamicField

担当者インターフェイス の FAQ 印刷画面に表示する ダイナミック・フィールド

デフォルト値:

--- {}
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125. Frontend → Agent → View →
FAQSearch

FAQ::Frontend::AgentFAQSearch###Defaults###ApprovedSearch

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###CategoryIDs

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###CreatedUserIDs

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###Fulltext

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###ItemChangeTimePoint

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###ItemChangeTimeSlot

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###ItemCreateTimePoint

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。
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この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###ItemCreateTimeSlot

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###Keyword

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###LanguageIDs

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###LastChangedUserIDs

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###Number

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###RateSearchType

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''
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FAQ::Frontend::AgentFAQSearch###Defaults###StateIDs

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###Title

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###ValidIDs

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###Defaults###VoteSearchType

FAQ 検索画面に表示されるFAQ 検索属性のデフォルト値を定義する。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

FAQ::Frontend::AgentFAQSearch###DynamicField

担当者インターフェイス の FAQ 検索画面に表示する ダイナミック・フィールド

デフォルト値:

--- {}

FAQ::Frontend::AgentFAQSearch###Order::Default

担当者インターフェイス（FAQ一覧）における、FAQ検索結果並び順の既定値を定義しま
す。Up: 古い順 / Down: 新しい順

この設定は無効化することはできません。

デフォルト値:

--- Down

FAQ::Frontend::AgentFAQSearch###SearchCSVDynamicField

検索結果をCSVフォーマットでエクスポートする際に利用するダイナミック・フィールドで
す。

デフォルト値:
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--- {}

FAQ::Frontend::AgentFAQSearch###SearchLimit

検索結果として担当者インターフェイスで表示されるFAQ項目の最大数

この設定は無効化することはできません。

デフォルト値:

--- '200'

FAQ::Frontend::AgentFAQSearch###ShowColumns

公開画面における、FAQ一覧での表示項目の設定。この設定によって項目の並び順を制御する
ことはできません。

この設定は無効化することはできません。

デフォルト値:

---
Category: '1'
Changed: '1'
Language: '1'
State: '1'
Title: '1'
Valid: '1'

FAQ::Frontend::AgentFAQSearch###SortBy::Default

担当者インターフェイスにおける、FAQ検索結果並び替えに利用する属性順の既定値を定義し
ます。

この設定は無効化することはできません。

デフォルト値:

--- FAQID

FAQ::Frontend::AgentFAQSearch###TitleSize

担当者インターフェイスのFAQ 検索で表示される件名のFAQ記事の最大サイズ

この設定は標準では有効ではありません。

デフォルト値:

--- '50'

126. Frontend → Agent → View →
FAQZoom

FAQ::Frontend::AgentFAQZoom###DynamicField

Dynamic fields shown in the FAQ zoom screen of the agent interface.

デフォルト値:

--- {}

FAQ::Frontend::AgentHTMLFieldHeightDefault

AgentFAQZoomで表示されるインラインHTMLのデフォルト高さ(ピクセル表記)を設定
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この設定は無効化することはできません。

デフォルト値:

--- '100'

FAQ::Frontend::AgentHTMLFieldHeightMax

AgentFAQZoomで表示されるインラインHTMLの最大の高さ(ピクセル表記)を設定

この設定は無効化することはできません。

デフォルト値:

--- '2500'

127. Frontend → Agent → View →
FAQZoom → MenuModule

FAQ::Frontend::MenuModule###000-Back

担当者インターフェイスのズームビューで「戻る」のリンクを表示する。

デフォルト値:

---
Action: ''
Description: Back
Link: '[% Env("LastScreenOverview") %]'
Module: Kernel::Output::HTML::FAQMenu::Generic
Name: Back
Target: Back

FAQ::Frontend::MenuModule###010-Edit

担当者インターフェイスのズームビューでFAQ編集のリンクを表示する。

デフォルト値:

---
Action: AgentFAQEdit
Description: Edit this FAQ
Link: Action=AgentFAQEdit;ItemID=[% Data.ItemID | html %];ScreenType=Popup
Module: Kernel::Output::HTML::FAQMenu::Generic
Name: Edit
Target: PopUp

FAQ::Frontend::MenuModule###020-History

担当者インターフェイスのズームビューでFAQの履歴のリンクを表示する。

デフォルト値:

---
Action: AgentFAQHistory
Description: History of this FAQ
Link: Action=AgentFAQHistory;ItemID=[% Data.ItemID | html %]
Module: Kernel::Output::HTML::FAQMenu::Generic
Name: History
Target: PopUp

FAQ::Frontend::MenuModule###030-Print

担当者インターフェイスのズームビューでFAQを印刷リンクを表示する。

デフォルト値:
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---
Action: AgentFAQPrint
Description: Print this FAQ
Link: Action=AgentFAQPrint;ItemID=[% Data.ItemID | html %]
LinkParam: target="print_FAQ"
Module: Kernel::Output::HTML::FAQMenu::Generic
Name: Print
Target: PopUp

FAQ::Frontend::MenuModule###040-Link

担当者インタフェースなどのズーム・ビューで、FAQを他のオブジェクトとリンクさせるリン
クをメニューに表示します。

デフォルト値:

---
Action: AgentLinkObject
Description: Link another object to this FAQ item
Link: Action=AgentLinkObject;SourceObject=FAQ;SourceKey=[% Data.ItemID | html %]
Module: Kernel::Output::HTML::FAQMenu::Generic
Name: Link
Target: PopUp

FAQ::Frontend::MenuModule###050-Delete

担当者インターフェイスのズームビューでFAQ削除のリンクを表示する。

デフォルト値:

---
Action: AgentFAQDelete
Description: Delete this FAQ
Link: Action=AgentFAQDelete;ItemID=[% Data.ItemID | html %]
Module: Kernel::Output::HTML::FAQMenu::Delete
Name: Delete
Target: ConfirmationDialog

128. Frontend → Agent → View →
LinkObject

Frontend::AgentLinkObject::WildcardSearch

Starts a wildcard search of the active object after the link object mask is started.

この設定は無効化することはできません。

デフォルト値:

--- 0

129. Frontend → Agent → View →
NotificationView

Notification::Transport::NotificationView::DaysToKeep

Defines the number of days a notification should be still shown in the notification web
view screen (value of '0' means always show).

デフォルト値:

--- '30'
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NotificationView::Frontend::AgentNotificationView###DefaultColumns

Columns that can be filtered in the notification web view of the agent interface.

この設定は無効化することはできません。

デフォルト値:

---
Age: '2'
Name: '2'
ObjectReference: '2'
ObjectType: '2'
Subject: '2'

NotificationView::Frontend::BulkFeature

Enables notification web view bulk action feature for the agent frontend to work on
more than one notification at a time.

この設定は無効化することはできません。

デフォルト値:

--- '1'

NotificationView::Frontend::BulkFeatureGroup

Enables notification web view bulk action feature only for the listed groups.

この設定は標準では有効ではありません。

デフォルト値:

---
- admin
- users

NotificationView::Frontend::Overview###Small

Allows having a small format notification web view.

デフォルト値:

---
Module: Kernel::Output::HTML::NotificationView::Small
ModulePriority: '100'
Name: Small
NameShort: S

NotificationView::ObjectType###Appointment

Defines the settings for appointment notification.

デフォルト値:

---
FilterPrio: '1020'
Hook: '[% Translate("Appointment") | html %]:'
Link: Action=AgentAppointmentCalendarOverview;AppointmentID=[% Data.ObjectID | html
  %]
Name: Appointment Notifications

NotificationView::ObjectType###Calendar

Defines the settings for calendar notification.

デフォルト値:
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---
FilterPrio: '1030'
Hook: '[% Translate("Calendar") | html %]:'
Link: Action=AgentAppointmentCalendarManage;Subaction=Edit;CalendarID=[% Data.ObjectID
  | html %]
Name: Calendar Notifications

NotificationView::ObjectType###Ticket

Defines the settings for ticket notification.

デフォルト値:

---
FilterPrio: '1010'
Hook: '[% Config("Ticket::Hook") | html %]'
Link: Action=AgentTicketZoom;TicketID=[% Data.ObjectID | html %]
Name: Ticket Notifications

130. Frontend → Agent → View →
Preferences

AgentPreferencesGroups

Defines groups for preferences items.

この設定は無効化することはできません。

デフォルト値:

---
- Description: Change your password and more.
  Icon: fa-user
  Key: UserProfile
  Name: User Profile
  Prio: '1000'
- Description: Choose which notifications you'd like to receive.
  Icon: fa-envelope
  Key: NotificationSettings
  Name: Notification Settings
  Prio: '1001'
- Description: Change the system appearance and more.
  Icon: fa-cog
  Key: Miscellaneous
  Name: Miscellaneous
  Prio: '1002'
- Description: For more experienced users.
  Icon: fa-cubes
  Key: Advanced
  Name: Advanced
  Prio: '1003'

PreferencesGroups###AppointmentNotificationEvent

Transport selection for appointment notifications. Please note: setting 'Active' to 0 will
only prevent agents from editing settings of this group in their personal preferences,
but will still allow administrators to edit the settings of another user's behalf. Use
'PreferenceGroup' to control in which area these settings should be shown in the user
interface.

デフォルト値:

---
Active: '1'
Desc: Choose for which kind of appointment changes you want to receive notifications.
Label: Appointment notifications
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Module: Kernel::Output::HTML::Preferences::AppointmentNotificationEvent
PrefKey: AdminAppointmentNotifcationEventTransport
PreferenceGroup: NotificationSettings
Prio: '8001'

PreferencesGroups###Avatar

Defines the users avatar. Please note: setting 'Active' to 0 will only prevent agents
from editing settings of this group in their personal preferences, but will still allow
administrators to edit the settings of another user's behalf. Use 'PreferenceGroup' to
control in which area these settings should be shown in the user interface.

デフォルト値:

---
Active: '1'
Block: Avatar
Desc: Change your avatar image.
Key: Avatar
Label: Avatar
Module: Kernel::Output::HTML::Preferences::Avatar
PreferenceGroup: UserProfile
Prio: '1000'

PreferencesGroups###CSVSeparator

Gives end users the possibility to override the separator character for CSV files,
defined in the translation files. Please note: setting 'Active' to 0 will only prevent
agents from editing settings of this group in their personal preferences, but
will still allow administrators to edit the settings of another user's behalf. Use
'PreferenceGroup' to control in which area these settings should be shown in the user
interface.

この設定は標準では有効ではありません。

デフォルト値:

---
Active: '1'
Data:
  '': ''
  ',': ','
  ;: ;
  \t: tab
  '|': '|'
DataSelected: '0'
Desc: Select the separator character used in CSV files (stats and searches). If you
  don't select a separator here, the default separator for your language will be used.
Key: CSV Separator
Label: CSV Separator
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserCSVSeparator
PreferenceGroup: Miscellaneous
Prio: '4000'

PreferencesGroups###Comment

Defines the config parameters of this item, to be shown in the preferences view. Please
note: setting 'Active' to 0 will only prevent agents from editing settings of this group
in their personal preferences, but will still allow administrators to edit the settings of
another user's behalf. Use 'PreferenceGroup' to control in which area these settings
should be shown in the user interface.

デフォルト値:

---
Active: '0'
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Block: Input
Data: '[% Env("UserComment") %]'
Desc: This is a Description for Comment on Framework.
Key: Comment
Label: Comment
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserComment
PreferenceGroup: Miscellaneous
Prio: '6000'

PreferencesGroups###CommunicationLogPageShown

Parameters for the pages (in which the communication log entries are shown) of the
communication log overview.

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
  '50': '50'
DataSelected: '25'
Desc: Communication log limit per page for Communication Log Overview.
Key: ''
Label: CommunicationLog Overview Limit
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: AdminCommunicationLogPageShown
PreferenceGroup: Miscellaneous
Prio: '8100'

PreferencesGroups###CreateNextMask

Parameters for the CreateNextMask object in the preference view of the agent
interface. Please note: setting 'Active' to 0 will only prevent agents from editing
settings of this group in their personal preferences, but will still allow administrators
to edit the settings of another user's behalf. Use 'PreferenceGroup' to control in which
area these settings should be shown in the user interface.

デフォルト値:

---
Active: '1'
Data:
  '0': Create Ticket
  AgentTicketZoom: Ticket Zoom
DataSelected: ''
Desc: Configure which screen should be shown after a new ticket has been created.
Key: ''
Label: Screen after new ticket
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserCreateNextMask
PreferenceGroup: Miscellaneous
Prio: '3000'

PreferencesGroups###CustomChatChannelExternal

Parameters for the ChatChannel object in the preference view of the agent interface.

デフォルト値:

---
Active: '1'
Desc: Your selection of your preferred external chat channels. You will be notified
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  about external chat requests in these chat channels.
Label: My Chat Channels
Module: Kernel::Output::HTML::Preferences::CustomChatChannel
Permission: ro
PrefKey: ExternalChannels
PreferenceGroup: NotificationSettings
Prio: '10000'

PreferencesGroups###CustomQueue

Parameters for the CustomQueue object in the preference view of the agent interface.
Please note: setting 'Active' to 0 will only prevent agents from editing settings of
this group in their personal preferences, but will still allow administrators to edit the
settings of another user's behalf. Use 'PreferenceGroup' to control in which area these
settings should be shown in the user interface.

デフォルト値:

---
Active: '1'
Desc: Your queue selection of your preferred queues. You also get notified about those
  queues via email if enabled.
Key: ''
Label: My Queues
Module: Kernel::Output::HTML::Preferences::CustomQueue
Permission: ro
PreferenceGroup: NotificationSettings
Prio: '1000'

PreferencesGroups###CustomService

Parameters for the CustomService object in the preference view of the agent interface.
Please note: setting 'Active' to 0 will only prevent agents from editing settings of
this group in their personal preferences, but will still allow administrators to edit the
settings of another user's behalf. Use 'PreferenceGroup' to control in which area these
settings should be shown in the user interface.

デフォルト値:

---
Active: '1'
Desc: Your service selection of your preferred services. You also get notified about
  those services via email if enabled.
Key: ''
Label: My Services
Module: Kernel::Output::HTML::Preferences::CustomService
PreferenceGroup: NotificationSettings
Prio: '1000'

PreferencesGroups###DocumentSearchPageShown

Parameters for the pages (in which the document are shown) of the document search.

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
  '50': '50'
DataSelected: '10'
Desc: Document limit per page for Document Search Results.
Key: ''
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Label: Document Search Results Page Limit
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: AgentDocumentSearchPageShown
PreferenceGroup: Miscellaneous
Prio: '8100'

PreferencesGroups###DynamicField

Defines the config parameters of this item, to be shown in the preferences view. Please
note: setting 'Active' to 0 will only prevent agents from editing settings of this group
in their personal preferences, but will still allow administrators to edit the settings of
another user's behalf. Use 'PreferenceGroup' to control in which area these settings
should be shown in the user interface.

この設定は標準では有効ではありません。

デフォルト値:

---
Active: '1'
Block: Input
Data: '[% Env("UserDynamicField_NameX") %]'
Desc: This is a Description for DynamicField on Framework.
Key: Default value for NameX
Label: NameX
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserDynamicField_NameX
PreferenceGroup: Miscellaneous
Prio: '7000'

PreferencesGroups###DynamicFieldsOverviewPageShown

Parameters for the pages (in which the dynamic fields are shown) of the dynamic
fields overview. Please note: setting 'Active' to 0 will only prevent agents from editing
settings of this group in their personal preferences, but will still allow administrators
to edit the settings of another user's behalf. Use 'PreferenceGroup' to control in which
area these settings should be shown in the user interface.

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
DataSelected: '25'
Desc: Dynamic fields limit per page for Dynamic Fields Overview.
Key: ''
Label: Dynamic Fields Overview Limit
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: AdminDynamicFieldsOverviewPageShown
PreferenceGroup: Miscellaneous
Prio: '8000'

PreferencesGroups###FAQJournalOverviewSmallPageShown

簡易版FAQジャーナル一覧のページ指定用のパラメータ

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
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  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
DataSelected: '25'
Desc: Select how many items should be shown in Journal Overview "Small" by default.
Key: Limit.
Label: FAQ Journal Overview "Small" Limit
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserFAQJournalOverviewSmallPageShown
PreferenceGroup: Miscellaneous
Prio: '8000'

PreferencesGroups###FAQOverviewSmallPageShown

簡易版FAQ概要のページ指定用のパラメータ

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
DataSelected: '25'
Desc: Select how many items should be shown in Overview "Small" by default.
Key: Limit.
Label: FAQ Overview "Small" Limit
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserFAQOverviewSmallPageShown
PreferenceGroup: Miscellaneous
Prio: '8000'

PreferencesGroups###GoogleAuthenticatorSecretKey

Defines the config parameters of this item, to be shown in the preferences view. Please
note: setting 'Active' to 0 will only prevent agents from editing settings of this group
in their personal preferences, but will still allow administrators to edit the settings of
another user's behalf. Use 'PreferenceGroup' to control in which area these settings
should be shown in the user interface.

デフォルト値:

---
Active: '0'
Block: Input
Desc: Enter your shared secret to enable two factor authentication.
Key: Shared Secret
Label: Google Authenticator
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserGoogleAuthenticatorSecretKey
PreferenceGroup: UserProfile
Prio: '0600'
ValidateRegex: ^([A-Z2-7]{16}|)$
ValidateRegexMessage: The secret you supplied is invalid. The secret must only contain
  letters (A-Z, uppercase) and numbers (2-7) and must consist of 16 characters.

PreferencesGroups###Language

Defines the config parameters of this item, to be shown in the preferences view. Please
note: setting 'Active' to 0 will only prevent agents from editing settings of this group
in their personal preferences, but will still allow administrators to edit the settings of
another user's behalf. Use 'PreferenceGroup' to control in which area these settings
should be shown in the user interface.
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デフォルト値:

---
Active: '1'
Desc: Select the main interface language.
Key: ''
Label: Language
Module: Kernel::Output::HTML::Preferences::Language
NeedsReload: '1'
PrefKey: UserLanguage
PreferenceGroup: UserProfile
Prio: '1000'

PreferencesGroups###NotificationEvent

Transport selection for ticket notifications. Please note: setting 'Active' to 0 will only
prevent agents from editing settings of this group in their personal preferences,
but will still allow administrators to edit the settings of another user's behalf. Use
'PreferenceGroup' to control in which area these settings should be shown in the user
interface.

デフォルト値:

---
Active: '1'
Desc: Choose for which kind of ticket changes you want to receive notifications. Please
  note that you can't completely disable notifications marked as mandatory.
Label: Ticket notifications
Module: Kernel::Output::HTML::Preferences::NotificationEvent
PrefKey: AdminNotifcationEventTransport
PreferenceGroup: NotificationSettings
Prio: '8000'

PreferencesGroups###NotificationViewFilterSettings

Parameters for notification web view filters.

デフォルト値:

---
Active: '0'
Desc: Column ticket filters for Notification web view type "Small".
Key: ''
Label: Enabled filters.
Module: Kernel::Output::HTML::Preferences::ColumnFilters
PrefKey: UserFilterColumnsEnabled
PreferenceGroup: Miscellaneous
Prio: '8100'

PreferencesGroups###NotificationViewSmallPageShown

Parameters for the pages (in which the notifications are shown) of the small
notifications view.

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
DataSelected: '25'
Desc: Notification limit per page for Notification web view "Small".
Key: ''
Label: Notification web view "Small" Limit
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Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserNotificationViewSmallPageShown
PreferenceGroup: Miscellaneous
Prio: '8000'

PreferencesGroups###OutOfOffice

Defines the config parameters of this item, to be shown in the preferences view. Please
note: setting 'Active' to 0 will only prevent agents from editing settings of this group
in their personal preferences, but will still allow administrators to edit the settings of
another user's behalf. Use 'PreferenceGroup' to control in which area these settings
should be shown in the user interface.

デフォルト値:

---
Active: '1'
Block: OutOfOffice
Desc: If you're going to be out of office, you may wish to let other users know by
  setting the exact dates of your absence.
Key: ''
Label: Out Of Office Time
Module: Kernel::Output::HTML::Preferences::OutOfOffice
PrefKey: UserOutOfOffice
PreferenceGroup: UserProfile
Prio: '4000'

PreferencesGroups###Password

Defines the config parameters of this item, to be shown in the preferences view.
'PasswordRegExp' allows to match passwords against a regular expression. Define the
minimum number of characters using 'PasswordMinSize'. Define if at least 2 lowercase
and 2 uppercase letter characters are needed by setting the appropriate option to
'1'. 'PasswordMin2Characters' defines if the password needs to contain at least 2
letter characters (set to 0 or 1). 'PasswordNeedDigit' controls the need of at least 1
digit (set to 0 or 1 to control). 'PasswordMaxLoginFailed' allows to set an agent to
invalid-temporarily if max failed logins reached. Please note: setting 'Active' to 0 will
only prevent agents from editing settings of this group in their personal preferences,
but will still allow administrators to edit the settings of another user's behalf. Use
'PreferenceGroup' to control in which area these settings should be shown in the user
interface.

デフォルト値:

---
Active: '1'
Area: Agent
Desc: Set a new password by filling in your current password and a new one.
Label: Change password
Module: Kernel::Output::HTML::Preferences::Password
PasswordMaxLoginFailed: '0'
PasswordMin2Characters: '0'
PasswordMin2Lower2UpperCharacters: '0'
PasswordMinSize: '0'
PasswordNeedDigit: '0'
PasswordRegExp: ''
PreferenceGroup: UserProfile
Prio: '0500'

PreferencesGroups###RefreshTime

Parameters for the RefreshTime object in the preference view of the agent interface.
Please note: setting 'Active' to 0 will only prevent agents from editing settings of
this group in their personal preferences, but will still allow administrators to edit the
settings of another user's behalf. Use 'PreferenceGroup' to control in which area these
settings should be shown in the user interface.
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デフォルト値:

---
Active: '1'
Data:
  '0': off
  '10': 10 minutes
  '15': 15 minutes
  '2': ' 2 minutes'
  '5': ' 5 minutes'
  '7': ' 7 minutes'
DataSelected: '0'
Desc: If enabled, the different overviews (Dashboard, LockedView, QueueView) will
  automatically refresh after the specified time.
Key: ''
Label: Overview Refresh Time
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserRefreshTime
PreferenceGroup: Miscellaneous
Prio: '2000'

PreferencesGroups###Skin

Defines the config parameters of this item, to be shown in the preferences view. Please
note: setting 'Active' to 0 will only prevent agents from editing settings of this group
in their personal preferences, but will still allow administrators to edit the settings of
another user's behalf. Use 'PreferenceGroup' to control in which area these settings
should be shown in the user interface.

デフォルト値:

---
Active: '1'
Desc: Select your preferred layout for the software.
Key: ''
Label: Skin
Module: Kernel::Output::HTML::Preferences::Skin
NeedsReload: '1'
PrefKey: UserSkin
PreferenceGroup: Miscellaneous
Prio: '100'

PreferencesGroups###Theme

Defines the config parameters of this item, to be shown in the preferences view. Please
note: setting 'Active' to 0 will only prevent agents from editing settings of this group
in their personal preferences, but will still allow administrators to edit the settings of
another user's behalf. Use 'PreferenceGroup' to control in which area these settings
should be shown in the user interface.

デフォルト値:

---
Active: '1'
Desc: Select your preferred theme for OTRS.
Key: ''
Label: Theme
Module: Kernel::Output::HTML::Preferences::Theme
NeedsReload: '1'
PrefKey: UserTheme
PreferenceGroup: Miscellaneous
Prio: '3000'

PreferencesGroups###TicketOverviewFilterSettings

Parameters for the column filters of the small ticket overview. Please note: setting
'Active' to 0 will only prevent agents from editing settings of this group in their personal
preferences, but will still allow administrators to edit the settings of another user's
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behalf. Use 'PreferenceGroup' to control in which area these settings should be shown
in the user interface.

デフォルト値:

---
Active: '0'
Desc: Column ticket filters for Ticket Overviews type "Small".
Key: ''
Label: Enabled filters.
Module: Kernel::Output::HTML::Preferences::ColumnFilters
PrefKey: UserFilterColumnsEnabled
PreferenceGroup: Miscellaneous
Prio: '8100'

PreferencesGroups###TicketOverviewMediumPageShown

Parameters for the pages (in which the tickets are shown) of the medium ticket
overview. Please note: setting 'Active' to 0 will only prevent agents from editing
settings of this group in their personal preferences, but will still allow administrators
to edit the settings of another user's behalf. Use 'PreferenceGroup' to control in which
area these settings should be shown in the user interface.

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
DataSelected: '20'
Desc: Ticket limit per page for Ticket Overview "Medium".
Key: ''
Label: Ticket Overview "Medium" Limit
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserTicketOverviewMediumPageShown
PreferenceGroup: Miscellaneous
Prio: '8100'

PreferencesGroups###TicketOverviewPreviewPageShown

Parameters for the pages (in which the tickets are shown) of the ticket preview
overview. Please note: setting 'Active' to 0 will only prevent agents from editing
settings of this group in their personal preferences, but will still allow administrators
to edit the settings of another user's behalf. Use 'PreferenceGroup' to control in which
area these settings should be shown in the user interface.

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
DataSelected: '15'
Desc: Ticket limit per page for Ticket Overview "Preview".
Key: ''
Label: Ticket Overview "Preview" Limit
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserTicketOverviewPreviewPageShown
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PreferenceGroup: Miscellaneous
Prio: '8200'

PreferencesGroups###TicketOverviewSmallPageShown

Parameters for the pages (in which the tickets are shown) of the small ticket overview.
Please note: setting 'Active' to 0 will only prevent agents from editing settings of
this group in their personal preferences, but will still allow administrators to edit the
settings of another user's behalf. Use 'PreferenceGroup' to control in which area these
settings should be shown in the user interface.

デフォルト値:

---
Active: '0'
Data:
  '10': '10'
  '15': '15'
  '20': '20'
  '25': '25'
  '30': '30'
  '35': '35'
DataSelected: '25'
Desc: Ticket limit per page for Ticket Overview "Small".
Key: ''
Label: Ticket Overview "Small" Limit
Module: Kernel::Output::HTML::Preferences::Generic
PrefKey: UserTicketOverviewSmallPageShown
PreferenceGroup: Miscellaneous
Prio: '8000'

PreferencesGroups###TimeZone

Defines the config parameters of this item, to be shown in the preferences view. Please
note: setting 'Active' to 0 will only prevent agents from editing settings of this group
in their personal preferences, but will still allow administrators to edit the settings of
another user's behalf. Use 'PreferenceGroup' to control in which area these settings
should be shown in the user interface.

デフォルト値:

---
Active: '1'
Desc: Select your personal time zone. All times will be displayed relative to this
  time zone.
Key: ''
Label: Time Zone
Module: Kernel::Output::HTML::Preferences::TimeZone
PrefKey: UserTimeZone
PreferenceGroup: UserProfile
Prio: '3500'

PreferencesTable

Defines the name of the table where the user preferences are stored.

この設定は無効化することはできません。

デフォルト値:

--- user_preferences

PreferencesTableKey

プレファレンス・テーブルのためのキーを格納するコラムを定義してください。

この設定は無効化することはできません。
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デフォルト値:

--- preferences_key

PreferencesTableUserID

プレファレンス・テーブルにおいてユーザ識別子を格納するためのコラムの名前を定義しま
す。

この設定は無効化することはできません。

デフォルト値:

--- user_id

PreferencesTableValue

プレファレンス・テーブルにおいてデータを格納するコラムの名前を定義します。

この設定は無効化することはできません。

デフォルト値:

--- preferences_value

131. Frontend → Agent → View → Stats
Stats::CustomerIDAsMultiSelect

全ての顧客識別子をマルチ・セレクトのフィールドに表示します（顧客識別子を多く抱えてい
る場合は利便性が低いです）。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Stats::CustomerUserLoginsAsMultiSelect

Shows all the customer user identifiers in a multi-select field (not useful if you have
a lot of customer user identifiers).

この設定は無効化することはできません。

デフォルト値:

--- 0

Stats::DefaultSelectedDynamicObject

ダイナミックオブジェクトに関するドロップダウン・メニューにおいて、デフォルトの選択を
定義します(Form: Common Specification)。

この設定は無効化することはできません。

デフォルト値:

--- Ticket

Stats::DefaultSelectedFormat

統計フォーマットに関するドロップダウン・メニューにおいて、デフォルトの選択を定義しま
す(Form: Common Specification)。フォーマット・キーを挿入してください（Stats::Formatを
確認ください）。
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この設定は無効化することはできません。

デフォルト値:

---
- Print
- CSV
- Excel
- D3::BarChart
- D3::LineChart
- D3::StackedAreaChart

Stats::DefaultSelectedPermissions

許可（permission）に関するドロップダウン・メニューにおいて、デフォルトの選択を定義し
ます(Form: Common Specification)。

この設定は無効化することはできません。

デフォルト値:

---
- stats

Stats::ExchangeAxis

担当者が統計情報を生成する場合、担当者が統計情報の軸を交換できるようにします。

この設定は無効化することはできません。

デフォルト値:

--- 0

Stats::Format

全ての可能な統計アウトプットのフォーマットを定義します。

この設定は無効化することはできません。

デフォルト値:

---
CSV: CSV
D3::BarChart: 'Graph: Bar Chart'
D3::LineChart: 'Graph: Line Chart'
D3::StackedAreaChart: 'Graph: Stacked Area Chart'
Excel: Excel
Print: Print

Stats::SearchLimit

統計に関する検索のリミットを定義します。

この設定は無効化することはできません。

デフォルト値:

--- '1000'

Stats::SearchPageShown

一覧画面の1ページあたりのデフォルトの最大統計数を定義します。

この設定は無効化することはできません。

デフォルト値:
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--- '50'

Stats::UseAgentElementInStats

統計出力において所有者・責任者を選択できるようにします。

この設定は無効化することはできません。

デフォルト値:

--- 0

Stats::UseInvalidAgentInStats

統計出力において無効にされた担当者も出力対象とします。

この設定は無効化することはできません。

デフォルト値:

--- '1'

132. Frontend → Agent → View →
TicketBounce

Ticket::Frontend::AgentTicketBounce###Permission

担当者インタフェースで、チケット・バウンス画面を使用するために必要な許可です。

この設定は無効化することはできません。

デフォルト値:

--- bounce

Ticket::Frontend::AgentTicketBounce###RequiredLock

担当者インタフェースで、チケット・バウンス画面でチケットのロックが要求されるかどうか
を定義します（まだチケットがロックされていなければ、チケットはロックされ現在の担当者
が自動的に所有者に設定されます）。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketBounce###StateDefault

担当者インタフェースのチケット・バウンス画面で、チケットがバウンスされた後の、デフォ
ルトの次の状態を定義します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- closed successful

Ticket::Frontend::AgentTicketBounce###StateType

担当者インタフェースのチケット・バウンス画面で、チケットのバウンスされた後の次の状態
を定義します。

この設定は無効化することはできません。
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デフォルト値:

---
- open
- closed

Ticket::Frontend::BounceText

担当者インタフェースのチケット・バウンス画面で、顧客/送信者に対するデフォルトのチケッ
ト・バウンス通知を定義します。

この設定は無効化することはできません。

デフォルト値:

--- Your email with ticket number "<OTRS_TICKET>" is bounced to "<OTRS_BOUNCE_TO>".
  Contact this address for further information.

133. Frontend → Agent → View →
TicketBulk

Ticket::Frontend::AgentTicketBulk###DynamicField

担当者インターフェイス のチケット・バルク画面に表示する ダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketBulk###IsVisibleForCustomerDefault

Defines if the note in the ticket bulk screen of the agent interface is visible for the
customer by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketBulk###Owner

担当者インタフェースのチケット・バルク画面で、チケット所有者を設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketBulk###Priority

担当者インタフェースのチケット・バルク画面で、チケットの優先度オプションを表示しま
す。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketBulk###PriorityDefault

担当者インタフェースのチケット・バルク画面で、チケットのデフォルトの優先度を定義しま
す。
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この設定は標準では有効ではありません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketBulk###RequiredLock

バルク・アクションのために選択した後に、所有者をロックし現在のAgentに設定します。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketBulk###Responsible

担当者インタフェースのチケット・バルク画面で、チケットの責任を有する担当者を設定しま
す。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketBulk###State

Sets the state of a ticket in the ticket bulk screen of the agent interface.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketBulk###StateDefault

Defines the default next state of a ticket, in the ticket bulk screen of the agent
interface.

この設定は標準では有効ではありません。

デフォルト値:

--- open

Ticket::Frontend::AgentTicketBulk###StateType

Defines the next state of a ticket, in the ticket bulk screen of the agent interface.

この設定は無効化することはできません。

デフォルト値:

---
- open
- closed
- pending reminder
- pending auto

Ticket::Frontend::AgentTicketBulk###TicketType

Sets the ticket type in the ticket bulk screen of the agent interface.

This setting can be overridden in the user preferences, but is not active by default.
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デフォルト値:

--- '1'

Ticket::Frontend::BulkFeature

担当者フロントエンドで、同時に2つ以上のチケットの作業を可能にするためのチケット・バ
ルク・アクション機能を有効にするものです。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::BulkFeatureGroup

リストされたグループに対してのみ、チケット・バルク・アクション機能を有効にします。

この設定は標準では有効ではありません。

デフォルト値:

---
- admin
- users

134. Frontend → Agent → View →
TicketClose

Ticket::Frontend::AgentTicketClose###Body

担当者インタフェースのクローズ・チケット画面で、追加されたメモに関するデフォルトの本
文テキストを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketClose###DynamicField

担当者インタフェースのチケットクローズ画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketClose###FormDraft

Allows to save current work as draft in the close ticket screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketClose###HistoryComment

担当者インタフェースでチケット履歴のために使用される、クローズ・チケット画面アクショ
ンの履歴コメントを定義します。

682



デフォルト値:

--- '%%Close'

Ticket::Frontend::AgentTicketClose###HistoryType

担当者インタフェースでチケット履歴のために使用される、クローズ・チケット画面アクショ
ンの履歴タイプを定義します。

デフォルト値:

--- AddNote

Ticket::Frontend::AgentTicketClose###InformAgent

担当者インタフェースのクローズ・チケット画面で、可能性ある担当者（キュー/チケットに対
してメモの許可を有する全ての担当者）のリストを表示し、そのメモについて誰に通知するべ
きか決定します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###InvolvedAgent

担当者インタフェースのクローズ・チケット画面で、そのチケットに関与する全ての担当者の
リストを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###IsVisibleForCustomerDefault

Defines if the note in the close ticket screen of the agent interface is visible for the
customer by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###Note

Allows adding notes in the close ticket screen of the agent interface. Can be
overwritten by Ticket::Frontend::NeedAccountedTime.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketClose###NoteMandatory

Sets if note must be filled in by the agent. Can be overwritten by
Ticket::Frontend::NeedAccountedTime.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:
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--- '1'

Ticket::Frontend::AgentTicketClose###Owner

担当者インタフェースのクローズ・チケット画面で、チケットの所有者を設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###OwnerMandatory

チケットの所有者が担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###Permission

担当者インタフェースで、クローズ・チケット画面を使用するために必要な許可です。

この設定は無効化することはできません。

デフォルト値:

--- close

Ticket::Frontend::AgentTicketClose###Priority

担当者インタフェースのクローズ・チケット画面で、チケット優先度オプションを表示しま
す。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###PriorityDefault

担当者インタフェースのクローズ・チケット画面で、デフォルトのチケット優先度を定義しま
す。

この設定は標準では有効ではありません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketClose###Queue

担当者インタフェースのズームされたチケットのチケット・クローズ画面で、キューを設定し
ます。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0
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Ticket::Frontend::AgentTicketClose###QueueMandatory

担当者がキューを選択する必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###RequiredLock

担当者インタフェースのクローズ・チケット画面で、チケット・ロックが必要とされるかどう
かを定義します（チケットがまだロックされていない場合、チケットはロックされ現在の担当
者が自動的に所有者に設定されます）。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketClose###Responsible

担当者インタフェースのチケット・クローズ画面で、チケットの責任を有する担当者を設定し
ます。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###ResponsibleMandatory

Sets if ticket responsible must be selected by the agent.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketClose###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketClose###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。
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This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###Service

Sets the service in the close ticket screen of the agent interface (Ticket::Service needs
to be enabled).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###State

Sets the state of a ticket in the close ticket screen of the agent interface.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketClose###StateDefault

担当者インタフェースのクローズ・チケット画面で、チケットのメモを追加した後の、デフォ
ルトの次の状態を定義します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- closed successful

Ticket::Frontend::AgentTicketClose###StateMandatory

Sets if state must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###StateType

担当者インタフェースのクローズ・チケット画面で、チケットのメモを追加した後の次の状態
を定義します。

この設定は無効化することはできません。

デフォルト値:

---

686



- closed

Ticket::Frontend::AgentTicketClose###Subject

担当者インタフェースのクローズ・チケット画面で、追加されたメモに関するデフォルトの件
名を設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketClose###TicketType

Sets the ticket type in the close ticket screen of the agent interface (Ticket::Type needs
to be enabled).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketClose###Title

Shows the title field in the close ticket screen of the agent interface.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

135. Frontend → Agent → View →
TicketCompose

Ticket::Frontend::AgentTicketCompose###DynamicField

担当者インタフェースのチケット作成画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketCompose###FormDraft

Allows to save current work as draft in the ticket compose screen of the agent
interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketCompose###IsVisibleForCustomerDefault

Defines if the message in the ticket compose screen of the agent interface is visible
for the customer by default.

この設定は無効化することはできません。

デフォルト値:
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--- '1'

Ticket::Frontend::AgentTicketCompose###Permission

担当者インタフェースで、チケット構成画面を使用するための必要な許可です。

この設定は無効化することはできません。

デフォルト値:

--- compose

Ticket::Frontend::AgentTicketCompose###RequiredLock

担当者インタフェースのチケット構成画面で、チケット・ロックが要求されるかどうかを定義
します（チケットがまだロックされていない場合、チケットはロックされ現在の担当者が自動
的に所有者として設定されます）。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketCompose###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '320'

Ticket::Frontend::AgentTicketCompose###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketCompose###StateDefault

担当者インタフェースのチケット構成画面で、チケットが構成（compose）/回答（answer）
された後の、デフォルトの次の状態を定義します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- open

Ticket::Frontend::AgentTicketCompose###StateType

担当者インタフェースのチケット構成画面で、チケットを構成/回答した後の、可能性ある次の
状態を定義します。

この設定は無効化することはできません。

デフォルト値:

---
- open
- closed
- pending auto
- pending reminder
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Ticket::Frontend::ComposeAddCustomerAddress

Adds customers email addresses to recipients in the ticket compose screen of the
agent interface. The customers email address won't be added if the article type is
email-internal.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::ComposeReplaceSenderAddress

担当者インタフェースのチケット構成画面で、オリジナルの送信者を、コンポーズ・アンサー
上の現在の顧客のEメール・アドレスに置換します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::Quote

Defines the used character for plaintext email quotes in the ticket compose screen
of the agent interface. If this is empty or inactive, original emails will not be quoted
but appended to the response.

デフォルト値:

--- '>'

Ticket::Frontend::ResponseFormat

Defines the format of responses in the ticket compose screen of the agent interface
([% Data.OrigFrom | html %] is From 1:1, [% Data.OrigFromName | html %] is only
realname of From).

この設定は無効化することはできません。

デフォルト値:

--- '[% Data.Salutation | html %]

  [% Data.StdResponse | html %]

  [% Data.Signature | html %]

  [% Data.CreateTime | Localize("TimeShort") %] - [% Data.OrigFromName | html %] [%
  Translate("wrote") | html %]:

  [% Data.Body | html %]

'

Ticket::Frontend::ResponseQuoteMaxLines

Defines the maximum number of quoted lines to be added to responses.

この設定は標準では有効ではありません。

デフォルト値:

--- '99'
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136. Frontend → Agent → View →
TicketCustomer

Ticket::Frontend::AgentTicketCustomer###Permission

担当者インタフェースで、チケットの顧客を変更するための必要な許可です。

この設定は無効化することはできません。

デフォルト値:

--- customer

Ticket::Frontend::AgentTicketCustomer###RequiredLock

担当者インタフェースで、チケットの顧客を変更するためにチケットのロックが必要かどうか
を定義します（チケットがまだロックされていない場合、チケットはロックされ現在の担当者
が自動的に所有者として設定されます）。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketCustomer::CustomerIDReadOnly

Controls if CustomerID is read-only in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

137. Frontend → Agent → View →
TicketEmailNew

Ticket::Frontend::AgentTicketEmail###Body

担当者インタフェースで、新規Eメール・チケットに関してデフォルトのテキストを設定しま
す。

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketEmail###DynamicField

担当者インタフェースのチケット電子メール送信画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketEmail###HistoryComment

担当者インタフェースでチケット履歴のために使用される、Eメール・チケット画面アクション
の履歴コメントを定義します。
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この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketEmail###HistoryType

担当者インタフェースでチケット履歴のために使用される、Eメール・チケット画面アクション
の履歴タイプを定義します。

この設定は無効化することはできません。

デフォルト値:

--- EmailAgent

Ticket::Frontend::AgentTicketEmail###IsVisibleForCustomer

担当者Webインターフェイスで新しいメールチケットのデフォルト記事を顧客参照と定義しま
す。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketEmail###Priority

担当者インタフェースで、新規Eメール・チケットに関してデフォルトの優先度を設定しま
す。

この設定は無効化することはできません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketEmail###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '320'

Ticket::Frontend::AgentTicketEmail###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketEmail###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.
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デフォルト値:

--- 0

Ticket::Frontend::AgentTicketEmail###SenderType

担当者インタフェースで、新規Eメール・チケットに関してデフォルトの送信者タイプを設定
します。

この設定は無効化することはできません。

デフォルト値:

--- agent

Ticket::Frontend::AgentTicketEmail###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketEmail###SplitLinkType

担当者Webインターフェイスのスプリットチケットのデフォルトリンクタイプを設定します。

デフォルト値:

---
Direction: Target
LinkType: ParentChild

Ticket::Frontend::AgentTicketEmail###StateDefault

担当者インタフェースで、Eメール・チケットを作成した後の、デフォルトの次のチケット状態
を設定します。

この設定は無効化することはできません。

デフォルト値:

--- open

Ticket::Frontend::AgentTicketEmail###StateType

担当者インタフェースで、Eメール・チケットを作成した後の、可能性ある次のチケット状態を
定義します。

この設定は無効化することはできません。

デフォルト値:

---
- open
- pending auto
- pending reminder
- closed

Ticket::Frontend::AgentTicketEmail###Subject

担当者インタフェースで、新規Eメール・チケットに関してデフォルトの件名を設定します
（例：'email Outbound')。
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この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketEmail::CustomerIDReadOnly

Controls if CustomerID is read-only in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

138. Frontend → Agent → View →
TicketEmailOutbound

Ticket::Frontend::AgentTicketEmailOutbound###DynamicField

担当者インタフェースの電子メール送信画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketEmailOutbound###FormDraft

Allows to save current work as draft in the email outbound screen of the agent
interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketEmailOutbound###IsVisibleForCustomerDefault

Defines if the message in the email outbound screen of the agent interface is visible
for the customer by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketEmailOutbound###Permission

Required permissions to use the email outbound screen in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- compose

Ticket::Frontend::AgentTicketEmailOutbound###RequiredLock

Defines if a ticket lock is required in the email outbound screen of the agent interface
(if the ticket isn't locked yet, the ticket gets locked and the current agent will be set
automatically as its owner).

デフォルト値:
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--- '1'

Ticket::Frontend::AgentTicketEmailOutbound###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '300'

Ticket::Frontend::AgentTicketEmailOutbound###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketEmailOutbound###StateDefault

担当者インタフェースの外部メール送信画面で、メッセージが送信された後の、デフォルトの
次の状態を定義します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- open

Ticket::Frontend::AgentTicketEmailOutbound###StateType

エージェント画面のメール送信画面後に設定できる状態をを設定してください。

デフォルト値:

---
- open
- closed
- pending reminder
- pending auto

139. Frontend → Agent → View →
TicketEmailResend

Ticket::Frontend::AgentTicketEmailResend###IsVisibleForCustomerDefault

Defines if the message in the email resend screen of the agent interface is visible for
the customer by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketEmailResend###Permission

Required permissions to use the email resend screen in the agent interface.
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この設定は無効化することはできません。

デフォルト値:

--- compose

Ticket::Frontend::AgentTicketEmailResend###RequiredLock

Defines if a ticket lock is required in the email resend screen of the agent interface
(if the ticket isn't locked yet, the ticket gets locked and the current agent will be set
automatically as its owner).

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketEmailResend###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '300'

Ticket::Frontend::AgentTicketEmailResend###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '620'

140. Frontend → Agent → View →
TicketEscalation

Ticket::Frontend::AgentTicketEscalationView###DefaultColumns

Columns that can be filtered in the escalation view of the agent interface. Note: Only
Ticket attributes, Dynamic Fields (DynamicField_NameX) and Customer attributes
(e.g. CustomerUserPhone, CustomerCompanyName, ...) are allowed.

デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '2'
EscalationUpdateTime: '1'
Lock: '2'
Owner: '2'
PendingTime: '1'
Priority: '1'
Queue: '2'
Responsible: '1'
SLA: '1'
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Sender: '2'
Service: '1'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
Type: '1'

Ticket::Frontend::AgentTicketEscalationView###Order::Default

担当者インタフェースのエスカレーション・ビューで、デフォルトのチケット順番（優先度
ソート後）を定義します。Up:一番古いものをトップに. Down:最新のものをトップに。

この設定は無効化することはできません。

デフォルト値:

--- Up

Ticket::Frontend::AgentTicketEscalationView###SortBy::Default

担当者インタフェースのエスカレーション・ビューで、チケット・ソートのためのデフォルト
のチケット属性を定義します。

この設定は無効化することはできません。

デフォルト値:

--- EscalationTime

Ticket::Frontend::AgentTicketEscalationView###TicketPermission

Defines the required permission to show a ticket in the escalation view of the agent
interface.

この設定は無効化することはできません。

デフォルト値:

--- rw

Ticket::Frontend::AgentTicketEscalationView###ViewableTicketsPage

担当者インタフェースのエスカレーション・ビューにある、全てのオープン・チケット（たと
えロックされていたとしても）を表示します。

この設定は無効化することはできません。

デフォルト値:

--- '50'

141. Frontend → Agent → View →
TicketForward

Ticket::Frontend::AgentTicketForward###DynamicField

担当者インタフェースのチケット転送画面に表示するダイナミック・フィールド

デフォルト値:

--- {}
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Ticket::Frontend::AgentTicketForward###FormDraft

Allows to save current work as draft in the ticket forward screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketForward###IsVisibleForCustomerDefault

Defines if the message in the ticket forward screen of the agent interface is visible
for the customer by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketForward###Permission

担当者インタフェースのチケット転送画面を使用するために必要な許可です。

この設定は無効化することはできません。

デフォルト値:

--- forward

Ticket::Frontend::AgentTicketForward###RequiredLock

担当者インタフェースのチケット転送画面で、チケット・ロックが必要とされるかどうかを定
義します。（チケットがまだロックされていない場合、チケットはロックされ現在の担当者が
自動的に所有者として設定されます）。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketForward###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketForward###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketForward###StateDefault

担当者インタフェースのチケット転送画面で、チケットが転送された後の、デフォルトの次の
状態を定義します。

This setting can be overridden in the user preferences, but is not active by default.
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デフォルト値:

--- closed successful

Ticket::Frontend::AgentTicketForward###StateType

担当者インタフェースのチケット転送画面で、チケットを作成した後の、可能性ある次の状態
を規定します。

デフォルト値:

---
- open
- closed
- pending reminder
- pending auto

142. Frontend → Agent → View →
TicketFreeText

Ticket::Frontend::AgentTicketFreeText###Body

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、メモのデフォルトの本
文を定義します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketFreeText###DynamicField

担当者インタフェースのチケットフリーテキスト画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketFreeText###FormDraft

Allows to save current work as draft in the ticket free text screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketFreeText###HistoryComment

チケット履歴で使用される、チケット・フリー・テキスト画面のアクションに関する履歴コメ
ントを定義します。

デフォルト値:

--- '%%FreeText'

Ticket::Frontend::AgentTicketFreeText###HistoryType

チケット履歴で使用される。、チケット・フリー・テキスト画面のアクションに関して履歴タ
イプを定義します。

デフォルト値:

--- AddNote
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Ticket::Frontend::AgentTicketFreeText###InformAgent

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、可能性ある全ての担当
者（キュー/チケットに関してメモ許可を有する全ての担当者）を表示し、そのメモに関して誰
に通知するべきかを決定します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###InvolvedAgent

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、そのチケットに関与す
る全ての担当者のリストを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###IsVisibleForCustomerDefault

Defines if the note in the ticket free text screen of the agent interface is visible for
the customer by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###Note

Allows adding notes in the ticket free text screen of the agent interface. Can be
overwritten by Ticket::Frontend::NeedAccountedTime.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###NoteMandatory

Sets if note must be filled in by the agent. Can be overwritten by
Ticket::Frontend::NeedAccountedTime.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###Owner

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、チケット所有者を設定
します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0
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Ticket::Frontend::AgentTicketFreeText###OwnerMandatory

チケットの所有者が担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###Permission

担当者インタフェースで、チケット・フリー・テキスト画面を使用する為の必要な許可です。

この設定は無効化することはできません。

デフォルト値:

--- rw

Ticket::Frontend::AgentTicketFreeText###Priority

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、チケット優先度のオプ
ションを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###PriorityDefault

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、デフォルトのチケット
優先度を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketFreeText###Queue

担当者インタフェースのズームされたチケットのチケット自由テキスト画面で、キューを設定
します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###QueueMandatory

担当者がキューを選択する必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###RequiredLock

担当者インタフェースのチケット・フリー・テキスト画面で、チケット・ロックが必要である
かどうかを設定します。（チケットがまだロックされていない場合、チケットはロックされ現
在の担当者が自動的に所有者として設定されます）。
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デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###Responsible

担当者インタフェースのチケット自由テキスト画面で、チケットの責任を有する担当者を設定
します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###ResponsibleMandatory

Sets if ticket responsible must be selected by the agent.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketFreeText###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketFreeText###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###Service

Sets the service in the ticket free text screen of the agent interface (Ticket::Service
needs to be enabled).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:
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--- '1'

Ticket::Frontend::AgentTicketFreeText###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###State

Sets the state of a ticket in the ticket free text screen of the agent interface.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###StateDefault

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、メモを追加した後の、
デフォルトのチケットの次の状態を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- open

Ticket::Frontend::AgentTicketFreeText###StateMandatory

Sets if state must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketFreeText###StateType

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、メモを追加した後のチ
ケットの次の状態を定義します。

この設定は無効化することはできません。

デフォルト値:

---
- open
- closed
- pending reminder
- pending auto

Ticket::Frontend::AgentTicketFreeText###Subject

担当者インタフェースのチケット・フリー・テキスト・スクリーンで、メモのデフォルトの件
名を定義します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- ''
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Ticket::Frontend::AgentTicketFreeText###TicketType

Sets the ticket type in the ticket free text screen of the agent interface (Ticket::Type
needs to be enabled).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketFreeText###Title

Shows the title field in the ticket free text screen of the agent interface.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

143. Frontend → Agent → View →
TicketHistory

Ticket::Frontend::HistoryOrder

担当者インタフェースで、チケット履歴（逆の順番）を表示します。

この設定は無効化することはできません。

デフォルト値:

--- normal

Ticket::Frontend::HistoryTypes###000-Framework

Controls how to display the ticket history entries as readable values.

この設定は無効化することはできません。

デフォルト値:

---
AddNote: Added note (%s).
ArchiveFlagUpdate: Changed archive state to "%s".
Bounce: Bounced to "%s".
CustomerUpdate: Changed customer to "%s".
EmailAgent: Sent email to customer.
EmailCustomer: Added email. %s
EmailResend: Resent email to "%s".
EscalationResponseTimeNotifyBefore: Notified about response time escalation.
EscalationResponseTimeStart: Started response time escalation.
EscalationResponseTimeStop: Stopped response time escalation.
EscalationSolutionTimeNotifyBefore: Notified about solution time escalation.
EscalationSolutionTimeStart: Started solution time escalation.
EscalationSolutionTimeStop: Stopped solution time escalation.
EscalationUpdateTimeNotifyBefore: Notified about update time escalation.
EscalationUpdateTimeStart: Started update time escalation.
EscalationUpdateTimeStop: Stopped update time escalation.
FollowUp: Added follow-up to ticket [%s]. %s
Forward: Forwarded to "%s".
Lock: Locked ticket.
LoopProtection: 'Loop protection: no auto-response sent to "%s".'
Merged: Merged Ticket (%s/%s) to (%s/%s).
Misc: '%s'
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Move: Changed queue to "%s" (%s) from "%s" (%s).
NewTicket: Created ticket [%s] in "%s" with priority "%s" and state "%s".
OwnerUpdate: Changed owner to "%s" (%s).
PhoneCallAgent: Added phone call to customer.
PhoneCallCustomer: Added phone call from customer.
PriorityUpdate: Changed priority from "%s" (%s) to "%s" (%s).
Remove: '%s'
ResponsibleUpdate: Changed responsible to "%s" (%s).
SLAUpdate: Changed SLA to "%s" (%s).
SendAgentNotification: Sent "%s" notification to "%s" via "%s".
SendAnswer: Sent email to "%s".
SendAutoFollowUp: Sent auto follow-up to "%s".
SendAutoReject: Sent auto reject to "%s".
SendAutoReply: Sent auto reply to "%s".
SendCustomerNotification: Sent notification to "%s".
ServiceUpdate: Changed service to "%s" (%s).
SetPendingTime: Changed pending time to "%s".
StateUpdate: Changed state from "%s" to "%s".
Subscribe: Added subscription for user "%s".
SystemRequest: Added system request (%s).
TicketDynamicFieldUpdate: Changed dynamic field %s from "%s" to "%s".
TicketLinkAdd: Added link to ticket "%s".
TicketLinkDelete: Deleted link to ticket "%s".
TimeAccounting: Added %s time unit(s), for a total of %s time unit(s).
TitleUpdate: Changed title from "%s" to "%s".
TypeUpdate: Changed type from "%s" (%s) to "%s" (%s).
Unlock: Unlocked ticket.
Unsubscribe: Removed subscription for user "%s".
WebRequestCustomer: Added web request from customer.

Ticket::Frontend::HistoryTypes###001-Framework

Controls how to display the ticket history entries as readable values.

この設定は無効化することはできません。

デフォルト値:

---
AddSMS: Added SMS for "%s".

144. Frontend → Agent → View →
TicketLocked

Ticket::Frontend::AgentTicketLockedView###DefaultColumns

Columns that can be filtered in the locked view of the agent interface. Note: Only
Ticket attributes, Dynamic Fields (DynamicField_NameX) and Customer attributes
(e.g. CustomerUserPhone, CustomerCompanyName, ...) are allowed.

デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '1'
EscalationUpdateTime: '1'
Lock: '2'
Owner: '2'
PendingTime: '1'
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Priority: '1'
Queue: '2'
Responsible: '1'
SLA: '1'
Sender: '2'
Service: '1'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
Type: '1'

Ticket::Frontend::AgentTicketLockedView###Order::Default

担当者インタフェースのロック済チケット・ビューで、デフォルトのチケットの順番を定義し
ます。Up: 一番古いものがトップ. Down: 最新のものがトップ。

この設定は無効化することはできません。

デフォルト値:

--- Up

Ticket::Frontend::AgentTicketLockedView###SortBy::Default

担当者インタフェースのロック済チケット・ビューで、チケット・ソートのためのデフォルト
のチケット属性を定義します。

この設定は無効化することはできません。

デフォルト値:

--- Age

145. Frontend → Agent → View →
TicketMerge

Ticket::Frontend::AgentTicketMerge###Permission

担当者インタフェースで、ズームされたチケットのチケット結合画面を使用するための必要な
許可です。

この設定は無効化することはできません。

デフォルト値:

--- rw

Ticket::Frontend::AgentTicketMerge###RequiredLock

Defines if a ticket lock is required in the ticket merge screen of a zoomed ticket in the
agent interface (if the ticket isn't locked yet, the ticket gets locked and the current
agent will be set automatically as its owner).

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketMerge###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.
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デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketMerge###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Ticket::Frontend::AutomaticMergeSubject

チケットがマージされると、有効ではなくなったチケットに自動的にメモが追加されます。こ
のメモの件名をここで定義できます(担当者はこの件名を変更できません)。

この設定は無効化することはできません。

デフォルト値:

--- Ticket Merged

Ticket::Frontend::AutomaticMergeText

チケットがマージされると、有効ではなくなったチケットに自動的にメモが追加されます。こ
のメモの内容をここで定義できます(担当者はこの本文を変更できません)。

この設定は無効化することはできません。

デフォルト値:

--- Merged Ticket <OTRS_TICKET> to <OTRS_MERGE_TO_TICKET>.

Ticket::Frontend::MergeText

担当者インタフェースでズームされたチケットのチケット結合画面で、チケット・ロックが必
要かどうかを定義します。（チケットがまだロックされていない場合、チケットはロックされ
現在の担当者が自動的に所有者として設定されます）。

この設定は無効化することはできません。

デフォルト値:

--- Your email with ticket number "<OTRS_TICKET>" is merged to "<OTRS_MERGE_TO_TICKET>".

146. Frontend → Agent → View →
TicketMove

Ticket::Frontend::AgentTicketMove###Body

担当者インタフェースの移動チケット画面で、追加されるメモのデフォルトの本文テキストを
設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- ''
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Ticket::Frontend::AgentTicketMove###DynamicField

担当者インタフェースのチケット移動画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketMove###FormDraft

Allows to save current work as draft in the ticket move screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketMove###NextScreen

Determines the next screen after the ticket is moved. LastScreenOverview will return
the last overview screen (e.g. search results, queueview, dashboard). TicketZoom will
return to the TicketZoom.

この設定は無効化することはできません。

デフォルト値:

--- TicketZoom

Ticket::Frontend::AgentTicketMove###Note

Allows adding notes in the ticket free text screen of the agent interface. Can be
overwritten by Ticket::Frontend::NeedAccountedTime.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketMove###NoteMandatory

Sets if note must be filled in by the agent. Can be overwritten by
Ticket::Frontend::NeedAccountedTime.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketMove###Priority

担当者インタフェースの移動チケット画面で、チケット優先度のオプションを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketMove###RequiredLock

Automatically lock and set owner to current Agent after opening the move ticket
screen of the agent interface.

デフォルト値:
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--- '1'

Ticket::Frontend::AgentTicketMove###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketMove###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketMove###State

担当者インタフェースの移動チケット画面で、新しいチケット状態を設定することを許可しま
す。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketMove###StateMandatory

Sets if state must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketMove###StateType

担当者インタフェースの移動チケット画面で、チケットが他のキューへ移動させられた後の次
の状態を定義します。

この設定は無効化することはできません。

デフォルト値:

---
- open
- closed

Ticket::Frontend::AgentTicketMove###Subject

担当者インタフェースの移動チケット画面で、追加されるメモのデフォルトの件名を設定しま
す。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- ''
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Ticket::Frontend::MoveType

チケットへ移動していくであろう、可能性あるキューのリストが、担当者インタフェースにド
ロップ・ダウン・リストまたは新規ウィンドウとして表示されるべきかどうかを定義しま
す。"New Window"を設定した場合、チケットに移動メモを追加することができます。

この設定は無効化することはできません。

デフォルト値:

--- form

147. Frontend → Agent → View →
TicketNote

Ticket::Frontend::AgentTicketNote###Body

担当者インタフェースのチケット・メモ画面で、追加されたメモのデフォルトの本文テキスト
を設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketNote###DynamicField

担当者インタフェースのチケット注釈画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketNote###FormDraft

Allows to save current work as draft in the ticket note screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketNote###HistoryComment

担当者インタフェースのチケット履歴で使用される、チケット・メモ画面アクションに関する
履歴コメントを定義します。

デフォルト値:

--- '%%Note'

Ticket::Frontend::AgentTicketNote###HistoryType

担当者インタフェースのチケット履歴で使用される、チケット・メモ画面アクションについ
て、履歴タイプを定義します。

デフォルト値:

--- AddNote

Ticket::Frontend::AgentTicketNote###InformAgent

担当者インタフェースのチケット・メモ画面で、可能性ある担当者（キュー/チケットに対して
メモ許可を持つ全担当者）を表示し、そのメモについて誰に通知するか決定しまう。
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この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###InvolvedAgent

担当者インタフェースのチケット・メモ画面で、そのチケットに関与する全担当者のリストで
す。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###IsVisibleForCustomerDefault

Defines if the note in the ticket note screen of the agent interface is visible for the
customer by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###Note

Allows adding notes in the ticket note screen of the agent interface. Can be overwritten
by Ticket::Frontend::NeedAccountedTime.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketNote###NoteMandatory

Sets if note must be filled in by the agent. Can be overwritten by
Ticket::Frontend::NeedAccountedTime.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketNote###Owner

担当者インタフェースのチケット・メモ画面で、チケット所有者を設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###OwnerMandatory

チケットの所有者が担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:
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--- 0

Ticket::Frontend::AgentTicketNote###Permission

担当者インタフェースのチケット・メモ画面を使用するための必要な許可です。

この設定は無効化することはできません。

デフォルト値:

--- note

Ticket::Frontend::AgentTicketNote###Priority

担当者インタフェースのチケット・メモ画面で、チケット優先度のオプションを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###PriorityDefault

担当者インタフェースのチケット・メモ画面で、デフォルトのチケット優先度を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketNote###Queue

担当者インタフェースのズームされたチケットのチケットノート画面で、キューを設定しま
す。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###QueueMandatory

担当者がキューを選択する必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###RequiredLock

担当者インタフェースのチケット・メモ画面で、チケット・ロックが必要とされるかどうかを
定義します（チケットがまだロックされていない場合、チケットはロックされ現在の担当者が
自動的に所有者として設定されます）。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###Responsible

担当者インタフェースのチケット・メモ画面で、チケットの責任を有する担当者を設定しま
す。
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This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###ResponsibleMandatory

Sets if ticket responsible must be selected by the agent.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketNote###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketNote###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###Service

Sets the service in the ticket note screen of the agent interface (Ticket::Service needs
to be enabled).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:
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--- 0

Ticket::Frontend::AgentTicketNote###State

Sets the state of a ticket in the ticket note screen of the agent interface.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###StateDefault

担当者インタフェースのチケット・メモ画面で、メモを追加した後の、デフォルトのチケット
の次の状態を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- open

Ticket::Frontend::AgentTicketNote###StateMandatory

Sets if state must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketNote###StateType

担当者インタフェースのチケット・メモ画面で、メモを追加した後のチケットの次の状態を定
義します。

この設定は無効化することはできません。

デフォルト値:

---
- open
- closed
- pending reminder
- pending auto

Ticket::Frontend::AgentTicketNote###Subject

担当者インタフェースのチケット・メモ画面で、追加されたメモのデフォルトの件名を設定し
ます。

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketNote###TicketType

Sets the ticket type in the ticket note screen of the agent interface (Ticket::Type needs
to be enabled).

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:
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--- 0

Ticket::Frontend::AgentTicketNote###Title

Shows the title field in the ticket note screen of the agent interface.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

148. Frontend → Agent → View →
TicketOwner

Ticket::Frontend::AgentTicketOwner###Body

担当者インタフェースのズームされたチケットのチケット所有者画面で、追加されたメモのデ
フォルトの本文テキストを設定します。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketOwner###DynamicField

Dynamic fields shown in the ticket owner screen of the agent interface.

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketOwner###FormDraft

Allows to save current work as draft in the ticket owner screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketOwner###HistoryComment

担当者インタフェースでチケット履歴のためにしようされる、チケット所有者画面のアクショ
ンのための履歴コメントを定義します。

デフォルト値:

--- '%%Owner'

Ticket::Frontend::AgentTicketOwner###HistoryType

担当者インタフェースでチケット履歴のために使用される、チケット所有者画面のアクション
のための履歴タイプを定義します。

デフォルト値:

--- AddNote

Ticket::Frontend::AgentTicketOwner###InformAgent

担当者インタフェースのズームされたチケットのチケット所有者画面で、全ての可能性ある担
当者（キュー/チケットにメモ許可を有する全ての担当者）のリストを表示し、そのメモについ
て誰に通知するべきかを決定します。
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この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###InvolvedAgent

担当者インタフェースのズームされたチケットのチケット所有者画面で、そのチケットに関与
する全ての担当者のリストを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###IsVisibleForCustomerDefault

Defines if the note in the ticket owner screen of the agent interface is visible for the
customer by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###Note

Allows adding notes in the ticket owner screen of a zoomed ticket in the agent
interface. Can be overwritten by Ticket::Frontend::NeedAccountedTime.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketOwner###NoteMandatory

Sets if note must be filled in by the agent. Can be overwritten by
Ticket::Frontend::NeedAccountedTime.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketOwner###Owner

担当者インタフェースのズームされたチケットのチケット所有者画面で、チケット所有者を設
定します。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketOwner###OwnerMandatory

チケットの所有者が担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketOwner###Permission

担当者インタフェースで、ズームされたチケットのチケット所有者画面を使用するための必要
な許可です。
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この設定は無効化することはできません。

デフォルト値:

--- owner

Ticket::Frontend::AgentTicketOwner###Priority

担当者インタフェースのズームされたチケットのチケット所有者画面で、チケット優先度のオ
プションを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###PriorityDefault

担当者インタフェースのズームされたチケットのチケット所有者画面で、デフォルトのチケッ
ト優先度を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketOwner###Queue

担当者インタフェースのズームされたチケットのチケットのチケット所有者画面で、キューを
設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###QueueMandatory

担当者がキューを選択する必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###RequiredLock

担当者インタフェースのズームされたチケットのチケット所有者画面で、チケット・ロックが
必要とされるかどうかを定義します（チケットがまだロックされていない場合、チケットは
ロックされ現在の担当者が自動的に所有者として設定されます）。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###Responsible

担当者インタフェースのズームされたチケットのチケット所有者画面で、チケットの責任を有
する担当者を設定します。

デフォルト値:

--- 0
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Ticket::Frontend::AgentTicketOwner###ResponsibleMandatory

Sets if ticket responsible must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketOwner###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketOwner###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###Service

Sets the service in the ticket owner screen of a zoomed ticket in the agent interface
(Ticket::Service needs to be enabled).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###State

Sets the state of the ticket in the ticket owner screen of a zoomed ticket in the agent
interface.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###StateDefault

担当者インタフェースのズームされたチケットのチケット所有者画面で、メモを追加した後
の、デフォルトのチケットの次の状態を定義します。

デフォルト値:
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--- open

Ticket::Frontend::AgentTicketOwner###StateMandatory

Sets if state must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###StateType

担当者インタフェースのズームされたチケットのチケット所有者画面で、メモを追加した後の
チケットの次の状態を定義します。

この設定は無効化することはできません。

デフォルト値:

---
- open
- pending reminder
- pending auto

Ticket::Frontend::AgentTicketOwner###Subject

担当者インタフェースのズームされたチケットのチケット所有者画面で、追加されたメモのデ
フォルトの件名を設定します。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketOwner###TicketType

Sets the ticket type in the ticket owner screen of a zoomed ticket in the agent interface
(Ticket::Type needs to be enabled).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketOwner###Title

Shows the title field in the ticket owner screen of a zoomed ticket in the agent
interface.

デフォルト値:

--- 0

149. Frontend → Agent → View →
TicketPending

Ticket::Frontend::AgentTicketPending###Body

担当者インタフェースのズームされたチケットのチケット保留画面で、追加されたメモのデ
フォルトの本文テキストを設定します。

デフォルト値:

--- ''
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Ticket::Frontend::AgentTicketPending###DynamicField

Dynamic fields shown in the ticket pending screen of the agent interface.

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketPending###FormDraft

Allows to save current work as draft in the ticket pending screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPending###HistoryComment

担当者インタフェースでチケット履歴のために使用される、チケット保留画面のアクションの
ための履歴コメントを定義します。

デフォルト値:

--- '%%Pending'

Ticket::Frontend::AgentTicketPending###HistoryType

担当者インタフェースでチケット履歴のために使用される、チケット保留画面のアクションの
ための履歴タイプを定義します。

デフォルト値:

--- AddNote

Ticket::Frontend::AgentTicketPending###InformAgent

担当者インタフェースのズームされたチケットのチケット保留画面で、全ての可能性ある担当
者（キュー/チケットにメモ許可を有する全ての担当者）のリストを表示し、そのメモについて
誰に通知するべきかを決定します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###InvolvedAgent

担当者インタフェースのズームされたチケットのチケット保留画面で、そのチケットに関与す
る全ての担当者のリストを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###IsVisibleForCustomerDefault

Defines if the note in the ticket pending screen of the agent interface is visible for
the customer by default.

デフォルト値:

--- 0
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Ticket::Frontend::AgentTicketPending###Note

Allows adding notes in the ticket pending screen of a zoomed ticket in the agent
interface. Can be overwritten by Ticket::Frontend::NeedAccountedTime.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPending###NoteMandatory

Sets if note must be filled in by the agent. Can be overwritten by
Ticket::Frontend::NeedAccountedTime.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPending###Owner

担当者インタフェースのズームされたチケットのチケット保留画面で、チケット所有者を設定
します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###OwnerMandatory

チケットの所有者が担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###Permission

担当者インタフェースで、ズームされたチケットのチケット保留画面を使用するための必要な
許可です。

この設定は無効化することはできません。

デフォルト値:

--- pending

Ticket::Frontend::AgentTicketPending###Priority

担当者インタフェースのズームされたチケットのチケット保留画面で、チケット優先度のオプ
ションを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###PriorityDefault

担当者インタフェースのズームされたチケットのチケット所有者画面で、デフォルトのチケッ
ト優先度を定義します。

この設定は標準では有効ではありません。

デフォルト値:
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--- 3 normal

Ticket::Frontend::AgentTicketPending###Queue

担当者インタフェースのズームされたチケットのチケット保留画面で、キューを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###QueueMandatory

担当者がキューを選択する必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###RequiredLock

担当者インタフェースのズームされたチケットのチケット保留画面で、チケット・ロックが必
要とされるかどうかを定義します（チケットがまだロックされていない場合、チケットはロッ
クされ現在の担当者が自動的に所有者として設定されます）。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPending###Responsible

担当者インタフェースのズームされたチケットのチケット保留画面で、チケットの責任を有す
る担当者を設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###ResponsibleMandatory

Sets if ticket responsible must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketPending###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketPending###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。
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デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###Service

Sets the service in the ticket pending screen of a zoomed ticket in the agent interface
(Ticket::Service needs to be enabled).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###State

Sets the state of the ticket in the ticket pending screen of a zoomed ticket in the agent
interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPending###StateDefault

担当者インタフェースのズームされたチケットのチケット保留画面で、メモを追加した後の、
デフォルトのチケットの次の状態を定義します。

デフォルト値:

--- pending reminder

Ticket::Frontend::AgentTicketPending###StateMandatory

Sets if state must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###StateType

担当者インタフェースのズームされたチケットのチケット保留画面で、メモを追加した後のチ
ケットの次の状態を定義します。

この設定は無効化することはできません。

デフォルト値:

---
- pending reminder
- pending auto

Ticket::Frontend::AgentTicketPending###Subject

担当者インタフェースのズームされたチケットのチケット保留画面で、追加されたメモのデ
フォルトの件名を設定します。
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デフォルト値:

--- ''

Ticket::Frontend::AgentTicketPending###TicketType

Sets the ticket type in the ticket pending screen of a zoomed ticket in the agent
interface (Ticket::Type needs to be enabled).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPending###Title

Shows the title field in the ticket pending screen of a zoomed ticket in the agent
interface.

デフォルト値:

--- 0

150. Frontend → Agent → View →
TicketPhoneInbound

Ticket::Frontend::AgentTicketPhoneInbound###Body

Defines the default note body text for phone tickets in the ticket phone inbound screen
of the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketPhoneInbound###DynamicField

Dynamic fields shown in the ticket phone inbound screen of the agent interface.

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketPhoneInbound###FormDraft

Allows to save current work as draft in the ticket phone inbound screen of the agent
interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPhoneInbound###HistoryComment

Defines the history comment for the ticket phone inbound screen action, which gets
used for ticket history in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- ''
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Ticket::Frontend::AgentTicketPhoneInbound###HistoryType

Defines the history type for the ticket phone inbound screen action, which gets used
for ticket history in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- PhoneCallCustomer

Ticket::Frontend::AgentTicketPhoneInbound###Permission

Required permissions to use the ticket phone inbound screen in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- phone

Ticket::Frontend::AgentTicketPhoneInbound###RequiredLock

Defines if a ticket lock is required in the ticket phone inbound screen of the agent
interface (if the ticket isn't locked yet, the ticket gets locked and the current agent
will be set automatically as its owner).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPhoneInbound###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '200'

Ticket::Frontend::AgentTicketPhoneInbound###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '475'

Ticket::Frontend::AgentTicketPhoneInbound###SenderType

Defines the default sender type for phone tickets in the ticket phone inbound screen
of the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- customer

Ticket::Frontend::AgentTicketPhoneInbound###State

担当者インタフェースの電話応答着信画面で、電話メモを追加した後のチケットのデフォルト
の次の状態を定義します。
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デフォルト値:

--- open

Ticket::Frontend::AgentTicketPhoneInbound###StateType

Next possible ticket states after adding a phone note in the ticket phone inbound
screen of the agent interface.

この設定は無効化することはできません。

デフォルト値:

---
- open
- pending auto
- pending reminder
- closed

Ticket::Frontend::AgentTicketPhoneInbound###Subject

Defines the default subject for phone tickets in the ticket phone inbound screen of
the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- ''

151. Frontend → Agent → View →
TicketPhoneNew

Ticket::Frontend::AgentTicketPhone###Body

担当者インタフェースで、新規電話チケットのためのデフォルトのメモのテキストを設定しま
す（例：'New ticket via call'）。

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketPhone###DynamicField

Dynamic fields shown in the ticket phone screen of the agent interface.

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketPhone###HistoryComment

担当者インタフェースのチケット履歴で使用される、電話チケット画面アクションに関する履
歴コメントを定義します。

この設定は無効化することはできません。

デフォルト値:

--- ''

725



Ticket::Frontend::AgentTicketPhone###HistoryType

担当者インタフェースのチケット履歴で使用される、電話チケット画面アクションについて、
履歴タイプを定義します。

この設定は無効化することはできません。

デフォルト値:

--- PhoneCallCustomer

Ticket::Frontend::AgentTicketPhone###IsVisibleForCustomer

担当者Webインターフェイスで新しい電話チケットのデフォルト記事を顧客参照と定義しま
す。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPhone###Priority

担当者インタフェースで、新規電話チケットのためのデフォルトの優先度を設定します。

この設定は無効化することはできません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketPhone###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '320'

Ticket::Frontend::AgentTicketPhone###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketPhone###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPhone###SenderType

担当者インタフェースで、新規電話チケットのためのデフォルトの送信者タイプを設定しま
す。

この設定は無効化することはできません。

デフォルト値:
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--- customer

Ticket::Frontend::AgentTicketPhone###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPhone###SplitLinkType

担当者Webインタフェースで、分割されたチケットのデフォルトのリンク・タイプを設定しま
す。

デフォルト値:

---
Direction: Target
LinkType: ParentChild

Ticket::Frontend::AgentTicketPhone###StateDefault

担当者インタフェースで、新規電話チケットのためのデフォルトの次の状態を設定します。

この設定は無効化することはできません。

デフォルト値:

--- open

Ticket::Frontend::AgentTicketPhone###StateType

担当者インタフェースで、新規電話チケットを作成した後の、次の可能性あるチケット状態を
定義します。

この設定は無効化することはできません。

デフォルト値:

---
- open
- pending auto
- pending reminder
- closed

Ticket::Frontend::AgentTicketPhone###Subject

担当者インタフェースで、新規電話チケットのためのデフォルトの件名を設定します。
（例：'Phone call'）

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketPhone::AllowMultipleFrom

Controls if more than one from entry can be set in the new phone ticket in the agent
interface.

この設定は無効化することはできません。

デフォルト値:
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--- '1'

Ticket::Frontend::AgentTicketPhone::CustomerIDReadOnly

Controls if CustomerID is read-only in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

152. Frontend → Agent → View →
TicketPhoneOutbound

Ticket::Frontend::AgentTicketPhoneOutbound###Body

担当者インタフェースのチケット電話アウトバウンド画面で、電話チケットのためのデフォル
トのメモ本文テキストを定義します。

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketPhoneOutbound###DynamicField

Dynamic fields shown in the ticket phone outbound screen of the agent interface.

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketPhoneOutbound###FormDraft

Allows to save current work as draft in the ticket phone outbound screen of the agent
interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPhoneOutbound###HistoryComment

担当者インタフェースのチケット履歴で使用される、チケット電話アウトバウンド画面アク
ションに関する履歴コメントを定義します。

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketPhoneOutbound###HistoryType

担当者インタフェースのチケット履歴で使用される、チケット電話アウトバウンド画面アク
ションについて、履歴タイプを定義します。

この設定は無効化することはできません。

デフォルト値:
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--- PhoneCallAgent

Ticket::Frontend::AgentTicketPhoneOutbound###Permission

担当者インタフェースで、チケット電話アウトバウンド画面を使用するための必要な許可で
す。

この設定は無効化することはできません。

デフォルト値:

--- phone

Ticket::Frontend::AgentTicketPhoneOutbound###RequiredLock

担当者インタフェースのチケット電話アウトバウンド画面で、チケット・ロックが必要かどう
かを定義します（チケットがまだロックされていない場合、チケットはロックされ現在の担当
者が自動的に所有者として設定されます）。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPhoneOutbound###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '200'

Ticket::Frontend::AgentTicketPhoneOutbound###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '475'

Ticket::Frontend::AgentTicketPhoneOutbound###SenderType

担当者インタフェースのチケット電話アウトバウンド画面で、電話チケットに関するデフォル
トの送信者タイプを設定します。

この設定は無効化することはできません。

デフォルト値:

--- agent

Ticket::Frontend::AgentTicketPhoneOutbound###State

担当者インタフェースの電話応答発信画面で、電話メモを追加した後のチケットのデフォルト
の次の状態を定義します。

デフォルト値:

--- closed successful

Ticket::Frontend::AgentTicketPhoneOutbound###StateType

担当者インタフェースのチケット電話アウトバウンド画面で、電話メモを追加した後の次の可
能性あるチケットの状態です。
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この設定は無効化することはできません。

デフォルト値:

---
- open
- pending auto
- pending reminder
- closed

Ticket::Frontend::AgentTicketPhoneOutbound###Subject

担当者インタフェースのチケット電話アウトバウンド画面で、電話チケットのためのデフォル
トの件名を定義します。

この設定は無効化することはできません。

デフォルト値:

--- ''

153. Frontend → Agent → View →
TicketPrint

Ticket::Frontend::AgentTicketPrint###DynamicField

担当者インターフェイスのチケット印刷画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

154. Frontend → Agent → View →
TicketPriority

Ticket::Frontend::AgentTicketPriority###Body

担当者インタフェースのズームされたチケットのチケット優先度画面で、追加されたメモのデ
フォルトの本文テキストを設定します。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketPriority###DynamicField

担当者インターフェイスのチケット優先度画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketPriority###FormDraft

Allows to save current work as draft in the ticket priority screen of the agent interface.

デフォルト値:

--- '1'
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Ticket::Frontend::AgentTicketPriority###HistoryComment

担当者インタフェースでチケット履歴のために使用される、チケット優先度画面のアクション
のための履歴コメントを定義します。

デフォルト値:

--- '%%Priority'

Ticket::Frontend::AgentTicketPriority###HistoryType

担当者インタフェースでチケット履歴のために使用される、チケット優先度画面のアクション
のための履歴タイプを定義します。

デフォルト値:

--- AddNote

Ticket::Frontend::AgentTicketPriority###InformAgent

担当者インタフェースのズームされたチケットのチケット優先度画面で、全ての可能性ある担
当者（キュー/チケットにメモ許可を有する全ての担当者）のリストを表示し、そのメモについ
て誰に通知するべきかを決定します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###InvolvedAgent

担当者インタフェースのズームされたチケットのチケット優先度画面で、そのチケットに関与
する全ての担当者のリストを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###IsVisibleForCustomerDefault

Defines if the note in the ticket priority screen of the agent interface is visible for the
customer by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###Note

Allows adding notes in the ticket priority screen of a zoomed ticket in the agent
interface. Can be overwritten by Ticket::Frontend::NeedAccountedTime.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPriority###NoteMandatory

Sets if note must be filled in by the agent. Can be overwritten by
Ticket::Frontend::NeedAccountedTime.

デフォルト値:
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--- '1'

Ticket::Frontend::AgentTicketPriority###Owner

担当者インタフェースのズームされたチケットのチケット優先度画面で、チケット所有者を設
定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###OwnerMandatory

チケットの所有者が担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###Permission

担当者インタフェースで、ズームされたチケットのチケット優先度画面を使用するための必要
な許可です。

この設定は無効化することはできません。

デフォルト値:

--- priority

Ticket::Frontend::AgentTicketPriority###Priority

担当者インタフェースのズームされたチケットのチケット優先度画面で、チケット優先度のオ
プションを表示します。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPriority###PriorityDefault

担当者インタフェースのズームされたチケットのチケット優先度画面で、デフォルトのチケッ
ト優先度を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketPriority###Queue

担当者インタフェースのズームされたチケットのチケット優先度画面で、キューを設定しま
す。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###QueueMandatory

担当者がキューを選択する必要があるかどうかを設定します。

デフォルト値:

--- 0
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Ticket::Frontend::AgentTicketPriority###RequiredLock

担当者インタフェースのズームされたチケットのチケット優先度画面で、チケット・ロックが
必要とされるかどうかを定義します（チケットがまだロックされていない場合、チケットは
ロックされ現在の担当者が自動的に所有者として設定されます）。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketPriority###Responsible

担当者インタフェースのズームされたチケットのチケット優先度画面で、チケットの責任を有
する担当者を設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###ResponsibleMandatory

Sets if ticket responsible must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketPriority###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketPriority###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###Service

Sets the service in the ticket priority screen of a zoomed ticket in the agent interface
(Ticket::Service needs to be enabled).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。
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デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###State

Sets the state of the ticket in the ticket priority screen of a zoomed ticket in the agent
interface.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###StateDefault

担当者インタフェースのズームされたチケットのチケット優先度画面で、メモを追加した後
の、デフォルトのチケットの次の状態を定義します。

デフォルト値:

--- open

Ticket::Frontend::AgentTicketPriority###StateMandatory

Sets if state must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###StateType

担当者インタフェースのズームされたチケットのチケット優先度画面で、メモを追加した後の
チケットの次の状態を定義します。

この設定は無効化することはできません。

デフォルト値:

---
- open
- pending reminder
- pending auto

Ticket::Frontend::AgentTicketPriority###Subject

担当者インタフェースのズームされたチケットのチケット優先度画面で、追加されたメモのデ
フォルトの件名を設定します。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketPriority###TicketType

Sets the ticket type in the ticket priority screen of a zoomed ticket in the agent
interface (Ticket::Type needs to be enabled).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketPriority###Title

Shows the title field in the ticket priority screen of a zoomed ticket in the agent
interface.
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デフォルト値:

--- 0

155. Frontend → Agent → View →
TicketProcess

Ticket::Frontend::AgentTicketProcess###SplitLinkType

担当者Webインターフェイスのスプリットチケットのデフォルトリンクタイプを設定します。

デフォルト値:

---
Direction: Target
LinkType: ParentChild

Ticket::Frontend::AgentTicketProcess###StateType

Determines the next possible ticket states, for process tickets in the agent interface.

この設定は無効化することはできません。

デフォルト値:

---
- new
- open
- pending auto
- pending reminder
- closed

Ticket::Frontend::AgentTicketProcess::CustomerIDReadOnly

Controls if CustomerID is read-only in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

156. Frontend → Agent → View →
TicketQueue

Ticket::Frontend::AgentTicketQueue###Blink

最も古いチケットを含むキューの、点滅メカニズムを有効にします。

This setting can be overridden in the user preferences.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketQueue###DefaultColumns

Columns that can be filtered in the queue view of the agent interface. Note: Only
Ticket attributes, Dynamic Fields (DynamicField_NameX) and Customer attributes
(e.g. CustomerUserPhone, CustomerCompanyName, ...) are allowed.
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デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '1'
EscalationUpdateTime: '1'
Lock: '2'
Owner: '2'
PendingTime: '1'
Priority: '1'
Queue: '2'
Responsible: '1'
SLA: '1'
Sender: '2'
Service: '1'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
Type: '1'

Ticket::Frontend::AgentTicketQueue###HideEmptyQueues

Show queues even when only locked tickets are in.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketQueue###HighlightAge1

タッチされていないチケットを含むキューをハイライトするための、経過時間を分で設定しま
す（第1レベル）。

この設定は無効化することはできません。

デフォルト値:

--- '1440'

Ticket::Frontend::AgentTicketQueue###HighlightAge2

タッチされていないチケットを含むキューをハイライトするための、経過時間を分で設定しま
す（第2レベル）。

この設定は無効化することはできません。

デフォルト値:

--- '2880'

Ticket::Frontend::AgentTicketQueue###Order::Default

キュー・ビューの全てのキューに関して、優先度ソートの後の、デフォルトのソート順番を定
義します。

この設定は無効化することはできません。
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デフォルト値:

--- Up

Ticket::Frontend::AgentTicketQueue###PreSort::ByPriority

Defines if a pre-sorting by priority should be done in the queue view.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketQueue###QueueSort

1つのキューがキュー・ビューで選択され、チケットが優先度によってソートされた後に、チ
ケットをソートします（昇順または降順）。Values: 0 = ascending (oldest on top, default),
1 = descending (youngest on top)。キーに関してキューIDを使用し、値（value）に関して
0または1を使用してください。

この設定は標準では有効ではありません。

デフォルト値:

---
'3': '0'
'7': '1'

Ticket::Frontend::AgentTicketQueue###SortBy::Default

Defines the default sort criteria for all queues displayed in the queue view.

この設定は無効化することはできません。

デフォルト値:

--- Age

Ticket::Frontend::AgentTicketQueue###StripEmptyLines

キュー画面で、チケット・プレビューの空の行を削除します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketQueue###UseSubQueues

Include tickets of subqueues per default when selecting a queue.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketQueue###ViewAllPossibleTickets

キュー・ビューで、roとrwの両方全てのキューを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0
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Ticket::Frontend::AgentTicketQueue###VisualAlarms

Enable highlighting queues based on ticket age.

デフォルト値:

--- 0

157. Frontend → Agent → View →
TicketResponsible

Ticket::Frontend::AgentTicketResponsible###Body

担当者インタフェースのチケット責任者画面で、追加されたメモのデフォルトの本文テキスト
を設定します。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketResponsible###DynamicField

担当者インターフェイスのチケット責任者画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketResponsible###FormDraft

Allows to save current work as draft in the ticket responsible screen of the agent
interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketResponsible###HistoryComment

担当者インタフェースでチケット履歴のために使用される、チケット責任者画面のアクション
のための履歴コメントを定義します。

デフォルト値:

--- '%%Responsible'

Ticket::Frontend::AgentTicketResponsible###HistoryType

担当者インタフェースでチケット履歴のために使用される、チケット責任者画面のアクション
のための履歴タイプを定義します。

デフォルト値:

--- AddNote

Ticket::Frontend::AgentTicketResponsible###InformAgent

担当者インタフェースのチケット責任者画面で、全ての可能性ある担当者（キュー/チケットに
メモ許可を有する全ての担当者）のリストを表示し、そのメモについて誰に通知するべきかを
決定します。

この設定は無効化することはできません。
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デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###InvolvedAgent

担当者インタフェースのチケット責任者画面で、そのチケットに関与する全ての担当者のリス
トを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###IsVisibleForCustomerDefault

Defines if the note in the ticket responsible screen of the agent interface is visible for
the customer by default.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###Note

Allows adding notes in the ticket responsible screen of the agent interface. Can be
overwritten by Ticket::Frontend::NeedAccountedTime.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketResponsible###NoteMandatory

Sets if note must be filled in by the agent. Can be overwritten by
Ticket::Frontend::NeedAccountedTime.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketResponsible###Owner

担当者インタフェースのチケット責任者画面で、チケット所有者を設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###OwnerMandatory

チケットの所有者が担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###Permission

担当者インタフェースで、チケット責任者画面を使用するための必要な許可です。

この設定は無効化することはできません。

デフォルト値:

--- responsible
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Ticket::Frontend::AgentTicketResponsible###Priority

担当者インタフェースのチケット責任者画面で、チケット優先度のオプションを表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###PriorityDefault

担当者インタフェースのチケット責任者画面で、デフォルトのチケット優先度を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketResponsible###Queue

担当者インタフェースのズームされたチケットのチケット責任者画面で、キューを設定しま
す。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###QueueMandatory

担当者がキューを選択する必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###RequiredLock

担当者インタフェースのチケット責任者画面で、チケット・ロックが必要とされるかどうかを
定義します（チケットがまだロックされていない場合、チケットはロックされ現在の担当者が
自動的に所有者として設定されます）。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###Responsible

担当者インタフェースのチケット責任者画面で、チケットの責任を持つ担当者を設定します。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketResponsible###ResponsibleMandatory

Sets if ticket responsible must be selected by the agent.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketResponsible###RichTextHeight

Defines the height for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).
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デフォルト値:

--- '100'

Ticket::Frontend::AgentTicketResponsible###RichTextWidth

Defines the width for the rich text editor component for this screen. Enter number
(pixels) or percent value (relative).

デフォルト値:

--- '620'

Ticket::Frontend::AgentTicketResponsible###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###Service

Sets the service in the ticket responsible screen of the agent interface (Ticket::Service
needs to be enabled).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###State

Sets the state of a ticket in the ticket responsible screen of the agent interface.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###StateDefault

担当者インタフェースのチケット責任者画面で、メモを追加した後の、デフォルトのチケット
の次の状態を定義します。

デフォルト値:

--- open

Ticket::Frontend::AgentTicketResponsible###StateMandatory

Sets if state must be selected by the agent.

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###StateType

担当者インタフェースのチケット責任者画面で、メモを追加した後のチケットの次の状態を定
義します。

741



この設定は無効化することはできません。

デフォルト値:

---
- open
- pending reminder
- pending auto

Ticket::Frontend::AgentTicketResponsible###Subject

担当者インタフェースのチケット責任者画面で、追加されたメモのデフォルトの件名を設定し
ます。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketResponsible###TicketType

Sets the ticket type in the ticket responsible screen of the agent interface (Ticket::Type
needs to be enabled).

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketResponsible###Title

Shows the title field in the ticket responsible screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketResponsibleView###DefaultColumns

Columns that can be filtered in the responsible view of the agent interface. Note: Only
Ticket attributes, Dynamic Fields (DynamicField_NameX) and Customer attributes
(e.g. CustomerUserPhone, CustomerCompanyName, ...) are allowed.

デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '1'
EscalationUpdateTime: '1'
Lock: '2'
Owner: '2'
PendingTime: '1'
Priority: '1'
Queue: '2'
Responsible: '1'
SLA: '1'
Sender: '2'
Service: '1'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
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Type: '1'

Ticket::Frontend::AgentTicketResponsibleView###Order::Default

担当者インタフェースの責任ビューで、デフォルトのチケットの順番を定義します。Up: 一番
古いものがトップ. Down: 最新のものがトップ。

この設定は無効化することはできません。

デフォルト値:

--- Up

Ticket::Frontend::AgentTicketResponsibleView###SortBy::Default

担当者インタフェースの責任ビューで、チケット・ソートのためのデフォルトのチケット属性
を定義します。

この設定は無効化することはできません。

デフォルト値:

--- Age

158. Frontend → Agent → View →
TicketSMSNew

Ticket::Frontend::AgentTicketSMS###DynamicField

担当者インターフェイス のSMSチケット画面に表示する ダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketSMS###IsVisibleForCustomer

Sets the default article customer visibility for new SMS tickets in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketSMS###Priority

Sets the default priority for new SMS tickets in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- 3 normal

Ticket::Frontend::AgentTicketSMS###SLAMandatory

SLAが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0
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Ticket::Frontend::AgentTicketSMS###SenderType

Sets the default sender type for new SMS tickets in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- agent

Ticket::Frontend::AgentTicketSMS###ServiceMandatory

サービスが担当者によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketSMS###StateDefault

Sets the default next ticket state, after the creation of an SMS ticket in the agent
interface.

この設定は無効化することはできません。

デフォルト値:

--- open

Ticket::Frontend::AgentTicketSMS###StateType

Determines the next possible ticket states, after the creation of a new SMS ticket in
the agent interface.

この設定は無効化することはできません。

デフォルト値:

---
- open
- pending auto
- pending reminder
- closed

Ticket::Frontend::AgentTicketSMS###Subject

Sets the default title for new SMS tickets in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSMS###Text

Sets the default text for new SMS tickets in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSMS::CustomerIDReadOnly

Controls if CustomerID is read-only in the agent interface.
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この設定は無効化することはできません。

デフォルト値:

--- '1'

159. Frontend → Agent → View →
TicketSMSOutbound

Ticket::Frontend::AgentTicketSMSOutbound###DynamicField

担当者インターフェイス のSMS送信画面に表示する ダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketSMSOutbound###FormDraft

Allows to save current work as draft in the SMS outbound screen of the agent interface.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketSMSOutbound###IsVisibleForCustomerDefault

Defines if the message in the SMS outbound screen of the agent interface is visible
for the customer by default.

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketSMSOutbound###Permission

Required permissions to use the SMS outbound screen in the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- compose

Ticket::Frontend::AgentTicketSMSOutbound###RequiredLock

Defines if a ticket lock is required in the SMS outbound screen of the agent interface
(if the ticket isn't locked yet, the ticket gets locked and the current agent will be set
automatically as its owner).

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketSMSOutbound###StateDefault

Defines the default next state of a ticket after the message has been sent, in the SMS
outbound screen of the agent interface.

デフォルト値:

--- open
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Ticket::Frontend::AgentTicketSMSOutbound###StateType

Defines the next possible states after sending a message in the SMS outbound screen
of the agent interface.

デフォルト値:

---
- open
- closed
- pending reminder
- pending auto

160. Frontend → Agent → View →
TicketSearch

Ticket::Frontend::AgentTicketSearch###ArticleCreateTime

担当者インタフェースのチケット検索で、項目の作成時間を含みます。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketSearch###DefaultColumns

Columns that can be filtered in the ticket search result view of the agent interface.
Note: Only Ticket attributes, Dynamic Fields (DynamicField_NameX) and Customer
attributes (e.g. CustomerUserPhone, CustomerCompanyName, ...) are allowed.

デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '1'
EscalationUpdateTime: '1'
Lock: '2'
Owner: '2'
PendingTime: '1'
Priority: '1'
Queue: '2'
Responsible: '1'
SLA: '1'
Sender: '2'
Service: '1'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
Type: '1'

Ticket::Frontend::AgentTicketSearch###Defaults###ArticleCreateTimePoint

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:
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--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###ArticleCreateTimeSlot

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###CustomerID

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###CustomerUserLogin

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###DynamicField

デフォルトで表示するチケット検索条件を定義します。 Keyはダイナミック・フィールドの名
前（この例の場合は"X"）を指定します。 Contentはダイナミック・フィールドの形式によっ
て設定内容が異なります。 例） [テキスト] ’文字列’ （任意の文字列） [ドロップダウ
ン] '1' （項目の順番） [日時] 'Search_DynamicField_XTimeSlotStartYear=1974;
Search_DynamicField_XTimeSlotStartMonth=01;
Search_DynamicField_XTimeSlotStartDay=26;
Search_DynamicField_XTimeSlotStartHour=00;
Search_DynamicField_XTimeSlotStartMinute=00;
Search_DynamicField_XTimeSlotStartSecond=00;
Search_DynamicField_XTimeSlotStopYear=2013;
Search_DynamicField_XTimeSlotStopMonth=01;
Search_DynamicField_XTimeSlotStopDay=26;
Search_DynamicField_XTimeSlotStopHour=23;
Search_DynamicField_XTimeSlotStopMinute=59;
Search_DynamicField_XTimeSlotStopSecond=59;' and or
'Search_DynamicField_XTimePointFormat=week;
Search_DynamicField_XTimePointStart=Before;
Search_DynamicField_XTimePointValue=7';

This setting can be overridden in the user preferences.

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketSearch###Defaults###Fulltext

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

This setting can be overridden in the user preferences.
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デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###MIMEBase_Body

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###MIMEBase_Cc

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###MIMEBase_From

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###MIMEBase_Subject

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###MIMEBase_To

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###QueueIDs

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- []

Ticket::Frontend::AgentTicketSearch###Defaults###SLAIDs

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。
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この設定は標準では有効ではありません。

デフォルト値:

--- []

Ticket::Frontend::AgentTicketSearch###Defaults###SearchInArchive

Defines the default shown ticket search attribute for ticket search screen (AllTickets/
ArchivedTickets/NotArchivedTickets).

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###ServiceIDs

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- []

Ticket::Frontend::AgentTicketSearch###Defaults###StateIDs

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- []

Ticket::Frontend::AgentTicketSearch###Defaults###TicketChangeTimePoint

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###TicketChangeTimeSlot

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###TicketCloseTimePoint

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''
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Ticket::Frontend::AgentTicketSearch###Defaults###TicketCloseTimeSlot

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###TicketCreateTimePoint

Default data to use on attribute for ticket search screen. Example:
"TicketCreateTimePointFormat=year;TicketCreateTimePointStart=Last;TicketCreateTimePoint=2;".

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###TicketCreateTimeSlot

Default data to use on attribute for ticket search screen. Example:
"TicketCreateTimeStartYear=2010;TicketCreateTimeStartMonth=10;TicketCreateTimeStartDay=4;TicketCreateTimeStopYear=2010;TicketCreateTimeStopMonth=11;TicketCreateTimeStopDay=3;".

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###TicketEscalationTimePoint

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###TicketEscalationTimeSlot

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###TicketNumber

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###Defaults###Title

チケット検索画面で、デフォルトの表示されるチケット検索属性を定義します。

この設定は標準では有効ではありません。

750



デフォルト値:

--- ''

Ticket::Frontend::AgentTicketSearch###DynamicField

担当者インターフェイスのチケット検索画面に表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketSearch###ExtendedSearchCondition

Allows extended search conditions in ticket search of the agent interface. With
this feature you can search e. g. ticket title with this kind of conditions like
"(*key1*&&*key2*)" or "(*key1*||*key2*)".

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketSearch###GlobalProfileGroup

Defines the groups whose agents can set up global search templates.

デフォルト値:

---
- admin

Ticket::Frontend::AgentTicketSearch###Order::Default

担当者インタフェースのチケット検索結果で、デフォルトのチケット順番を定義します。Up:
最も古いものがトップ. Down: 最新のものがトップ。

この設定は無効化することはできません。

デフォルト値:

--- Down

Ticket::Frontend::AgentTicketSearch###SearchArticleCSVTree

検索結果で、全ての項目ツリーをエクスポートします（システム・パフォーマンスに影響が出
る場合があります）。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketSearch###SearchCSVData

検索結果をCSVフォーマットでエクスポートするために使用されるデータです。

この設定は無効化することはできません。

デフォルト値:

---
- TicketNumber
- Age
- Created
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- Closed
- FirstLock
- FirstResponse
- State
- Priority
- Queue
- Lock
- Owner
- UserFirstname
- UserLastname
- CustomerID
- CustomerName
- From
- Subject
- AccountedTime
- ArticleTree
- SolutionInMin
- SolutionDiffInMin
- FirstResponseInMin
- FirstResponseDiffInMin

Ticket::Frontend::AgentTicketSearch###SearchCSVDynamicField

検索結果をCSVフォーマットでエクスポートする際に利用するダイナミック・フィールドで
す。

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketSearch###SearchLimit

担当者インタフェースの検索結果で、表示されるチケットの最大数です。

この設定は無効化することはできません。

デフォルト値:

--- '2000'

Ticket::Frontend::AgentTicketSearch###SearchPageShown

担当者インタフェースの検索結果の各ページで、表示されるチケットの数です。

この設定は無効化することはできません。

デフォルト値:

--- '40'

Ticket::Frontend::AgentTicketSearch###SearchViewableTicketLines

担当者インタフェースの検索ユーティリティにより、表示される行（チケット毎）の数です。

この設定は無効化することはできません。

デフォルト値:

--- '10'

Ticket::Frontend::AgentTicketSearch###SortBy::Default

担当者インタフェースのチケット検索結果のチケット・ソートについて、デフォルトのチケッ
ト属性を定義します。

この設定は無効化することはできません。

デフォルト値:
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--- Age

161. Frontend → Agent → View →
TicketService

Ticket::Frontend::AgentTicketService###DefaultColumns

Columns that can be filtered in the service view of the agent interface. Note: Only
Ticket attributes, Dynamic Fields (DynamicField_NameX) and Customer attributes
(e.g. CustomerUserPhone, CustomerCompanyName, ...) are allowed.

デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '1'
EscalationUpdateTime: '1'
Lock: '2'
Owner: '2'
PendingTime: '1'
Priority: '1'
Queue: '2'
Responsible: '1'
SLA: '1'
Sender: '2'
Service: '2'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
Type: '1'

Ticket::Frontend::AgentTicketService###Order::Default

Defines the default sort order for all services in the service view, after priority sort.

この設定は無効化することはできません。

デフォルト値:

--- Up

Ticket::Frontend::AgentTicketService###PreSort::ByPriority

Defines if a pre-sorting by priority should be done in the service view.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::Frontend::AgentTicketService###ServiceSort

Sorts the tickets (ascendingly or descendingly) when a single queue is selected in the
service view and after the tickets are sorted by priority. Values: 0 = ascending (oldest
on top, default), 1 = descending (youngest on top). Use the ServiceID for the key and
0 or 1 for value.
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この設定は標準では有効ではありません。

デフォルト値:

---
'3': '0'
'7': '1'

Ticket::Frontend::AgentTicketService###SortBy::Default

Defines the default sort criteria for all services displayed in the service view.

この設定は無効化することはできません。

デフォルト値:

--- Age

Ticket::Frontend::AgentTicketService###StripEmptyLines

Strips empty lines on the ticket preview in the service view.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::AgentTicketService###ViewAllPossibleTickets

サービス・ビュー内の読み取り専用と読み書き可能なチケットの両方を全て表示する。

この設定は無効化することはできません。

デフォルト値:

--- 0

162. Frontend → Agent → View →
TicketStatus

Ticket::Frontend::AgentTicketStatusView###DefaultColumns

Columns that can be filtered in the status view of the agent interface. Note: Only
Ticket attributes, Dynamic Fields (DynamicField_NameX) and Customer attributes
(e.g. CustomerUserPhone, CustomerCompanyName, ...) are allowed.

デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '1'
EscalationUpdateTime: '1'
Lock: '2'
Owner: '2'
PendingTime: '1'
Priority: '1'
Queue: '2'
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Responsible: '1'
SLA: '1'
Sender: '2'
Service: '1'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
Type: '1'

Ticket::Frontend::AgentTicketStatusView###Order::Default

担当者インタフェースのステータスビューで、デフォルトのチケット順番（優先度によるソー
トの後）を定義します。Up: 最も古いものがトップ. Down: 最新のものがトップ。

この設定は無効化することはできません。

デフォルト値:

--- Down

Ticket::Frontend::AgentTicketStatusView###SortBy::Default

担当者インタフェースのステータスビューで、チケット・ソートのためのデフォルトのチケッ
ト属性を定義します。

この設定は無効化することはできません。

デフォルト値:

--- Age

Ticket::Frontend::AgentTicketStatusView###ViewableTicketsPage

Number of tickets to be displayed in each page.

この設定は無効化することはできません。

デフォルト値:

--- '50'

163. Frontend → Agent → View →
TicketWatch

Ticket::Frontend::AgentTicketWatchView###DefaultColumns

Columns that can be filtered in the watch view of the agent interface. Note: Only
Ticket attributes, Dynamic Fields (DynamicField_NameX) and Customer attributes
(e.g. CustomerUserPhone, CustomerCompanyName, ...) are allowed.

デフォルト値:

---
Age: '2'
Changed: '1'
Created: '1'
CustomerCompanyName: '1'
CustomerID: '2'
CustomerName: '1'
CustomerUserID: '1'
EscalationResponseTime: '1'
EscalationSolutionTime: '1'
EscalationTime: '1'
EscalationUpdateTime: '1'
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Lock: '2'
Owner: '2'
PendingTime: '1'
Priority: '1'
Queue: '2'
Responsible: '1'
SLA: '1'
Sender: '2'
Service: '1'
State: '2'
Subject: '1'
TicketNumber: '2'
Title: '2'
Type: '1'

Ticket::Frontend::AgentTicketWatchView###Order::Default

担当者インタフェースの監視（watch）ビューで、デフォルトのチケットの順番を定義しま
す。Up: 一番古いものがトップ. Down: 最新のものがトップ。

この設定は無効化することはできません。

デフォルト値:

--- Up

Ticket::Frontend::AgentTicketWatchView###SortBy::Default

担当者インタフェースの監視（watch）ビューで、チケット・ソートのためのデフォルトのチ
ケット属性を定義します。

この設定は無効化することはできません。

デフォルト値:

--- Age

164. Frontend → Agent → View →
TicketZoom

Ticket::Frontend::AgentTicketZoom###DynamicField

担当者インタフェースチケット詳細画面のサイドバーに表示するダイナミック・フィールド

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketZoom###ProcessDisplay

Display settings to override defaults for Process Tickets.

この設定は無効化することはできません。

デフォルト値:

---
NavBarName: Processes
WidgetTitle: Process Information

Ticket::Frontend::AgentTicketZoom###ProcessWidgetDynamicField

担当者インタフェースのチケットプロセス詳細に表示するダイナミック・フィールド

この設定は無効化することはできません。
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デフォルト値:

--- {}

Ticket::Frontend::AgentTicketZoom###ProcessWidgetDynamicFieldGroups

Dynamic fields groups for process widget. The key is the name of the group, the value
contains the fields to be shown. Example: 'Key => My Group', 'Content: Name_X,
NameY'.

この設定は無効化することはできません。

デフォルト値:

--- {}

Ticket::Frontend::AgentTicketZoom###Widgets###0100-TicketInformation

Agent ticket zoom widget that displays ticket data in the side bar.

デフォルト値:

---
Async: '1'
Location: Sidebar
Module: Kernel::Output::HTML::TicketZoom::TicketInformation

Ticket::Frontend::AgentTicketZoom###Widgets###0200-
CustomerInformation

Agent ticket zoom widget that displays customer information for the ticket in the side
bar.

デフォルト値:

---
Async: '1'
Location: Sidebar
Module: Kernel::Output::HTML::TicketZoom::CustomerInformation

Ticket::Frontend::AgentTicketZoom###Widgets###0210-ContactWithData

Agent ticket zoom widget that displays contact with data dynamic field in the side bar.

この設定は無効化することはできません。

デフォルト値:

---
Async: '1'
Location: Sidebar
Module: Kernel::Output::HTML::TicketZoom::ContactWithData

Ticket::Frontend::AgentTicketZoom###Widgets###0300-LinkTable

チケット に リンク されたオブジェクトのテーブルを表示する 担当者 チケット のズームウィ
ジェットです。

デフォルト値:

---
Async: '1'
Location: Main
Module: Kernel::Output::HTML::TicketZoom::LinkTable

Ticket::Frontend::AgentTicketZoom###Widgets###0400-ProcessInformation

Agent ticket zoom widget that displays process information for the ticket.
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デフォルト値:

---
Async: '1'
Location: Process
Module: Kernel::Output::HTML::TicketZoom::ProcessInformation

Ticket::Frontend::AgentZoomExpand

Shows all the articles of the ticket (expanded) in the agent zoom view.

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::ArticleAttachmentModule###1-Download

担当者インタフェースの項目ズーム・ビューにおいて、項目の添付ファイルをダウンロードす
るためのリンクを表示します。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleAttachment::Download

Ticket::Frontend::ArticleAttachmentModule###2-HTML-Viewer

担当者インタフェースの項目ズーム・ビューにおいて、項目の添付ファイルにhtmlオンライ
ン・ビュアーでアクセスするためのリンクを表示します。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleAttachment::HTMLViewer

Ticket::Frontend::ArticlePreViewModule###1-PGP

PGPをチェックするための、担当者インタフェースの項目通知のモジュールです。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleCheck::PGP

Ticket::Frontend::ArticlePreViewModule###2-SMIME

S/MIME-Keyが利用可能かつtrueである場合、Ticket-Zoom-Viewで受信Eメールをチェックす
る、担当者インタフェースのモジュールです。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleCheck::SMIME

Ticket::Frontend::ArticleViewModule###1-PGP

PGPをチェックするための、担当者インタフェースの項目通知のモジュールです。

758



この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleCheck::PGP

Ticket::Frontend::ArticleViewModule###1-SMIME

S/MIME-Keyが利用可能かつtrueである場合、Ticket-Zoom-Viewで受信Eメールをチェックす
る、担当者インタフェースのモジュールです。

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleCheck::SMIME

Ticket::Frontend::HTMLArticleHeightDefault

AgentTicketZoomで、インラインHTML項目のデフォルトの高さ（pixel）を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '100'

Ticket::Frontend::HTMLArticleHeightMax

AgentTicketZoomで、インラインHTML項目の最大高さ（pixel）を設定します。

この設定は無効化することはできません。

デフォルト値:

--- '2500'

Ticket::Frontend::MaxArticlesPerPage

AgentTicketZoomの通常表示モードで1ページあたりに表示する記事の数

この設定は無効化することはできません。

デフォルト値:

--- '1000'

Ticket::Frontend::MaxArticlesZoomExpand

AgentTicketZoomの拡大表示モードで1ページあたりに表示する記事の数

この設定は無効化することはできません。

デフォルト値:

--- '400'

Ticket::Frontend::PlainView

ズームされたEメール・チケットを、プレイン・テキストで見るためのリンクを表示します。

この設定は無効化することはできません。

デフォルト値:
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--- 0

Ticket::Frontend::TicketArticleFilter

ズーム・ビューで、どの項目を表示するか特定するために項目フィルタを有効にします。

この設定は無効化することはできません。

デフォルト値:

--- 0

Ticket::Frontend::ZoomCollectMeta

Whether or not to collect meta information from articles using filters configured in
Ticket::Frontend::ZoomCollectMetaFilters.

This setting can be overridden in the user preferences, but is not active by default.

デフォルト値:

--- 0

Ticket::Frontend::ZoomCollectMetaFilters###CVE-Google

Defines a filter to collect CVE numbers from article texts in AgentTicketZoom. The
results will be displayed in a meta box next to the article. Fill in URLPreview if you
would like to see a preview when moving your mouse cursor above the link element.
This could be the same URL as in URL, but also an alternate one. Please note that
some websites deny being displayed within an iframe (e.g. Google) and thus won't
work with the preview mode.

この設定は標準では有効ではありません。

デフォルト値:

---
Meta:
  Name: CVE Google Search
  Target: _blank
  URL: http://google.com/search?q=<MATCH1>-<MATCH2>-<MATCH3>
  URLPreview: ''
RegExp:
- (CVE|CAN)\-(\d{3,4})\-(\d{2,})

Ticket::Frontend::ZoomCollectMetaFilters###CVE-Mitre

Defines a filter to collect CVE numbers from article texts in AgentTicketZoom. The
results will be displayed in a meta box next to the article. Fill in URLPreview if you
would like to see a preview when moving your mouse cursor above the link element.
This could be the same URL as in URL, but also an alternate one. Please note that
some websites deny being displayed within an iframe (e.g. Google) and thus won't
work with the preview mode.

この設定は標準では有効ではありません。

デフォルト値:

---
Meta:
  Name: CVE Mitre
  Target: _blank
  URL: http://cve.mitre.org/cgi-bin/cvename.cgi?name=<MATCH1>-<MATCH2>-<MATCH3>
  URLPreview: http://cve.mitre.org/cgi-bin/cvename.cgi?name=<MATCH1>-<MATCH2>-<MATCH3>
RegExp:
- (CVE|CAN)\-(\d{3,4})\-(\d{2,})
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Ticket::Frontend::ZoomCustomerTickets

Displays the number of all tickets with the same CustomerID as current ticket in the
ticket zoom view.

デフォルト値:

--- 0

Ticket::Frontend::ZoomExpandSort

担当者インタフェースのチケット・ズームの下で、ノーマルまたは逆順でソートされた項目を
表示します。

この設定は無効化することはできません。

デフォルト値:

--- reverse

Ticket::Frontend::ZoomRichTextForce

リッチ・テキストのライティングが無効にされている場合でも、項目をリッチ・テキストで表
示します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Ticket::ZoomAttachmentDisplayCount

Shows a count of attachments in the ticket zoom, if the article has attachments.

この設定は無効化することはできません。

デフォルト値:

--- '20'

Ticket::ZoomTimeDisplay

チケット・ズーム・ビューで、項目に関してアカウントされた時間を表示します。

この設定は無効化することはできません。

デフォルト値:

--- 0

165. Frontend → Agent → View →
TicketZoom → ArticleAction

Ticket::Frontend::Article::Actions###Chat

Defines available article actions for Chat articles.

この設定は無効化することはできません。

デフォルト値:

---
AgentTicketCompose:
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  Module: Kernel::Output::HTML::ArticleAction::AgentTicketCompose
  Prio: '100'
  Valid: '1'
AgentTicketForward:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketForward
  Prio: '200'
  Valid: '1'
AgentTicketPrint:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPrint
  Prio: '500'
  Valid: '1'
MarkAsImportant:
  Module: Kernel::Output::HTML::ArticleAction::MarkAsImportant
  Prio: '700'
  Valid: '1'

Ticket::Frontend::Article::Actions###Chat###AgentTicketSMSOutbound

Defines available article actions for SMS articles.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleAction::AgentTicketSMSOutbound
Prio: '50'
Valid: '1'

Ticket::Frontend::Article::Actions###Email

Defines available article actions for Email articles.

この設定は無効化することはできません。

デフォルト値:

---
AgentTicketBounce:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketBounce
  Prio: '300'
  Valid: '1'
AgentTicketCompose:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketCompose
  Prio: '100'
  Valid: '1'
AgentTicketEmailResend:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketEmailResend
  Prio: '900'
  Valid: '1'
AgentTicketForward:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketForward
  Prio: '200'
  Valid: '1'
AgentTicketMessageLog:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketMessageLog
  Prio: '550'
  Valid: '1'
AgentTicketNote:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketNote
  Prio: '800'
  Valid: '1'
AgentTicketPhone:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPhone
  Prio: '400'
  Valid: '1'
AgentTicketPlain:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPlain
  Prio: '600'
  Valid: '1'
AgentTicketPrint:
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  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPrint
  Prio: '500'
  Valid: '1'
MarkAsImportant:
  Module: Kernel::Output::HTML::ArticleAction::MarkAsImportant
  Prio: '700'
  Valid: '1'

Ticket::Frontend::Article::Actions###Email###AgentTicketSMSOutbound

Defines available article actions for SMS articles.

この設定は無効化することはできません。

デフォルト値:

---
Module: Kernel::Output::HTML::ArticleAction::AgentTicketSMSOutbound
Prio: '50'
Valid: '1'

Ticket::Frontend::Article::Actions###Internal

Defines available article actions for Internal articles.

この設定は無効化することはできません。

デフォルト値:

---
AgentTicketBounce:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketBounce
  Prio: '300'
  Valid: '1'
AgentTicketCompose:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketCompose
  Prio: '100'
  Valid: '1'
AgentTicketForward:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketForward
  Prio: '200'
  Valid: '1'
AgentTicketNote:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketNote
  Prio: '800'
  Valid: '1'
AgentTicketPhone:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPhone
  Prio: '400'
  Valid: '1'
AgentTicketPlain:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPlain
  Prio: '600'
  Valid: '1'
AgentTicketPrint:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPrint
  Prio: '500'
  Valid: '1'
MarkAsImportant:
  Module: Kernel::Output::HTML::ArticleAction::MarkAsImportant
  Prio: '700'
  Valid: '1'

Ticket::Frontend::Article::Actions###Internal###AgentTicketSMSOutbound

Defines available article actions for SMS articles.

この設定は無効化することはできません。

デフォルト値:
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---
Module: Kernel::Output::HTML::ArticleAction::AgentTicketSMSOutbound
Prio: '50'
Valid: '1'

Ticket::Frontend::Article::Actions###Invalid

Defines available article actions for invalid articles.

この設定は無効化することはできません。

デフォルト値:

---
GetHelpLink:
  Module: Kernel::Output::HTML::ArticleAction::GetHelpLink
  Prio: '100'
  Valid: '1'
ReinstallPackageLink:
  Module: Kernel::Output::HTML::ArticleAction::ReinstallPackageLink
  Prio: '200'
  Valid: '1'

Ticket::Frontend::Article::Actions###Phone

Defines available article actions for Phone articles.

この設定は無効化することはできません。

デフォルト値:

---
AgentTicketBounce:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketBounce
  Prio: '300'
  Valid: '1'
AgentTicketCompose:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketCompose
  Prio: '100'
  Valid: '1'
AgentTicketForward:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketForward
  Prio: '200'
  Valid: '1'
AgentTicketNote:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketNote
  Prio: '800'
  Valid: '1'
AgentTicketPhone:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPhone
  Prio: '400'
  Valid: '1'
AgentTicketPlain:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPlain
  Prio: '600'
  Valid: '1'
AgentTicketPrint:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPrint
  Prio: '500'
  Valid: '1'
MarkAsImportant:
  Module: Kernel::Output::HTML::ArticleAction::MarkAsImportant
  Prio: '700'
  Valid: '1'

Ticket::Frontend::Article::Actions###Phone###AgentTicketSMSOutbound

Defines available article actions for SMS articles.

この設定は無効化することはできません。

764



デフォルト値:

---
Module: Kernel::Output::HTML::ArticleAction::AgentTicketSMSOutbound
Prio: '50'
Valid: '1'

Ticket::Frontend::Article::Actions###SMS

Defines available article actions for SMS articles.

この設定は無効化することはできません。

デフォルト値:

---
AgentTicketCompose:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketCompose
  Prio: '100'
  Valid: '1'
AgentTicketForward:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketForward
  Prio: '200'
  Valid: '1'
AgentTicketPrint:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketPrint
  Prio: '500'
  Valid: '1'
AgentTicketSMSOutbound:
  Module: Kernel::Output::HTML::ArticleAction::AgentTicketSMSOutbound
  Prio: '50'
  Valid: '1'
MarkAsImportant:
  Module: Kernel::Output::HTML::ArticleAction::MarkAsImportant
  Prio: '700'
  Valid: '1'

166. Frontend → Agent → View →
TicketZoom → MenuModule

Ticket::Frontend::MenuModule###000-Back

Shows a link in the menu to go back in the ticket zoom view of the agent interface.
Additional access control to show or not show this link can be done by using Key
"Group" and Content like "rw:group1;move_into:group2". To cluster menu items use
for Key "ClusterName" and for the Content any name you want to see in the UI. Use
"ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: ''
ClusterName: ''
ClusterPriority: ''
Description: Go back
Link: '[% Env("LastScreenOverview") %];TicketID=[% Data.TicketID | html %]'
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Back
PopupType: ''
Target: ''

Ticket::Frontend::MenuModule###100-Lock

Shows a link in the menu to lock/unlock tickets in the ticket zoom view of the agent
interface. Additional access control to show or not show this link can be done by using
Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu items
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use for Key "ClusterName" and for the Content any name you want to see in the UI.
Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketLock
ClusterName: Miscellaneous
ClusterPriority: '800'
Description: Lock / unlock this ticket
Module: Kernel::Output::HTML::TicketMenu::Lock
Name: Lock
Target: ''

Ticket::Frontend::MenuModule###200-History

Shows a link in the menu to access the history of a ticket in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketHistory
ClusterName: Miscellaneous
ClusterPriority: '800'
Description: Show the history for this ticket
Link: Action=AgentTicketHistory;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: History
PopupType: TicketHistory
Target: ''

Ticket::Frontend::MenuModule###210-Print

Shows a link in the menu to print a ticket or an article in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketPrint
ClusterName: ''
ClusterPriority: ''
Description: Print this ticket
Link: Action=AgentTicketPrint;TicketID=[% Data.TicketID | html %]
LinkParam: target="print"
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Print
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###300-Priority

Shows a link in the menu to see the priority of a ticket in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:
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---
Action: AgentTicketPriority
ClusterName: ''
ClusterPriority: ''
Description: Change the priority for this ticket
Link: Action=AgentTicketPriority;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Priority
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###310-FreeText

Shows a link in the menu to add a free text field in the ticket zoom view of the agent
interface. Additional access control to show or not show this link can be done by using
Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu items
use for Key "ClusterName" and for the Content any name you want to see in the UI.
Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketFreeText
ClusterName: Miscellaneous
ClusterPriority: '800'
Description: Change the free fields for this ticket
Link: Action=AgentTicketFreeText;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Free Fields
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###320-Link

Shows a link in the menu that allows linking a ticket with another object in
the ticket zoom view of the agent interface. Additional access control to show
or not show this link can be done by using Key "Group" and Content like
"rw:group1;move_into:group2". To cluster menu items use for Key "ClusterName" and
for the Content any name you want to see in the UI. Use "ClusterPriority" to configure
the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentLinkObject
ClusterName: Miscellaneous
ClusterPriority: '800'
Description: Link this ticket to other objects
Link: Action=AgentLinkObject;SourceObject=Ticket;SourceKey=[% Data.TicketID | html
  %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Link
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###400-Owner

Shows a link in the menu to change the owner of a ticket in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketOwner
ClusterName: People
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ClusterPriority: '430'
Description: Change the owner for this ticket
Link: Action=AgentTicketOwner;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Owner
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###410-Responsible

Shows a link in the menu to change the responsible agent of a ticket in the ticket zoom
view of the agent interface. Additional access control to show or not show this link
can be done by using Key "Group" and Content like "rw:group1;move_into:group2".
To cluster menu items use for Key "ClusterName" and for the Content any name you
want to see in the UI. Use "ClusterPriority" to configure the order of a certain cluster
within the toolbar.

デフォルト値:

---
Action: AgentTicketResponsible
ClusterName: People
ClusterPriority: '430'
Description: Change the responsible for this ticket
Link: Action=AgentTicketResponsible;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Responsible
Name: Responsible
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###420-Attachments

チケットで有効なすべての添付を表示する

デフォルト値:

---
Action: AgentTicketAttachmentView
ClusterName: Miscellaneous
ClusterPriority: '999'
Description: View all attachments of the current ticket.
Link: Action=AgentTicketAttachmentView;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::AttachmentView
Name: Attachments
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###420-Customer

Shows a link in the menu to change the customer who requested the ticket
in the ticket zoom view of the agent interface. Additional access control to
show or not show this link can be done by using Key "Group" and Content like
"rw:group1;move_into:group2". To cluster menu items use for Key "ClusterName" and
for the Content any name you want to see in the UI. Use "ClusterPriority" to configure
the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketCustomer
ClusterName: People
ClusterPriority: '430'
Description: Change the customer for this ticket
Link: Action=AgentTicketCustomer;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Customer
PopupType: TicketAction
Target: ''
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Ticket::Frontend::MenuModule###420-Note

Shows a link in the menu to add a note in the ticket zoom view of the agent interface.
Additional access control to show or not show this link can be done by using Key
"Group" and Content like "rw:group1;move_into:group2". To cluster menu items use
for Key "ClusterName" and for the Content any name you want to see in the UI. Use
"ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketNote
ClusterName: Communication
ClusterPriority: '435'
Description: Add a note to this ticket
Link: Action=AgentTicketNote;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Note
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###425-Phone Call Outbound

Shows a link in the menu to add a phone call outbound in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketPhoneOutbound
ClusterName: Communication
ClusterPriority: '435'
Description: Add an outbound phone call to this ticket
Link: Action=AgentTicketPhoneOutbound;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Phone Call Outbound
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###426-Phone Call Inbound

Shows a link in the menu to add a phone call inbound in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketPhoneInbound
ClusterName: Communication
ClusterPriority: '435'
Description: Add an inbound phone call to this ticket
Link: Action=AgentTicketPhoneInbound;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Phone Call Inbound
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###427-Email Outbound

Shows a link in the menu to send an outbound email in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
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using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketEmailOutbound
ClusterName: Communication
ClusterPriority: '435'
Description: Send new outgoing mail from this ticket
Link: Action=AgentTicketEmailOutbound;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: E-Mail Outbound
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###429-SMS Outbound

Shows a link in the menu to send an outbound SMS in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketSMSOutbound
ClusterName: Communication
ClusterPriority: '435'
Description: Send new outgoing SMS from this ticket
Link: Action=AgentTicketSMSOutbound;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::SMS
Name: SMS Outbound
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###430-Merge

Shows a link in the menu that allows merging tickets in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketMerge
ClusterName: Miscellaneous
ClusterPriority: '800'
Description: Merge this ticket and all articles into another ticket
Link: Action=AgentTicketMerge;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Merge
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###440-Pending

Shows a link in the menu to set a ticket as pending in the ticket zoom view of the
agent interface. Additional access control to show or not show this link can be done by
using Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu
items use for Key "ClusterName" and for the Content any name you want to see in the
UI. Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.
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デフォルト値:

---
Action: AgentTicketPending
ClusterName: ''
ClusterPriority: ''
Description: Set this ticket to pending
Link: Action=AgentTicketPending;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Pending
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###448-Watch

Shows a link in the menu for subscribing / unsubscribing from a ticket in
the ticket zoom view of the agent interface. Additional access control to show
or not show this link can be done by using Key "Group" and Content like
"rw:group1;move_into:group2". To cluster menu items use for Key "ClusterName" and
for the Content any name you want to see in the UI. Use "ClusterPriority" to configure
the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketWatcher
ClusterName: ''
ClusterPriority: ''
Description: Watch this ticket
Module: Kernel::Output::HTML::TicketMenu::TicketWatcher
Name: Watch
Target: ''

Ticket::Frontend::MenuModule###450-Close

Shows a link in the menu to close a ticket in the ticket zoom view of the agent interface.
Additional access control to show or not show this link can be done by using Key
"Group" and Content like "rw:group1;move_into:group2". To cluster menu items use
for Key "ClusterName" and for the Content any name you want to see in the UI. Use
"ClusterPriority" to configure the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentTicketClose
ClusterName: ''
ClusterPriority: ''
Description: Close this ticket
Link: Action=AgentTicketClose;TicketID=[% Data.TicketID | html %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Close
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###460-Delete

Shows a link in the menu to delete a ticket in the ticket zoom view of the agent
interface. Additional access control to show or not show this link can be done by using
Key "Group" and Content like "rw:group1;move_into:group2". To cluster menu items
use for Key "ClusterName" and for the Content any name you want to see in the UI.
Use "ClusterPriority" to configure the order of a certain cluster within the toolbar.

この設定は標準では有効ではありません。

デフォルト値:

---
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Action: AgentTicketMove
ClusterName: ''
ClusterPriority: ''
Description: Delete this ticket
Link: Action=AgentTicketMove;TicketID=[% Data.TicketID %];DestQueue=Delete
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Delete
PopupType: ''
Target: ''

Ticket::Frontend::MenuModule###470-Junk

Shows a link to set a ticket as junk in the ticket zoom view of the agent interface.
Additional access control to show or not show this link can be done by using Key
"Group" and Content like "rw:group1;move_into:group2". To cluster menu items use
for Key "ClusterName" and for the Content any name you want to see in the UI. Use
"ClusterPriority" to configure the order of a certain cluster within the toolbar.

この設定は標準では有効ではありません。

デフォルト値:

---
Action: AgentTicketMove
ClusterName: ''
ClusterPriority: ''
Description: Mark this ticket as junk!
Link: Action=AgentTicketMove;TicketID=[% Data.TicketID %];DestQueue=Junk
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: Spam
PopupType: ''
Target: ''

Ticket::Frontend::MenuModule###480-Process

Shows a link in the menu to enroll a ticket into a process in the ticket zoom view of
the agent interface.

デフォルト値:

---
Action: AgentTicketProcess
Cluster: ''
Description: Enroll process for this ticket
Link: Action=AgentTicketProcess;IsProcessEnroll=1;TicketID=[% Data.TicketID | html
  %]
Module: Kernel::Output::HTML::TicketMenu::Process
Name: Process
PopupType: TicketAction
Target: ''

Ticket::Frontend::MenuModule###500-ExternalLink

Shows link to external page in the ticket zoom view of the agent interface. Additional
access control to show or not show this link can be done by using Key "Group" and
Content like "rw:group1;move_into:group2".

この設定は標準では有効ではありません。

デフォルト値:

---
Action: ''
ClusterName: Miscellaneous
ClusterPriority: ''
Description: Open an external link!
ExternalLink: '1'
Link: http://external-application.test/app/index.php?TicketID=[% Data.TicketID
 %]&queue_id=[%
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  Data.QueueID %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: External Link
PopupType: ''
Target: _blank

Ticket::Frontend::MenuModule###550-Appointment

Shows a link in the menu for creating a calendar appointment linked to the ticket
directly from the ticket zoom view of the agent interface. Additional access control
to show or not show this link can be done by using Key "Group" and Content like
"rw:group1;move_into:group2". To cluster menu items use for Key "ClusterName" and
for the Content any name you want to see in the UI. Use "ClusterPriority" to configure
the order of a certain cluster within the toolbar.

デフォルト値:

---
Action: AgentAppointmentCalendarOverview
ClusterName: Miscellaneous
ClusterPriority: '800'
Description: Create a new calendar appointment linked to this ticket
Link:
 Action=AgentAppointmentCalendarOverview;Subaction=AppointmentCreate;PluginKey=0100-
Ticket;ObjectID=[%
  Data.TicketID | uri %]
Module: Kernel::Output::HTML::TicketMenu::Generic
Name: New Appointment
PopupType: ''
Target: ''

167. Frontend → Base
AttachmentDownloadType

チケットの添付をブラウザに表示するか（インライン）、単にダウンロードできるようにする
か（アタッチメント）、選択できるようにします。

この設定は無効化することはできません。

デフォルト値:

--- attachment

DefaultLanguage

デフォルトのフロント・エンドの言語を設定します。全ての可能性ある値は、システムの利用
可能な言語ファイルによって定義されます（次の設定を参照ください)。.

この設定は無効化することはできません。

デフォルト値:

--- en

DefaultTheme

Defines the default front-end (HTML) theme to be used by the agents. If you like, you
can add your own theme. Please refer the administrator manual located at http://
otrs.github.io/doc/.

この設定は無効化することはできません。

デフォルト値:
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--- Standard

DefaultTheme::HostBased

It is possible to configure different themes to be used on a per-domain basis within
the application. Using a regular expression (regex), you can configure a Key/Content
pair to match a domain. The value in "Key" should match the domain, and the value
in "Content" should be a valid theme on your system. Please see the example entries
for the proper form of the regex.

この設定は標準では有効ではありません。

デフォルト値:

---
host1\.example\.com: SomeTheme1
host2\.example\.com: SomeTheme2

DefaultUsedLanguages

Defines all the languages that are available to the application. Specify only English
names of languages here.

この設定は無効化することはできません。

デフォルト値:

---
ar_SA: Arabic (Saudi Arabia)
bg: Bulgarian
ca: Catalan
cs: Czech
da: Danish
de: German
el: Greek
en: English (United States)
en_CA: English (Canada)
en_GB: English (United Kingdom)
es: Spanish
es_CO: Spanish (Colombia)
es_MX: Spanish (Mexico)
et: Estonian
fa: Persian
fi: Finnish
fr: French
fr_CA: French (Canada)
gl: Galician
he: Hebrew
hi: Hindi
hr: Croatian
hu: Hungarian
id: Indonesian
it: Italian
ja: Japanese
ko: Korean
lt: Lithuanian
lv: Latvian
ms: Malay
nb_NO: Norwegian
nl: Dutch
pl: Polish
pt: Portuguese
pt_BR: Portuguese (Brasil)
ru: Russian
sk_SK: Slovak
sl: Slovenian
sr_Cyrl: Serbian Cyrillic
sr_Latn: Serbian Latin
sv: Swedish
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sw: Swahili
th_TH: Thai
tr: Turkish
uk: Ukrainian
vi_VN: Vietnam
zh_CN: Chinese (Simplified)
zh_TW: Chinese (Traditional)

DefaultUsedLanguagesNative

Defines all the languages that are available to the application. Specify only native
names of languages here.

この設定は無効化することはできません。

デフォルト値:

---
ar_SA: العَرَبِية
bg: Български
ca: Català
cs: Česky
da: Dansk
de: Deutsch
el: Ελληνικά
en: English (United States)
en_CA: English (Canada)
en_GB: English (United Kingdom)
es: Español
es_CO: Español (Colombia)
es_MX: Español (México)
et: Eesti
fa: فارسى
fi: Suomi
fr: Français
fr_CA: Français (Canada)
gl: Galego
he: #####
hi: ######
hr: Hrvatski
hu: Magyar
id: Bahasa Indonesia
it: Italiano
ja: 日本語
ko: 한국어
lt: Lietuvių kalba
lv: Latvijas
ms: Melayu
nb_NO: Norsk bokmål
nl: Nederlandse
pl: Polski
pt: Português
pt_BR: Português Brasileiro
ru: Русский
sk_SK: Slovenčina
sl: Slovenščina
sr_Cyrl: Српски
sr_Latn: Srpski
sv: Svenska
sw: Kiswahili
th_TH: #######
tr: Türkçe
uk: Українська
vi_VN: Vi#t Nam
zh_CN: 简体中文
zh_TW: 正體中文

DefaultViewLines

テキスト・メッセージに表示される行の数を設定します（つまり、キュー・ズーム内のチケッ
ト・ラインのためです）。
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この設定は無効化することはできません。

デフォルト値:

--- '6000'

DefaultViewNewLine

X個の文字型の後の、テキスト・メッセージにおける自動化されたライン・ブレイク。

この設定は無効化することはできません。

デフォルト値:

--- '90'

DisableContentSecurityPolicy

HTTPヘッダ"Content-Security-Policy”を無効化し、外部のスクリプトコンテンツの読み込みを
許可します。 このHTTPヘッダを無効にすることにより、セキュリティ上の問題が生じること
があります! 変更内容をよく理解している場合に限り無効化を実行してください!

デフォルト値:

--- 0

DisableIFrameOriginRestricted

HTTPヘッダ"X-Frame-Options: SAMEORIGIN”を無効化し、OTRSを外部のWebサイトの一部と
してiframeに埋め込むことを許可します。 このHTTPヘッダを無効にすることにより、セキュ
リティ上の問題が生じることがあります! 変更内容をよく理解している場合に限り無効化を実行
してください!

デフォルト値:

--- 0

FirstnameLastnameOrder

担当者の姓と名を表示する順序を指定してください。

この設定は無効化することはできません。

デフォルト値:

--- 0

Frontend::AjaxDebug

Delivers extended debugging information in the frontend in case any AJAX errors
occur, if enabled.

この設定は無効化することはできません。

デフォルト値:

--- 0

Frontend::DebugMode

Enables or disables the debug mode over frontend interface.

デフォルト値:
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--- 0

Frontend::MenuDragDropEnabled

メイン画面でドラッグアンドドロップを有効にします。

この設定は無効化することはできません。

デフォルト値:

--- '1'

Frontend::PrefixPath

Needed for operation behind a reverse proxy with a prefix path. Specify with leading,
but without trailing slash (e.g. '/prefix/path').

この設定は無効化することはできません。

デフォルト値:

--- ''

Frontend::RichText

作成と表示確認にリッチテキストを利用します。: 記事、挨拶、署名、標準テンプレート、自動
応答と通知

この設定は無効化することはできません。

デフォルト値:

--- '1'

Frontend::RichText::DefaultCSS

リッチテキスト・エディターで使用されるデフォルトCSSを定義します。

この設定は無効化することはできません。

デフォルト値:

--- 'font-family:Geneva,Helvetica,Arial,sans-serif; font-size: 12px;'

Frontend::RichText::EnhancedMode

Defines if the enhanced mode should be used (enables use of table, replace, subscript,
superscript, paste from word, etc.).

この設定は無効化することはできません。

デフォルト値:

--- 0

Frontend::RichTextHeight

Defines the height for the rich text editor component. Enter number (pixels) or percent
value (relative).

この設定は無効化することはできません。

デフォルト値:

--- '320'
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Frontend::RichTextPath

URLリッチテキスト・エディター・パスを定義します。

この設定は無効化することはできません。

デフォルト値:

--- <OTRS_CONFIG_Frontend::PrefixPath>/htdocs/js/thirdparty/ckeditor-4.7.0/

Frontend::RichTextWidth

リッチテキスト・エディター・コンポーネントを定義します。数字（ピクセル）またはパーセ
ント値（相対的）を入力します。

この設定は無効化することはできません。

デフォルト値:

--- '620'

Frontend::TemplateCache

Enables or disables the caching for templates. WARNING: Do NOT disable template
caching for production environments for it will cause a massive performance drop!
This setting should only be disabled for debugging reasons!

この設定は無効化することはできません。

デフォルト値:

--- '1'

Frontend::Themes

システムで利用可能なテーマをアクティベートします。値1がアクティブ、0が非アクティブを
意味します。

デフォルト値:

---
Lite: '0'
Standard: '1'

HTTPSForceRedirect

Whether to force redirect all requests from http to https protocol. Please check that
your web server is configured correctly for https protocol before enable this option.

この設定は無効化することはできません。

デフォルト値:

--- 0

HttpType

アプリケーションにサービスを提供するWebサーバが使用するプロトコルの種類を定義しま
す。 HTTPSプロトコルをプレーンHTTPの代わりに使用する場合はここで指定する必要があり
ます。これがないWebサーバの設定や行動に影響を与えるので、アプリケーションへのアクセ
スの方法を変更しないと、それが間違っている場合、アプリケーションにログインできなくな
ることがあります。この設定は、システム内でのチケットへのリンクを構成するためにアプリ
ケーションが使用するメッセージングのすべての形態で発見されている変
数、OTRS_CONFIG_HttpTypeとして使用されます。
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この設定は無効化することはできません。

デフォルト値:

--- http

OutOfOfficeMessageTemplate

Defines out of office message template. Two string parameters (%s) available: end
date and number of days left.

デフォルト値:

--- '*** out of office until %s (%s d left) ***'

WebMaxFileUpload

ブラウザからOTRSへファイルアップロードする最大サイズ（バイト単位）を定義します。 警
告：このオプションを低すぎる値に設定すると、OTRSインスタンス内の多くのインプット機能
が機能しなくなる可能性があります。

この設定は無効化することはできません。

デフォルト値:

--- '24000000'

WebUploadCacheModule

ウェブ・インタフェースを通じてアップロードを取り扱うための、モジュールを選択しま
す。"DB"は全てのアップロードをデータベースに格納し、"FS"はファイル・システムを使用し
ます。

この設定は無効化することはできません。

デフォルト値:

--- Kernel::System::Web::UploadCache::DB

168. Frontend → Base → Loader
Loader::Agent::CommonCSS###000-Framework

担当者インタフェースに対して、常にロードされるCSSファイルのリストです。

この設定は無効化することはできません。

デフォルト値:

---
- Core.Reset.css
- Core.Default.css
- Core.Header.css
- Core.OverviewControl.css
- Core.OverviewSmall.css
- Core.OverviewMedium.css
- Core.OverviewLarge.css
- Core.Footer.css
- Core.PageLayout.css
- Core.Form.css
- Core.Table.css
- Core.Login.css
- Core.Widget.css
- Core.WidgetMenu.css
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- Core.TicketDetail.css
- Core.Tooltip.css
- Core.Dialog.css
- Core.InputFields.css
- Core.Print.css
- Core.Animations.css
- Core.DocumentSearch.css

Loader::Agent::CommonCSS###001-Daemon

担当者インタフェースに対して、常にロードされるCSSファイルのリストです。

この設定は無効化することはできません。

デフォルト値:

---
- Core.Agent.Daemon.css

Loader::Agent::CommonCSS###200-FAQ

担当者インタフェースに対して、常にロードされるCSSファイルのリストです。

この設定は無効化することはできません。

デフォルト値:

---
- Core.Agent.FAQ.Default.css

Loader::Agent::CommonJS###000-Framework

担当者インタフェースに対して、常にロードされるJSファイルのリストです。

この設定は無効化することはできません。

デフォルト値:

---
- thirdparty/jquery-3.2.1/jquery.js
- thirdparty/jquery-browser-detection/jquery-browser-detection.js
- thirdparty/jquery-ui-1.12.1/jquery-ui.js
- thirdparty/jquery-ui-touch-punch-0.2.3/jquery.ui.touch-punch.js
- thirdparty/jquery-validate-1.16.0/jquery.validate.js
- thirdparty/jquery-pubsub/pubsub.js
- thirdparty/jquery-jstree-3.3.4/jquery.jstree.js
- thirdparty/nunjucks-3.0.1/nunjucks.js
- Core.Init.js
- Core.JavaScriptEnhancements.js
- Core.Debug.js
- Core.Exception.js
- Core.Data.js
- Core.Config.js
- Core.Language.js
- Core.Template.js
- Core.JSON.js
- Core.App.js
- Core.App.Responsive.js
- Core.AJAX.js
- Core.UI.js
- Core.UI.InputFields.js
- Core.UI.Accordion.js
- Core.UI.Datepicker.js
- Core.UI.DnD.js
- Core.UI.Floater.js
- Core.UI.Resizable.js
- Core.UI.Table.js
- Core.UI.Accessibility.js
- Core.UI.RichTextEditor.js
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- Core.UI.Dialog.js
- Core.UI.ActionRow.js
- Core.UI.Popup.js
- Core.UI.TreeSelection.js
- Core.UI.Autocomplete.js
- Core.Form.js
- Core.Form.ErrorTooltips.js
- Core.Form.Validate.js
- Core.Agent.js
- Core.Agent.Search.js
- Core.Agent.DocumentSearch.js
- Core.Agent.CustomerInformationCenterSearch.js
- Core.Agent.CustomerSearch.js
- Core.Agent.CustomerUserInformationCenterSearch.js
- Core.Agent.Header.js
- Core.UI.Notification.js
- Core.Agent.Responsive.js

Loader::Agent::CommonJS###001-Daemon

担当者インタフェースに対して、常にロードされるJSファイルのリストです。

この設定は無効化することはできません。

デフォルト値:

---
- Core.Agent.Daemon.js

Loader::Agent::CommonJS###001-JQueryMigrate

担当者インタフェースに対して、常にロードされるJSファイルのリストです。

この設定は標準では有効ではありません。

デフォルト値:

---
- thirdparty/jquery-migrate-3.0.0/jquery-migrate.js

Loader::Agent::CommonJS###002-Ticket

担当者インタフェースに対して、常にロードされるJSファイルのリストです。

この設定は無効化することはできません。

デフォルト値:

---
- Core.Agent.Chat.Toolbar.js
- Core.VideoChat.js
- thirdparty/adapter.js-6.4.0/adapter.js

Loader::Agent::CommonJS###100-CKEditor

担当者インタフェースに対して、常にロードされるJSファイルのリストです。

この設定は無効化することはできません。

デフォルト値:

---
- thirdparty/ckeditor-4.7.0/ckeditor.js

Loader::Agent::CommonJS###200-DynamicFieldContactWithData

担当者インタフェースに対して、常にロードされるJSファイルのリストです。
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この設定は無効化することはできません。

デフォルト値:

---
- Core.Agent.DynamicFieldContactWithDataSearch.js

Loader::Agent::CommonJS###200-FAQ

担当者インタフェースに対して、常にロードされるJSファイルのリストです。

この設定は無効化することはできません。

デフォルト値:

---
- Core.Agent.FAQ.TicketCompose.js

Loader::Agent::DefaultSelectedSkin

担当者インタフェースで使用されるべき、担当者スキンのインターナル・ネームで
す。Frontend::Agent::Skinsにおける利用可能なスキンをチェックしてください。

この設定は無効化することはできません。

デフォルト値:

--- default

Loader::Agent::DefaultSelectedSkin::HostBased

アプリケーション内でドメインごとのベースで使用されている異なる担当者間を区別するため
など、異なるスキンを設定することが可能です。通常の表現（regrex）を使用すること
で、Key/Contentのペアをドメインにマッチするように設定することが可能です。“Key”の値は
ドメインにマッチするべきであり、“Content”の値はご利用のシステムの有効なスキンであるべ
きです。Regrexの適切な形式については、入力例を参照してください。

この設定は標準では有効ではありません。

デフォルト値:

---
host1\.example\.com: SomeSkin1
host2\.example\.com: SomeSkin2

Loader::Agent::ResponsiveCSS###000-Framework

List of responsive CSS files to always be loaded for the agent interface.

この設定は無効化することはできません。

デフォルト値:

---
- Core.Responsive.css

Loader::Agent::Skin###000-default

担当者インターフェースのデフォルトスキン

デフォルト値:

---
Description: The Default skin of OTRS.
HomePage: www.otrs.org
InternalName: default
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VisibleName: OTRS

Loader::Agent::Skin###001-slim

担当者インターフェースのデフォルトスキン (スリムバージョン)

デフォルト値:

---
Description: A more compact version of the OTRS skin which tries to save screen space
  for power users.
HomePage: www.otrs.org
InternalName: slim
VisibleName: Slim

Loader::Agent::Skin###002-high-contrast

High contrast skin for visually impaired users.

デフォルト値:

---
Description: High contrast skin for visually impaired users.
HomePage: www.otrs.com
InternalName: highcontrast
VisibleName: High Contrast

Loader::Enabled::CSS

If enabled, OTRS will deliver all CSS files in minified form.

この設定は無効化することはできません。

デフォルト値:

--- '1'

Loader::Enabled::JS

有効にすると、OTRSは全JavaScriptファイルを縮小した形式で配信します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

169. Frontend → Base →
NavBarModule

Frontend::AdminModuleGroups###001-Framework

Defines available groups for the admin overview screen.

この設定は無効化することはできません。

デフォルト値:

---
Administration:
  Order: '6000'
  Title: Administration
Automation:
  Order: '4000'
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  Title: Processes & Automation
Communication:
  Order: '2000'
  Title: Communication & Notifications
External:
  Order: '4500'
  Title: External Interface
Miscellaneous:
  Order: '7000'
  Title: Miscellaneous
OTRSGroup:
  Order: '5000'
  Title: OTRS Group Services
Ticket:
  Order: '1000'
  Title: Ticket Settings
Users:
  Order: '3000'
  Title: Users, Groups & Roles

170. Frontend → Base → OutputFilter
Frontend::Output::FilterText###AAAURL

URLをハイライトするため、項目の中のテキストを処理するフィルタを定義します。

デフォルト値:

---
Module: Kernel::Output::HTML::FilterText::URL
Templates:
  AgentTicketZoom: '1'

Frontend::Output::FilterText###OutputFilterTextAutoLink

事前定義されたキーワードをハイライトするため、項目の中のテキストを処理するフィルタを
定義します。

この設定は標準では有効ではありません。

デフォルト値:

---
Module: Kernel::Output::HTML::FilterText::AutoLink
Templates:
  AgentTicketZoom: '1'

Frontend::Output::OutputFilterTextAutoLink###Bugtraq

バグトラック・ナンバーの後ろにリンクを追加するhtmlアウトプットのための、フィルタを定
義します。エレメント・イメージは、2種類のインプットを許可します。すぐに、イメージの
名前です（つまりfaq.png）。この場合、OTRSイメージ・パスが使用されます。2つめの可能性
は、イメージにリンクを挿入することです。

この設定は標準では有効ではありません。

デフォルト値:

---
RegExp:
- Bugtraq[\s\w\t]*?ID[\s\w\t]*?:[\s\w\t]*?(\d{2,8})
- Bugtraq[\s\w\t]*?ID[\s\w\t]*?(\d{2,8})
- Bugtraq[\s\w\t]*?:[\s\w\t]*?(\d{2,8})
- Bugtraq[\s\w\t]*?(\d{2,8})
- BID[\s\w\t]*?:[\s\w\t]*?(\d{2,8})
- BID[\s\w\t]*?(\d{2,8})
Templates:
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  AgentTicketZoom: '1'
URL1:
  Description: Security Focus
  Image: http://www.securityfocus.com/favicon.ico
  Target: _blank
  URL: http://www.securityfocus.com/bid/<MATCH1>/info
URL2:
  Description: Google
  Image: http://www.google.de/favicon.ico
  Target: _blank
  URL: http://google.com/search?q=<MATCH>

Frontend::Output::OutputFilterTextAutoLink###CVE

CVEナンバーの後ろにリンクを追加するhtmlアウトプットのための、フィルタを定義します。
エレメント・イメージは、2種類のインプットを許可します。すぐに、イメージの名前です
（つまりfaq.png）。この場合、OTRSイメージ・パスが使用されます。2つめの可能性は、イ
メージにリンクを挿入することです。

この設定は標準では有効ではありません。

デフォルト値:

---
RegExp:
- (CVE|CAN)\-(\d{3,4})\-(\d{2,})
Templates:
  AgentTicketZoom: '1'
URL1:
  Description: Mitre
  Image: http://cve.mitre.org/favicon.ico
  Target: _blank
  URL: http://cve.mitre.org/cgi-bin/cvename.cgi?name=<MATCH1>-<MATCH2>-<MATCH3>
URL2:
  Description: Google
  Image: http://www.google.de/favicon.ico
  Target: _blank
  URL: http://google.com/search?q=<MATCH1>-<MATCH2>-<MATCH3>
URL3:
  Description: US-CERT NVD
  Image: http://nvd.nist.gov/favicon.ico
  Target: _blank
  URL: http://nvd.nist.gov/nvd.cfm?cvename=<MATCH1>-<MATCH2>-<MATCH3>

Frontend::Output::OutputFilterTextAutoLink###FAQ

フィルタ定義　-定義された文字列（string）にリンクを追加するhtmlアウトプット- エレメン
ト・イメージは、2種類のインプットが可能です。1つ目、イメージの名前です (例. faq.png)。
この場合、OTRSイメージ・パスが使用されます。2つ目、イメージにリンクを挿入することが
可能性です。

この設定は標準では有効ではありません。

デフォルト値:

---
RegExp:
- (FAQ)[#\s]*?1(\d{4})
URL1:
  Description: FAQ
  Image: /otrs-web/skins/Agent/default/img/help-small.png
  Target: _blank
  URL: /otrs/index.pl?Action=AgentFAQZoom;ItemID=<MATCH2>

Frontend::Output::OutputFilterTextAutoLink###MSBulletins

MSBulletinナンバーの後ろにリンクを追加するhtmlアウトプットのための、フィルタを定義
します。エレメント・イメージは、2種類のインプットを許可します。すぐに、イメージの名
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前です（つまりfaq.png）。この場合、OTRSイメージ・パスが使用されます。2つめの可能性
は、イメージにリンクを挿入することです。

この設定は標準では有効ではありません。

デフォルト値:

---
RegExp:
- MS[^A-Za-z]{0,5}(\d\d).?(\d{2,4})
Templates:
  AgentTicketZoom: '1'
URL1:
  Description: Microsoft Technet
  Image: http://www.microsoft.com/favicon.ico
  Target: _blank
  URL: http://www.microsoft.com/technet/security/bulletin/MS<MATCH1>-<MATCH2>.mspx
URL2:
  Description: Google
  Image: http://www.google.de/favicon.ico
  Target: _blank
  URL: http://google.com/search?q=MS<MATCH1>-<MATCH2>

Frontend::Output::OutputFilterTextAutoLink###Setting1

定義された文字列（string）の後ろにリンクを追加するhtmlアウトプットのための、フィルタ
を定義します。エレメント・イメージは、2種類のインプットを許可します。すぐに、イメー
ジの名前です（つまりfaq.png）。この場合、OTRSイメージ・パスが使用されます。2つめの可
能性は、イメージにリンクを挿入することです。

この設定は標準では有効ではありません。

デフォルト値:

---
RegExp:
- RegExp
Templates:
  AgentTicketZoom: '1'
URL1:
  Description: Description
  Image: right-small.png
  Target: _blank
  URL: URL
URL2:
  Description: Description
  Image: Image
  Target: _blank
  URL: URL

Frontend::Output::OutputFilterTextAutoLink###Setting2

定義された文字列（string）の後ろにリンクを追加するhtmlアウトプットのための、フィルタ
を定義します。エレメント・イメージは、2種類のインプットを許可します。すぐに、イメー
ジの名前です（つまりfaq.png）。この場合、OTRSイメージ・パスが使用されます。2つめの可
能性は、イメージにリンクを挿入することです。

この設定は標準では有効ではありません。

デフォルト値:

---
RegExp:
- RegExp
Templates:
  AgentTicketZoom: '1'
URL1:
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  Description: Description
  Image: right-small.png
  Target: _blank
  URL: URL
URL2:
  Description: Description
  Image: Image
  Target: _blank
  URL: URL
URL3:
  Description: Description
  Image: Image
  Target: _blank
  URL: URL

171. Frontend → External
ExternalFrontend::CustomizationColors

List of colors in hexadecimal RGB which will be available for selection during
customization of the external interface. Make sure the colors are dark enough so white
text can be overlayed on them.

デフォルト値:

---
- '#000000'
- '#1E1E1E'
- '#3A3A3A'
- '#545453'
- '#6E6E6E'
- '#878687'
- '#888787'
- '#A09FA0'
- '#B8B8B8'
- '#D0D0D0'
- '#E8E8E8'
- '#FFFFFF'
- '#891100'
- '#894800'
- '#888501'
- '#458401'
- '#028401'
- '#018448'
- '#008688'
- '#004A88'
- '#001888'
- '#491A88'
- '#891E88'
- '#891648'
- '#FF2101'
- '#FF8802'
- '#FFFA03'
- '#83F902'
- '#05F802'
- '#03F987'
- '#00FDFF'
- '#008CFF'
- '#002EFF'
- '#8931FF'
- '#FF39FF'
- '#FF2987'
- '#FF726E'
- '#FFCE6E'
- '#FFFB6D'
- '#CEFA6E'
- '#68F96E'
- '#68FDFF'
- '#68FBD0'
- '#6ACFFF'
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- '#6E76FF'
- '#D278FF'
- '#FF7AFF'
- '#FF7FD3'

ExternalFrontend::DefaultLanguage

Defines the method for determining the default language in the external interface.
'Auto-detect' will set language based on the user browser configuration. 'System
default' will use configured value of the DefaultLanguage setting. Please note that
once a user overrides the default language, their choice will be honored in the future.

この設定は無効化することはできません。

デフォルト値:

--- Browser

ExternalFrontend::LanguageFallback

Defines fallback language for the external interface.

この設定は無効化することはできません。

デフォルト値:

--- en

ExternalFrontend::Languages

List of languages which will be available in external frontend. Please, make sure that
it contains value selected in ExternalFrontend::LanguageFallback.

この設定は無効化することはできません。

デフォルト値:

---
- en
- en_CA
- en_GB
- de
- es
- es_MX
- hu
- zh_CN
- pt_BR
- fr

ExternalFrontend::StateMap

Defines state name map for external interface.

デフォルト値:

--- {}

172. Frontend → External → Auth
ExternalFrontend::Auth::LoginURL

Defines an alternate login URL for the external interface.

この設定は標準では有効ではありません。
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デフォルト値:

--- http://host.example.com/cgi-bin/login.pl

ExternalFrontend::Auth::LogoutURL

Defines an alternate logout URL for the external interface.

この設定は標準では有効ではありません。

デフォルト値:

--- http://host.example.com/cgi-bin/logout.pl

173. Frontend → External → Menu
ExternalFrontend::Menu###Bottom

Bottom menu item registration for the external interface. Additional menu links are
defined by adding new items and specifying their parameters. 'Group' and 'GroupRo'
arrays can be used to limit display of the links to members of certain groups with
RW and RO permissions respectively. 'Name' defines the displayed link text and
'Description' will be shown in a tooltip on hover. 'Link' is meant for an application route
path or a link to an external site. Please note you can only define one of them at the
time. 'IsPublic' defines if the link will be shown to unauthenticated users and in case
this is set to '1', 'Group' and 'GroupRo' parameters will be ignored. 'Target' will define
link's target attribute, please use '_blank' for opening in a new tab. 'Prio' determines
the order of the links, with smaller numbers displayed first.

デフォルト値:

---
- Description: Knowledge base.
  Group: []
  GroupRo: []
  IsPublic: '1'
  Link: /knowledge-base
  Name: Knowledge Base
  Prio: '100'
  Target: ''
- Description: Service catalogue.
  Group: []
  GroupRo: []
  IsPublic: '0'
  Link: /service-catalogue
  Name: Service Catalogue
  Prio: '200'
  Target: ''
- Description: Privacy policy example.
  Group: []
  GroupRo: []
  IsPublic: '1'
  Link: /c/privacy-policy-example
  Name: Privacy Policy Example
  Prio: '300'
  Target: ''
- Description: Imprint example.
  Group: []
  GroupRo: []
  IsPublic: ''
  Link: /c/imprint-example
  Name: Imprint Example
  Prio: '400'
  Target: ''
- Description: Copyright notice.
  Group: []
  GroupRo: []
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  IsPublic: '1'
  Link: https://otrs.com
  Name: Copyright 2018 OTRS
  Prio: '500'
  Target: ''

ExternalFrontend::Menu###Main

Main menu item registration for the external interface. Additional menu links are
defined by adding new items and specifying their parameters. 'Group' and 'GroupRo'
arrays can be used to limit display of the links to members of certain groups with
RW and RO permissions respectively. 'Name' defines the displayed link text and
'Description' will be shown in a tooltip on hover. 'Link' is meant for an application route
path or a link to an external site. Please note you can only define one of them at the
time. 'IsPublic' defines if the link will be shown to unauthenticated users and in case
this is set to '1', 'Group' and 'GroupRo' parameters will be ignored. 'Target' will define
link's target attribute, please use '_blank' for opening in a new tab. 'Prio' determines
the order of the links, with smaller numbers displayed first.

デフォルト値:

---
- Description: Knowledge base.
  Group: []
  GroupRo: []
  IsPublic: '1'
  Link: /knowledge-base
  Name: Knowledge Base
  Prio: '100'
  Target: ''
- Description: Service catalogue.
  Group: []
  GroupRo: []
  IsPublic: '0'
  Link: /service-catalogue
  Name: Service Catalogue
  Prio: '200'
  Target: ''
- Description: Custom link 2.
  Group: []
  GroupRo: []
  IsPublic: '1'
  Link: /error
  Name: Custom Link 2
  Prio: '300'
  Target: ''
- Description: Custom link 3.
  Group: []
  GroupRo: []
  IsPublic: ''
  Link: /ticket/overview
  Name: Custom Link 3
  Prio: '400'
  Target: ''

ExternalFrontend::Menu###Top

Top menu item registration for the external interface. Additional menu links are
defined by adding new items and specifying their parameters. 'Group' and 'GroupRo'
arrays can be used to limit display of the links to members of certain groups with
RW and RO permissions respectively. 'Name' defines the displayed link text and
'Description' will be shown in a tooltip on hover. 'Link' is meant for an application route
path or a link to an external site. Please note you can only define one of them at the
time. 'IsPublic' defines if the link will be shown to unauthenticated users and in case
this is set to '1', 'Group' and 'GroupRo' parameters will be ignored. 'Target' will define
link's target attribute, please use '_blank' for opening in a new tab. 'Prio' determines
the order of the links, with smaller numbers displayed first.
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デフォルト値:

---
- Description: Custom Link 1.
  Group: []
  GroupRo: []
  IsPublic: '1'
  Link: /home
  Name: Custom Link 1
  Prio: '100'
  Target: ''

174. Frontend → External →
PrivacyNotice

ExternalFrontend::PrivacyNotice

Defines privacy notice configuration for the external interface. The notice will be
shown to all users until they accept the privacy policy.

デフォルト値:

---
de:
  ButtonText: Ok
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: Datenschutz-Vereinbarung
  Text: Diese Website verwendet Cookies. Mit der Nutzung dieser Website akzeptieren
    Sie unsere %s.
en:
  ButtonText: Ok
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: data protection
  Text: This site uses cookies. By using this site you accept our %s agreement.
en_CA:
  ButtonText: Ok
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: data protection
  Text: This site uses cookies. By using this site you accept our %s agreement.
en_GB:
  ButtonText: Ok
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: data protection
  Text: This site uses cookies. By using this site you accept our %s agreement.
es:
  ButtonText: Ok
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: protección de datos
  Text: Este sitio utiliza cookies. Al continuar navegando, usted acepta nuestro acuerdo
    de %s.
es_MX:
  ButtonText: Ok
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: protección de datos
  Text: Este sitio utiliza cookies. Al continuar navegando, usted acepta nuestro acuerdo
    de %s.
fr:
  ButtonText: Ok
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: de protection des données
  Text: Ce site utilise des cookies. En utilisant ce site, vous acceptez notre accord
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    %s.
hu:
  ButtonText: Rendben
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: adatvédelmi
  Text: Ez az oldal sütiket használ. Az oldal használatával elfogadja az %s
 irányelveinket.
pt_BR:
  ButtonText: Ok
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: proteção de dados
  Text: Este site utiliza cookies. Ao usar este site, aceita o nosso acordo de %s.
zh_CN:
  ButtonText: 好的
  Link: https://www.example.com/your-cookie-consent
  LinkTarget: _blank
  LinkText: 数据保护
  Text: 该网站使用cookies。使用本网站表示您接受我们的%s条款。

175. Frontend → External → Route
ExternalFrontend::Route###001-Framework

Defines the application routes for the external interface. Additional routes are defined
by adding new items and specifying their parameters. 'Group' and 'GroupRo' arrays
can be used to limit access of the route to members of certain groups with RW and RO
permissions respectively. 'Path' defines the relative path of the route, and 'Alias' can be
used for specifying an alternative path. 'Component' is the path of the Vue component
responsible for displaying the route content, relative to the Components/Route folder
in the app. 'IsPublic' defines if the route will be accessible for unauthenticated users
and in case this is set to '1', 'Group' and 'GroupRo' parameters will be ignored. 'Props'
can be used to signal that the path contain dynamic segments, and that their values
should be bound to the component as props (use '1' to turn on this feature).

デフォルト値:

---
- Alias: /home
  Component: HomePage
  Group: []
  GroupRo: []
  IsPublic: '1'
  Path: /
  Props: ''
- Alias: /c/:slug
  Component: CustomPage
  Group: []
  GroupRo: []
  IsPublic: '1'
  Path: /content/:slug
  Props: '1'
- Alias: '*'
  Component: ErrorPage
  Group: []
  GroupRo: []
  IsPublic: '1'
  Path: /error
  Props: '1'
- Alias: ''
  Component: AccountResetPage
  Group: []
  GroupRo: []
  IsPublic: '1'
  Path: /account/reset/:token
  Props: '1'
- Alias: ''
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  Component: TicketOverview
  Group: []
  GroupRo: []
  IsPublic: '0'
  Path: /ticket/overview/:filter?
  Props: '1'
- Alias: ''
  Component: Search
  Group: []
  GroupRo: []
  IsPublic: '1'
  Path: /search/:searchQuery?
  Props: '1'
- Alias: ''
  Component: PersonalPreferences
  Group: []
  GroupRo: []
  IsPublic: '0'
  Path: /account/personal-preferences/:category?
  Props: '1'
- Alias: ''
  Component: TicketCreate
  Group: []
  GroupRo: []
  IsPublic: '0'
  Path: /ticket/create/:mode?
  Props: '1'
- Alias: ''
  Component: TicketDetailView
  Group: []
  GroupRo: []
  IsPublic: '0'
  Path: /ticket/number/:ticketNumber
  Props: '1'
- Alias: ''
  Component: ServiceCatalogue
  Group: []
  GroupRo: []
  IsPublic: '0'
  Path: /service-catalogue/:categoryId?
  Props: '1'
- Alias: /knowledge-base/
  Component: KnowledgeBaseOverview
  Group: []
  GroupRo: []
  IsPublic: '1'
  Path: /knowledge-base/category/:categoryId?
  Props: '1'
- Alias: ''
  Component: KnowledgeBaseDetailView
  Group: []
  GroupRo: []
  IsPublic: '1'
  Path: /knowledge-base/article/:articleId
  Props: '1'
- Alias: ''
  Component: PersonalNotifications
  Group: []
  GroupRo: []
  IsPublic: '0'
  Path: /personal-notifications
  Props: '1'

ExternalFrontend::Route###999-Development

Defines the application routes for the external interface. Additional routes are defined
by adding new items and specifying their parameters. 'Group' and 'GroupRo' arrays
can be used to limit access of the route to members of certain groups with RW and RO
permissions respectively. 'Path' defines the relative path of the route, and 'Alias' can be
used for specifying an alternative path. 'Component' is the path of the Vue component
responsible for displaying the route content, relative to the Components/Route folder
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in the app. 'IsPublic' defines if the route will be accessible for unauthenticated users
and in case this is set to '1', 'Group' and 'GroupRo' parameters will be ignored. 'Props'
can be used to signal that the path contain dynamic segments, and that their values
should be bound to the component as props (use '1' to turn on this feature).

デフォルト値:

---
- Alias: ''
  Component: DesignSandbox
  Group: []
  GroupRo: []
  IsPublic: '1'
  Path: /sandbox
  Props: ''

176. Frontend → External → View →
KnowledgeBaseDetail

ExternalFrontend::KnowledgeBaseDetailView###DynamicField

外部インターフェイス のナレッジベース詳細ビューに表示する ダイナミック・フィールド

デフォルト値:

--- {}

177. Frontend → External → View →
Preferences

CustomerPersonalPreference###Avatar

顧客プレファレンスにおいて、本アイテムの全パラメータを定義してください。

デフォルト値:

---
Active: '1'
Desc: Upload your avatar image.
Key: Avatar
Label: Avatar
Module: Kernel::WebApp::Util::UserPreferenceType::Avatar
PrefKey: UserAvatar
PreferenceGroup: General
Prio: '0100'

CustomerPersonalPreference###GoogleAuthenticatorSecretKey

本アイテムのコンフィグ・パラメータを、プレファレンス・ビューで表示されるように定義し
ます。

デフォルト値:

---
Active: '1'
Block: Input
Desc: Enter your shared secret to enable two factor authentication.
Key: Shared Secret
Label: Google Authenticator
Module: Kernel::WebApp::Util::UserPreferenceType::Generic
PrefKey: UserGoogleAuthenticatorSecretKey
PreferenceGroup: Security
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Prio: '1100'
ValidateRegex: ^([A-Z2-7]{16})$
ValidateRegexMessage: The secret you supplied is invalid. The secret must only contain
  letters (A-Z, uppercase) and numbers (2-7) and must consist of 16 characters.

CustomerPersonalPreference###Language

顧客プレファレンスにおいて、本アイテムの全パラメータを定義してください。

デフォルト値:

---
Active: '1'
Desc: Select the main interface language.
Key: Language
Label: Language
Module: Kernel::WebApp::Util::UserPreferenceType::Select::Language
PrefKey: UserLanguage
PreferenceGroup: General
Prio: '2000'

CustomerPersonalPreference###PGP

顧客プレファレンスにおいて、本アイテムの全パラメータを定義してください。

デフォルト値:

---
Active: '1'
Desc: Upload your PGP key.
Key: PGP Key
Label: PGP Key
Module: Kernel::WebApp::Util::UserPreferenceType::File::PGP
PrefKey: UserPGPKey
PreferenceGroup: Security
Prio: '10000'

CustomerPersonalPreference###Password

Defines all the parameters for this item in the customer preferences.
'PasswordRegExp' allows to match passwords against a regular expression. Define the
minimum number of characters using 'PasswordMinSize'. Define if at least 2 lowercase
and 2 uppercase letter characters are needed by setting the appropriate option to '1'.
'PasswordMin2Characters' defines if the password needs to contain at least 2 letter
characters (set to 0 or 1). 'PasswordNeedDigit' controls the need of at least 1 digit
(set to 0 or 1 to control).

デフォルト値:

---
Active: '1'
Area: Customer
Desc: Set a new password by filling in your current password and a new one.
Label: Change password
Module: Kernel::WebApp::Util::UserPreferenceType::Password
PasswordMin2Characters: '0'
PasswordMin2Lower2UpperCharacters: '0'
PasswordMinSize: '0'
PasswordNeedDigit: '0'
PasswordRegExp: ''
PreferenceGroup: Security
Prio: '1000'

CustomerPersonalPreference###SMIME

顧客プレファレンスにおいて、本アイテムの全パラメータを定義してください。

デフォルト値:
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---
Active: '1'
Desc: Upload your S/MIME certificate.
Key: S/MIME Certificate
Label: S/MIME Certificate
Module: Kernel::WebApp::Util::UserPreferenceType::File::SMIME
PrefKey: UserSMIMEKey
PreferenceGroup: Security
Prio: '11000'

CustomerPersonalPreference###TimeZone

顧客プレファレンスにおいて、本アイテムの全パラメータを定義してください。

デフォルト値:

---
Active: '1'
Desc: Select your personal time zone. All times will be displayed relative to this
  time zone.
Key: Time Zone
Label: Time Zone
Module: Kernel::WebApp::Util::UserPreferenceType::Select::TimeZone
PrefKey: UserTimeZone
PreferenceGroup: General
Prio: '2500'

CustomerPersonalPreference::Groups###0001-Framework

Customer preferences categories.

この設定は無効化することはできません。

デフォルト値:

---
- Description: ''
  Label: General
  Name: General
  Order: '1000'
  Title: ''
- Description: ''
  Label: Security
  Name: Security
  Order: '2000'
  Title: ''

178. Frontend → External → View →
TicketCreate

ExternalFrontend::TicketCreate###DynamicField

Dynamic fields options shown in the ticket message screen of the customer
interface. NOTE: If you want to display these fields also in the ticket
detail view of the external interface, you have to enable them in
ExternalFrontend::TicketDetailView###DynamicField.

デフォルト値:

--- {}

ExternalFrontend::TicketCreate###HistoryComment

顧客インタフェースの新規履歴エントリーのためのコメントです。

この設定は無効化することはできません。
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デフォルト値:

--- ''

ExternalFrontend::TicketCreate###HistoryType

顧客インタフェースのデフォルトの履歴タイプを定義します。

この設定は無効化することはできません。

デフォルト値:

--- WebRequestCustomer

ExternalFrontend::TicketCreate###KnowledgeBase::RelatedArticles::DefaultLanguages

The default languages for the related knowledge base articles.

デフォルト値:

---
- en

ExternalFrontend::TicketCreate###KnowledgeBase::RelatedArticles::Enabled

Enable the related knowledge base article feature for the external interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

ExternalFrontend::TicketCreate###KnowledgeBase::RelatedArticles::QueuesEnabled

List of queue names for which the related knowledge base article feature is enabled.

この設定は標準では有効ではありません。

デフォルト値:

---
- Raw

ExternalFrontend::TicketCreate###KnowledgeBase::RelatedArticles::ShowLimit

Output limit for the related knowledge base articles.

この設定は無効化することはできません。

デフォルト値:

--- '5'

ExternalFrontend::TicketCreate###NextScreenAfterNewTicket

顧客インタフェースで、新規顧客チケットの後の次の画面を決定します。

この設定は無効化することはできません。

デフォルト値:

--- TicketOverview

ExternalFrontend::TicketCreate###Priority

顧客が顧客インタフェースでチケット優先度を設定することを、許可します。
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この設定は無効化することはできません。

デフォルト値:

--- 0

ExternalFrontend::TicketCreate###PriorityDefault

顧客インタフェースで、新規顧客チケットのデフォルトの優先度を定義します。

デフォルト値:

--- 3 normal

ExternalFrontend::TicketCreate###Queue

Allows customers to set the ticket queue in the customer interface. If this is not
enabled, QueueDefault should be configured.

この設定は無効化することはできません。

デフォルト値:

--- 0

ExternalFrontend::TicketCreate###QueueDefault

顧客インタフェースで、新規顧客チケットのためのデフォルトのキューを定義します。

デフォルト値:

--- Postmaster

ExternalFrontend::TicketCreate###SLA

顧客が顧客インタフェースでチケットSLAを設定することを、許可します。

この設定は無効化することはできません。

デフォルト値:

--- 0

ExternalFrontend::TicketCreate###SLAMandatory

SLAが顧客によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

ExternalFrontend::TicketCreate###SenderType

顧客インタフェースからの新規チケットのための送信者タイプです。

この設定は無効化することはできません。

デフォルト値:

--- customer

ExternalFrontend::TicketCreate###Service

顧客が顧客インタフェースでチケット・サービスを設定することを、許可します。

この設定は無効化することはできません。
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デフォルト値:

--- 0

ExternalFrontend::TicketCreate###ServiceMandatory

サービスが顧客によって必ず選択される必要があるかどうかを設定します。

デフォルト値:

--- 0

ExternalFrontend::TicketCreate###StateDefault

顧客インタフェースで、新規顧客チケットのデフォルトの状態を定義します。

この設定は無効化することはできません。

デフォルト値:

--- new

ExternalFrontend::TicketCreate###TicketType

Allows customers to set the ticket type in the customer interface. If this is not enabled,
TicketTypeDefault should be configured.

この設定は無効化することはできません。

デフォルト値:

--- 0

ExternalFrontend::TicketCreate###TicketTypeDefault

Defines the default ticket type for new customer tickets in the customer interface.

デフォルト値:

--- Unclassified

179. Frontend → External → View →
TicketDetail

ExternalFrontend::TicketDetailView###AccountedTimeDisplay

Displays the accounted time for an article in the ticket detail view of the external
interface.

この設定は無効化することはできません。

デフォルト値:

--- 0

ExternalFrontend::TicketDetailView###AttributesView

Shows the enabled ticket attributes in the external interface (0 = Disabled and 1 =
Enabled).

この設定は無効化することはできません。

デフォルト値:
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---
Owner: '0'
Priority: '1'
Queue: '1'
Responsible: '0'
SLA: '0'
Service: '0'
State: '1'
Type: '0'

ExternalFrontend::TicketDetailView###DynamicField

外部インターフェイス のチケット詳細ビューに表示する ダイナミック・フィールド

デフォルト値:

--- {}

ExternalFrontend::TicketDetailView###FollowUpDynamicField

Dynamic fields options shown in the ticket reply section in the ticket detail view of
the external interface.

デフォルト値:

--- {}

ExternalFrontend::TicketDetailView###HistoryComment

Defines the history comment for the ticket detail view, which gets used for ticket
history in the external interface.

この設定は無効化することはできません。

デフォルト値:

--- ''

ExternalFrontend::TicketDetailView###HistoryType

Defines the history type for the ticket detail view, which gets used for ticket history
in the external interface.

この設定は無効化することはできません。

デフォルト値:

--- FollowUp

ExternalFrontend::TicketDetailView###NextScreenAfterFollowUp

Determines the next screen after the follow-up from the ticket detail view in the
external interface.

この設定は無効化することはできません。

デフォルト値:

--- TicketOverview

ExternalFrontend::TicketDetailView###Priority

Allows customers to change the ticket priority in the external interface.

デフォルト値:

800



--- 0

ExternalFrontend::TicketDetailView###PriorityDefault

Defines the default priority of follow-up customer tickets in the ticket detail view in
the external interface.

この設定は無効化することはできません。

デフォルト値:

--- 3 normal

ExternalFrontend::TicketDetailView###SenderType

Defines the default sender type for tickets in the ticket detail view of the external
interface.

この設定は無効化することはできません。

デフォルト値:

--- customer

ExternalFrontend::TicketDetailView###State

Allows choosing the next compose state for customer tickets in the external interface.

デフォルト値:

--- 0

ExternalFrontend::TicketDetailView###StateDefault

Defines the default next state for a ticket after customer follow-up in the external
interface.

この設定は無効化することはできません。

デフォルト値:

--- open

ExternalFrontend::TicketDetailView###StateType

Defines the next possible states for customer tickets in the external interface.

この設定は無効化することはできません。

デフォルト値:

---
- open
- closed

180. Frontend → External → View →
TicketOverview

ExternalFrontend::TicketOverview###ColumnHeader

Shows either the last customer article's subject or the ticket title in the external
interface.
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デフォルト値:

--- TicketTitle

ExternalFrontend::TicketOverview###DynamicField

Dynamic fields shown in the ticket overview screen of the external interface.

デフォルト値:

--- {}

ExternalFrontend::TicketOverview###Owner

Show the current owner in the external interface.

この設定は無効化することはできません。

デフォルト値:

--- 0

ExternalFrontend::TicketOverview###Queue

Show the current queue in the external interface.

この設定は無効化することはできません。

デフォルト値:

--- 0

ExternalFrontend::TicketOverview###State

Show the current state in the external interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

181. GenericInterface
GenericInterface::WebserviceConfig::CacheTTL

Cache time in seconds for the web service config backend.

この設定は無効化することはできません。

デフォルト値:

--- '86400'

182. GenericInterface → ErrorHandling
→ ModuleRegistration

GenericInterface::ErrorHandling::Module###RequestRetry

GenericInterface module registration for an error handling module.

デフォルト値:
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---
CommunicationTypeFilter: Requester
ConfigDialog: AdminGenericInterfaceErrorHandlingRequestRetry
Name: RequestRetry

183. GenericInterface → Invoker →
ModuleRegistration

GenericInterface::Invoker::Module###Test::Test

GenericInterface module registration for the invoker layer.

この設定は標準では有効ではありません。

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceInvokerDefault
Controller: Test
Name: Test

GenericInterface::Invoker::Module###Test::TestSimple

GenericInterface module registration for the invoker layer.

この設定は標準では有効ではありません。

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceInvokerDefault
Controller: Test
Name: TestSimple

184. GenericInterface → Mapping →
ModuleRegistration

GenericInterface::Mapping::Module###Simple

GenericInterface module registration for the mapping layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceMappingSimple

GenericInterface::Mapping::Module###Test

GenericInterface module registration for the mapping layer.

この設定は標準では有効ではありません。

デフォルト値:

---
ConfigDialog: ''

GenericInterface::Mapping::Module###XSLT

GenericInterface module registration for the mapping layer.

デフォルト値:
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---
ConfigDialog: AdminGenericInterfaceMappingXSLT

185. GenericInterface → Operation
GenericInterface::Operation::Common::CachedAuth::AgentCacheTTL

Cache time in seconds for agent authentication in the GenericInterface.

この設定は無効化することはできません。

デフォルト値:

--- '300'

GenericInterface::Operation::Common::CachedAuth::CustomerCacheTTL

Cache time in seconds for customer authentication in the GenericInterface.

この設定は無効化することはできません。

デフォルト値:

--- '300'

GenericInterface::Operation::ResponseLoggingMaxSize

Defines the maximum size in KiloByte of GenericInterface responses that get logged
to the gi_debugger_entry_content table.

この設定は無効化することはできません。

デフォルト値:

--- '200'

186. GenericInterface → Operation →
Generic → RPC

GenericInterface::Operation::Generic::RPC

Enables the usage of operation Generic::RPC.

この設定は無効化することはできません。

デフォルト値:

--- 0

GenericInterface::Operation::Generic::RPC::Modules###001-Default

Registration of allowed modules used by operation Generic::RPC. Just modules below
Kernel::System and Custom::Kernel::System (and Kernel::Config) are allowed for
executions.

デフォルト値:

---
- Kernel::Config
- Kernel::System::CustomerCompany
- Kernel::System::CustomerUser
- Kernel::System::Encode
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- Kernel::System::Group
- Kernel::System::LinkObject
- Kernel::System::Log
- Kernel::System::Main
- Kernel::System::PID
- Kernel::System::Queue
- Kernel::System::AuthSession
- Kernel::System::Ticket

187. GenericInterface → Operation →
ModuleRegistration

GenericInterface::Operation::Module###FAQ::LanguageList

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: FAQ
Name: LanguageList

GenericInterface::Operation::Module###FAQ::PublicCategoryList

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: FAQ
Name: PublicCategoryList

GenericInterface::Operation::Module###FAQ::PublicFAQGet

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: FAQ
Name: PublicFAQGet

GenericInterface::Operation::Module###FAQ::PublicFAQSearch

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: FAQ
Name: PublicFAQSearch

GenericInterface::Operation::Module###Generic::RPC

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationRPC
Controller: Generic
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Name: RPC

GenericInterface::Operation::Module###Session::SessionCreate

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: Session
Name: SessionCreate

GenericInterface::Operation::Module###Session::SessionGet

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: Session
Name: SessionGet

GenericInterface::Operation::Module###Test::Test

GenericInterface module registration for the operation layer.

この設定は標準では有効ではありません。

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: Test
Name: Test

GenericInterface::Operation::Module###Ticket::TicketCreate

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: Ticket
Name: TicketCreate

GenericInterface::Operation::Module###Ticket::TicketGet

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: Ticket
Name: TicketGet

GenericInterface::Operation::Module###Ticket::TicketHistoryGet

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
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Controller: Ticket
Name: TicketHistoryGet

GenericInterface::Operation::Module###Ticket::TicketSearch

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: Ticket
Name: TicketGet

GenericInterface::Operation::Module###Ticket::TicketUpdate

GenericInterface module registration for the operation layer.

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceOperationDefault
Controller: Ticket
Name: TicketUpdate

188. GenericInterface → Operation →
TicketCreate

GenericInterface::Operation::TicketCreate###AutoResponseType

Defines the default auto response type of the article for this operation.

この設定は無効化することはできません。

デフォルト値:

--- auto reply

GenericInterface::Operation::TicketCreate###HistoryComment

Defines the history comment for this operation, which gets used for ticket history in
the agent interface.

この設定は無効化することはできません。

デフォルト値:

--- '%%GenericInterface Create'

GenericInterface::Operation::TicketCreate###HistoryType

Defines the history type for this operation, which gets used for ticket history in the
agent interface.

この設定は無効化することはできません。

デフォルト値:

--- NewTicket

GenericInterface::Operation::TicketCreate###IsVisibleForCustomer

この操作のために顧客へデフォルトで参照する設定を定義します。
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この設定は無効化することはできません。

デフォルト値:

--- '1'

189. GenericInterface → Operation →
TicketSearch

GenericInterface::Operation::TicketSearch###Order::Default

Defines the default ticket order in the ticket search result of the this operation. Up:
oldest on top. Down: latest on top.

この設定は無効化することはできません。

デフォルト値:

--- Down

GenericInterface::Operation::TicketSearch###SearchLimit

Maximum number of tickets to be displayed in the result of this operation.

この設定は無効化することはできません。

デフォルト値:

--- '500'

GenericInterface::Operation::TicketSearch###SortBy::Default

Defines the default ticket attribute for ticket sorting of the ticket search result of this
operation.

この設定は無効化することはできません。

デフォルト値:

--- Age

190. GenericInterface → Operation →
TicketUpdate

GenericInterface::Operation::TicketUpdate###AutoResponseType

Defines the default auto response type of the article for this operation.

この設定は無効化することはできません。

デフォルト値:

--- auto follow up

GenericInterface::Operation::TicketUpdate###HistoryComment

Defines the history comment for this operation, which gets used for ticket history in
the agent interface.
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この設定は無効化することはできません。

デフォルト値:

--- '%%GenericInterface Note'

GenericInterface::Operation::TicketUpdate###HistoryType

Defines the history type for this operation, which gets used for ticket history in the
agent interface.

この設定は無効化することはできません。

デフォルト値:

--- AddNote

GenericInterface::Operation::TicketUpdate###IsVisibleForCustomer

この操作のために顧客へデフォルトで参照する設定を定義します。

この設定は無効化することはできません。

デフォルト値:

--- '1'

191. GenericInterface → Transport →
ModuleRegistration

GenericInterface::Transport::Module###HTTP::REST

トランスポート層にジェネリックインターフェイス・モジュールを登録します。

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceTransportHTTPREST
Name: REST
Protocol: HTTP

GenericInterface::Transport::Module###HTTP::SOAP

トランスポート層にジェネリックインターフェイス・モジュールを登録します。

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceTransportHTTPSOAP
Name: SOAP
Protocol: HTTP

GenericInterface::Transport::Module###HTTP::Test

トランスポート層にジェネリックインターフェイス・モジュールを登録します。

この設定は標準では有効ではありません。

デフォルト値:

---
ConfigDialog: AdminGenericInterfaceTransportHTTPTest
Name: Test
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Protocol: HTTP

192. WebApp
WebApp::DefaultRedirect

Defines the default redirect. Use '/external' for the external or '/otrs/index.pl' for the
agent interface, or an absolute URL if you want to redirect to an external site.

この設定は無効化することはできません。

デフォルト値:

--- /external

WebApp::SSO::RemoteUserSecret

Shared secret for SSO. Reverse proxies must pass a REMOTE_USER and a
REMOTE_USER_SECRET header with the value of this setting, only then REMOTE_USER
will be accepted and usable for HTTPBasicAuth.

この設定は標準では有効ではありません。

デフォルト値:

--- ''

WebApp::Server::AutomaticReloadFile

Defines the path to a file that should signal the need to reload the web server. It will
only work correctly with the default value; change this only if you intend to use this
file for other purposes (like triggering a cluster-wide web server reload - in this case
you have to handle the actual reloads on your own).

この設定は無効化することはできません。

デフォルト値:

--- <OTRS_CONFIG_Home>/var/run/otrs.WebServer.pid.needs-reload

WebApp::Server::TriggerAutomaticReloads

If active, certain operations like package changes and external interface setting
changes will trigger a hot reload of the production web server on the current node.
This can be turned off if you plan to restart the web server manually or if another
mechanism is used to perform the needed restarts.

この設定は無効化することはできません。

デフォルト値:

--- '1'

193. WebApp → API → Customer →
Account

WebApp::API::Customer::Account::EmailBlacklist

If active, none of the regular expressions may match the user's email address to allow
registration.
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この設定は標準では有効ではありません。

デフォルト値:

---
- \@your\.domain\.example$

WebApp::API::Customer::Account::EmailWhitelist

If active, one of the regular expressions has to match the user's email address to allow
registration.

この設定は標準では有効ではありません。

デフォルト値:

---
- \@your\.domain\.example$

WebApp::API::Customer::Account::Recover

Enables customers to recover their own accounts via the external interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'

WebApp::API::Customer::Account::RecoverBody

Defines the body for an email with password recovery instructions for customer users,
containing a link to request a new password.

この設定は無効化することはできません。

デフォルト値:

--- "Hi <OTRS_USERFIRSTNAME>,\n\nYou or someone impersonating you has requested to
  change your OTRS password.\n\nIf you want to do this, click on this link. You will
  receive another email containing the password.\n\n<OTRS_CONFIG_HttpType>://
<OTRS_CONFIG_FQDN><OTRS_CONFIG_Frontend::PrefixPath>/external/account/reset/<OTRS_TOKEN>
\n\nIf
  you did not request a new password, please ignore this email.\n            "

WebApp::API::Customer::Account::RecoverSubject

Defines the subject for an email with password recovery instructions for customer
users.

この設定は無効化することはできません。

デフォルト値:

--- New OTRS password request

WebApp::API::Customer::Account::Register

Enables customers to create their own accounts via the external interface.

この設定は無効化することはできません。

デフォルト値:

--- '1'
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WebApp::API::Customer::Account::RegisterBody

新アカウントについて、顧客に送信される通知メールの本文テキストを定義します。

この設定は無効化することはできません。

デフォルト値:

--- "Hi <OTRS_USERFIRSTNAME>,\n\nYou or someone impersonating you has created a new
  OTRS account for you.\n\nFull name: <OTRS_USERFIRSTNAME> <OTRS_USERLASTNAME>\nUser
  name: <OTRS_USERLOGIN>\nPassword: <OTRS_USERPASSWORD>\n\nYou can log in via the
  following URL. We encourage you to change your password in the user preferences
  after logging in.\n\n<OTRS_CONFIG_HttpType>://
<OTRS_CONFIG_FQDN><OTRS_CONFIG_Frontend::PrefixPath>/external\n
  \           "

WebApp::API::Customer::Account::RegisterSubject

新アカウントについて、顧客に送信される通知メールの件名を定義します。

この設定は無効化することはできません。

デフォルト値:

--- New OTRS Account!

WebApp::API::Customer::Account::ResetBody

Defines the body for an email with new password for customer users.

この設定は無効化することはできません。

デフォルト値:

--- "Hi <OTRS_USERFIRSTNAME>,\n\nYour new password is: <OTRS_NEWPW>\n\nYou can log
  in via the following URL. We encourage you to change your password in the user
 preferences
  after logging in.\n\n<OTRS_CONFIG_HttpType>://
<OTRS_CONFIG_FQDN><OTRS_CONFIG_Frontend::PrefixPath>/external\n
  \           "

WebApp::API::Customer::Account::ResetSubject

Defines the subject for an email with new password for customer users.

この設定は無効化することはできません。

デフォルト値:

--- New OTRS password

194. WebApp → APIClient
WebApp::APIClient###CloseTimeout

Defines timeout in milliseconds for the closing of a WebSocket connection in the
frontend applications. Value of '0' will disable the timeout. Please note that changes to
this setting require a restart of the web server (bin/otrs.WebServer.pl --deploy-assets).

この設定は無効化することはできません。

デフォルト値:

--- 0
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WebApp::APIClient###MaxReconnectionDelay

Defines maximum delay in milliseconds when trying to re-establish a WebSocket
connection in the frontend applications. Please note that changes to this setting
require a restart of the web server (bin/otrs.WebServer.pl --deploy-assets).

この設定は無効化することはできません。

デフォルト値:

--- '10000'

WebApp::APIClient###OpenTimeout

Defines timeout in milliseconds for the opening of a WebSocket connection in the
frontend applications. Value of '0' will disable the timeout. Please note that changes to
this setting require a restart of the web server (bin/otrs.WebServer.pl --deploy-assets).

この設定は無効化することはできません。

デフォルト値:

--- 0

WebApp::APIClient###PrimaryProtocol

Defines primary API client communication protocol in the frontend applications. Please
note that WebSocket option will fall back automatically to XHR in certain situations
(e.g. file uploads). Please note that changes to this setting require a restart of the web
server (bin/otrs.WebServer.pl --deploy-assets).

この設定は無効化することはできません。

デフォルト値:

--- ws

WebApp::APIClient###ReconnectionDelayIncrement

Defines increment delay in milliseconds with every reconnection attempt of a
WebSocket connection in the frontend applications. Please note that changes to this
setting require a restart of the web server (bin/otrs.WebServer.pl --deploy-assets).

この設定は無効化することはできません。

デフォルト値:

--- '1000'

WebApp::APIClient###ResponseTimeout

Defines timeout in milliseconds for the responses of WebSocket requests in the
frontend applications. Value of '0' will disable the timeout. Please note that changes to
this setting require a restart of the web server (bin/otrs.WebServer.pl --deploy-assets).

この設定は無効化することはできません。

デフォルト値:

--- '30000'
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付録C GNUフリー文書許諾契約書
Version 1.1, March 2000

Copyright (C) 2000 Free Software Foundation, Inc. 51 Franklin St, Fifth Floor,
Boston, MA 02110-1301 USA Everyone is permitted to copy and distribute
verbatim copies of this license document, but changing it is not allowed.

0. はじめに
この利用許諾契約書の目的は、この契約書が適用されるマニュアルや教科書、 その他機能本位で実
用的な文書を(無料ではなく)自由という意味で「フリー」 とすること、すなわち、改変の有無ある
いは目的の営利非営利を問わず、文書 を複製し再頒布する自由をすべての人々に効果的に保証する
ことです。加えて この契約書により、著者や出版者が自分たちの著作物に対して相応の敬意と賞
賛を得る手段も保護されます。また、他人が行った改変に対して責任を負わず に済むようになりま
す。

この利用許諾契約書は「コピーレフト」的なライセンスの一つであり、この契 約書が適用された文
書から派生した著作物は、それ自身もまた原本と同じ意味 でフリーでなければなりません。この契
約書は、フリーソフトウェアのために 設計されたコピーレフトなライセンスであるGNU一般公衆
使用許諾契約書を補足 するものです。

この利用許諾契約書は、フリーソフトウェア用のマニュアルに適用することを 目的として書かれ
ました。フリーソフトウェアはフリーな文書を必要としてお り、フリーなプログラムはそのソフト
ウェアが保証するのと同じ自由を提供す るマニュアルと共に頒布されるべきだからです。しかし、
この契約書の適用範 囲はソフトウェアのマニュアルに留まりません。対象となる著作物において扱
われる主題が何であれ、あるいはそれが印刷された書籍として出版されるか否 かに関わらず、この
契約書は文字で書かれたいかなる著作物にも適用すること が可能です。私たちとしては、主にこの
契約書を解説や参照を目的とする著作 物に適用することをお勧めします。

1. この利用許諾契約書の適用範囲と用語の定義
著作物がこの利用許諾契約書の定める条件の下で頒布される旨の告知を、著作 権者がその中に書い
たすべてのマニュアルあるいはその他の著作物は、この契約書の適用対象となります。以下におい
て、「『文書』(Document)」 とはそのような告知が記載されたマニュアルないし著作物すべてを
指します。公衆の一員ならば誰でも契約の当事者となることができ、この契約書中では「あなた」
と表現されます。

『文書』の「改変版 (Modified Version)」とは、一字一句忠実に複製したか、 あるいは改変や他言
語への翻訳を行ったかどうかに関わらず、その『文書』の 全体あるいは一部分を含む著作物すべて
を意味します。

「補遺部分 (Secondary Section)」とは、文書中でその旨指定された補遺 ないし本文
に先だって前付けとして置かれる一部分であり、文書の出版者 あるいは著者と、文書全体の主
題 (あるいはそれに関連する事柄)との関係のみを論じ、全体としての主題の範疇に直接属する内容
を全く含まないものです (たとえば、文書の一部が数学の教科書だった場合、補遺部分では数学に
ついて何も解説してはなりません)。補遺部分で扱われる関係は、その主題あるいは関連する事柄と
の歴史的なつながりのことかも知れないし、それらに関する法的、商業的、哲学的、倫理的、ある
いは政治的立場についてかも知れません。

「変更不可部分 (Invariant Sections)」とは補遺部分の一種で、それらが変更 不可部分であること
が、文書をこの利用許諾契約書の下で発表する旨述べ た告知中においてその部分の題名と共に明示
されているものです。

「カバーテキスト(Cover Texts)」とは、文書がこの利用許諾契約書の指定する条件の下で発表され
る旨述べた告知において、「表カバーテキスト」あるいは「裏カバーテキスト」として列挙された
短い文章のことを指します。
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文書の「透過的」複製物とは、機械による読み取りが可能な文書の複製物のことを指します。透過
的な複製物の文書形式は、その仕様が一般の人々に入手可能で、文書の内容を一般的なテキストエ
ディタ、または(画素で構成さ れる画像ならば)一般的なペイントプログラム、あるいは(図面なら
ば)いくつかの広く入手可能な製図エディタで簡単に改訂するのに適しており、なおかつテキスト
フォーマッタへの入力に適する(あるいはテキストフォーマッタへの入力に適する諸形式への自動的
な変換に適する)ものでなければなりません。透過的なファイル形式への複製であっても、マーク
アップ、あるいはマークアップの不在が読者によるそれ以降の改変をわざと邪魔し阻害するように
仕組まれたものは透過的であるとは見做されません。ある画像形式が、相当量のテキスト文章を表
現するために使われた場合、それは透過的ではない。透過的ではない複製は「非透過的」複製と呼
ばれます。

透過的複製に適した形式のサンプルとしては、マークアップを含まないプレーンな ASCII形
式、Texinfo入力形式、LaTeX入力形式、一般に入手可能なDTDを用いたSGMLあるいはXML、また
は人間による改変を想定して設計された、標準に準拠したシンプルなHTMLやPostScript、PDFなど
が挙げられます。透過的な画像形式の例には、PNGやXCF、JPGが含まれます。非透過な形式として
は、独占的なワードプロ セッサでのみ閲覧編集できる独占的なファイル形式、普通には入手できな
いDTDまたは処理系を使ったSGMLやXML、ある種のワードプロセッサが生成する、出力のみを目
的とした機械生成のHTMLやPostScript、PDFなどが含まれます。

「題扉 (Title Page)」とは、印刷された書籍に於いては、実際の表紙自身のみ ならず、この利用許
諾契約書が表紙に掲載することを義務づける文章や図など を、読みやすい形で載せるのに必要なだ
けの、表紙に引き続く数ページをも意味する。表紙に類するものが無い形式で発表される著作物に
おいては、「題扉」とは本文の始まりに先だって、その著作物の題名が最も目立つ形で現れる場所
の近くに置かれる文章のことを指します。

2. 逐語的に忠実な複製
この利用許諾契約書、著作権表示、この契約書が文書に適用される旨述べた告知の三つがすべての
複製物に複製され、かつあなたがこの契約書で指定されている以外のいかなる条件も追加しない限
り、あなたはこの文書を、商用であるか否かを問わずいかなる形でも複製頒布することができま
す。あなたは、あなたが作成あるいは頒布する複製物に対して、閲覧や再複製を技術的な手法に
よって妨害、規制してはいけません。しかしながら、複製と引き換えに代価を得てもかまいませ
ん。あなたが相当量の複製物を頒布する際には、本契約書第3項で指定される条件にも従わなけれ
ばなりません。

またあなたは、上記と同じ条件の下で、複製物を貸与したり複製物を公に開示 することができま
す。

3. 大量の複製
もしあなたが、文書の印刷された (あるいは通常は印刷された表紙を持つ 媒体における)複製物
を100部を超えて出版し、また文書の利用許諾告知が カバーテキストの掲載を要求している場合に
は、指定されたすべてのカバーテ キストを、表カバーテキストは表表紙に、裏カバーテキストは裏
表紙に、はっ きりと読みやすい形で載せた表紙の中に複製物本体を綴じ込まなければなりません。
また、両方の表紙において、それらの複製物の出版者としてのあなたをはっ きりとかつ読みやすい
形で確認できなければなりません。表表紙では文書の完全な題名を、題名を構成するすべての語が
等しく目立つようにして、視認可 能な形で示さなければなりません。それらの情報に加えて、表紙
に他の文章や図 などを加えることは許可される。表紙のみを変更した複製物は、それが文書の題名
を保存し上記の条件を満たす限り、ほかの点では逐語的に忠実な複製物として扱われます。

もしどちらかの表紙に要求されるカバーテキストの量が多すぎて読みやすく収 めることが不可能な
らば、あなたはテキスト先頭の一文(あるいは適切に収まる だけ)を実際の表紙に載せ、続きは隣接
したページに載せるべきです。

あなたが文書の「非透過的」複製物を100部を超えて出版あるいは頒布する場合、それぞれの非透
過な複製物と一緒に機械で読み取り可能な透過的複製物を添付するか、それぞれの非透過な複製物
(あるいはそれに付属する文書)中で、公にアクセス可能なコンピュータネットワーク上の所在地を
記述しなければなりません。その場所には、非透過な複製物と内容的に寸分違わず、余計なものが
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追加されていない完全な文書の透過的複製物が置かれ、またそこから、ネットワークを利用する一
般公衆が、一般に標準的と考えられるネットワークプロ トコルを使ってダウンロードすることがで
きなければなりません。もしあなたが後者の選択肢を選ぶならば、その版の非透過な複製物を公衆
に(直接、あるいは あなたの代理人ないし小売業者が)最後に頒布してから最低1年間は、その透過
的複製物が指定の場所でアクセス可能であり続けることを保証するよう、非透 過な複製物の大量頒
布を始める際に十分に慎重な手順を踏まなければならなりません。

これは要望であり必要条件ではないが、文書の著者に、文書の更新された版をあなたに提供する機
会を与えるため、透過非透過を問わず大量の複製物を再頒布し始める前には彼らにきちんと連絡し
ておいて下さい。

4. 改変
文書の改変版を、この利用許諾契約書と細部まで同一の契約の下で発表する限り、すなわち原本の
役割を改変版で置き換えた形での頒布と改変を、その複製物を所有するすべての人々に許可する限
り、あなたは改変版を上記第2項および第3項が指定する条件の下で複製および頒布することができ
ます。さらに、あなたは改変版において以下のことを行わなければなりません。

A.題扉に(もしあればその他の表紙にも)、文書および文書のそれ以前の版と見分けがつく題名を載
せること(もし以前の版があれば、文書の「履歴 (History)」の部分に列記されているはずです)。
もし元の版の出版者から許可を得たならば、以前の版と同じ題名を使っても良いです。

B.題扉に、改変版における改変を行った1人以上の人物 か団体名を列記すること。あわせて元の
『文書』の著者として、最低5人(も し5人以下ならばすべて)の主要著者を列記すること。

C.改変版の出版者名を出版者として記載すること。

D.文書にあるすべての著作権表示を残すこと。

E.他の著作権表示の近くに、あなたの改変に対する適 当な著作権表示を追加すること。

F. 著作権表示のすぐ後に、改変版をこの契約書の条件 の下で利用することを公衆に対して許可す
る告知を含めること。その形式はこの契約書の末尾にある付記で示されている。

G.元の『文書』の利用許諾告知に書かれた、変更不可部分の完全な一覧と、要求されるカバーテキ
ストとを、改変版の利用許諾告知でもそのまま残すこと。

H.この契約書の、変更されていない複製物を含めること。

I. 「履歴 (History)」と題された部分とその題名を保 存し、そこに改変版の、少なくとも題名、出
版年、新しく変更した部分の著者名、出版者名を、題扉に掲載するのと同じように記載した一項
を加えること。もし文書中に「履歴」と題された部分が存在しない場合には、文書の題名、出版
年、著者、出版者を題扉に掲載するのと同じように記載した部分を用意し、上記で述べたよう
な、改変版を説明する一項を加えること。

J. 文書中に、文書の透過的複製物への公共的アクセスのために指定されたネットワーク的所在地が
記載されていたならば、 それを保存すること。同様に、その『文書』の元になった以前の版で
指定されていたネットワーク的所在地も載っていたならば、それも保存すること。これらの情報
は「履歴(History)」の部分に置いても良いです。ただし、それが 文書自身より少なくとも4年前
に出版された著作物の情報であったり、あるいは改変版が参考にしている版の元々の出版者から
許可を得たならば、その情報を削除してもかまいません。

K.「謝辞 (Acknowledgement)」あるいは「献辞 (Dedication)」等と題されたいかなる部分も、その
部分の題名を保存し、その部分の内容(各貢献者への謝意あるいは献呈の意)と語調を保存するこ
と。

L. 『文書』の変更不可部分を、その本文および題名を 変更せずに保存すること。章番号やそれに
相当するものは部分の題名の一部とは見做さない。

M.「推薦の辞 (Endorsement)」というような章名が題された部分はすべて削除すること。そのよう
な部分を改変版に含めてはいけません。
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N.すでに存在する部分を「推薦の辞 (Endorsement)」 と題されるように改名したり、題名の点で変
更不可部分のどれかと抵触するように改名してはいけません。

もし改変版に、補遺部分としての条件を満たし、かつ文書から複製物され た文章や図などをいっさ
い含んでいない、前書き的な章あるいは付録が新しく含まれるならば、あなたは希望によりそれら
の部分の一部あるいはすべてを変更不可と宣言することができます。変更不可を宣言するために
は、それらの部分の題名を改変版の利用許諾告知中の変更不可部分一覧に追加すれば良いです。こ
れらの題名は他の章名とは全く別のものでなければなりません。

含まれる内容が、さまざまな集団によるあなたの改変版に対する推薦の辞のみである限り、あなた
は、「推薦の辞 (Endorsement)」と題された章を追加することができます。推薦の辞の例として
は、ピアレビュー（内容審査）の陳述、あるいは文書がある標準の権威ある定義としてその団体に
承認されたという声明などがあります。

あなたは、 5語までの一文を表カバーテキストとして、 25語までの文を裏表紙テキストとして、
改変版のカバーテキスト一覧の末尾に加えることができます。 一個人ないし一団体が直接(あるい
は団体内で結ばれた協定によって)加えることができるのは、表カバーテキストおよび裏カバーテキ
ストとしてそれぞれ一 文ずつのみである。もし以前すでにその文書において、表裏いずれかの表紙
にあなたの(またはあなたが代表する同じ団体内で為された協定に基づく)カバー テキストが含まれ
ていたならば、あなたが新たに追加することはできません。しかしあなたは、その古い文を加えた
以前の出版者から明示的な許可を得たならば、古い文を置き換えることができます。

文書の著者あるいは出版者は、この利用許諾契約書によって、彼らの名前を利用することを許可し
ているわけではありません。彼らの名前を改変版の宣伝に使ったり、改変版への明示的あるいは黙
示的な保証のために使うことを許可するものではありません。

5. 文書の結合
あなたは、上記第4項において改変版に関して定義された条件の下で、この利用許諾契約書の下で
発表された複数の文書を一つにまとめることができます。その際、原本となる文書にある変更不可
部分を全て、改変せずに結合後の著作物中に含め、それらをあなたが統合した著作物の変更不可部
分としてその利用許諾告知において列記し、かつ原本にある全ての保証否認警告を保存しなければ
なりません。

結合後の著作物についてはこの契約書の複製物を一つ含んでいればよく、同一内容の変更不可部分
が複数ある場合には一つで代用してよいです。もし同じ題名だが内容の異なる変更不可部分が複数
あるならば、そのような部分のそれぞれの題名の最後に、(もし分かっているならば)その部分の原
著者あるいは出版者の名前で、あるいは他と重ならないような番号を括弧で括って記載すること
で、 それぞれ見分けが付くようにしなければなりません。結合後の著作物の利用許諾告知における
変更不可部分の一覧においても、章の題名に同様の調整をするこ と。

結合後の著作物においては、あなたはそれぞれの原本の「履歴 (History)」と 題されたあらゆる
部分をまとめて、「履歴 (History)」と題された一章にしな ければなりません。同様に、「謝辞
(Acknowledgements)」あるいは「献辞 (Dedications)」と題されたあらゆる部分もまとめなければ
ならない。あなたは 「推薦の辞 (Endowsements)」と題されたあらゆる部分も削除しなければなり
ません。

6. 文書の収集
あなたは、この利用許諾契約書の下で発表された複数の文書で構成される収集著作物を作ることが
でます。その場合、それぞれの文書が逐語的に忠実に複製されることを保障するために他のすべて
の点でこの契約書の定める条件に従う限り、さまざまな文書中のこの契約書の個々の複製物を、収
集著作物中に複製物を一つ含めることで代用することがでます。

あなたは、このような収集著作物から文書を一つ取り出し、それをこの契約書の下で頒布すること
ができます。ただしその際には、この契約書の複製物を抽出された文書に挿入し、またその他すべ
ての点でこの文書の逐語的に忠実な複製に関してこの契約書が定める条件に従わなければなりませ
ん。
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7. 独立した著作物の集積
文書あるいはその派生物を、他の別の独立した文書あるいは著作物と一緒 にし、一巻の記憶装置あ
るいは頒布媒体に収めた編集著作物は、編集に起因する著作権が編集著作物に含まれる個々の著作
物がその利用者に許可した法的権利を制限するよう行使されない限り、「集積」著作物と呼ばれま
す。文書が集積著作物に含まれる場合、この契約書は、文書と共にまとめられた他の独立した著作
物には、それら自身が文書の派生物で無い限り適用されることにはなりません。

このような文書の複製物において、この利用許諾契約書の第3項によりカバーテキストの掲載が要
求されている場合、文書の量が集積著作物全体の2分の1以下であれば、文書のカバーテキストは集
積著作物中で文書そのものの周りを囲む中表紙、あるいは文書が電子的形式である場合には表紙の
電子的等価物にのみ配置するだけでよいです。その場合以外は、カバーテキストは集積著作物全体
を取り巻く印刷された表紙に掲載されなければなりません。

8. 翻訳
翻訳は改変の一種と見做すので、あなたは文書の翻訳をこの利用許諾契約書の第4項の定める条件
の下で頒布することができます。変更不可部分を翻訳によって置き換えるには著作権者の特別許可
を必要としますが、元の変更不可部分に追加する形で変更不可部分の全てないし一部の翻訳を含め
ることはかまいません。 この契約書や文書中の利用許諾告知、保証否認警告すべての英語原本も含
める限り、あなたはこの契約書、告知、警告の翻訳を含めることができます。契約書や告知、警告
に関して翻訳と英語原本との間に食い違いが生じた場合、英語原本が優先されます。

9. 契約の終了
この利用許諾契約書の下で明確に提示されている場合を除き、あなたは文書を複製、改変、サブラ
イセンス、あるいは頒布してはなりません。このライセンスで指定されている以外の、文書の複
製、改変、サブライセンス、頒布に関するすべての企ては無効であり、この契約書によって保証さ
れるあなたの権利を自動的に終結させることとなります。しかし、この契約書の下であなたから複
製物ないし諸権利を得た個人や団体に関しては、そういった人々がこの契約書に完全に従ったまま
である限り、彼らに与えられた許諾は終結しません。

10. 将来における本利用許諾契約書の改訂
フリーソフトウェア財団は、時によってGNU フリー文書利用許諾契約書の新しい改訂版を出版す
ることができます。そのような新版は現在の版と理念においては似たものになるでしょうが、新た
に生じた問題や懸念を解決するため細部に おいては違ったものになるでしょう。詳しく は http://
www.gnu.org/copyleft/を 参照して下さい。

GNU フリー文書利用許諾契約書のそれぞれの版には、新旧の区別が付くようなバージョン番号が
振られています。もし文書において、この契約書のある特定の版か「それ以降のどの版でも」適用
して良いと指定されている場合、あなたはフリーソフトウェア財団から発行された(草稿として発表
されたものを除く)指定の版かそれ以降の版のうちどれか一つを選び、その条項や条件に従うことが
できます。もし文書がこの契約書のバージョン番号を指定していない場合には、あなたはフリーソ
フトウェア財団から今までに出版された(草稿として発表されたものを除く)版のうちからどれか一
つを選ぶことができます。

. この利用許諾契約書をあなたの文書に適用する
には
この利用許諾契約書をあなたが書いた文書に適用するには、この契約書の複製物一つを文書中に含
め、以下に示す著作権表示と利用許諾告知を題扉のすぐ後に置いて下さい:

Copyright (C) 西暦年 あなたの名前. この文書を、フリーソフトウェア財団発
行の GNU フリー文書利用許諾契約 書(バージョン1.1かそれ以降から一つを選
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択)が定める条件の下で複製、頒 布、あるいは改変することを許可します。変更不
可部分、表カバーテキスト、 裏カバーテキストは存在しません。この利用許諾契
約書の複製物は「GNU フ リー文書利用許諾契約書」という章に含まれています。

もし変更不可部分や表カバーテキスト、裏カバーテキストがあれば、「変更不 可部分…は存在しな
い。」というところを以下で置き換えてください:

あなたの文書に、他に類を見ない独自のプログラムコードのサンプルが含まれる場合、フリーソフ
トウェアにおいてそのコードを利用することを許可するために、そういったサンプルに関してはこ
の利用許諾契約書と同時にGNU 一般公衆許諾契約書のようなフリーソフトウェア向けライセンス
のうちどれか一つを選択して適用してもよい、というような条件の下で発表することを推奨しま
す。
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